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Lesson

1 Sketching

3D Sketching overview

3D sketching overview

2D sketch geometry defines the cross-sectional shape used to create a base solid body
or the shape used to create a feature on an existing solid body. Sketches are drawn
in 3D on either a planar face or a reference plane. You lock onto a planar face or
reference plane to draw sketch geometry.

Both open and closed sketches can be used to create a model feature. A sketch that
forms a closed area (from sketch elements or a combination of sketch elements and
model edges on the sketch plane) produces a selectable region. When a region is
selected, the protrusion feature command is started. To use an open sketch, choose a
protrusion command (Extrude or Revolve) in the Solids group which requires a step
to define the material side of the open sketch.

Sketches do not drive features. Geometric relationships applied to the sketch
geometry do not migrate to the feature created. The system can detect, on the
resulting feature, tangent, parallel, coplanar and concentric faces. Dimensional
relationships do migrate from the sketch geometry to the edges of the body as a
feature is created.

Sketch geometry used in creating a feature is consumed and placed in a “Used
Sketches” collector in PathFinder. Any remaining sketch geometry not consumed
remains in the “Sketches” collector.
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Lesson 1 Sketching

By default, all sketch geometry placed on a sketch plane merge into a single sketch.
This is controlled by the sketch option “Merge with Coplanar Sketches”. If separate
sketches are required on a sketch plane, the “Merge with Coplanar Sketches” option
can be turned off. This sketch option is primarily used in an Assembly Layout design
workflow.
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Sketch workflow

1. On the Sketching tab®Draw group, choose a sketching command.

2. Start drawing or lock to a sketch plane (reference plane or planar face) to draw
sketch geometry on.

3. (Optional) Draw a sketch in the active view orientation or rotate the view
normal to the sketch plane by choosing the View tab®Views group®Sketch

View command .

4. Draw sketch geometry or perform any sketch related operation (for example:
placing relationships, dimensions).

5. Finish or draw another sketch. If the sketch plane is locked and you need
another sketch plane, unlock the plane. Repeat steps 2–4.

If the new sketch area is on the same plane, continue sketching geometry.

Note

You can only have one sketch on a plane, but the sketch may contain as many
regions and separate elements as you need. If separate sketches are required
on a sketch plane, turn off the Merge with Coplanar Sketchesoption.

Activity: Draw a simple sketch

Draw a simple sketch

This activity guides you through the process of drawing a simple a sketch. You
will add relationships and dimensions.
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Open a part file

▸ Start Solid Edge.

▸ Click the Application button®New®ISO Part.

Choose a sketch command

▸ On the Sketching tab®Draw group, choose the Line command .

▸ Position the cursor as shown to place first point of line.

Draw the sketch shape with line segments

▸ The line command requires two points to create a line. Click to place the first
point of a line.
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Sketching

Notice the alignment lines connected to the cursor. These lines assist you in aligning
sketch geometry.

When a line alignment is horizontal, you see the horizontal indicator.

When a line alignment is vertical, you see the vertical indicator.

When you are at the endpoint of another line you see the endpoint indicator.

▸ Draw eight lines to form the basic shape shown. Be sure to make all of the lines
horizontal or vertical, but do not worry about the line lengths at this time.
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Lesson 1 Sketching

▸ In PathFinder, click the Base check box (1) to turn off the display of coordinate
systems.

Add a circle to the sketch

▸ On the Sketching tab®Draw group, choose the Circle by Center Point command

.

▸ Place a circle as shown.
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Place sketch relationships

▸ On the Sketching tab®Relate group, choose the Horizontal/Vertical command

.

▸ Align midpoint (2) with midpoint (1). Make sure you get the midpoint indicator
before clicking.

▸ Align circle center (3) with midpoint (1). Make sure you get the center point
indicator before clicking.

▸ Align circle center (3) with midpoint (4). Make sure you get the center point
indicator before clicking.

▸ Align point (5) with point (6).

Place sketch dimensions

Numbers denote the select location for dimensioning the sketch elements.

▸ On the Sketching tab®Dimension group, choose the Smart Dimension command

.
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▸ Dimension the circle by clicking at (3).

In the dimension value edit box, type 25.

▸ Dimension the length of line (4) by clicking at (4).

In the dimension value edit box, type 50.

▸ Dimension the length of line (1) by clicking at (1).

In the dimension value edit box, type 70.

▸ On the Sketching tab®Dimension group, choose the Distance Between command

.

▸ Dimension the distance between line (1) and line (2) by clicking line (1) and
then line (2).

In the dimension value edit box, type 90.

▸ Right-click to restart the dimension command.

▸ Dimension the distance between line (5) and line (6) by clicking line (5) and
then line (6).

In the dimension value edit box, type 15.
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Sketching

Sketch complete

The sketch is complete. Turn on the relationships handle display to see the sketch
relationships.

▸ On the Sketching tab®Relate group, choose the Relationship Handles command.

▸ Turn off the relationship handles.

Summary

In this activity you learned how to create a sketch. Dimensional and geometric
relationships can be added at any time during the sketch creation. Extruded or
revolved features in Solid Edge require sketches for creation.

Practice

▸ Try changing dimensions and adding sketch geometry for practice. Otherwise,
close the file and do not save.
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Sketch plane locking

Sketch plane locking

Many commands in Solid Edge use a 2D plane for placement of geometry in 3D
model space. For example, when drawing 2D sketch elements, such as lines, arcs,
and circles, the 2D elements reside on a coordinate system plane, reference plane,
or planar face on the model. This 2D plane is called the sketch plane. Only one
sketch plane is available at a time.

There are two methods for locking input to the sketch plane:

• Automatic locking, where the active command locks the sketch plane for you,
and unlocks the sketch plane when you restart the command, or you start
another command.

• Manual locking, where you lock the sketch plane, and unlock it later yourself.

Sketch plane locking makes it easy to draw on several reference planes or planar
faces quickly.

Automatic sketch plane locking

When you start a command that uses a sketch plane, and then position the cursor
over a reference plane or planar face, the plane or face highlights (1), and an edge
on the plane (2) is highlighted to indicate x-axis of the current sketch plane. The
alignment lines, which extend outward from the cursor, also align themselves to the
plane under the cursor. A lock symbol (3) is also displayed if you want to manually
lock the sketch plane, which is discussed later.
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Sketching

When you click to position the starting point for the sketch element, the sketch plane
is automatically locked to the highlighted plane or face. The alignment lines (1) (2)
remain displayed as you draw to indicate the current sketch plane’s X and Y axes.

The sketch plane remains locked until you right-click to restart the current
command, or start another command. This ensures all sketch input lies on the
current sketch plane.

Sketch plane locking makes it easy to draw on several faces of the model quickly. For
example, after drawing the first circle, you can right-click to restart the command,
then draw a circle on a second face, right click again, and draw a circle on a third face.
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Manual sketch plane locking

You can also manually lock the sketch plane. This is useful when the sketch
geometry is complex or will extend beyond the outer edges of the planar face or
reference plane on which you want to draw.

When you are in a command that supports manual sketch plane locking, a lock
symbol is displayed near the cursor (1) when you are over a planar face or reference
plane. You can click this symbol to manually lock the plane.

Tip

You can also lock and unlock the sketch plane by pressing the F3 key when
you are in any command that supports sketch plane locking.

The sketch plane remains locked regardless of the cursor position until you manually
unlock the plane. This makes it easy to draw beyond the outer edges of the planar
face.
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When the sketch plane has been locked manually, a locked plane indicator symbol (1)
is displayed in the top-right corner of the graphics window.

When you want to unlock the sketch plane, you can click the locked plane indicator
symbol in the graphics window to unlock the plane, or you can press the F3 key.

Plane locking and PathFinder

Whether you lock the sketch plane automatically or manually, a locked plane
indicator (1) appears in PathFinder adjacent to the sketch which is locked.

If there are existing sketches in the model, you can lock and unlock the sketch plane
using the Lock Sketch Plane command on the PathFinder shortcut menu when your
cursor is over a sketch entry.

Drawing synchronous sketches of parts

Drawing synchronous sketches of parts

You draw synchronous sketches to establish the basic shape requirements of a part
before you construct any features. You can draw a synchronous sketch on a principal
plane of the base coordinate system, a planar face on the model, or a reference plane.
You can then use these sketches to create sketch-based features, such as extruded
features which add or remove material.
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Visual sketching aids

There are a variety of visual sketching aids available to you. The triad in the center
of the graphics window is the base coordinate system.

The principal planes on the base coordinate system are typically used to draw the
first sketch for the base feature on a new part.
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You can also independently display the sketching grid, alignment lines, and
coordinate readouts using the Grid Options command.

Getting started with sketching

Getting started with sketching is easy. When you sketch elements, they will go on
the coordinate system plane, planar face, or reference plane that is directly under
your cursor when you start placing the element.

When starting a new part, you would typically draw a sketch on one of the three
principal planes of the base coordinate system. For example, you can draw the first
sketch for a new part on the XZ principal plane of the base coordinate system (1).

You can see which plane of the coordinate system you will draw on because the plane
under the cursor highlights, and the alignment lines, which extend out from the
cursor, adjust dynamically depending on what plane your cursor is over.
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When you click to define the first endpoint of an element, such as a line, sketch input
is locked to the current plane.

Note

• If there is not a coordinate system plane, model face, or reference plane
under your cursor, the element will fall on one of the three principal
planes of the document. The system will automatically choose the one
that is flattest to the view.

• See the Help topic, Start a sketch, to learn how to get started.

Sketch plane locking

Many of the sketching commands require a locked sketch plane for placement of 2D
geometry in 3D model space.

There are two methods for locking the sketch plane:

• Automatic locking, where the active command locks the sketch plane for you,
and unlocks the sketch plane when you start another command. This makes
it easy to get started.

• Manual locking, where you lock the sketch plane, and unlock it later yourself.
This is useful for complex sketches or for sketches where the sketch geometry
extends beyond the boundary of the sketch plane.

Note

To learn more, see: Sketch plane locking.

Synchronous sketches locked to faces

A synchronous sketch drawn on a model face is automatically locked to the face. As
the face moves, the sketch moves with the face. By default, the Live Rules option
Maintain Sketch Planes is on.

To unlock the sketch from the model face, turn off theMaintain Sketch Planes option
in Live Rules.

If a sketch is drawn on a model face that is coplanar to a base reference plane, the
sketch is not locked to the model face.
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Sketch plane X-axis orientation

When you highlight a coordinate system plane, planar face, or reference plane
on which you want to draw a sketch, a default X-axis orientation is displayed
automatically (1).

While you are defining the sketch plane and the default X-axis is highlighted (1),
you can use the shortcut keys to change the X-axis orientation. For example, you
can press the N key to select the next linear edge (2), or the B key to select the
previous linear edge (3).

The valid shortcut keys for defining the X-axis orientation of a sketch plane are
displayed in PromptBar when you are defining the sketch plane.
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The X-axis orientation (1) (2) of a sketch controls the dimension text alignment for
dimensions, and determines the horizontal and vertical axes for horizontal and
vertical relationships.

Sketch regions

In a part or sheet metal document, when you draw 2D sketch elements that form a
closed area, the closed area is automatically displayed as a sketch region (1). When
working in a shaded view, the closed region also displays as shaded.
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In a part or sheet metal document, you can use sketch regions to construct features
using the Select tool. Sketch regions are formed automatically when a series of
sketch elements close on themselves (1), or when sketch elements and one or more
model edges form a closed area (2).

As you draw, you may want to disable sketch regions. You can do this by clearing
the Enable Regions command, which is located on the shortcut menu when you
select a sketch in PathFinder.

You can use the Enable Regions command to turn region selection on again.

The Enable Regions command is not available in an assembly document.
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Adding dimensions and geometric relationships

You can add dimensions and geometric relationships to control the size, shape,
and position of the sketch elements. You can also place dimensions and geometric
relationships relative to the primary axes of the coordinate system. This can be
especially useful for symmetric parts during later design modifications. For example,
the 10 mm and 22.5 mm dimensions were placed relative to the X and Z axes of the
base coordinate system.

Note

You can display and hide geometric relationships using the Relationship
Handles command.

You can also define functional relationships using the Variables command.

Keeping dimensions horizontal and vertical to the sketch geometry

To keep dimensions horizontal and vertical to the sketch geometry, you can move
the sketch plane origin and reorient the sketch plane X-axis using the Reposition
Origin command on the Sketching tab. This makes it possible to draw and dimension
on different coplanar faces in the same sketch, yet keep dimension text and
relationships oriented to an edge on the face, as shown.
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Using sketches to construct features
When you use a sketch to construct a feature in a part or sheet metal document,
by default, the sketch elements are automatically consumed and transferred to
the Used Sketches collection in PathFinder and the dimensions on the sketch are
automatically migrated to the appropriate model edges when possible.

Note

After you construct a feature in a synchronous model, the original sketch
geometry does not drive the feature.

You can use the Migrate Geometry and Dimensions command on the shortcut
menu when a sketch is selected in PathFinder to control whether sketch elements
are consumed and dimensions are migrated when you construct features using
the sketch.

Editing sketches
You can move and resize sketch elements using the Select tool. You also can edit
sketch elements using commands such as Extend To Next, Trim, Mirror, Scale,
Rotate, Stretch, and so forth. With these commands, you select the command first,
then follow the prompts to edit the sketch elements you want.
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Sketching and PathFinder

The sketches you draw are listed in PathFinder. PathFinder also lists the base
coordinate system, PMI dimensions, the base reference planes, features you
construct, and used sketches.

You can display or hide individual sketches or all the sketches in the document using
the check box options in PathFinder and commands on the PathFinder shortcut
menu.

When a sketch name is selected in PathFinder, you can use shortcut commands to:

• Delete a sketch.

• Cut, copy, and paste a sketches.

• Rename a sketch.

Moving sketches

Sometimes you may want to move or rotate an entire sketch to a new position in
space. By default, when you use the Select tool to select sketch elements in the
graphics window, only a sketch region or the selected sketch element is selectable.

To select an entire sketch, you can select the sketch entry in PathFinder, or you can
use QuickPick to select the sketch in the graphics window.
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You can then use the steering wheel to move or rotate the sketch to a new position
in space.

If the sketch in moved such that it becomes coplanar to another sketch, the two
sketches are combined into one sketch, unless the Merge Coplanar sketches option
has been cleared for one of the sketches.

Sketches and associativity

Sketch geometry is not directly associative to the plane or face on which it is drawn.
If you move the plane or face on which the sketch is drawn, the sketch geometry does
not move unless it is also in the select set. This does not apply to sketches drawn on
the principal planes of the base coordinate system or the base reference planes, as
these planes are fixed in space.

You can apply 2D geometric relationships between sketch elements and model edges.
If the model edges move, the sketch elements and geometric relationships update.

Restoring sketches

To restore a sketch to its original location on the model, use the Restore command on
the shortcut menu when a used sketch is selected. This can be useful if you want to
use the sketch to construct another feature elsewhere on the model or if you deleted
the feature that the used sketch described.

Projecting elements onto a sketch

You can use the Project to Sketch command on the Sketching page to project model
edges or sketch elements onto the current sketch plane. The sketch elements you
project are associative to the parent element. If the parent element is modified,
the projected element updates.

Note

The associative link between the parent element and the projected element is
discarded when you construct a feature using the projected elements.
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Regions

Definition

A region is a closed area formed by sketch elements or a combination of sketch
elements and part edges. Use regions to create a solid feature consisting of planar
and non-planar faces.

Regions are formed by the placement of 2D sketch geometry on sketch planes or part
faces. Regions are created when a series of sketch elements or model edges form a
closed area. Regions are a by-product of a closed sketch. Deselected regions appear
with a shaded light blue color.

Region examples

Selecting a region

As the cursor moves over a region, the region appears with a shaded tan color.
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When the region is selected, the region appears with a shaded green color.

Regions can be selected in both object-action and action-object workflows.

Activity: Create regions

Create regions

This activity guides you through the process of drawing a sketch to observe when
regions are formed. You will also learn how to select regions.

Open a part file

▸ Start Solid Edge.

▸ Click the Application button®New®ISO Part.

Draw a rectangle

▸ On the Sketching tab®Draw group, choose the Line command .

▸ Draw a rectangle. Notice that as soon as the last line connects to the first line, a
region forms. (1) denotes the first point.
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Select the region

▸ On the Home tab®Select group, choose the Select tool command .
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▸ Move cursor over rectangle and notice the color change. Closed sketches (regions)
and faces highlight as the cursor moves over them.

▸ Select the region and notice the color change. The region can extrude or revolve.
This is covered in the Base Feature Creation course. Press the Esc key to end
the select command.

Create nested regions

▸ On the Sketching tab®Draw group, choose the Rectangle command .

▸ Draw two rectangles that overlap as shown.

mt01413-s-1050 Solid Edge fundamentals 1-27



Lesson 1 Sketching

Select multiple regions

The two overlapping rectangles forms three regions.

▸ Move the cursor over the overlapping rectangles and notice the regions formed.

▸ Select each region and notice that the previously selected region is deselected.

▸ To select multiple regions, select a region and then press the Spacebar.

Note

The Spacebar sets the select mode to add/remove . If you select an
element already selected, it is deselected. If you select an element not
already selected, it is selected.
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▸ Create the following select sets. Press Esc after each select set is created.

Summary

In this activity you learned how to create and select regions. Creating a synchronous
feature in Solid Edge requires a region.

Practice

▸ Try creating other regions for practice. Otherwise, close the file and do not save.

Open sketches
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An open sketch that is not coplanar with a body face or is coplanar with a body face
but does not touch or cross a face edge does not create a region. A region is created if
an open sketch is connected to or crosses a coplanar face edge.

Note

Open sketches use the extrude command to create a body feature. Define
the side of the open sketch to add material to and the sketch automatically
extends to next face to create a body feature.

Synchronous sketch behavior in the ordered environment

Synchronous sketches are used to create both synchronous and ordered features.
Ordered sketches cannot be used to create a synchronous feature because while in
the synchronous environment, ordered elements are not available for selection.

Synchronous sketches can only be selected when creating an ordered feature by
using the “Select from Sketch” option in the Profile step.

In ordered modeling, fully-constrained sketches help you maintain predictability as
you change a model by adding features and editing constraints. In synchronous
modeling, sketches are consumed by the features that are based upon them, after
which time the sketches no longer drive the shape or behavior of the model. So
developing fully-constrained sketches is important in ordered modeling, but not
in synchronous modeling. In synchronous modeling it is important that a sketch
properly define a shape at the time the sketch is used to create new features; whether
or not that shape is fully constrained does not determine the appropriateness of the
shape. Since constraints defined on a sketch are consumed when the shape is used,
they no longer constrain the resulting features.

Editing an ordered feature created with a synchronous sketch

Ordered features are driven by sketches. To edit the cross section definition of an
ordered feature, edit the driving sketch.

The following are the methods available for editing a synchronous sketch which
drives an ordered feature.

Directly edit the synchronous sketch

Step 1: Turn on the display of the driving synchronous sketch.

Step 2: Select a sketch element to edit.

You can move the selected sketch element and/or change the element
properties on command bar.

Step 3: Edit sketch dimensions.

Note

You cannot edit or add synchronous sketch relationships using this method.

Note

As the synchronous sketch is edited, the ordered feature dynamically updates.
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Feature edit (Edit Profile)

Step 1: Select the ordered feature to edit.

Step 2: Choose the Edit Profile command on the Feature Edit box.

Step 3: The modeling environment switches to synchronous. You can now fully
edit the synchronous sketch.

Step 4: When the synchronous sketch edits are complete, switch to the ordered
environment to observe the feature edits.

Feature edit (Dynamic Edit)

Step 1: Select the ordered feature to edit.

Step 2: Choose the Dynamic Edit command on the Feature Edit box.

Step 3: The driving synchronous sketch appears. Make edits to synchronous
sketch.

Synchronous sketch behavior in ordered modeling
• Synchronous sketch dimensions are not migrated to ordered features.

• Synchronous sketches are not consumed when creating an ordered feature.

• Synchronous sketches can drive ordered features.

• Synchronous sketches appear while in the ordered environment.

• Regions are disabled.

• Synchronous sketches appear in the synchronous sketch style and colors.

• When using the Select Tool in the ordered environment, synchronous sketch
elements locate as individual elements.

• Synchronous sketches can be moved using the steering wheel handle. The entire
sketch moves (not single elements).

• In the ordered environment, synchronous sketch geometry or relationships
commands are not available.

• Synchronous and ordered sketches cannot be copied while in ordered
environment.
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Drawing ordered sketches of parts
Drawing ordered sketches allows you to establish the basic functional requirements
of a part before you construct any features. You can draw a sketch on any reference
plane using the Sketch command in the Part and Sheet Metal environments. Then
you can use these sketches to create profile-based features.

Sketching a part before modeling it gives you several advantages:

• Allows you to draw multiple profiles on one reference plane.

• Allows you to define relationships, such as tangency or equality, between profiles
on different reference planes.

• Allows you to draw the profiles you want without creating the subsequent
features until later.

Drawing ordered sketches

When you click the Sketch button and then select a reference plane or planar face,
a profile view is displayed. You can then use the drawing commands to draw 2D
geometry.

The sketch elements you draw are assigned to the active layer. For example, when
working with a complex sketch that will be used to construct a lofted feature, you
may want to arrange the elements on multiple layers.

Note

For more information about 2D drawing in Solid Edge, see the following
related topics: Drawing in Solid Edge and Drawing Profiles.

You can add dimensions and relationships to control the positions and sizes of the
profiles. You can also define functional relationships using the Variables command.
You can use the Save and Save All commands to save the sketch while you create
them. When you have finished drawing, close the profile view using the Return
button on the command bar.

For more information on drawing sketches, see the Drawing 2D elements Help topic.

Sketches and PathFinder

Sketches are represented in the PathFinder tab just like features are. You can
display or hide them from the feature tree with the PathFinder Display: Sketches
command on the shortcut menu. You can use PathFinder to reorder or rename a
sketch just as you would any feature.
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Displaying sketches
You can control the display of all the sketches in a document or individual sketches.
To display or hide all sketches, use the Show All: Sketches and Hide All: Sketches
commands. To display or hide individual sketches, select a sketch in the application
window or PathFinder, then use the Show and Hide commands on the shortcut menu.

You can also control the display of elements in a sketch by assigning the sketch
elements to a logical set of layers, and then display or hide the layers to control the
display of the sketch elements.

When a sketch is active, it is displayed using the Profile color. When a sketch is not
active, it is displayed using the Construction color. You can set the colors you want
using the Options command.

Using sketches to construct features
You can use sketches to construct features in the following ways:

• Directly, by clicking the Select From Sketch button on the feature command bar.

• Indirectly, by clicking the Draw button on the feature command bar and then
associatively copying sketch geometry onto the active profile plane using the
Include command.

Using sketches directly
You can use sketch profiles directly if no modifications to the profile are required.
When constructing an ordered feature, click the Select From Sketch button on the
feature command bar. You can then select one or more sketch profiles. When you
click the Accept button on the command bar, the profiles you selected are checked to
make sure they are valid for the type of feature you are constructing. For example, if
you are constructing an ordered base feature, the profile you select must be closed. If
you select an open profile or more than one profile, an error message is displayed.
You can then select the Deselect (x) button on the command bar to clear the selected
profiles.

Ordered features constructed using sketched profiles are associative to the sketch
and will update when the sketch is edited.

Using sketches indirectly
If the sketch profile requires modification before using it to construct a feature, you
must first copy it to the active profile plane using the Include command. When you
click the Draw Profile button on the feature command bar, and define the profile
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plane you want, a profile view is displayed. You can then use the Include command
to copy elements from sketch profiles to the active profile plane.

After you have copied sketch elements, you can use the drawing commands to modify
them. For example, you may need to add elements to the profile not contained in
the sketch. You can also add dimensions and relationships between the elements on
the active profile plane and the sketch.

The sketched elements you copy are associative to the sketch and will update if the
sketch dimensions are edited.

Editing and modifying sketches
You can modify sketch elements using the command bar or the element’s handles.
When you modify an element, other elements may also change.

Selecting Elements

You can use the Select Tool to select elements in several ways:

• To select an individual element, position the cursor over the element and
click when the element highlights.

• To select multiple elements, press the Ctrl or the Shift key while you select
the elements.

• To select all 2D elements, press Ctrl+A. The Select Tool command does not
need to be active for this to work.

• To deselect an element, press the Shift or Ctrl key and click the element.

• To select multiple elements using a fence, drag the cursor to define a
rectangular fence. You can use the Selection Options button on the Select
Tool command bar to specify the selection criteria you want.

Command bars

After you select an element, you can modify it by changing its values on a
command bar. For example, you can change the length of a line by typing a new
value in the Length box on the command bar.

Element handles

You can use an element’s handles to modify an element. An element handle is
represented by a solid square on the element, such as the end of a line or the
center of an arc. You can dynamically drag a handle to modify an element. First,
select the element, then drag the handle to modify it.
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• Lines - Drag a handle to modify the length or angle of a line.

• Arcs - Drag an endpoint, midpoint, or center point handle to modify an arc.

• Fillets and Chamfers - Drag the handle to modify the size of a fillet or
chamfer.

Sketches and revolved features

Sketches that are used for constructing revolved ordered features must have an axis
defined in the sketch. If you select a sketch profile that does not have an axis, an
error message is displayed. You will have to cancel the revolved feature you are
constructing, then open the sketch to define the axis.

Sketches and the swept and loft commands

Drawing sketches can be especially useful when constructing swept and lofted
features. Because the Sketch command allows you to define relationships between
profiles on separate planes, you can more easily define the relationships you need
to control these features properly. Additionally, the ability to exit a sketch profile
window without creating a feature can be especially useful when drawing the profiles
for swept and lofted features.

Converting 2D drawing view data to a 3D sketch

You can use the Create 3D command to convert two-dimensional drawing view data
into a three-dimensional sketch.

The command displays the Create 3D dialog box that prompts you for the drawing
view elements you want to include in the sketch.

Before selecting the elements that you want to include in the sketches, you need to
select a template to create a part, assembly, or sheet metal file. After you select a
template file, specify the projection angle that you want to use when the sketches are
created in the new document. After you specify the projection angle, select the view
type of the elements you want to include in the sketch:

• Folded principal views are orthogonal or aligned with the primary view. You can
select this view type to define the primary view.

• Folded auxiliary views are true auxiliary views that are generally derived from
principal views and require a fold line to determine the edge or axis around
which you want to fold the view.

• Copy views are not orthogonal and they may not actually align with the primary
view. These views are placed as sketches on the same plane as the last principal
view defined in the draft file.
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After you define this information, you are ready to select the geometry to create
the sketches. You can include lines, arcs, circles, curves, and polylines and line
strings created with imported data. You can drag the mouse to fence elements or
press the Shift key and click each element to select more than one element.

If you select the Fold Principal Views option or Fold Auxiliary Views option and
it is not the primary view, you can click the Fold Line button after you select all
of the elements for the view. The Fold Line button allows you to define a line or
point in an orthogonal or auxiliary view on which to fold the primary view.

If you want to define another view, click the New View button and select the
next view.
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Continue this process to define any additional views.

After you define all views, click the Finish button to launch the Part or Sheet
Metal environment to create the model file in which the views are placed as
sketches.

Drawing commands

Drawing commands

The commands for creating and manipulating sketch elements are located on the
Sketching tab (1) in the Draw group (2).
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Drawing 2D elements

In Solid Edge, you can draw 2D elements to help you complete a variety of tasks. For
example, you can use 2D elements to construct features in the Part environment and
to draw layouts in the Assembly environment.

In the Draft environment, you can use 2D drawing tools to complete a variety
of tasks such as drawing sketches from scratch on the 2D Model sheet or in 2D
views, creating background sheet graphics, and defining cutting planes for section
views. The drawing commands, relationships, and dimensions work similarly in
all environments.

Drawing commands and tools
You can draw any type of 2D geometric element in Solid Edge, such as lines, arcs,
circles, B-spline curves, rectangles, and polygons.

You can also use Solid Edge to do the following:

• Move, rotate, scale, and mirror elements

• Trim and extend elements

• Add chamfers and fillets

• Create precision graphics from a freehand sketch

• Change the color of elements

Tools that work with the drawing commands –IntelliSketch, Intent Zones, and Grid
– allow you to easily relate elements to each other, define your drawing intentions
as you sketch, and provide precise coordinate input relative to any key position in
the drawing.

Drawing command input
Use Solid Edge drawing commands to provide input by clicking in the graphics
window, or by typing values in command bar boxes. No strict input order is required.

It is often productive to use a combination of graphics window and command bar
input. For example, you can type a line length in the command bar, press the Enter
or Tab key to lock the value, then set the orientation angle of the line in the graphics
window. Or you can use the drawing command dynamics to get a graphic idea of
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the size and orientation you want, then type values in the command bar boxes to
provide more precise input.

You can use the Line Color option on the element command bar to apply colors
to 2D elements. You can click the More option on the Colors dialog box to define
custom colors.

Drawing dynamics

As you draw, the software shows a temporary, dynamic display of the element you
are drawing (A). This temporary display shows what the elements will look like if
you click at the current cursor position.

Until you click the point that completely defines the element that you are drawing,
values in the command bar boxes update as you move the cursor. This gives you
constant feedback on the size, shape, position, and other characteristics of the
elements you draw.

When you lock a value by typing it into a command bar box, the dynamic display of
the element you are drawing shows that the value is locked. For example, if you lock
the length of a line, the length of the dynamic line does not change as you move the
cursor to set the angle. If you want to free the dynamics for a value, you can clear
the value box by double-clicking in the box and pressing the Backspace or Delete key.

Applying and displaying relationships

As you draw, IntelliSketch recognizes and applies 2D relationships that control
element size, shape, and position. When you make changes, relationships help the
drawing retain the characteristics you do not want altered.

When a relationship indicator is displayed at the cursor, you can click to apply that
relationship. For example, if the horizontal relationship indicator is displayed when
you click to place the end point of a line, the line will be drawn exactly horizontal.
You can also apply relationships to elements after you draw them.
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Relationship handles displayed on the 2D geometry show you how elements are
related. You can remove any relationship by deleting its handle. You can display or
hide the relationship handles with the Relationship Handles command.

Maintaining relationships

You can draw and modify 2D elements in the way that best suits your design
needs. You can make your assembly layouts and drawings associative by applying
relationships, or you can draw them freely, without relationships. When you draw
2D elements in a part document, 2D relationships are maintained.

Maintaining relationships between 2D elements makes the elements associative (or
related) to each other. When you modify a 2D element that is related to another
2D element, the other element updates automatically. For example, if you move a
circle that has a tangent relationship with a line, the line also moves so that the
elements remain tangent.

You can draw elements freely, or non-associatively. When you modify a
non-associative portion of an assembly sketch or drawing, the changed elements
move freely, without changing other portions of the design. For example, if you move
a circle that is tangent to a line (but does not have a tangent relationship with the
line) the line does not move with the circle.

To control whether you draw and modify 2D elements freely or associatively in
layouts and drawings, use the Maintain Relationships command in the Assembly
and Draft environments.

Note

When you construct a synchronous feature using the 2D elements, the sketch
elements are moved to the Used Sketches collector in PathFinder.
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How 2D relationships work
An element that has no relationships applied can be moved and changed in various
ways. For example, when there are no relationships between two lines (A), the
lines can be moved and changed without affecting each other. If you apply a
perpendicular relationship between the two lines (B), and move one line, the lines
remain perpendicular.

When you apply a relationship between elements, the relationship is maintained
when you modify either element. For example:

• If a line and an arc share a tangent relationship, they remain tangent when
either is modified.

• If a line and arc share a connect relationship, they remain connected when
either is modified.

Relationships also maintain physical characteristics such as size, orientation, and
position.

• You can make the size of two circles equal with an equal relationship.

• You can make the orientation of two lines parallel with a parallel relationship.

• You can connect a line and an arc with a connect relationship.
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A relationship can also maintain a physical characteristic of an individual element.
For example, you can make a line horizontal. The line remains horizontal even
if you change its position and length.

Construction elements

For 2D elements you draw in a part or assembly document, you can specify that the
element is a considered a construction element. The Construction command on
the Sketching tab allows you to specify that an element is a construction element.
Construction elements are not used to construct features—they are used only as
drawing aids. The line style for a construction element is dashed.

Intent Zones

Solid Edge uses intent zones to interpret your intentions as you draw and modify
elements. Intent zones allow you to draw and modify elements many ways using few
commands. You do not need to select a different command for every type of element.

How intent zones work

When you click to begin drawing certain elements, the software divides the region
around the clicked position into four intent zone quadrants. For example, when
drawing a line that is connected to a circle, four intent zones are displayed around
the point you clicked (A).

Two of these intent zones allow you to draw the line tangent to the circle. The other
two intent zones allow you to draw the line perpendicular to, or at some other
orientation relative to the circle.
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By moving the cursor through one of these intent zones on the way to your next click
location, you can tell the software what you want to do next. This allows you to
control whether the line is tangent to the circle (A), perpendicular to the circle (B), or
at some other orientation (C).

The last intent zone you move the cursor into is the active zone. To change the active
intent zone, move the cursor back into the zone circle, and then move the cursor out
through the intent zone quadrant to the position where you want to click next.

Intent zone size

You can change the size of the intent zones with the IntelliSketch command. The
Intent Zone option on the Cursor tab on the IntelliSketch dialog box allows you to
set the intent zone size.

Drawing lines tangent or connected to curved elements

Using intent zones with the Line command, you can draw a line tangent to a circle or
arc. Or you can draw a line that is connected to the circle or arc, but not tangent to it.

To draw an line tangent to a circle, first click a point on the circle (A) to place the first
end point of the line. Then move the cursor through the tangent intent zone. As you
move the cursor, the line remains tangent to the circle. Position the cursor where you
want the second end point of the line (B), then click to place the second end point.
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If you do not want the line to be tangent to the circle, you can move the cursor back
into the intent zone region and out through one of the perpendicular zones (A) before
clicking to place the second end point of the line. When you move the cursor through
the perpendicular zones, you can also draw the line such that it is not perpendicular
to the circle (B) and (C).

The Line command also allows you to draw a connected series of lines and arcs. You
can use the L and A keys on the keyboard to switch from line mode to arc mode.
When you switch modes, intent zones (A) and (B) are displayed at the last click point.

The intent zones allow you to control whether the new element is tangent to,
perpendicular to, or at some other orientation to the previous element.

Drawing tangent or perpendicular arcs

You can use intent zones to change the result of the Tangent Arc command. To draw
an arc tangent to a line, first click a point on the line to place the first end point of
the arc. Then move the cursor through the tangent intent zone and click to place
the second end point of the arc.

If you do not want the arc to be tangent to the line, you can move the cursor back
into the intent zone region and out through the perpendicular zone before clicking to
place the second end point of the arc.
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Drawing arcs by three points

When you use the Arc By 3 Points command, intent zones allow you to input the three
points in any order. You can also use intent zones to change the arc direction. The
intent zone used with the Arc By 3 Points command is not divided into quadrants.
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Construction Geometry

You can use construction geometry to help you draw and constrain a profile, but the
construction geometry is not used to construct the surfaces for the feature. When the
feature is created, the construction geometry is ignored. The Construction command
is used to change a profile element or sketch element into a construction element.

• Construction elements use the double-chain line style so you can distinguish
them from other elements.

• For example, you can use 45 degree construction lines to control the location of
the tabs on the profile or sketch.

• The construction lines make it easier to edit the location of the tabs, but the
construction lines are not used to produce the solid model.

Modifying 2D elements

Solid Edge provides a wide range of tools for modifying 2D elements. 2D drawing
and modification tools work together smoothly, so that you can modify your profiles,
sketches, and 2D drawings as you work.
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Using element handles

You can change the size, position, or orientation of an element with the cursor. When
you select an element with the Select tool, its handles are displayed at key positions.

You can change the shape of a selected element by dragging one of its handles. The
first figure shows the effect of dragging an end point handle. The second figure
shows the effect of dragging the midpoint handle.
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Moving and copying elements with the mouse

You can also drag a selected element to move it without changing its shape. Position
the cursor so it is not over a handle, then drag the element to another location.

To copy an element, hold the Ctrl key while you drag.

Applying relationships between elements

You can apply geometric relationships as you draw or after you draw. To apply a
geometric relationship onto an existing element, select a relationship command and
then select the element to which you want to add the relationship. When you apply a
relationship to an element, the element is modified to reflect the new relationship.

If a line and arc are not tangent (A), applying a tangent relationship modifies one or
both elements to make them tangent (B).

When you use relationship commands, the software allows you to select only elements
that are valid input for that command. For example, when you use the Concentric
command, the command allows you to select only circles, arcs, and ellipses.
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Changing relationships

You can delete a relationship as you would delete any other element by selecting a
relationship handle, then press the Delete key on the keyboard.

Dimensions as relationships

Driving dimensions are relationships that allow you to maintain characteristics
such as the size, orientation, and position of elements. When you place a driving
dimension on or between elements, you can change the measured elements by
editing the dimensional value. You do not have to delete or redraw elements at
different sizes.

For example, you can dimension the radius of an arc to maintain its size (A), and
then edit the value of the radius dimension to change its size (B).

To create dimensional relationships, select a dimension command and click the
elements you want to control.

Changing elements with relationships

When you modify 2D elements, elements with maintained relationships
automatically update to honor the relationship. For example, if you move an element
that shares a parallel relationship with another element, the other element moves
as needed to remain parallel. If a line and an arc share a tangent relationship, they
remain tangent when either is modified.

If you want to change an element by adding or removing a relationship, and the
element does not change the way you expect, it may be controlled by a driving
dimension. You can toggle the dimension from driving to driven, then make the
change.
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Element modification: trimming, extending, splitting, filleting, chamfering,
offsetting, and stretching
Whether your sketching technique is to start big and whittle away or to start small
and build up, relationships make it possible to sketch and evolve, rather than draw
every element to its exact measurements. Solid Edge modification tools allow you to
change a sketch and still maintain applied relationships.

Solid Edge provides commands to trim, extend, or split elements.

The Trim command trims an element back to the intersection with another element.
To use the command, click on the part to trim.

You can trim one or more elements by dragging the cursor across the part to trim.

You can also select the elements you want to trim to. This selection overrides
the default option of trimming to the next element only. To select an element to
trim to, press the Ctrl key while selecting the element to trim to. For example, in
normal operations, if you selected line (A) as the element to be trimmed, it would be
trimmed at the intersection of the next element (B). However, you can select the
edges (C) and (D) as the elements to trim to and the element will be trimmed at
the intersection of those edges.
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The Trim Corner command creates a corner by extending two open elements to
their intersection.

The Extend to Next command extends an open element to the next element. To do
this, select the element and then click the mouse near the end to extend.

You can also select an element to extend to. This selection overrides the default
option of extending to the next element only. To select an element to extend to,
press the Ctrl key while selecting the element to extend to. For example, in normal
operations, if you selected line (A) as the element to be extended, it would be
extended to the intersection of the next element (B). However, you can select edge
(C) to extend the line to that edge.

The Split command splits an open or closed element at the location you specify. When
splitting elements, appropriate geometric relationships are applied automatically.
For example, when splitting an arc, a connect relationship (A) is applied at the split
point, and a concentric relationship (B) is applied at the center point of the arcs.
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Fillet and Chamfer commands combine drawing and trimming operations.

The Offset command draws a uniform-offset copy of selected elements.

You cannot select model edges with this command. If you want to offset model edges,
use the Include command.

The Symmetric Offset command draws a symmetrically offset copy of a selected
centerline.

The Stretch command moves elements within the fence and stretches elements
that overlap the fence.
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Relationships are added or removed as necessary during element modification. If
you trim part of a circle and more than one arc remains, concentric and equal
relationships are applied between the remaining arcs.

For example, you typically begin designing with key design parameters. You would
draw known design elements in proper relation to one another (A) and then draw
additional elements to fill in the blanks (B).

As you draw, you may need to modify elements to create a valid profile, or to make
a drawing look the way you want it to (C-F). You can use modification commands
such as Trim and Extend to modify the elements. The relationships are maintained
and additional relationships are applied.
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Element manipulation: rotating, scaling, mirroring, copying, and deleting

Tools are provided for moving, rotating, scaling, and mirroring elements. These tools
can also be used for copying. For example, you can make a mirror copy, or you can
cut or copy 2D elements from another application and paste them into the profile
window, the assembly sketch window, or a drawing.

When you manipulate elements that have relationships, the relationships are
retained when possible. For example, if you make a copy of two related elements, the
relationship is also copied. However, if you copy one of two elements that are related
to each other, the relationship is not copied.

Relationships that are no longer applicable after a manipulation are automatically
deleted. For example, if you delete one of a pair of parallel lines, the parallel
relationship is deleted from the remaining line.

The Rotate command turns or turns and copies 2D elements about an axis. The
command requires you to specify a center point for the rotation (A), a point to rotate
from (B), and a point to rotate to (C).
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The Scale command uses a scale factor to proportionally scale or scale and copy
2D elements.

The Mirror command mirrors or mirror copies 2D elements about a line or two points.

The Delete command removes 2D elements from the profile or sketch window.

Applying colors and patterns to closed boundaries

A boundary in a Solid Edge drawing, sketch, or profile can be filled with a pattern
or solid color.

A fill is like other elements in that you can format it and move it around, but the
fill is always associated with a boundary. The boundary can be made up of more
than one element.

Modifying fills

A fill can exist only inside a closed boundary. A fill is associative, which means
it maintains its original orientation to an element regardless of the way you
manipulate the element. For example, if you move the boundary, the fill moves with
it. If you change the boundary, the fill changes to conform to the new boundary area.
You can delete a fill the same way you would delete an element.
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Fill insertion point

• When you click inside an object to fill it, the cursor location designates the fill
insertion point.

• The fill insertion point is also the fill handle. You can select the fill handle and
drag the fill to another object.

• If you use the Redo Fill option to refill the area based on a new boundary, the
insertion point designates which side of the object will be refilled.

Formatting fills

Formatting a fill is similar to applying formats to an element. You can apply unique
formats to fills with the Properties command or by setting options on the Fill
command bar. To make several fills look the same, you can apply a fill style by
selecting the style on the command bar.

The software provides fill styles for various engineering standards, such as ANSI,
ISO, and AIA. You can modify an existing fill style or create a new one with the
Style command.
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Sketch geometric relationships

Sketch geometric relationships

The sketch relationship commands are located on the Sketching tab (1) in the
Relate group (2).

Sketch relationships do not migrate to the feature created from them.

Geometric Relationships

Geometric relationships control the orientation of an element with respect to another
element or reference plane. For example, you can define a tangent relationship
between a line and an arc. If the adjoining elements change, the tangent relationship
is maintained between the elements.

Geometric relationships control how a sketch changes when edits are made.
IntelliSketch displays and places geometric relationships as you draw. After you
complete the sketch, you can use the various relationship commands and the
Relationship Assistant to apply additional geometric relationships.
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Relationship Handles

Relationship handles are symbols used to represent a geometric relationship
between elements, keypoints, and dimensions, or between keypoints and elements.
The relationship handle shows that the designated relationship is being maintained.

Relationship Handle
Collinear

Connect (1 degree of freedom)

Connect (2 degrees of freedom)

Concentric
Equal
Horizontal/Vertical

Tangent
Tangent (Tangent + Equal Curvature)

Tangent (Parallel Tangent Vectors)

Tangent (Parallel Tangent Vectors + Equal Curvature)

Symmetric

Parallel

Perpendicular

Fillet

Chamfer

Link (local)
Link (peer-to-peer)
Link (sketch to sketch)
Rigid Set (2-D elements)

In some cases, more than one relationship may be required and displayed at the
same location on the profile. For example, a connect relationship and a tangent
relationship can be used where an arc meets a line.
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Displaying Parents for a Relationship

When modifying a profile or sketch, it can be useful to determine the parent
elements for a relationship. When you select a geometric relationship, the parents
highlight. For example, when you select the horizontal relationship shown in the
first illustration, the left vertical line and the circle are highlighted as the parent
elements.

This can be useful when multiple relationships are in the same location and you
need to delete one relationship. In this situation, you can use QuickPick to highlight
the relationship, and the parent elements are displayed using a dashed line style.

Collinear

The Collinear command forces two lines to be collinear. If the angle of one of the
lines changes, the second line changes its angle and position to remain collinear
with the first.
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Connect
The Connect command joins a keypoint on one element to another element, or
element keypoint. For example, you can apply a connect relationship between the
endpoints of two elements. Establishing a connect relationship between element
endpoints helps you draw a closed sketch. The symbol for connected endpoints
displays a dot at the center of a rectangle.

You can also use the Connect command to connect the endpoint of an element to any
point on another element, not necessarily an endpoint or keypoint. This is called
a point-on-element connection, and the symbol resembles an X. For example, the
endpoint of the top horizontal line on the right side of the profile is connected to
the vertical line, but not at an endpoint.

When drawing profiles, pay close attention to the relationship indicator symbols
that IntelliSketch displays, and try to draw the elements as accurately as possible.
Otherwise, you may accidentally apply a connect relationship in the wrong location,
which can result in an invalid profile. For example, for a base feature you may
accidentally create an open profile, rather than the required closed profile.

Tangent
The Tangent command maintains tangency between two elements or element groups.

When you apply a tangent relationship, you can use the Tangent command bar to
specify the type of tangent relationship you want:

• Tangent

• Tangent + Equal Curvature

• Parallel Tangent Vectors
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• Parallel Tangent Vectors + Equal Curvature

A simple tangent relationship is useful when you want a line and an arc, or two arcs
to remain tangent. The other options are useful in situations where a b-spline curve
must blend smoothly with other elements. The Tangent + Equal Curvature, Parallel
Tangent Vectors, and Parallel Tangent Vectors + Equal Curvature options require
that the first element you select is a b-spline curve.

Note

You can also apply a tangent or connect relationship to an end-point connected
series of elements to define a profile group. For more information on profile
groups, see the Working With Profile Groups topic.

Perpendicular

The Perpendicular command maintains a 90-degree angle between two elements.

Horizontal/Vertical

The Horizontal/Vertical command works in two modes. In one mode, you can fix the
orientation of a line as either horizontal or vertical by selecting any point on the line
that is not an endpoint or a midpoint.

In the second mode, you can apply vertical/horizontal relationships between graphic
elements by aligning their midpoints, center points, or endpoints so that their
positions remain aligned with respect to each other.
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Equal

The Equal command maintains size equality between similar elements. When this
relationship is applied between two lines, their lengths become equal. When applied
between two arcs, their radii become equal.

Parallel

The Parallel command makes two lines share the same angled orientation.

Concentric

The Concentric command maintains coincident centers for arcs and circles.

Symmetric

You can use the Symmetric command to make elements symmetric about a line or
reference plane. The Symmetric command captures both the location and size of
the elements.
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Rigid Set

You can use the Rigid Set command to add a rigid set relationship to a group of
2-D elements.

Drawing Tools

Solid Edge provides tools to help you draw quickly and precisely in a variety of
situations.

Grid
Grids help you draw with precision when the endpoints of elements you are
drawing fit within regular intervals.

IntelliSketch
IntelliSketch helps you create, and optionally maintain, geometric relationships
between elements. As you draw, IntelliSketch recognizes the opportunity to
relate new elements to existing elements and displays visual cues that help make
elements connected, tangent, collinear, perpendicular, parallel, and so forth.

Based on your preference, Solid Edge will either maintain the relationships
that IntelliSketch creates or only use IntelliSketch to create new elements with
precision, without maintaining relationships as you add and change geometry.

FreeSketch

The FreeSketch command initiates a freehand drawing tool that you can use
to sketch lines, arcs, circles and rectangles. As you press and hold the mouse
button and drag the cursor across the drawing sheet, a rough sketch of your
design appears. When you release the mouse button, the software recognizes the
shapes in your sketch and turns them into a precise drawing.

To learn how, see Draw with FreeSketch.
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Projection Lines
Projection lines help you maintain alignment of key points, for example between
related 2D Drawing Views of a model. Projection lines fulfill the function of the
squares, triangles, and parallel rules used in classical drafting.

Sketch Cleanup
Use the Clean Sketch command in the Draw group to remove redundant and
unwanted elements from a sketch.

Working with grids

The grid helps you draw and modify elements relative to known positions in the
working window. It displays a series of intersecting lines or points, and X and Y
coordinates, which enable you to draw 2D elements with precision. You can use the
grid with all sketching, dimensioning, and annotation functions. It also works with
IntelliSketch and the Select command.

For example, you can use the grid to:

• Draw elements at known locations, draw elements known distances apart, and
so forth. When the Show Grid option is set, the grid is displayed whenever you
create or modify 2D elements. For an example, see Help topic Draw a line
with a grid.

• Align dimensions and annotations by snapping them to grid points or lines. Only
bolt hole circles and center marks cannot be snapped to a grid. For an example,
see Help topic Place a dimension or annotation using a grid.

1-64 Solid Edge fundamentals mt01413-s-1050



Sketching

synchronous environment

ordered environment
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Grid display and setting options
You can use the Grid Options command to open the Grid Options dialog box, where
you can specify grid appearance and turn grid display options on and off. For easy
access, some of the options also are available as commands on the ribbon.

You can do this Using these options in
the dialog box

Or selecting this
command on the ribbon

Display the grid. Show Grid, plus one of the
following:

• As Lines

• As Points

Show Grid

Turn alignment lines on
and off.

Show Alignment Lines Not available

Turn snap-to-grid on and
off.

Show Grid, plus one of the
following:

• Using Lines

• Using Points

Snap to Grid

Turn coordinate display on
and off.

Show Readouts Not available

Change grid spacing. Angle

Major Line Spacing

Minor Spaces Per Major

Not available

Enter X and Y coordinates
for the next point.

Enable Key-ins (X,Y) XY Key-in

Display X and Y alignment
lines.

Show Alignment Lines Not available

Change grid line color. Major Line Color

Minor Line Color

Not available

Change grid origin line
colors

On the Colors tab in the
Solid Edge Options dialog
box, change the Select and
Highlight colors.

Not available

Grid shortcut keys
You can use the following shortcut keys while working with grids:

You can do this Using these shortcut keys
Reposition grid to current cursor position. F8
Turn snap-to-grid on and off. F9
Reset the grid origin point to zero. F12
Displays the X and Y coordinate input
boxes, with the cursor in the X box.

Alt+X

Displays the X and Y coordinate input
boxes, with the cursor in the Y box.

Alt+Y

How grids work in the ordered environment
The grid is displayed in Draft and in profile and sketch mode as you draw, dimension,
and annotate 2D elements. The X and Y coordinates it displays are relative to an
origin point (A), which you can position anywhere in the window. The origin point is
marked by the intersection of the X and Y origin lines.

As you move the cursor, the horizontal and vertical distance between the cursor
position and the origin point is dynamically displayed (B).

If the Snap To Grid option is on when you add dimensions and annotations, they will
snap to grid lines and points.
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How grids work in the synchronous environment
The grid is available for drawing and editing 2D elements, and for adding 2D
dimensions and annotations.

Grid visibility is somewhat different in Draft than in synchronous modeling
environments. In Draft, when the grid is turned on, it is always visible. In
synchronous modeling, the grid is visible only when a sketch plane is locked.

In 3D environments, the grid helps you draw horizontally and vertically with respect
to part edges and model faces by displaying a series of intersecting lines or points,
and by displaying alignment lines. The grid also helps you draw with precision by
displaying X and Y coordinates that are relative to an origin point (A), which you
can position anywhere in the window.

As you move the cursor, the horizontal and vertical distance (B) and orientation
between the cursor position and the origin point is displayed and updated.

If the Snap To Grid option is on when you add dimensions and annotations, they will
snap to grid lines and points.
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Recognizing the grid origin

The grid origin is marked by the intersection of the X and Y origin lines.

• In ordered profile and sketch, the default display mode is a red dashed line
for the X axis and a green dashed line for the Y axis. The user-defined grid
origin point is marked by a circle and dot. The default origin is at the center of
the profile or sketch reference plane.

• In Draft, the default display mode is a red dashed line for the X axis and a
magenta dashed line for the Y axis. The user-defined grid origin point is marked
by a concentric circle and dot. The default origin is the (0,0) location of the
drawing sheet.

• In the synchronous modeling environment, the default display color scheme
matches that of the user-defined origin triad in the center of the graphics
window. The X axis is a red line, and the Y axis is green. These lines are solid in
the positive direction and dashed in the negative direction. There is no marker
at the user-defined origin point. The default origin is the 0,0,0 center of the
currently locked sketch plane.
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Moving the grid origin

You can move the grid origin point using either of these commands:

• Use the Reposition Origin command to move the origin to a user-defined
location. This is helpful when you want to do any of the following:

o Add dimensions or constraints that are horizontal or vertical to a model edge.

o Draw lines and other elements at a precise distance from another element
at a known location.

o Offset a series of elements by the same distance from a known location.

• To automatically reset the origin point to match the origin of the drawing sheet

or working plane, use the Zero Origin command .

Note

The Reposition Origin and Zero Origin commands are available in synchronous
modeling environments only when a sketch plane is locked.

See the Help topic, Reposition the grid origin point.

Changing the grid orientation

In ordered profile and sketch, the default orientation for the x-axis of the grid is
horizontal to the profile or sketch reference plane. You can reorient the x-axis to any
angle using the Angle option on the Grid Options dialog box.

In the synchronous modeling environment, the orientation of the grid axes matches
the origin axes of the currently locked sketch plane. When you lock onto a different
sketch plane, the origin axes reorient to the new plane. You can use the Reposition
Origin command to do the following:

• Change the grid angle. See the Help topic, Reposition the sketch plane origin.

• Ensure that dimensions placed on coplanar geometry remain horizontal and
vertical. See the Help topic, Set sketch plane horizontal and vertical for
dimensioning.

In Draft, the default orientation for the X-axis of the grid is horizontal. You can
reorient the X-axis to any angle using the Angle option on the Grid Options dialog
box.

IntelliSketch

IntelliSketch is a dynamic drawing tool used for sketching and modifying elements.
IntelliSketch allows you to sketch with precision by specifying characteristics of
the design as you sketch.

For instance, IntelliSketch allows you to sketch a line that is horizontal or vertical,
or a line that is parallel or perpendicular to another line or tangent to a circle. You
can also draw an arc connected to the end point of an existing line, draw a circle
concentric with another circle, draw a line tangent to a circle—the possibilities
are too numerous to list.
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IntelliSketch places dimensions and geometric relationships on any new 2D elements
as you draw them. You can use another tool, the Relationship Assistant, to place
dimensions and relationships automatically on existing profile elements.

How IntelliSketch works

As you draw, IntelliSketch tracks the movement of the cursor and shows a temporary,
dynamic display of the element you are drawing. This temporary display shows what
the new element will look like if you click at the current position.

IntelliSketch gives you more information about the element you are drawing by
displaying relationships between the temporary, dynamic element and the following:

• Other elements in the drawing

• Horizontal and vertical orientations

• The origin of the element you are drawing

When IntelliSketch recognizes a relationship, it displays a relationship indicator
at the cursor. As you move the cursor, IntelliSketch updates the indicator to show
new relationships. If a relationship indicator is displayed at the cursor when you
click to draw the element, the software applies that relationship to the element. For
example, if the Horizontal relationship indicator appears when you click to place the
second end point of a line, then the line will be horizontal.

IntelliSketch relationships

You can set the types of relationships you want IntelliSketch to recognize on the
Relationships page on the IntelliSketch dialog box. IntelliSketch can recognize one
or two relationships at a time. When IntelliSketch recognizes two relationships, it
displays both relationship indicators at the cursor.
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IntelliSketch locate zone
You do not have to move the cursor to an exact position for IntelliSketch to recognize
a relationship. IntelliSketch recognizes relationships for any element within the
locate zone of the cursor. The circle around the cursor crosshair or at the end of the
cursor arrow indicates the locate zone. You can change the size of the locate zone
with the IntelliSketch command on the Tools menu.

Alignment indicators
IntelliSketch displays a temporary dashed line to indicate when the cursor position
is horizontally or vertically aligned with a key point on an element.

Infinite elements
IntelliSketch recognizes the Point On Element relationship for lines and arcs as if
these elements were infinite. In the following example, IntelliSketch recognizes
a Point On Element relationship when the cursor is positioned directly over an
element and also when the cursor is moved off the element.

Center points
IntelliSketch displays an indicator at the center point of an arc or circle to make this
keypoint easy to locate.

Snapping to points
When drawing and manipulating 2D elements, you can use shortcut keys with
QuickPick to snap to keypoints and intersection points. This also applies the point
coordinates as input to the command in progress.

Once you have highlighted the element you want to snap to with the cursor, you can
use these shortcut keys to snap to points:

• Midpoint - press M.

• Intersection point - press I.
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• Center point - press C.

• Endpoint - press E.

To learn more, see Selecting and snapping to points.

Sweep angle lock at quadrants
When you draw tangent or perpendicular arcs, the arc sweep angle locks at quadrant
points of 0, 90, 180, and 270 degrees. This allows you to draw common arcs without
typing the sweep value on the command bar.

A temporary dashed line appears from the arc endpoint to the centerline of the arc to
notify you that the arc is at a quadrant.

Automatic dimensioning
You can use options on the Auto-Dimension page in the IntelliSketch dialog box
to automatically create dimensions for new geometry. The page provides several
options to control when the dimensions are drawn as well as whether to use
dimension style mapping or not.

You can use the Auto-Dimension command as a quick way to turn automatic
dimensioning on and off.

Example: Draw a horizontal line

You can use IntelliSketch to draw a line that is exactly horizontal. You can apply a
horizontal relationship as you draw the line, or draw the line without a horizontal
relationship.

1. Choose the IntelliSketch command on the Home tab or the Sketching tab.

2. In the IntelliSketch dialog box, on the Relationships tab, set the Horizontal
Or Vertical option, and then click OK.

3. Choose the Line command.
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4. Click where you want to place the first end point of the line, anywhere in the
application window (A).

5. Move the cursor around in the window (B). Notice that the dynamic line display
always extends from the end point you just placed to the current cursor position.
You may also see IntelliSketch relationship indicators displayed at the cursor.

6. Move the cursor to make the dynamic line approximately horizontal.

7. When the IntelliSketch Horizontal relationship indicator is displayed at the
cursor (C), click to place the second end point.

IntelliSketch places a horizontal relationship handle on the new line (D).

Tip

Relationship handles can be displayed or hidden with the Relationship
Handles command.

Tip

To snap to an intersection point or a keypoint, locate the element(s) with the
cursor and then press one of these shortcut keys.

• Midpoint of a line or arc: press M.

• Intersection point of lines, circle, curves, and arcs: press I.

• Center point of a circle or arc: press C.

• Endpoint of a line, arc, or curve: press E.

For intersection points—If there are multiple eligible points located, then
QuickPick opens and lists them. In QuickPick, click to select the point you
want.

Example: Draw a line connected to another line

You can use IntelliSketch to connect an element you are drawing with an existing
element. You can apply a connect relationship as you draw the lines, or draw the line
without a connect relationship.

1. Choose the IntelliSketch command .

2. In the IntelliSketch dialog box, on the Relationships tab, set the End Point
option, and then click OK.

3. Choose the Line command.
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4. Move the cursor to the end of a line in the application window. As you move the
cursor over it, the line is highlighted and IntelliSketch displays the End Point
relationship indicator at the cursor.

5. While IntelliSketch displays the relationship indicator, click to place the first
end point of the new line (A). This end point is connected to the end point of
the previous line.

Tip

Rather than clicking, you can snap to the line end point nearest the cursor
by pressing the E key.

6. Click where you want to place the second end point of the new line.

7. The new line and the previous line have connected end points (B).

IntelliSketch places a connect relationship handle at the point where the two lines
connect (C).

Tip

Relationship handles can be displayed or hidden with the Relationship
Handles command.

Tip

Relationships are maintained only if the Maintain Relationships command
is set.

Tip

To snap to a keypoint or intersection point, locate the element(s) with the
cursor and then press one of these shortcut keys.

• Midpoint of a line or arc: press M.

• Intersection point of lines, circle, curves, and arcs: press I.

• Center point of a circle or arc: press C.

• Endpoint of a line, arc, or curve: press E.

For intersection points—If there are multiple eligible points located, then
QuickPick opens and lists them. In QuickPick, click to select the point you
want.

1-74 Solid Edge fundamentals mt01413-s-1050



Sketching

Projection lines

Projection lines are extensions of lines that assist in 2D drawing.

• You can use projection lines to help you create new geometry, and any constraints
you create with them remain active even after you turn projection lines off.
For example, in a drawing, you can use projection lines on an auxiliary view to
enable creation of additional views with proper alignment and size.

• You can create a line with the projection line option set, or you can edit an
existing line and set the projection line property later.

• You can place dimensions and annotations to projection lines. Dimensions and
annotations connect to the defining segment of the projection line (the original
2D line on which the projection line is based).

Projection lines are available as a line property on the Line command bar and on
the Format page of the Element Properties dialog box.

Distance and area measurement

You can measure distances or areas, even when you are in the middle of another
task. To set the units for measuring distances or areas, use the Properties command
on the Application menu.
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Measuring distances in 2D

In the Draft environment, you can measure distance using the Measure Distance
command. These commands measure linear distances or measure the cumulative
linear distance along a series of points. The first point you click establishes the origin
of the measurement (A). After that, you can select any keypoint to see the distance
between it and the origin, as well as the delta distance along each principal axis (B).

Clicking the keypoint adds it to a series of measurement points. Then you can select
another point to see the new linear distance and deltas (C), or click it to see the
distance between the last two points and the total cumulative distance from the
origin to the last point (D). Click the right button to reset the command.
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Measuring distances and angles in 3D

In the Part, Sheet Metal, and Assembly environments, the Measure Distance
command measures linear distances. The first point you click establishes the origin
of the measurement (A). After that, you can select any keypoint (B) to display the
Measure Distance dialog box which displays the keypoint select type, the true
distance, the apparent screen view distance, and the delta distance along each
principal axis.

In the Part, Sheet Metal, and Assembly environments, the Measure Angle command
measures angles. You can measure between any two faces or between any three
points.

Measuring minimum distances

In the Part, Sheet Metal, and Assembly environments, you can use the Measure
Minimum Distance command to measure the minimum distance between any two
elements or keypoints. You can use the Select Type option on the Minimum Distance
command bar to filter which type of elements you want to select. When working in
the context of an assembly, you can also use the Activate Part option to activate
the parts you want to measure.
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Measuring normal distances

In the Part, Sheet Metal, and Assembly environments, the Measure Normal
Distance command measures normal distances between a planar element or line and
a keypoint. You can use the Element Types option on the Measure Normal Distance
command bar to filter which type of elements you want to select. You can use the
Key Point option to specify the type of keypoint you want to identify when measuring
the distance. You can use the Coordinate System option to select a user-defined
coordinate system to define one of the points. If you use a coordinate system, the
returned values will be relative to the specified coordinate system. When working
in the context of an assembly, you can also use the Activate Part option to activate
the parts you want to measure.

Measuring areas

The Measure Area command, available only in the Draft environment and in 2D
profiles and sketches, measures the area inside a closed boundary (A). You can also
measure the cumulative area inside more than one closed boundary by holding the
Shift key as you click elements (B). Each time you click, the area of the last element
is displayed, along with the total area. Click another element without holding the
Shift key to reset the command.

Measuring lengths

The Measure Total Length command measures the cumulative length of a select
set of 2D geometry.

Measuring automatically

In addition to the individual distance, area, length, and angle commands, you
can use the Smart Measure command in 2D and 3D environments to measure
automatically based on what you select:

• Select a single 2D element or 3D object to measure its length or its angle or
radius.

• Select two or more 2D elements or 3D objects to measure the distance or angle
between them.

The Smart Measure command works like the Smart Dimension command, except
that it does not place a dimension as a result.
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Copying measurement values

You can copy the highlighted measurement value to the Clipboard by pressing
Ctrl+C. You can then use the copied value as input for another command. For
example, you can paste the copied value into the Line command bar to define the
length of a line. Use the Tab key if you want to highlight a different value.

Measuring drawing view geometry

When you measure model geometry within a drawing view, or when you measure
distances between model edges in two drawing views, you can select the Use
Drawing View Scale check box on the command bar to specify that the measured
value is displayed using the equivalent of the model distance.

Alternatively, you can apply a user-defined scale value by selecting it from the Scale
list on the command bar.

When measuring between drawing views, they must be views of the same model
and they must use the same view rotation and orientation. For example, you can
measure between an edge in a front view and an edge in a detail view with the same
front orientation, but not between a front view and a side view.

Note

• You can show the scale of a drawing view using the General page (Drawing
View Properties dialog box).

• User-defined scale values are defined in the Drawing View Scales section
of the Custom.xml file, in the Solid Edge Program folder. See the Help
topic, Add custom drawing view scales to Solid Edge.

Example: Measuring the length of a line

Even when you are in the middle of a task, you can measure distances with the
Measure Distance command. For example, consider the following workflow.

1. Use the Line command to draw a line (A).

2. On the Inspect tab, click the Measure Distance command and measure a
distance (B).

Note

You do not need to exit the Line command before measuring a distance.

3. To exit the Measure Distance command, right-click. The Line command is still
active-you can pick up where you left off.

4. Continue using the Line command (C).
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Dimensioning sketches

Dimensioning sketches

Dimensioning commands are located in three locations. They are located in the
Dimension group on the Home, Sketching, and PMI tabs.

Locked dimensions

Sketch dimensions are placed as driving. A driving dimension is colored red. A
driving dimension is also referred to as a locked dimension. A locked dimension
cannot change unless it is edited directly. As sketch geometry is modified, a locked
dimension does not change.

Change a dimension to driven (or unlocked) by selecting the dimension and then
clicking the lock on the Dimension Value Edit QuickBar. A driven dimension is
colored blue. A driven dimension value cannot be selected for editing. It must be
changed to a locked dimension to change its value directly.
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To change a dimension value of a locked dimension, click the dimension value and
enter a new value.

Dimension orientation

The orientation of a sketch dimension is controlled by the sketch plane origin. The
sketch plane origin defines the horizontal/vertical direction.
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The Sketch View command orients the view to where the dimension text
is horizontal.

Dimension style

Modify the dimension style settings in the Style dialog box. The Style command is
located on the View tab (1) in the Style group (2).

Sketches in PathFinder

Sketches in PathFinder

• In PathFinder, there are two sketch collectors (Sketches and Used Sketches).

• Sketches are stored in a Sketches collector until they are consumed by body
creation or deleted.
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• The pencil symbol in front of a sketch denotes that its sketch plane is locked.

• Unconsumed sketches can be displayed or hidden with a check mark. All
sketches or specific sketches can be hidden or shown.

• Sketch elements used to create a feature are removed from the Sketches collector
and placed in the Used Sketches collector.

• Used sketches can be highlighted, deleted, renamed or restored.

Sketches context menu in PathFinder

The sketches context menu includes options on how a sketch responds to creation of
regions and feature creation. These options are on a per sketch basis.

Merge with Coplanar Sketches

• If a sketch exists on the locked sketch plane, then any new sketch geometry
merges with the existing sketch.

Enable Regions

• Locate regions as sketch geometry forms closed area(s).

Migrate Geometry and Dimensions

• Consume the sketch geometry used to create features and move into the
geometry into the Used Sketches collector.

• Create the PMI dimensions on the body as the sketch geometry is used to create
features.

Used Sketches context menu in PathFinder

Right-click on a used sketch to bring up the context menu. The Restore command
restores a consumed sketch to the Sketches collector. If a sketch plane exists that is
the same as the used sketch plane, the restored sketch will merge with the existing
sketch.
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Sketch plane origin

Sketch plane origin

reference planes

The origin of a reference plane is system defined. The horizontal direction and the
origin are positioned at the center of the reference plane. To change the reference
origin, use the Reposition Origin command to define the new origin and horizontal
direction.

planar faces

The origin of a sketch on a planar face can be defined before locking the plane. The
system determines a horizontal direction and origin. To change the system defined
origin, cycle through the linear edges on the planar face. The edge displays green.
Press (N) for next edge, (B) to go back to previous edge, (F) to flip the Y direction
and (T) to toggle which end of the edge is used. Once the desired origin is displayed,
click the lock to lock the sketch plane.
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Reposition origin command

A sketch plane can only contain a single collection of sketch elements. However,
there can be more than one sketch area per sketch plane. In the example, there are
two sketch areas (1 and 2). Sketch area (1) orizontal/vertical directions are not the
same as sketch area (2). The sketch plane origin can be repositioned to redefine the
horizontal/vertical directions for a particular sketch area.

Zero Origin command

The Zero Origin command automatically resets the origin as follows:

• In Draft, the drawing grid origin is reset to the drawing sheet (0,0) coordinate.

• In the synchronous environment, both the drawing grid and the sketch plane
origin are reset to the (0,0,0) coordinate and orientation at the center of the
currently locked sketch plane.
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Note

This command is available only when you have locked a sketch plane.

Reposition origin workflow

Workflow based on using a planar face for a sketch plane.

1. Lock the sketch plane.

2. In the Draw group, choose the Reposition Origin command.

The reposition origin handle displays at the sketch plane origin on the locked
plane (1).

3. Click and drag the handle origin to a new vertex or edge.

This defines the new origin.

4. Click and drag the torus to position the horizontal direction. Select a keypoint
or type in angle to lock the direction.
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Sketch view

On the View tab®Views group, the Sketch View command orients the active
view normal to the horizontal/vertical direction of the locked sketch plane.

Sketch consumption and dimension migration

Sketch consumption and dimension migration

In synchronous part and sheet metal environments, you typically draw 2D sketch
geometry for the purpose of constructing features on a solid model. In the
synchronous environment, when you use sketch elements to construct a feature, the
sketch elements are consumed and the 2D dimensions you placed on the sketch
migrate to the appropriate edges on the solid body, whenever possible.

You can use the Migrate Geometry and Dimensions command command on the
shortcut menu when a sketch is selected in PathFinder to control whether sketch
elements are consumed and dimensions are migrated.

Automatic sketch consumption and dimension migration

By default, the Migrate Geometry and Dimensions command is set for a new
document. The sketch elements are automatically consumed and 2D dimensions
are automatically migrated when you use them to construct features. After you
construct a feature, the 2D sketch geometry is moved to the Used Sketches collector
in PathFinder, and the 2D dimensions are migrated as 3D PMI model dimensions.

You can disable the automatic consumption of sketch elements and migration of
2D dimensions on a sketch-by-sketch basis by clearing the Migrate Geometry and
Dimensions command on the shortcut menu when a sketch is selected in PathFinder.

All model dimensions, whether migrated from sketches or added to edges on the 3D
model directly, are PMI dimensions. PMI dimensions are displayed on PathFinder in
the PMI collection, Dimensions sub-collection.
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To learn more about creating and using PMI, see the Help topic, PMI dimensions
and annotations.

Partially migrated sketches and dimensions

In many cases, only some of the sketch elements on a single sketch are used to
construct a feature. If this is the case, only the selected sketch elements and the
associated 2D dimensions are consumed and migrated.

During this process, dimensions and constraints may be connected to both body
edges and to remaining sketch geometry. If the sketch contains stacked dimensions,
then some dimensions in the stack may migrate individually. Other dimensions,
such as coordinate dimensions, do not migrate until all of the 2D geometry they are
attached to has been used to construct a feature.

As you continue to construct features using the remaining sketch elements, sketch
elements are consumed and dimensions are migrated.

Dimension locking status after migration

2D dimensions are locked by default. When they migrate to the 3D model, they
remain locked.
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Note

Dimension colors are determined by settings on the Colors page of the Options
dialog box.

Dimension variable and formula migration

Sketch dimensions that use variables retain the variables after migration to PMI
dimensions. If a sketch dimension is driven by a formula, the formula is maintained
when the dimension is migrated to a PMI dimension. The PMI dimension is still
driven by the formula, but must be driving for the formula to solve properly.

Working with combinable sketches

You can use the Merge Coplanar Sketches command on the shortcut menu to control
whether a sketch is combined with another coplanar sketch in a synchronous part
or assembly.

Although this command is available in synchronous part, sheet metal, and assembly
documents, the merge property is most useful when working with assembly sketches,
and it also plays a role when converting traditional parts and assemblies into
synchronous documents.

When you set the Merge Coplanar Sketches option for a sketch, the following rules
and conditions apply:

• New sketch elements that are drawn coplanar to the sketch in free space are
added to the existing sketch. To create the new coplanar sketch elements as a
separate sketch, you can select the existing sketch and clear the Merge with
Coplanar Sketches command before you draw the new, coplanar sketch elements.

• The sketch will combine with another sketch if the two sketches become coplanar
during a move operation.

• In part and sheet metal documents, sketch regions are automatically enabled for
a combinable sketch. When sketch regions are enabled, you can use the Select
tool to construct features using the sketch. You can clear the Enable Sketch
Regions command on the shortcut menu to disable sketch regions.

• In part and sheet metal documents, sketch consumption is automatically
enabled for the combinable sketch. When sketch consumption is enabled, sketch
elements are consumed when you construct features from the sketch. You can
clear the Migrate Geometry and Dimensions command on the shortcut menu to
disable sketch consumption.

Unique symbols are used in PathFinder to indicate whether a sketch is a combinable
sketch, noncombinable sketch, or the active sketch.

Legend

Noncombinable sketch

Combinable sketch
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Active sketch (combinable active sketch shown)

Assembly sketches
A noncombinable sketch is most useful when creating layout sketches in an
assembly. Noncombinable sketches make it possible to draw multiple sketches which
are coplanar. This can be useful if you want to create separate, coplanar sketches
that represent individual parts or subassemblies for a new assembly. Noncombinable
sketches makes it possible to show, hide, or move a set of sketch elements easily.

For more information, see HELP topic Drawing sketches in assemblies.

Moving sketches

Moving sketches

Sketches can be moved/copied in 2D or 3D. Sketches can be deleted or cut for pasting
in 2D or 3D. This section covers three methods available for manipulating sketch
geometry.

• Manipulating sketch elements in 2D

• Moving and copying sketch elements in 3D
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• Copy, cut and paste sketch elements

Manipulating sketch elements in 2D

Planar sketch elements can be moved or copied with the 2D move command
found on the Sketching tab, in the Draw group.

2D sketch element manipulation is confined to the selected sketch element’s plane. If
sketch elements in the select set are on different sketch planes, an error box appears
when choosing any sketch manipulation command.

Error message: Selected sketch geometry must lie in the same plane.

Workflow for moving or copying a sketch

1. Select sketch elements to copy or move in the part window individually or with a
select box. If the sketch elements form a region, disable regions for the sketch
before using the select box.

2. Choose the Move command .

3. Select point (on any of the selected sketch elements) to move or copy from. You
can use keypoints to define the move or copy from point.

4. Notice that there are options available in the Move (1) command bar.

If you want to move a copy, select the Copy option (2) . You can also enter
the X (4), Y (5) distances to move or copy to. You can also enter a step distance
Step field (3).

5. Click a ’to’ point to move or copy to. If you are moving, then the command ends
once a to point is clicked. The select set is still active. If you are copying, each
click places a copy. A right-click during a copy will end the command with the
select set still active.

6. Press Esc to clear select set.
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2D sketch manipulation commands

Two lists are available that contain 2D commands for manipulating sketch geometry.

Manipulation commands are move, rotate, mirror, scale and stretch.

These commands each have a set of options in command bar. Each command also
can manipulate a copy of the selected sketch elements.

Moving and copying sketch elements in 3D

Sketch elements can be moved/copied in 3D. The select set of sketch elements are not
required to lie all on the same plane. The 3D move requires the use of the graphic
handle. See the Graphic handle section in the “Moving and rotating faces” course
to learn how to use the graphic handle.

The selected sketch elements can be:

• Moved or copied in the sketch plane

• Moved or copied to a parallel plane

• Rotated or copy rotated to another plane

Workflow for a synchronous 3D move or rotate of sketch elements

1. Select sketch geometry.

Selection methods

• Select entire sketch(s) in PathFinder

• Select sketch elements individually in the part window.

• Select sketch elements in the part window with a select box

Note

If the sketch elements form a region, disable regions before using the
select box.

Note

Select set can contain sketch elements on different planes.

2. If entire synchronous sketches are selected in PathFinder, the Move command
starts.
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Use the secondary axis or handle plane to move sketch elements in a plane.

To rotate, drag the handle origin to an edge that will be the axis of rotation.
Then click the torus to define the angle of rotation.

Click the Copy option on the command bar to move a copy of the selected
sketch elements.

3. If sketch elements are selected in the part window, on the Modify command bar,
choose the Move command from the drop list.

Use the graphic handle as described in the previous step to move or rotate the
selected sketch elements.

4. After sketches are manipulated and regions were disabled, you will need to
remember to enable regions in order to create features from the sketches.

Copy, cut, and paste sketch elements

Sketch elements can be manipulated using the Microsoft clipboard behavior.

• Ctrl+C copies the selected sketch elements to the clipboard.

• Ctrl+X deletes the selected sketch elements from the model and adds them to
the clipboard.

• Ctrl+V pastes the selected sketch elements in the model.

Paste behavior

A paste operation places the sketch elements (clipboard) onto the locked sketch plane
at the location clicked. At this point, the paste elements are attached to the cursor
and each click places another copy paste elements on the locked plane.

If there is no locked sketch plane, the sketch elements are placed onto the plane
highlighted under the cursor at the location clicked. At this point, the paste elements

mt01413-s-1050 Solid Edge fundamentals 1-93



Lesson 1 Sketching

are attached to the cursor and each click places another copy of the paste elements
on the locked plane.

To select another plane to paste to, end the paste operation with the Esc key. Ctrl+V
starts the paste operation again and then select the new plane.

Projecting elements onto a sketch plane

Projecting elements onto a sketch plane

Face edges, sketch elements and base reference plane edges can be projected onto
a locked sketch plane.

• The Project to Sketch command is located on the Sketching tab® Draw
group.

• The Project to Sketch command requires a locked sketch plane.

• Use the Project to Sketch command bar to refine the selection of elements to
project and to set the project options.

Project to sketch command

Copies part edges or sketch elements onto the current sketch plane. For example,
you can select a part edge (A) to project onto the current sketch plane (B). The
projected edge (C) can then be used in the current sketch.

A relationship symbol indicates that an element is associatively linked to the
parent element. You can break the associative link on projected elements by deleting
the link relationship symbols. You can trim and modify projected elements, and
incorporate associatively projected elements into a sketch that contains newly
created non-associative elements.

You can also add relationships or dimensions to associatively projected elements,
but if the relationship or dimension conflicts with the associative relationship to the
parent element, a warning message is displayed.

Note

When you use sketch elements to construct a feature in a part document, the
sketch elements are transferred to the Used Sketches collection in PathFinder.
For projected elements, the associative link between the parent element and
the projected element is discarded.
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Sketching instructional activities

Activity: Sketching (Part 1)

Sketching (Part 1)

Activity covers plane locking, drawing sketch elements, placing dimensions, applying
geometric relationships, showing relationship handles, reposition sketch plane origin
and controlling sketch display.

Open a part file

▸ Start Solid Edge.

▸ Click the Application button®Open.

▸ In the Open File dialog box, set the Look in: field to the folder where the training
files reside.

▸ Click sketch_A and then click Open.

Start the sketching process

▸ Choose the Line command.
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▸ Define the sketch plane. Pause the cursor over the angled sketch plane. Press
the N key until the green edge highlights as shown. This defines the horizontal
direction for the sketch plane.

Note

While the plane highlights, you can begin sketching and you lock to the plane.
If you move the cursor away from the plane before placing any geometry,
you have to highlight the plane again. You could also click the lock on the
highlighted plane to lock the plane. If you manually lock the plane, it remains
locked until you unlock it.

Draw sketch geometry

▸ Draw a slot shaped sketch consisting of two lines and two arcs. While the angled
plane highlights, click to place the first point of the line.

▸ For the second point of the line, make sure the horizontal indicator displays
and then click.

1-96 Solid Edge fundamentals mt01413-s-1050



Sketching

▸ Place a tangent arc. Press the A key to enter the place arc command.

Position the intent zone as shown.

Place the arc end point vertical from arc start point.

▸ Place the second line as shown. Make sure you get the tangent alignment symbol
and the vertical alignment from the first point of the start line.

▸ Place the second tangent arc. Press A and then end the arc at the endpoint of
the first line.
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Regions formed

Notice the face changes to a blue color. This denotes the presence of regions. The
sketch drawn on the face creates two regions.

Place geometric relationships

Center the slot sketch on the face using geometric relationships.
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▸ Turn on the display of relationship handles. On the Sketching tab®Relate
group, choose the Relationship Handles command.

The handles show that the lines are horizontal and the arcs are tangent
connected to the endpoints of the lines.

▸ Align the midpoint of one line to the midpoint of a face edge. In the Relate group,
choose the Horizontal/Vertical command. Click the midpoint of the line and
then click the midpoint of the face edge.

▸ Align the center of the arc to the midpoint of a face edge. Using the
horizontal/vertical command, click the arc center and then the midpoint of the
face edge. The slot is centered on the face.
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Add dimensions

Dimension the slot radius and distance between centers.

▸ On the Sketching tab®Dimension group, choose the Smart Dimension command.
Click on one of the arcs and type 5 in the Dimension Value Edit dialog box.

▸ On the Sketching tab®Dimension group, choose the Distance Between
command. Select the center of each arc and type 30 in the edit box.

Turn off sketch

▸ If the sketch plane was manually locked, in PathFinder, right-click the on the
sketch. On the short-cut menu, choose Lock Sketch Plane.

▸ Click the check box to turn off the sketch display.

▸ Activity is complete. Exit the file and do not save.
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Summary

In this activity you learned how to create a sketch on a part face. You learned how to
apply relationships and dimensions to a sketch.

Activity: Sketching (Part 2)

Sketching (Part 2)

Activity covers drawing a sketch on a reference plane, including edges from part
faces, sketch associativity to part model edges and the sketch view command.

Open a part file

▸ Start Solid Edge.

▸ Click the Application button®Open.

▸ In the Open File dialog box, set the Look in: field to the folder where the training
files reside.

▸ Click sketch_B and then click Open.

Create a sketch plane

▸ On the Home tab®Planes group, choose the Coincident Plane command.
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▸ Select the part face shown.

▸ Click the primary axis on the graphic move handle.

▸ In the distance edit box, type 20.
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Start the sketching process

▸ You will use edges of the part in the sketch. On the Sketching tab®Draw group,
choose the Project to Sketch command. The command requires a locked plane.

▸ Lock the sketch plane. Pause over the sketch plane created earlier and then
click the lock.

▸ Select the edges shown.
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▸ Notice how these edges project to the locked sketch plane.

Observe sketch associativity

▸ Display PMI dimensions. In PathFinder, click the Dimensions check box.

▸ Click the 60° value on the dimension.
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▸ Change the dimension (any value between 45° and 75°) and notice how the edge
that was projected to the sketch plane follows the angle of the face. Make sure
the direction arrow on the dimension matches the illustration. You can change
the direction by clicking the arrow buttons in the dynamic edit box.

▸ Set dimension to 60° and turn off the PMI dimension display.

Draw sketch geometry

Add and modify sketch geometry.

▸ Orient the sketch plane normal to the view. On the View tab®Views group,
choose the Sketch View command.

mt01413-s-1050 Solid Edge fundamentals 1-105



Lesson 1 Sketching

▸ Draw the sketch geometry as shown. Segment lengths and location are not
important.

▸ Trim line segments. On the Sketching tab®Draw group, choose the Trim

command .

▸ Click and drag the cursor over the line segments shown.
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▸ Click and drag the cursor over the three line segments shown.

Edit display

▸ Turn off the Relationship Handles display.

▸ Switch to an isometric view. Type Ctrl+I.

▸ Close the file and do not save.

Summary

In this activity you learned how to draw a sketch on a reference plane and how
to include edges from part faces. You observed sketch associativity to part model
edges and used the Sketch View command.
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Activity: Sketching (Part 3)

Sketching (Part 3)

Activity covers drawing a sketch on a face, copying the sketch to another face,
rotating and moving the copied sketch.

Open a part file

▸ Start Solid Edge.

▸ Click the Application button®Open.

▸ In the Open File dialog box, set the Look in: field to the folder where the training
files reside.

▸ Click sketch_C and then click Open.
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Draw a sketch on a face

▸ Lock to the face shown.

▸ Draw the following sketch.

▸ Delete the sketch dimensions. The dimensions were placed to only define the size.

▸ Change the view to an isometric view. Press Ctrl+I.

Copy the sketch

▸ Unlock the sketch plane.
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▸ Select the sketch in PathFinder.

▸ Press Ctrl+C to copy the selected sketch. The sketch is added to the clipboard.

Paste the sketch

▸ Press Ctrl+V. The copied sketch attaches to the cursor. Pause the cursor over
the face and then click to place the sketch as shown. You will position the
sketch next.

Note

You can press the N or B keys to control the copied sketch orientation.
However, in this activity, use the rotate command to position the sketch.
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▸ Press the Esc key to end the paste operation.

Rotate the copied sketch

▸ In PathFinder, right-click the copied sketch and choose Lock Sketch Plane.

▸ Choose the Sketch View command.

▸ On the Move command drop list, choose the Rotate command.

▸ On command bar, make sure the copy option is not on.

▸ While holding down the Ctrl key, click the two lines and two arcs. The elements
turn green as they are selected.
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▸ Select the arc center as center of rotation.

▸ Select the other arc center as the start point for rotation.
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▸ Click when the horizontal indicator appears. This rotates the sketch 90°.

Move the copied sketch

▸ Select the four elements again.

▸ Choose the Move command.

▸ For the move from point, select the center of an arc.
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▸ For the to point, move the cursor over the midpoint of the top edge. The sketch
will be centered to this point. Do not click.
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▸ While maintaining midpoint alignment display, move the cursor down to the
location shown and click.

▸ Press Ctrl+I.
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▸ Activity complete. Close the file and do not save.

Summary

In this activity you drew a sketch on face and learned how to copy the sketch to
another face. You also learned how to rotate and move a sketch.
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Sketch projects

mt01413-s-1050 Solid Edge fundamentals 1-117



Lesson 1 Sketching

Drawing A
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Drawing B
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Drawing C
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Drawing D
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Drawing E
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Course review
Answer the following questions:

1. What is the first step in creating a sketch?

Choose a command from the Draw group.

Select a sketch plane.

Switch to a sketch view.

Select the base coordinate system.

2. How do you lock a sketch plane?

Move cursor over a planar face or reference plane and select the lock icon.

Move cursor over a planar face or reference plane and press the F3 key.

Right-click on an existing sketch in PathFinder and choose Lock Sketch
Plane.

None of the above.

All of the above.

3. How do you unlock a sketch plane?

Click the Lock icon in upper right corner of screen.

Press the F3 key.

Right-click on a locked sketch in PathFinder and choose Lock Sketch Plane.

None of the above.

All of the above.

4. What controls the horizontal/vertical direction of a sketch plane?

5. How do you know what sketch relationships exist?

6. How do you use the maintain relationships command?

7. What is a region?

8. Can an open sketch create a region?

9. What is the Used Sketches collector used for?

10. How do you reposition the sketch plane origin?

11. Explain what the Enable Regions command is used for.

12. Explain what the Merge with Coplanar Sketches command is used for.
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Course summary
• Sketches that form closed areas are called regions.

• Use regions to define the cross section of a synchronous feature.

• Sketches do not drive the feature.

• Sketches move to the Used Sketch collector when used to create a feature.

• Lock to a sketch plane to create a sketch.

• Sketches relationships do not migrate to the feature. However Live Rules can
detect if feature faces are coplanar. parallel, perpendicular, etc.
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2 Constructing base features
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What is a base feature?
Note

This course presents the method for creating synchronous base features.
To learn about the method for creating ordered base features, refer to the
self-paced course spse01536: Modeling synchronous and ordered features.

When constructing a 3D model in Solid Edge, it is helpful to evaluate the basic shape
of the part, and develop a plan as to how you want to construct the model. The part’s
overall shape can be captured in the very first feature, called the base feature.

How to define the shape of the base feature

1. Create a region (a series of sketch elements that create a closed area).

2. Select the region to construct the base feature using either the Extrusion or
Revolved Extrusion command.

Once the base feature is created, material can be added or removed by the definition
of other features.

2-2 Solid Edge fundamentals mt01413-s-1050



Constructing base features

Part modeling: Tips for getting started
When constructing a 3D model in Solid Edge, it is helpful to evaluate the basic shape
of the part, and develop a plan as to how you want to construct the model.

You should consider the following questions when starting a new model:

• What is the best sketch for the first feature on the part?

• Which reference plane should it be drawn on?

• Are there symmetric features on the part?

Constructing the base feature

The first feature you create for a part or sheet metal model is called the base feature.
Several commands are available for creating base features, but one thing they have
in common is that they are sketch-based features.

You construct a sketch-based feature by drawing a closed sketch region (1) on a
reference plane (2).
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Reference planes
A reference plane is a flat surface that is typically used for drawing 2D sketches
in 3D space. Although the size of a reference plane is theoretically infinite, it is
displayed at a fixed size to make it easier to select and visualize.

Three default, or base reference planes, are available in Solid Edge part and sheet
metal documents for defining the base feature.

Choosing the best sketch for the base feature
When evaluating the part you want to construct, the sketch for the base feature
should generate as much of the basic shape of the part as possible. Most models
present several choices for constructing the sketch for the base feature, but often one
alternative is better than others.

As you gain experience, it becomes easier to see the best choice. In the example
model, you could construct the base feature using each of the three sketches shown.
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Sketch 1

The L-shaped sketch of the model is a good choice, but would require extra
features to finish defining the tapered end of the model. In many cases this could
be the best choice, especially when working with standard shapes and extrusions.

Sketch 2

The rectangular sketch would require many extra features to remove the
material around the stiffening rib and tapered end of the model. This would be
a poor choice for this model.

Sketch 3

For this model, this would be the best choice. It defines the basic length and
width of the model and includes the tapered end. Two additional protrusion
features complete the basic shape of the part. A hole feature, a cutout feature,
and a round feature complete the part.
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Choosing the best reference plane

After you decide on the best sketch to use for the base feature, you should decide
which reference plane you want to draw the profile on.

As discussed earlier, there are three base reference planes you can use for the first
feature. These planes are oriented to the top, front, and right views. The three base
reference planes intersect at the exact center, or global origin, of the model space.

When choosing the reference plane, you can consider how the finished part will
be displayed in the graphic window, or how it will be arranged in the assembly or
the drawing.

The default view orientation in the graphic window is the dimetric view, so orienting
the sketch for the base feature such that the finished part is easy to visualize in
the dimetric view is a good approach.

The following examples illustrate the results of using the Top (1), Front (2), and
Right (3) reference planes to draw the first sketch. For this part, using the Top
reference plane (1) results in a part that is easiest to visualize in the dimetric view.

As your modeling skills increase, and when modeling parts in the context of the
assembly, choosing the best reference plane becomes less of a concern. You can use
the Rotate command to rotate the graphic window to an easy to visualize orientation.
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Taking advantage of part symmetry

Because the three base reference planes are fixed (they can not move), when
modeling symmetric parts, you should also use the base reference planes to take
advantage of symmetric features on the part. For example, when drawing the sketch
for the base feature, you can use dimensions and relationships to symmetrically
orient the sketch about the Front (1) and Right (2) reference planes.

Orienting the sketch for the base feature symmetrically with respect to the base
reference planes makes it easier to construct the rest of the model because you can
also use the base reference planes to symmetrically orient the subsequent features.

Creating base features

Creating base features

Intuitive commands based on context

Depending on the design context you are working in, you can add material to or
subtract material from a base feature without choosing a command. Use the same
workflow to create extrusions and cutouts, and the result of a particular operation is
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dependent on the defined extent direction. For a base feature, the result will be an
extrusion, because there is no existing body (or material) to subtract from.

For features on an existing body, the extent direction defined by cursor position
with respect to the sketch’s planar surface or plane determines whether you create
an extrusion or cutout.

• If the sketch extends away from the model volume, this creates an extrusion.

• If the sketch extends toward the volume of the model body, this creates a cutout.

Two methods for constructing a base feature

Once a region exists, two workflows are available for creating a base feature.

• Selection workflow

Select a region. Click the extrude handle to create a solid from the sketch region.
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• Creation workflow

On the Home tab®Solids group, choose the Extrude command. Select the sketch
region to define the feature. Right-click or press Enter to accept.

Note

You may find that the first method minimizes interaction with the command
bar and lets you work faster. The creation workflow has other advantages
that you learn about in a later section.

General workflow for constructing a base feature

Whether you use the selection workflow or the creation workflow, the basic steps for
constructing a base feature are the same.

This topic shows the extrude and revolve workflows.

Extrude a region

Using the Select tool

1. Use the Select command to select a region.

2. (Optional) Set the Symmetric extent option to extrude the feature symmetrically
on both sides of the region.
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3. Click the extrude handle, move the cursor to define the extent, and click to
create the solid,

or you can type an extent in the dynamic input box and press the Tab key. Then
move the cursor to define the extent side.

Using the Extrude command

1. Choose the Extrude command.

2. (Optional) Set the Symmetric extent option to extrude the feature symmetrically
on both sides of the region.
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3. Select the region to extrude.

4. Right-click or press Enter to accept the region.

5. Move the cursor to define the extent, and click to create the solid,

or you can type an extent in the dynamic input box and press the Tab key. Then
move the cursor to define the extent side.
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Revolve a region

Using the Select tool

1. Use the Select command to select a region.

2. Drag the extrude handle origin (1) to the edge (2) to define the axis of revolution.

3. (Optional) Set the Symmetric option to revolve the feature symmetrically on
both sides of the region.

4. On the revolve handle, click the torus to begin the revolve extent step.
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5. Move the cursor to define the extent and then click to create the solid,

or type an extent in the dynamic input box and press the Tab key. Then click to
one side or the other of the region to define the direction and create the solid,
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or select the 360° option on the Extent type list.

Note

Turn off the Create Live Section option (1).

Using the Revolve command

1. Choose the Revolve command.

2. Select the region to revolve.

3. Right-click or press Enter to accept.

4. Select an edge for the axis of revolution.

5. (Optional) Set the Symmetric option to revolve the feature symmetrically on
both sides of the region.
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6. Move the cursor to define the revolve extent.

or type an extent in the dynamic input box and press the Tab key. Then click to
one side or the other of the region to define the direction and create the solid,
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or select the 360° option on the Extent type list.

Note

Turn off the Create Live Section option (1).

Constructing synchronous extruded features using the Select tool

In the synchronous environment, you can use the Select tool to construct extruded
features. When you select a valid sketch element, such as a sketch region, both the
Extrude command bar (A) and the extrude handle (B) appear.

The command bar contains the options required to construct a wide variety of
extruded features. To start the feature construction process, you position the cursor
over the arrow on the extrude handle and click (A).

The cursor shape changes to a cross hair, and a dynamic representation of the
feature is displayed, along with a dynamic input box, which allows you to type a
precision value for the feature (B).
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To finish defining the feature (C), you can click the mouse, or type a value and press
the Enter key.

Note

The sketch elements used to define the feature are moved to the Used
Sketches list in PathFinder and hidden. The sketch dimensions are migrated
to the appropriate model edges.

Extent Options

Extents

Defines the depth of the feature or the distance to extrude the sketch to construct
the feature. You can specify that the feature extends in one direction only or two
directions symmetrically. The extent options are: Finite, Through All, Through
Next, and From/To Extent.

Finite

Sets the feature extent so that the sketch is extruded a finite distance to
either side of the sketch plane, or symmetrically to both sides of the sketch
plane. You can type the distance into the dynamic input box or click to
define the extent.

Through All

Sets the feature extent so that the sketch is extruded through all faces of the
part, starting at the sketch plane. You can extrude the sketch to either side
of the profile plane, or to both sides.

Through Next

Sets the feature extent so that the sketch is extruded through only the next
closed intersection with the part on the selected side. You can extrude the
sketch to either side of the sketch plane, or to both sides.

From/To Extent

Sets the feature extent so that the sketch is extruded from a specified face
or reference plane to another specified face or reference plane. You can
use the sketch plane as one of the extents, select the sketch plane handle,
or right-click.
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Note

If the region is selected first, the From extent surface can be redefined
be dragging the extrude handle origin to another surface or plane.
Click the extrude handle. Select the To surface or plane. Right-click
extrudes to the profile plane. A PMI dimension is automatically added
for the extent length.

Symmetric Extent

Specifies that the feature extent is to be applied symmetrically about the sketch
plane. To ensure the appropriate operation is performed in each direction (for
example: whether material is added or removed) make sure you select Add
or Cut on the command bar:

Keypoints

Sets the type of keypoint you can select to define the feature extent. You can
define the feature extent using a keypoint on other existing geometry. The
available keypoint options are specific to the command and workflow you use.

all keypoints

end point

midpoint

center point (arc or circle)

tangency point (select a tangent point on an analytic curved face such as
a cylinder, sphere, torus, or cone)
silhouette point

edit point on a curve

no keypoint
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In the following case, a vertex was chosen.

Open/Closed Sketch

Specifies whether adjacent model edges are considered part of the sketch region
when an open sketch is attached to one or more model edges. This allows you to
control how adjacent faces are trimmed in certain situations.

Open

Ignores adjacent model edges. When this option is set, additional faces may
be modified, such as illustrated in the cutout example below.

Closed

Includes adjacent model edges. When this option is set, fewer faces may be
modified, such as illustrated in the cutout example below.
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Automatic

Specifies that whether model edges are included or ignored is determined
automatically. This option is the preferred option in most cases.

To Extent Selector

Select the “To” surface when the From/To Extent option is set. The From
surface is automatically set to the sketch plane when using the command bar to
construct the feature. If you want to specify a different face as the From surface,
use the command bar options to specify the From surface.

Note

If the region is selected first, the From extent surface can be redefined be
dragging the extrude handle origin to another surface or plane. Click
the extrude handle. Select the To surface or plane. Right-click extrudes
to the profile plane. A PMI dimension is automatically added for the
extent length

Treatment Request

Define draft or crowning for the feature.

• Prompted to define treatment parameters after the extent for the feature is
defined.

• When this option is cleared, not prompt is given to define treatment
parameters after the extent for the feature is defined.

2-20 Solid Edge fundamentals mt01413-s-1050



Constructing base features

Activity: Create a base extruded synchronous feature

Create a base extruded synchronous feature

Overview

This activity demonstrates the process of creating a base feature, the initial solid in
a model.

Objectives

Create a vise base to become familiar with techniques used in the construction
of a base feature.

In this activity you will:

• Create regions consisting of sketch elements.

• Use the Select tool to define an initial solid shape.

Create a new ISO Part file

Note

You must be in the Synchronous environment to complete this activity.

The white Solid Edge background used in these instructions may differ from
your display.

▸ Start Solid Edge.

▸ Click the Application button®New®ISO Part.

Draw the initial cross-sectional shape

▸ On the Home tab®Draw group®Rectangle by Center list, choose the Rectangle
by 2 Points command.
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▸ Hover over the XZ plane and then click the lock.

▸ Draw the sketch and place the dimensions shown.

▸ Place a fillet on corner (1). On the Home tab®Draw group, choose the Fillet
command.

▸ Pause the cursor over corner (1) and click when both lines highlight.
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▸ On the Fillet command bar, type 40 in the Radius field (2).
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Create the base feature

▸ Select the region contained within the fillet and four lines.

▸ Select the extrude handle.
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▸ Define the extrusion extent by typing 70 mm into the dynamic edit box and press
the Tab key. Position the cursor to extend to the side as shown.

Note

Notice that the sketch dimensions migrate to the base feature.

▸ Save this file. You will continue to work in it as you progress through this course.

Summary

In this activity you learned how to create a base feature. A sketch was created
and dimensioned. A region was extruded and the sketch dimensions migrated to
the base feature. The base feature is ready for material to be added or removed to
create the desired part.

Constructing revolved features using the Select tool

In the synchronous environment, use the Select tool to construct revolved features.
When you select a valid sketch element, such as a sketch region, the Extrude
command bar and the extrude handle display by default.

You can click the extrude handle origin and drag it to a linear sketch element that
defines the axis of revolution. The extrude handle changes to a revolve handle.
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You can also construct a synchronous revolved feature by selecting the Revolve
command on the command bar.

The command bar updates to display the options for constructing revolved features
(A), and the revolve handle appears (B).

To construct a revolved feature, you move the revolve handle to a linear sketch
element, model edge, or to the center of a cylindrical face that defines the axis about
which you want to revolve the sketch. In the following example, the axis element is
separate from the sketch region that defines the cross section of the revolved feature.

You can move the revolve handle by clicking the handle origin (A), which attaches it
to the cursor. You can then position the handle over the axis element. The revolve
handle snaps into alignment with any linear elements. When aligned with the
proper element, you can click to accept the handle position (B).
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You can construct a revolved feature that is equal to or less than 360 degrees using
the options on the Revolve command bar. After you define the options you want on
the command bar, you can click the torus element on the revolve handle (A) to begin
constructing the feature. The cursor shape changes to a cross hair, and a dynamic
representation of the feature is displayed, along with a dynamic input box, so you
can type an angular value for the feature (B).

To finish defining the feature, you can click to define the feature extent, select a
keypoint, or type a value and press the Enter key.

Note

The sketch elements used to define the feature are moved to the Used
Sketches collector in PathFinder and hidden. The sketch dimensions are
migrated to the appropriate model edges when possible.

Notice that since the axis element is separate from the sketch elements that
define the cross section of the feature, that the axis element does not move to
the Used Sketches list in PathFinder.

Create Live Section

On the command bar, use the Create Live Section option (1) to create a live section
upon feature completion.
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The option is on by default. All sketch dimensions migrate to the live section.

Activity: Create a base revolved synchronous feature

Create a base revolved synchronous feature

Overview

This activity demonstrates the process of creating a part model using the Revolve
command.

Objectives

Create a vise screw to become familiar with the Revolve command for construction of
base features.

In this activity you will:

• Create a region consisting of sketch elements.

• Use the Select tool to invoke the Revolve command.

Open a new ISO part file

▸ Create a new ISO part file.
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Sketch the initial basic shape

▸ Draw and dimension the following sketch.

Create the base feature

▸ Select the region.
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▸ Click the extrude handle origin (1) and drag it to the edge (2).

The extrude handle changes to a revolve handle. Edge (2) is the axis of revolution.

▸ Click the torus to start the rotation extent definition.
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The geometry dynamically attaches to the cursor.

▸ On command bar, select the Live Sections options (1) and turn off 360° extent
option (2).

▸ Save and close the file.

Summary

In this activity you learned how to create a revolved base feature. A sketch was
created and dimensioned. A region was revolved and the sketch dimensions
migrated to the base feature. The extrude handle changes to a revolve handle when
you drag it to an edge.

Creating subsequent features

Creating subsequent features

Intuitive commands based on context

For features on an existing body, the extent direction defined by cursor position
with respect to the sketch’s planar surface or plane determines whether you create
an extrusion or cutout.
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Construct an extrusion or cutout: subsequent features

You can construct extruded features using the Select tool or the Extrude command.
Both workflows are explained in this topic.

Construct an extrusion or cutout using the Select tool

1. On the Home tab®Selection group, choose the Select command .

2. Position the cursor over a sketch region, then click to select it.

The extrude handle (A) appears.

3. Position the cursor over the Extrude handle, then click to select it.

4. Reposition the cursor to define the direction of the material you want to add or
remove.

• If you click away from the model body, material is added.
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• If you click into the model body, material is removed.

5. Click to both position and finish the feature.

Construct an extrusion or cutout using the Extrude command

1. On the Home tab®Solids group, choose the Extrude command .

2. On command bar, do one of the following:

• Set the Face option, position the cursor within a sketch region, and then
click the left mouse button.
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• Set the Chain option, position the cursor over one of a connected chain of
sketch elements, and then click the left mouse button to accept the selection.

• Set the Single option, select one or more connected elements, and then
right-click to accept the selection.

3. Reposition the cursor to define the direction of the material you want to add or
remove.

• If you click away from the model body, material is added.

• If you click into the model body, material is removed.
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4. Click to both position and finish the feature.

Tip

• To define draft and crown parameters for the protrusion or cutout, use the
Treatment Step options on the command bar. See the Help topic, Applying
draft angle and crowning.

Activity: Remove material from a base feature

Remove material from a base feature
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Overview

This activity demonstrates the process of removing material from a base feature.

Objectives

Create regions and use those regions to cut material from the part.

Open an existing file

▸ Open the file you saved in the Activity: Create a base extruded synchronous
feature.

Remove material from the base solid

▸ Turn off the display of the Sketches and PMI collectors in PathFinder.

▸ On the front face of the part, draw the sketch and add dimensions.

▸ Select the region formed by the sketch.

▸ On the command bar, select the Through All extent option (1).
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▸ Click the extrude handle.

▸ Move cursor to point the arrow inward to remove material. Click when arrow
direction is towards the part.

mt01413-s-1050 Solid Edge fundamentals 2-37



Lesson 2 Constructing base features

The material is removed.

Remove additional material

▸ Draw a sketch on face (1) and add dimensions as shown. Ensure that the center
of the circle aligns with the midpoint of the bottom edge.
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▸ Draw a horizontal line passing through the circle center as shown.
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▸ Select the region as shown. Click the extrude handle. On the command bar, click

the Through Next option . Click when arrow direction points towards
the part.
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Create a circular cutout

▸ Draw an 18 mm diameter circle concentric with the existing circle.

▸ Select and accept the two regions bounded by the 18 mm diameter circle.

Note

Use QuickPick if needed to select the two regions. You build a select set
by selecting the first region and then, while holding down the Ctrl key,
select an additional region.

▸ Click the extrude handle.

▸ On the command bar, click the Through Next option.
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▸ When the direction arrow points towards the part, click to create the circular
cutout.
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Create another cutout

▸ Draw the sketch on face (1) and center the sketch on the bottom edge of face.
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▸ Select the region.

▸ Click the extrude handle and set the extent option to Through All on the
command bar. Click when the arrow points towards the part.
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▸ Turn off all sketches and PMI, and press Ctrl+I to display an isometric view.

▸ Save the file. You will continue working in it in another activity.

Summary

In this activity you learned how to remove material from a base feature. A sketch
was created and dimensioned. A region was selected representing the cross-sectional
area to define the material to be removed.

Activity: Add material to a base feature

Add material to a base feature
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Overview
In this activity you will

• Create the four feet of the vise by extruding four regions at once.

• Create cutouts at the back of the vice and through the feet.

Open an existing file

▸ Open the file saved from the Activity: Remove material from a base feature.

Add mounting flanges

▸ On the bottom face of the part, sketch four mounting flange profiles.
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▸ Holding the Shift key, select the four regions shown.
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▸ Select the “up” arrow to add material towards the top of the part. In the dynamic
input box, type a distance of 8 mm and press Enter.
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Create mounting holes

▸ Sketch four circles of diameter 8 mm on each of the mounting flange faces. Place
the circles concentric with flange arc.

▸ Select all four circles and remove material from the flanges.
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Add circular cutouts

▸ Sketch two 7 mm diameter circles on the face shown and add dimensions. To
center the two circles on the face, draw a line connecting the two circle centers.
Change the line to a construction element. Align the midpoint of construction
line to the midpoint of the top edge on the face.

▸ Select both circular regions. You may need to use QuickPick to select the regions.

▸ Remove material at a depth of 16 mm.
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▸ Click the left mouse button to finish.

▸ Save and close this file.

Summary

In this activity you continued to apply techniques to add and remove material from a
base feature.

Constructing features using the feature construction commands

Solid Edge provides a feature-based modeling workflow. This workflow is where you
select a feature construction command first, such as Extrude, Hole, or Round, then
the software guides you through the rest of the process, letting you know what type
of input you need to provide at each step.

mt01413-s-1050 Solid Edge fundamentals 2-51



Lesson 2 Constructing base features

The first step is to click the feature command. You can then use the command bar to
define the input required to complete the feature. PromptBar, at the bottom of the
working area, also displays prompts as to what you should do.

Command bar

The command bar for each feature command contains all the options available for
the command. You can select one of two configurations for the command bar:

• Horizontal toolbar form: the command options are contained in a floating toolbar
which resides in the document view.

• Vertical docking window form: the command options are contained in a vertical
window which can be docked with other windows.
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Note

You can choose the command bar configuration from Solid Edge
Options®Helpers page®Command User Interface. For more information:
Customize Solid Edge options and Helpers page (Solid Edge Options dialog
box)

All options specific to the command are included in the command bar, and are
generally organized in the sequence you would use to complete the command. You
can also use the command bar to go back to a previous step, or to go to an optional
step. Although feature construction is a sequential process, you do not have to start
all over again if you want to change something you did in an earlier step.

Along with the command bar, the PromptBar will guide you as you complete the
necessary command options.

Construction and Reference Elements

You can use construction and reference elements to help you construct features.
For example, when constructing a hole feature, you can draw a construction line
to help you position the hole properly. You can use the Construction command to
change a sketch element into a construction element, or a construction element into
a sketch element. Construction elements display using a different line style than
sketch elements.

Reference elements are planes and axes used to define sketch planes, extrude
extents, and revolve axes.

Lesson review

Answer the following questions:

1. For features on an existing body, what determines whether you are creating an
extrusion or a cutout?

2. Of the two workflows for creating a base feature, which one minimizes
interaction with the command bar and lets you work faster?

3. There are two command bar configurations available: horizontal and vertical.
Where do you choose the active configuration?

Lesson summary

• Once a region exists, two workflows are available for creating a base feature: the
selection workflow (synchronous environment) and the creation workflow.

• Surface shapes are directly tied to the curves defining those surfaces. Therefore,
the control of curves is crucial in modifying surface topology.

• You can use construction and reference elements to help you construct features.
For example, when constructing a hole feature, you can draw a construction line
to help you position the hole properly. You can use the Construction command to
change a sketch element into a construction element. Reference elements are
planes and axes used to define sketch planes, extrude extents, and revolve axes.
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Model Dimensions

Model Dimensions

Once a solid model exists, you can fully dimension it as needed. You can define
dimensions necessary for manufacturing and other downstream functions directly
to the model’s edges and faces. In fact, you do not have to create any dimensions
in the 2D sketch at all. You can wait until a base feature exists to perform all of
the dimensioning work.

Dimensioning the model

Solid Edge provides a unified set of dimensioning commands whether you’re working
with a 2D sketch or placing dimensions on a 3D model. This single tool set simplifies
your work, allowing you to focus on the job at hand instead of hunting for a unique
2D or 3D command.

You can access dimensioning commands from the following tabs within Solid Edge.

• Home

• Sketching

• Surfacing

• PMI

Note

The PMI tab adds more dimensioning commands, as well as a full set of
manufacturing annotations.

The application of dimensions to a 3D model does not differ from placement on a 2D
sketch. Since this topic was already covered this in a previous lesson, we will not
cover the individual types here.

Editing model dimensions

Dimensions attached to model edges are PMI dimensions. PMI dimensions are
created indirectly through sketch migration, and by directly adding them to the
model. You can edit any dimensions attached to synchronous feature edges to modify
models. You can determine if a dimension can be directly edited by its color. To learn
about creating and editing PMI dimensions, see the Help topic, PMI dimensions
and annotations.
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Model dimension editing tools

When you click dimension text, several model editing and selection tools are
displayed:

• Dimension value edit controls

• Modify Dimension QuickBar

• Live Rules

Changing model size

You can change the size of the model by changing the value of one or more PMI
dimensions. For example, when you select the dimension text for the 60 mm
dimension (A), the dimension value edit handle appears [(B)(C)]. The dimension
value edit handle indicates how the model will react if you type a new value for
the dimension.

Controlling what is changed

You can use the Lock button (A) on the Dimension Value Edit dialog box to ensure
dimensions and the model geometry they control remain unchanged when you edit
other model dimensions.
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For example, you can lock both of the 20 mm dimensions before you edit the 60
mm dimension. Then, when you edit the 60 mm dimension to 70 mm, the 20 mm
dimensions do not change.

PMI dimensions display using different colors depending on whether they are locked
or unlocked.

Controlling the direction of change

When you highlight or select the dimension text on a 3D dimension, the dimension
terminators update to indicate which side of the model will change when you edit the
value of the dimension. A 3D arrow (A) appears on the side of the model which will
be modified, and a 3D sphere (B) appears on the side of the model which remains
stationary.

You can also use the options on the dialog box to control how the model reacts to
a dimension edit. Use the direction arrows to specify which side of the model is
modified (A), and which side remains stationary (B).
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You can also drive a symmetric edit by selecting the symmetric arrow.

Controlling face selection with Live Rules
When you choose a dimension to edit, you can add or remove faces from the selection
set by changing the options in Live Rules. This controls how the model behaves
when you modify it.

To learn more, see the Help topic, Working with Live Rules.
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Activity: Dimension a model

Dimension a model

Overview

This activity demonstrates the process of applying dimensions to define and control
a model.

Objectives

Use some of the dimensioning commands on an existing part.

In this activity you will:

• Place linear and radial dimensions.

• Modify these dimensions and observe how the model changes.

• Use virtual vertices to define dimensions.

Open a file

▸ Open jaw.par.
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Add dimensions to the model

Note

Place dimensions on the 3D part and use them to change the model size. You
will learn that dimensions can be placed at any time in the design cycle, and
these dimensions control the model.

▸ In PathFinder, turn off the display of the Dimensions collector under PMI.

▸ Place a diameter on the bore. Change the value to 20 mm and press the Enter
key.
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▸ Place a radius dimension on the saddle surface and change the value to 25 mm.

▸ Select Distance Between to place a dimension representing the overall height of
the part.

• On Command Bar, click the Lock Dimension Plane option .

• Use QuickPick to select the dimension plane shown.
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• Click edge (1) and then click edge (2).

• Change the dimension value to 86 mm. Ensure that the direction arrow
points upward.
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• Press the F3 key to unlock the dimension plane.

• Press the F5 key to refresh the screen to clear the display of the dimension
plane.

▸ Save and close this file.

Dimension to intersection points

▸ Open jaw_rounds.par. It is similar to the part in the previous activity. The file
includes rounds.
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▸ Press Ctrl+F to change to a front view.

▸ Use PathFinder to hide the dimensions.
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▸ Place a Distance Between dimension from the bottom edge to the underside edge
as shown below. Change the value to 40 mm.

▸ While still in the Dimension Between command, select the round to dimension to
the center of the round.

Note

You can see that the dimension is attached to a virtual center of the round.
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▸ Place the dimension.

▸ Save and close this file.

Summary

In this activity you placed dimensions on the 3D model. These dimensions can
be used to control the model shape. You also learned how to dimension to an
intersection using a virtual vertex.

Sketch consumption and dimension migration

In synchronous part and sheet metal documents, you typically draw 2D sketch
geometry for the purpose of constructing features on a solid model. In a synchronous
model, when you use sketch elements to construct a feature, the sketch elements
are consumed and the 2D dimensions you placed on the sketch migrate to the
appropriate edges on the solid body, whenever possible.

For more information, see the Sketch consumption and dimension migration topic in
the Sketching course (spse01510).

Lesson review

Answer the following questions:

1. What type of dimensions attach to the edges of a model?

2. What allows you to prevent change in a dimension when you are editing other
dimensions in a model?

Lesson summary

• You can define dimensions necessary for manufacturing and other downstream
functions directly to a model’s edges and faces. In fact, you do not have to create
any dimensions in the 2D sketch at all. You can wait until a base feature exists
to perform all of the dimensioning work.

• Solid Edge provides a unified set of dimensioning commands whether you’re
working with a 2D sketch or placing dimensions on a 3D model. This single tool
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set simplifies your work, allowing you to focus on the job at hand instead of
hunting for a unique 2D or 3D command.

• PMI dimensions are created indirectly through sketch migration, and by directly
adding them to the model.

• You can change the size of the model by changing the value of one or more PMI
dimensions.

Coordinate systems

Coordinate systems

In synchronous, a coordinate system is a set of planes and axes used to assign
coordinates to features, parts, and assemblies. You can also draw sketches on the
principal planes associated with a coordinate system.

There are two types of coordinate systems:

• Base coordinate system

• User-defined coordinate systems

When constructing synchronous parts, you typically use the principal planes of the
base coordinate system to draw 2D sketches in 3D space.

You can use a coordinate system to position a part in an assembly. You can measure
distances relative to a coordinate system with the Measure Distance and Measure
Minimum Distance commands. You can display and hide the base coordinate system.
Coordinate systems are displayed in the Coordinate System collection in PathFinder.
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Base coordinate system

The Base coordinate system is displayed at the origin of a new part or assembly
document. When constructing synchronous parts, you typically use one of the
principal planes of the base coordinate system to draw a 2D sketch for the first
feature of a new part. For example, you can draw the first sketch for a new part on
the principal XY plane of the base coordinate system. You can also place dimensions
and geometric relationships relative to the primary axes of the coordinate system.

User-defined coordinate systems

When you create a user-defined coordinate system, you can position the coordinate
system relative to model geometry, another coordinate system, or in empty space.

When placing a user-defined coordinate system, you can use the shortcut keys to
control the orientation of the coordinate system. When placing a coordinate system
on a model face, the coordinate system is positioned relative to linear edges on the
face. For example, you can use the N key to choose another model edge to orient
the coordinate system. The valid shortcut keys are displayed in PromptBar while
you are placing the coordinate system.
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Activity: Model with a coordinate system

Model with a coordinate system

Overview

This activity demonstrates the process of creating features using a coordinate
system.

Objectives

Create handle on a coffee cup using coordinate system.

Open a part file

▸ Open cup.par.
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Create a coordinate system

▸ On the Home tab®Planes group, choose the Coordinate System command.

▸ Place the coordinate system on the outside cylindrical surface of the cup. Do not
be concerned with exact location. Press the Esc key when it places.

▸ Place a dimension between the coordinate system’s X-axis and the edge on the
top of cup.
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• Choose the Lock Dimension Plane option .

Lock to the XY plane on the coordinate system on the cylindrical face.

• Select the edge on the top of the cup.

• Select the X axis on the coordinate system. Change the dimension value to
52 mm.
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Press F3 to unlock the dimension plane and then F5 to clear its display.

Create the handle

▸ Draw a rectangle on the coordinate system’s XZ plane. Press the N key until the
(green) edge shown on the plane highlights and then press the F3 key to lock
to that plane.
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On the View tab®Views group, choose the Sketch View command. Add
dimensions as shown.

Press F3 to unlock the sketch plane. Press Ctrl+I to return to the ISO view.

▸ Choose the Revolve command to generate the handle. Select the rectangle as the
sketch. Accept it and then select the coordinate system X-axis as the rotation
axis. You may need to use QuickPick to locate the X-axis.

Note

In QuickPick, the X-axis name is Edge (Coordinate System 3) - or similar.
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▸ On the command bar, clear the Create Live Section option

▸ On the command bar, set the Symmetric option, and type an angle of 183
degrees. Press the Enter key.

▸ Save the file.
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Optional: Finish the cup

▸ If you wish to aesthetically finish the handle, you can add rounds to the edges.
First add a 5 mm round to the handle’s four edges and then right-click. Add a 7
mm round to the two handle/cup interface edges and then right-click.

▸ Turn off the display of the coordinate system entry in the Coordinate Systems
collector.
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▸ Save and close this file.

Summary

In this activity you learned how to create a coordinate system to use to draw a
sketch. The coordinate system was positioned with dimensions.

Lesson review

Answer the following questions:

1. What are the two types of coordinate systems?

2. You can locate which coordinate system type with respect to model geometry or
another coordinate system?

Lesson summary

• When constructing synchronous parts, you typically use the principal planes of
the base coordinate system to draw 2D sketches in 3D space.

• You can use a coordinate system to position a part in an assembly. You can
measure distances relative to a coordinate system with the Measure Distance
and Measure Minimum Distance commands. You can display and hide the base
coordinate system. Coordinate systems are displayed in the Coordinate System
collection in PathFinder..

• Pierce and silhouette points can assist in connecting curves to off-plane geometry.

2-76 Solid Edge fundamentals mt01413-s-1050



Constructing base features

Sets

Sets

The Extrude command creates a face set in PathFinder; these have names such as
Protrusion 1. This set contains all faces of the protrusion.

The resulting set of faces may be used as input to other commands, and grouped by
the user for further selection.

Working with user-defined sets

You use user-defined sets to group a set of features, faces, sketches, and other
modeling elements into one entry in the Synchronous portion of PathFinder. This
can make it easier to manipulate the set of elements when modifying the model.
When you create a user-defined set, it is added to the User-Defined Set collection
in PathFinder.

For example, you can create a user-defined set that includes an extruded feature,
two cutouts on the extruded feature, and the round features between the extruded
feature and the rest of the model.

You can then select the user-defined set in PathFinder and use the steering wheel
to quickly move the user-defined set to a new location.
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Note

User-defined sets are only available in the Synchronous portion of a model.

The following commands are available for working with user-defined sets:

• Create User-Defined Set

• Add to User-Defined Set

• Dissolve User-Defined Set

Creating user-defined sets

You can create a user-defined set by selecting the elements you want in the set in
PathFinder or the graphics window. With the set of elements selected, you can use
the Create User-Defined Set command on the shortcut menu to create the set. You
can use the Rename command on the shortcut menu to rename the set to a more
logical name.

The following element types can be included in a user-defined set:

• Faces

• Features

• Complete sketches
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• User-defined reference planes

• User-defined coordinate systems

• PMI dimensions (only when another valid element is also selected)

Note

Some types of elements are not valid for adding to a user-defined set. If no
valid elements are in the select set, the Create User-Defined Set and Add to
User-Defined Set commands are not available. Also, these commands will not
be available in the Ordered portion of the model.

Adding to an existing user-defined set

The Add to User-Defined Set command can be used to add new elements to an
existing user-defined set. When you select an element to add to an existing set, then
click the Add to User-Defined Set command on the shortcut menu, you are prompted
to select an existing set to which you want to add the new elements. You can then
select the existing set in PathFinder.

Dissolving a user-defined set

The Dissolve User-Defined Set command can be used to dissolve or modify an
existing set. When you dissolve an existing set, the element set remains selected.
You can then deselect the elements you wanted to remove from the previous set,
then use the Create User-Defined Set command to create a new set that does not
contain the deselected elements.

Lesson review

Answer the following questions:

1. Are user-defined sets available in both Synchronous and Ordered portions of
a model?

2. How do you delete a user-defined set?
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Part modification by moving and rotating faces and planes

Part modification by moving and rotating faces and planes

Overview

A synchronous solid model is a set of connected facial topology that encompasses a
volume. You modify a synchronous solid model by manipulating the facial topology.
In this course, you learn to modify a synchronous model by moving and rotating
facial topology.

• Synchronous model faces and reference planes can move or rotate.

• When you select a face, command bar displays the commands available for the
selected face.

• Move (1) is the default command .

• Move includes both a linear direction movement and a rotational movement.

Note

The Constructing base features course covers the Extrude (2) and Revolve
(3) commands.
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Moving synchronous faces

Moving synchronous faces

When you select a synchronous face or reference plane, a default graphic handle (1)
appears at the select point. If you select the handle origin, a different graphic handle
(2) appears with more move options. Click the primary axis, secondary axis, or
torus to start the Move command.

Graphic handle (3D steering wheel)

(1) secondary knob

3-2 Solid Edge fundamentals mt01413-s-1050



Moving and rotating faces

(2) secondary axis

(3) cardinal points

(4) torus

(5) primary knob

(6) primary axis

(7) origin

(8) tool plane

The steering wheel displays in a minimal state when selecting a face (1) or a feature
(2). In a minimal state, only the primary axis appears. To fully expose the steering
wheel, click the origin and move it to an edge, keypoint or face of the model.

Reorient the steering wheel

To learn how to use the 2D steering wheel, see the 2D steering wheel overview
Help topic.

Swap the primary and secondary axes

1. Hold the Shift key down.

2. Click the steering wheel plane.
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Change the direction of the primary axis at 90° increments

• Click a cardinal point on the steering wheel torus.

Change the direction of the primary axis at a user-defined angle

1. Hold the Shift key down.

2. Click the primary axis knob.

3. Move the cursor to define the angle or type an angular value in the dynamic
edit box.

4. Press the Tab key.
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Change the direction of the primary axis using a geometric keypoint

1. Click the primary axis knob.

2. Move the cursor over the target keypoint and then click.

Change the direction of the secondary axis

1. Click the secondary axis knob.

2. As the cursor moves, the secondary axis automatically locks onto a 90° increment
in either direction. Click to apply the new direction.
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Change the secondary axis direction at a user-defined angle

1. Hold the Shift key down.

2. Click the secondary axis knob.

3. Move the cursor to define the angle or type an angular value in the dynamic
edit box.

4. Press the Tab key.

Maintain a steering wheel orientation at a different location

• Hold the Shift key down and drag the steering wheel origin to the new location.
If you drag the steering wheel origin near an edge midpoint, the origin snaps to
the midpoint. Click to position the steering wheel at the midpoint or continue
dragging the origin to another location.

Activity: Reorient the steering wheel

Reorient the steering wheel

The activity guides you through the process of reorienting the steering wheel. The
steering wheel orientation controls the movement direction of selected geometry
during a synchronous operation.

Overview

Examine the components used for reorienting the steering wheel. In this activity,
a geometric feature moves using the steering wheel. The steering wheel orients to
define the move direction.
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▸ Open steering_wheel.par.

Move geometry in the primary and secondary axes directions

Note

A move in the primary axis direction occurs on the steering wheel plane. A
move in the secondary axis direction is normal to the steering wheel plane.

Note

A move occurs between the move from point to the move to point. The move
from point is always the steering wheel origin. The move to point can be a
keypoint, user-defined distance, or a drag and click location.

▸ In PathFinder, select the feature named feature A.

▸ The steering wheel displays in a minimal state. Click the primary axis. As you
drag the cursor up and down, notice the feature moves in a direction defined by
the primary axis.

At this point, you can drag and click to define the move distance, type a distance
value in dynamic edit box, or select a keypoint.

▸ Press the Esc key to end the move.
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▸ The steering wheel is now fully exposed. Click the secondary axis. As you drag
the cursor, notice the feature moves in a direction defined by the secondary axis.

▸ Press the Esc key to end the move.

Change the direction of the primary axis

Note

You can change the primary axis direction in 90° increments by clicking
a cardinal point.

Note

You can change the primary axis direction at a user-defined point or a drag
and click point to define direction angle
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▸ Hold the Shift key and click the primary knob.

▸ Move feature A at a 45° direction angle. Once the angle is set, click the primary
axis to start the move. The right portion of the image shows a front view to
better visualize the 45° movement.

▸ Press the Esc key to end the move.

Move geometry in the steering wheel plane

You can perform a free move to any point on the steering wheel plane. You click
the steering wheel plane and drag the selected geometry to a desired location and
then click, or select a keypoint.

▸ Select feature A.
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▸ Click the steering wheel plane. Drag the feature around and notice that the
movement is locked to the steering wheel plane.

▸ Press the Esc key to end the move.

Use the steering wheel torus to rotate geometry

Clicking the torus starts a rotate operation. The rotation axis is the secondary axis.
You click the steering wheel torus and drag and then click to define the rotation
angle. You can also type a rotation angle in the dynamic edit box.

▸ Select feature A.

▸ Click the torus and rotate feature A 90°.
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▸ Click to end the rotate command.

Swap primary/secondary axes

You swap the primary and secondary axes by holding down the Shift key and clicking
the steering wheel torus plane.

▸ Select feature A.
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▸ Hold down the Shift key and click the steering wheel plane.

Note

This is a quick method of changing the rotation axis.

▸ Press the Esc key.

Change the direction of the primary/secondary axes using a geometric keypoint

You can change the direction of the primary or secondary axis by clicking the axis
knob and then selecting a geometric keypoint.

▸ Select feature A.
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▸ Reposition the move from point. Select the steering wheel origin and then drag
the origin to the corner of the selected feature shown.

You want to move the feature to corner (1). Define the direction axis pointing to
corner (1).

▸ Click the primary axis knob. Move the cursor over corner (1) and click when
the endpoint displays.
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▸ Click the primary axis and notice the direction of movement.

At this point if you click the endpoint shown, the feature moves to that point.

▸ Press the Esc key twice to cancel the operation.

Maintain a steering wheel orientation at a different location

If you want to maintain a steering wheel orientation at a different location, you
hold the Shift key down, click the steering wheel origin, and drag it to the desired
location. If the origin is close to a keypoint, it snaps to that point. Click to position
origin to that point.

▸ Select feature A.

▸ Hold the Shift key down and click the steering wheel origin.

▸ Drag the steering wheel origin over the model (at the corners and edge
midpoints) and notice that the steering maintains the orientation.

If you repeat the same step without holding down the Shift key, the steering
wheel orientation changes as it passes over the model edges, corners and faces.
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Use the steering wheel to reorient and move a feature

Move the feature to the location shown. Make sure the feature has same orientation
as shown.

▸ Turn off the display of feature A. In PathFinder, click the box in front of feature A.

▸ Turn on the display of feature B.

▸ Rotate feature B. Select feature B.
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▸ Click the torus, type 90 in the dynamic edit box, and then click.
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▸ Rotate the feature again to complete the orientation. Position the steering wheel
origin as shown. Click the torus. Drag and type either 90 or -90 in the dynamic
edit box (note the plus or minus value in the dynamic edit box to determine if 90
or -90 should be entered). Press the Tab key and then click.
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▸ Move the feature to new location. Select feature B. Position the steering wheel
origin as shown (midpoint of edge). Define the primary axis direction to point
to the edge midpoint on part. Click the primary axis to start the move. Move
the cursor over the edge midpoint and click when the midpoint highlights. Press
Esc to end the move operation.

▸ Try positioning the feature at other locations on the part.

Summary

In this activity you learned how to reorient the steering wheel to accomplish desired
move and rotate operations.

3-18 Solid Edge fundamentals mt01413-s-1050



Moving and rotating faces

Moving a face

You can move a face in the following ways:

• Move a face in a direction along the primary axis or secondary axis by selecting
either axis.

• Move a face freely along a plane where the graphic handle connects by clicking
the plane on the handle.

• Set the direction of the primary axis by dragging the handle origin to an edge or
vertex. The primary knob also locks onto the edge to define the direction.

• Reposition the primary knob to change the direction of the primary axis.

• Reposition the secondary axis direction in 90° increments by selecting one of
three cardinal points.

• The origin is the move from point. The origin can move prior to a move face
operation.

Rotating a face

Rotate a face by positioning the steering wheel secondary axis on an edge. The
secondary axis becomes the axis of revolution. Select the torus to begin dynamic
rotation or type a rotation angle in the dynamic input box.

Note

You can lock and drag a graphic handle orientation. Hold the Shift key, click
the handle origin, and drag it to a desired edge or vertex.

Move face workflow

Single face move

1. Using the Select tool, select a face. The 3D steering wheel appears on the
selected face. Initially you get the primary axis only. Click the 3D steering wheel
origin to display entire steering wheel.

2. The command bar appears with the available operations that can be performed
on the selected face. Move is the default operation and thus does not need to be
selected.

3. Click the primary axis on the handle to move the face in or out in a direction
normal to the face.

4. Define the move to location by one of the following methods:

• Dynamically drag the face to a new location and then click.

• Click a keypoint location. Choose the keypoint type on the Move command
bar list.
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• Type in a distance in the dynamic input box.

5. Press Esc key to end move.

Note

Workflow is the same for multiple faces in a select set.

Single face rotate

1. Using the Select tool, select a face. The 3D steering wheel appears on the
selected face. Initially you get the primary axis only. Click the 3D steering wheel
origin to display entire steering wheel.

2. Click and drag the origin of the steering wheel to an edge to rotate about.

3. Make sure the secondary axis of the steering wheel lies on the edge to rotate
about. Click and drag the secondary knob to position if necessary.

4. Click the torus on the handle to rotate the face. Dynamically rotate the face by
moving the cursor or by typing in an angle in the dynamic edit input box.

5. Press Esc key to end rotate.

Note

Workflow is the same for multiple faces in a select set.

Activity: Moving and rotating faces

Moving and rotating faces

This activity guides you through a move and a rotate face process to reinforce the
use of the 3D steering wheel.

Change the shape of part (1) to a modified part (2).
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Open activity file

▸ Open move_01.par.

Move a face

Move the back face of the boss a distance defined by a vertex on the back face
of the lower base.

▸ Select the face shown. Use QuickPick if necessary.
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▸ Click the primary axis to start the move command. Clicking the primary axis
defines the direction vector for the move. All you need to complete the move
is a distance to move.

The selected face connects to the cursor and moves dynamically as the cursor moves.

▸ Use a keypoint locate to define the move to distance. On the Move command
bar, choose the All keypoints option.

▸ Move the cursor over the corner shown and click when the endpoint appears.

▸ Press the Esc key to end the move command.

Move faces

▸ Move the side faces on the boss a distance defined by a vertex on the side face
of the lower base.
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Rotate a face

▸ Select the angled face.
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▸ To rotate the selected face, define a rotation axis. Drag the steering wheel
origin to the edge shown. The secondary axis must lie on an edge that the face
rotates about.

▸ Click the steering wheel torus to start the rotation. As the cursor moves, the
rotation angle tracks with the cursor. Type 35 in the Dynamic Edit box to define
the rotation angle.

▸ Press the Esc key to end the command.

▸ This ends the activity. Exit the file and do not save.

Summary

In this activity you learned how to move and rotate faces. You define distances to
move by dragging and clicking, typing in a distance, or by using keypoints. To rotate
a face, position the secondary axis of the steering wheel on an edge to rotate about.
Click the torus and move the cursor to define the rotation angle or type a rotation
angle in the Dynamic Edit box.

Activity: Copying a face and using keypoints to define movement

Copying a face and using keypoints to define movement

This activity guides you through the process of copying a face and using other
geometry to define the movement direction and distance. Copy the lower hole (2) and
positioned it at the same angle and distance as the upper holes (1).
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Open activity file

▸ Open move_02.par.

Select the hole to copy

▸ Select the cylindrical face shown.

▸ On the Move command bar, choose the Copy option.
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Define the move from point

At this point, the steering wheel origin is at the center of the selected cylindrical
face. Move the origin to the top left hole.

▸ Click the steering wheel origin and then move the cursor to the upper left hole.
Click when the origin locks to the center of the hole. You may have to zoom in if
you have trouble locking to the center of the hole.

Define the move direction

▸ Click the primary knob shown. This controls the primary axis direction.
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▸ Move the cursor over the cylindrical face shown, and click when the center point
symbol appears.

▸ Notice that the primary axis now points to the center of the hole. Direction
definition is complete.
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Define the move distance

▸ Click the primary axis to start the Move command.

▸ Make sure the keypoints option in command bar is set to All or Center Point.
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▸ Click the center of the hole shown. This defines the move distance. Click again
to end the command.

Verify move distance

▸ Measure the copied distance. On the Inspect tab®3D Measure group, choose the

Measure Distance command .

▸ Measure the distance between the top two holes. Click when the center point
highlights. Notice the minimum distance and then click Reset in the command
bar. The distance is 14 mm.

▸ Measure the distance between the lower two holes. The distance between the
holes should also be 14 mm.
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▸ This ends the activity. Exit the file and do not save.

Summary

In this activity you learned how to use the 3D steering wheel to control a move
or copy operation. You learned how to redefine an origin point (move from point)
and how to modify the direction of a move. You used face keypoints to define the
move/copy direction and distance.

Lesson review

Answer the following questions:

1. How do you move a face?

2. How do you rotate a face?

3. How do you move a feature?

4. How do you rotate a feature?

5. What are the cardinal points on the steering wheel used for?

6. How do you copy a feature to a new location?

Lesson summary

Moving and rotating faces is how you modify synchronous models. You can move or
rotate a single face, a select set of faces, features, and a combination of faces and
features. Use the steering wheel to control how the selected faces move or rotate.

Selecting faces

Selecting faces

Select faces using the Select tool .

A collection of selected faces to perform an action on is referred to as a select set.

Face selection methods

• Select and deselect faces manually (one face at a time).

• Select and deselect faces using the Selection mode.

• Select and deselect faces with the assistance of the Selection Manager.

The Selection Manager uses the topological and attribute data of the face
selected to add faces to a select set.
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Selection mode

A selection mode symbol appears in the upper-right corner of the graphics window.
Press the Spacebar to change the select mode. The select mode selection is also
available on the Home tab®Selection group.

Normal mode

normal mode

Normal mode is the default selection mode. Normal mode is a single selection. Select
a face and the steering wheel displays on that face. Select another face and the
steering wheel moves to that face. The face previously selected is deselected. You
can only select one face per click.

Add/remove mode

add/remove mode

Use the add/remove selection mode to build a select set. In the normal mode, select a
face and then press the Spacebar to switch to the add/remove mode. Each face you
select in this mode adds to the select set. If a you select face that is already selected,
it is deselected. The graphic handle remains on the first face selected. Both selected
and deselected faces highlight as the cursor moves over them.

Add mode

add mode

The add mode only adds faces to the select set. Only deselected faces highlight as
the cursor moves over faces. To set the mode to add, cycle through the select modes
by pressing Spacebar.
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Remove mode

remove mode

The remove mode only removes (deselects) faces from the select set. Only selected
faces highlight as the cursor moves over faces. To set the mode to remove, cycle
through the select modes by pressing Spacebar.

Selection Manager mode

Selection Manager mode

To activate Selection Manager mode, choose the Selection Manager mode button on
the Home tab®Select group®Select command list. You can also activate by pressing
Shift + Spacebar. To end the Selection Manager mode, press the Spacebar.

Selection Manager

Use Selection Manager to add or remove items from a select set using the topological
and attribute data of a selected object.

When in the Selection Manager mode, a green dot attaches to the cursor.

Clicking on a face displays the Selection Manager menu.

The topological relations relate only to the face where the green dot is selected.

The topological relations listed in the Select Manager menu are determined by the
type of face selected (planar, non-planar, cylindrical, partial cylindrical).

You can also switch to a Selection Manager mode. On the Home tab®Select group,

in the Select list, choose the Select Manager Mode command . You can also start
the Select Manager mode by pressing Shift+Spacebar. To end the Select Manager
mode, press the Spacebar.

Selection Manager options

The Selection Manager shortcut menu is available when you select valid elements.

To display the Selection Manager menu, click on a face.
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Connected

Add faces which are connected to the focus element. Use the flyout options to specify
what type of connected elements to add.

• Connected – Adds all faces which connect to the focus element.

• Interior Faces – Adds all interior faces which connect to the focus element.

• Exterior Faces – Adds all exterior faces which connect to the focus element.

Related Items

Adds elements that have a persistent relationship to the focus element.

Sets

Adds faces which are part of the same face set as the focus element.

Recognize

Adds all faces which are part of the same feature as the focus element. Use the
flyout options to specify what feature type is recognized.

• Feature – Adds all faces which are part of the same feature as the focus element.

• Rib/Boss – Adds all faces which are part of the same rib/boss as the focus
element.

• Cutout – Adds all faces which are part of the same cutout as the focus element.

Parallel

Add planar faces or reference planes which are parallel to the focus element. Use the
flyout options to specify what type of parallel faces to add.

• Faces – Adds all planes which are parallel to the focus element, regardless
of whether they are aligned or opposing. This option supports the Use Box
Selection option.

• Aligned – Adds all planes which are parallel and face the same direction as the
focus element. This option supports the Use Box Selection option.

• Opposing – Adds all planes which are parallel and face the opposite direction as
the focus element. This option supports the Use Box Selection option.

Perpendicular

Adds all planes which are perpendicular to the focus element. This option supports
the Use Box Selection option.

Coplanar

Adds all planes which are coplanar to the focus element. This option supports the
Use Box Selection option.
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Concentric
Adds all faces that are concentric to the focus element. This option is available
only on faces that are cylinders, cones, and torii, both partial and full. This option
supports the Use Box Selection option.

Blend Chain
Adds faces which are part of the same blend chain as the focus element to the
select set.

Equal Radius
Adds faces which have a radius equal to the focus element to the select set. This
option is available only on faces that are partial cylinders, partial cones, and partial
tori. This option supports the Use Box Selection option.

Equal Diameter
Adds faces which have a diameter equal to the focus face to the select set. This
option is available only on faces that are full cylinders, full cones, and full torii. This
option supports the Use Box Selection option.

Tangent Faces
Adds faces which are tangent to the focus element.

Tangent Chain
Adds faces which are part of the same blend chain or tangent to the same blend
chain as the focus element.

Symmetric About
Adds faces which are symmetric to the focus element about the same reference
plane type specified. Use the flyout options to specify what type of reference plane
to use as the symmetry plane.

• Base XY Plane – Adds faces which are symmetric to the focus element about
the base XY plane.

• Base ZX Plane – Adds faces which are symmetric to the focus element about
the base ZX plane.

• Base YZ Plane – Adds faces which are symmetric to the focus element about
the base YZ plane.

• Local Plane – Adds faces which are symmetric to the focus element about a
reference plane you select.

Axis
Adds faces which have an axis that is parallel or perpendicular to the focus element.
This option is available only on faces that are cylinders, cones, and tori, both partial
and full. Use the flyout to specify whether the axis must be parallel or perpendicular.
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• Parallel – Adds faces which have an axis that is parallel to the focus element.

• Perpendicular – Adds faces which have an axis that is perpendicular to the
focus element.

Use Box Selection

Defines a 3D box in the graphic window to add or remove items to the select set.
When using box selection, the elements which are inside or overlapping the 3D box
are included in the selection. This option is available only for a specific shortcut
menu options.

When using the Use Box Selection option, there are two key in options to help
define the location or area the selection box covers. The first option for box select
is to define an area box. Use the C key to switch between a center or corner area
box definition. Once the area of the box is defined, define the depth of the box. Use
the S key to define a symmetric or non-symmetric box.

Use the Selection Manager shortcut menu as many times as required to build the
select set.

Deselect Items

Deselects elements which match the focus element criteria when set.

Set the Deselect Items option and then define criteria to remove items from the
select set.

Select menu options

Deselect

Removes the focus element from the select set.

Clear Selection

Removes all elements from the select set.

3D Box Select

Specifies that you want to define a 3D box in the graphics window to add items
to the select set. When using box selection, the elements which are inside or
overlapping the 3D box are included in the selection.

Activity: Using the Selection Manager

Using the Selection Manager

Activity guides you through the process of using the Selection Manager.

Open activity file

▸ Open select_b.par.
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Select all rounds of equal radius

Use Selection Manager to select all rounds of equal radius and change the radius
value for all the rounds selected.

▸ Activate the Selection Manager mode by either choosing on the Home tab®Select
group, from the Select list or by pressing Shift+Spacebar.

▸ Select the round shown below.

▸ On the Selection Manager menu, make sure Use Box Selection is not checked.

▸ On the Selection Manager, click the Equal Radius option. Notice that all rounds
that have the same radius (1.5 mm) add to the select set.

▸ Press the Spacebar to exit the Selection Manager mode.
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Change the round radius

▸ Select the PMI dimension on the round.

▸ In the dimension box, type 2 and then press the Enter key. Press Esc to clear the
select set. All rounds in the select set are now equal to 2.
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Use the selection box

Add rounds to a select set using a selection box.

▸ Activate the Selection Manager.

▸ Select the round shown.

▸ On the Selection Manager menu, choose Use Selection Box.

▸ On the Selection Manager menu, choose Equal Radius.
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Define selection box area

▸ The first step in defining the selection box is to define the area. Typing a C
changes the area definition from a corner start point (1) to an area center start
point (2). The start point is the point where you select the face.

mt01413-s-1050 Solid Edge fundamentals 3-39



Lesson 3 Moving and rotating faces

Use the center option and define an area as shown.
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Define select box depth

▸ The next step is to define the select box depth. Typing an S changes the
definition from a side definition (3) to a symmetric definition (4). Side step
defines depth in either direction (3) normal to the defined area. The symmetric
option defines the depth symmetric (4) about the defined area.

Define a symmetric depth as shown.

Note

You can rotate the view to better view the positioning of the area and the
depth of the selection box.
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▸ Press the Spacebar to exit the Selection Manager mode.

Change radius of select set

▸ Change the selected rounds radius to 3.
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▸ Press the Esc key to clear the select set.

▸ This completes the activity.

Summary

In this activity you learned how to use the Selection Manager to control the selection
process. With practice you will master the use of the box selection.

Activity: Modifying a part by moving select sets

Modifying a part by moving select sets

This activity demonstrates how to move multiple faces in a single operation. You will
modify part (1) to the shape of part (2).
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Open activity file

▸ Open select_a.par.

Select feature to move

Move protrusion feature to other end of part.

▸ To select the feature to move, first select the face shown.

At this point, only the selected face moves.

▸ Activate the Selection Manager mode.

▸ Select the face shown.
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▸ On the Selection Manager menu, choose Sets. This finds any sets that contain
the selected face.

▸ QuickPick displays the sets found. Click the Protrusion entry listed in QuickPick.

▸ Press the Spacebar the exit the Selection Manager mode.

▸ The selected protrusion feature participates in the move operation.

Move the feature

▸ Click the primary axis on the steering wheel and move the feature to the other
side of the channel-shaped feature.

▸ Move the feature to the approximate location and click. The move from point
is the origin on the graphic handle.
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▸ Move complete. Press the Esc key to clear the select set.

Select the channel-shaped feature

▸ Activate the Selection Manager mode.

▸ Select the face shown.

▸ On the Selection Manager menu, choose Recognize® Rib/Boss.

The Sets option would work here also.

▸ Press Spacebar to exit the Selection Manager mode.
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Move the channel-shaped feature

▸ Click the primary axis on the steering wheel and move the select set to the
edge of the part.

Use a keypoint on the edge of the part to define distance to move. Choose the
keypoint option on command bar (1).
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Extend the legs of the channel-shaped feature

▸ Select the face shown (1).

Note

Both red faces move together because they are coplanar. Live Rules
controls the relationship between these faces.

▸ Move the faces to the end of the protrusion feature as shown. Use a keypoint
to define the distance.
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Move top face of channel-shaped feature

▸ Select the top face.

▸ Move the top face to the top of the protrusion feature.
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Move protrusion feature to end of part

▸ Select the protrusion feature.

Note

You can select the protrusion from Pathfinder, QuickPick, or with Selection
Manager. Make sure you select the protrusion shown.

▸ Move the select set to end of part.

▸ This ends the activity. Exit the file and do not save.

Summary

In this activity you learned how to create select sets for a move operation.

Lesson review

Answer the following questions:

1. What is a select set?
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2. What are the face selection methods?

3. What are the four selection modes and how do you change modes?

4. What is the Selection Manager?

5. How do you start the Selection Manager? How do you end Selection Manager?

Lesson summary

You can build a select set by selecting faces to modify one at a time. This becomes
cumbersome when models become large. The selection methods are available to
ease the building of select sets. Selection Manager is a powerful tool to help define
faces to modify. You can a combination of selection mode and selection manager
to build the select set.

Move face command bar options

Move face command bar options

You control the results of the Move command with options that control the
interaction of the select set and the rest of the model.

By setting these options, the resultant transformation can alter within the command.

The options are Connected faces, Copy, Detach, and Precedence.

Connected face options

Extend/Trim

Default option. Selected face moves by extending and trimming the adjacent faces.

Tip

Selected face is rigid. Adjacent faces change to meet the movement of the rigid
selected face.
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Lift

Selected face is rigid. Adjacent connected faces are not affected. The selected face
moves in a direction normal to the face to either add or remove material.

Copy

The Copy option creates a copy of the faces in the select set.

The faces collect into a face set feature.

The face set feature can move or rotate.

This option is similar to a copy and paste operation.

The original selected faces do not change.

Activity: Copying and attaching a feature (method 1)

Copying and attaching a feature (method 1)

The activity guides you through the process of copying a cutout feature and then
attaching the copied feature in a new location on the model.
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Open activity file

▸ Open copy_a.par.

Select the feature to copy

▸ Select the cutout feature by clicking Cutout1 in PathFinder.

▸ Position the 3D steering wheel as shown.

Suspend Live Rules

Live Rules is covered in the Working with geometric relationships self-paced course.
Suspend the Live Rules settings while moving the cutout feature. This ensures no
other faces in the model participate in the move.

▸ On the Live Rules panel, click the Suspend Live Rules (1) button.
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Set the copy option and move the feature

▸ On command bar, choose the Copy option.

▸ Move the copied feature to the orange face.

To begin the move, click the secondary axis shown. The move origin point is
where the origin of the steering wheel resides.
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Define the move distance and direction

▸ Move the feature to the edge of the part using a keypoint. On command bar, click
the keypoints list and choose Endpoint.

▸ Select the keypoint location shown.

Change move direction

▸ The primary axis should point down. If your steering wheel position is different,
change the move direction by clicking the cardinal point (1) on the steering
wheel and then click the primary axis.
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▸ Select the keypoint.

Move by keying in a distance

▸ Click the secondary axis.
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▸ Type 10 in dynamic edit box.

Attach the copied feature

The copied feature is in position but is detached from the model.

▸ Right-click in the part window and choose Attach.
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Summary

In this activity you learned how to copy a feature and then position the copied
feature. There are other methods available to move the copied feature to a location
other than what was shown in this activity.

Activity: Copying and attaching a feature (method 2)

Copying and attaching a feature (method 2)

This activity has the same goal as method 1, but uses a different approach.

Open activity file

▸ Open copy_b.par.
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Suspend Live Rules

Live Rules is covered in the Working with geometric relationships self-paced course.
Suspend the Live Rules settings while moving the cutout feature. This ensures no
other faces in the model participate in the move.

▸ On the Live Rules panel, click the Suspend Live Rules (1) button.

Select the feature to copy

▸ Select the cutout feature by clicking Cutout1 in PathFinder.

▸ Position the 3D steering wheel as shown.

Set the copy option and move the feature

▸ On the command bar, choose the Copy option.
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▸ Move the copied feature to the face shown in orange.

Relocate the steering wheel origin

In this activity, use the steering wheel plane to move the copied feature instead of
the secondary axis used in the method 1 activity.

▸ To relocate the steering wheel origin, hold the Shift key down, and drag the
steering wheel origin to the midpoint of the face edge (1). As you drag along the
face edge (1), notice that the steering wheel origin jumps to the midpoint of edge
(1). When you hold the Shift key down to move the steering wheel origin, the
steering wheel orientation remains fixed.

The move is from the midpoint of edge (1) to the midpoint of edge (2).
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Move the copied feature using the steering wheel plane

▸ Click the steering wheel tool plane.

▸ Drag the cursor over the edge shown and click when the midpoint symbol
displays. You may have to turn on the midpoint option on command bar.
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▸ Press the Esc key to end the move command.

Note

Since this copy operation was accomplished in one movement, the copied
feature attaches automatically.

Summary

In this activity you learned how to copy a feature and then position the copied
feature by moving the steering wheel origin and using the steering wheel plane to
define the move vector.

Activity: Copying, rotating, and attaching a feature to a new location

Copying, rotating, and attaching a feature to a new location

This activity guides you through the process of copying a feature, aligning the
feature to an angled face, and then positioning the feature on the model. Use two
methods in the activity.
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Open activity file

▸ Open rotate.par.
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Suspend Live Rules

Live Rules is covered in the Working with geometric relationships self-paced course.
Suspend the Live Rules settings while moving the cutout feature. This ensures no
other faces in the model participate in the move.

▸ On the Live Rules panel, click the Suspend Live Rules (1) button.

Method one overview

Use the Copy option on command bar. Align the feature using the Parallel
relationship command. Position the feature using the steering wheel. Copy feature
(1) onto face (2). Center feature on face (2) with the feature holes aligned to the
midpoint of edge (3).

Select the feature

▸ In PathFinder, select the feature named Protrusion 1.

▸ On the command bar, choose the Copy option.
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Move the copied feature

▸ Position the steering wheel as shown and click the primary axis to start the
move command.

▸ In the dynamic edit box, type 125 and press the Enter key.
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Align the feature to the angled face

▸ On the Home tab®Face Relate group, choose the Parallel relationship

command .

Note

The Face Relationship commands are covered in the Working with face
relationships course. Use the command to change the angle of the copied
feature. You could use the steering wheel to rotate the feature but you
need to know the angle of the face. The parallel relationship command is
an easier step.

▸ When selecting the parallel command, face (1) is the seed face. Select the face
(2) to redefine the seed face.

Select the angled face.
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▸ Click the Accept button on command bar and then press the Esc key.

The feature aligns parallel‘ with the angled face.

Position the feature

▸ Move the steering wheel origin to the center of one of the cylindrical faces as
shown.

mt01413-s-1050 Solid Edge fundamentals 3-67



Lesson 3 Moving and rotating faces

▸ Click the cardinal point shown to define the move direction.
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▸ Click the secondary axis and then select the midpoint of the edge shown.

Note

If you cannot locate the midpoint on the edge, make sure the All keypoints
option is on.
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▸ Move the steering wheel origin to any point on the bottom of the feature.

▸ Click the primary axis and then select the endpoint shown.

Attach the feature

▸ Right-click in the part window and choose Attach.
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This completes the first method of copying, aligning, and positioning a feature.

Method two overview

Use the Copy to and Paste from clipboard commands. Use the short-cut keys Ctrl+C
(copy) and Ctrl+V (paste). Align the feature using the F3 key. Position the feature
using the steering wheel. Copy feature (1) onto face (3). Center feature on face (3)
with the feature holes aligned to the midpoint of edge (2).

To copy a selected feature to the clipboard, press Crtl+C.

To paste a feature from the clipboard, press Crtl+V.

You can also choose the commands from the Home tab®Clipboard group.
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Select the feature to copy

▸ In PathFinder, select the feature named Protrusion 1.

▸ Position the steering wheel origin at any point on the bottom of the feature. This
comes into play when the feature aligns to the target angled face. Make sure the
secondary axis points in the direction shown.

Note

The secondary axis orients normal to the face pasted to.

Copy and paste feature

▸ Press Ctrl+C to copy the selected feature to the clipboard.

▸ Press Ctrl+V to paste the feature. The feature attaches to the cursor.

▸ Drag the cursor over the face shown.

3-72 Solid Edge fundamentals mt01413-s-1050



Moving and rotating faces

▸ Press the F3 key to coplanar align the steering wheel face to the angled face.
This is the reason you position the steering wheel to a point on the bottom of
the feature in an earlier step.

▸ Click to place the feature.
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Rotate the feature

▸ Position the steering as shown and click the steering wheel torus.

▸ In the dynamic edit box, type 90 and then press the Enter key.
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Center the feature on the face

▸ Move the steering wheel origin to the midpoint of a linear edge on the feature
and click the secondary axis point shown to define the move direction.

▸ Click the midpoint on the edge shown.
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Align the feature center to the midpoint on the edge

▸ Move the steering wheel origin to the center of a cylindrical face on the feature
and then click the axis shown to define move direction.

▸ Click the midpoint of the edge.
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Attach the feature to the model

▸ Right-click in the part window and choose Attach.

This completes the activity.

Summary

In this activity you learned how to copy, align, and position a feature. Two methods
were shown to help you understand the available tools for copying geometry.

Detach

The Detach option removes the select set from the part body.

The removed select set can move or rotate.

This option is similar to a cut and paste operation.

Activity: Detaching and attaching a feature

Detaching and attaching a feature

The activity guides you through the process of detaching an extruded feature and
then attaching the copied feature at a new location on the model.
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Open activity file

▸ Open detach_a.par.

Suspend Live Rules

Live Rules is covered in the Working with geometric relationships self-paced course.
Suspend the Live Rules settings while moving the cutout feature. This ensures no
other faces in the model participate in the move.

▸ On the Live Rules panel, click the Suspend Live Rules (1) button.
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Select the feature to detach

▸ In PathFinder, click the feature named Protrusion 2.

Position the steering wheel origin

▸ Drag the steering wheel origin to the midpoint of the edge shown.

Move the feature

▸ On the command bar, choose the Detach option.
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▸ Click the steering wheel tool plane to start the move.
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▸ Select the midpoint of the edge shown to complete the move.

Attach the feature

▸ Right-click in the part window and choose the Attach command.
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Summary

In this activity you learned how to detach a feature, move it to a new location, and
then attach the feature to the model. This process is similar to a cut and paste
process.

Precedence

Use the precedence option to set which faces have priority during a synchronous
move operation.

Select Set Priority

Selected and other moving faces have priority over non-moving faces.

Model Priority

Non-moving faces have priority over moving faces.

Lesson review

Answer the following questions:

1. Name the three connected faces options and briefly describe the results of each
option.
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2. When you copy a set of faces or a feature, what happens to the original faces?

3. When using the Copy to (Ctrl+C) clipboard command, what is the importance of
the steering wheel secondary axis direction?

4. What does the Detach option do?

5. Explain the Precedence option.

Lesson summary

Use the move command bar options to control the behavior of the select set during
a move operation.

Working with Live Sections

Working with Live Sections

You use the Live Section command to create a 2D cross-section on a plane through
a 3D part. For example, you can select one of the principal planes on the base
coordinate system as the plane for a live section.

Live sections can make it easier to visualize and edit certain types of parts, such as
parts that contain revolved features. You can then edit the 2D elements of the live
section to modify 3D model geometry.
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Creating live sections

You can select a planar face, reference plane, or principal plane on a coordinate
system as the plane for the live section. When you select the plane, a live section is
created, similar to a section view in a drawing. When the live section passes through
a procedural feature, such as a hole, an edge set is created.

An entry for the live section is added to the Live Sections collector in PathFinder.

Automatic creation of live sections

When creating a revolved extrusion or cutout, use the Create Live Section option (1)
to create a live section upon feature completion. The option is on by default.

All sketch dimensions migrate to the live section.

Editing live sections

You edit a live section using the Select tool and the 2D steering wheel editing handle.
You can edit individual elements or you can edit the entire live section.

Editing 2D elements in a live section to modify the 3D model

When you select a 2D element in a live section, the 2D steering wheel editing
tool appears. You can use the handles on the 2D steering wheel to move or rotate
the live section element to modify 3D model geometry. If the live section element
you select is an edge set created from a procedural feature, such as a hole, the
editing handle for the procedural feature is also displayed.

You can also place PMI dimensions on the 2D elements of a live section and then
edit the dimension value to modify the model.
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Note

When moving a live section element using the 2D steering wheel edit
tool or a PMI dimension, the current settings in Live Rules are used to
control the edit behavior.

Editing the entire live section

You can select the entire live section using PathFinder or QuickPick. You can
then use the steering wheel to move or rotate the entire live section. When you
move or rotate the entire live section, 3D model geometry is not modified. The
live section recalculates at its new position. This can be useful when you have
modified the 3D model using other methods, such that the live section is no
longer positioned where you want it.

Displaying live sections

You can use the check box adjacent to a live section entry in PathFinder to show or
hide a live section in the graphics window. You can use the check box adjacent to the
Live Sections collector to display or hide all the live sections.

You can use the Live Section Colors section on the Colors page of the Solid Edge
Options dialog box to specify the colors you want to use for the edges, centerlines,
and regions for live sections.

Model editing and live section update

The live section automatically updates when you add or remove features, or directly
edit the 3D model. For example, if you add a pattern of holes to a synchronous model,
the live section automatically updates.

Live sections in an assembly

You can edit a 2D element on a live section to modify a part in the context of an
assembly. You can use the keypoints on adjacent parts to modify the live section
element with respect to other parts in the assembly.

You can use commands on the shortcut menu to control the display of live sections
on a selected part.
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Activity: Live Section

Live Section

This activity guides you through the process of creating a live section through a
model. The model is modified by manipulating the live section edges.

Open activity file

▸ Open live_section.par.

Create a section plane

▸ On the Home tab®Planes group, choose the Coincident Plane command.
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▸ Select the plane shown.

▸ Move the coincident plane to the midpoint of the edge shown.
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Create a Live Section

▸ On the Home tab®Section group, choose the Live Section command .

▸ Select the plane created in the previous step to define the live section.

At this point you can use the steering wheel to move the live section if desired.
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▸ Press the Esc key to end the live section command.

▸ Notice in PathFinder that a Live Sections collector appears. You control the
display of a live section with the check box.

Move a face

Instead of selecting a face to move, you can select the edge created by the section
through a face to move. Moving the edge is the same as moving the face.
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▸ Select the edge shown and move it to observe the behavior.

Dynamically move the edge but do not click. Press Esc to end the move. Press
Esc again to clear the selected edge.

Note

The edge can take on all operations that its parent face can (for example:
dimension, rotate, delete).

Modify the model shape by manipulating the live section

The model does not have to display to manipulate a live section. Turn off the display
of the model.
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▸ Right-click in the part window and on the shortcut menu choose Hide All ®
Design Body. Hide all reference planes too.

▸ Change the display to a front view. Press Ctrl+F.
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▸ Rotate the two arms on the left 15° about the center hole. Select the live section
edges shown using a fence.
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▸ Move the steering wheel origin to the center of the hole as shown.

▸ Change the orientation of steering wheel. Click the cardinal point shown and
then click the midpoint of the right edge.
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▸ Click the torus. Type 15 and press the Enter key.

Note

If you get an error during the rotation, click the Suspend Live Rules (1)
button. After completion, uncheck suspend live rules.

▸ Press the Esc key to end the move command.
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Observe model changes

▸ Change to a Dimetric view.

▸ On the shortcut menu, turn on the display of the Design Body. Notice that the
model changes to the modifications made to the live section.
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Delete a face

▸ Click the circular edge shown and press the Delete key.

Deleting the live section circular edge is the same as deleting the circular face.

Remove material to create a slot

▸ Turn off the design body display.
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▸ Draw a sketch containing two lines and one arc. Choose the Line command and
click the right section edge.
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▸ Align the circle center with the midpoint of the right edge.

▸ Select the region shown.

▸ On the command bar, click (1) to set the Through All extent option, click (2) to
set the Symmetric extent, and click (3) to set the Remove material option.
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▸ Click on a direction handle and dynamically drag to exceed the width of the part.
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Change display to observe the changes

▸ Turn on the design body.

▸ In PathFinder, turn off the live section display.

This completes the activity.

Summary

In this activity you learned how to create a live section. The live section command
creates edges where a user defined plane intersects the design body. Each live
section edge represents a face in the model. You can select either the face or live
section edge to modify the model.

Lesson review

Answer the following questions:

1. How do you create a Live Section?

2. How do you edit a model with a Live Section?

3. When creating a revolved feature with a dimensioned sketch, what is the result
when you choose Live Section option on the revolve command bar?
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4. How do you redefine the live section?

Lesson summary

You use the Live Section command to create a 2D cross-section on a plane through
a 3D part. For example, you can select one of the principal planes on the base
coordinate system as the plane for a live section. Live sections can make it easier to
visualize and edit certain types of parts, such as parts that contain revolved features.
You can then edit the 2D elements of the live section to modify 3D model geometry.
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Face relationships overview
When modeling synchronous features, you have control over the solve behavior
of a model or an assembly during face editing. The control is achieved through
relationships between faces. Face relationships are inherited from sketch elements
used to create the faces of a body feature. Face relationships are also applied
using the relationships commands in the Home tab®Face Relate group. Applied
relationships are made permanent by the default persist setting on the command
bar. If a relationship is to be temporary, you can turn off the persist option.

Relationships are assigned to faces. During a face move, Live Rules considers
found relationships, persistent relationships, and locked dimensions in the model.
Live Rules controls any or all of these during the operation. Found relationships
are applied based on the geometric state of the model during edit, as well as on
the Live Rules settings.

Live Rules settings control what you want to look for.

Creating face relationships

Creating face relationships

• Use the relationship commands in the Face Relate Group (1) to apply face
relationships to selected faces.

• The face relationship commands define how faces relate to each other. You select
a face to relate (seed face) and then select a face to relate to (target face). This
does not apply to the Ground, Rigid, and Horizontal/Vertical commands.

• A relationship is permanent (Persist option on) by default. However, the
relationship can be set to temporary (Persist option off).

• Persistent and temporary relationships that are detected can be ignored by the
system during a solve of a geometric change.

Face Relate command bars

Each face relate command has a unique command bar.

The following is an example of the coplanar relationship command bar.
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Understanding seed and target faces

Seed face

• The seed face refers to the initial face selected.

• The seed face is the face to be related.

• The seed face position changes.

• The steering wheel locks onto the seed face.

• More faces can be related simultaneously by adding the faces to a select set. The
seed face definition remains.

Target face

• The target face defines the relationship to be applied to the seed face.

• The target face does not change during the Relate command.

• There can only be one target face.

Persist

Relationships applied through the face relate commands are persistent by default.

A persistent relationship:

• Is always detected by the system during a synchronous command.

• Is stored in the Relationships collector in PathFinder.

• Can be deleted using the relationships context menu in PathFinder.

• On a face in a select set, a persistent relationship can be turned off in Solution
Manager. If turned off, the persistent relationship is deleted after the command
completes.

Non persistent relationships are ignored if that specific relationship is turned off
in Live Rules.

Accept or cancel

If the desired relationship results are achieved, click Accept. The face relationship
command ends but the select set remains active.

If the desired relationship results are not achieved, click Cancel. The face
relationship command ends but the select set remains active.
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Single/All face alignment

Single Align

Only the seed face is related to the target face. The remaining faces in the select set
maintain their original relationship with the seed face.

Multiple Align

All faces in the select set relate to the target face.

Relationships

Concentric

Relates cylindrical faces concentric to each other.

Coplanar

Relates faces coplanar to each other.

Parallel

Relates faces parallel to each other.

Perpendicular

Relates faces perpendicular to each other.
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Tangent

Relates two faces tangent at their connection edge (1) or tangent by touching a
theoretical face extension (2).

Rigid

Locks face plane orientations to one another. Rigid relationship is automatically
persistent. Faces with a rigid relationship can be trimmed and extended. Image
below shows the rigid relationship in PathFinder.

Ground

Fixes a face plane. A fixed face can be trimmed and/or extended. A fixed face can
translate in its plane only. Multiple faces can be grounded. A ground relationship is
permanent (persistent). Image below shows the ground relationship in PathFinder.

Symmetric about

Makes a selected face symmetric to a target face about a face or plane.

Symmetric about workflow

1. Select face to be modified (referred to as the seed face).

2. Select target face. This face determines what the seed face is symmetric to.

3. Select symmetry plane or face.
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4. Accept.

Equal radius

Makes the radius of a selected cylinder/partial cylinder(s) equal to the target
cylinder/partial cylinder.

Coplanar axis

Makes selected holes/cylindrical faces aligned on an axis that is parallel to a target
face/plane. The target face/plane can be selected on the part or a custom axis can
be defined. See the following activities:

• Coplanar axis hole alignment

• Coplanar axis alignment using a custom axis

Offset

Makes the selected face(s) parallel to the target face with an offset distance.

Horizontal and vertical

Makes a selected planar face parallel to the most similar base reference plane. You
also can apply a horizontal/vertical constraint between two keypoints relative to
a reference plane.

Workflow for relating faces

The following workflow applies to the coplanar, concentric, parallel, perpendicular,
perpendicular, symmetry, offset, and tangent relationship commands.

1. Select a relationship command on the Home tab®Face Relate group and then
select a face (seed) or a select set (a seed face with additional faces).

or

You could also select a face (seed) or a select set (a seed face with additional faces)
and then select a relationship command on the Home tab®Face Relate group.

2. If more than one face is in the select set, click the Single/Multiple Align option.

3. At this point, you can select a target face, which will use the default option
settings. Other options can be selected at any time during the command.

4. Select the target face (face for the seed to be related to).
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5. Relationships are permanent by default. If the relationship is to be temporary,

click the Persist option .

6. If the desired result is not achieved, click Cancel . The select set
remains and the relationship command can be started again.

7. If the desired result is achieved, click the Accept button to apply
the relationship.

Activity: Relating a single face with a rigid select set

Relating a single face with a rigid select set

Learn how to use the Coplanar command to apply a relationship to a single face
while the select set remains rigid to the single face.

Open activity file

▸ Open rigid_set.par.
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Problem

Align the clevis base (2) at a 10° angle measured from the left upper edge (1). Clevis
faces are to maintain their position (rigid) relative to the clevis base.

Create a 10° face

The face created in this step is a construction face.

▸ Select the face shown and click the Copy option (1) on the command bar.

4-8 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

▸ Drag the steering wheel to the edge shown. Rotate the copied face about this
edge.

▸ Click the torus on the steering wheel and then type 10 in the dynamic edit box.
Press the Enter key.
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Ground faces

In order to control the result, we will need to ground two faces.

▸ On the Home tab®Face Relate group, choose the Rigid command.

▸ Select the two faces shown and click Accept.

Note

After the synchronous edit, you can remove the two ground relationships
in Pathfinder.
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Define the select set for the clevis

▸ Select the seed face. This is the face that will have a relationship applied to it.
Select the face shown.
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▸ To add faces to a select set, you press the Spacebar. Press the Spacebar and

notice the selection mode symbol next to the cursor . Faces you select now
add to the select set. Place a rectangular fence as shown. This selects all the
faces that are part of the clevis.

Choose the Relate command and options

▸ On the Home tab®Face Relate group, choose the Coplanar relationship
command.
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Define the target face

The target face is the face copied at the 10° angle. Selecting this target face makes
the seed face coincident with it.

▸ Select the target face.

▸ On the command bar, click the Accept button.

▸ Double-click to end the Coplanar relationship command. Press Esc to clear
the select set.

▸ Notice that with the persist option on, a coplanar relationship between the seed
face and the target face (the copied rotated face) is in the Relationships collector.
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▸ To verify the alignment, go to the front view by pressing Ctrl+F.

Turn off the copied face

▸ In PathFinder, clear the check box for the copied face. This turns off the display.
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▸ This completes the activity.

Summary

In this activity you learned how to use a relate command to apply a coplanar
relationship between two faces. You also learned how to include other faces in the
relate operation.

▸ Close the file and do not save.

Activity: Relating faces using parallel, coplanar, perpendicular and concentric
relationships

Relating faces using parallel, coplanar, perpendicular and concentric relationships

Learn how to use the Relate Face command to apply relationships that will alter
the shape of an existing part.

Open activity file

▸ Start Solid Edge.

▸ Open existing file relate.x_t.

▸ Open with the iso part.par template.

Note

Restore the Live Rules to the default settings. On the Live Rules panel, click

the Restore button . You must select a face to display the Live Rules panel.

Problem

Align several faces to change the shape of the part. The purpose of the activity is to
learn to apply face relationships and observe the results.
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Change the orientation of the center feature

Vertically align the angled center feature (green).
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▸ Select the side face shown. This is the seed face. This is the face to align.

▸ You want the other faces on the feature to move with the selected face. Selecting
these faces makes them rigid to the seed face. You can select each face
individually or use a select box. Press the Spacebar to enter the Add/Remove

selection mode .
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▸ Rotate the view and use a selection box.

▸ The select set is defined. On the Home tab®Face Relate group, choose the

Parallel relationship command .

4-18 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

▸ Select the face shown to align to.

▸ Click the Accept button and then press the Esc key..
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▸ The center feature orients vertically and its position changes. Click the Cancel
button. The select set is still active. Move the vertical feature to approximately
the center of the top face.

▸ You can dimension the feature for an accurate position. Press Esc to end the
command.
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Apply concentric relationships

Align the holes (green) concentric to the cylindrical feet (red).

▸ Select a hole. The holes are concentric. Since the concentric rule is on, both
holes stay aligned.

▸ On the Home tab®Face Relate group, choose the Concentric relationship

command .
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▸ Select the cylindrical face shown to align the hole to.

▸ The Persist option is on by default. Click the Accept button.

▸ Repeat for the other hole. Notice the concentric relationships add to the
Relationships collector in PathFinder.
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Apply perpendicular relationships

Align the angled face (red) perpendicular to side face of part (blue).

▸ Select the face.
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▸ Add the two faces shown to remain rigid with the selected face.

▸ On the Home tab®Face Relate group, choose the Perpendicular relationship

command .

▸ Select the side face.
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▸ Click the Accept button.

▸ Repeat the alignment for the faces on the opposite side.
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Apply coplanar relationships

Make the red faces coplanar.

▸ Select the face shown and then add the face on the underside to remain rigid to
the selected face.

▸ On the Home tab®Face Relate group, choose the Coplanar relationship

command .
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▸ Select the face shown and then click the Accept button.

Apply more coplanar relationships

Align the green face coplanar with the red face. Make sure to add the face on the
underside. Since coplanar live rule is on, the faces on the opposite side align also.

Apply more coplanar relationships

Align the blue faces coplanar with the red face. The blue faces are not coplanar. Use

the Multiple Alignment option located on the Coplanar relationship command
bar.
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Align the faces on the back side also.

Summary

In this activity you learned how to use the relate command to apply a relationship
to modify a part shape. You also learned how to make a relationship permanent
(persistent) and also how to make other faces rigid to the face being aligned.

▸ Close the file and do not save.

4-28 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

Activity: Applying a relationship to all faces in a select set

Applying a relationship to all faces in a select set

Learn how to use the relationship commands to apply the same relationship to
each face in the select set.

Open activity file

▸ Open independent.par.

Problem 1

Use the system default Live Rules.

Make all green faces parallel to the yellow face.

Since the Live Rules coincident rule is on, only one face needs be selected for each
row. Both top planes in each row are coplanar.

Select faces

▸ Select the faces shown.
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Choose the Parallel relationship command and options

▸ On the Home tab®Face Relate group, choose the Parallel relationship command

.

▸ On the command bar, select the Multiple Align option .

▸ On the command bar, deselect the Persist option .

Select target face

▸ Select the face shown.
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▸ Notice that all selected faces are now parallel to the target face. Accept the
results by clicking the Accept button.

▸ Press the Esc key to clear the select set.

Problem 2

Make all rows the same height as the shortest one.

▸ Select the faces shown.

▸ On the Home tab®Face Relate group, choose the Coplanar relationship

command .

▸ On the command bar, select the Multiple Align option .
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▸ Select the target face.

▸ Accept the results and end the command.

Problem 3

Make all faces coplanar with the inclined face on the left end.

▸ Select the face shown. Since coplanar live rule is on, the other faces are included
in the coplanar relationship operation.

▸ On the Home tab®Face Relate group, choose the Coplanar relationship

command .

▸ On command bar, select the Single Align option .
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▸ Select the target face.

▸ Accept results and end the Coplanar command.

Summary

In this activity you learned how to use the relationship commands to apply a
relationship to each face in a select set. You also learned how to take advantage of
the live rules so every face to be included does not have to be selected.

▸ Close the file and do not save.

Activity: Coplanar axis hole alignment

Coplanar axis hole alignment

Learn how to use the Coplanar axis relationship command. A random placement
of holes exist on a planar part face. Align the holes along an axis parallel to an
orthogonal face.
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Open activity file

▸ Open coplanar_axis.par.
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Select the holes to align

▸ Select the four holes to align. Select the holes in PathFinder or select them by
clicking each hole on the part.

Align the selected holes

▸ On the Home tab®Face Relate group, choose the Coplanar Axis relationship

command .
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▸ Select the face or plane to align the axis with. Select the face shown.

▸ On the command bar, click the Accept button.

Note

The seed hole (1) remains fixed and all other holes in the select set move
to align with the seed.
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Move the aligned holes

The holes align along the base X direction. The face selected to align to in the
previous step is an orthogonal face, thus the alignment axis of the holes aligns with
the base X direction. The live rules setting Maintain coplanar axes can detect holes
that align with one of the base directions.

If you move a hole, all holes that align with it move. If this live rule is turned off,
then only the selected holes move.

▸ Select any hole.
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▸ Click the steering wheel axis shown to start the move.

▸ Select the midpoint of the edge shown to define the move distance. This
movement positions the line of holes centered on the part. You may have to turn
on the midpoint keypoint locate on command bar.
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Note

When moving a set of holes that axially align, the spacing between the holes
remain unchanged if the move direction is perpendicular to the alignment
axis. If the move direction is not perpendicular to the alignment axis, then
the holes’ spacing may not remain fixed. To ensure that the holes maintain
a fixed spacing, it is recommended that locked dimensions be added to the
hole spacing.

Summary

In this activity you learned how to align holes along an axis. As long as the
alignment axis remains orthogonal, then live rules detects the alignment and holes
remain aligned during a synchronous modification. A non-orthogonal alignment
can be created by using a custom axis.

▸ Close the file and do not save.

Activity: Coplanar axis alignment using a custom axis

Coplanar axis alignment using a custom axis

Learn how to use the Coplanar Axis relationship command. The previous activity
used an orthogonal face to define the alignment axis. This activity uses a custom
axis. The custom axis is defined by a plane whose first two points are the axis of the
first hole selected and the third point is a center point on one of the other holes in
the select set. All holes in the select set are aligned with the custom axis.

Open activity file

▸ Open coplanar_axis_custom.par.
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Select the holes to align

▸ In this activity, the holes are cylindrical cutouts. Since the four holes were
constructed with a single cutout operation, you must select each cylinder on the
part. You cannot select each cylinder in PathFinder. Use QuickPick if needed to
select the cylinders. Select the four cylinders shown to align.

Align the selected holes

▸ On the Home tab®Face Relate group, choose the Coplanar Axis command .

▸ On the command bar, turn off the Persist option .
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▸ Notice the message in PromptBar to select a point or a plane.

Select the circular edge shown. Cylinders are custom axial aligned. On the
command bar, click Accept.

▸ Press the Esc key to end the Coplanar Axis relationship command.
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Move the aligned cylinders

The cylinders are axial aligned but not aligned with a base axis. Live Rules does not
detect these cylinders as being aligned. A Live Rules option is available to define a
custom axis. When this is set, live rules detects the aligned cylinders.

▸ Select the cylinder shown and then click the primary axis to start the move
command.

▸ Notice that only the selected cylinder moves. Do not click or exit the command.
Go to Live Rules and click the custom axis button.

▸ Select the cylinder shown to define the custom axis direction.

▸ Notice that now as you move the cursor, the aligned cylinders move together
while staying aligned. Click to move a small distance and then end the command.
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Note

When moving a set of holes that are axially aligned, the spacing between
the holes remain unchanged if the move direction is perpendicular to the
alignment axis. If the move direction is not perpendicular to the alignment
axis, then the hole spacing may not remain fixed. To ensure that the holes
maintain a fixed spacing, it is recommended that locked dimensions be added
to the hole spacing.

Align the cylinders with part geometry

▸ Apply a concentric relationship between cylinder (1) and cylinder (2).

Apply a concentric relationship between cylinder (3) and cylinder (4).
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▸ Select the four cylinders.

▸ Choose the Coplanar Axis relationship command.

▸ Select the circular edge shown to define the axial alignment direction. On the
command bar, click Accept. Press Esc to end the Coplanar Axis command.

Note

To keep these cylinders aligned you could persist the coplanar axis
relationship.
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Summary

In this activity you learned how to align holes along a custom axis. Live Rules does
not recognize this alignment unless the custom axis option is set and defined.

▸ Close the file and do not save.

Lesson review

Answer the following questions:

1. Where are the face relationship commands located?

2. What is a selected seed face?

3. What is a selected target face?

4. Explain the workflow for applying a face relationship.

5. What is a persistent relationship?

6. How do you remove a persistent relationship?

7. Explain the Single/Multiple option.

8. Which of the following is NOT a face relationship?

• Parallel

• Concentric

• Coplanar

• Angled

9. Do sketch geometric relationships migrate to model faces?

Lesson summary

You modify synchronous models by defining relationships between faces using the
Face Relate commands. The Face Relate commands are available when one or more
faces or a reference plane is selected. You can use the options on the relationship
command bar to specify how you want the selected face to be geometrically related
with the target face.

Detected face relationships

Detected face relationships

Overview

• Face relationships are detected during a synchronous face modification.
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• During a synchronous face modification, the system is instructed to detect
relationships turned on in Live Rules, persistent relationships, and dimensional
constraints.

• Solution Manager provides control of the solve behavior of the model during a
synchronous face modification.

• In Solution Manager, relationships detected can be removed and thus ignored
during face modification.

• New relationships can be added to the Live Rules to be included in the face
modification.

Live Rules

The user can control which face relationships Solid Edge detects during a
synchronous face move. Live Rules is the tool used to set the face relationships to
detect. Live Rules appears in the document window when a part face is selected.

Live Rules is a global setting while the Solid Edge application is running. If a
change is made to the default settings, opening a new or existing file will use these

settings. The Restore Defaults button returns the default settings to the system
delivered settings. When the Solid Edge application closes, the Live Rules return
to the default settings.

Live Rules Panel location

You control the Live Rules panel from the Application button®Solid Edge
options®Helpers page. The default option fixes the Live Rules panel to the bottom
center of the modeling window. You can set the Live Rules panel to floating. This
allows you to drag the panel to any location in the modeling window. You can also
set a floating panel to a vertical display.

Working with Live Rules

Use the Live Rules options to locate and display the inferred geometric relationships
between faces in the current select set and the rest of the model. Use this information
to control how synchronous modifications are performed.

For example, when moving a planar face, use Live Rules to locate and display all
the faces in the model that are coplanar to the face you are moving. Then use Live
Rules to specify whether any, some, or all of these coplanar faces are moved when
the selected face moves.

Live Rules is available for the following types of synchronous modeling modifications:

• Moving or rotating model faces or features in a synchronous part or assembly
document.

• Defining 3D geometric relationships between model faces using the Face Relate
command in a synchronous part document.
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• Editing the value of a 3D dimension in a synchronous part or assembly document.

• Editing the dimensional value of a locked 3D dimension using the Variable Table.

Note

Live Rules are not used when editing hole and round features using the Edit
Definition handle.

Live Rules options

Live Rules automatically appears when moving faces, defining 3D relationships, or
editing dimensions. The active options in Live Rules determine how the rest of the
model reacts to the edit you are performing.

For example, when moving a single planar face with the steering wheel (1), you can
use Live Rules to specify whether other coplanar faces, which are not in the select
set, stay coplanar during the move operation.

In this example, when the Coplanar option in Live Rules is on, the deselected
coplanar faces stay coplanar (2) when moving the selected face. When the Coplanar
option in Live Rules is off, the deselected coplanar faces remain stationary (3) when
moving the selected face.
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Relationship detection indicators in Live Rules

Detected and active

When Live Rules detects model geometry that matches an active setting (1) in
Live Rules, the setting display in Live Rules appears in green (2).
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Detected and inactive

When Live Rules detects model geometry that matches an inactive setting (1) in
Live Rules, the setting display in Live Rules appears in red (2).

Restore Live Rules

The Live Rules options you select or clear for the current edit operation are
maintained for future edit operations in the current design session. When you exit
Solid Edge, the Live Rules settings return to the default settings.

You can click the Restore Defaults button to restore the default Live Rules
options.

Suspend relationships

You can also Suspend relationships detected for the current edit operation.

Suspend options for relationship categories are on the Live Rules panel. When
making a synchronous edit, the solution honors on these options. You can suspend:

• (1) Live Rule relationships.

• (2) Locked dimensions.

• (3) Persisted relationships.
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When you suspend a relationship category, the button changes as shown.

Orthogonal to base if possible

As a face moves, this option attempts to keep attached faces parallel to base
reference planes.

Detect local symmetry

Option to detect a local symmetry plane. You are prompted to select a local symmetry
plane to use for symmetric face detection.

Activity: Detecting symmetry relationships

Detecting symmetry relationships

Learn how to detect local symmetry during a synchronous modification.

Open activity file

▸ Open symmetry.par.
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Turn on reference planes

▸ Turn on the base reference planes. Observe that the model was not designed
symmetrically about the base reference planes. In PathFinder, click the check
box for the three base planes.

▸ Turn off the base reference planes.

Move a face

The model was not designed symmetrically about the base planes. However, a
symmetry plane was used to mirror features.
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▸ Turn on the plane used for symmetry. In PathFinder, click the check box for the
plane named symmetry plane.

▸ Select the face shown and then move it to observe the results. Only the selected
face moves. Do not click.

▸ Press the Esc key.

Detect symmetry during a move

▸ Click the move handle again.

▸ This time we want to detect symmetry. In Live Rules, click the Local Symmetry
button.
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▸ Select the symmetry plane shown.

▸ Notice that as you move the selected face, the symmetric face also moves. Type
20 in the dynamic input box and then press the Enter key. Press the Esc key to
end the move command.
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Modify the model

▸ Select the faces shown.

▸ Move the select set of faces a distance of 30. Select the detect local symmetry
button to make a symmetric move. Select the plane named symmetry plane.

Summary

In this activity you learned how to detect symmetry about a plane that is not a base
reference plane. The symmetric about relationship is automatically persisted.

▸ Close the file and do not save.

Activity: Applying a symmetric about relationship

Applying a symmetric about relationship

Learn how to make features (1) and (2) symmetric to a target face about a symmetry
plane (3).
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Open activity file

▸ Open symmetric_about.par.

Problem: Make feature (1) symmetric to feature (2) about the symmetry plane
(3).
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Apply a rigid relationship

Apply a rigid relationship to feature (2). You do this because relationships are
applied to faces. You want the entire feature (2) to move with the face that has
a symmetric relationship applied to it.

▸ In PathFinder, select Protrusion B.

▸ On the Home tab®Face Relate group, choose the Rigid relationship command

.

▸ On the command bar, click the Accept button.

Create a symmetry plane

▸ On the Home tab®Planes group, choose the Coincident Plane command.

▸ Select the face shown.
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▸ Move the coincident plane a distance along the primary axis direction that
extends to the arc center shown.

Apply a symmetric about relationship

▸ Select the face shown.

▸ On the Home tab®Face Relate group, choose the Symmetry relationship

command .
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▸ Select the face shown as the target symmetric face and then right-click to accept.

▸ Select the plane shown for the symmetry plane.

▸ On the command bar, click the Accept button.

Note

A symmetry relationship is automatically persistent.

Observe symmetric behavior

▸ Select the face shown. Click the axis and dynamically move it. Notice that the
features Protrusion A and Protrusion B move symmetrically.
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This completes the activity.

Summary

In this activity you learned how to make two faces symmetric about a plane.
The selected face (seed face) is modified to be symmetric to a target face about a
symmetry plane. Use the Symmetry relationship command. Only the seed face
moves unless a rigid relationship is applied to the other faces that are to move along
with the seed face.

▸ Close the file and do not save.

Solution Manager

Solution Manager overview

Synchronous models use face relationships to control the model behavior during an
edit. These face relationships include:

• Found

Relationships the system finds at the instance of a synchronous edit. These
relationships are found if the relationship type is turned on in Live Rules.

• Persisted

User applied relationships that are permanent and are maintained during a
synchronous edit.

• PMI

Locked dimensional relationships.

It is possible that a synchronous edit could fail due to an over constrained condition.
It is also possible for a synchronous edit be successful but produce unexpected or
unwanted results. Solution Manager provides detail and actions regarding the faces
participating in the solution of a synchronous edit. Solution Manager is a tool that
graphically interacts with the model to provide control of all relationships relevant
to the current solve.

Solution Manager is an optional step during synchronous move or edit operations.
When in Solution Manager mode:

• Relevant faces change color to represent their role in the solution.

• Click on a face to switch between relationships.

• Right-click a face for access to all relationships to the face.

mt01413-s-1050 Solid Edge fundamentals 4-59



Lesson 4 Working with face relationships

• Click a locked dimension to relax the constraint. The dimension returns to a
locked state after making an edit.

Solution Manager options

The Solution Manager options are located on the Live Rules panel. During a
synchronous edit, the Solution Manager button (1) changes from inactive to active
(2). The Auto-Solution Manager button (3) is off by default.

When Auto-Solution Manager is turned on, synchronous edits automatically start
the Solution Manager.

• If there are no failures and you are satisfied with the solution, you complete the
edit and then click the check box (4) to accept the results.

• If the solution produces unwanted results or a failed condition, you click the
Solution Manager button to make changes to the solving face relationships. You
can also press the V key to start Solution Manager.

When Auto-Solution Manager (3) is turned off, you must manually start the Solution
Manager.

Model display in Solution Manager

In Solution Manager mode, the model faces that participate in the solution change
colors.

The following example illustrates the face coloration in a successful solution
situation.

Synchronous editing starts when you select a face.
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As the cursor moves, the faces dynamically extend.

When Solution Manager starts, model faces involved in the solution change color.
The remainder of model faces display as transparent.

The following example illustrates the face coloration in a failed solution situation.

During a synchronous edit,
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as the cursor moves in a dynamic extent, notice that an error occurs. The
solution is in a fail state.

When Solution Manager starts, model faces involved in the solution change color.
The remainder of the model faces display as transparent.
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Face Type Color Example Notes
Rest of Model - ROM Transparent
Select Set Green (Select color)
Failed placement of
Select Set – These
faces are where we
would like the select
set to be if it were
solving successfully.

Orange (Highlight
Color)

Solving (not error
path) no relaxed
relations

“Solving” Blue (Sky
Blue)

Solving, but with some
severed relationships.

½ “Solving” Blue (Sky
Blue)
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Failed Path Cases Orange (“Over
constrained” Color)

Rigid Procedural
Features (Ribs, Webs,
Patterns, etc.)

Purple (“Driven” color)

Grounded Faces Black Overrides any other
coloration.

Isolated Faces Red (Handle Color) Overrides any color
other than black.

Managing face relationships in Solution Manager

In Solution Manager mode, only faces that are relevant to the solution display in
color. The nonparticipating faces display transparent. Right-clicking a colored face
displays a relationship palette listing all relationships to the face.

Relationship palette

Columns

• Found relationships (1). These are the detected relationships that are turned
on in Live Rules.

• Dimensional constraints (2)

• Persisted relationships (3)

Hovering over a relationship on the palette (4, 5) exposes a fly out option. Use the fly
out option to turn off all similar relationships to other faces.
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Example

You can turn off a coplanar relationship to all of the coplanar faces. This is
handy if there are numerous faces to control. You can turn them all off and
then selectively turn on the faces that are to participate in the synchronous
edit.

The yellow triangle (6) on a relationship denotes that the relationship contributes to
a failed solution.

Solution Manager workflow

1. Select a face to edit.

2. Click the primary axis on the steering wheel to start a synchronous edit
operation.

Note

Two solution conditions are possible (success or failure). You can use the
Solution Manager in both conditions.

3. Start Solution Manager by pressing the V key or by clicking the Solution
Manager button on the Live Rules panel.

Note

If Auto-Solution Manager is turned on, Solution Manager starts when
you click to define a move distance.

4. While in Solution Manager mode, you graphically interact with the face
relationships involved in the edit. You resolve over constrained relationships in
failed conditions. You change relationships in a successful condition to produce
the intended solution.

5. When the synchronous edit is complete and no failed condition exists, you click
the check box. This exits the Solution manager mode.

Examining dimension changes during a synchronous edit

While in Solution Manager mode, you can examine the dimension values that are
affected by the synchronous edit.

• Unaffected dimensions are automatically hidden, as shown on the right portion
of the image below.

• Changed dimensions (3) automatically display if hidden, and a changed
dimension indicator symbol (1) displays in the top-right corner of the graphics
window.

• Detached dimensions (4) automatically display if hidden, and a detached
dimension indicator symbol (2) displays in the top-right corner of the graphics
window.
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You can use view commands such as Fit, Rotate, and Zoom to better observe the
faces and dimensions on the model which are changing.

You can click the indicator symbols (1, 2) to display total count values for changed and
detached dimensions in PromptBar. You can also pause the cursor over individual
changed or detached dimensions to display their previous value in PromptBar.

Demonstration

A face is rotated and an edge of the face has a driven angular dimension. A

model change indicator displays showing that a dimension is changing. A face is
then rotated and as the face moves it consumes a face that has a dimensioned edge.

A model change indicator appears showing that a dimension is detached.

Activity overview: Synchronous editing scenarios

Learn how to use the Solution Manager to graphically interact with a model during
a synchronous edit. You can alter an edit solution or correct a problem where the
solution fails. The activities present several synchronous edit scenarios so you
can understand how to use Solution Manager in a situation that may arise while
designing a model.
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Scenario 1

Scenario 2
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Scenario 3

Activity: Using Solution Manager (scenario 1)

Using Solution Manager (scenario 1)

Extend the part 20 mm in the X direction. All of the red faces should move as a
rigid set.
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Note

The four holes are aligned with a coplanar axis relationship. The outside
cylindrical faces are concentric to the holes.

Open the part file

▸ Open solution_manager_scenario1.par.

Live Rules settings

▸ On the Live Rules panel, click the Restore button (4) to set Live Rules to the
default settings. Auto Preview (5) should not be checked.

Define the select set

▸ Select the two faces shown.

▸ Start the synchronous edit by clicking the primary axis.
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▸ In the dynamic edit box type 20 and press Enter.
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Observe the graphical edit feedback

Notice that the fail symbol displays. This symbol is an alert that the solution is
in a failed condition. When a failed condition occurs, you are placed in the Solution
Manager mode. When in Solution Manager mode, the Solution Manager button
changes from a magnifying glass to a check mark.

Notice the face color changes.

• Orange

Faces failing to move

• Green

Select set faces

• Blue

Faces participating in the edit

• Transparent

Faces not involved in the edit

• Black

Grounded faces
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Investigate failure

You can right-click on any colored face to display a palette of relationships applied to
the face.

Pausing over a colored face displays a tool tip with the solve status.

▸ Pause over the face shown to display the tool tip.

▸ Right-click on the cylindrical face shown to display the relationships palette (1).
The relationships with a yellow triangle are the relationships that are involved
in the failed solution.
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Resolve over constrained condition

You can relax an over constrained relationship to allow an edit to solve. Your
intended solution dictates what relationships to relax. In this example, the 120
dimension is locked. This causes the edit to fail.

You can relax the locked dimension in three ways.

• Right-click on cylindrical face (2) that the locked dimension is applied to. On
the relationships palette, click the dimension constraint (3). The dimension
constraint on the palette turns gray to denote it is relaxed. The edit solves.
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• Click the dimension and it temporarily relaxes to complete the edit. When the
edit is complete, the dimension automatically returns to a locked condition.

To complete the edit, click the Solution Manager green check mark.
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• On the Live Rules panel, click the Relax Dimensions button. This relaxes all
locked dimension in the model. The edit solves and when the edit is complete,
the Relax Dimensions button returns to original setting.

▸ Choose on of three relax relationship methods to complete the edit. Remember,
to complete the edit you click the Solution Manager green check mark.
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Activity: Using Solution Manager (scenario 2)

Using Solution Manager (scenario 2)

Extend the highlighted faces 40 mm in the X direction. The top portion of the model
should not change.

Note

The four holes are aligned with a coplanar axis relationship. The outside
cylindrical faces are concentric to the holes.

Open the part file

▸ Open solution_manager_scenario2.par.

Live Rules settings

▸ On the Live Rules panel, click the Restore button (4) to set Live Rules to the
default settings. Auto Preview (5) should not be checked.
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Define the select set

▸ Select the face shown.

▸ Start the synchronous edit by clicking the primary axis.

▸ In the dynamic edit box type 40 and press Enter.
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Investigate failure and remove over constrained relationships

▸ Right-click on a few of the orange colored faces and observe the relationship
palette for each face. The relationships listed on the palette that have a yellow
triangle on them are the relationships that are participating in the failure.

▸ Right-click on the planar face (1).

▸ On the relationship palette, pause over the coplanar relationship (2). When the
fly out option displays, pause over the fly out and notice the face that highlights
is coplanar to the selected face (1).
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▸ The selected face (1) is contributes to the failed condition. The face (3) we are
trying to move cannot move because it is coplanar to the selected face (1). Click
the relationship on the fly out or on the palette to relax that relationship. The
relationship button turns gray to denote it is temporarily relaxed. The solution
is still in a failed condition.

Remove another over constrained relationship

The solution still contains another over constrained relationship. All of the holes are
related with an axial alignment and one the holes is locked by a dimension. We need
to relax the coplanar axis relationship.

▸ Right-click on the cylindrical face (4).
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▸ On the relationship palette, pause over the coplanar axis relationship. Click the
fly out button (5) to relax all coplanar axis relationships.
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▸ The synchronous edit solves. On the Live Rules panel, click the Solution
Manager check box to complete the synchronous edit.
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Summary

When performing a synchronous edit, you can either have a success or failure. You
can use the Solution Manager to alter a successful solution to achieve the desired
result. In a failed condition, Solution Manager can help you with graphical feedback
to determine what is causing the failure.

There may be more than one way to correct a failed condition. You can use Solution
Manager, change Live Rule settings, or relax all relationships.
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Activity: Using Solution Manager (scenario 3)

Using Solution Manager (scenario 3)

Extend the red face 20 mm in the Y direction. The yellow face is coplanar to the red
face. The yellow face should remain fixed. In this edit scenario, the solution does not
fail. You only want to alter the solution.

Open the part file

▸ Open solution_manager_scenario3.par.

Live Rules settings

▸ On the Live Rules panel, click the Restore button (4) to set Live Rules to the
default settings. Auto Preview (5) should not be checked.

Define the select set

▸ Select the face shown.
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▸ Start the synchronous edit by clicking the primary axis.

▸ As you move the cursor, notice the rear plane (1) also moves because it is
coplanar to the selected face.
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Press the V key to enter Solution Manager.

Observe the graphical feedback

Notice only two faces participate in the edit.
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Alter the solution

There are four ways to alter the solution in this scenario.

• Right-click on the blue colored face. On the relationships palette, click the
coplanar relationship (1).

• Click the blue colored face. This isolates the face from the solution. Isolated
faces turn red.
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• On the Live Rules panel, turn off the Coplanar rule. This isolates the blue
colored face from the solution.

Note

Be aware that this method causes all coplanar faces in the model to not
participate in the solution.

• On the Live Rules panel, click the Relax Live Rules button. The blue colored
face is not recognized in the solution.

Note

Be aware that this method causes all relationships in the model to be
ignored in the solution.

▸ Choose one of the methods mentioned. Click the Solution Manager check mark
button.

▸ In the dynamic edit box, type 20 and press Enter. Press Esc to clear the select set.
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Lesson review

Answer the following questions:

1. How do you show the Live Rules?

2. If you change the Live Rules options, what are the Live Rules options when
opening an existing or new file?

3. What is Solution Manager?

4. How do you start Solution Manager?

5. What relationships can be suspended?

6. How do you display a face relationship palette in Solution Manager?

7. What happens when you click a relationship on the relationship palette?

8. What is the Lock to Base Reference option?

9. How do you delete a persistent relationship?

Lesson summary

Live Rules control which relationships to detect during a synchronous operation. If a
relationship is detected, the faces maintain that relationship during modification.
You can suspend detected relationships set in Live Rules, persisted relationships,
and locked dimensional constraints with Suspend options on the Live Rules panel.

You use Solution Manager to alter a synchronous edit solution or to correct a failed
solution. Solution Manager is a tool that graphically interacts with the model to
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provide control of all relationships relevant to the current solve. Solution Manager
provides detail and actions regarding the faces participating in the solve of a
synchronous edit.

Using variables

Using variables

You can use the Variable Table to define and edit functional relationships between
the variables and dimensions of a design in a familiar spreadsheet format.

When you select the Variables command, the Variable Table is displayed. Each
row of the table displays a variable. A series of columns is used to list the various
properties of the variable, such as Type, Name, Value, Rule, Formula, and Range.
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You can use variables to do the following:

• Control a dimension with another dimension (Dimension A = Dimension B).

• Define a variable (pi=3.14).

• Control a dimension with a formula (Dimension A = pi * 3.5).

• Control a dimension with a formula and another dimension (Dimension A = pi
* Dimension B).

• Control a dimension with a formula that includes a function (Dimension A =
Dimension B + cos(Dimension C)).

• Control a dimension with a value from a spreadsheet, such as a Microsoft Excel
document, by copying the value from the spreadsheet into the Variable Table
with the Paste Link command. You can use any spreadsheet software that can
link or embed objects.

Note

You can use a VBScript function or subroutine in the formula. The trig
functions available in the variable table always assume input value for the
function is in radians and returns the results in radians, not in degrees. An
example function might be sin(x)=y, where x and y are always in radians.

Types of variables

There are three types of variables displayed in the Variable Table:

• Dimensions (2D dimensions)

• User Variables

• PMI dimensions (model dimensions)
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Dimensions

You create Dimension variables when you place a dimension on a 2D element,
when you define an assembly relationship, or when the system creates a
dimension automatically, such as the extent dimension for a protrusion or cutout.

Dimension variables can be displayed and selected in the graphics window or in
the Variable Table. You can use Dimension variables to control and edit a design.

User Variables

You create User Variables when you type a name and value directly into the
Variable Table, or when you define values within certain commands. For
example, when you define the properties for a counterbore hole with the Hole
command, user variables are automatically added to the Variable Table. Other
types of user variables are also created automatically, such as the Physical
Properties Density and Physical Properties Accuracy variables.

User variables have no graphic element you can display and edit in the graphics
window. They can only be accessed and edited through the Variable Table. You
can use user variables to control and edit a design.

PMI Dimensions

PMI Dimension variables are created automatically in the Variable Table when
you place dimensions on the model.

PMI dimensions on ordered features are always driven dimensions, but they can
be used to control other elements in the design in certain circumstances.

PMI dimensions on synchronous features are created initially as unlocked
dimensions, but you can lock a dimension so it can be used to control other
elements in the design.

Note

A synchronous PMI dimension must be locked before it can be driven by a
formula or be used in a formula.

You cannot unlock a synchronous dimension that is controlled by a
formula or is used within the formula of another dimension or variable.

Entering data into the Variable Table

When you create the dimensions for a design, variables for these dimensions are
placed into the variable table automatically. If the Variable Table is open, any
dimension that is placed by you or the software will display in the Variable Table
after the dimension is placed.

Working with the Variable Table open allows you to change the dimension name
that is generated by the software to a more logical name as you work. When you
rename variables, the variable name should begin with a letter, and should contain
only letters, numbers, and the underscore character. You should not use punctuation
characters.

Note

Variable names are not case-sensitive. For example, if you create the variable
VAR1, you cannot create another variable named var1.
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Identifying dimensions in the design

When reviewing or editing dimension names and values through the Variable Table,
you may need to know which variable name is associated with which dimension in
the design. This is true especially when you are editing a design you are not familiar
with, or if the 2D geometry and dimensions are placed on many different layers.

With the Variable Table open, when you hover over a cell labeled Dim in the Type
column, the dimension in the graphics window changes to the highlight color. When
you select a cell labeled Dim in the Type column, the dimension changes to the
select color.

Editing data in the Variable Table

You can directly edit ordered variable names, values, and formulas in the Variable
Table as long as the information exists in a cell with a white background.

If an ordered variable value exists in a cell with a gray background, you cannot edit it
directly. It means the data is controlled by another variable, dimension, or formula.

All synchronous variable values cells have gray backgrounds. If the open lock is

displayed , the value cannot be edited. If the closed lock displays , the value
can be edited.

Click the lock to toggle between open and closed.

Cells with a gray background and no lock button indicate the data is controlled by
another variable, dimension, or formula.

To change data in a cell with a white background, click in the cell, type the
new information, and then press Enter. To change data in a cell with a lock
button, double-click the value and the Edit Dimension box appears. Type the new
information, and then press Enter. When the Edit Dimension box appears, the Live
Rules window also appears, with the recognized relationships indicated. When you
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type a new value, the model faces which correspond to the recognized relationships
in Live Rules change color. In this example, the Planar and Symmetric About Base
(X)Y and (Y)Z Live Rules relationships are recognized and honored.

In the same manner that dimension variables are entered in the Variable Table
automatically when you add dimensions to the design, dimension values are changed
automatically when you edit your design.

• The value of a locked dimension is updated when you change the dimensional
value of a dimension.

• The value of an unlocked dimension is controlled by the element it refers to, or
by a formula or variable you define. If the element, formula, or variable changes,
the dimensional value updates.

• The values of area and perimeter are updated when you use the Area command
bar to change the size of an area object.

Note

If the background color in a Value cell is orange, it means that the value of
a dependent variable could not be changed because it would have violated
a rule limiting its range of values.

Restricting the display of variables

You can control the display of variables in the table with the Filters button on the
Variable Table or the Filters command on the shortcut menu. For example, you
can display only the Dimension type variables that were named by users. You can
also display variables that are associated with elements in the current document,
elements in the active window, or a set of elements that you have selected in the
document.
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Creating rules for variables

When you select a variable in the Variable Table, you can click the Variable Rule
Editor button to define a set of rules for a variable using the Variable Rule Editor
dialog box.

Note

You also can access the Variable Rule Editor dialog box using the Edit Formula
command bar shortcut menu.

Defining rules for a variable restricts design changes to a more controllable set of
values. You can define a discrete set of values, or a range of values for a variable
using the Variable Rule Editor dialog box. For example, you can specify that only the
values 10, 20, 30, and 40 millimeters are valid for a variable.

The rule type you define for a variable is displayed in the Rule column in the
Variable Table, and the numerical values for the rule are displayed in the Range
column in the Variable Table.

You can also define a discrete list or limited range of values for a variable by typing
the proper characters into the Range cell for a variable in the Variable Table. The
following table and examples illustrate how to do this:

Character Meaning Where Used Variable Type

( Greater Than Beginning Only Limit
) Less Than End Only Limit
[ Greater Than or

Equal To
Beginning Only Limit

] Less Than or Equal To End Only Limit
{} Encloses a Discrete

List
Use both as a set Discrete List

; Separates values Between values in a
limit or discrete list

Limit and Discrete
List

Examples:

• To define a variable that must be greater than 5 and less than 10, type the
following in the Range cell:

(5;10)

• To define a variable that must be greater than or equal to 7 and less than or
equal to 12, type the following:

[7;12]

• To define a variable that must be greater than or equal to 6 and less than 14,
type the following:

[6;14)

• To define a variable that must be limited to the following list of values: 5, 7,
9, and 11, type the following:

{5;7;9;11}
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Editing variables that have rules defined

The edit behavior of a variable changes when you have defined a set of rules for
the variable.

• If a dimension variable has a discrete list of values applied, you also can access
the list of values on the Dimension command bar.

• If an driving variable has a rule applied, and if you type a value in the command
bar or Variable Table that violates the rule, a message is displayed to warn you
that the rule has been violated, and the value you type is not applied.

• If an unlocked variable cannot be resolved because the rule conflicts with the
formula result, the background color of the Value cell changes to orange to
notify you of the conflict. See the When rules and formulas conflict section for
more details.

Creating expressions (formulas)

You can create expressions (formulas) to control variables using the Formula
column in the Variable Table. The expressions can consist of variables only or of
mathematical expressions that contain any combination of constants, user-defined
variables, or dimension variables that the software placed.

You can create expressions by typing them directly into the Formula box for a
variable, using the Function Wizard, or using the Formula option on the Variable
Rule Editor dialog box.

The system provides a set of standard mathematical functions. You can also select
functions that you wrote and saved. The functions can be typed in with the proper
syntax or you can use the Function Wizard to select and define the function. The
Function Wizard is convenient when you forget the proper syntax for a math
function. You start the Function Wizard by clicking the Fx button in the Variable
Table.

You can link VBScript functions and subroutines to variables in the variable table.
To see an example, at the bottom of this topic, click Creating a Variable with an
External Function or Subroutine.
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Displaying the expressions (formulas) graphically

You can use the Show All Formulas, Show All Names, and Show All Values commands
on the dimension shortcut menu to change the display of dimensions to make it
easier to define expressions between dimensions. For example you can use the Show
All Formulas command to display the dimension names and formulas you define.

You can also use the Edit Formula command on the dimension shortcut menu to
define formulas between dimensions.

When rules and formulas conflict

You can also define rules for variables that are controlled by formulas. During edits,
it is possible that the formula-driven value for an unlocked variable conflicts with
its defined rules.

When this occurs, the rule will not be violated, but the Value cell color for the
variable changes to the orange color to indicate there is a conflict. For example, you
can define a simple formula that states that DimA=DimB. The dimension text color
for DimA changes to indicate that the dimension value is controlled by another
dimension. The Value cell for the dimension in the variable table turns gray to
indicate that its value is controlled by another variable.
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You can then specify a discrete list rule for DimA where the only valid values are
{50; 60; 70}. If you then edit DimB to 55, the discrete list rule for DimA is violated.
When this occurs, the value for DimA will not change to the invalid value. The value
cell for DimA in the Variable Table turns orange to indicate that there is a conflict
between the limit rule and the formula.

Examples

Suppose you draw a sheet metal bracket and you want to build a relationship
between the bend radius and stock thickness. You can use a formula in the Variable
Table to build and manage this relationship. The following example illustrates how
the Variable Table would look if you built a relationship that changes the bend
radius when the stock thickness changes.

Type Name Value Formula
Variable Stock_thickness .25
Dimension Bend_radius .375 1.5 x stock_thickness

Here are some more examples of how you might set up the Variable Table:

Type Name Value Formula
Variable c 2.0 kg
Variable d 10.0 rad @c:\bearing.xls!sheet1!R6C3
Variable e 20 mm @c:\bearing.xls!sheet1!R6C3
Dimension f 8.5 mm (1.5 + Func.(func1(c,d)))^2

Variables d and e are controlled by an external document, in this case an Excel
spreadsheet. You can also control a variable using a variable in another Solid Edge
document.

Variable f is controlled by a formula that includes variables c and d and function.
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Argument conventions

The following argument conventions are used in the Variable Table:

• In the syntax line, required arguments are bold and optional arguments are not.

• Argument names should follow the rules for Visual Basic.

• In the text where functions and arguments are defined, required and optional
arguments are not bold. Use the format in the syntax line to determine whether
an argument is required or optional.

Using driven and driving dimensions within expressions in ordered
modeling

When creating expressions between dimensions, you cannot use a driven dimension
to drive the value of a driving dimension when both dimensions are within the same
sketch or profile. For example, if the profile circles HA and HB for the cutout feature
shown are on the same profile or sketch plane, you cannot use DmA to control the
value of DmB, because DmA is a driven dimension. (DmA is driven because the
location of profile circle HA is controlled by geometric relationships between the
midpoints of the part edges).

In this example, there are two approaches you can take to work around this issue.

• You can use two cutout features rather than one to create the circular cutouts.

• You can use driving dimensions and expressions to keep profile circle HA
centered on the part, rather than geometric relationships.

4-98 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

As shown below, reworking the relationship scheme allows you to draw profile circles
HA and HB on the same profile plane, and then use DmA in an expression to control
the value for DmB (DmB=DmA*.6). Rather than controlling the location of profile
circle HA using geometric relationships, a driving dimension that controls the
base feature length (PL) and an expression is used to ensure that profile circle HA
is centered on the part (DmA=PL/2). This allows you create an expression where
DmA controls DmB.

Accessing variables for other parts within an assembly

The Peer Variables command, on the Tools menu, gives you access to part and
subassembly variables for the other parts and subassemblies within an assembly.
You can use the Peer Variables command while you are in the assembly, or when you
have in-place activated a part or subassembly within the assembly. The parts can be
contained directly in the assembly or in a subassembly. To edit a part or subassembly
variable, click the Peer Variables command, select the part or subassembly, and then
edit the values in the Variable Table.

You can edit values, create user-defined variables, enter equations, and copy and
paste variables between parts and subassemblies within an assembly. All the
functionality of the variable table is available, with the increased convenience that
you do not have to in-place activate the peer part.

After you open the Peer Variable Table for a part, you can access the variables of
any assembly occurrence by clicking the occurrence in Assembly PathFinder or in
the graphics window. The Peer Variable Table will update to display the variables
of the occurrence you select. The title bar of the Peer Variable Table also lists the
name for the selected occurrence.

To display the variables of the active document, click the Active Model button on the
Peer Variable command bar with the Peer Variable Table open.

Note

When using Peer Variables to edit a synchronous part in the context of the
assembly, Live Rules relationships are not recognized or honored.
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Linking variables between parts in an assembly in ordered modeling

You can also use the Peer Variables command to associatively copy and paste
variables between parts within an assembly or subassembly. For example, you can
control the flange thickness of Part B using a variable in Part A. When you edit
the value for the variable in Part A, the flange thickness in both parts is changed
simultaneously. To take advantage of associative copy and paste, you must first set
the Paste Link To Variable Table option on the Inter-Part tab on the Options dialog
box.

To associatively link a variable between two parts in an assembly, use the Peer
Variables command to select the part containing the variable you want to copy (Part
A). In the Variable Table for Part A, select the variable row you want to copy, and
then click the Copy command on the shortcut menu. Then select the part in which
you want to paste the variable (Part B). Select the variable table row in which you
want to paste the variable, and then click the Paste Link command on the shortcut
menu.

After the relationship is established, any changes made to the parent variable for
Part A will update the linked variable for Part B. To ensure that the link is updated,
use the Update All Links command. When you link Solid Edge variables between
parts in an assembly, the document names and folder path should contain only
letters, numbers, and the underscore character. You should not use punctuation
characters.

For more information, see the Link variables between parts in an assembly Help
topic.

Creating variables with a link to a spreadsheet

You can use Microsoft Excel or other spreadsheet software to link Solid Edge
variables to a spreadsheet. Before you can link variables to a spreadsheet, you must
first create the variables you want in the Solid Edge document. When you link
Solid Edge variables to a spreadsheet, the document names and folder path for the
spreadsheet and the Solid Edge document should contain only letters, numbers, and
the underscore character. You should not use punctuation characters.

Note

Links are not supported in the Synchronous environment.

To successfully edit the linked Solid Edge variables from the spreadsheet later, you
must open the Solid Edge and spreadsheet documents in a specific order:

• You can open the spreadsheet document first, then open the linked Solid Edge
document.

• You can open the Solid Edge document first, then click the Edit Links command
on the shortcut menu when a linked formula is selected within the variable
table. You can then use the Open Source option on the Links dialog box to open
the spreadsheet document.

For more information, see the Create a variable with a link to a spreadsheet Help
topic.
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Accessing the Variable Table using property text

You can use property text to extract system and user variables, values, and
dimensions from the Variable Table into design annotations.

In this example, property text in callouts reference weight and force values
calculated for the crane, crate, and force.

To extract property text from the Variable Table, on the Select Property Text dialog
box, select Variables From Active Document as the property text source. The new
property text string has the format %{Variable_name|V}, where Variable_name
converts to the current value of the named variable.

Example: The Crane = 1000 kg annotation in the illustration is a result of this entry
in the Callout dialog box: Crane = %{Crane_mass|V} kg.

Exposing variables as custom properties

You can select variables from within individual part and assembly files and expose
them as custom properties using the Expose and Exposed Name columns in the
Variable Table. The variables you expose are then displayed in the Properties list in
the Custom tab in the File Properties dialog box.

This also makes the variables available in the Draft environment (for inclusion
in annotations, for example), in Property Manager, and in Insight Connect and
associated SharePoint interfaces.

The exposed variables are displayed in the Properties list in the Custom tab in the
order in which they were exposed in the Variable Table. If you want to change the
order in the Properties list, clear the check marks for all the exposed variables, then
check the variables you want to expose, in the order you want them displayed in
the Properties list.
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Suppressing features using a variable in ordered modeling

You can suppress and unsuppress a part or sheet metal feature using the Variable
Table by adding a suppression variable to the variable table using the Add
Suppression Variable command on the shortcut menu when a feature is selected. If
you link the suppression variable to an external spreadsheet, you can then suppress
and unsuppress the feature using the external spreadsheet.

Activity: Using the variable table

Using the variable table

This activity demonstrates how to use the variable table to control dimensions.

In this activity an existing part is dimensioned and then the variable table is used
make changes to the part.

Open activity file

▸ Open variable_X.par.
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Dimension the model

▸ Place four dimensions. Place them in the order shown.

Open the variable table

▸ Choose the Tools tab®Variables group®Variables command.
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Change the dimension variable name

▸ Change the dimension display. Right-click a dimension and then click Show All
Names.

4-104 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

▸ In the variable table, double-click in the Name box for Linear_1. Type height for
the new variable name and press Enter.

▸ Rename the remaining dimensions: Linear_2=width, Linear_3=hole_Y,
Linear_4=hole_X.
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Create a user defined variable

▸ In the variable table, double-click the first empty Name box shown, and type
user_defined_A. Press Enter.

▸ Double-click the Value box for variable user_defined_A and type 50. Press Enter.

4-106 Solid Edge fundamentals mt01413-s-1050



Working with face relationships

Lock a dimension

▸ Select the width dimension on the part and click the lock button to lock the
dimension.

Note

Notice that the dimension changes to red, which means that it is a driving
dimension.
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▸ Notice in the variable table that the width value has a locked icon.

You can click the value edit button or click the dimension on the part to change
the dimension value. Both bring up the same dimension value edit dialog.
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Add a formula to a dimension variable

▸ Add a formula to control the hole_X value. Notice in the variable table that the
Formula box for hole_X is not available. This means that it cannot be edited
because it is a driven dimension.

Select the hole_X dimension on the part and click the lock button. Notice in
the variable table that the Formula box is enabled and a value edit button
is available the value.
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▸ Click the Formula box for the hole_X variable, and type =user_defined_A and
press Enter.

Notice that the hole_X dimension on the model contains two colors. The value is
still driven (purple), but the dimension can be edited using a formula (red).

Edit the dimensions

▸ In the variable table, change the dimension variables with the value edit button
and observe the model changes. You decide what values to enter. As changes
are made, the model follows the live rules settings.

Summary

In this activity you learned how to use the variable table control the dimensions on a
model. You learned how to rename a system defined variable, create a user defined
variable and how to add a formula for a variable.

▸ Close the file and do not save.

Miscellaneous commands

Delete face

A face can be deleted only if the faces it is connected to can extend to fill in the area
vacated. This extension of faces is termed healing.
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To delete a face, select the face and then press the Delete key.
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Replace face

The Replace Face command is located on the Surfacing tab in the Surfaces group.
This command replaces selected faces on a part. The replacement face can be a
construction surface, a reference plane, or another face on the part. When replacing
more than one face, the faces being replaced cannot touch each other.

When you replace a face using a construction surface, the construction surface is
hidden automatically when you finish the feature.

If edges on the face you are replacing have rounds applied, the rounds are reapplied
after you complete the replace face operation.
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5 Constructing treatment features

Treatment features

Treatment features
Note

This course presents the Synchronous method of treatment feature creation.
To learn about the Ordered method, please refer to the self-paced course
spse01536: Modeling synchronous and ordered features.

Treatment features are those which affect a model’s existing edges or faces. You
construct treatment features by applying face and edge treatments, such as drafts,
rounds, and thin wall to the part.

Treatment feature types within Solid Edge

• A round feature applies a constant radius to one or more part edges.

• A blend feature applies a variable radius to one or more part edges or blends
between two faces.

• A draft feature tilts an existing part face to a specified angle relative to a
reference plane.

• The thin wall feature is useful in plastic part modeling to create a shell of a part.

1. Choose command.

2. Select an edge, face, or body.
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When to add treatment features to models

For best results, add treatment features to your model as late as possible in the
design process.

In particular, it is preferable to round edges after constructing thin-walls. If a draft
is crucial for positioning other features, construct the draft just before you define
the other features. Although you can construct a treatment feature at any time, non
critical features can complicate the display of the part in orthogonal views (especially
the presence of drafted faces).

Lesson review

Answer the following questions:

1. In general, should you add rounds before constructing thin-walls, or after?

2. True or False: You should add treatment features as early as possible in the
design process.

Lesson summary

• Treatment features are those which affect a model’s existing edges or faces. You
construct treatment features by applying face and edge treatments, such as
drafts, rounds, and thin wall to the part.

Rounding and blending

Rounding and blending

Use rounding to replace a model’s sharp edges with a smooth, rounded surface to
improve its appearance or function. Rounding is edge-based, which means you can
only round edges.

In the ordered environment, you use a constant rounding radius, a variable radius,
or a combination of the two.

With the Round command in the synchronous environment, you only use a constant
radius round to the edges of a part.

With blending in the ordered environment, you blend between edges, faces, or a
combination of the two.
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With the Blend command in the synchronous environment, you can create a variable
radius round,

a blend between faces,
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or a blend between surface bodies.

You can do full-pocket rounding. In other words, you can create a round where the
round radius is greater than the depth of the pocket.

With blending, you can create a round with a radius less than or equal to the depth
of the pocket. However, when the radius becomes greater than the depth of the
pocket, the round will fail.

Round workflow

Step 1: On the Home tab®Solids group, choose the Round command .

Step 2: On the Round command bar, use the Select menu (1) to specify the
element to round (chain, edge/corner, face, loop, all fillets or all rounds).

Step 3: Select the elements to round. When you select an edge is, you see a
dynamic preview of the round.
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Step 4: Type the radius for the round.

Step 5: Continue selecting edges defined with the same radius value.

Right-click when finished with this common radius. This converts all
preview geometry to finished geometry. The command remains active.

Step 6: To place additional rounds with different radii, continue selecting edges
and then change the radius value.
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Step 7: Right-click to finish the round.

Step 8: Press the Esc key or pick the Select command to end the round command.

Rounding order

The order in which you apply individual round features to a model can make a
difference in the completed model. This typically occurs when the edges you select
to define the rounds intersect or meet.

For example, if you construct a round feature by selecting edge (1), the ends of edge
(2) modify when the first round applies.
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When you construct the second round feature by selecting edge (2), you get the
following result.

If you reverse the order of the two round features, and select edge (2) for the first
round feature, the ends of edge (1) modify when the round applies.

When you construct the second round feature using edge (1), you get the following
result.
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If you then compare both results side-by-side, you can see that the surfaces where
the two rounds meet are different.

Although both results are valid, one solution may be easier to manufacture or be
more aesthetically acceptable than the other. In these situations, you may want to
experiment by applying the round features in a different order to determine which
result is the most appropriate for your requirements.

Reordering rounds

In synchronous modeling:

You can right-click a blend patch between intersecting blends and use the Reorder
Rounds command on the shortcut menu to reorder rounds.

You can select multiple rounds and the radius for the rounds being reordered does
not have to be the same.
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Activity: Round edges

Round edges

This activity demonstrates the process of placing rounds on edges of a model.

Open part file

Open the vise base part file you previously created, or open the part vise.par.

Round edges/corners

▸ On the Home tab®Solids group, choose the Round command .
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▸ In the Round command bar, in the Select box (1), click the Edge/Corner option.

▸ Select the edges shown. Type in a radius of 6.35 mm into the dynamic input box.

▸ Press the Enter key or right-click to apply.

Note that the Round command is still active. Do not exit the command.
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Round a chain of edges

▸ Select the Chain option from the command bar. Select the two edge chains
shown. Type 3 mm for the radius and press the Tab key.

Continue with rounding

▸ Continue selecting the edges shown below making sure to select the symmetrical
edges on the backside.

Press the Enter key or right-click.
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▸ The Round command is active. Change the Edge/Corner option and select the
following edges. Type a radius of 6.35 mm.

Press the Tab key.
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▸ Finally, change to the Chain option. Select the edges shown and type a radius
of 3 mm.

Ignore the caution symbol and press the Enter key to accept.

▸ Save and close the part file.

Summary

In this activity you placed rounds on edges of a 3D model. The round radius can be
changed by selecting the round and changing the value in the dimension edit box.
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Editing rounds

In synchronous modeling:

To edit a round radius, select the radius value and type a new value in the Edit
Dimension Value dialog box.

Note

You can also use the scroll wheel on the mouse to dynamically edit the radius
value. The scroll behavior is controlled by the Solid Edge options®Helpers
page option Enable Value Changes Using the Mouse Wheel. If the option
is unchecked, use Crtl+mouse wheel to change the value. If the option is
checked, use the mouse wheel to change the value.

In ordered modeling:

To edit a round radius, right-click the round, and then click Edit Definition. In the
Radius field of the Select Step on the Round command bar, type a new value and
click the Finish button.

Variable radius rounds

In ordered modeling:
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When you construct variable-radius blends in Solid Edge, you can define different
radius values at keypoints and intersection points along an edge or face.

In synchronous modeling:

With the Blend command, you construct variable-radius blends in Solid Edge by
defining different radius values at keypoints and intersection points along an edge or
face.

The next illustration shows a round with different radius values at the two endpoints
and midpoint of an edge.

You can use a radius value of zero when creating variable radius blends. The round
below has a radius of 15 mm at one end and zero at the other.

Blend workflow

Step 1: On the Home tab®Solids group, choose the Blend command .

Step 2: When placing a blend, you must first define the type. On command bar,
select variable radius, blend, or a surface blend.

Step 3: If the type is blend, on command bar, in the Select Step, select the
Shape (constant radius, constant width, chamfer, bevel, conic, curvature
continuous).

Step 4: Select the elements to create a blend between and type a radius on
command bar.
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Step 5: Define an overflow condition and select the edges needed to define the
overflow.

Step 6: Select Finish on command bar to complete the blend. Press the Esc key
to end the command.
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Defining the blend shape

Modeling ordered features:

When you set the Blend or Surface Blend options on the Round Options dialog box,
you can use the Shape option on the Blend command bar to specify the blend shapes
shown below.

Modeling synchronous features:

When you set the Blend or Surface Blend options on the Blend Type Step of the
Blend command bar, you can use the Shape option on the Select Step of the Blend
command bar to specify the blend shapes shown below.

Blend shapes

• Constant Radius

• Constant Width

• Chamfer

• Bevel

• Conic

• Curvature Continuous

These options give you the flexibility you need for a wide variety of design situations.
For example, you can use the Chamfer command to create a chamfer on a solid body,
but not on a surface body. To create a chamfer on a surface body, you must use the
blending options within the Round command.

The Constant Radius option constructs a blend with a uniform radius. This option
works in a similar fashion to rounding.
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The Constant Width option constructs a blend between two sets of surfaces where
the chord width of the blend is a constant width (A). This option is useful when a
surface intersects another surface at an angle where a constant radius blend (B)
might add too much or too little material.

The Chamfer option constructs a planar blend with an equal setback chamfer. You
can use the Setback option to define the chamfer size.

The Bevel option constructs a blend with a linear cross section that is determined
by the bevel length and ratio you specify. The value you enter in the Setback box
determines the length of the new blend face (A). The value you enter in the Value box
determines what amount of material to remove from the two adjacent faces (B), (C).

For example, if you specify a Setback of 30 mm and a Value entry of 0.50, a new
blend face that is 30 mm in length is constructed. The Value entry of 0.50 specifies
that to position the new blend face (A), twice as much material is removed from the
first face you select (B), than the second face you select (C). In the case of two planar
faces, which are also perpendicular to each other, 26.84 mm is removed from face (B)
and 13.42 mm is removed from face (C). You can type a value that is greater than
zero, but less than or equal to 10.0. A Value entry of 1.0 creates a 45 degree bevel.
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The Conic option constructs a constant elliptical cross section blend. When you set
this option, the Radius value defines the width of the cross section and the Value
entry you type changes the cross section shape. You can type a Value entry that is
greater than but not equal to zero. As the Value entry approaches 0.0, the cross
section becomes flatter and more closely resembles a chamfer (A). As the Value
entry increases, the cross section becomes more rounded (B) and then becomes
flatter again (C).

You can use the Curvature Continuous blend option to control the continuity, or
softness, of the blend surface. A Value entry less than 1.0 creates a flatter, more
chamfer-like cross-section (A) and (B). A Value entry greater than 1.0 appears to
extend the selected surfaces and creates a smaller blend radius (C), (D), and (E).
Typical values can range from 0.0 to 10.0.
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Activity: Blend between faces

Blend between faces

This activity demonstrates the process of placing blends between faces of a model.

Learn how to define constant and variable radius blends, as well as how to use a
tangent hold line.

Open the part file

Open the part file blends.par. Place a blend on the inside of the support bracket.

Placing a blend

▸ On the Home tab®Solids group, choose the Blend command.
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Note

The Blend command is found on the list headed by Round.

▸ On command bar, in the Blend Type step, select the Blend option.

▸ On the Select Step, select the two faces shown.

▸ For the Shape, keep the default Constant radius and type a radius of 40 mm.

Click the Accept button.
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▸ On the Overflow Step on command bar, select the Tangent Hold Line option

. Select the Full Radius option .

▸ You are prompted to click on an edge chain representing the tangent hold line.
Select the two curved edges.

▸ Click Accept and then click Finish.

Investigate other blend options

▸ To see how the other Blend options work, undo the previous operation. Choose
the Blend command again. Select Blend as the blend type. For the shape, click
Constant Radius. Select the same two faces as before. Type 60 mm for the
radius and click the Accept button. This time on the Overflow step, select the

Roll Along/Across option .

Note

Ignore the error that blend radius is too large.
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▸ Select the two curved edges as the edge chains. The preview appears.

▸ Click Accept and then click Finish.

Place a variable radius blend

▸ Undo the previous blend operation. Choose the Blend command again. In the
Blend Type step, select the Variable radius option.
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▸ In the Select step, select and Accept the interior edge.

▸ The Select Vertices step prompts you to select the end points. Move cursor to the
edge location shown and click when the endpoint highlights. Type 30 mm and
Accept for the left-side radius.

▸ Move cursor to the end of edge shown and click when the endpoint highlights.
On command bar, type 10 mm for the right-side then click Accept.
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The blend preview appears.

▸ Click Finish.

▸ Save and close the part file.

Summary

In this activity you learned how to place a blend between two surfaces. There are a
few options available for placing a blend. Experiment with these options.

Lesson review

Answer the following questions:

1. Name the six available blend shapes.

2. When editing the radius of a round produced in ordered modeling, what step
must you take before entering a new radius value?
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Chamfer command

Chamfer command

Constructs a chamfer between two faces along their common edge.

Chamfer command (feature)

Constructs a chamfer between two faces along their common edge. Typically, you
should construct chamfer features as the model nears completion. On most parts,
you should not include small chamfers when drawing the profile for profile-based
features. This allows you to add the chamfers later as treatment features, which
makes changes faster and easier.

Chamfer Construction Methods

You can use the Chamfer Options dialog box to specify the chamfer construction
method you want to use:

• Equal Setbacks

• Angle and Setback

• 2 Setbacks
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Chamfer Feature Workflow

When you select the Chamfer command, the command bar guides you through the
following steps:

1. Face Selection Step—Defines the faces from which you want to measure the
setbacks or chamfer angle. This step is available only when you set the Angle
and Setback or the 2 Setbacks options on the Chamfer Options dialog box.

2. Edge Selection Step—Defines the edges you want to chamfer.

3. Preview Step—Processes the input and displays the feature.

4. Finish Step—Finishes the feature.

Equal Setback Chamfers

When you construct Equal Setback chamfer features, you only need to select the
edges you want to chamfer. You can chamfer multiple edges in one operation if they
have the same setback value. When constructing chamfers where the setback value
is the same, it is usually better to chamfer as many edges as possible in one operation.

If you want to apply different setback values to different edges, you must construct
separate chamfer features for each chamfer size.
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Angle and Setback Chamfers

When constructing a chamfer feature using the Angle and Setback option, you first
select a face (1), then select the edges to chamfer (2). The value you type in the
Setback box on the command bar applies along the selected face and measures from
the selected edge. For example, a 5 millimeter setback and 60 degree angle chamfer
applies as shown (3).

Two Setback Chamfers

When constructing a chamfer using the 2 Setbacks option, you select a face first. The
value you type in the Setback 1 box applies to the face you select, and the value you
type in the Setback 2 box applies to the adjacent face. As in the earlier example, if
you select the cylindrical face and the circular edge at the top of the part, and then
specified a Setback 1 value of 5 millimeters, and a Setback 2 value of 12 millimeters,
the 5 millimeter value applies along the cylindrical face, and the 12 millimeter value
applies along the planar face on the top of the part.

Chamfers in Assemblies

When working in an assembly, you can use this command to construct an assembly
feature.
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Activity: Creating chamfer features

Creating chamfer features

This activity demonstrates the process of creating a chamfer feature.

Learn how to use the two commands to create chamfer features. One command
creates a chamfer feature which only creates faces to define the chamfer. The
chamfer definition does not maintain during model edits. The other command
creates a procedural chamfer feature which can be edited and maintains the chamfer
definition during a model edits.

Open the part file

Open the part file chamfer.par.

Create a chamfer with unequal setbacks

▸ On the Solids group, in the Round list, choose the Chamfer Unequal Setbacks

command .

▸ On command bar, click the Options button.

▸ The default setting is Angle and setback. Use this option. Click OK.
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▸ Select the three faces shown and click the Accept button on the command bar.

▸ On command bar, type 8 in the Setback field and press Tab. Type 15 in the Angle
field. Select the three edges shown.

▸ Click the Accept button. The chamfer feature (shown in orange for clarity) places
but the command is still active. Do not click Finish.
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The setback distance 8 is measured off the edge selected. The angle 15° is
measured from the setback distance inward to the selected face.

Change the chamfer definition

▸ Once you click the Finish button, no changes can be made to the chamfer feature.

Change the setback angle. On command bar, click the Select Edge step .

▸ Change the angle to 30 and click the Accept button. Click Finish to end the
command.

If you select one of the chamfer faces for a model edit, it does not know about the
other chamfer faces. It uses the live rules settings.

Create another chamfer with unequal setbacks

▸ In PathFinder, delete the chamfer feature placed in the previous step.

▸ Choose the Chamfer Unequal Setbacks command.

▸ On command bar, click the Options button. Click the 2 Setbacks option and
click OK.
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▸ Select the same three faces and three edges as in the previous step. Type 12 for
the first setback and 5 for the second setback.

Setback 1 is measured from the selected edge on the selected face. Setback 2 is
measured from the selected edge normal to the selected face.

▸ Click Accept and then click Finish.

Create chamfers with equal setbacks

▸ Choose the Chamfer Equal Setbacks command .
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▸ Select the edge shown.

▸ In the dynamic edit box, type 3 and press the Enter key.
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Edit the chamfer feature

▸ Edit the chamfer feature by either selecting a chamfer face or by selecting the
chamfer feature in PathFinder. Select a face on the chamfer.

▸ Notice the chamfer edit handle text. Click the text to make an edit. Type 4 in
the dynamic edit box; select the Selected Faces Only option on the box.

Only the selected chamfer face is edited. The remainder of faces on the chamfer
feature maintain their original value.

Choose the Undo command to return to the original value.
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▸ To change the setback value of all the faces in the chamfer feature, select the
chamfer feature in PathFinder, choose the All Feature Faces option.

Change the value to 4. Exit the command.
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Make a model edit to observe chamfer behavior

▸ Select a face shown and move the face to observe how the chamfer feature stays
attached. Do not make any changes. Right-click or press the Esc key to return
without any changes.

Place another set of chamfers

▸ Choose the Chamfer Equal Setbacks command.

▸ Select the three edge chains as shown and type 2 in the dynamic edit box. End
the command.
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▸ Observe how the chamfers stay attached as the face they are connected to moves.
Select the face shown and move above and below original position. Do not make
any changes.

This completes the activity. Close the file and do not save.

Summary

In this activity you learned how to create two types of chamfer features. One type
maintains its chamfer definition during a model edit and the other does not. Once
you understand the behavior of the chamfer command, you will be able to apply any
type of chamfer required in the design a model.
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Adding draft to parts

Adding draft to parts

Use the Add Draft command to add draft angles to one or more part faces.

To construct a simple draft feature in the synchronous environment, you first define
a draft plane:

Then select the faces to draft:
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The part dynamically updates to reflect the draft angle and direction.

Right-click to apply the draft angle to the model.

To construct a simple draft feature in the ordered environment, you first define
a draft plane:
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Then select the faces to draft and type the draft angle on command bar:

On command bar, click Next to specify the draft direction:
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And click the right mouse button to apply the draft angle to the model.

Activity: Add draft to model faces

Add draft to model faces

This activity demonstrates the process of drafting faces of a model.

Learn how to draft faces and how to edit existing draft features.
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Open the part file

Open the part file draft.par.

Add 5° draft to the chain of vertical faces on the base plate, outside faces on the
boss and faces on the cutout.

Add draft to the base plate

▸ On the Home tab®Solids group, choose the Draft command .

▸ Select the bottom face of the base plate as the draft plane. The draft angle pivots
at the draft plane.

▸ Select the chain of faces as shown.
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▸ Click the origin of the direction handle to define the direction inward. In the
dynamic edit box, type 5 for the draft angle and then press the Enter key.

Add draft to the boss

▸ Add 5° draft to the four faces of the boss with direction inward. Use the top face
of the base plate as the draft plane.
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Add draft to the cutout faces

▸ Add 5° draft to the four faces of the cutout with direction outward. Use the
bottom face of the base plate as the draft plane.

Edit a draft feature

▸ Edit the draft feature on the boss. Select the feature with QuickPick or select the
feature in PathFinder.
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▸ Click the 5° text to edit the draft parameters.

▸ Change the draft angle to 7° and press Enter.

At this point the draft direction and draft plane can be edited also. Press Enter
to apply the edit and then Esc to end the command.

▸ This completes the activity. Close the file and do not save.

Summary

In this activity you learned how to apply draft to faces on the model. A draft plane
was selected to control the pivot point for the draft angle. If no face exists to use as
a draft plane, you can create a plane and move it to the desired location. You also
learned how to edit an existing draft feature.
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Things to consider with rounds and draft angles

If you add both rounds and draft angles to a model, there are some important
issues you need to consider before deciding on the order in which you add these
features. If you add the rounds first, the rounded faces no longer have a constant
radius and are conical.

If you add the rounds after the draft is applied, the radius value remains constant.

The manufacturing process you use to produce the actual part may be the factor that
determines when the rounds are added.

Lesson review

Answer the following questions:

1. True or False: A round added to a model prior to drafting faces will maintain a
constant radius after the draft operation.

Thickening and thinning parts

Thickening and thinning parts

You can use the Thicken command to add thickness to a part.
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Or use the Thin Wall command to thin a part.

Thicken feature workflow

When you select the Thicken command, the command bar guides you through the
following steps:

• Select Step—Sets the face selection criteria for defining the thicken feature. You
can thicken an individual face, a tangentially continuous chain of faces, or the
entire body. After you make the selection, click the Accept (check mark).

• Offset—Sets the distance to offset the faces. You can type in an offset distance
and click the offset arrow to define the offset direction.
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• Finish Step—Processes the input and finishes the feature. Click the Finish
button to finish the thicken feature.

Thin wall feature workflow

In ordered modeling:

When you select the Thin Wall command, the command bar guides you through
the following steps:

• Common Thickness Step—Defines the common wall thickness and the side you
want to apply the thickness to. You can apply the wall thickness toward the
inside of the solid, toward the outside, or symmetrically from the solid’s face.
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• Open Faces Step—Selects any faces you want to leave open. Open faces are not
offset, they are removed from the solid body. For example, if you specify that face
(1) should be open, the face is removed and the thin wall feature is created.

• You can select multiple open faces when creating the thin wall feature.

• When one side of the model has multiple tangent faces, they are all selected as
one face and cannot be selected individually.
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• Unique Thickness Step—Select any faces you want to apply a unique thickness
to, and define the unique thickness. You can select individual or multiple planar
and non-planar part faces as walls for unique thickness.

• Finish Step—Process the input and preview the feature. Since the open faces
and unique thickness steps are optional, you can preview the feature any time
after the common thickness step.

In synchronous modeling:

When you select the Thin Wall command, the Thin Wall command bar guides you
through the following steps:

• Open Faces Step—Selects any faces you want to leave open. When you click on a
face, it dynamically updates to display the thin-wall.
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Type the common wall thickness and the click the arrow to define the side you
want to apply the thickness to.

• Exclude/Include—Define the faces you want to include or exclude from the thin
wall.

To exclude a face from the thin wall being created, click the button, and
then click the face you want to exclude.

If you want to include a face in an existing thin wall, click the button, and
then click the face you want to include.

Things to consider when using thin walls

You can thin wall a part more than once. In some cases, you might find it easier to
construct a part using multiple thin wall features rather than using profile-based
features. For example, you can thin wall a solid box to create a bracket.
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You can then add a protrusion feature to the bracket, and

then add a second thin wall feature to hollow the interior of the bracket.

Activity: Create a plastic part using Thin Wall

Create a plastic part using Thin Wall

This activity demonstrates the process of creating a plastic part.

Learn how to create and modify thin walls.
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Open the part file

Open the part file thinwall.par.

Thin wall and identify faces to remove

▸ On the Home tab®Solids group, choose the Thin Wall command .

▸ Press Ctrl+I to change to an isometric view.

▸ The entire part is automatically selected for the thin wall operation. Select
the highlighted top face for removal.
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The dynamic preview shows the effect of the thin wall operation. In dynamic
input box, type a thickness of 1.00 mm and keep the direction towards the inside.

▸ Select the face shown to also remove it.

▸ Right-click to accept.

Exclude faces from the thin wall operation

▸ Select the Undo command to reverse the thin wall.

▸ Choose the Thin Wall command again and remove the top face as you did in
the previous step.
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▸ Select the Exclude Faces option on the Thin Wall command bar.

Select the faces two faces shown. The thin wall preview updates.

▸ Click the right mouse button to accept.

▸ Save and close this file.

Summary

In this activity you learned how to thin wall a solid model. You also learned how to
identify the open faces and faces to exclude.
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Activity: Model an oil pan

Model an oil pan

This activity demonstrates the process of constructing an automotive oil pan using
treatment features.

Apply several types of features to a basic solid.

• Drafted faces

• Rounds

• Thin wall
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Open the part file

You will place draft, round and thin wall treatment features on a basic solid model.

▸ Open the part file oil_pan.par.
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Drafting faces

▸ Select the Draft command.

▸ Select the top face as the reference plane. The faces draft with respect to this
face.

▸ To specify the faces to draft, select All Normal Faces from the Add Draft
command bar list. Select on the side of the part.
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▸ Type 5 degrees into the dynamic input box and select the draft arrow to define
the direction as shown.

Right-click to accept this angle and direction.
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Add a drain

▸ Create a drain for the pan by extruding a circle from the bottom face. Sketch a
circle centered on that face and dimension as shown.

▸ Select the region formed by the circle and extrude it 8 mm.
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Round edges

▸ Using the Round command, select the two underside edges and give them a
radius of 15 mm. Right-click to accept.

▸ Round the vertical edges with a radius of 10 mm. Right-click to accept.
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▸ Select the chain along the bottom, as well as the edge of the drain. Define a
radius of 5 mm and then right-click to accept.

▸ Press the Esc key.
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Thin wall

▸ Select the Thin Wall command.

▸ Enter a thickness of 3 mm into the dynamic input box. Remove the top face and
the capping face for the drain. Define an interior thin wall.

Right-click to accept and finish.

▸ Save and close this part.
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Summary

In this activity you applied the draft, round and thin wall treatment features to a
solid model. These features are commonly used in the design of solid models.
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Functional features
Note

This course presents the method of creating synchronous functional features.
To learn about the method for creating ordered features, refer to the self-paced
course spse01536: Modeling synchronous and ordered features.

Functional features are manufactured features which perform a particular function.
Unlike rounds and drafted faces, procedural features generally come later in the
design process and thus do not affect the form of the model. There are several types
of functional features available within Solid Edge, some of which are used extensively
in the plastics industry. In this lesson, learn how to define the following features.

• Hole

• Rib

• Vent

• Lip

Also in this lesson, you will define feature patterns for repetitive use, as well as
learn the organizational aspects of feature libraries. You will learn how to manage
features using standard Windows operations Cut, Copy and Paste. You will also
learn about the Attach and Detach functionality.

Hole command (synchronous environment)

Holes (synchronous environment)

When constructing one or more holes in the synchronous environment, you
dynamically drag the hole onto any face in the model.

Holes may be placed on multiple reference objects within the same instance of the
command. All holes created within one instance of the command will share the
same attributes.
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Plane locking

When placing a hole feature, you lock to a plane by pressing the F3 key, clicking the

lock icon while pausing the cursor over a plane, or when you place two hole
occurrences on the same face within the same instance of the command, the plane
automatically locks.

Plane locking is helpful when placing multiple holes on a single face because all
holes are placed with respect to the same plane regardless of where you drag the
cursor. Once you lock to a plane, you can use edge references to more precisely
define the hole location with dimensions.

When you lock to plane, the locked plane icon is displayed in the upper right corner
of the graphics window and planar alignment lines are displayed on the locked plane.

Precise placement

When locked to a plane in the hole placement workflow, dimensions may be placed
on each occurrence dynamically.
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Press E to create dimensions from the center of the circle to the closest edge endpoint.

Press C to create dimensions from the center of an existing circle.

Before the hole is placed, you can type a dimension value and the dynamic movement
is locked to the defined value. You can redefine the dimension from the keypoint in a

different direction, by either pressing the Toggle Dimension Axis button on
the command bar, or pressing T.

All precise placement dimensions are maintained as PMI dimensions after the hole
is placed.
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Align a hole to an edge center

You can use theM option to align a hole to the midpoint of a highlighted edge. Upon
hole placement, a horizontal/vertical relationship is created.

Align a hole to an existing hole axis

When you pause the cursor over an existing hole, the hole center point highlights.
Pressing the A key begins the hole alignment. As you move the hole, alignment lines
display on the face when the hole position is horizontal or vertical with the existing
hole axis. You can align the hole on other faces in the model. As you move the hole
on other faces, the alignment lines also display. You may need to press the N key to
highlight the edge on the face that is parallel to the alignment lines. You can position
the hole on a circular face also. The alignment lines display on the circular face as
you move the hole over the circular face.

Placing a hole on a cylinder

When placing a hole on a cylinder, press F3 as the cursor moves over the cylinder.
The Tangent plane command activates. You can position tangent plane by
dynamically dragging or by entering an angular value and then press Enter. Once
the tangent plane locks, you can drag the hole over the tangent line (C) and the
hole locks to the tangent line.

While in the Hole command you can place dimensions between the holes. You can
also dimension the holes after the holes are placed.
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Hole types

Use the Type option on the Hole Options dialog box defines the type of hole you want.
You can construct several types of holes:

• (A) simple holes

• (B) threaded holes

• (C) tapered holes

• (D) counterbore holes

• (E) countersink holes

You can only define one type of hole for a single hole feature. To construct a different
type of hole, you must construct another hole feature.

The options available on the Hole Options dialog box change, depending on the type
of hole you specify. For example, when you set the Threaded option, new options are
displayed so you can specify the thread type you want.
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Threaded holes

You can specify a straight thread, a standard pipe thread, or a tapered pipe thread
when you set the Type option to Threaded. You can also specify standard or straight
pipe threads when you set the Type option to Counterbore or Countersink.

For threaded holes, the size of the hole in the solid model matches the minor thread
diameter listed in the Holes.txt file or PipeThreads.txt file for the thread size you
selected. For example, when you construct a M24 x 1 metric threaded hole, the hole
diameter in the solid model will be 22.917 millimeters, as this is the minor thread
diameter listed for this thread in the Holes.txt file.

A different face style is used to indicate that a hole is threaded. The Color Manager
command provides an option to define the Face style for Threaded Cylinders. The
default value for the Threaded Cylinder option is the Thread style. With the Thread
style, you can also use the Rendering tab on the Format View dialog box to specify
whether a photo-realistic texture is applied to threaded features in a shaded view.

For more information, see the Threaded Features Help topic.

Hole extents

You can use several extent types when constructing holes:

• Through All

• Through Next

• Finite Extent

The extents that are available depend on the type of hole you are creating. Simple
holes, counter bore holes, countersink holes, and threaded holes support all three
extent types. Tapered holes support only the Finite Extent option, but you can define
a finite extent length that exceeds the thickness of the part.

With counter bore holes, if you use the Finite Extent option, you define only the hole
extent. The counter bore extent is defined by the Counter bore Depth value you
specify on the Hole Options dialog box.
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V bottom angles

When you construct a hole using the Finite Extent option, you can use the V Bottom
Angle option to specify whether the bottom of the hole is flat or V shaped.

When you set the V Bottom Angle option, you can also type a value for the bottom
angle. The angle you specify represents the total included angle. You can also specify
how the finite depth value is measured.

You can specify that the depth dimension is applied to the flat portion of the hole
where the V bottom angle begins (A), or that the hole depth dimension is applied
to the V bottom of the hole (B).
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Hole edits

When you place a hole, an Edit Definition handle is created so that you can change
dimension values for existing holes. To change the dimension value, click the hole
dimension,

type a new value, and press Enter.
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The dimension changes to reflect the new value.

You can click the Options button on the command bar to display the Holes Options
dialog box if you want to change the hole type.

After placing a hole, you can add additional occurrences of the hole. To add more
hole occurrences, click the dimension for the hole (A), click the More Holes button

, drag the cursor to the new location (B), and click to place the new occurrence
of the hole (C).
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Creating a through all hole on a c-shaped model creates a from-to extent from the
top plane (A) to the bottom plane (B).

Suppose you create a protrusion below the face,

or a protrusion between the two faces.
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If you edit the dimension of the hole,

the hole dimension is updated, but the hole does not pass through the new faces.

Also, if you change the hole type, the change is applied only to the existing faces. The
new faces remain unchanged.

In the following example, two 100 mm finite depth holes are placed as a group in
a block.
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The hole on the left does not penetrate the entire depth of the block and is capped.

If you select the handle of the hole on the left, you can change the depth and
diameter for the hole.

Also notice that the hole type on the command bar is set to Finite Depth.

The hole on the right penetrates the entire depth of the block and is not capped.
Because it is not capped the hole extent for the hole is changed from finite depth to
through next.
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If you select the handle of the hole on the right, you can change the diameter of
the hole, but not the depth of the hole.

Also notice that the hole type on the command bar is set to Through Next.

Suppose you select the highlighted face (A) and drag it to a new position (B).

If you select the hole on the right for edit it remains a from-to hole and is not capped.
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If you change the diameter for the hole, the diameter changes, but the hole type
remains from-to.

If you change the hole type to Finite, the hole depth changes to the original depth of
100 mm.

If you change the depth of the hole, the depth for both holes in the group changes.
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Holes.txt and Pipethreads.txt files

The Holes.txt and PipeThreads.txt files are ASCII text files that are used to populate
hole size values on the Hole Options dialog box. You can use a text editor, such as
Notepad, to add or edit values in these files. By default, the files are located in
the Solid Edge Program folder.

You can use Hole Size File or Pipe Threads File entry on the File Locations tab of the
Options dialog box to instruct Solid Edge to look for these files in a different folder,
including a folder on another machine on the network.

Saving commonly used hole parameters

Use the Saved Settings options on the Hole Options dialog box to save commonly
used hole parameters to an external file, named CUSTOM.XML. You can then use
the Saved Settings list on the Hole Options dialog box or the Hole command bar to
select a saved setting later in any Solid Edge document where you can construct
hole features.

Similar to the Holes.txt file, you can use the File Locations tab on the Options dialog
box to specify a folder for the Custom.xml file.

When you specify a machine on the network for the Holes.txt, PipeThreads.txt, and
Custom.xml files, all users can use the same parameters for the hole features they
construct, which makes it easier to enforce company and industry standards.

Activity: Place holes

Place holes

This activity demonstrates the process of placing holes in a conveyor belt hanger.

In this activity you will:

• Place holes dynamically.
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• Use precise methods to locate holes.

• Add dimensions to existing holes.

Open part file

Open holes.par.

Place a hole

▸ On the Home tab®Solids group, choose the Hole command .

▸ On the Hole command bar, click the Options button.

In the Hole Options dialog box, select 10 mm from the Diameter drop list.
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▸ Drag the cursor over the part’s flange and click to place a hole at the approximate
location shown.

Do not exit out of the hole command. You will continue placing holes.

Use precise placement

▸ While still in the Hole command, press the F3 key to lock the plane. Place your
cursor over the right edge and type E to obtain a dimension from the hole center
to the edge’s endpoint. Repeat for the bottom edge (do not click in between
selecting these edges).
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Type 25 for the dimension to the right edge. Press the Tab key. Type 35 for
the bottom value. Press the Tab key.

▸ Place your cursor over the edge of the second hole and type C to obtain a
dimension from that hole’s center point. Also, hover the cursor over the bottom
edge and type E. Drag your cursor vertically from the second hole and type 0.00
mm for the distance. Press the Tab key and type 75 mm to define the distance
from the bottom edge. Press the Tab key.

Do not exit out of the hole command.
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Dimension existing holes

▸ Place the fourth hole as shown.

▸ Choose the Dimension Between command and in the command bar, pick the

Lock Dimension Plane option .

You are prompted to select a plane.

Select the flange face as shown.
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Select the left edge and the center of the upper left hand hole.

▸ Place the dimension. Change it to 25 mm (ensure the arrow points towards
the right).

Create another dimension between the bottom edge and the hole center. Change
it to 75 mm.
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▸ Repeat for the lower left hand hole, changing to 35 mm from the bottom edge
and 25 mm from left edge.

▸ Use the Smart Dimension command to place diameters on the four holes.

Note

The purple dimension denotes that it is a driven dimension. To edit the hole,
you must select the hole feature and edit the hole properties.

▸ Save and close the part file.

Summary

In this activity you learned how to place hole features on a solid model. You
learned how to place holes with precision input using short-cut keys to dimension
to geometric keypoints.
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Activity: Edit holes

Edit holes

This activity demonstrates the process of editing holes.

In this activity you will:

• Change the hole size.

• Change the type of holes.

• Add new holes.

• Separate one hole instance from others.

Open the part file

▸ Open hole_edit.par.

Note

Four holes exist on this part, represented in two face sets (Hole1 and Hole3)
in Pathfinder.
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Modify hole sizes

▸ Select the left hand counter bore hole (Hole 1).

▸ Select the dimension handle.

6-24 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

The Hole Options dialog box appears, along with the Hole command bar.

Change the Hole Diameter (1) to 10 mm using the list.
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Change the counter bore diameter (2) to 20 mm and the counter bore depth
(3) to 10 mm.

▸ Note that these changes propagate to the lower right hand counter bore (4). This
is due to the fact that these two holes were placed within the same command.
They exist within the same face set.

Note

All changes to a single hole within a face set affects all other hole instances
in that face set.

6-26 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

Change the hole type

▸ While you still have the hole selected, on the hole command bar, click the options
list button and select 1/2 Countersink.

By default, the 1/2 Countersink parameters are in English units.

You can change the units to Metric by selecting the Hole Options button and
selecting mm from the Unit list (1).

Enter into the Saved Settings field the name 12.7 mm Countersink and select
Save.

Not only have the hole parameters changes to Metric units, but the saved
settings are now available from the command bar.
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Change the diameter to 10 mm, and the countersink diameter to 20 mm.

Note

You can save as many frequently-used settings as needed across your
design organization. See the Help article Holes.txt and Pipethreads.txt
files for more information.

Add holes

▸ Select the upper simple hole at top-left of the part and click the hole edit handle.

On the command bar, select the Add button .
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Place the new hole on the central beam as shown.

Note

You can add as many holes carrying the same attributes as the selected
one. These added holes can be placed on any face, unless you lock a plane.

Separate one hole instance from the parent

To change the parameters of just one hole of a group, use the Separate command
on the short-cut menu.
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▸ Select the countersink hole at the left end of the part. Right-click and choose
the Separate command.

▸ Select the hole’s handle, and select 1/2 Counter bore from the command bar list.

Note that the hole changes independently of the right hand one.

▸ Save and Close this file.

Summary

In this activity you learned how to edit existing hole features on a solid model. You
also learned how to edit one hole in a set without changing the whole set.

Lesson review

Answer the following questions:

1. How do you lock a plane for hole placement?

2. If you are placing a hole on a locked plane and you pause the cursor over an
edge, pressing which key defines a dimension from the edge’s midpoint to the
hole center?

3. Can you place a hole on a cylinder?
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Lesson summary

• You can construct simple, threaded, tapered, counterbore and countersink holes
using the Hole command.

• You can specify a straight thread, a standard pipe thread, or a tapered pipe
thread when you set the Type option to Threaded.

• The Holes.txt and PipeThreads.txt files are ASCII text files that are used to
populate hole size values on the Hole Options dialog box. You can use a text
editor, such as Notepad, to add or edit values in these files. By default, the files
are located in the Solid Edge Program folder.

Pattern features

Pattern features

You construct a pattern feature by copying a parent element in a rectangular,
circular, region fill, along a curve, or mirror arrangement.
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When patterning part features, the parent element for a pattern can contain more
than one part feature. For example, you can pattern sketch-based features, such
as a protrusion (1), and a hole (2), and treatment features, such as a round (3),
in one operation.

The parent element is included in the occurrence count for rectangular patterns,
circular patterns, and patterns along curves. For example, if you construct a 4 by 3
rectangular pattern of holes (four holes in the x direction and three holes in the y
direction) the resulting pattern feature contains the parent feature and eleven copies.

Patterning treatment features

You can pattern a treatment feature by itself or along with a sketch-based feature.
For example, you can mirror the round feature (1) about the reference plane (2)
to add a round to edge (3). This operation succeeds because the parent edges are
symmetric about the reference plane.
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Mirroring features

You can mirror one or more features, faces, or the entire part with the Mirror
command. The mirror plane can be a reference plane or a planar face.

When mirroring faces or features in a solid model, if the mirrored faces touch the
solid model, they are combined with the solid model, unless you set the Detach
option on QuickBar. When you set the Detach option, the faces or features are
mirrored as a construction body.

Rectangular Pattern command (3D features)

Constructs a rectangular pattern of selected elements. For example, you can
construct a hole feature, and then construct a rectangular pattern of holes using the
hole feature as the parent element of the pattern.

You can suppress pattern occurrences to define gaps in a pattern to avoid other
features.
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Workflow overview

You construct rectangular patterns using the following workflow:

1. Select the elements you want to pattern.

2. Start the Rectangular Pattern command.

3. Select a plane onto which you want to place the pattern preview.

4. Define the pattern parameters using command bar and the dynamic input boxes
in the graphics window.

Selecting the elements to pattern

You can select features, faces, and face sets, as the parent elements to pattern. You
can select the elements in the graphics window or in PathFinder.

Starting the Rectangular Pattern command

The Rectangular Pattern command is only available when you have selected valid
elements first.

Selecting a plane for the pattern preview

You can select any planar face, reference plane, or base coordinate system plane for
the pattern preview. For example, to place a rectangular pattern of the hole shown,
the planar face that the hole pierces is appropriate for the pattern preview.
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When you select the planar face, a default preview pattern is displayed, along with
various on-screen tools you can use to define and edit the pattern parameters.

These on-screen tools include command bar (A), occurrence count box (B), dynamic
edit boxes (C), occurrence handles (D), and the orient vector tool (E).

Defining the pattern parameters

You can use the on-screen tools to define the following pattern parameters:

• Occurrence count

• Occurrence spacing

• Pattern angle

• Suppressed occurrences

Options are also available for adding new features to an existing pattern, positioning
the pattern origin, and so forth.
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Defining occurrence count and spacing

Two options on command bar are available for defining the occurrence count and
spacing of pattern occurrences:

• Fit

• Fixed

These options specify whether you want to define the overall height and width of the
pattern, or the spacing between individual pattern occurrences. With both methods,
you specify the number of occurrences in the X and Y directions using the occurrence
count boxes. You can also define the spacing by dragging occurrence handles, which
is described later.

Fit example

With the Fit option, you specify the number of occurrences in the X and Y
directions, and the overall height and width of the pattern. The x spacing and y
spacing values are calculated automatically.

For example, you can set the Fit option and then specify an X Count of 5, a Y
Count of 4, a width of 70, and a height of 35.

The x and y spacing between each occurrence is calculated automatically.

Fixed example

With the Fixed option, you specify the number of occurrences in the X and Y
directions, and the X and Y spacing. The width and height values are calculated
automatically.

For example, you set the Fixed option and then specify an X Count of 5, a Y
Count of 4, an X spacing of 18, and a Y spacing of 12.

The width and height is calculated automatically.
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Using dynamic edit boxes and occurrence handles

You use the dynamic edit boxes to specify the exact values you want for occurrence
count and spacing. For example, when the Fit option is set, you can use the dynamic
edit boxes to specify the total number of occurrences in the X and Y directions, and
the overall height and width of the pattern.

You can also change the height and width of the pattern by dragging an occurrence
handle using the cursor. First, position the cursor over an occurrence handle,
then drag the handle to a new location. The values in the height and width boxes
dynamically update.
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Orient vector tool

The orient vector tool is similar to the steering wheel, and you can use it to
manipulate the angular orientation of the pattern. For example, you can use the
torus on the orient vector tool to rotate the pattern dynamically by dragging the
cursor.

You can use the knobs on the orient vector tool to reorient the pattern in 90 degree
increments.

You can also reposition the origin of the pattern to another keypoint on the model.

Suppressing pattern occurrences

You can suppress individual patterns occurrences or you can suppress a group of
pattern occurrences. You can suppress occurrences while you are constructing the
pattern or you can edit the pattern later to suppress occurrences.

6-38 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

Suppressing individual occurrences

You suppress individual occurrences in patterns with the Suppress Occurrence
button on command bar. With the pattern feature selected, you can click the
Suppress Occurrence button on command bar, then click occurrence symbols to
specify which occurrences you want to suppress (A). The symbols change size
and color to indicate that the corresponding occurrences are suppressed.

You can also drag the cursor to fence any number of occurrences.

This option is useful for when you need to define gaps in a large pattern, for
example, to leave space for another feature.

You can also display suppressed pattern occurrences with the Suppress
Occurrence button. Click the button and then select the suppressed occurrences
you want to reappear.
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Suppressing occurrences using a sketch region or plane

You can also suppress pattern occurrences using a sketch region or planar face.
With the pattern selected, you can click the Suppress Regions button, and then
select the sketch region that encloses the occurrences you want to suppress.
The occurrences inside the region suppress, and a suppression direction arrow
appears.

You can click the direction arrow to specify that the occurrences outside the
sketch region suppress instead.

Editing pattern parameters
You edit the parameters for an existing pattern by first selecting the pattern using
PathFinder or QuickPick. Selecting the pattern displays the pattern action handle.
You can then click the pattern action handle to display the same set of on-screen
tools that appear when you create a pattern.
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Adding new elements to an existing pattern

You can add new elements to an existing pattern using the Add to Pattern button on
command bar when you are editing an existing pattern. For example, you can add a
hole feature to any occurrence on a pattern.

You can then edit the pattern feature, and use the Add to Pattern button on
command bar to select the hole feature and add it to the pattern.

You also need to specify the occurrence position onto which you added the hole
feature. The feature is then added to all occurrences in the pattern.
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Synchronous editing of pattern features

Pattern features behave as a set when performing synchronous modifications, such
as moving faces using the steering wheel. For example, if you move a face on one
of the pattern occurrences, all the corresponding faces in all the other pattern
occurrences also move.

Deleting pattern occurrences

You can also delete pattern occurrences. Position the cursor over the pattern
occurrence you want to delete. When the ellipsis appears, left-click to display
QuickPick. You can then use QuickPick to select the pattern occurrence, and then
press the Delete key to delete it.

When you delete a pattern occurrence, the software is actually suppressing the
corresponding occurrence symbol on the pattern. Deleting, rather than suppressing,
an occurrence can be useful when working with large or complex models, because
you do not have to edit the pattern feature to suppress the occurrence. To restore the
deleted occurrence, you can use the workflow for displaying suppressed occurrences.

Guidelines for creating pattern features

• You can pattern multiple elements in one operation.

• You can suppress individual occurrences in a pattern.

• You can delete individual feature occurrences in a pattern.

• You can add features to an existing pattern.
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Activity: Rectangular patterns

Rectangular Patterns

This activity demonstrates the patterning of features.

You will work with a rectangular pattern of holes.

In this activity you will:

• Create the pattern.

• Change the pattern’s dimensions.

• Change the pattern’s parameters.

• Suppress occurrences within the pattern.

• Modify the original feature (a hole) to observe the change in the pattern.

• Add a feature to the pattern.
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Open the part file

Open patterns.par.

Create a rectangular pattern of a hole

▸ Select the hole feature.
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▸ On the Home tab®Pattern group, choose the Rectangular Pattern command.

Select the top face shown.

Notice the preliminary pattern position. This may differ from yours.
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Note

The warning icon displays to let you know that some of the pattern instances
fall outside the part body.

▸ On the steering wheel, click the cardinal point (1) to define the X Count direction.
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▸ Edit the pattern rectangle. Click the pattern rectangle point (1) and drag inside
the top face (2). This creates a 3 x 3 pattern inside the top face.

▸ In the command bar, click Accept. Click in the part window to end the pattern
command.

Modify the pattern size

You can change the dimensional size of the pattern in several ways.
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▸ In Pathfinder, select the Pattern feature just created.

▸ Select the pattern Edit Definition handle.
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The Pattern command bar appears, as well as all of the defining dimensions.

▸ Change the pattern width (X direction) to 60 mm and the length (Y direction) to
115 mm.

Change the pattern fill method

▸ On the command bar, change the Fill style to Fixed.
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Change the occurrence separation dimension (1) to 25 mm (2) in the X direction.

The X and Y count remains the same (3 x 3). While in the fixed mode, the X
spacing is set at 30 mm and the Y spacing is set at 25 mm.

▸ Drag the pattern handle (3) to change the size of the pattern rectangle. As the
rectangle changes size, the X and Y counts automatically change to fill in the
rectangular pattern area.
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▸ Drag to the approximate location (4) and notice that the X and Y changes to
4 and 2.

▸ Drag to the approximate location (5) and notice that the X and Y changes to 5
and 3. On the command bar, click Accept.
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▸ Click in the part window to terminate the pattern edit.

Suppress instances

▸ Select the pattern feature and click the edit handle. Select the Suppress Instance
option on the Pattern command bar.

Select the middle 3 holes.
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Select Accept on the Suppress command bar. Select Accept on the Pattern
command bar to finish. Click in the part window to end the pattern edit.

Modify the parent feature

Make a change to the original feature and observe how the change propagates
through the pattern.

▸ Select the original hole. Drag the steering wheel away from the hole for clarity.
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Select the Edit Definition handle to access the hole’s parameters.

Change the diameter to 5 mm and the counter bore diameter to 8 mm.

▸ Press the Esc to complete the hole edit.
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Add a feature to the pattern

▸ Construct 12 mm and 8 mm diameter circles centered on the original parent hole.
Extrude the region formed by these circles a distance of 10 mm to form a boss.

▸ Select the pattern feature. Select its handle to access the Pattern command bar.

Choose the Add to Pattern option .

▸ Select the boss and accept it.

▸ Click the instance marker (1) and then click Accept.

▸ Save and close the file.

Summary

In this activity you learned how to create and edit a rectangular pattern of features.
With practice, you should be able to create any desired rectangular pattern.
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Circular Pattern command (3D features)

Constructs a circular pattern of selected elements. For example, you can construct a
hole feature, and then construct a circular pattern of holes using the hole feature
as the parent element of the pattern.

Note

Pattern features behave as a set when performing synchronous modifications,
such as moving faces using the steering wheel. If you move a face in one of
the pattern occurrences, all the corresponding faces in all the other pattern
occurrences also move.

You can suppress individual pattern members to define gaps in a pattern to avoid
other features.
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Workflow overview

You construct circular patterns using the following workflow:

1. Select the elements you want to pattern.

2. Start the Circular Pattern command.

3. Select a plane onto which you want to place the pattern preview.

4. Define the pattern parameters using command bar and the dynamic input boxes
in the graphics window.

Selecting the elements to pattern

You can select features, faces, and face sets as the parent elements to pattern. You
can select the elements in the graphics window or in PathFinder.

Starting the Circular Pattern command

The Circular Pattern command is only available when you select valid elements first.

Selecting a plane for the pattern preview

You can select any planar face, reference plane, or base coordinate system plane for
the pattern preview. When you select the planar face, a default preview pattern
appears.

You also define the axis of rotation for the circular pattern when selecting the
pattern plane. For example, to place a circular pattern of the hole shown, the center
of the circular planar face that the hole pierces is appropriate. In this example, use
the Keypoints option on QuickBar to make it easier to position the axis of rotation
handle at the center point of the circular model face.
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Defining the pattern parameters

You can use command bar and the dynamic edit boxes in the graphics window to
define the pattern parameters you want. For example, you can change the number of
occurrences, and whether a partial or full circle pattern is constructed. You use the
Circle/Arc Pattern option on command bar to specify a full or partial circular pattern.

You can construct circular patterns with the following placement options:

• Fit

• Fixed

Fit example

With the Fit option and a full circle pattern, you specify the number of
occurrences.
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If you specify a partial circular pattern, you also specify the sweep angle of the
arc and the pattern direction. The pattern direction controls whether the pattern
occurrences are copied in a clockwise or counter clockwise direction. You specify
the pattern direction by clicking the direction arrow, as shown below.

Fixed example

With the Fixed option, you specify the total the number of occurrences, the
angular spacing between occurrences, and the pattern direction.

mt01413-s-1050 Solid Edge fundamentals 6-59



Lesson 6 Constructing functional features

You can also use the Fixed option to create a full circular pattern where the
angular spacing between the parent feature and the last occurrence is less than
the defined angular spacing. For example, with a pattern count of 8, and a
defined angular spacing of 47°, the angular spacing between the parent feature
and the last occurrence will be 31°.

Suppressing pattern occurrences

You can suppress individual patterns occurrences or you can suppress a group of
pattern occurrences. You can suppress occurrences while you are constructing the
pattern or you can edit the pattern later to suppress occurrences.
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Suppressing individual occurrences

You suppress individual occurrences in patterns with the Suppress Occurrence
button on command bar. With the pattern feature selected, you can click the
Suppress Occurrence button on command bar, and then click occurrence symbols
to specify which occurrences you want to suppress. The symbols change size and
color to indicate that the corresponding occurrences are suppressed.

You can also drag the cursor to fence any number of occurrences.

You can also display suppressed pattern occurrences with the Suppress
Occurrence button. Click the button and then select the suppressed occurrences
you want to appear.

Suppressing occurrences using a sketch region or plane

You can also suppress pattern occurrences using a sketch region or planar face.
With the pattern selected, you can click the Suppress Regions button, and then
select the sketch region that encloses the occurrences you want to suppress. The
occurrences inside the region are then suppressed, and a suppression direction
arrow appears.
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You can click the direction arrow to specify that the occurrences outside the
sketch region suppress instead.

Editing pattern parameters

You edit the parameters for an existing pattern by first selecting the pattern using
PathFinder or QuickPick. Selecting the pattern displays the pattern action handle.

When you click the pattern action handle, the Pattern command bar and the
pattern dynamic edit boxes appear in the graphics window. You can then edit the
pattern parameters, change the pattern placement option (Fit or Fixed), suppress
occurrences, and so forth.
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Deleting pattern occurrences

You can also delete pattern occurrences. Position the cursor over the pattern
occurrence you want to delete. When the ellipsis appears, click to display QuickPick.
You can then use QuickPick to select the pattern occurrence, and then press the
Delete key to delete it.

When you delete a pattern occurrence, the software is actually suppressing the
corresponding symbol on the pattern sketch. Deleting, rather than suppressing, an
occurrence can be useful when working with large or complex models, because you
do not have to edit the feature to suppress the occurrence. To restore the deleted
occurrence, you can edit the pattern feature to display the suppressed occurrences.

Adding new elements to an existing pattern

You can add new elements to an existing pattern using the Add to Pattern button
on command bar when you are editing an existing pattern. For example, if you
add a chamfer feature to the original feature that was patterned, you can edit the
pattern feature, and then use the Add to Pattern button on command bar to select
the chamfer and add it to the pattern.

Synchronous editing of pattern features

Pattern features behave as a set when performing synchronous modifications, such
as moving faces using the steering wheel. If you move a face in one of the pattern
occurrences, all the corresponding faces in all the other pattern occurrences also
move.

Guidelines for pattern features

• You can pattern multiple elements in one operation.

• You can suppress individual occurrences in a pattern.

• You can delete individual feature occurrences in a pattern.

• You can add features to an existing pattern.
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Activity: Circular patterns

Circular Patterns

This activity demonstrates the circular patterning features.

Create and then modify a circular pattern of holes.

Open the part file

Open pattern_circle.par.
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Create a circular pattern of a hole

▸ Zoom in on the lower end of the arm and select the hole.

▸ On the Home tab®Pattern group, choose the Circular Pattern command.

▸ Move the cursor (rotation axis) over the center of the circular plane shown.
When the center symbol displays, click to define the center of rotation.
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▸ A preview is shown with the default Count set to 4.

Change the Count to 6 and press the Enter key.
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▸ Click in the part window to end the pattern command.

Modify the pattern

▸ Select the circular pattern and then click the Edit Definition handle to access the

Pattern command bar. Select the Circle/Arc Pattern icon .

▸ Change the arc angle to 270°. Click the direction arrow to define the arc angle in
a clockwise direction.
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▸ On the command bar, click Accept. Click in the part window to end command.

Note

Press the Tab key to change the focus from one dialog to another, such as
when changing from the Count to the Arc Angle dialog box.

▸ Select the circular pattern set from PathFinder. Select the pattern handle to
access the command bar. Change the fill style to Fixed.

▸ Set the angle to 30°.

Note

The Count and Angle control the pattern in the Fixed fill mode.
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▸ Modify the incremental angle to 45°, leaving the same count of 6 holes.

▸ Change the Fill style to Fit.

▸ On the command bar, select the Circle/Arc Pattern option to return to a full
circle. Accept the pattern and click the left mouse button to finish.

▸ The holes have threads associated with them. To see the threads, on the View

tab®Style group, choose the View Overrides command .

On the Rendering tab, select the Textures check box.
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Notice the threads on the patterned holes.

▸ Save and close this file.

Note

Just as with rectangular patterns, you can suppress occurrences, add
features, and modify the parent feature. You are free to experiment with those
functions on the command bar as desired.

Summary

In this activity you learned how to create and edit a circular pattern of features.
With practice, you should be able to create any desired circular pattern.

Pattern Along Curve command

Constructs a pattern of selected elements along a specified curve. You can select
features, faces, face sets, surfaces, or design bodies as the parent elements to pattern.
You can control how the pattern follows the curve by customizing parameters such
as start point and transformation type, as well as occurrence count, spacing, and
orientation.

You can pattern the elements along any 2D or 3D curve or model edges. For example,
you can pattern a feature (A) along a set of sketch elements (B).
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Note

Pattern features are associative to the parent elements. If you modify the
parent elements, the pattern updates. If you delete the parent elements,
the pattern is deleted.

Selecting the elements to pattern and the pattern curve

Selecting the elements to pattern

The first step in constructing a pattern along a curve is selecting the elements to
pattern. You can select the elements to pattern in PathFinder or the graphics
window.

Selecting the curve

After you select the elements to pattern, you can select any 2D or 3D sketch,
curve, or model edges to pattern the elements along.

Configuring the pattern

After you select the pattern curve, you can configure the pattern. First select the
pattern anchor point. The anchor point is the point where the pattern begins. The
anchor point must be a keypoint on the pattern curve. Use the dynamic arrow on the
anchor point to select the direction in which the pattern goes.

After you define the anchor point and direction, you can use the options on
command bar to define the number and spacing of occurrences with the Pattern
Type, Count, and Spacing options. When the Pattern Type is set to Fit, the pattern
operation places the number of occurrences specified by the Count option, equally
spaced. When the Pattern Type is set to Fill, the pattern operation places as
many occurrences as fits on the curve, with the distance specified by the Spacing
option between each occurrence. When set to Fixed, the pattern operation places
occurrences using both the Count and Spacing options.

Setting transformation type

You can customize the transformation and rotation of the pattern to better capture
your design intent. You can specify that occurrences be placed in the pattern
linearly, keeping the same orientations throughout the pattern. Or, you can specify
a transformation that will change the orientations of the occurrences depending
on the input curve or a specified plane.

The reference point is the point in the pattern at which transformation begins. By
default, the reference point is the anchor point (A). To select a different reference
point, click the Reference Point button on the command bar and click a new point on
the pattern (B). The pattern transforms to the new position (C).
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A linear transformation orients occurrences based on the orientation of the patterned
elements.

A full transformation orients occurrences based on the input curves.

A transformation from plane projects the initial occurrence and a target occurrence
onto a plane, where a measured angle defines occurrence orientation.
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You can also use the Rotation Type control to specify whether the input feature
position or input curve position determines occurrence placement.

Controlling pattern occurrences

You can suppress occurrences in patterns along curves with the Suppress Occurrence
button on command bar. After you click the Suppress Occurrence button, click the
occurrence symbols for the occurrences you want to suppress. You can suppress
individual occurrences, or you can use a fence to suppress adjacent multiple
occurrences.

You can insert occurrences in patterns along curves with the Insert Occurrence
button. After you click the Insert Occurrence button, you can click a keypoint to
insert an occurrence. Use the Offset option to control its offset.

Adding new elements to an existing pattern

You can add new elements to an existing pattern using the Add to Pattern button
on the command bar when you are editing an existing pattern. For example, if
you add a chamfer feature to the original feature that was patterned, you can edit
the pattern feature, then use the Add to Pattern button on command bar to select
the chamfer and add it to the pattern.

Guidelines for creating pattern features

• You can pattern multiple elements in one operation.

• You can suppress individual pattern occurrences in a pattern along a curve.

• You can insert individual feature occurrences into a pattern along a curve.

Activity: Pattern Along Curve

Pattern Along Curve

This activity demonstrates the Along Curve patterning command.

Work with a pattern of holes arrayed along a curve chain.
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In this activity you will:

• Create the pattern.

• Change the pattern’s parameters.

• Add an occurrence of the hole.

Open the part file

Open pattern_curve.par.

Create a pattern of holes along a curve

▸ Select the hole at the top of the angled arm.

▸ On the Home tab®Pattern group, choose the Along Curve command.
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In the command bar, select Chain from the Select list.

Select the curve along the angled arm and accept it on the command bar.

Select the left endpoint of the curve to define the anchor point.

Select the pattern direction by moving the cursor until the arrow points to the
right and then click to accept it.
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A preview is shown.

Change the Count to 8.
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Accept this pattern by selecting the green check. Click the left mouse button.

Insert an occurrence to the pattern

With the Along Curve command you can insert and offset a new occurrence by
selecting a keypoint of the curve.

▸ Select the pattern. Click the Edit Definition handle to access the command bar.

Select the Insert Occurrence icon .

Select the endpoint of the first curve segment in the chain.

Type 5 in the Offset field in the command bar.
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▸ A new hole occurrence is created at 5 mm along the curve. Click to accept the
offset. Click to accept the changes and exit the command.

▸ Save and close this file.

Note

Just as with rectangular and circular patterns, you can suppress occurrences,
add features, and modify the parent. You are free to experiment with those
functions on the command bar as desired.

Summary

In this activity you learned how to create and edit a pattern of features along a
curve. The pattern feature origin is used during pattern creation. With practice, you
should be able to create any desired pattern along a curve.

Fill pattern
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The Fill Pattern command creates a pattern of a selected feature(s) that completely
fills a defined region(s). The fill pattern can be rectangular, staggered or radial. Each
fill pattern type has a set of options to define the pattern array. You can suppress
occurrences manually or with a pattern boundary offset value. You can edit fill
patterns to produce the desired result.

Fill pattern types

Fill Patterning workflow

Step 1: Select feature(s) to pattern.

Step 2: On the Home tab®Pattern group®Rectangular pattern list, choose the
Pattern Fill command.

Step 3: Click region to pattern fill.

Step 4: Press the Enter key, click the green check mark or right-click to place the
pattern fill preview.

Step 5: On the pattern fill command bar, select the pattern fill type. Rectangular
fill is the default.

Step 6: On command bar, set the desired pattern options.

Step 7: The origin of the feature(s) to pattern defaults to the centroid. Using the
steering wheel, you can modify the origin, define the direction of the first
pattern row and edit the spacing values. You can also click the Edit
Profile handle to modify the pattern region.

Step 8: Right-click or click the green check mark to place the fill pattern.

Step 9: Left-click or press the Esc key to end the pattern fill command.
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Rectangular fill

Default pattern fill type. This pattern type fills a region(s) with rows and columns of
occurrences.

Two values to define row and column spacing. Use the Tab key to alternate between
the spacing value boxes.

Change the direction vector for the pattern row by clicking the steering wheel torus
and then enter an angular value. In a rectangular fill pattern, the columns always
align perpendicular to the direction of the rows.

Stagger fill

This pattern type fills a region(s) with staggered rows of occurrences.

Polar and Linear offset are the options to control the staggered fill pattern.
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Using the Polar option, (A) is the spacing of occurrences on the first row. (B) defines
the offset row. The spacing is defined by an angle of rotation with a radius of the
row spacing value.

Using the Linear Offset option, (C) is the offset spacing of occurrences above (and
below) the first row. (D) defines the spacing between rows.

Radial fill

This pattern type fills a region(s) with radial rings of occurrences.
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The Instance Count spacing option provides control of how many occurrences count
box (A) per ring. The value box (B) controls the radial spacing of occurrences.

The Target Spacing option provides control of the radial spacing of occurrences (C)
and the occurrence spacing on each ring (D).

Center orient

The Center orient option is available with radial fill only.
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This option provides control of the orientation of the radial occurrences. When you
select this option is, the steering wheel changes and an arrow inside the torus
appears. This arrow orients the occurrences.

The image below shows the steering wheel display with center orient Off.

The images below show the steering wheel display when center orient is On. The
steering wheel displays a knob that lies on the torus and an arrow that lies inside
the torus. Select either the knob or arrow to change the orientation of occurrences.

Notice that as the center orient angular value changes, the first occurrence (colored
orange for clarification) on the direction vector rotates by that value.
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Editing a fill pattern

You can edit fill patterns at any time. Select the fill pattern to edit by either selecting
an occurrence in the pattern or by selecting the pattern feature in PathFinder.

Click the text handle Fill Pattern to edit the pattern.

At this point, you can make any changes to the selected pattern fill. You can even
change the fill pattern type.

Add a feature to the parent features set of an existing pattern

You can add (or remove) parent features that are patterned.

Workflow

Step 1: Edit the pattern.

Step 2: Click the Add to pattern button on the command bar.

Step 3: Select feature to add or remove from parent features.

Step 4: Right-click (or green check mark) for a preview. Right-click (or green
check mark) to accept.

6-84 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

Edit a pattern profile

When you create a fill pattern, the patterned region boundaries are copied into
the pattern fill profile. The pattern fill profile is not associative to the original
sketch/model edges. The pattern profile can be edited.

To edit the pattern profile click the text handle Edit Profile.

When you make an edit, the pattern profile changes but not the original sketch/model
edges. When the edit is complete, the pattern updates to fill the updated profile
region. When in the edit profile mode, an icon appears in the upper right portion of

the window . Click this icon to finish the edit. The edited pattern profile must
produce a valid closed region. An error results when there is a problem with the
profile. If the profile is not corrected and the update is accepted, the fill pattern is
deleted.

Tip

In PathFinder, turn off the display of the sketch region when editing a pattern
profile. If both the pattern profile and sketch are displayed simultaneously,
editing the profile pattern may be confusing. For example: If you delete a
pattern profile element, the display of the sketch element remains and it
appears that the deleted element is still there.

Suppressing occurrences

Occurrences in a pattern fill can suppressed (or hidden).

Workflow

Step 1: On the Fill pattern command bar, click the Suppress button.

Step 2: All unsuppressed occurrences display with a green dot. Click the
occurrence to suppress. The suppressed occurrences display with a red
circle. Click a suppressed occurrence and it becomes unsuppressed.
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Step 3: On the suppress command bar, click Reset to return all occurrences to
unsuppressed.

Step 4: To suppress occurrences that overlap the region boundaries, enter an
offset value in the value box (A). This value is the normal distance
between the occurrence and the boundary. A negative value (B)
suppresses occurrences inside the region boundary by the offset value.
A positive value (C) displays occurrences outside the region boundary
by the offset value.
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Touching or overlapping pattern features

When you define the pattern fill array, an occurrence places at every location
specified by the pattern spacing or angular values. However a patterned feature may
not place at that occurrence if that feature touches or overlaps the adjacent feature.
In the example below, (A) rectangular pattern fill array was 10 x 10 and (B) was
changed to 7 x 7. The occurrence spacing in (B) caused the pattern parent to overlap
other occurrences. The pattern fill command determines which occurrences to place
a pattern parent on in order to produce a pattern result.

Activity: Fill Pattern

Fill pattern

This activity covers the steps to create a fill pattern feature. Examples of a
rectangular, staggered and radial pattern are shown. The activity shows how to edit
an existing fill pattern definition and also how to edit a pattern region profile.

Open the part file

Open fill_pattern.par.
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Attach feature to pattern

▸ The feature that we want to pattern is detached. In PathFinder, right-click on
the feature named rectangle and then choose the Attach command.

Turn on the sketch that defines the region to pattern fill

▸ In PathFinder, click the box on the sketch named fill region.
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Create a rectangular fill pattern

▸ In PathFinder, select the feature named rectangle.

▸ In the Pattern group, choose the Fill Pattern command.

▸ Select the region shown.
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▸ On the command bar, click Accept.

▸ In both of the dynamic edit boxes, type 10 and then press the Tab key.

Note

Notice that the primary axis on the steering wheel controls the first row
direction. To change the direction of the first row, click the torus.

▸ On the command bar, click Accept. Press the Esc key to end the command.
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Edit the pattern

▸ Change display to a front view.

▸ In PathFinder, select the pattern feature.
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▸ Click the Fill Pattern handle to edit the pattern definition.

▸ Notice that in some locations, the patterned feature comes very close to touching
the pattern boundary. The pattered feature origin can lie on the boundary. A
boundary tolerance can be applied to the pattern to control whether a patterned
occurrence crosses or touches the boundary. Make all pattern occurrences lie
inside the boundary.

Note

The origin of the patterned feature is defined at the center of the rectangle.

On the command bar, click the Suppress Instance button .
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▸ In the dynamic edit box, type –5 and press Tab. This value offsets the boundary
inward at a distance of 5. Notice that occurrences are now suppressed that
touched or crossed the pattern boundary. The suppressed occurrences are
denoted by a red circle.

▸ On the Suppress command bar, click the Accept button.
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▸ At this point, changes to any pattern definition can be made (for example: the
row and column distances). Make no more changes. Click the Accept button.

▸ Press the Esc key to end the pattern edit.

This completes the rectangular fill pattern portion of this activity.

Change the fill pattern type to staggered

▸ Select the fill pattern feature in PathFinder.
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▸ Click the Fill Pattern text to edit the pattern. In the fill pattern command bar,
click the Stagger fill pattern type.

▸ Notice that the occurrence vertical spacing value for a rectangular pattern is
replaced with an angular value in a staggered pattern. The default Polar value
of 60° produces a stagger on the second row equal to half of the first row spacing.

Click the Accept button.

mt01413-s-1050 Solid Edge fundamentals 6-95



Lesson 6 Constructing functional features

▸ Press Esc to end the pattern edit.

Create a radial fill pattern

▸ We will use a different parent feature to create a radial fill pattern. The feature
is triangular shaped. Delete the fill pattern created in the previous steps.

▸ In PathFinder, right-click on the feature named rectangle and then choose the
Detach command.
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▸ The fill pattern region sketch was moved to the Used Sketches collector after it
was used to create the previous fill pattern. To get the sketch back, right-click on
the sketch and click Restore.

▸ In PathFinder, right-click on the feature named triangle and then choose the
Attach command.

▸ In PathFinder, select the feature named triangle.

▸ Choose the Fill Pattern command.
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▸ On the command bar, click the Radial fill pattern type.

▸ Select the same pattern region as used for the rectangular fill pattern and then
click the Accept button.

Notice that Instance Count is the default spacing.
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▸ Change the count to 16 and the spacing distance to 15.

▸ Click the Accept button and then press Esc.

Edit the radial fill pattern

▸ In PathFinder, select the fill pattern feature.
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▸ Change the spacing to Target Spacing.

▸ Edit the spacing as shown.

▸ Edit the boundary offset to –5.
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▸ Accept the Suppress step. Accept the pattern edit. Press Esc to end the pattern
edit.

Change orientation of occurrences

▸ An option available only for a radial pattern fill is the Center Orient option. This
option provides the control of the orientation of each occurrence in the pattern.
Edit the radial pattern feature.
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▸ On the command bar, click the Center Orient option .

Notice all occurrences now have a new orientation.
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The orientation is controlled by the steering wheel’s secondary axis (short arrow).
The arrow points to the side of the parent feature which points to the center of
the radial pattern. The following image shows the default orientation. In this
example, the patterned arrows align in a counter-clock wise direction.
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▸ Click on the steering wheel’s torus sphere at the 12 o’clock position. All arrows
point to the center.
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▸ Change the orientation as shown. All arrows should point away from the center.

▸ Accept the edit and end the edit pattern command.

▸ Detach the pattern parent. In PathFinder, right-click the feature named triangle
and choose the Detach command.
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Edit the pattern fill boundary

▸ When a pattern fill is created, the boundaries are copied into the pattern
definition. The original edges and sketch elements that define boundaries are
not associative to the pattern boundaries. The original sketch is moved to the
Used sketches collector.

▸ Edit the radial pattern feature. Click the Fill Pattern handle.

▸ Click the Edit Profile handle.
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▸ Edit the region profile as shown. When edit is complete, click the green check in
the upper right portion of the window.

Note

Hint: Use the Arc by 3 points command to place two new arcs. Use the
Trim command to remove profile elements. Use the Connect relationship
on the new arcs and the lines.

▸ Click the Accept button and then press Esc.

This concludes this activity. Close the file.
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Summary

In this activity you learned how to create and edit a fill pattern. There are several
options available to assist you in creating a desired fill pattern. Spend some time
exploring these options to help master the use of the fill pattern command.

Lesson review

Answer the following questions:

1. What are the two options for defining the occurrence count and spacing of
pattern occurrences?

2. When are the Rectangular and Circular pattern commands available?

3. What element types are valid for patterning?

4. In the Pattern Along Curve command, what types of curves can be used?

5. When using a Stagger fill pattern type, which of the following offset options
requires an angle of rotation and a radius of the row spacing value?

Lesson summary

• Solid Edge provides four methods for patterning features: rectangular, circular,
along a curve and a region fill.

• Patterns can be mirrored about a plane just like any single feature.

• You can suppress individual patterns occurrences or you can suppress a group of
pattern occurrences. You can suppress occurrences while you are constructing
the pattern or you can edit the pattern later to suppress occurrences.

Feature libraries

Feature libraries

You can use many of the features used for modeling in Solid Edge in a similar
fashion in other designs. The Feature Library page and Teamcenter Feature Library
page provides a place for you to store commonly used part and sheet metal features
in an easy to access location so you create new designs with less effort and more
consistency.

Note

You cannot edit the features stored in the feature library.

For example, you can construct a cable tie in one part, store the feature in a feature
library location, then reuse it in a new part later.
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A feature library entry may contain the following synchronous elements:

• features

• faces

• sketches

• planes

• coordinate systems

• constructions

Note

You can only place a synchronous feature library member while in the
synchronous environment.

The only ordered element that you can add to the feature library is a feature. When
placing an ordered feature in a feature library, the attributes for the feature are
maintained.

A feature library entry cannot contain a mixture of synchronous and ordered
elements.

Note

You can place an ordered feature library member while in either the
synchronous or ordered environment.

Feature library members

A feature library member is a special type of Solid Edge part or sheet metal
document. Feature library members typically do not have a base feature.
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Defining unmanaged feature library locations

An unmanaged feature library is a folder on your computer or a network drive that
is used to store feature library members. You define the location for a feature
library using the Look In option on the Feature Library page. Use the Look In
option to browse to an existing folder on your hard drive or a network drive. You
also can use the Create New Folder button to create a new folder where you can
store library members.

To avoid confusion, define standards for which folders you use as feature libraries.
You should use these folders for feature library member documents only and not
store other Solid Edge documents in them.

It is recommended that ordered and synchronous feature library members be added
into separate folders.

Learn how to use feature libraries

A feature library tutorial is available for learning how to use feature libraries. To
access the tutorials, click Tutorials on the Help menu. The feature library tutorial is
located in the Sheet Metal section on the Tutorials menu.

Storing features in a library

The steps for creating an unmanaged feature library member are:

for synchronous members

Step 1: Switch to the synchronous environment.

Step 2: Select one or more synchronous elements.

Step 3: On the Feature Library page, click the Add Entry button.

Note

You can also select the synchronous elements, add them to the
clipboard, and then paste into the Feature Library page.

Step 4: Define a name for the library member using the Feature Library Entry
dialog box.

for ordered members

Step 1: Switch to the ordered environment.

Step 2: Select one or more ordered features.

Step 3: On the Feature Library page, click the Add Entry button.

Note

You can also select the ordered elements, add them to the
clipboard, and then paste into the Feature Library page.
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Step 4: Define custom prompts and notes for the library member using the
Feature Set Information dialog box.

Step 5: Define a name for the library member using the Feature Library Entry
dialog box.

The steps for creating a Teamcenter-managed feature library member are:

Step 1: Select a feature from the part.

Step 2: Click the Teamcenter Feature Library tab.

Step 3: Drag the geometric feature to the Teamcenter Feature Library page.

Step 4: Complete the New Document dialog box.

A simple ordered example

To create a new ordered member in a feature library, select a feature (A). On the

Feature Library page, click the Add Entry button to add the new library member
to a Feature Library folder (B).

When you click the Add Entry button on the Feature Library page, the Feature
Set Information dialog box appears so you can review the required and optional
elements of the new library member, define custom prompts, and add notes for the
library member elements.

The feature library stores each member you add as an individual document and the
software assigns a default document name.
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Selecting features

You can select features in the application window or on the PathFinder page. You can
store a single feature in a library or you can store several features as a unit. To store
multiple features as a unit, hold the Ctrl or Shift keys when you select the features.

When storing a single ordered feature, only a profile-based feature is valid. When
storing several ordered features, the lower-most feature in the feature set must
be a profile-based feature. Subsequent features can be profile-based or treatment
features.

Ordered Feature Set Information dialog box

The Feature Set Information dialog box Feature Set Information dialog box displays
the features, reference planes, and dimension elements in the same sequence that
will be used when the library member is placed. For example, when defining a
library member for a cutout feature, the cutout feature is listed in the Feature Name
column. Elements that belong to the cutout are listed in the Type column. This
can include the profile plane (A) and any dimensions that reference edges outside
the cutout profile (B) (C).

A Status column in the dialog box lists whether a library element is required or
optional. A required element must be redefined when placing the library member.
An optional element can be redefined when you place the library member or can
be skipped and redefined later.

You can use the Prompt column to define custom prompts for each element in the
Type list. This makes it easier for other users to place the library members.
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Ordered dimensions that reference geometry outside the profile

When you create a new ordered feature library member, dimensions that reference
geometry outside of the feature set are listed in the Feature Set Information dialog
box, but you will need to redefine the external elements for the dimensions later.
For example, the two 12 millimeter dimensions reference edges that are outside the
library member profile.
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You can redefine the dimension edges when you place the library member, or you can
skip the dimensions and redefine the dimension edges by editing the feature.

Defining custom prompts and notes

To type custom prompts, double click a Prompt cell, then type the prompt you
want. The prompts you type are displayed in the status bar on the command bar
when you place the library feature. When you open a prompt cell, the message area
at the bottom of the dialog box is also activated, so you can type more information
about the element.

Closing the dialog box and renaming the library feature

When you click the Close button on the Feature Set Information dialog box, a new
library member is added to the Feature Library page using a default document
name. To rename a stored feature, select it in the Feature Library page, then click
the Rename command on the shortcut menu.

Placing feature library members

Placing synchronous feature members

You place a synchronous library member in a document by dragging the library
member from the Feature Library page to the application window.

When you paste a feature library member, the origin of the steering wheel is the
origin of the feature library member. The orientation and position are maintained.
You cannot locate a keypoint when pasting the feature library. You can use the Move
and Rotate commands to precisely position and orient the feature.

When placed, faces add as detached. You can use the Attach command to attach
the geometry to the new model.
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Placing ordered feature members

You place an ordered library member in a document by dragging the library member
from the Feature Library page and dropping it into the application window.
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When you drop the ordered member into the application window, the feature creation
process starts, similar to when you create a feature from scratch. A command bar
and the Feature Set Information dialog box appear, so you can define the required
and optional elements for positioning the library member on your model.

The basic steps for placing an ordered library member include:

1. Define the required elements, such as the profile plane and profile orientation.

2. Define the optional elements, such as dimensions that reference external
elements.

Defining the profile plane and the profile orientation

The profile for the member attaches to the cursor so you can position the feature
approximately where you want it. When you move the cursor over a planar
face or reference plane, the profile for the feature orients itself with respect to
the x-axis of the profile plane.

6-116 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

You also can select a different reference plane placement option using the
Create-From Options list on the command bar.

For coincident and parallel reference planes, you can reorient the profile for the
library member by defining a different x-axis for the profile plane. For example,
when defining a coincident profile plane, you can use the N key on the keyboard
to select the next linear edge as the x-axis. When the profile is oriented properly,
click to position the library member.
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After you define the profile plane and profile orientation, the profile positions on
the face, and the Feature Set Information dialog box updates to the next element
in the list. If dimensions that reference external elements are in the list, the first
dimension appears in the graphic window so you can redefine the external edge.
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Redefining dimension edges while placing the library member

To redefine the external edge for a dimension while placing the library member,
simply select an appropriate edge in the graphic window (A). The dimension
attaches to the selected edge, using the dimension value that appears (B). The
profile updates its position, and if another dimension that references an external
element is in the list, it appears in the graphic window (C).

You can then select an edge for the next dimension (A), and the profile updates
again (B). If this is the last element in the Feature Set Information list, the
completed feature appears in the graphic window. The value of the dimensions
reflects the original dimension value when you defined the library member.

If this is the only copy of the library member you want to place, you can click the
Close button to close the dialog box. If you want to place another member, you
can click the Repeat on the command bar.
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Placing additional copies of the library member

After you place a library member, you can place another copy using the Repeat
button on the command bar. You can place a copy on the same face, (A), or a
copy on a different face (B).
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If you place another library member on the same face as the original member,
you will likely want to avoid placing both copies directly on top of one another. If
you select the same edges for the dimensions that reference external elements,
the second member places directly on top of the first member. This can cause the
feature to fail, but you can fix it by editing the dimensions for the feature later.

You can also avoid this by not selecting an edge for one of the dimensions during
placement of the library member. For example, you can skip the 12 millimeter
dimension shown (A), by clicking the next row in the Feature Set Information
dialog box (B).
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The next dimension appears in the graphic window (A). In this case, you can
select the same edge (B) as the first member. The profile and feature place on the
face, and the dimension you skipped appears in the failed color (C) to indicate
that it needs to have its external edge defined. You can then close the dialog box
and edit this feature to define the dimension edge and edit its value.

Library members with multiple features

You can create library members that contain more than one profile-based
feature. For this type of member, the reference plane for each profile-based
feature is captured in the Feature Set Information dialog box as a required
element. You must redefine the profile plane for each feature in the library
member at placement time.

Feature library member behavior after placement and feature groups

After you place a feature library member on a model, it is treated the same as
features you construct manually. You edit them in the same fashion. A feature
group is created in Feature PathFinder for library members that consist of
multiple features. In this example, there were three feature library members
placed on the model. Two with single features (A) and (B), and one with multiple
features (C). Notice that only one feature group was defined.
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Redefining parent edges

When you bypass dimensions with references to external elements while placing an
ordered library member, the dimensions appear using the Failed color (A). This
makes it easy to find and redefine parent edges for the dimensions. Bypassing
dimensions can be useful in the following situations:

• When placing two library members on the same face.

• When redefining a dimension that references an external edge at placement
time would cause the feature to fail. For example, defining the 48 millimeter
dimension (A) during placement forces the library member profile off the
selected face, which causes the feature to fail temporarily. This can be easily
fixed by editing the feature later, but it is often easier to visualize placement of
a complex library member when you bypass source dimensions in these cases,
as shown at (B).
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To redefine the parent edge for a dimension later, do the following:

Step 1: Select the feature in Feature PathFinder or the graphic window (A),
then click the Dynamic Edit button (B) on the Select Tool command bar.
The profile and dimensions appear in the graphic window. Any failed
dimensions (C) are displayed using the Failed color.

Step 2: Select the failed dimension you want to reattach (A). The dimension
handles appear (B) (C).

Step 3: Position the cursor over the appropriate dimension handle (A), then drag
the handle over the edge (B) to which you want to attach the dimension.
Notice that the dimension value updates to reflects the current distance
between the external edge and the profile element (C).
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Step 4: Edit the dimension to the value you want.

Feature library guidelines

• The first feature for an ordered library member must be a profile-based feature.

• You can select one or more features.

• An ordered library member that contains a treatment feature, such as a round or
chamfer, must also include the parent profile-based feature.

• Driving dimensions that reference edges outside of the select set are captured as
part of the library member definition.

• Geometric relationships that reference edges outside of the select set are not
captured as part of the library member definition.

• When you place an ordered library member, a command bar and Feature
Set Information dialog box allow you to place the profile-based features onto
reference planes you select.
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• An ordered library member can contain suppressed features. When placed, the
features remain suppressed.

• Library members that use a sketch profile as input are allowed as long as a
feature exists on the same face as the sketch. Dimensions that reference edges
outside of the select set are not captured when using sketches.

• The library member can not contain external dependencies other than
dimensions. For example, you can not use edges of the model that are not
included in the select set to orient a reference plane that is used to create one of
the features for the library member.

Create an unmanaged feature library member

Step 1: Click the Feature Library tab.

Step 2: On the Feature Library page, use the arrow button on the Look In box to
specify the location of the feature library folder.

Step 3: In the Solid Edge window or on the PathFinder page, select the feature(s)
you want to copy to the feature library.

Step 4: Right-click and choose Copy. Display the Feature Library tab, right-click
and choose Paste.

Note

You can also click Add Entry button to perform a copy and
paste into the feature library.

Step 5:

Note

When adding ordered features, a feature library member
document is added to the Feature Library tab, and the Feature Set
Information dialog box appears.

In the Feature Library Entry dialog box, type a name for the library entry.

Tip

• To store multiple features as a unit, press the Shift or Ctrl keys, and
select the features.

• You can use the Rename command on the shortcut menu to change the
name of the new feature library member document on the Feature Library
page.

• For ordered features, you can define prompts and notes for the elements
in the Feature Library Information dialog box.
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Place a feature library member into another document

Step 1: Open the Solid Edge document you want to place the stored feature
library member into.

Step 2: In the lower left portion of the window, click the Feature Library tab.

Step 3: Select the feature library member you want and drag it from the Feature
Library page to the Solid Edge window.

Step 4: Position the cursor over the face you want and click to position the profile
for feature library member.

Step 5: Use the Move command to precisely position and orient the feature.

Step 6: Use the Attach command to attach the geometry to the model.

Activity: Feature Libraries

Feature Libraries

This activity demonstrates the definition and use of feature libraries.

Create and place a frequently-used face set.

In this activity you will:

• Create a feature library.

• Copy a feature to the new library.

• Place the library member into two different part files.

Open the part file

Open feature_library.par.
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Create a feature library

▸ Select the Feature Library tab on the left edge of the application window,
exposing the Feature Library pane.

On the Look In list, change the view to the C: drive.

Note

The C: drive contents will vary from those shown below.

▸ Click the Create New Folder button to create your own folder under the Local
Disk (C:). You can type any folder name you wish.

The focus automatically changes to the new folder.
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Note

The folder name shown will vary from yours.

Define a member of the feature library

▸ Select the Protrusion 8 face set, either directly or from PathFinder.

Note

It is important to position the steering wheel on a feature that is being copied
so that when it is pasted to a face, the copied feature orients properly.

Use the following steps to position the steering wheel plane on the bottom face.
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▸ Click the steering wheel origin and drag it to an edge on the bottom face.

▸ Click the secondary axis knob.

▸ Move the cursor to rotate the secondary handle about the primary axis. As you
move to location (1), the knob jumps to a 90 degree increment. Click to position
the secondary axis.

▸ Hold the Shift key and click the steering wheel plane.
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▸ Right-click and choose Copy, or press Ctrl+C.

Select the Feature Library tab from the left hand edge of the application window.

It should still be set to the folder created earlier. Right-click in the white space
towards the bottom and choose Paste.

The Feature Library Entry dialog box appears. Type cable_tie for the name,
then click Save.

You now have a feature library member.

Note

You can speed up member creation by selecting the desired face set and
clicking the Add button on Pathfinder.

Reuse the feature library member

Since it is saved to a folder on your computer, this feature is now available to use
again in this part file, as well as in other part files. You will do this in the following
steps.
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▸ Select the cable_tie.par in the Feature Library and drag it into the model window.
Notice the feature attaches to your cursor.

Place the bottom of the feature on the inside surface of the channel. When the
surface highlights, press the F3 key to lock to that plane.

Click the left mouse button to place the cable tie.
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Click the left mouse button to end the command.

▸ Place two more instances of the cable tie to get the feel for this process.
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Add features to model

▸ To add the feature to the model, select the feature in PathFinder. Right-click and
choose Attach from the list.

Select Add from the Attach dialog box.

The construction body is now attached.
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▸ Repeat for all three features.
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Position the feature in the channel center

▸ Select the first feature you placed. You can either select it directly or in
PathFinder.

Note

You will need to use QuickPick to select the feature directly. It is faster to
select it from PathFinder.

▸ Move steering wheel origin to the cylinder center.

▸ Click cardinal point shown to define move direction.
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▸ Click the move handle.

▸ Move to the midpoint of the edge shown. Click when the midpoint symbol
displays. If the midpoint does not display, select the midpoint option on the
command bar.

Left-click to end the move command.

Position feature along channel with a dimension

▸ Place a dimension from end face of channel to face of feature. Choose the
Distance Between command.

▸ On command bar, click the Lock Dimension Plane option .

Select face shown.
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▸ Place the following dimension.

▸ Select the feature in PathFinder.
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▸ Click the dimension value. Make sure the direction is as shown. Lock the
dimension.

▸ Type 75 in the dimension edit box and press Tab.

Left-click to end the move command.

▸ Optional step: Center the two remaining features in the channel. Position the
middle feature at the center of the channel length. Dimension feature on the
other end 75 mm from channel end.

▸ Save and close this file.

Use the feature library member in another file

The feature is available to use in other part files.
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▸ Open the file feature_library2.par.

▸ In the Feature Library tab, navigate to the folder you created earlier.

▸ Select the cable_tie.par feature and drag it into the model window.
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Highlight the face shown and press the F3 key to lock it. The feature flips. Click
the left mouse button to place the tie.

▸ Save and close this file.

Summary

In this activity you learned how to create a feature library. You also learned how
to add features to the library and how to place the feature into other files. Feature
libraries are for storing common features that are used often in a company’s design
process.

Lesson review

Answer the following questions:

1. What is the major difference between feature library entries in ordered modeling
compared to synchronous modeling?

2. When placing a feature library member, what serves as its origin?

3. True or False: Driving dimensions that reference edges outside of the select set
are captured as part of the library member definition.

4. Generally, why would you define construction elements (curves and points) as
a first step?

Lesson summary

• You can create a single feature library member composed of one or more features.

• Library members that use a sketch profile as input are allowed as long as a
feature exists on the same face as the sketch. Dimensions that reference edges
outside of the select set are not captured when using sketches.
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• After you place a feature library member on a model, it is treated the same as
features you construct manually. You edit them in the same fashion.

Detaching and attaching faces and features

Detaching and attaching faces and features

You can modify synchronous models by detaching and attaching one or more faces
or features. Detaching faces or features makes it possible to remove faces from the
solid model without deleting them. This can be useful when you need to create
a new variation of an existing model that does not contain some of the features
on the existing model, but you want to maintain the features in the document for
possible future needs.

Detaching faces or features also makes it possible for you to move or rotate the face
set to a new position on the model and then reattach them in the new location.

Detaching faces

You can detach faces using the Detach command on the shortcut menu when one or
more faces or features are selected, or you can use the Detach option available on the
Move QuickBar. You can select the faces in the graphics window or in PathFinder.

When you use the Detach shortcut menu command, the detached faces are hidden
automatically in the graphics window, and the color is changed to the construction
color. You can use PathFinder to display the faces.
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To detach faces successfully, the integrity of the solid body must be maintained.
In other words, for a detach operation to be successful, no gaps between faces are
allowed. If a solid body cannot be maintained, the detach operation is unsuccessful,
and the model will not be modified. A message is also displayed to inform you that
the model was not modified.

When you detach faces, adjacent faces are often modified to ensure the integrity of
the solid model. For example, when you detach a blend face, such as a round, the
size and shape of the adjacent faces changes.

Attaching faces

You can attach faces using the Attach command on the shortcut menu when detached
faces are selected in PathFinder or the graphics window. To successfully attach, a
valid solid body must be formed. If the faces you are trying to attach do not form
a valid solid body, a message appears.

In some cases you may be able to adjust the position of the detached faces, and
attach them successfully. In other cases, it may not be possible to form a valid
body. In this situation you should consider deleting the detached faces, and model
the faces or feature over again.

Detach faces

Major methods of detaching faces or features and the advantages of each:
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• Detach can be useful when you need to create a new variation of an existing
model without compromising your current design. Use the Detach command on
the shortcut menu upon selecting the faces or features.

Note

When you use this shortcut menu command, the detached faces hide
automatically in the graphics window, and the color is changed to the
construction color. You can use PathFinder to display the faces.

• A detached face set can move or rotate to a new position on the model and then
reattach. Use the Detach option available on the Move command bar. You can
select the faces in the graphics window or in PathFinder.

6-146 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

What faces can detach?

• Procedural Features may detach in their entirety.
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• Blends may detach.

• Faces of patterns may detach. Reattaching does not reintroduce the faces back
into the pattern.
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• Thin-wall faces may detach. Reattaching does not cause the thin-wall
relationship to reestablish.

• A single instance of a hole group can detach.
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Dimensional and geometric relationships

Internal relationships between faces that detach are maintained.

External relationships to faces outside the faces being detached are kept, but
suppressed.

Note

To detach faces successfully, the integrity of the solid body must be
maintained. In other words, for a detach operation to be successful, no gaps
between faces are allowed. If a solid body cannot be maintained, the detach
operation is unsuccessful, and the model will not be modified. A message is
also displayed to inform you that the model was not modified.

Note

When you detach faces, adjacent faces are often modified to ensure the
integrity of the solid model. For example, when you detach a blend face, such
as a round, the size and shape of the adjacent faces changes.

Attach faces

Detached faces can be selected in PathFinder or the graphics window, and reattached
to the model using the shortcut menu Attach command.

What faces can attach?

• Any selected construction body can attach to the design model.
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• Faces attaching that do not have add/remove attributes on the edges of the model
require the user to specify the behavior at the time of attaching.

o When attaching a sheet body with no add/remove attributes, the user is
required to specify a side.

o When attaching a solid body, the user must specify the behavior at the time
of attaching (Add or Subtract).

Note

To successfully attach, a valid solid body must be formed. If the faces you are
trying to attach do not form a valid solid body, a message appears.

Note

In some cases you may be able to adjust the position of the detached faces, and
attach them successfully. In other cases, it may not be possible to form a valid
body and you should consider deleting the detached faces, and re-model them.
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Activity: Detach and attach face sets

Detach and attach face sets

This activity demonstrates the method of detaching and attaching faces in response
to a design change.

Detach an existing set of faces and make a change to the model. Then reattach them
within the same part.

In this activity you will:

• Detach faces.

• Extend a face (representing the design change).

• Reattach the faces.

Open part file

In this activity, you will respond to a major design change. Three mounting arms
remain in place as the height of the body increases.
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Open detach.par.

Detach faces

▸ In PathFinder, select the features Ear, Slot, Pattern4.
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▸ Right-click and select Detach.

The faces disappear from the display.

Note

These detached face sets appear gray in PathFinder.
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You can display the detached face sets by clicking the check box in
PathFinder.

▸ Ensure display of the detached face set is off.
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Modify the height of the part

▸ Select the top and beveled faces shown.

Move the selected faces a distance of 50 mm.
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▸ Press Esc to finish.

Attach the face set

▸ Turn on display of the detached face sets Ear, Slot, Pattern4 and select them,
either graphically or from Pathfinder. The latter method is often easier.

▸ Right-click and choose Attach.
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You can see the face sets attach by their color change.

▸ Save and close this file.

Summary

In this activity you learned how to detach features and then make model changes.
After changes were made, you learned how to reattach the detached features. The
detached features are listed in PathFinder. Their display can be turned on or off.

Activity: Attach

Attach

This activity demonstrates how to attach faces.

Attach a mounting tab to an anchor bracket.
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In this activity you will:

• Move faces.

• Attach the faces.

Open the part file

Attach a mounting tab to an anchor bracket.

Open attach.par.

Move faces

▸ In PathFinder, select the detached protrusion.
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▸ While the feature is selected, click the 45 mm dimension. Make sure the
dimension direction is as shown. Change the dimension to 32 and press the
Enter key.

Click the left mouse button to finish the move.
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Attach the faces

▸ Select the detached protrusion again; right-click and select Attach.

On the Attach dialog, select Add.

The protrusion attaches. Notice the color change from that of construction faces
to model faces.

▸ Save and close the file.

Summary

In this activity you learned how to attach a detached feature. Detached faces display
with a construction face color. As the faces attach to the solid model and form a
volume, the faces turn the color of the solid model faces.

Lesson review

Answer the following questions:

1. If you wish to detach faces from a model, what condition must exist for the
detach operation to be successful?

2. What elements can be detached?

3. For a successful attach operation, what must be formed?
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Lesson summary

• You can modify synchronous models by detaching and attaching one or more
faces or features. Detaching faces or features makes it possible to remove faces
from the solid model without deleting them.

• This can be useful when you need to create a new variation of an existing model
that does not contain some of the features on the existing model, but you want to
maintain the features in the document for possible future needs.

• Detaching faces or features also makes it possible for you to move or rotate
the face set to a new position on the model and then reattach them in the new
location.

Cutting, copying, and pasting model elements

Cutting, copying, and pasting model elements

You can cut, copy, and paste part and model elements using the Windows clipboard.
For example, you can copy the cutout feature (1), then paste it to a new location
on the part (2).

Eligible element types

You can cut, copy, and paste the following element types:

• Model faces
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• Solids

• Surfaces

• Face sets

• Manufactured features

o Occurrences

• Sketches

o Sketch elements

• Reference objects

o Reference planes

o Base reference planes omitted from copy and cut operations

o Coordinate systems

• Bodies

You can select multiple objects to copy. You can have a mixed set of sketches, faces,
manufactured features, and reference planes. If ineligible elements are found in the
select set, an error message is displayed and you can remove the ineligible elements
from the select set.

You can copy and paste elements from one source to many targets. For example, in
Synchronous documents, you can copy or cut from a part document and paste them
to another part document. Any 3D elements copied or cut from the part document
are filtered and will not be pasted.

In draft documents, 2D elements can be copied or cut and pasted to another draft
document or to a Synchronous part document. When pasting into a draft file, only
the 2D elements are pasted. Any 3D elements are filtered from and not pasted. All
sketch geometry is compressed to a single plane when pasted to a draft document.

Copying and cutting elements

When you select a set of elements to cut or copy, the following information is added
to the clipboard:

• The current orientation of the select set relative to base reference planes of
the source document.

• PathFinder Structure

o Any complete face sets

o Occurrence structure of any procedural feature

• Individual elements

o Loose faces that do not comprise a complete face set

o Sketch elements, but not an entire sketch
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o Face style override, if defined

• User defined sets

o All eligible items contained in the collection

Patterns behave differently depending on what is selected. When a pattern or all
occurrences of a pattern is selected for copy, the following information is recorded:

• All occurrences of the pattern

• Occurrence structure

• Pattern attributes

• All information needed to regenerate the pattern

When a pattern occurrence is selected for copy, the following information is recorded:

• Face geometry

• If multiple, but not all, occurrences are copied, only the geometry is copied.

There are several ways to copy an element.

• Select the element you want to copy, press the Ctrl key, and click an arrow of
the steering wheel that is in the direction you want to copy. To complete the
copy, drag the cursor to a new location and either click or type in a distance to
copy the element.

• Select an element, then click the Copy button on the command bar after
initiating a move or rotate.

• Right-click an element and select Copy.

• Press Ctrl+C on an element.
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• To copy during rotate, press the Ctrl key, and click a torus of the steering wheel.
To complete the copy, drag the cursor to a new location and either click or type in
an angle to copy the element.

When you select geometry to copy, the steering wheel appears. The location and
orientation of the steering wheel is recorded. The steering wheel location is relative
to the selected geometry and the orientation is recorded relative to the source
document.

Copying 2D elements

When copying 2D elements, sketches and sketch elements follow the same rules
as solids. You can copy the entire sketch or the sketch elements that make up
the sketch. You can select multiple sketches collected from any plane.

Copying reference objects

Reference objects such as planes and coordinate systems can be copied and
pasted. When pasted to a model, the elements are added to the target document’s
PathFinder. The steering wheel provides orientation when the objects are pasted
in the model.

mt01413-s-1050 Solid Edge fundamentals 6-165



Lesson 6 Constructing functional features

Pasting elements

The Paste command inserts elements at a specified location. When pasting elements,
you can press F3 to lock to a plane.

Once pasted, you can use the steering wheel to move the geometry into the desired
position and orientation.
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When placed, any closed solid volumes are pasted to the models as solids. However,
faces and manufactured features are added as detached geometry. Once pasted, use
the Attach command to attach the geometry as a solid to the model.

Note

You can move or rotate the geometry before or after it has been attached.

Pasting 2D elements

When a 2D element is pasted, the element’s orientation is relative to its native
sketch plane. If the sketch being pasted is coincident with another sketch plane
in the target document, then it is absorbed to the existing sketch. If the sketch is
not coincident with any other sketch plane, then it creates a new sketch plane.
Sketches with new planes are added to the PathFinder as new sketches.

Activity: Copy and move face sets

Copy and move face sets

This activity demonstrates the method of copying and moving design features within
a part due to a design change.

In this activity you will:

• Extend a face (this represents the design change).
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• Copy a face set.

• Drag this set into another position.

• Delete the original set.

Open the part file

In this activity, you will respond to a major design change. Three mounting arms
have to move as the body of this part gets taller.

Open cut_copy.par.

Modify the height of the part

▸ Rotate the view so you can see the bottom and select the bottom face.

▸ Since this face is coplanar to a base plane, it will not move. On the Live Rules
panel, click the Lock to Base Plane button (1).
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▸ Extend the face a distance of 25 mm.

▸ Click the left mouse button to finish.
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Copy and move the face set

▸ Select the features Ear, Slot, and Ear Slot Pattern, either graphically or from
PathFinder. Make sure the steering wheel origin lies on an edge of the bottom
of the select set.

▸ While holding down the Ctrl key, drag the face set along the primary axis of
the steering wheel.
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You can see a copy of the original set is connected to your cursor, and you can
move it dynamically. Instead of entering a specific value in the dialog box, select
the edge of the bottom face.

The copied set locks to the bottom face.

Click the left mouse button to finish.
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Note

Note the addition of the copied set in PathFinder.

▸ Select the original face set: Ear, Slot, and Ear Slot Pattern.

Delete this set by either

• Right—click and choose Delete, or

• Pressing the Delete key.

▸ Activity complete. Save and close the file.

Summary

In this activity you learned how to copy and move a select set. The same operation
could be accomplished by using the detach option. The select set would then have to
be attached after movement.
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Activity: Copy and paste face sets

Copy and paste face sets

This activity demonstrates the method of copying and pasting design features from
one document to another.

Copy an existing set of design features and paste them onto another part.

In this activity you will:

• Create a user-defined set of design features.

• Copy this set from its resident document.

• Paste this set into another part document.

• Attach the pasted geometry.

• Precisely dimension the face set.
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Open the part file

Open copy1.par.

Copy face sets

▸ Select Protrusion 8, Protrusion 9, Round 10, Hole 2. All features associate with
the clip button.

Note

Make sure the steering wheel plane lies on the tan face. This will ensure
the correct orientation when pasting the feature face set.
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▸ Copy this set by one of the following.

• Use the right mouse button Copy shortcut menu option.

• Press Ctrl+C.

Paste the face set into another part document

Paste the copied clip and hole features onto an alternate cell phone belt-carrier.

▸ Open the copy2.par part file.

▸ Paste the previously-selected set by either of the following.

• Press Ctrl+V, or

• Use the right mouse button Paste option

You can see the set in this document. Note that the pasted set connects to your
cursor, and you can move it around.
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Move the set over the front face of the carrier and press the F3 key to lock that
plane.

Position it as shown, and click the left mouse button to paste it.

▸ Attach the set to the carrier part using the right mouse button option Attach.
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The set converts from construction faces to faces on this design body.

Position the pasted set

When pasted, the clip/hole set places randomly on the design body. Align the set on
the vertical center of the face.

▸ In PathFinder, select the set of features. Position the steering wheel origin at
the hole center shown.
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▸ Rotate the primary axis of the steering wheel as shown. This is your move
direction.

Select the primary axis and in the command bar, selectMidpoint in the Keypoints
option. Click when the midpoint symbol on the top edge appears. Press Esc.
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▸ Activity complete. Save and Close both part files.

Summary

In this activity you learned how to copy feature(s) to the clipboard. The copied
features can be pasted into the same file or another file.

Lesson review

Answer the following questions:

1. How do you copy an element during rotate?

2. Can you paste copied faces to a model?

Lesson summary

• When a 2D element is pasted, the element’s orientation is relative to its native
sketch plane. If the sketch being pasted is coincident with another sketch plane
in the target document, then it is absorbed to the existing sketch. If the sketch is
not coincident with any other sketch plane, then it creates a new sketch plane.

• You can select multiple objects to copy. You can have a mixed set of sketches,
faces, manufactured features, and reference planes. If ineligible elements are
found in the select set, an error message is displayed and you can remove the
ineligible elements from the select set.

Mirror

Mirror

Constructs a mirror copy of selected elements about a plane you define.
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You can mirror any of the following:

• Faces of the model body

• Surfaces

• Face Sets

• Procedural Features, such as Hole Occurrences and Patterns

• Entire model body

The mirror plane can be a reference plane or a planar face.
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Activity: Mirror faces

Mirror faces and features

This activity demonstrates the method of mirroring faces and features.

In this activity you will:

• Mirror hole features.

• Mirror other elements such as faces and body features.

Open a part file

In this activity, you will mirror holes as well as faces.
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Open mirror.par.

Mirror holes

▸ Show the Right (yz) reference plane.
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▸ Select the Hole 102 group.

▸ On the Home tab®Pattern group, choose the Mirror command.
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Select the Right base reference plane as the mirror plane.
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Note

Notice from Pathfinder that the new hole occurrences are placed into the
same hole group as the originals.

Press Esc to finish.

Mirror multiple elements

▸ Turn on the Front (xz) reference plane. Turn off all other reference planes.
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▸ Select the following elements using PathFinder.

Protrusion 3

Hole 3

Round 2

Cutout 1

Hole 27

Hole 29

Pattern 2

Hole 102

Choose the Mirror command, using the Front reference plane as the mirror plane.
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Press Esc to finish.
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Note

Note in PathFinder that the mirrored elements organize into a new
User-Defined Set.

▸ Save and close the file.

Summary

In this activity you learned how to mirror feature(s). Select the feature(s) to be
mirrored and then select a mirror plane. If multiple features are selected to mirror,
these mirrored features are collected into a user-defined set.
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Replace Face command
Replaces selected faces on a part. The replacement face can be a construction
surface, a reference plane, or another face on the part. When replacing more than
one face, the faces being replaced cannot touch each other.

When you replace a face using a construction surface, the construction surface is
hidden automatically when you finish the feature.

If edges on the face you are replacing have rounds applied, the rounds are reapplied
after you complete the replace face operation.

Plastics design features

Plastics design features

There are several feature types which you use extensively in the design of plastic
parts, often in the consumer products we use every day.

Solid Edge provides the following commands:

• Rib

• Web network

• Vent

• Lip
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Rib command

Constructs a rib by extruding a profile. The Direction and Side steps allow you
to control the shape of the rib.

Constructing a synchronous rib feature

When you choose the synchronous Rib command, the command bar guides you
through the following steps. The Rib command requires an existing sketch.

Step 1: Select Step—Select the sketch elements that define the rib feature.

Step 2: Rib Thickness Step—On the dynamic edit box, type in the rib thickness
value and press the Tab key.

Step 3: Extent Step—Option to extend the ends of the sketch elements until
they intersect the part.

Step 4: Finite Depth Step

Option on–Sets the rib extent so that the sketch elements are
projected a specified distance to either side of the profile plane. (The
rib does not project all the way to the existing faces on the part.)
Type the distance in the value edit box.

Option off–Extends the faces on the rib that are perpendicular to the
sketch plane to the existing faces on the part.

Step 5: Alignment Step—Define the side of the sketch to create the rib on.

Step 6: Side Step—Use the steering wheel to define direction for the rib.

Step 7: Finish Step—Click the Accept button to create the feature.

Constructing an ordered rib feature

When you select the Rib command, the command bar guides you through the
following steps:

Step 1: Plane or Sketch Step—Define the profile plane for the rib or specify that
you want to use an existing sketch.

Step 2: Draw Profile Step—This step automatically activates when you define
the reference plane for the rib. When editing a rib, you can select this
step to edit the rib profile.
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Step 3: Direction Step—Define the direction you want to project the profile to
form the body of the rib.

Step 4: Side Step—Define the side to which you want to offset the profile to
form the thickness of the rib.

Note

By default, all ribs offset symmetrically. If you do not want the rib
offset symmetrically, click the Side Step button, and define the
side of the profile you want to offset.

Step 5: Finish Step—Process the input and create the feature.

Web Network command

Constructs a series of webs. All webs constructed in the same operation become
part of a single web network feature.

Note

You can construct a web network as the base feature of a part using sketch
geometry.

The web network is constructed perpendicular to the sketch plane. The web material
thickness is always applied symmetrically on both sides of the web sketch. This
differs from the Rib command, which allows you to specify a material side for a rib.
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When constructing complex web networks using the Extend Profile option, the
results can be affected by connect relationships on profile element vertices. For
example, when no connect relationship is applied between the vertical profile line (A)
and the horizontal line, the corresponding web is extended to the edge of the part.

If a connect relationship is applied to the vertex, the web does not extend.

You can also specify that draft is added to the faces on a web network feature that
are perpendicular to the profile plane.

Controlling the web network definition

In the ordered environment, the sketch used to create the web network controls the
feature. Use the Edit Profile command to add dimensions and to add or remove
elements.

In the synchronous environment, the initial sketch defines the web network. The
sketch is consumed during feature creation and is not associated with the web
network feature. After the feature is created, you can add dimensions to control
the web network. You can dimension to the midpoint of a rib. On the command
bar, you must turn on the midpoint keypoint option to locate the rib midpoint to
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dimension to it. To delete a rib section, you select both faces on either side of the rib
to remove and press the Delete key. To add a new section to the web network, you
must create a new rib.

Vent command

Constructs a vent. You construct a vent feature by selecting elements from a single,
existing sketch. The sketch defines the exterior boundary element (A), ribs (B), and
spars (C) for the vent feature. The exterior boundary must be a closed element and
cannot pass through any surfaces on the design model. The ribs and spars can be
open or closed elements.

You can use the Vent Options dialog box to define rib and spar properties, such as
thickness, depth, draft and rounding properties. You can also specify whether the
ribs or spars extend past the opening created by the boundary element, and whether
the ribs or spars are offset from the entrance surface.

Note

You must have both a solid body and a sketch in a Part document before you
can construct a vent feature.

Vent construction details

The top and bottom surfaces on the ribs and spars are constructed by offsetting the
first surface (entrance surface) that the boundary element cuts. For example, the
boundary element (A) for the vent shown cuts through a cylindrical surface (B) with
a radius value of 125 millimeters. The top and bottom faces of the ribs and spars will
then also be cylindrical.
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The cylindrical radius value of the top and bottom faces of the ribs and spars is
determined by the values you enter in the Vent Options dialog box for the rib and
spar properties for Offset and Depth.

Property Rib Spar
Thickness 8 mm 5 mm
Extension 8 mm 3 mm
Offset 2 mm 6 mm
Depth 8 mm 5 mm

For example, the top face of the rib has a radius value of 123 millimeters because
an offset value of 2 millimeters was specified for the top face of the rib. The radius
value of the bottom face of the rib is determined by the values for the Offset and
Depth property. In this example, the bottom face of the rib has a radius value of 115
millimeters (125 - (8+2)). Similar results are shown for the top and bottom faces on
the spar (119 mm and 114 mm). Also notice the rib extension value of 8 mm.

Draft angle for a vent feature is defined relative to the sketch and extent direction
for the feature. For the following vent feature, the sketch (A) is positioned above the
part, and the extent (B) is defined downward toward the part. The red faces on the
ribs and spars are then considered outside faces, and the draft direction was defined
as outward, which adds material.

6-194 Solid Edge fundamentals mt01413-s-1050



Constructing functional features

Lip command

Creates a lip or groove on a part. You can specify whether material is added to form
a lip, or removed to form a groove. The cross section shape cannot be changed. Only
the dimensions that control the size of the rectangular cross section can be modified.

Selecting edges

The first step in adding a lip or groove feature is to specify which edges to add it to.
You can select the edges individually, or you can select a chain of edges. The edges
must be connected.

Defining the shape and direction

After selecting the edges, type the feature height and width in the command bar
boxes. A dynamic representation of the feature is displayed. Move your cursor until
the lip or groove is in the position you want, then click.

mt01413-s-1050 Solid Edge fundamentals 6-195



Lesson 6 Constructing functional features

Activity: Functional features in consumer products

Functional features in consumer products

This activity demonstrates the placement of several functional features commonly
used in plastic part design.

Use the following commands to finish the design of an automotive speaker grille.

• Vent

• Web network

• Lip

Open the part file

In this activity, you will add several features to further the design of a speaker cover.

Open plastics.par.
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Apply a thin wall

▸ Rotate the view 180° about the Z-axis to see the backside of this model.

▸ On the Home tab®Solids group, choose the Thin Wall command .
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The part selects automatically. Type 5.00 mm for the thickness. Ensure the
arrow points inward towards the model’s center and select the back planar face
as the open face.
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The preview shows the material is removed. Click the right mouse button
to finish.

Return to an isometric view by pressing Ctrl + I.

Add a vent feature

▸ In PathFinder, click the plus sign on the Sketches collector. Click the Vent Sketch
box to turn on the sketch display.
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▸ On the Home tab®Solids group, choose the Vent command .

Note

The vent command is located on the Thin Wall drop list.

In the Vent Options dialog box, set the thickness and depth for the ribs and spars
as shown in the table below and select OK.

Ribs Spars
Thickness 5.00 mm 5.00 mm
Depth 5.00 mm 5.00 mm

▸ Select the chain shown to define the vent’s boundary and then click accept in
the command bar.

▸ Select the 13 vertical lines for the rib definition.

Accept these in the command bar.
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Note

To deselect an element from the rib definition step, hold the Ctrl key down
and select the element.

▸ Select the 5 horizontal lines for the spar definition.

Accept these in the command bar.

▸ Select the side shown for the Extent.
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The vent feature takes a short time to process. When finished, you see the
preview. Click Finish in the command bar.

▸ In the PathFinder, open the Sketches collector and turn off Vent Sketch.

Add a web network

▸ Rotate the view to see the backside. In the Sketches collector, turn on the sketch
named Rib Network Sketch.

▸ On the Home tab®Solids group, choose the Web Network command .

Note

The Web Network command is located in the Thin Wall drop list.
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Select the 3 lines in the sketch. Click Accept in the command bar.

▸ For the direction step on command bar, type 5.00 mm for the thickness.

▸ Select Finish in the command bar.

Mirror the web network

▸ Turn on the display of the Right (yz) reference plane. This plane will be the
mirror plane.

mt01413-s-1050 Solid Edge fundamentals 6-203



Lesson 6 Constructing functional features

▸ Select the web network feature.

▸ On the Home tab®Pattern group, choose the Mirror command.

▸ Select the Right (yz) base reference plane as the mirror plane. The preview
shows the results.
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Left-click to finish. Turn off the reference planes.

Add a lip feature

▸ On the Home tab®Solids group, choose the Lip command .

Note

The Lip command is located in the Thin Wall drop list.

▸ Select the inside edge of the thin wall and Accept in command bar.

▸ On the Lip command bar, type 3 for the width and 5 for the height.
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A rectangle appears where the lip begins. Zoom in for closer view.

There are 4 possible positions for the rectangle. Position the rectangle as shown
above to remove material from the thin wall.

Note

The long side of the rectangle should be pointing down along the part wall.

Click to create the lip.

▸ Select Finish. The lip is placed.
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▸ Save and close this file.

Summary

In this activity you learned how to create vent and web network features. Since there
are several steps in creating these features, be sure to use the command bar to go
back to a previous step if the desired results are not achieved.

Lesson review

Answer the following questions:

1. How do you define the side to which you want to offset the profile to form the
thickness of a rib?

2. Can you do the same action as in #1 above to a web network?

3. What two things must you have in a Part document before constructing a vent
feature?

4. What is the difference between a lip and a groove?

Lesson summary

• Ribs, web networks, vents and lips/grooves are all features used extensively
in the design of plastic parts. Many consumer products (cell phones, watches,
cooking utensils and computing tablets being common examples) are constructed
out of plastic parts.
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Lesson

7 Modeling synchronous and
ordered features

Modeling synchronous and ordered features

Modeling synchronous and ordered features

In a Solid Edge modeling document, two environments coexist for creating
model features. The two environments are synchronous and ordered. You create
synchronous features in the synchronous modeling environment. You create
ordered features in the ordered modeling environment. A model can contain only
synchronous features, only ordered features, or a combination of both feature types.

A synchronous feature is a collection of faces that define the feature shape. There
is no history retained of how a synchronous feature was created. You can edit the
faces of a synchronous feature.

An ordered feature is history based. You can edit an ordered feature by returning to
any step used in the feature creation process. You do not edit faces of an ordered
feature.

Opening a Solid Edge modeling document

• The Solid Edge Options®Helpers page provides a setting for the modeling
environment to use when a new document opens. The default setting is
Synchronous modeling.

• If an existing modeling document contains only synchronous elements, the
document opens in the synchronous environment.

• If an existing modeling document contains only ordered elements or a
combination of ordered and synchronous elements, the document opens in the
ordered environment.

Moving between modeling environments

You can switch between environments at any time during the modeling process.

• Right-click in PathFinder or the graphics window to activate the shortcut menu,
and then choose either Transition to Synchronous or Transition to Ordered,
depending on the environment that is active.

• If a model contains both synchronous and ordered features, click the Ordered
environment bar or the Synchronous environment bar in PathFinder.
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• On the ribbon, from the Tools tab®Model group, choose the modeling
environment to transition to.

Note

Each environment presents its own set of modeling commands.

Feature display

In the ordered modeling environment, ordered and synchronous features appear.

In the synchronous modeling environment, only synchronous features appear.

Editing features

In ordered modeling, selecting an ordered feature displays the Edit Feature
command bar for ordered editing.

In ordered or synchronous modeling, selecting a synchronous body face displays the
steering wheel for synchronous editing.

Moving ordered features to synchronous

You can convert ordered features to synchronous features while in a part or
sheet metal modeling file. The conversion performs by moving ordered features
into the synchronous portion of the PathFinder tree. This move results in the
feature geometry consuming into the synchronous body and therefore available
for synchronous editing.

The move to synchronous workflow occurs only when the file is in the ordered
environment. Single features or any number of features can convert with the Move
to Synchronous command.

The ordered conversion is one way only. Synchronous features cannot convert to
ordered features.

Note

You can also convert ordered features to synchronous features at a file level
with the Convert command. Multiple files can process simultaneously.

Feature conversion must start at the top of the ordered feature tree and be in a
contiguous order. All features in the tree above the selected feature include in the
conversion. Mirror and pattern features require both child and parent features
for conversion to be successful. If any of the parents in the select set have a child
relationship to either a mirror or pattern feature, all features above these children
features are in the select set.

If a problem occurs in the conversion process, the Undo command is available.

A Move to Synchronous dialog displays to alert the users if additional dependencies
are found, and to provide any warning message that may affect the outcome of the
move. This dialog only displays when warnings exist and/or there are additional
dependencies found.

Warning message: Feature dependency found. It is recommended that all
dependencies be moved with the selected feature.
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You can click the “Selection only” button in the dialog to exclude the dependencies
from the Move operation.

Note

It is recommended to recompute the ordered node, and resolve any possible
warnings or failures before moving the ordered features to synchronous.

Moving local dimensions and sketches

When ordered local dimensions move to synchronous, Solid Edge attempts to locate
and bind dimensions to a vertex. If no vertex is found, then the dimensions become
dangling dimensions. Once moved, all ordered dimensions, except for dangling
dimensions, display along with the synchronous dimensions in the Dimensions
node of the Synchronous portion of PathFinder. All ordered dimensions that are
driving or driven dimensions move as driven dimensions. When you do a Move to
Sync for a feature at a time,Solid Edge creates a user defined set each time there
are dangling dimensions.

Note

Synchronous does not support dimensions between a part edge and a reference
plane. Therefore, dimensions placed between an ordered part edge and a
reference plane move to synchronous as dangling dimensions.

Local profile sketches in ordered convert as used sketches when they move to
synchronous. The profile sketch name in synchronous is the same as the ordered
feature name.

Activity: Creating ordered features

Creating ordered features

This activity guides you through the process of creating ordered features. Learn how
to switch between modeling environments.

Create a new part document

When creating a new part document, you can control the environment to begin
modeling in. The Solid Edge Options dialog provides a setting to start in the
Synchronous or Ordered environment. The default setting is the Synchronous
environment.

Note

Existing files that contain only synchronous elements, open in the
synchronous environment. Existing files that contain only ordered elements
or a combination of ordered and synchronous elements, open in the ordered
environment.

▸ Start Solid Edge ST5.

▸ On the Start-up page, click the Application button.
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▸ Click Solid Edge Options.

▸ On the Solid Edge Options dialog, click the Helpers page.

▸ On the Helpers page, under Start Part and Sheet Metal documents using this
environment:, click the Ordered button. Click OK.

▸ On the Start-up page, under Create, click ISO Part.

Create an ordered base feature

▸ Create an extrusion with the cross-section shown. Extend symmetrically at
a distance of 100 mm.

Create an ordered cut feature

▸ Create a cut with the cross-section shown. Extend through all.
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Transition to the Synchronous environment

There are three ways to transition to the other environment.

1. Right-click in PathFinder or modeling window and choose Transition to
Synchronous (or Transition to Ordered).

2. On the Tools tab® Model group, click the environment to transition to.

3. If both environments exist, in PathFinder, click the environment bar to
transition to.

Note

An environment bar is only available for selection if features exist in that
environment.

▸ Transition to the Synchronous environment using a method of your choice.

Note

Notice that the ordered features do not appear. Only synchronous features
appear in the Synchronous environment. In the Ordered environment, both
synchronous and ordered features appear.
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Transition to the Ordered environment

▸ Click the Ordered environment bar to transition back to the Ordered
environment.

▸ Save the file as ordered.par.

▸ Close the file.

Summary

In this activity you learned how to create ordered features. You also learned how to
switch between modeling environments.

Activity: Creating both ordered and synchronous features in a model

Creating both ordered and synchronous features in a model

This activity guides you through the process of creating both ordered and
synchronous features in the a model. Learn how to edit both feature types and how
to convert an ordered feature to a synchronous feature.

Create a new part document

▸ Create a new part document.

▸ Switch to the Synchronous environment. See the previous activity (Creating
ordered features) if you need help switching modeling environments.

Create a synchronous base feature

▸ Create an extrusion with the cross-section shown. Extend symmetrically at
a distance of 100 mm.
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Create an ordered feature

▸ Transition to the ordered environment.
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▸ Create an extrusion with the cross-section shown. Extend upward at a distance
of 100 mm. Draw the cross-section on the green face.
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Edit a synchronous feature face while in the ordered environment

Move the green face on the synchronous feature. The ordered feature is colored
orange for clarity only.

▸ Select the green face. Notice the face has a locked dimension on it. This
dimension migrates from the sketch to the feature. Either delete the dimension
or unlock the dimension.

▸ Select the move handle and drag the face in an area around the ordered feature.
Notice how the ordered feature is recognized during an edit. Press the Esc key to
end the move operation.
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▸ Select the green face. Notice the face has a locked dimension on it. This
dimension migrates from the sketch to the feature. Either delete or unlock the
(225 mm) dimension.

▸ Select the move handle and drag the face to the right. Notice how the ordered
feature moves with face. This occurs because the ordered feature sketch was
dimensionally locked to the synchronous feature edge. Press the Esc key to
end the move operation.

Transition to synchronous

▸ Switch to the synchronous environment. Notice the ordered feature does not
display.

Edit the ordered feature

▸ Switch to the ordered environment.
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▸ Select the ordered feature.

▸ Click the Dynamic Edit button. Change the 35 mm dimension to 70 mm.
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Convert the ordered feature to a synchronous feature

An ordered feature converts to a synchronous feature by moving the ordered feature
to the synchronous portion of the PathFinder. Once converted, all dimensions are
dropped. The converted feature can be manipulated as an entire synchronous
feature or have individual face(s) manipulated.

▸ You must be in the ordered environment to convert ordered features. In
PathFinder, right-click on the ordered protrusion feature.

▸ On the shortcut menu, choose the Move to Synchronous command.

Move the converted feature

▸ In PathFinder, select the converted protrusion.
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▸ Click the move handle and move feature to the approximate location shown
and click.
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This completes the activity.

Summary

In this activity you learned how to create both ordered and synchronous features in
a single model. You also learned how to edit both feature types and how to convert
an ordered feature to a synchronous feature.

Lesson review

Answer the following questions:

1. What is an ordered feature?

2. What is a synchronous feature?

3. What are the differences in ordered and synchronous environments?

4. How do you convert ordered features to synchronous features?

5. How do you convert synchronous features to ordered features?

Lesson summary

Solid Edge provides environments for modeling either synchronous or ordered
features. You work in a single model file with only synchronous features, only
ordered features, or a combination of both features types. You can convert ordered
features to synchronous features.

Modeling ordered features activities

Modeling ordered features activities

This section is a collection of activities that focuses on modeling ordered features.

Sketching_activities

Activity: Using IntelliSketch

Using IntelliSketch

Create a sketch in this activity. Apply relationships, dimensions and variables to the
geometry so that you can reliably and predictably change the shape of the profile
by editing dimensions.

Objectives

Create an ordered sketch in this activity. You can also perform this activity in the
synchronous environment with a slightly different interface. Apply relationships,
dimensions and variables to the geometry so that you can reliably and predictably
change the shape of the profile by editing dimensions.

• The sketch is in the shape of a cross-section of an I-beam.
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• Relationships, dimensions and variables control the width of the web and flanges
of the “I” shape.

▸ Create a new part document.

▸ Make sure you are in the Ordered environment.

Draw the sketch

Draw an “I” shaped sketch.

▸ On the Home tab®Sketch group, choose the Sketch command.

▸ Select the reference plane shown.

▸ In PathFinder, turn off the display of the base coordinate system (1) and turn on
the display of the base reference planes (2).
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▸ Fit the window and zoom out until the base reference planes appear as shown.

▸ On the Home tab®IntelliSketch group, choose IntelliSketch options.

▸ On the Relationships page (1), set the options shown. Click OK.

▸ In the IntelliSketch group, click the Horizontal or Vertical option to make it
recognizable if a line is horizontal or vertical during placement.
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▸ On the Home tab®Draw group, choose the Line command .

▸ Draw the first line by positioning the cursor below and left of the reference
planes as shown and click to place the first point of the line.

▸ Place the second point by moving the cursor to the right. When the horizontal
indicator is shown and the line is approximately in the same position as shown
below, click to place the line.
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▸ Continue drawing the “I” shape with the following considerations. Draw each
segment with the horizontal or vertical indicator displayed. Exact lengths of the
lines are unimportant at this stage.

Note

If you make a mistake, you can delete a line by first clicking the Select tool

, selecting the line, and pressing the Delete key on the keyboard.

Also by choosing the Undo command , you can step back through
the creation of the sketch.

▸ Draw the rough shape of the “I” in a counterclockwise order. Use the alignment
indicator to position the endpoint of the next to the last line above the left
endpoint of the first line as shown. To activate the alignment indicator for the
last segment, brush (move the cursor over without clicking) the horizontal line.
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▸ To place the last segment, click on the endpoint of the first line when the
endpoint indicator is displayed as shown.

Add relationships

Add relationships to control the behavior of the shape. When you anticipate the
need to make a shape symmetrical, it is useful to establish relationships between
the geometry of the shape and reference planes. Reference the line segments by
numbers as shown.

▸ In the Relate group, choose the Horizontal/Vertical command .
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▸ Position the cursor over middle of segment 1. When the midpoint indicator
displays, click.

▸ Move the cursor to the top of the vertical reference plane, and when the endpoint
indicator displays, click.
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▸ A relationship applies represented by a dashed line that forces the midpoint of
segment 1 to remain vertically aligned with the endpoint of the reference plane.

▸ In the Relate group, choose the Equal command .

▸ Select segment 1, then select segment 7. This applies an equal relationship to
the lines, which keeps their lengths the same while other constraints alter the
shape of the profile. Line segment 1 is equal to line segment 7.

mt01413-s-1050 Solid Edge fundamentals 7-21



Lesson 7 Modeling synchronous and ordered features

▸ Continue applying the equal relationship between the following lines:

2 and 12

8 and 6

8 and 12

11 and 3

9 and 5

9 and 11

10 and 4

Add dimensions

Add dimensions to control the size of the shape.

▸ In the Dimension group, choose the SmartDimension command .
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▸ Select segment 1, position the dimension below the line, and then click to place it.

▸ Dimension segment 12 in the same way.

▸ Choose the Distance Between command .

▸ Select segment 10, select 4, position the dimension above the ”I” shape, and then
click to place it. Right-click to restart the Distance Between command.

▸ Dimension the distance between segments 1 and 7 in the same way.

Edit dimension values

Edit the dimensions placed in the previous step. Because of the dimensions and
relationships defined, the shape responds to dimensional changes predictably.

▸ Choose the Select Tool command.
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▸ Select dimension (A). Type 15 and then press the Enter key.

▸ Select dimension (B) and change the value to 120.

▸ Select dimension (C) and change the value to 12.

▸ Select dimension (D) and change the value to 95.

▸ Practice altering the shape by editing the values of the dimensions (A-D) and
observe how the shape responds. Return the dimension values to those shown
above.

Using dimension variables

Dimensions and relationships make it easier to control the shape of a profile.
Variables are used to make the shape of a profile parametric. Formulas are applied
that define mathematical relationships between variables and dimensions. In this
step, make the width of the web (dimension (C)) 2/3 the thickness of the flange
(dimension (A)), and make the flange height (dimension (B)) 3/4 the flange width
(dimension (D)).

Each time a dimension is placed, a randomly named variable is created to represent
it. Rename the variables and assign mathematical expressions to further control the
behavior of the shape.

▸ Right-click on the 95 mm dimension. Choose the Edit Formula command on the
shortcut menu. The Edit Formula command bar displays to edit the dimension
name and formula. In the Name: field, change the variable name to D and then
press the Enter key. Click the Select tool to end the dimension edit.

▸ Repeat the previous step to make the following dimension edits:

15 mm dimension Name=A
120 mm dimension Name=B
12 mm dimension Name=C

Note

To enter a formula, click the formula field, type the formula, and press the
Enter key. Basic mathematical operators in formulas can be used:

+ to add

- to subtract

* to multiply

/ to divide

Mathematical functions can be grouped with parenthesis if necessary.
Many functions are available. For more information, see the Variables
Help topic.
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▸ Assign a mathematical expression to dimensions named B and D. Right-click
the 120 mm dimension and choose Edit Formula. In the Formula field, enter
3/4*D and press the Enter key.

▸ Edit the formula for the 12 mm dimension. In the Formula field, enter 2/3*A
and press the Enter key.

▸ Right-click on a dimension and choose Show All Names. Right-click on a
dimension and choose Show All Formulas. Return the display to Show All Values.
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Using the Variable Table

The same operations performed in the previous could also be done using the Variable
Table.

▸ On the Tools menu®Variables group, choose the Variables command to display
the Variable Table.

▸ Notice the same fields as in the Edit Formula command bar are available. Click
the field to edit, type in the appropriate value and then press the Enter key.

Note

The shadowed values represent values that cannot be directly changed
because they are controlled by relationships, dimensions or formulas.

▸ Close the variable table by clicking the X in the upper right corner.

▸ On the sketch, modify the dimension values of (A) and (D) and observe how the
sketch responds.

Save the sketch

▸ Choose Close Sketch to complete the Sketch.

You can also complete the sketch by clicking the checkmark located in the
upper left corner of the sketch window.

▸ On the command bar, click Finish.

▸ Close and save this file as Ishape.par. This completes this activity.
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Summary

In this activity, you learned how to use dimensions and relationships to control
the size and position of 2D geometry in a profile. You also learned how to use
mathematical formulas within the variable table to establish relative behavior
between geometry. This is useful in establishing design intent within a model. If a
critical dimension changes, the profile adjusts itself predictably and accordingly.

Activity: Applying sketch relationships (collinear, parallel, equal)

Applying sketch relationships (collinear, parallel, equal)

In this activity, learn to use more relationships in the profile/sketch environment.

This activity covers the collinear, parallel, and equal relationships.

Open part file

In this activity, learn to use more relationships in the profile/sketch environment.

This activity covers the collinear, parallel and equal sketch relationships.

▸ Open sketch_a1.par.

Apply relationships

Apply relationships to control the E shape.

Note

No horizontal/vertical relationships are used. This allows the sketch to rotate
at any angle and maintain the E shape.

▸ In Pathfinder, right-click on the sketch named Sketch A. On the short cut menu,
choose the Edit Profile command.

▸ Define the shape by applying parallel relationships. The first element you select
is made parallel to the second element selected. In the Relate group, choose

the Parallel command .
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▸ Select the line segments as described below.

• Click (3), then click (1).

• Click (5), then click (1).

• Click (7), then click (1).

• Click (9), then click (1).

• Click (11), then click (1).

Continue adding parallel relationships

Continue to add parallel relationships to the remaining line segments.

▸ Apply the parallel relationships shown:

• Click (10), then click (12).

• Click (8), then click (12).

• Click (6), then click (12).

• Click (4), then click (12).

• Click (2), then click (12).
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Apply collinear relationships

Apply collinear relationships to align line segments. The first line segment you select
is made collinear to the second line segment selected.

▸ Choose the Collinear command .

▸ Select the line segments as shown.

• Click (7), then click (11).

• Click (3), then click (11).

• Click (5), then click (9).

Apply equal relationships

Apply equal relationships to control the thickness of the E shape.

▸ Choose the Equal command .
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▸ The first line segment you select is made equal to the second line segment
selected.

• Click line segment (5), then click line segment (3).

• Click line segment (7), then click line segment (3).

• Click line segment (9), then click line segment (3).

• Click line segment (11), then click line segment (3).

Add dimensional constraints

Add dimensional constraints to complete the E shape.

▸ Choose the SmartDimension command .

▸ Dimension the line as shown. The value is not important at this point.

▸ Choose the Distance Between command .
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▸ On the command bar, click the By 2 Points option.

▸ Dimension the two line segments as shown. Click on the lines (do not click the
endpoints or midpoints).

▸ Choose the SmartDimension command and dimension the line segment shown.

Align the sketch

Align the midpoint of the left line segment to the center of the reference planes.

▸ Choose the Horizontal/Vertical command .
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▸ Click on the midpoint of the left line segment as shown.

▸ Click on the midpoint of the reference plane edge as shown.
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▸ The midpoint of the left line segment aligns with center of the reference planes.

Edit the dimensions

Edit the dimensions to complete the E shape.
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▸ Edit the dimensions as shown.

• Dimension (A) = 200

• Dimension (B) = 50

• Dimension (C) = Dimension (B)

Note

How to make two dimensions equal

Step 1: Right-click on dimension (C).

Step 2: On the shortcut menu, choose the Edit Formula command.

Step 3: On the Edit Formula command bar, in the Formula field,
type = and then click on dimension (B).

Step 4: Click the Accept button.

Step 5: Click the Select tool to end Edit Formula.

▸ The result should be as shown.

Add angular dimensions

Add angular dimensions which controls the shape and orientation relative to the
horizontal reference plane.

▸ Choose the Angle Between command .
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▸ Place the dimension shown by clicking on the two lines (do not select any
keypoints).

▸ Place an angular dimension between the horizontal reference plane and the
bottom line segment to control the E shape orientation. First right-click to
restart the Angle Between command. Click the horizontal reference plane and
the bottom line segment as shown (again do not click any keypoints).

Edit the angular dimensions

Edit the angular dimensions to observe the control over the shape and orientation.
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▸ Orientation angle = 45, shape angle = 90

▸ Orientation angle = 0, shape angle = 60

▸ Click Close Sketch. On the command bar, click Finish.

▸ This completes the activity.

Summary

In this activity, you learned how to use dimensions and relationships to position a
profile containing interior features. Relationships were used to position various
features relative to each other. By varying the dimensions, you are able to control
the size and position of the interior features and maintain design intent.
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Activity: Applying sketch relationships (symmetric)

Applying sketch relationships (symmetric)

In this activity, learn to use symmetric relationships in the profile/sketch
environment.

Open a part file

In this activity, use the symmetric relationships in the profile/sketch environment.

▸ Open sketch_b1.par.

Add construction elements

▸ Select the sketch in the window and then click the Edit Profile command (1).

▸ Place the lines as shown. Lines connect to the centers of the circles and center of
the reference planes.
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▸ Change the two lines to construction elements. In the Draw group, choose the

Construction command . Select the two lines just placed.

▸ Dimension the circles and lines as shown.

Place circle sketch elements

Place six circles in the remaining three quadrants of the main circle.
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▸ Place the circles as shown. Position and size do not matter. Be sure not to pick
up any relationships from other geometry while placing the circles. If you have
problems doing this, place a circle outside the main circle and then drag it
inside the main circle.

Apply symmetric relationships between the circles

▸ In the Relate group, choose the Symmetric Relationship command .

▸ Click the horizontal reference plane (A). Click circle (1) and then click circle (2).
Circle (1) is now symmetrical to circle (2). Click circle (3) and then click circle (4).
Circle (3) is now symmetrical to circle (4).

▸ Apply symmetric relationships to the remaining circles using the vertical
reference plane as the symmetry axis. In order to do this you must select a new

symmetry axis. Choose the Set Symmetry Axis command .
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▸ Click the vertical reference plane.

▸ Click the Symmetric Relationship command and then click the remaining circles
to apply symmetry as shown.

Edit dimensions

Edit the dimensions and observe the results.

▸ Edit the 40 dimension on the angled construction line to 50.

▸ Edit both 25° dimensions to 30°.

▸ Edit the 15 diameter to 10.

▸ Choose the Close Sketch command. On the command bar, click Finish.
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▸ Close the file and do not save. This completes the activity.

Summary

In this activity, you learned how to use dimensions and relationships to position a
profile containing interior features. Relationships were used to position various
features relative to each other. By varying the dimensions, you are able to control
the size and position of the interior features and maintain design intent.

Activity: Using construction elements in profiles

Using construction elements in a profile

In this activity learn to use construction elements when drawing a profile or sketch
in order to capture design intent.

Overview

Overview

In this activity, learn to use construction elements when drawing a profile or sketch
in order to capture design intent.

Objectives

After completing this activity, you are able to:

• Use construction elements to simplify profile or sketch construction.

• Use the construction elements to drive the resulting geometry (a cutout feature).

In this activity, examine a specific feature within a part. You do not construct the
part in this activity, but you draw the profile for the feature. To simplify profile
creation, use a construction element in the Sketch drawing environment. As
previously mentioned, construction elements aid in profile creation but are ignored
during profile validation checks.

Note

Construction elements serve as skeletal elements that helps drive the other
elements in the profile.
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Examining the Problem

Examine the patterned cutout feature (A).

Each of the four cutouts must sweep 90°. A narrow web of material must
occupy space between each cutout to avoid breakout. To create this model, use
construction elements to locate the cutout, provide the mechanism for the sweep
angle, and provide the distance between each cutout.

Create part document

▸ Create a new ISO part document.

▸ Make sure you are in the ordered environment.

Define the sketch plane

▸ Choose the Sketch command .

▸ In PathFinder, turn off the display of the base coordinate system (1) and turn on
the display of the base reference planes (2).
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▸ Select the reference plane shown.

▸ On the status bar, click the Pan command . Hold the left mouse button at
the center or intersection of the reference planes. Move the cursor from position
1 to the lower right corner of the Sketch window (position 2). This moves the
reference planes out of the way and prevents unwanted relationship placement
between a profile element and a reference plane.

Construct a sketch

▸ Choose the Line command. Draw the three lines as shown in the illustration.

▸ Add the dimensions and edit their values as shown.

▸ Make each of the lines construction geometry.
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In the Draw group, choose the Construction command and select each
of the three lines.

▸ The angled lines attach to the horizontal line at its midpoint.

▸ Using the Equal relationship, make each of the angled lines equal to the
horizontal line.

Add lines

Add lines using the Offset command .

▸ In the Draw group, choose the Offset command.

▸ Type a value of 10 for the offset distance.

▸ Set the Chain option in the Offset Select box.
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▸ Offset the two angled lines as seen in the illustration below.

▸ Click the Accept button to confirm selection. Move the cursor to the interior
of the “V” shape as shown and click.

Place two arcs

▸ Choose the Arc by Center command . Place two arcs as shown in the
following illustration.

• Both arc center point origins are the midpoint of the horizontal construction
line.

• Small arc Point-2 is on the left angled line, Point-3 on the right-angled line.

• Large arc Point-2 connects to the end point of the left angled line, and Point-3
connects to the end point of the right-angled line.

• Use SmartDimension to dimension the two arcs and edit the values of the
dimensions to those shown in the illustration.
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Trim the sketch elements

▸ Choose the Trim command .

▸ Trim away the offset lines below the small arc. The result of the trim is shown.

Relationship assistant

▸ On the Home tab®Relate group, choose Relationship Assistant. Use the Show
Variability command to verify that the profile has only two degrees of freedom.
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▸ Resolve the two remaining degrees of freedom.

In the Relate group, choose the Connect command and place a Connect
relationship between the midpoint of the horizontal construction line, as seen in
the illustration to the left, and the midpoint of a reference plane, as seen in the
illustration to the right. This anchors the profile and eliminates any remaining
degrees of freedom.

▸ Edit the dimension values as shown in the illustration and then change them
back to the original values. This sketch is ready to be used in a feature function
such as cutout.

▸ This completes the activity. Close the file and save as cutout.par.

Summary

In this activity, you learned how to use construction elements, dimensions and
relationships to position a profile. Design intent is maintained by positioning the
construction elements. Construction elements do not become a part of the feature
but are handy in controlling the position of the geometry.

Creating ordered base feature activities

Activity: Constructing ordered features from sketches

Constructing ordered features from sketches

This activity demonstrates how to construct ordered features using sketches.
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Open a new part file

▸ Open a new ISO part file.

▸ Switch to Ordered environment.

Sketch the initial basic shape

▸ Choose the Sketch command and select the Base Reference plane Front (xz) as
the sketch plane.

▸ Sketch and add dimensions to create this basic shape. The sketch is vertically
symmetric.

▸ Close the sketch. On the command bar, click Finish.

Create the base feature

▸ Choose the Extrude command.

▸ On the command bar, click the Select from Sketch option.

▸ Select the sketch and right-click to accept the sketch.
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▸ On command bar, type 65 in the distance field.

▸ Position cursor away from sketch as shown and then click.

▸ In pathfinder, turn off the display of the sketch.

▸ Click Finish.
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Remove material from the base feature

▸ On the side face of the part, sketch two lines and add dimensions as shown.

▸ Close the sketch and click Finish.

▸ Choose the Cut command. On the Cut command bar, click the Select from
Sketch and the Chain options.
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▸ Select the two lines. On command bar, click Accept.

▸ Select the side of the lines towards the front of the part.

▸ On command bar, click the Through All option .

▸ Click when the direction arrow points to the other side of the part.
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▸ Click Finish and turn off the sketch.

Remove more material

▸ On the side face, draw the following sketch.
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▸ Close the sketch and click Finish.

▸ Choose the Cut command. On the Cut command bar, click the Select option:
Chain. Select the two lines and click when the direction arrow is as shown.

▸ Click the Through All extent option. Click when the direction arrow is as shown.
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▸ Click Finish and turn off the sketch.

Note

Note that you could perform the previous two material removals in one step,
combining the curves into a single sketch and performing one cut. Either
method works fine.

Remove more material

▸ On the side face, draw and dimension an arc and two lines as shown. Convert
the vertical line into a construction line.
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▸ Close the sketch and click Finish.

▸ Choose the Cut command. Select the horizontal line and arc. On command
bar, click Accept. Click when the direction arrow is as shown. Material is to
be removed on this side of the sketch.

▸ On command bar, click the Through All option.

▸ Click when the direction arrow is as shown.
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▸ Click Finish and turn off the sketch.

More modifications

▸ On the face shown, draw a 35 mm diameter circle centered on the midpoint of
edge (B) The circle center lies on edge (A). Do not place a connect relationship
for the circle center on line (A). Use a horizontal/vertical relationship with an
endpoint of edge (A).
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▸ Close the sketch and click Finish.

▸ Choose the Extrude command. Click the Select from Sketch option.

▸ Select the sketch and right-click to accept.

▸ On command bar, click the Through Next option. Position direction arrow as
shown and click.
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▸ Click Finish and turn off sketch.

▸ Draw a circle of diameter 19 mm concentric with the previous circular feature
and create a cut at a depth of 30 mm.

▸ Select the region formed by the circle and remove material at a depth of 30 mm.
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▸ Turn off all sketches.

▸ Save and close this file.

Summary

In this activity you created a new part by using techniques learned on adding and
removing material from a base feature.

Activity: Creating profile-based features

Creating profile-based ordered features activity

This activity demonstrates the construction of profile-based ordered features.

Construct a revolved protrusion and then add cutouts and secondary protrusions.

Use the following commands to create profile-based features: (revolve, extrude, cut,
revolved cut, select from sketch, parallel plane, profile, mirror, fillet, include, trim).
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Open the part file

Overview

This activity demonstrates the construction of profile-based features.

Objectives

Construct a revolved protrusion and then add cutouts and secondary protrusions.

▸ Open bell.par.
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Create a revolved protrusion

Create a revolved protrusion using the sketch provided with the file.

▸ On the Home tab®Solids group, choose the Revolve command .

▸ In the Sketch step, click the Select from Sketch option.

▸ In the part window, select the sketch and then, click the Accept button.

▸ For the axis of revolution, select the vertical dashed line.

▸ On the command bar, click Revolve 360° .

▸ Click Finish.

▸ The sketch and axis of revolution are no longer needed. Turn off their display.
Right-click in the part window. Choose Hide All®Sketches and choose Hide
All®Reference Axes.

Create an extrusion

Create an extrusion. Draw the profile on a parallel plane.

▸ In the Solids group, choose the Extrude command .

▸ In the Sketch step, click the Parallel Plane option.
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▸ Select the reference plane shown.

Note

Throughout this activity, hidden lines and reference planes are removed
from illustrations for clarity.

▸ Type 82.5 in the Distance box and press the Enter key.

▸ Move the cursor to the bottom right of the window, and click to define the location
of the new parallel reference plane.

▸ Choose the Fit command .
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▸ In the Draw group, use the Line command to draw the profile shown. Draw the
profile with the same dimensional values and relationships shown below. Notice
the vertical relationship between the midpoint of the vertical reference plane
and the center of the profile arc.

Note

Within the line command, press A on the keyboard or click the arc option
on the ribbon bar to enter arc mode. Once you place the arc, the command
reverts back to line mode. When in arc mode, notice the intent zones
available for arc placement.

Turn on the Tangent option in IntelliSketch. This applies a tangent relationship
when placing the arc.

▸ Choose Close Sketch.
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▸ Move the cursor so that the arrow points as shown and click. This will add
material to the inside of the profile.

Note

Notice the side step on command bar. When you use an open profile, you
must specify the side of the profile to add material to.

▸ On command bar, click Through Next.

▸ Move the cursor so that the arrow points as shown and click.
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▸ Click Finish to complete the protrusion.

Remove material from the base feature

Remove material from the part using an open profile.

▸ Choose the Cut command .

▸ On command bar, click Coincident Plane from the plane type list. Select the
reference plane shown.
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▸ Draw the open profile.

▸ Click Close Sketch.

▸ Position the direction arrow as shown to remove material outside the open profile.

▸ On command bar, click the Through All extent option. Position the arrow as
shown to remove material in both directions.
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▸ Click Finish.

Mirror the cutout feature

▸ In the Pattern group, choose the Mirror Copy Feature command on the Mirror
drop down list.
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▸ Select the cutout feature.

▸ On command bar, click the Smart option and then click the Accept button.

▸ Select the Front (xz) reference plane as the mirror plane.
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▸ Click Finish.

Remove material from part

Remove material from the middle of the part using a closed profile.

▸ Choose the Cut command .

▸ Select the reference plane shown.
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▸ Draw the profile. Connect the midpoint of the top line segment to the vertical
reference plane (A).

▸ Click Close Sketch.

▸ Click the Through All extent option. Position the arrow as shown to remove
material in both directions.
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▸ Click Finish.

▸ Save the file.

Add rounds

Round edges of the cutout features.

Note

The Constructing treatment features self-paced course (spse01530) covers
rounding. It is appropriate at this point to add rounds to the part.

▸ In the Solids group, choose the Round command .

▸ Select the six edges as shown.
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▸ Type 10 for the radius and then click the Accept button.

▸ Click Preview then click Finish.
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▸ Place 19 mm rounds on the two edges shown.

Add a revolved cutout

Add a revolved cutout to the part. To create this cutout, include and offset an
existing part edge.

▸ Choose the Revolved Cut command .
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▸ Select the reference plane as shown.

▸ In the Draw group, choose the Include command .

▸ On the Include Options dialog box, set the Include with offset option and click
OK.
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▸ Select the arc shown, and on the command bar click the Accept button.

▸ Type 6.5 in the Distance field and press the Enter key.

▸ Click inside the arc to accept the offset. Notice that the system places a
dimension between the offset element and the arc from which it is offset.

▸ Draw a horizontal line and a vertical line as shown.

▸ Choose the Trim command .
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▸ Trim away the lines and arc to produce the following profile shape. If a mistake

is made, click Undo and repeat the step.

▸ Choose the Distance Between command , and place dimensions as shown.
Edit the values of the dimensions to the values shown below.
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▸ Click the Axis of Revolution command .

To define the axis of revolution, select the reference plane labeled (A).

▸ Click Close Sketch.

▸ To define the direction of material removal, position the cursor so that the arrow
points to the outside of the part, and click.

▸ On command bar, click the Symmetric Extent button. Type 30 in the Angle field
and then press the Enter key.
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▸ Click Finish to complete the revolved cutout.

▸ Save and close the file. This completes the activity.

Summary

In this activity you learned how to create a base feature and then construct
additional features to complete the part. The include command used existing
geometry which made the features associative. Because the geometry is associative,
it will respond predictably to modifications. An open profile in the Revolved Cut
command was used to show that the profile adjusts itself to intersect the face of the
protrusion it is cutting.

Activity: Creating a loft and swept protrusion

Creating a loft and swept protrusion

In this activity, construct a solid model using the Loft and Swept Protrusion
commands. Edit end conditions and curves to adjust the overall shape of the model.

Open the part file

Objectives

In this activity, construct a solid model using the Loft (1) and Swept Protrusion (2)
commands. Edit end conditions and curves to adjust the overall shape of the model.
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▸ Open loft.par. This file contains sketches and curves that will be used to model
the part.

Create a loft protrusion

Create a loft protrusion using sketches provided in the file.

▸ On the Home tab®Solids group, choose the Loft command in the Add drop down

list .

▸ Hide the reference planes.

▸ Select the sketch (base sketch) at location (A) shown for the first cross-section.
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Select the sketch (top sketch) at location (B) shown for the second cross-section.

Note

It is important to select the cross-sections at start locations where a twist
will not be introduced in the geometry (or a self-intersecting result). If
this condition occurs, an error message displays.

▸ On the command bar, click Preview. Do not click Finish.

Note

The result shown above uses the default end-condition of “Natural”. This
is where the cross-sections connect using a linear vector.

Edit end conditions

▸ On command bar, click the Extent Step.
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▸ Change the end-conditions of both cross-sections. Set both End 1: (A) and End
2: (B) to“Normal to section” (C). This setting creates a lofted feature where the
surface starts and ends with a normal vector to the cross-sections.

▸ Click Preview and then click Finish. Notice the results [(1) Normal to section,
(2) Natural].

Add guide curves

Add guide curves to further control the overall shape of the lofted protrusion feature.
Edit the definition of the lofted protrusion completed in the previous step.

▸ Turn on the display of curves. In PathFinder, click the check box on the curves
named side curve 1,mirrored side curve 1, side curve 2 andmirrored side curve 2.

▸ Click the Select tool and then select the protrusion in the part window.

▸ Click Edit Definition.

▸ On command bar, click the Guide Curve step.
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▸ Select each curve and then click the Accept button. Select and accept only one
curve at a time. The right-mouse button or Enter on the keyboard can also be
used to accept the guide curve.

▸ After selecting all four curves, click the Preview button.

▸ Notice how the shape of the loft protrusion follows these guide curves.
Dynamically rotate the model to better observe the shape. Click Finish.

Edit the guide curves

Continue to refine the loft protrusion shape by editing the guide curves. When one
curve is edited, the curve on the opposite side will adjust automatically because it
is a mirrored element.

▸ Click the Select tool.

▸ Select curve named side curve 1.

▸ Click the Dynamic Edit button.

▸ Select the green dot on the curve. This will be the edit point on the curve.

▸ Click the Relative/Absolute Position button . Absolute uses the actual X-Y-Z
coordinates for positioning. Relative uses a delta distance for positioning. Use
relative positioning.
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▸ Type 25 in the dX: field and press the Enter key. This moves the edit point 25
units in the positive X direction and 0 units in the Y and Z direction. The edit is
made when the Enter key is pressed. Each time the Enter key is pressed after
this point will apply a move again of the values displayed in the ribbon bar
delta fields.

▸ Click the Select tool.

▸ Select curve named side curve 2.

▸ Click the Dynamic Edit button.
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▸ Select the green dot on the curve. This will be the edit point on the curve.

▸ Click the Relative/Absolute Position button.

▸ Type -25 in the dY: field and press the Enter key. This moves the edit point 25
units in the negative Y direction and 0 units in the X and Z direction. The edit is
made when the Enter key is pressed.

▸ Continue to modify the shape on your own. This completes this portion of the
activity. Close and do not save the file.

Create a swept protrusion

▸ Open sweep.par. This file contains sketches and curves to use to define swept
protrusions.

▸ The curves provided were created using the project curve onto surface command.
This command is not be covered in this course. These are the trace curves for
the swept feature. Lines, arcs, curves, etc. can be used to define the path trace
for the sweep.
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▸ On the Home tab®Solids group, choose Swept Protrusion command on the Add

drop down list .

▸ On the Sweep Options dialog box, click the Single path and cross section option.
Click OK.

▸ Select the curve shown.

▸ Click the Accept button (or right-click) to accept the trace curve.

▸ The cross section select step is now active. Select the sketch as shown for the
cross section.

▸ On the command bar, click Finish.

▸ Repeat the previous steps to create a swept protrusion on the opposite side.

▸ Hide the curves and sketch. Right-click in the part window and choose Hide All
®. Curves. Choose Hide All ®. Sketches.

▸ This completes the activity. Close the file.
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Summary

In this activity you learned how to create both a swept protrusion and a lofted
protrusion. To better manage the geometry, sketches were used to define the cross
sections to be swept and lofted. Guide paths were used to control the transition of
geometry between cross sections.

Miscellaneous activities

Activity: Constructing a mouse base

Constructing a mouse base

In the following activity, construct a computer mouse base. This activity reinforces
the feature construction techniques you have already learned, and it utilizes
treatment features.

Create a new part file

Overview

Construct the computer mouse base shown in the illustration. This activity
reinforces the ordered feature construction techniques you have already learned,
and it utilizes treatment features.

Objectives

In this activity, learn how to:

• Construct a solid model with holes, cutout, and draft.

• Use the Thin Wall command.

• Use the Mounting Boss command.

• Use PathFinder to select features.

mt01413-s-1050 Solid Edge fundamentals 7-87



Lesson 7 Modeling synchronous and ordered features

▸ Create a new ISO part file.

▸ Make sure you are in the ordered environment.

Create the base feature

Create an extrusion as the base feature for the mouse.

▸ In PathFinder, turn off the base coordinate system display. Turn on the base
reference planes display.

▸ Choose the Extrude command.

▸ On the command bar, click the Coincident Plane option, and select the reference
plane shown.

▸ Draw the profile.
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▸ Place Horizontal/Vertical relationships to center the profile on the midpoints of
the reference planes.

Note

Fillets (R 10 and R 15) are in two places with equal relationships applied.

▸ Click Close Sketch.

▸ Extend the profile upward 20 and click Finish.
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▸ Hide all reference planes.

▸ Change the display of the part. In the Styles group, click the Visible and Hidden
Edges display.

Create a cutout

Create a cutout on the bottom side of the part.

▸ Choose the Cut command.

▸ Use the reference plane used to create the base feature. On command bar, select
the Last Plane option.

▸ Draw the profile and apply the dimensional constraints.

▸ Click Close Sketch.
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▸ On command bar, click the Finite Extent option, and in the Distance box type 8.

▸ Project the cutout upward, and finish the feature.

▸ Save the file as mouse.par.

Apply draft to the part

▸ In the Solids group, choose the Draft command .

▸ For the Draft Plane Step, select the bottom face as shown.

▸ For the Select Face Step, select one side face of the mouse base. All side faces of
the mouse base should highlight. The default Select option is set to Chain which
selects all chained faces not parallel to the draft plane.
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▸ Type 10 in the Draft Angle field, and click the Accept button.

▸ You can specify different draft angles for multiple faces in the Select Face Step.
If no other faces are to be drafted, click Next to leave the Select Face Step

▸ For the Draft Direction Step, orient the direction as shown so that the draft is
applied outward, and then click.

▸ Click Finish.

Add a round

Add a round feature to the bottom edge of the part.
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▸ Choose the Round command .

▸ For the Select Step, identify the edges to round. On command bar, in the Select
box, click the Chain option. This lets you select a connected chain of edges with
one click.

▸ Select the chain of edges around the bottom face of the part as shown.

▸ Type 5 in the Radius field and click the Accept button.

▸ Use the default parameters. Skip the Round Parameters Step. Click Preview
and then Finish.

▸ Save the document.

Add draft

Add draft to the cutout feature in the part.

▸ Choose the Draft command.

▸ Use QuickPick to select the bottom face to define the draft plane as shown.
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▸ Select the chain of faces that form the sides of the cutout. Click once to select
the three faces that are tangent to each other, and click once more to select
the remaining face.

▸ Type 2 in the Draft Angle field and click the Accept button.

▸ Click Next.

▸ Orient the draft direction as shown, and then click to accept.

▸ Click Finish.

▸ Save the file.
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Apply a thin wall feature

Use the Thin Wall command to remove the interior material from the part.

▸ Choose the Thin Wall command.

▸ For the Common Thickness Step, specify the thickness to apply to all faces of the
part. In the Common Thickness box, type 1 and press the Enter key.

▸ For the Open Faces Step, select the top face of the part and the top face of the
cutout as the open surfaces.

▸ Click the Accept button to accept the faces.

▸ You can apply unique thickness to faces of the part. To skip this step, click
Preview to process the thin wall. Click Finish to complete the feature placement.

▸ Click the Shaded with Visible Edges display.

Add a cutout

Add a cutout to remove material from the top of the mouse base.

▸ Right-click in the part window and click Show All® Reference Planes.

▸ Choose the Cut command, and select the reference plane shown.
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▸ Choose the Arc by 3 Points command , and place an arc that touches the two
sides and is tangent to the top of the part. The command is in the Draw group
on the Tangent Arc drop list.

Note

The first and second points define the arc sweep. The third point defines
the radius.

▸ Place and modify the dimension as shown. Add a Horizontal relationship to
the two endpoints of the arc as shown.

▸ Click Close Sketch.

▸ For the Side Step, position the cursor as shown in the illustration and click.
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▸ On command bar, set the Extent to Through All. Position the cursor so that
arrows point from both sides of the profile and click.

▸ Finish the cutout and save the file.

▸ Hide all reference planes.

Add a cutout and use GoTo

Add another cutout. Since the part is thin walled, the additional cutout is not
thin walled unless it is constructed before the thin wall step. The following steps
demonstrate how to go back in the creation process to a point before the thin wall
had been applied and place another cutout.
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▸ Change display to Visible and Hidden Edges.

▸ Choose the Select Tool.

▸ In PathFinder, right-click on the feature named Cutout 1, and on the shortcut
menu, select the GoTo command.

▸ Choose the Cut command and use QuickPick to select the reference plane shown.

▸ Draw the rectangular profile.

▸ Click Close Sketch and project the cutout upward 5 using the Finite Extent
option.
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▸ Click Finish.

Note

Since this cutout was placed before the thin wall feature, use the GoTo
command to apply the thin wall to the new cutout.

▸ Choose the Select Tool.

▸ Right-click on the last feature listed in Feature PathFinder, and select the
GoTo option from the shortcut menu. The part returns to the thin wall state.
The cutout just constructed has thin wall sides because it was placed before
the thin wall feature.

Add mounting boss features

▸ In the Solids group, choose the Mounting Boss command on the Thin Wall
drop list.

▸ On the Mounting Boss command bar, click the Parallel Plane option.

▸ Select the bottom plane as shown.
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▸ On the command bar, type 10 in the Distance field. Position the parallel plane
above the bottom plane as shown and click.

▸ On the command bar, click the Mounting Boss Options button and set the
Mounting Boss Options as shown and click OK.
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▸ Position the bosses as shown and then click Close Sketch.

▸ Define the extent direction as shown.
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▸ Click Finish.

▸ Save the document and close the file. This completes the activity.

Summary

In this activity you learned how to add draft to some of the faces of a molded part. You
learned how use the GoTo command to insert a feature at a desired location within
Feature Pathfinder. You learned to place bosses using the Mounting Boss command.

Activity: Embossing text

Embossing text on a part

This activity covers the procedure of embossing text characters onto a simple model
of a casting.
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Open part file

Overview

This activity covers the procedure of embossing text characters onto a simple model
of a casting.

▸ Open support.par.

Create a sketch containing the text profile

To emboss text on a part, create a sketch containing the text profile.

▸ Choose the Sketch command .

▸ Select the face shown for the sketch plane.
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▸ On the Tools tab®Insert group, choose the Text Profile command .

▸ In the Text dialog box, set the values as shown. In the Font field (A), choose
Tahoma. In the Script field (B), choose Arabic. In the Font size control fields (C),
set the values shown. In the Text box (D), type ACME MFG. and click OK.
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▸ Position the text in the approximate position shown, and click.

▸ Click Close Sketch to complete the profile.

▸ Click Finish.

Cut the text profile from part

Use the Cut command and the text sketch created in the previous step to remove
material from the part.

▸ Choose the Cut command.

▸ On command bar, click the Select from Sketch option.

▸ Select the sketch (text) and click the Accept button.

▸ In the distance box, type 2 and press the Enter key.

▸ Click below the profile to extend the text into the part.

▸ Click Finish to complete the cutout.

▸ Hide all sketches.

▸ Save the file as myblock.par.
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▸ Close the file. This completes the activity.

Summary

In this activity you learned how to create and add embossed text to a part.

Activity: Modeling a machined part

Modeling a machined part

This activity uses treatment feature commands, cutouts, rounds, patterns, mirror
copied features, ribs, lip and hole. This activity is advanced and it might take a while
to complete. There is a stopping point in the activity you can decide to continue or
finish later. Pay careful attention to the instructions and illustrations.

Open a new part file

Overview

This activity uses ordered treatment feature commands, cutouts, rounds, patterns,
mirror copied features, ribs, lip and hole. This activity is advanced and it might take
a while to complete. There is a stopping point in the activity where the you can decide
to continue or finish later. Pay careful attention to the instructions and illustrations.

▸ Open a new ISO part file. Save the file as machine01.par.

▸ Make sure you are in the ordered environment.

Create the base feature

Begin the activity by creating a rectangular extrusion as the base feature for this
part.
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▸ In PathFinder, turn off the display of the base coordinate system. Turn on the
display of the base reference planes.

▸ Choose the Extrude command.

▸ For the plane step, select the reference plane shown.

▸ Draw the profile and center the profile at the intersection of the default reference
planes.

▸ Choose Close Sketch.

▸ Extrude the profile 50 mm below the reference plane and click Finish
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Add a cutout to the base feature

▸ Choose the Cut command.

▸ Select the Coincident Plane option and orient the plane as shown.

▸ On the right side of the part, draw the profile.
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▸ Choose Close Sketch.

▸ Click as shown for direction to remove material.

▸ For the Extent step, on the command bar, select the Through All option and
click the direction as shown.
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▸ Click Finish.

Create a cutout

Create a second cutout on a side face created by the cutout in the previous step. The
cutout looks like the one shown.

▸ Choose the Cut command.

▸ For the profile plane, select the right surface shown using the Coincident Plane
option on the command bar.
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▸ Draw the open profile.

▸ Choose Close Sketch.

▸ For the Side step, position the cursor so the arrow points to the inside of the
profile, as shown, and click.

▸ For the Extent Step, on the command bar, click the From/To Extent button.
Make the depth of the cutout from surface (A) to surface (B).
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▸ Click Finish.

Mirror cutouts

Mirror the cutouts created in the previous two steps about reference plane (A). Using
this reference plane, which lies at the center of the part, ensures that the two cutouts
are mirrored symmetrically on the opposite side of the part.

▸ In the Pattern group, on the Mirror drop list, choose the Mirror Copy Feature

command .

▸ On command bar, click the Smart button.

▸ Select the two cutout features in PathFinder and click the Accept button.

▸ For the plane to mirror about, select reference plane (A).
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▸ Click Finish.

Create a cutout

Create a cutout using two profiles created in a single profile step. This allows
removing or adding material of a complex shape in a single step.

▸ Choose the Cut command.

▸ Select the reference plane shown.

▸ Draw and dimension the two profiles as shown. The top and bottom lines
are coincident with the part edges. Notice that lines A and B have equal
relationships applied.
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▸ Click Close Sketch.

▸ For the extent step, use the Through All extent and click the Symmetric Extent
button. Type 108 in the Distance field and press Enter.

▸ Click Finish.

Construct a rib

Construct a rib to strengthen the interior of the part.

▸ In the Solids group, on the Thin Wall drop list, choose the Rib command .

▸ On command bar, click the Parallel Plane option.

▸ Select the top face as shown.
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▸ On the command bar, type 3 and position the cursor so the parallel plane is
placed below the top face and click.

▸ Draw the rib profile. Looking down from the top of the model, the profile
endpoints are connected to the cutout edges.

▸ Choose Close Sketch.

▸ On the command bar, type 3 for rib thickness.

▸ Select the direction shown.
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▸ Click Finish.

Create a groove

Create a groove around the top inside edge of the part. Use the Lip command. Use
this command to add material to create lips or remove material to create grooves.

▸ On the Thin Wall drop list, choose the Lip command .

▸ Select the four edges shown and then click the Accept button.

7-116 Solid Edge fundamentals mt01413-s-1050



Modeling synchronous and ordered features

▸ On the command bar, type 4 for the width and 3 for the height. Use the Zoom
command to adequately see this rectangle. This rectangle defines whether
material will be added to create a lip or removed to create a groove. Position the
rectangle as shown to create the groove.

▸ Click Finish.
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Create circular cutout

Create a circular-shaped cutout and remove a finite amount of material from the
part. The Hole command could be used here, however in this step the Cut command
and a circular profile is used.

▸ Choose the Cut command.

▸ Select the profile plane as shown.

▸ Draw and dimension the profile. Center the circle on midpoint of line (A).
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▸ Choose Close Sketch.

▸ In the Distance box, type 40 for the extent and position the cutout into the part.

▸ Click Finish.

Construct a hole

Construct a hole at the rear of the cutout created in the previous step.

▸ Choose the Hole command .

▸ Select the profile plane as shown.
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▸ On the command bar, click the Hole Options button . Type 6.35 for the
Diameter, select the Finite extent and Hole Depth of 8. Click OK.
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▸ Place the hole centered on circle (A).

▸ Choose Close Sketch.

▸ Position the extent to the right as shown and click.

▸ Click Finish.

Create a cutout

Create another cutout on the part. This cutout will surround the circular cutout
created earlier.

▸ Choose the Cut command.

▸ Select the profile plane as shown.
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▸ Draw and dimension the profile. Use Horizontal/Vertical and Equal relationships
to center the square profile around the circular cutout from the previous step.

▸ Choose Close Sketch.

▸ Click the Finite Extent button, and type 3 in the Distance field.

▸ Position the cursor so that material is removed from the part and click.
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▸ Click Finish.

Add rounds

Add rounds to the cutout.

▸ Choose the Round command.

▸ Select the four edges as shown.

▸ Type 3 in the Radius field, and then click the Accept button.

▸ Click Preview and Finish.
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Add holes

Add a series of holes to the surface created by the rectangular cutout.

▸ Choose the Hole command.

▸ Select the profile plane as shown.

▸ Click the Hole Options button and set the options as shown. Click OK.
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▸ Place four holes as shown (B). Center the holes on the rounds you created in the
previous step. The dashed line around the hole profile indicates a threaded hole.

▸ Choose Close Sketch.

▸ Position the direction arrow to point towards the interior of the part and click.
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▸ Click Finish.

Create a pattern of features

Pattern the five features, which include the circular cutout, single hole, square
cutout, rounds, and series of four holes.

▸ Choose the Pattern command and on the command bar, click the Smart option.

▸ Select the features shown below to pattern.
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▸ Click the Accept button.

▸ Select the pattern reference plane as shown.

▸ On the command bar, type the following patterning parameter values.

▸ Define the pattern profile by selecting the first point in the center of the small
hole and then position the rectangle as shown.
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▸ Choose Close Sketch.

▸ Click Finish.

Create an extrusion

Use the Extrusion command to add material in the corner of the part. It serves
as a boss for the model.

▸ Choose the Extrude command.

▸ Select the profile plane as shown.
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▸ Draw and dimension the profile.

▸ Choose Close Sketch.

▸ Position the direction arrow as shown and click.

▸ For the extent step, on the command bar, click the Through Next button. Position
the cursor so that the material is added below the profile as shown and click.
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▸ Click Finish.

Apply a round

Apply a round to the material added in the previous step.

▸ Choose the Round command.

▸ Select the edge shown.

▸ Type 3 in the Radius field, and then click the Accept button.

▸ Click Preview and Finish.
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Add a threaded hole

▸ Choose the Hole command.

▸ Select the profile plane as shown.

▸ Click the Hole Options button and set the options as shown. Click OK.
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▸ Place the hole concentric with the arc.

▸ Choose Close Sketch.

▸ Position the cursor so that the extent is defined as shown and click.
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▸ Click Finish.

Mirror features

Mirror the features created in the previous steps. These include the rectangular
boss, round, and hole.

▸ Choose the Mirror Copy Feature command.

▸ Click the Smart button.

▸ In PathFinder, select the last three features constructed, protrusion, round and
hole. Click the Accept button.
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▸ Select the reference plane shown as the plane to mirror the features about.

▸ Click Finish.
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▸ Choose the Mirror Copy Feature command.

▸ Click the Smart button.

▸ In the PathFinder, select the protrusion, round, hole and mirror features. Click
the Accept button.

▸ Select the reference plane shown as the plane to mirror the features about.
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▸ Click Finish.

Note

In order to save time, you may stop at this point. The remainder of the
activity covers adding more rounds and holes. Save the file at this point and
finish later.

Add rounds to the inside edges

▸ Choose the Round command.

▸ Select the edges shown.

7-136 Solid Edge fundamentals mt01413-s-1050



Modeling synchronous and ordered features

▸ Type 3 in the Radius field. Click the Accept button.

▸ Click Preview and Finish.

Add rounds

Add rounds to more of the interior edges of the part.

▸ Choose the Round command.

▸ Select the edges shown.
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▸ Type 6 in the Radius field. Click the Accept button.

▸ Click Preview and Finish.

Add holes to the part

▸ Choose the Hole command.

▸ Select the profile plane as shown.
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▸ On the Main toolbar, click Fit.

▸ Click the Hole Options button. Type 6.35 for the hole diameter and click OK.

▸ Place and dimension four holes.

▸ Choose Close Sketch.

▸ Click the Through All button.

▸ Position the cursor so that the direction arrow is displayed as shown, and click.

mt01413-s-1050 Solid Edge fundamentals 7-139



Lesson 7 Modeling synchronous and ordered features

▸ Click Finish.

▸ Close and save the file. This completes the activity.

Summary

In this activity you modeled a machined part that included cutouts, rounds, patterns,
mirror copied features, ribs, lip and holes. In this activity, non profile based features
were used to more efficiently model the machined part.
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Actiivty: Constructing a bracket

Constructing a bracket

In this activity, construct a solid model and create holes, chamfer, and pattern
features.

Open a new part file

Objectives

In this activity you will construct a solid model and create holes, chamfer, and
pattern features.

▸ Create a new ISO part file.

▸ Make sure you are in the ordered environment.

Construct the base feature

Create an L-shaped extrusion as the base feature. In subsequent steps, use
additional features to create the final part shown above.

▸ Choose the Extrude command.

▸ Turn on the display of the base reference planes.

▸ Set the Create-from option to Coincident Plane, and select the reference plane
shown.
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▸ Hide all reference planes.

▸ Draw the profile.

▸ Use an equal relationship, as shown above, to make the two shorter lines equal
to one another.

▸ Choose Close Sketch to complete the profile.

▸ On command bar. click the Symmetric Extent button. Type 200 in the Distance
field and press the Enter key.

▸ Fit the view.

▸ Click Finish.
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Add a chamfer feature

Add a chamfer treatment feature to the base feature.

▸ In the Solids group, on the Round drop list, choose the Chamfer command.

▸ Select the two short vertical edges on the front of the part as shown.

▸ On the command bar, type 20 in the Setback field and click the Accept button.

▸ Click Finish.
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Add chamfer feature

Change the chamfer option settings and add another set of chamfers with an angle
and setback.

▸ Choose the Chamfer command.

▸ On command bar, click the Chamfer Options button. Click the Angle and setback
option and then click OK.

▸ Notice that after setting the Angle and Setback option, the command bar
changes to include the Select Face step.

▸ Select the top face and then on the command bar click the Accept button.

▸ Select the short edge on each end of the top face.

▸ Type 30 in the Setback field and type 15 in the Angle field.

▸ Click the Accept button to apply these values.
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▸ Click Finish.

▸ Save the file as angle.par.

Construct a cutout

Construct a cutout on the front horizontal face shown.

▸ Choose the Cut command.

▸ Select the horizontal face shown to define the reference plane.

▸ Draw the profile. Use the Line command and toggle between the Line and Arc
modes.
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▸ Choose Close Sketch.

▸ On command bar, click the Through Next option, and position the cursor to
project the cutout downward.

▸ Click Finish.

Add a chamfer

Add a chamfer to the cutout constructed in the previous step.

▸ Choose the Chamfer command.

▸ On command bar, change the chamfer setting to Equal setbacks..

▸ Select the top and bottom edges of the cutout.
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▸ In the Setback box, type 3 and click the Accept button.

▸ Click Finish.

Pattern features

Pattern the cutout and chamfer. Since the cutout is the parent feature of the
chamfer, the cutout must be patterned with the chamfer.

▸ Choose the Pattern command and on command bar, click the Smart option.

▸ On PathFinder, select Cutout 1 and Chamfer 3 as the features to pattern. Click
the Accept button.

▸ Select the reference plane to place the pattern on. Use the same profile plane
that was used for the Cutout feature.
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▸ In the Features group, click the Rectangular Pattern command.

▸ Set the Pattern Type to Fixed. Set the X count to 3 and the Y count to 2. Type 50
for the X spacing and 45 for the Y spacing. Press the Enter key.

▸ Click the center of the arc in the bottom of the cutout to define the start point
of the pattern profile (1), and then position the rectangle defining the pattern
up and to the right (2).

▸ Choose Close sketch.
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▸ Click Finish to complete the feature.

▸ Save the file.

Add hole features

Add holes to the vertical front face of the part.

▸ Choose the Hole command.

▸ Select the front vertical face of the bracket as shown.

▸ Click the Hole Options button and set the options shown and click OK.
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▸ Place a hole centered over each slot. Align the holes as shown.

▸ Dimension the location of the holes as shown.

7-150 Solid Edge fundamentals mt01413-s-1050



Modeling synchronous and ordered features

▸ Choose Close Sketch.

▸ Specify the extent direction shown in the illustration.

▸ Click Finish.

▸ Save and close this file. This completes the activity.

Summary

In this activity you learned how to create a chamfer feature and to create a pattern
consisting of more than one feature. You used the hole command to create the
counterbored holes in the bracket.
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Lesson

8 Modeling assemblies

Solid Edge Assembly

Solid Edge Assembly

An assembly is a collection of parts and subassemblies that are positioned in a
meaningful way. The parts can be in their final orientation, or have freedom of
movement in translation and rotation. Solid Edge Assembly provides the tools
needed to lay out and position the parts relative to each other. Many methods
exist to accomplish this task and these approaches to building assemblies will be
covered in this text.

Objectives

This lesson introduces the Solid Edge Assembly interface and discusses the different
workflows for creating an assembly with the most commonly used part relationships.

Placing parts in assemblies

You can place any of the following types of solid parts in Solid Edge assemblies using
the Parts Library tab:

• A part constructed in the Solid Edge Part environment.

• A part constructed in the Solid Edge Sheet Metal environment.

• Another assembly constructed in the Solid Edge Assembly environment.

• Any file that is open in Solid Edge other than a draft file.

To place parts that were constructed in other CAD formats, you must first convert
them to Solid Edge part files.

Note

When you add an Insight-managed document to an assembly, Solid Edge
uses the SearchScope.txt file to prevent you from creating links to documents
with duplicate IDs. The SearchScope.txt file must list at least one managed
workspace, or you will not be able to place managed parts in assemblies.
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Sharing assemblies

You can place parts in assemblies by selecting them from a local folder path or from
a network share. If you use local folder paths, other Solid Edge users who access
the assembly over a network will not be able to view its parts and subassemblies. If
you intend to share an assembly over a network, you should always select the parts
through a network share, even if they are stored on your computer.

To do this, use the arrow on the right side of the Look In option on the Parts
Library tab to browse to and select the folder on a network drive where the part or
subassembly is stored.

The network share approach also allows you to build an assembly using parts that
are stored on several computers on your network. For example, your company
may have one or more computers that are used as servers, where commonly used
parts are stored.

Placing the first part in an assembly

To start the part placement process, in the Parts Library tab, select the part you
want, then drag it in the assembly window. You can also start the part placement
process by double-clicking the part in the Parts Library tab.

The first part you place into an assembly is important. It serves as the foundation
upon which the rest of the assembly will be built. Therefore, the first part should
represent a fundamental component of the assembly. Because the first part is placed
grounded, you should pick a part with a known location, such as a frame or base.

Although Solid Edge makes it easy to edit parts during the design cycle, the first
part you place in the assembly should be as completely modeled as possible. In the
same way, although it is easy to delete parts from assemblies and change assembly
relationships, the first part you place should remain grounded and not be deleted.

To reposition the first part, you should first delete the ground relationship. You can
then apply assembly relationships between the first part and the assembly reference
planes or subsequent parts you place in the assembly.
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Placing additional parts in an assembly

You can use the Assembly tab on the Options dialog box to specify whether
subsequent parts are temporarily placed in the assembly window (A), or displayed in
a separate Place Part window (B).

When you set the Do Not Create a New Window During Place Part option, the part is
temporarily placed in the assembly window at the location where you dragged and
dropped the part. To make the positioning process easier, drop the part in a location
where it is easy to select the positioning elements you want to use. If you start the
part placement process by double-clicking the part in the Parts Library tab, the
display area of the assembly window is adjusted so you can see the new part.

When you clear the Do Not Create a New Window During Place Part option, the part
is displayed in a separate Place Part window. If the active window is maximized,
the Place Part window is also maximized, essentially hiding the assembly window
from view. Due to this, beginning users should not maximize the active window.
Let the windows overlap, and this will make placing parts into the assembly and
applying relationships much easier.

mt01413-s-1050 Solid Edge fundamentals 8-3



Lesson 8 Modeling assemblies

Positioning parts

You use assembly relationships to position the new part relative to a part already
in the assembly. The Relationships Types option on the Assemble command bar
contains a wide range of assembly relationships for positioning parts relative to
one another.

In addition to traditional assembly relationships, the FlashFit option reduces
the steps required to position a part using the mate, planar align, or axial align
relationships. This option is recommended in most situations. For example, you can
use FlashFit to mate a face on the placement part (A) with a face on the target
part (B).

After you apply the first assembly relationship, the new part is repositioned within
the assembly.
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As you apply the remaining assembly relationships, the software positions and
reorients the part in the assembly.

Additional parts can be positioned relative to any part in the assembly, or even
relative to more than one part in the assembly. You can also position a part relative
to an assembly sketch.

For more information on positioning parts using assembly relationships, see the
Assembly Relationships Help topic.

Note

By default, Solid Edge maintains the relationships with which you position
the part. If you clear the Maintain Relationships command on the Parts
Library shortcut menu, the relationships will be used only for positioning,
and the part will be grounded. Grounded parts do not update their positions
when you make design changes.
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Placing parts that are not fully positioned

It is a good idea to fully position parts as you place them into assemblies.
Fully-positioned parts will update their positions more predictably when changes
are made. At times, though, you may want to place a part without fully positioning
it. For example, you may be placing another part later that will be used to complete
the positioning of both parts.

You can use the Esc key to interrupt the placement sequence at any time. If no
relationships have been applied, the part is placed in the assembly at the same
relative position it occupies in the part document. In other words, the part is placed
in the assembly such that the base reference planes in the part document (A) are
coincident with the base reference planes in the assembly (B).

If you work with the Do Not Create a New Window During Place Part option set,
the part is placed in the assembly at the location you dragged and dropped it into
the assembly.

If you work with the Do Not Create a New Window During Place Part option cleared,
the part is placed in the assembly such that the base reference planes in the part
document (A) are coincident with the base reference planes in the assembly (B).

You can also interrupt the placement process by selecting another command, for
example, the Select tool.
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Placing the same part more than once

If you want to place the same part in an assembly more than once, you do not have to
use the Parts Library tab every time. After you place the part the first time, you can
select it, copy it to the Clipboard, and then paste it into the assembly.

When you select the Paste command, the part is displayed in a separate window,
as if you had selected it from the Parts Library tab. You can then apply assembly
relationships between the new part and the other parts in the assembly.

You can also use PathFinder to place an existing part into an assembly again. Select
the part in PathFinder, then drag and drop it into the assembly window.

If a part is being placed in the assembly several times using the same relationship
scheme, you can use the Capture Fit command to store the relationships and faces
used to position the part the first time. This reduces the number of steps required to
define each relationship when you place the part again. When you place the part
later, you do not need to define which relationship and face you want to use on the
placement part. You only need to select a face on the target part in the assembly for
each relationship.

Positioning a set of parts

You can use the Assemble command to position a set of parts relative to each other
without fully constraining each part in an ordered sequence. This type of workflow
can make it easier to position a set of interrelated parts, such as when building
a mechanism.

First, drag and drop the set of parts into the assembly. Then click the Assemble
command and apply relationships between one part and the other parts. To position
a different part, click the right mouse button.

Finding parts

If you do not know the name and location of a part or subassembly, you can
define search criteria using Search button on the Parts Library tab. You can then
double-click the name of the part or subassembly from the list of search results to
start the part placement process.
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Part placement properties

When you place a part or subassembly into an assembly, Solid Edge sets properties
that determine the following:

• The placement name of a part or subassembly.

• Whether the part is selectable or not selectable.

• The quantity of the part.

• The x, y, and z location for grounded parts or parts or not positioned using
assembly relationships.

• Whether the part is displayed in a higher level assembly.

• Whether the part is displayed in a drawing of the assembly.

• Whether the part is considered a reference part in a drawing or parts list.

• Whether the part is used in a report, such as a Bill of Material.

• Whether the part is used in mass property calculations of the assembly.

• Whether a part is used in an interference analysis calculation.

You can also change these properties later using the Occurrence Properties button on
the Place Part command bar or the Occurrence Properties command when selecting
assembly components.

Placing simplified parts

The Use Simplified Parts command on the Parts Library shortcut menu allows you
to specify whether you want to use the simplified or designed version of a part when
placing it in the assembly. When you have the Use Simplified Parts command set
(there is a check mark adjacent to the command), any faces that were deleted when
simplifying the part will not be available for positioning purposes. To make these
faces available, clear the Use Simplified Parts command.
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Placing subassemblies

You can place a Solid Edge assembly document into another assembly in much the
same way you place an individual part. When placing an assembly, in the Place Part
window, you must first select the placement part in the assembly you want to use for
positioning purposes, then the face on the part.

If you are placing a large subassembly, you can save a display configuration in
the subassembly first, then use this configuration to make placement easier. For
example, you can hide all the parts, except those that will be used to position the
subassembly. Before you place the subassembly, make sure the Use Configuration
command on the shortcut menu is set. Then, when you place the subassembly,
you can select the configuration name from the Configuration list on the Use
Configuration dialog box. Subassemblies also place faster if parts have been hidden.

When placing a subassembly using FlashFit or the Reduced Steps mode, the
placement part step is skipped. You specify the placement part by selecting a face on
the placement part you want.

The placement part must be active before you can select a face. If the placement
part is not already active, you can use the Activate Part button on the Place Part
command bar to activate the placement part.

Note

When placing parts into a subassembly, you can set an option that controls
whether the part is displayed in higher level assemblies. If the Display When
Assembly Is Attached As Subassembly option on the Properties dialog box
is cleared for a part, that part will not be displayed in PathFinder or the
graphics window in higher level assemblies.

Locating parts

The parts and subassemblies used to build an assembly can be located on different
computers on a network. To locate a part or subassembly, you can use the Assembly
Statistics command on the Inspect tab to display the document name and location.
When the Assembly Statistics dialog box is displayed, select any document in the
list, then right-click, and then set the Show Document Name and Location option.

Non-graphic parts

Sometimes you need to place parts in assemblies that have no model associated with
them, so they can be documented in a parts list or bill of materials. For example,
items such as paint, grease, oil, and so forth require no model, but a part must
exist in the assembly for them to show up in the documentation for the assembly.
Solid Edge allows you to create non-graphic parts by adding custom properties to
an empty part document. You can then place the part in the assembly without
positioning it with assembly relationships, by pressing the Shift key, then dragging
the part into the assembly.

PathFinder in assemblies

The PathFinder tab helps you work with the components that make up your
assembly. It provides alternate ways to view the composition and arrangement of the
assembly, besides looking at the graphics in a regular assembly window. You can
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also use PathFinder to in-place activate a part or subassembly so you can make edits
to individual assembly components while viewing the entire assembly.

The PathFinder tab is available when you work in an assembly or a subassembly
within the active assembly.

In the Assembly environment, you can also use PathFinder to view, modify and
delete the assembly relationships used to position the parts and subassemblies,
reorder parts in an assembly, and to help you diagnose problems in an assembly.

In the Assembly environment, PathFinder is divided into two panes. The top
pane lists the components of the active assembly in a folder tree structure. Listed
components can include: parts, subassemblies, assembly reference planes, and
assembly sketches.

The bottom pane shows the assembly relationships applied to the part or
subassembly selected in the top pane.

Using the top pane

The top pane of PathFinder allows you to do the following:

• View components in collapsed or expanded form. For example, when you expand
a subassembly, you can view all of its parts.

• Highlight, select and clear components for subsequent tasks.

• Determine the current status of the components within the assembly.

• Determine how the assembly was constructed.

• Reorder parts within an assembly.

• Rename reference planes, sketches, and coordinate systems.
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When you pass your cursor over a component in the top pane of PathFinder, it
is displayed in the graphics window using the Highlight color. When you click a
component it is displayed using the Select color. This allows you to associate the
component entry in PathFinder with the corresponding component in the graphics
window.

Note

When you pass your cursor over or click the top-level assembly in PathFinder,
it does not display in the highlight or select color. This improves performance
when working with large assemblies.

Because the highlight and selection of components in large assemblies can impact
performance, options are available on the Assembly tab on the Options dialog box
that allow you to improve the performance when working with large assemblies. For
example, options are available that allow you to simplify the display of highlighted
and selected components in the graphics window and to disable the highlight
of components in the graphics window when you pass your cursor over them in
PathFinder.

For more information on improving performance in large assemblies, see the
Working with large assemblies efficiently Help topic.
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Determining the status of a component

The symbols in PathFinder reflect the current status of the components in the
assembly. The following table explains the symbols used in the top pane in
PathFinder:

Legend
Active part

Inactive part

Unloaded part

Part that is not fully positioned

Part that has conflicting relationships

Linked part

Simplified part

Missing component

Alternate components part

Part position is driven by a 2D relationship in an
assembly sketch
Displayed assembly

Adjustable Part

Adjustable Assembly

Driven Reference

Fastener System

Pattern group

Pattern item

Reference planes

Reference plane

Sketch

Noncombinable sketch (synchronous only)

Combinable sketch (synchronous only)

Active sketch (synchronous only)
Weldment
Group of parts and subassemblies

Motor

Available
In Work
In Review
Released
Baselined
Obsolete
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Note

The symbols in PathFinder can also represent combinations of conditions. For
example, a symbol can show that a part is hidden and not fully positioned:

Determining how the assembly was constructed

The components in the top pane of PathFinder are listed in the order in which they
were placed in the assembly. This can be useful when evaluating design changes.
For example, if you delete a single assembly relationship from a part, the symbols for
other parts could also change to indicate that the parts are no longer fully positioned.
This occurs because the positioning of the other parts depended upon the part
from which you removed the relationship. In this example, reapplying the single
relationship should cause the other parts to also become fully positioned again.

Making changes to assembly components

You can use the top pane of PathFinder to open or in-place activate a part or
subassembly so you can make design modifications. For example, you can select a
part in PathFinder, then use the Edit command on the shortcut menu to in-place
activate a part. You can then add, remove, or modify features on the part while
viewing the other assembly components. You can also use geometry on the other
assembly components to help you construct or modify features on the part. When
you use the Open command to open an assembly component, you cannot view the
other assembly components.

When you in-place activate a subassembly, the display of PathFinder changes to
make it easier to determine your current position within the assembly structure.
For example, while in the top-level assembly A1.asm, if you in-place activate into
subassembly S1.asm:1, subassembly S1.asm:1 is displayed using bold text and a
contrasting background color is used for the subassembly and its components.

When you in-place activate a part for editing, you do not need to return to the
assembly first to in-place activate another part or subassembly in the assembly.

You can select another part or subassembly in PathFinder and use the Edit command
on the shortcut menu to in-place activate the component for editing. When you are
finished making the design changes, you can use the Close and Return command on
the Home tab to return to the original assembly.
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When you in-place activate a part or subassembly for editing, you cannot collapse
the assembly structure to which the part or subassembly belongs within PathFinder.
For example, in the following illustration, part P2.par:1 has been in-place activated
and it is in subassembly S1.asm. If you click the minus (-) symbol adjacent to S1.asm
to collapse its structure, it will remain expanded.

Changing the display status of assembly components

You can use the top pane of PathFinder to control the display status of assembly
components. For example, you can hide parts and subassemblies to make it easier
to position a new part you are placing in an assembly. You can use the checkboxes
adjacent to the assembly components in PathFinder to control component display or
shortcut menu commands when one or more components are selected.

The color of the text in PathFinder also indicates whether a component is displayed
or hidden.

Reordering parts within an assembly

PathFinder allows you to drag a part to a different position within an assembly. As
you drag the part, PathFinder displays a symbol to show where you can reposition
the part in the assembly structure. The part will be positioned below the highlighted
part occurrence in PathFinder.
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Grouping parts and subassemblies within an assembly

PathFinder allows you to select a set of parts or subassemblies in the active
assembly, then specify that the selected components are a group using the Group
command on the shortcut menu. The set of components is then collected into a group
entry in PathFinder. You can then expand, collapse, or rename the group to a more
logical name. Defining a group of parts reduces the space requirements for a set of
parts, and allows you to gather together a set of similar parts into a logical group.
This can make it easier to select the parts for other operations, such as displaying
and hiding a set of parts.

You cannot select nested parts or nested subassemblies.

Grouping components is also useful when working with large assemblies that
contain few or no subassemblies. You can select a set of parts, define them as a group
with the Group command on the Pathfinder shortcut menu, then use the Rename
command to rename the group to a more logical name.

Note

Some assembly commands create a group of components automatically. For
example, the Move Components command creates a group entry in PathFinder
when you set the Copy option on the command bar.

You can ungroup a group using the Ungroup command on the shortcut menu when a
group is selected in PathFinder.

The Select Components command , on the shortcut menu when you select a group
entry in PathFinder, activates additional commands and options for manipulating
groups that would otherwise be disabled. For example, after selecting a group with
the Select Components command, you can then apply a face style to the group of
parts, or transfer the group of parts to another assembly.

Renaming PathFinder entries

You can use PathFinder to rename an entry for an assembly reference plane, sketch,
group, or coordinate system. To rename an entry, select it in PathFinder, right-click
and then click Rename. In the name box, type the new name for the entry.
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Finding parts

In a complex or unfamiliar assembly, it can sometimes be difficult to determine
which subassembly a particular part is contained in. You can use the Scroll To
Part command to quickly find a part in PathFinder. When you select a part in the
assembly window, then click the Scroll To Part command on the shortcut menu, the
display of PathFinder scrolls to the selected part. If the part is in a subassembly, the
listing for the subassembly is expanded to display the part.

Replacing the file name with the document name formula value

You can use the Document Name Formula dialog box to replace the file name
displayed in PathFinder with a value composed of document properties. Refer to the
Replace a file name with a property value help topic for instructions.

You can combine properties with additional characters to replace the file name.
For example, you can separate two properties with dashes, such as Document
Number–Revision Number.

If a property does not exist or does not have a value, the property name is displayed
in place of the property value, and the file name is displayed in parentheses after
the value.

Note

The Property list displays the properties that you can use to replace the file
name. You can add a property that is not in the active document by typing
[property name] in the Formula field.

Using the bottom pane

When you select a part or subassembly in the top pane of PathFinder, you can use
the bottom pane to view and modify the assembly relationships between the selected
part and the other parts in the assembly. The document name is also displayed,
as well as a symbol that represents the type of relationship. The following table
explains the symbols used in the bottom pane in PathFinder:

Legend
Ground relationship

Mate relationship

Planar align relationship

Axial align relationship

Connect relationship

Angle relationship

Tangent relationship

Gear relationship

Suppressed relationship
Failed relationship
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When you select a relationship in the bottom pane you can do the following:

• View which elements were used to apply the relationship.

• Edit the fixed offset value of the relationship.

• Change the offset type of the relationship.

• Delete the relationship.

• Suppress the relationship

Viewing assembly relationships

When you select a relationship in the bottom pane, the elements used to apply the
relationship are highlighted in the assembly window. For example, if you select
a planar align relationship, the planar faces or reference planes that were used
to apply the relationship highlight in the assembly window. This can help you
determine how design changes need to be applied.

Modifying assembly relationships

When you select a relationship in the bottom pane, you can use the relationship
command bar to edit the fixed offset value or change the offset type. For example,
you may want to change a mate relationship from a fixed offset to a floating offset.

Note

If you change the offset type from fixed to floating, you may have to make
other relationship edits to ensure that the part remains fully positioned.

Deleting assembly relationships

If you delete an assembly relationship, the symbol next to the part in the top pane
changes to show that the part is no longer fully positioned. The part is also placed on
the Error Assistant dialog box list. It is good practice to apply a new relationship to
the affected parts as soon as possible. If you delete too many relationships without
applying new ones, it could become difficult to fully position the affected parts. If
this occurs, you may have to delete the affected parts from the assembly and place
them again.

Replacing relationships

After you place a part in an assembly, you can replace any of its relationships. Select
the part in PathFinder or in the graphics window, then click the Edit Definition
button on the command bar. You can then select the relationship you want to replace
from the Relationship List box on the command bar. Use the Relationship Types
button to specify the new relationship you want to apply.

Note

You can also delete the current relationship in the bottom pane of PathFinder
and apply a new one using the Assemble command bar.
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Conflicting relationships

If you change the design of parts in an assembly, some assembly relationships may no
longer be applicable. When this occurs, the symbol next to the part or subassembly
in the top pane of PathFinder will change to indicate that there are conflicting
relationships and the part will be placed on the Error Assistant dialog box list.

When you select the conflicted part or subassembly, the symbols for the affected
relationships in the bottom pane of PathFinder are displayed in red. You can then
evaluate the relationship scheme to determine how to repair the assembly. For
example, you can delete the affected relationships and apply new relationships to
fully position the part.

Suppressing assembly relationships

You can use the Suppress command on the shortcut menu to temporarily suppress
an assembly relationship for a part. Suppressing an assembly relationship allows
you to use the Drag Part command to evaluate how the part interacts with other
parts in the assembly. When you suppress an assembly relationship, the symbol for
the part in the top pane of PathFinder changes to indicate that the part is no longer
fully positioned. Also, a symbol is added adjacent to the suppressed relationship in
the bottom pane to indicate that the relationship is suppressed.

Note

You can use the Unsuppress command on the shortcut menu to unsuppress
the relationship

Displaying document status in PathFinder

You can display the document status for components in PathFinder. For example,
in an Insight-managed document, the status can be Available, In Work, In Review,
Released, Baseline or Obsolete. The Status®Display Status command on the
PathFinder shortcut menu turns on and off the display of symbols adjacent to the
document names in PathFinder. For more information, see the Displaying and
updating status for documents in assemblies Help topic.
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Legend
Available

In Work

In Review

Released

Baselined

Obsolete

Dashed line in the bottom pane

Often a dashed line is displayed between sets of relationships in the bottom pane of
PathFinder. The relationships above the dashed line were applied to parts that are
above the selected part in the top pane of PathFinder. The relationships below the
dashed line were applied to parts that are below the selected part in the top pane
of PathFinder. You can edit the relationships above the dashed line and below the
dashed line. For example, when you select Valve01.asm, the relationships above the
dashed line were applied to Body01.par, which is above Valve01.asm in the top pane
of PathFinder. The relationships below the dashed line were applied to Handle01.par
and NutM15.par , which are below Valve01.asm in the top pane of PathFinder.
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Managing relationships in nested assemblies

PathFinder does not display relationships applied outside the active assembly.
Before you can view, modify, or delete an assembly relationship from a nested
subassembly, you must first open or in-place activate the subassembly where the
relationship was applied.

You can use the top pane of PathFinder to determine at which level in a multi-level
assembly a particular part was placed. You can then select the subassembly in the
top pane of PathFinder and use the Open or Edit commands on the shortcut menu to
open or in-place activate the subassembly to modify or replace the relationship.

For example, assembly A1 in the next illustration was built using part P1 and
subassemblies S1 and S2. Subassembly S1 was built using parts P2, P3, P4 and
P5. Subassembly S2 was built using parts P6 and P7. If you want to change
a relationship used to position part P5, you have to open or in-place activate
subassembly S1.

You can find part P5 by viewing the assembly in the top pane of PathFinder, as
shown in the next illustration. Since part P5 is indented under subassembly S1, you
would have to open or in-place activate subassembly S1 in order to view, modify, or
remove any relationships that control part P5.
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Assembly relationships

When placing a part or subassembly into an assembly, you must define how the
part will be positioned with respect to the other parts in the assembly by applying
assembly relationships. Available relationships include ground, mate, planar align,
axial align, parallel, connect, angle, cam, gear, tangent, and center-plane.

In addition to the traditional assembly relationships listed above, the FlashFit
option reduces the steps required to position a part using the mate, planar align, or
axial align relationships.

The relationship options and FlashFit are located on the Relationship Types list
on the Assemble command bar.

Part positioning workflows

Solid Edge provides several workflows for positioning parts in an assembly:

• FlashFit

• Traditional Workflow

• Reduced Steps

• Capture Fit

Note

New users should focus on learning both FlashFit and the Traditional
Workflow. As your expertise in building assemblies increases, you can explore
the other workflows available. All the workflows are discussed in more depth
later in this topic. The Slider tutorial demonstrates FlashFit capabilities.
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Maintaining assembly relationships

By default, Solid Edge maintains the relationships with which you position the part.
If the Maintain Relationships command is set on the Parts Library shortcut menu
when you place a part, the relationships that you apply also control the behavior of
the part when it is modified. For example:

• If you apply a planar align relationship between two parts, they remain aligned
when either part is modified.

• If you apply an axial align relationship between two parts, they remain axially
aligned when either part is modified.

Note

You can view, modify, and delete assembly relationships using the Assembly
PathFinder tab.

If the Maintain Relationships command is cleared when you place a part, you must
still use assembly relationships to position the part in the assembly. However,
instead of applying these relationships on the part, the software applies a ground
relationship. Grounded parts do not update their positions in the assembly when
other parts are modified.
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Capturing design intent

To fully control one part in relation to the other parts in an assembly, you must
use a combination of assembly relationships. There is often more than one way to
apply relationships that will position a part correctly. It is important to choose the
way that best captures design intent, because this makes your assembly easier
to understand and edit.

It may be helpful to keep in mind how the part will react to future modifications
when positioning a part. Although the part may be positioned correctly using a
particular set of assembly relationships, it may not behave as you expect when
modifications are made.

As you gain experience placing parts in an assembly, you may find it useful to make
minor design modifications and observe how the parts in your assembly react. If
the assembly does not behave as you expect, you can delete the relationships and
reapply them using a different approach. As you become more experienced, it will
become easier to see which set of relationships correctly positions the parts, and
gives you the behavior you want when design modifications are made.

Assembly relationships and part movement

When a part is fully positioned in an assembly, it cannot move in any direction in
relation to the assembly. The first assembly relationship you place controls some
part movement, but the part is still free to move in some direction by sliding along
or rotating around the X, Y, or Z axes.

Applying more relationships controls more movement until the part is fully
positioned. The types of relationships you apply and the options you use determine
how the relationships control part movement.

FlashFit

As discussed earlier, the FlashFit option reduces the steps required to position
parts using mate, planar align, and axial align relationships when compared to the
traditional workflow. Because many parts are positioned using these relationships,
FlashFit is appropriate in most situations.

When you position a part using FlashFit, you first select a face or edge on the
placement part. You then select a face or edge you want on the target part and let
the inference logic built into Solid Edge determine the most likely relationship,
based on the target part element.

For example, if you choose a planar face on the placement and target parts, the
software assumes that you want to establish a mate or planar align relationship.
When you select the target part element, the placement part is positioned in the
assembly using the closest solution.

• If the two faces you select are closer to a mate solution, a mate relationship is
applied.
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• If the two faces you select are closer to a planar align solution, a planar align
relationship is applied.
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A Flip button on the command bar allows you to select the alternate solution. You
can also use the Tab key to select an alternate solution.

When using FlashFit to position a part, it is displayed translucent to make it easier
to differentiate from the other parts in the assembly.

When possible, FlashFit moves the first part you select when applying the
relationship, and the second part remains stationary. If the first part you select is
fully constrained, the second part will move.

You can then use FlashFit to define the additional relationships required to fully
position the part in the assembly, or select another relationship type.

Note

When placing a subassembly using FlashFit or the Reduced Steps mode, the
parts in the subassembly must be active before you can select a face. If the
subassembly is not already active, you can use the Activate Part button on the
Assemble command bar to activate the placement part in the subassembly
which contains the face you want to select.

FlashFit also allows more flexibility to use edges, in addition to faces, when
positioning a part using mate, axial align, and planar align relationships.

This can be especially useful when positioning a fastener, such as a bolt into hole.
For example, when positioning a part using an axial align relationship, you cannot
use a circular edge to position a part. With FlashFit, you can use a circular edge on
both the placement part and target part to completely position the part in two steps.

FlashFit options

The Options dialog box on the command bar allows you to set the FlashFit options
you want to use. For example, you can specify the element types you want FlashFit
to recognize when placing a part. This allows you to tailor the behavior of FlashFit
for the part you are currently placing.

Moving and rotating parts with FlashFit

When using FlashFit, you can also move or rotate the placement part into a more
convenient location. To move the part, position the cursor over the part and drag
the cursor.

To rotate the part, press the Ctrl key while dragging the cursor. If any relationships
have been applied to the placement part, the movement or rotation is limited to the
available degrees of freedom.
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Traditional part positioning workflow

The traditional workflow walks you through every step required to position a
part using assembly relationships. For new users, this allows you to gain a full
understanding of the part positioning process. A command bar, which is unique to
each relationship, guides you through the positioning process.

The traditional workflow is also preferred when positioning parts using relationships
that FlashFit does not recognize, such as angle, cam, parallel, and tangent
relationships.

Reduced steps

The Reduced Steps option eliminates the part selection and accept steps in the
traditional workflow. You can set this option using the Options dialog box on
the Assemble command bar. When the Reduced Steps option is set, you specify
the placement part and target part by selecting a face on each part. This reduces
the number of steps from five to three for a typical mate relationship. There is
some trade-off when using this option. Since the part in the assembly is no longer
selected as a separate step, surfaces or cylinders on every active part are available
for selection.

In large assemblies or in assemblies with numerous overlapping parts, positioning
one part precisely to another can prove time consuming. In such cases, use QuickPick
to filter the selection process.

Note

When this option is set, you must specify the offset type and offset value before
selecting the target face. If you want to use a reference plane on the target part
to position the placement part, you must display the reference planes first.

Capture fit

The Capture Fit command captures the assembly relationships and faces used to
position a part or subassembly in the active assembly. When you place the part or
subassembly again, you simply select the faces on a new target part already in the
assembly to position the new part or subassembly. This reduces the number of steps
required to position the part.

If you used the Insert option to position a part, the Capture Fit command will
capture a mate and an axial align relationship, since these are the relationships
that the Insert option actually places.

You can also capture relationships by setting the Automatically Capture Fit When
Placing Parts option on the Options dialog box on the Assemble command bar.

Note

The Capture Fit command cannot capture Angular relationships.
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Defining offset values

Some relationships let you define fixed or floating offsets between the parts, such
as the mate and align relationships. To specify an offset type, click one of the two
offset buttons on the command bar. When you specify a fixed offset, you can type
a dimensional value for the offset distance. For example, when you define a fixed
offset for a planar align relationship, you can edit the value so that the parts are no
longer co-planar.

A floating offset is useful when you need to control the orientation of a part with
respect to another part, but it is impossible to define a fixed dimensional value.
For example, you can use a floating offset to control the rotational orientation of a
part. When you apply an axial align relationship using the Unlock Rotation option
between a cylindrical shaft and the cylindrical face on another part (A), you can then
use a planar align relationship, with a floating offset (B), to control the rotational
orientation of the shaft.

If you try to apply a fixed offset for the planar align relationship, a message is
displayed, saying that the fixed option conflicts with another relationship.

Note

The range offset command is not intended to be used to for geometric
tolerances. Depending on the relationships used to position the part are
defined, this may result in an over constrained condition and cause errors.
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Locking and unlocking rotation on axial align relationships

When you apply an axial align relationship, you can use the Lock Rotation and
Unlock Rotation buttons on the command bar to specify whether the part is free to
rotate around the axis of rotation. The Lock Rotation option is useful when the
rotational orientation of the part is not important, such as placing a bolt into a hole.
When you set the Lock Rotation option, the rotational orientation of the part is locked
at a random position, but one less relationship is required to fully position the part.

When you set the Unlock Rotation option, you can define the rotational orientation
you want by applying another relationship. For example, you can apply an angle
relationship.

Assembly relationship dimensions

When positioning parts using assembly relationships, driving or driven dimensions
are created and displayed when appropriate. For example, when you position a part
using a mate relationship with a fixed offset, a driving dimension is created.
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When you position a part using a mate relationship with a floating offset (the offset
value is controlled by another relationship), a driven dimension is created, which
cannot be edited to reposition the part. Zero and negative value dimensions are
supported.

When you apply or edit an assembly relationship, you can select and edit the driving
dimension to change the offset value. You can use the Show All Dimensions option
on the Options dialog box on the command bar to control whether the dimensions
are displayed or hidden. When you set this option, dimensions display when you
select a part and then click the Edit Definition button on the command bar. You can
then select a dimension and edit its value using the command bar. When you clear
this option, no dimensions are displayed, except for when you select a relationship
in the bottom pane of PathFinder. When you select a relationship in the bottom
pane of PathFinder, the dimension is displayed and selected, which allows you to
edit its value using the command bar.

Dimensions are only created when appropriate for the relationship options you are
using. Dimensions are created when using the mate, planar align, connect, angle,
tangent, and parallel relationships. Dimensions are not created when using axial
align, ground, or cam relationships.

Assembly Relationship Assistant command

When working with assemblies whose parts are oriented correctly, but do not have
assembly relationships, such as assemblies that were imported into Solid Edge from
another CAD system, you can use the Assembly Relationship Assistant command
to apply relationships between the parts and subassemblies. The relationships are
applied based on their current geometric orientation. For more information, see the
Assembly Relationship Assistant command Help topic.

Differences between assembly relationships and sketch relationships

The relationships that you apply between the parts and subassemblies of an
assembly differ from the relationships that you apply while working with part
sketches. For example:

• There are no relationship handles added to the assembly to show that a
relationship has been applied. Instead, the relationships between parts are
shown in PathFinder.

• Except for the ground relationship, all assembly relationships are defined
between the part or subassembly you are placing and a part or subassembly
already placed in the assembly.

• You cannot use dimensioning commands to place relationships between parts
and subassemblies in an assembly.
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Positioning parts using coordinate systems

You can also position parts in an assembly using coordinate systems. You do this by
first defining coordinate systems in the part document on both the placement and
target parts. You can then use the Planar Align relationship, Mate relationship,
and Match Coordinate Systems option on the Assemble command bar to position
the placement part.

For example, with the Match Coordinate Systems option, the placement part is
positioned using planar align relationships that match the three principal axes on
the coordinate system for the placement part and the target part. This allows you to
position the placement part using fewer steps than applying three separate planar
align relationships. This can be useful when working with a common part that is
placed into an assembly multiple times in the same position relative to a target part.

Capture Fit command

Captures the assembly relationships and faces used to position a part or subassembly
already placed in the assembly. You can then place the part or subassembly again
later using fewer steps. You can use the Capture Fit dialog box to specify which
relationships you want to capture.

If you used the Insert option to position a part, the Capture Fit command will
capture a mate and an axial align relationship, since these are the relationships
that the Insert option actually places.

You can also capture relationships by setting the Automatically Capture Fit When
Placing Parts option on the Options dialog box on the Place Part command bar.

Note

The Capture Fit command cannot capture angular relationships.

Capture Fit dialog box

Capture the assembly relationships for a part

1. In the assembly window, select a part for which you want to capture relationships.

2. Choose Home tab®Relate group®Capture Fit .

3. In the Capture Fit dialog box, use the Add and Remove buttons to specify which
relationships you want to capture, and then click OK.
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Tip

• You can also select the part you want to use in PathFinder.

• When you use the Capture Fit command, the relationships and faces used
to position the part or subassembly the first time are stored so you can
place the part using fewer steps later.

• If you used the Insert option to position a part, the Capture Fit command
will capture a mate and an axial align relationship, since these are the
relationships that the Insert option actually places.

• The Capture Fit command cannot capture angular, cam or center-plane
relationships.

• You can also capture relationships by setting the Automatically Capture
Fit When Placing Parts option on the Options dialog box on the Place
Part command bar.

Activity: Placing parts using mate, planar align, and axial align

Positioning parts with mate, axial align, planar align and insert

Overview

This activity shows the process of positioning parts using mate, axial align, planar
align and insert. The parts will be positioned with the reduced steps option turned
off to better understand the workflow options in the command bar. Then the same
parts will be placed with the reduced steps option turned on to show how the process
can be streamlined.

Note

FlashFit is a preferred method of quickly positioning parts in an assembly
and will be covered in another activity. This activity forces you to manually
position parts so that you will understand what is occurring when parts are
positioned using flashfit and how to change a single relationship to reposition
a part if an edit is later required.

Objectives

Parts will be added to an assembly using the commands mate, planar align, axial
align and insert

In this activity you will:

• Learn how to position parts using the commands mate, axial align, planar align
and insert without using reduced steps.

• Learn how the command bar reflects the workflow during the positioning of parts.

• Use reduced steps to position parts with mate, planar align, axial align, and
insert.
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Activity

In this activity you will learn the procedure for positioning parts in an assembly
using the mate, planar align and axial align relationships.

Overview

This activity will position a part with reduced steps turned off to show the complete
sequence of steps involved in positioning a part. The second part will be placed with
reduced steps turned on to show a more efficient method of positioning parts.

Create a new assembly and position the first part

In this step, you will create a new assembly using the Synchronous ISO Assembly
template. You will click the Parts Library on pathfinder and browse to the folder
containing the assembly class files.

▸ Create a new assembly. After the assembly opens, click the Application button.

Choose Solid Edge Options, and then click the assembly tab. Check the box
as shown.
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▸ From the Parts Library in PathFinder, drag the part dome.par in the assembly
window.

Note

The first part placed in the assembly is placed as a grounded part.

Applying a mate relationship

In this step you will drag the part a1_part.par into the assembly window and apply a
mate relationship.

▸ Click the Options button on the command bar.

▸ Set the options shown and then click OK. Make sure the reduced steps option is
off and FlashFit as the default placement method is off.
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▸ Select the Mate Relationship.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. Notice the step is currently the Placement
Part - Element step and you are being prompted to select an element of
the placement part. For this relationship, select a face.

▸ Select the face shown.

Note

The command bar shows the Target Part step is active, and you are being
prompted to select the target part. This part has the face you will apply
the mate relationship to. If you selected the wrong face in the previous
step, you can back up by clicking the button corresponding to that step
and then select the proper geometry again.
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▸ Select the target part, dome.par as shown.

Note

Notice the Target Part - Element step is active, and you are being
prompted to select the target part element. This element is the face the
mate relationship will be applied to.
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▸ Select the face shown on dome.par.

▸ Right-click or click the OK button to accept. The mate relationship is applied.

Applying a planar align relationship

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 2 will be a planar align.

▸ Set the relationship type to Planar Align.

Note

The Locate Steps group on the command bar reflects the current placement
step in the workflow. For this relationship, you will select a face.
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▸ Select the face shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This part has the face you will apply the
planar align relationship to.
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▸ Select the target part shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. Select the element that is the face you
will apply the planar align relationship to.
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▸ Select the face shown.

▸ Right-click or click the OK button to accept. The planar align relationship is
applied.

Applying an axial align relationship

The relationship list increments to the next relationship. Relationship 3 will be
an axial align.

▸ Set the relationship type to Axial Align

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. For this relationship, you will select a
cylindrical face.
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▸ Select the cylindrical face shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This part has the cylindrical face you will
apply the axial align relationship to.
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▸ Select the target part shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This element is the cylindrical face you
will apply the axial align relationship to.
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▸ Select the cylindrical face shown.

▸ Right-click or click OK to accept. The axial align relationship is applied, and the
part is fully positioned.
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Applying a mate relationship with reduced steps

Another occurrence of the part a1_part.par will be placed. The sequence of steps will
be the same except reduced steps will be used.

Note

When the reduced steps option is used, the step for selecting the target part is
eliminated. Valid features on every part are available for selection and the
target part is determined from the part containing the feature. This option is
more efficient in most cases, however in large assemblies where an area can
be congested with many parts, it is desirable to have more control by manually
choosing the target part as was shown in the previous steps.

▸ From the Parts Library, drag the part a1_part.par into the assembly window.
You will apply a mate relationship.

▸ Click the Options button on the command bar.

▸ Set the options shown. Make sure the reduced steps option is on and FlashFit as
the default placement method is off.

▸ Select the mate relationship.

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select an
element of the placement part. For this relationship, you will select a face.
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▸ Select the face shown.

Note

Because the reduced steps option is set, the command bar reflects the
placement step in the workflow. Notice the step is now the target part
element, and you are being prompted to select the target part element.
This element is the face the mate relationship will be applied to. The
target part is automatically assigned and is the part on which the target
element belongs.
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▸ Select the face shown.

▸ The mate relationship is applied.

Note

Using reduced steps, there is no need to click OK to complete. Once the
target element is selected, the relationship is established.

Applying a planar align relationship with reduced steps

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 2 will be a planar align.

▸ Set the relationship type to Planar Align.

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select an
element of the placement part. For this relationship, you will select a face.

mt01413-s-1050 Solid Edge fundamentals 8-45



Lesson 8 Modeling assemblies

▸ Select the face shown.

Note

The command bar reflects the placement step in the workflow. Notice
the step is now the target part element, and you are being prompted to
select the target part element. This element is the face you will apply the
planar align relationship to.
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▸ Select the target part element shown.

The planar align relationship is applied.

Applying a axial align relationship with reduced steps

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 3 will be an axial align.

▸ Set the relationship type to Axial Align

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select
an element of the placement part. For this relationship, you will select a
cylindrical face.
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▸ Select the cylindrical face shown.

Note

The command bar reflects the placement step in the workflow. Notice
the step is now the target part element, and you are being prompted to
select the target part element. This element is the cylindrical face you will
apply the axial align relationship to.
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▸ Select the cylindrical face shown.

The axial align relationship is applied, and the part is fully positioned.
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Placing a fastener with the Insert command

Insert will be used to position a fastener in a hole.

Note

Insert requires a mate and an axial align. Once you have established these
relationships, the rotation of the axial align is locked and the part is fully
positioned.

▸ Drag the part 10mm_fastener.par into the assembly window.

▸ Select the Insert Command.

Note

The mate relationship will be established first, then the axial align.
Because of the number of faces to choose from, Quickpick will be used to
aid in the selection.

▸ Fort the mate relationship, select the face shown.

8-50 Solid Edge fundamentals mt01413-s-1050



Modeling assemblies

▸ Select the target face for the mate relationship as shown.

▸ For the axial align relationship, select the cylindrical face shown.
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▸ For the target face of the axial align, select the face shown.

▸ The fastener is placed and fully positioned, with the rotation locked. Click the
Select tool to exit. Close the assembly document without saving.

Summary

In this activity you learned the workflow for establishing relationships needed to
position parts in an assembly. You also learned that using the reduced steps option
streamlines the process of positioning parts.
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Activity: Placing parts in an assembly with FlashFit

Placing parts in an assembly using FlashFit

Overview

In this activity, FlashFit will be used to position parts in a valve assembly.

Objectives

The objective of this activity is for you to be able to use appropriate relationships to
position parts in an assembly.

Activity

In this activity you will learn the procedure for positioning parts in an assembly
using FlashFit to achieve the relationships of mate, planar align and axial align.

Overview

You will use FlashFit to position parts and subassemblies in completing the valve
assembly.
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Place the first part in the assembly.

Create a new assembly and place the first part.

▸ Create a new assembly file.
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▸ On the assembly PathFinder, click the Parts Library and drag st_v_housing.par
into the assembly window. The first part placed in a new assembly file is
grounded.

Use FlashFit to position the valve parts and subassemblies

Use FlashFit to position the valve parts. Before placing additional parts, set the
FlashFit parameters. Once the parameters are set, the part will be positioned.

▸ From the Parts Library, drag the subassembly st_v_handleball.asm into the
assembly window.

▸ Click the Options button on the command bar.
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▸ Set the Options shown and then click OK.

▸ Set the relationship type to FlashFit.

▸ On the command bar, click the Activate Part button.

Note

When positioning a subassembly using reduced steps, the parts making up
the subassembly come in as inactive. The parts containing the geometry
needed to position the subassembly need to be activated.
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▸ Select st_v_shaft.par to activate it. Right-click to exit the Activate command
and continue.
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▸ Select the circular edge shown. Use QuickPick for an accurate selection.

Note

Matching circular edges with FlashFit is the equivalent of using the
Insert command. A Mate relationship, and an Axial Align relationship
with locked rotation is created.
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▸ Select the inner lip of the center hole of the housing.

▸ The subassembly is positioned.
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Place the remaining parts

Place additional parts in the assembly until finished.

▸ Drag st_v_endplate.par into the assembly window.

▸ Use QuickPick to select the face shown.
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▸ Select the target face on the housing as shown. A Mate relationship is applied.

▸ The next two relationships will be established using alignment of holes in the
parts. Select the cylindrical face on the st_v_endplate.par as shown.
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▸ For the target, select the cylindrical face shown. An Axial Align relationship is
applied.

▸ For the last relationship needed to completely position the part, select the
cylindrical face shown.
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▸ For the target, select the cylindrical face shown. An Axial Align relationship
is applied and the part is positioned.

▸ Drag another occurrence of st_v_endplate.par into the assembly window.
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▸ Place st_v_endplate.par on the opposite side of the housing from the one just
place using the same procedure you used to place the previous part.

Note

FlashFit will assign either a mate or a planar align to flat faces based on
the closest orientation of the two faces being positioned. In this case, if a
planar align is assigned rather than a mate, use the flip button to change

the relationship type to a mate.

▸ Drag st_v_top.par into the assembly window.
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▸ Use FlashFit to position st_v_top.par as shown. The procedure is similar to the
one used to place the previous two parts.

▸ Drag 10mm_fastener.par into the assembly window.

▸ Using QuickPick, select the circular edge shown.
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▸ For the target, select the circular edge shown on the top cap. The fastener
is placed.

▸ Place additional occurrences of 10mm_fastener.par in the remaining holes on
the valve using the same procedure.

Note
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If FlashFit positions the fasteners incorrectly as shown, follow the steps
outlined to correct the placement. The reason for the incorrect placement of
the fastener is that FlashFit determines whether to apply a Planar Align or a
Mate relationship to the fastener based on the orientation of the face relative
to the placement face. If the part faces are closer to a planar align relationship,
then that is what is applied. Prior to selecting the circular edges in FlashFit,
the fastener can be rotated into the approximate desired orientation by
holding Ctrl while dragging it. This will result in correct placement and is
easier than correcting the placement using Flip outlined below.

• Click the Select command.

• Select the fastener.

• In the lower pane of PathFinder, right-click the Planar aAlign relationship,
and then click Flip.
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▸ This completes the activity. Close the assembly document without saving.

Summary

In this activity you learned how to place parts and subassemblies from a Parts
Library and position them in an assembly. FlashFit consists of the Mate, Planar
Align and Axial Align relationships and determines which is appropriate. When
using FlashFit and selecting circular edges, fasteners can quickly be positioned
because the rotation of the fastener is locked and the part becomes fully constrained.

Lesson review

Answer the following questions:

1. What are the steps required to apply a mate relationship without using flashfit
or reduced steps?

2. What is the difference between mate and planar align?

3. What is a floating offset?

4. Are linear edges valid for the placement of an axial align relationship?

5. When using reduced steps, which step is eliminating when creating a
relationship?
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Lesson summary

In this lesson you learned the workflow for establishing relationships needed to
position parts in an assembly. You also learned that using the reduced steps option
streamlines the process of positioning parts.

More Assembly Relationships

More Assembly Relationships

Positions the selected part or subassembly into the active assembly. Parts are
positioned in assemblies using a combination of assembly relationships.

Relationship List
Lists the relationships applied to the part. You can replace a previously applied
relationship by selecting a relationship from the list and then selecting a new
relationship from the Relationship Types list.

Relationship Types
Lists the assembly relationship types you can apply. Parts can be positioned
using the following relationship options:

Mate Apply a mate relationship between parts

Modify the fixed offset value for a mate relationship

Mate command

Mate command bar
Planar
Align

Apply a Planar Align Relationship Between Parts

Planar Align command

Planar Align command bar
Axial
Align

Apply an Axial Align Relationship Between Parts

Axial Align command

Axial Align command bar
Insert Insert a Part in an Assembly

Insert command (Assembly Environment)

Insert command bar
Connect Apply a Connect Relationship Between Parts

Connect command (Assembly environment)

Connect command barr
Ground Apply a ground relationship to a part in an assembly

Ground command
Angle Apply an Angle relationship between parts

Angle command

Angle command bar
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Tangent Apply a Tangent Relationship Between Parts

Tangent command (Assembly environment)

Tangent command bar (Assembly Environment)
Cam Apply a Cam Relationship Between Two Parts

Cam command

Cam command bar
Parallel Apply a parallel relationship between two parts in an

assembly

Parallel command (Assembly environment)

Parallel command bar
Center-PlaneApply a Center-plane relationship

Center-plane command

Center-Plane command bar
Match
Coordinate
Systems

Position a Part in an Assembly By Matching the Coordinate
Systems

Match Coordinate Systems command

Match Coordinate Systems command bar
Gear/MotionPlace a gear relationship

Gear command

Gear command bar
Path Place a path relationship

Path command

Path command bar
Rigid Place a Rigid Set relationship

Rigid Set command

Rigid Set command bar

Note

The Insert option applies a mate relationship with a fixed offset value and
an axial align relationship with its rotational value fixed.
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Connect Relationship

Applying a connect relationship

When two parts in an assembly cannot be positioned properly by mate and align
relationships, you can position them using connect relationships. A connect
relationship positions a keypoint on one part with a keypoint, line, or face on another
part. For example, you can apply a connect relationship to position the center of a
spherical face on one part with respect to a spherical face on another part.

You can use the following methods to apply connect relationships:

• Point-to-Point: In the following figure, a mate relationship is applied between
the mitered corners of the parts. A connect relationship, which ties a point on
one part to the appropriate point on another, connects the two corners properly.
A floating align relationship between the back surfaces fully positions the part.

• Point-to-Line: In the following example, a mate relationship is applied between
the faces of the two parts. Because the sides of each part are drafted, there are
no part faces which you can use to apply a planar align relationship. You can
apply three connect relationships between the keypoints on the top part and
the linear edges on the bottom part.
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• Point-to-Plane: In the following example, the lower right pin is positioned to a
depth that just touches the surface of a reference plane.

• Cone-to-Cone: In the following example, the cone on the fastener is connected
to the cone on the countersunk hole on the plate. When you add a connect
relationship between two conical faces, the keypoint that represents the
theoretical intersection of the individual cones are connected. You can also apply
an offset value to a connect relationship between two conical faces.
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Activity: Positioning assembly parts using the connect relationship

Positioning assembly parts using the connect relationship

Overview

The objective of this activity is to position a part in an assembly using the connect
relationship.

Activity

In this activity you will use the connect relationship to position a part. The faces of
the parts have draft angles and because of this the connect relationship will need
to be used rather than the planar align relationship.
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Overview

This activity shows several options available that are used to position parts within
an assembly using the connect relationship.

Objectives

An assembly with several unconstrained parts will be opened. The Connect
relationship will be used to position the parts.
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Open the assembly

Open the assembly containing the parts to be positioned, and you will set the desired
parameters.

▸ Open Connect.asm and activate all the parts.

▸ Click the Application button. Click Solid Edge Options, and then click the
Assembly tab. Check the box as shown.

Position the lid by connecting 3 points

Use the Connect relationship to position the lid. Position the lid by connecting three
of the corner arc centers together. This will completely position the lid.

Note

The connect relationship recognizes key topological features to position parts.
Like the axial align option, linear edges can be connected. Endpoints and
midpoints of linear elements are valid for connecting, as well as arc and circle
centers.

▸ Set the display to Visible and Hidden Edges. By exposing the hidden edges,
locating desired geometry is more efficient.
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▸ Click the Select command, and then select the lid shown.

▸ To position the part, select the part with the select tool and then click the edit
definition button.

▸ Set the relationship type to Connect.
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▸ Select the point on the arc center of the lid as shown.

▸ Select the corner of the other lid shown as the target point for the first
relationship.
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▸ Repeat these steps for any two of the remaining three corners. The lid is then
completely positioned.

Use spherical faces to define a connect relationship

Position the center of the sphere on the knob to the center of the half sphere
depression in the lid. This shows how spherical faces can be positioned using the
Connect relationship.

▸ Click the Select tool and select the knob. Then click the Edit Definition
Command as shown.

▸ Set the relationship type to Connect.
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▸ Select the face of the sphere on the knob as shown.

▸ As the target, select the face shown. You may need to use QuickPick to make
the selection more efficient.

Note

The center of the sphere on the knob is now connected to the center of the
spherical depression on the face. The knob has freedom to pivot about this
point. Other relationships, such as Mate with a floating offset can be used
to exactly position the knob.
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▸ As an optional step in this activity, use the Mate relationship to completely
position the knob as shown. You may also want to use the parts reference planes
to help position the knob. Close the assembly without saving. This completes
the activity.

Summary

In this activity you learned to use the Connect relationship to position a lid using
points, and to position a knob by connecting sphere centers together.

This activity is complete.

Activity: Positioning assembly parts using the angle relationship

Positioning assembly parts using the angle relationship

Overview

The objective of this activity is to position a part using the angle relationship.

Activity

In this activity you will position a part using the angle relationship, then modify the
value of the angle and observe the change in position.
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Overview

This activity shows several options available that are used to position parts within
an assembly using the Angle relationship.

Objectives

An assembly with unconstrained parts will be opened. The Angle relationship will
be used to position the parts.
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Open the assembly

Open the assembly containing the parts to be positioned, and then set the desired
parameters.

▸ Open Angle.asm with all the parts active.

Create a connect relationship

To position the lid, the first relationship you establish will be the Connect
relationship.
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▸ Click the Select command and select the part shown. Then click the Edit
Definition button as shown.

▸ Select the Connect relationship.
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▸ Select the vertex point shown.

Note

You may have to rotate the view to better identify the point.

▸ For the target, select the vertex point shown.

Create an axial align relationship

Use the Axial Align relationship for the second relationship.
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▸ Click the Axial Align relationship.

▸ Select the linear edge shown.
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▸ For the target, select the linear edge shown.

Position the lid using the angle relationship

Use the Angle relationship to position the lid. Once placed, the angular value will be
able to be modified to reposition the orientation of the lid.

▸ Select the Angle Relationship.
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▸ Select the face shown as the face to measure to.

▸ Click the face shown as the face to measure from.
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▸ When prompted to click on a plane in which the angle measurement will lie,
click the edge shown.

Note

The Angle measurement is established.

▸ Click the Select tool.

Edit the angle

Edit the angle and the position of the lid will change.

▸ Press Ctrl+R on the keyboard to rotate the view to a right view.

▸ In PathFinder, select lid.par:2 and then, in the lower pane, select the Angle
relationship.

Note

Variable names and angle values may differ from the picture shown. This
is not a problem.
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▸ On the Placement command bar, click the Angle Format list, and then move the
cursor over the eight options. Notice the difference in how the angle is measured
in each of the different options.

▸ Click the Angle format which gives the measurement shown below. Change
the angle to 90°.

▸ Change the angle to different values and observe the behavior. Change the
angle to 190°.

▸ On the ribbon, choose Tools tab®Variables to display the Variable Table. Notice
this angular value is shown here and can be edited from the Variable Table. Also
the angular value can be driven via a formula to other values within the table.
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▸ This completes the activity. Close the assembly document without saving.

Summary

In this activity you learned to use the Angle relationship to position a lid, and modify
the value of the angle to change the position of the lid.

This activity is complete.

Lesson review

Answer the following questions:

1. Give an example of why a connect relationship would be used to position a part
rather than mate or planar align relationship.

2. Give some examples of valid geometry that can be used to create a connect
relationship.

3. Give some examples of connect relationship combinations.

Lesson summary

In this lesson you learned to use the Connect relationship to position a lid using
points, and to position a knob by connecting sphere centers together.

The Assemble command

The Assemble command

The Assemble command is an alternative method of positioning multiple parts in an
assembly that have been placed in an assembly, but that are yet to be positioned.
Utilizing Flashfit techniques, the Assemble command allows changing parts with a
right mouse click.

Assemble command

Positions parts in an assembly. You can use this command to position a single part in
an assembly, or you can use this command to position several parts relative to each
other without fully constraining each part in an ordered sequence.

This type of workflow can make it easier to position a set of interrelated parts, such
as when building a mechanism.
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After dragging and dropping a set of parts into an assembly, you can use the
Assemble command to apply relationships between one of the parts and one or more
target parts. To position a different part, click the right mouse button.

To position a series of parts using the Assemble command, you first drag and drop
the set of parts into the assembly using the Parts Library tab.

If it is a new assembly, the first part is automatically grounded. When you drag and
drop the second part into the assembly, the Assemble command bar is displayed, but
you can continue to drag and drop parts into the assembly without positioning them.

After the set of parts is placed in the assembly, you can use the Assemble command
to position the parts.

When you click the Assemble command, the Assemble command bar is displayed.
You can use the FlashFit option to apply a mate, planar align, or axial align
relationship, or choose from the complete set of ordered relationships.

After you apply a relationship between two parts, the first part you select (A)
remains selected so you can apply additional relationships to the part.
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To position a different part, click the right mouse button. You can then select a
different part (A) and apply the relationships you want.

The Assemble command is tightly integrated with the FlashFit positioning option.
When you click the Assemble command, FlashFit is the default option. For more
information on FlashFit, see the Assembly Relationships topic.

Assemble command bar

Activity: Assemble command

The Assemble command

Overview

The objective of this activity is to understand how to position parts using the
Assemble command.

Activity

In this activity you will learn how to use the Assemble command.
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Overview

When you complete this activity, you will be able to position parts in an assembly
using the Assemble command. This activity teaches how to use the Assemble
command to manipulate and fully position parts in an assembly.

Objectives

The activity consists of the following:

• Settings that affect the Assemble Command

• Manipulation and positioning of parts using the Assemble Command

• Editing and error recovery
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Note

Positioning parts with the Assemble command:

There are many ways to correctly assemble the parts and subassembly
associated with this activity. You will not be given specific instructions on how
to assemble these parts other than the order in which to assemble the parts.
How a part is positioned using FlashFit is predictable. With the Assemble
command however, parts can be positioned incorrectly or over constrained.
This activity will purposely position a part incorrectly so that the steps to
correct the positioning will be covered.

The rules on the behavior of the Assemble command are listed next. You will
be instructed to use these rules where appropriate.
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Note

Assemble Command guidelines

The following guidelines are used in positioning the parts in this assembly
using the Assemble command.

• In the assembly you will be working with valve_housing.par which was
placed first and is grounded. The other parts will be positioned relative
to this previously positioned part.

• FlashFit is the default assembly relationship creation mode and should
be used.

• Once you select a part to position, it will become transparent. Once
it is fully positioned, or another part is selected, it will no longer be
transparent.

• If, in the middle of positioning a part, you decide to position another part,
right-click to release the current part. It will no longer be transparent.
The next part you select will then become transparent.

• If you work in wireframe, rather than shaded, you will not have the
visual benefit of the selected part being transparent. For that reason, it
is suggested that you use Shaded with Visible Edges display mode while
using the Assemble command.

• Once a part is selected, it can be dragged to a new position with the left
mouse button. The selected part is the part you are applying relationships
to. Right-click to release the part.

• To rotate a selected part that is unconstrained, use Ctrl + left mouse
button.

• FlashFit will determine whether to use a Mate or Planar Align
relationship based on the closest orientation of the faces being matched. It
is good practice to rotate the selected part into the approximate position
before selecting the faces. After FlashFit, if the faces are 180° out of
position, click the Flip button on the command bar.

• Matching circular edges will quickly position a part, such as a fastener,
in one operation. The centerlines are superimposed and the rotation
is locked. You can unlock the rotation by editing the relationships in
Assembly PathFinder. Refer to the section of this activity that addresses
editing and error recovery.
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Assemble command setup

Open assemble.asm making all the parts active by using the settings shown in the
open dialog box.

▸ Choose the Home tab->Assemble group->Assemble command..

▸ Click the Options button on the command bar.

8-96 Solid Edge fundamentals mt01413-s-1050



Modeling assemblies

▸ Set the options shown below, then click OK.

Note

The behavior of positioning faces with FlashFit will first be shown. For
other parts, edges will be used.

▸ Click Shaded with Visible Edges.

Assemble the parts beginning with the top cap

Move the parts to their approximate final position. Select a part to move. The part
will become transparent. With the left mouse button, drag the part to the position
shown. Right-click to release the part and left-click to select a different part to drag.
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▸ Position all the parts approximately as shown.

▸ Right-click to release the last part selected. Select the top cap. Zoom in on the
top face of the valve housing. Using FlashFit, mate the bottom face of the top
cap to the top face of the valve housing as shown.
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▸ Select the cylindrical face of a hole on the top cap, and then select the cylindrical
face of a hole in the top of the valve housing, as shown.

▸ To completely position the part, repeat the previous step beginning with a
different cylindrical face in the top cap, and a corresponding cylindrical face in
the valve housing. Once the part is completely positioned, it will become shaded
and no longer be transparent.

Position the first fasteners on the top cap

Position the first fastener on the top cap.
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▸ To begin positioning the next part, select the face shown of one of the fasteners.

▸ Select the face of the top cap as shown.
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▸ FlashFit determines whether to apply a mate or planar align relationship based
on the orientation of each of the faces. If the fastener is placed reversed, as
shown, click Flip on the command bar to correct.
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▸ Select the cylindrical shaft of the fastener and the cylindrical face of the
corresponding hole. The fastener is positioned in the hole, but is transparent
because there is freedom in the axis defined by the center of the shaft.
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▸ Select the flat face on the head of the fastener as shown, and then select the face
on the top cap as shown. The bolt rotates such that the planes become parallel
and a floating offset is applied which locks the rotation of the bolt.
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Position the other fasteners using edge selection

You will now position other fasteners by using FlashFit and selecting circular edges.

▸ Click the options button on the command bar and set the options as shown.
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▸ Position the fastener using the edges shown below.

Note

Positioning by matching circular edges completely constrains the part by
fixing the rotation. This is the preferred method.
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▸ If the fastener becomes oriented as shown, it is because the original orientation
of the faces of the fastener was closer to a planar align relationship rather than a
mate relationship.

Note

Because the part is completely constrained, the Assemble command
has released this fastener and is ready to position another part. The
fastener has become shaded indicating it is fully positioned. To position
this fastener correctly, you will need to temporarily exit the Assemble
command by clicking the Select tool. Once the fastener is positioned
correctly, click the Assemble command to continue positioning parts.

▸ If the fastener was placed upside down, select the fastener. It will become
transparent. Select the mate relationship, click Flip, then click OK to correctly
position the fastener.
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▸ To position the remaining two fasteners, use these steps. Click the Assemble
command and select one of the remaining fasteners. To rotate the fastener into
the approximate vertical position, click and hold Ctrl while you left-click and
then drag.

▸ Position the fastener by selecting the same circular edges as the previous part.
The fastener will be oriented correctly because the orientation was close to the
final position. Right-click to clear the selection when done.

Position the handle subassembly

You will now position the handle subassembly by using FlashFit and selecting
circular edges.
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▸ Position the subassembly handle and ball.asm by selecting the circular edges
as shown.
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▸ Use the Assemble command and the techniques learned from the previous steps
to position each endcap into the correct position on the valve housing. This
completes this activity. Close the assembly document.

Summary

In this activity you learned how to use the Assemble command to quickly assemble a
group of parts into an assembly. If all the parts making up an assembly are placed in
an assembly window, the Assemble command can be used to complete the positioning
of the parts into the final assembly.

This completes the activity.

Lesson review

Answer the following questions:

1. How do you move an unconstrained assembly component when using the
assemble command?

2. How do you rotate an unconstrained assembly component when using the
assemble command?

3. How do you select a different assembly component to position without exiting
the assembly command?
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Lesson summary

In this lesson you learned how to use the Assemble command to quickly assemble a
group of parts into an assembly. If all the parts making up an assembly are placed in
an assembly window, the Assemble command can be used to complete the positioning
of the parts into the final assembly.

Designing in the context of an assembly

Designing in the context of an assembly

When designing in the context of an assembly, you can construct the parts with
either ordered or synchronous geometry based on which is appropriate for the
desired outcome.

In the activity, you will experience designing parts in context of a top level assembly
using the tools provided.

Activity: Designing in the context of a synchronous assembly

Designing in the context of a synchronous assembly

Overview

The objective of this activity is to explore designing in the context of an assembly
with Solid Edge synchronous technology. You will open an existing assembly and use
adjacent parts to refine the sizing and spacing of the faces and parts in the assembly.
You will also used geometry from one part to create a cavity in an adjacent part.

Activity

In this activity you will learn how synchronous technology can be of benefit when
designing in the context of an assembly.
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Overview

In this activity, you will modify parts in the context of the assembly using Solid Edge.
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Open the assembly

Open spindle_cover.asm with all the parts activated.

Note

Click the Select command and click on each part in PathFinder. Each
relationship that has been used to position the assembly can be viewed by
moving the cursor over the relationships in the lower pane of PathFinder.
These existing assembly relationships as well as Live Rules are honored when
manipulating geometry with Solid Edge.

▸ Open spindle_cover.asm. Activate all the parts.

Modify the plastic part to make the brackets fit

The brackets holding the axle do not fit correctly on the plastic cylindrical part,
and the face of the plastic part that the brackets attach to is not wide enough to
accommodate the brackets. You will modify the parts in the context of the assembly
to correct these problems.

▸ Set the Selection Priority to Face.
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▸ Select the face shown with the steering wheel in the position shown.

▸ Select the additional faces shown. You should have a total of 4 faces selected.
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▸ Select the axis of the steering wheel as shown.

▸ On the QuickBar, select the circle center key point.
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▸ Click the circular center of the end face of the axle. The 4 faces will move.

Note

Because symmetry about the base reference planes is set in live rules, the
parts are modified on the opposite side as well.

▸ Clear the Selection.

Shorten the brackets

Because the brackets are too tall, the axle is too far out from the plastic housing.
You will shorten the bracket.
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▸ Select the face and the cylinder shown. Move the origin of the steering wheel
to the face shown.

Note

The steering wheel can be relocated by dragging the origin knob which
is the large sphere at the center.
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▸ Drag the primary axis on the steering wheel so that the bracket becomes shorter.
Enter 30.00 mm. The axial alignment between the bracket and the axle force
the axle to stay aligned with the hole in the bracket.
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Note

The axle moves with the bracket because of the axial align relationship
used to place the axle.

▸ Clear the Selection.

Create clearance between the bracket and plastic housing

The face of the plastic part is too close to the bracket. You will move the face inward.
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▸ Select the face shown.

▸ Rotate the view to a right view and move the face somewhere between the
bracket face and the next face on the shaft. Exact placement is not important.
Because the part is symmetrical about the base, Live Rules are controlling the
behavior such that the opposite face is also positioned correctly.

In-place activate the plastic part and create inter-part geometry for cutting the part

After in-place activating the plastic part, inter-part faces and an inter-part body will
be created from other parts in the assembly.
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▸ Clear the select set.

▸ Set the selection criteria to Part.

▸ Double-click the plastic part to in-place activate the part. You are now in the
part environment but can still see the other parts in the assembly.

Note

Using Inter-Part Copy, you will copy needed geometry from the assembly.
You need two planar faces to create bolt holes in the plastic part to attach
the brackets. You will also need the body of beltdrive.par.
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▸ Click the Inter-Part Copy command.

Note

Linked Inter-Part copies of surfaces can only be created in the ordered
environment. The Inter-Part surface created for this exercise does not
need to be linked and we will stay in the synchronous environment for
this operation.

▸ Select the bracket.
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▸ In the Select Faces step in the command bar, select Face. Select the face shown.

▸ Accept and then click Finish. Repeat for the opposite side.
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▸ Click the Inter-Part Copy command and select the part shown.
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▸ In the Select Faces step in the command bar, select Body. Select the whole
body shown.

▸ Accept the body, then click finish. The body is created.

Cut the plastic part using the inter-part faces

The two inter-part faces and the inter-part body, and a cutout will be used to cut the
plastic part.

▸ Click the View tab and in the Show group, click Hide Previous Level. This will
turn off the display of the other parts in the assembly

mt01413-s-1050 Solid Edge fundamentals 8-125



Lesson 8 Modeling assemblies

▸ Click the Sketching tab. Lock the sketch plane to the face containing the
inter-part copies. Click Project to Sketch and select each of the 4 holes on the
two Inter-Part faces.

▸ Hide the Inter-Part Copy faces, used to create the holes, in PathFinder. Click the
Extrude command. Create cutouts from each of the holes.
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▸ Now you will draw a sketch for the first cutout in the housing. Select the sketch
plane shown.
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▸ Draw the sketch below and create an open cutout that extends the full length of
the part.

Note

In the Relate group on the ribbon, use the Equal relationship to make
the lines the same length. The angle between the lines is 120o. Use the
Horizontal/Vertical relationship to line up the ends of the lines vertically.
Intellisketch may put a perpendicular relationship at the intersection of
the two lines. You will need to delete that relationship in order to get
the 120o driving dimension placed.
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The part is shown.

▸ Click the Surfacing tab. In the Surfaces group, click the Offset command.
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▸ In the Select step in the command bar, set Select to Body. Select the Inter-Part
Copy shown and accept.
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▸ Enter 3.00 mm for the offset distance. For the direction, click as shown. Then
click Finish.
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▸ The offset surface is shown. Notice it is bigger than the Inter-Part Copy.

Note

If the offset is smaller than the original part, you have chosen the wrong
direction and will need to repeat the operation.

▸ Turn off the Inter-Part Copy of the body in PathFinder.

▸ Click the Surfacing tab. In the Surfaces group, click the Boolean command.

▸ In the command bar in the Tool Step, set the select to Body and click Subtract.

▸ Select the offset surface and accept. Then click Finish.
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▸ Hide the offset surface in PathFinder.

The part is as shown.
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▸ Click the Home tab and then click Close and Return to return to the assembly.
The assembly is as shown.

Modify the angle of the opening in the plastic part

Now you will modify the angle of the angular cut in the plastic face.

▸ Set the Selection Priority to Face.
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▸ Select the face shown and move the steering wheel so that the primary axis
aligns with the axis of the axle as shown.
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▸ Select the steering wheel torus as shown and rotate with the mouse. Notice the
angle of the cut in the plastic part changes.

Note

Make sure the 120o dimension is unlocked so the face can move

This completes the activity.

Summary

In this activity you learned how to modify parts in the context of an assembly
using Solid Edge.

Lesson review

Answer the following questions:

1. What is one advantage to modeling assemblies using synchronous components?

2. Can synchronous components in an assembly be copied using the steering wheel?

3. When using the steering wheel to move or copy an assembly component, when
can live rules be used?

Lesson summary

In this lesson you learned how to modify parts in the context of an assembly using
Solid Edge.
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Drafting

Course Overview

The Drafting course focuses on creating and editing drawings of 3D models. Upon
completion of this course, you will be able to:

• Create drawings

• Add views to a drawing

• Create dimensions

• Create annotations
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Drawing production

Drawing production overview

Overview

Drawing production is the process of formally documenting the design of a part or
assembly. Solid Edge gives you a variety of tools that allow you to easily document
designs during any stage of drawing production. You can create associative drawing
views of 3D parts and assemblies that you can quickly update when the part or
assembly changes. You can also create drawing views that consist of 2D elements
drawn from scratch that you can quickly change without making changes to a part
or assembly document.

A combination of the above methods also gives you the ability to meet the changing
demands of your workflow. You can place an associative drawing view, which you
can update when the model changes. Then, when you want to make changes to the
drawing document without changing the model, you can convert the associative
drawing view to a 2D element drawing view.

• Create a part drawing

• Create an assembly drawing

You can make a 2D drawing in Solid Edge using two types of drawing views: part
views and 2D views. The 2D drawing can contain dimensions and other annotations
that describe the size of a part or assembly, the materials used to create it, and
other information.
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Drawing View Types

When working from a 3D model, you can create the following types of drawing views:

• Principal views

• Auxiliary views

• Perspective views

• Detail views (dependent and independent)

• Section views

• Broken views

• Draft quality or high quality views

• Exploded assembly drawings

When working with Solid Edge 2D Drafting, you cannot create 3D views that require
a 3D model: section views, broken-out section views, and detail views.

9-4 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Drawing Production Workflow

The first step in drawing production is composing the drawing. Drawing composition
involves setting up a drawing sheet and creating part views or 2D views of a selected
part or assembly.

When you create a part view, Solid Edge applies visible and hidden line styles to part
edges. You can change the styles and the way they are applied to the part edges
after placing the part view. When you create a 2D view, you can use line styles and
formats to create a hidden-line display.

You can complete the drawing by adding detail information such as dimensions
and annotations.

Use the following workflow to produce drawings in Solid Edge:

Step 1: Create a new document using a draft document template.

Step 2: Set up drawing sheets.

Step 3: Do one of the following:

• Place a part view using the View Wizard command.

• Place an assembly view using the Create Drawing command.

• Place a 2D view using the 2D Model command.

Step 4: Create additional part views or drawing views.

Step 5: Adjust the display of visible, hidden, and tangent edges on the drawing
views.

Step 6: Add dimensions and annotations. You can also edit the format of the
displayed dimensions to apply tolerances or make other modifications.

Step 7: Print (plot) the 2D drawing.

Create a part drawing

Workflow to create a part drawing
Use the following process to produce a drawing from any Solid Edge part or sheet
metal document (.par and .psm file types).
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1. Open a new draft document using the ISO Draft template.

2. Use the View Wizard command to define and place primary part views.

3. (Optional) Create additional views as needed.

• Auxiliary views

• Detail views

• Section views

• Broken views

• Draft quality views

4. Dimension the part views. For example, you can:

• Retrieve dimensions and annotations from the model.

• Use the Smart Dimension command to add dimensions.

5. Annotate the part views. For example, you can use these commands to annotate
the model:

• Place a balloon.

• Place a callout.

• Place a feature control frame or datum frame.

• Place an edge condition symbol.
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• Define a weld symbol.

• Place a Surface Texture Symbol.

• Automatically create centerlines and center marks in a drawing view.

• Use the Edge Painter command to redraw, show, or hide part edges.

• Use the Text command to add notes to the drawing sheet.

6. Save the draft document.

7. Print a document.

8. When the model changes, drawing views go out-of-date. Do either of the
following:

• Use the Update Views command to update views of the model, indicated
by gray borders.

See Drawing view updates to learn about these features.

• Use the Dimension Tracker dialog box to Review changed dimensions and
annotations.

See Tracking dimension and annotation changes to learn about these
features.
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Create an assembly drawing

You can choose model representations defined in the assembly model to show in a
drawing view, such as an exploded model display configuration or a PMI model
view. Use the following process to create an isometric drawing view of an exploded
assembly with a ballooned parts list. You can do this from the assembly model or
from a draft document.

1. Start the Drawing View Wizard

In the assembly document, do the following:

a. Save the assembly document.

b. From the Application menu, select the New®Create Drawing command.

c. In the Create Drawing dialog box, select the Run Drawing View Creation
Wizard check box and click OK.

2. Choose an assembly model representation

In the Drawing View Creation Wizard (Drawing View Options), select one of the
following from the .cfg, PMI model view, or zone list:

• To create an exploded isometric model view, select an exploded model display
configuration , and then click Finish.

To learn how to create an exploded model configuration, see Explode an
assembly automatically.

• To communicate design, manufacturing, and functional information that has
been added to a saved view of the model, select a PMI model view name
, to Create a PMI drawing view.

To learn how to create a PMI model view, see Create a PMI model view.

• To create a user-defined view of the equipment and components in a

rectangular area of a large assembly model, select a zone name , and
then click Next.

• If there is no predefined model representation to select, or to create any
combination of user-defined assembly views, select No Selection, and then
click Next.

3. Place a user-defined view on the sheet

If the Drawing View Creation Wizard (Drawing View Orientation) page is
displayed:

a. Select a named view, such as isometric, as the principal view.

b. Click Next to choose additional views, or click Finish.

c. Click the drawing sheet to place the view(s).
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Tip

Predefined PMI model views and display configurations are placed on
the drawing automatically.

4. After placing the view, you can do any of the following:

• Adjust the assembly display

Use the Display page (Drawing View Properties dialog box) to control the
display of the individual parts and subassemblies in the assembly.

To learn more, see Creating drawings of assemblies.

• Retrieve model dimensions and annotations

o If the drawing views are orthographic, you can use the Retrieve
Dimensions command to extract dimensions and annotations from the
model onto the drawing.

o If the drawing views are pictorial (isometric, dimetric, or trimetric), you
can use the Smart Dimension command to Place a 3D dimension on a
pictorial drawing view.

5. Add a ballooned parts list

Use the Home tab®Tables group®Parts List command to Create a parts list.

Tip

• To place a parts list that shows the assembly model item numbering
schema in the table and in the balloons, select the Use assembly
generated item numbers check box on the Options page (Parts List
Properties dialog box. If this option is unavailable, you need to set the
Create item numbers check box on the Item Numbers page (Solid
Edge Options dialog box).

• You can rearrange balloons that have been generated automatically
with a parts list, so that all of the balloons are visible. To learn how,
see Stack balloons.

• If parts are missing in a parts list or a drawing view for an assembly,
verify that the missing parts are not turned off in the assembly
document Occurrence Properties dialog box. To learn how, see Display
assembly occurrences in a drawing view or parts list.

• You can create a drawing view of an alternate assembly

Create an alternate position assembly drawing view

When an assembly contains mechanisms like linkages and actuators that change
position during the physical operation of the assembly, these may be defined as
alternate position members in an alternate position assembly model. When you
use the View Wizard to create a drawing view of the assembly, you can choose the
different positions you want to show in the drawing view.
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1. In the Draft document, choose the Home tab®Drawing Views group®View

Wizard command .

Tip

To create an alternate position assembly drawing view from an
assembly document, select the New®Create Drawing command from the
Application menu. In the Create Drawing dialog box, ensure that the Run
Drawing View Creation Wizard check box is selected.

2. In the Select Model dialog box, select an assembly that has alternate positions
defined in it.

3. In the Drawing View Creation Wizard (Alternate Position Assembly), select
one Primary position check box, and then select one or more Alternate position
check boxes.

You can click the names in the Member Name column to see a preview of the
assembly in each position.

4. In the Drawing View Creation Wizard (Assembly Drawing View Options), click
Next.

5. In the Drawing View Creation Wizard (Drawing View Orientation), select a view
orientation to apply to the drawing view.

6. Click Finish to place a single drawing view, or if you want to place additional
views on the sheet, click Next, and then choose the views in the Drawing View
Creation Wizard (Drawing View Layout).

7. On the drawing sheet, click where you want to place the view.

Tip

• The model position that you designate as the primary position contains
the parts that are auto-ballooned when you create a parts list and shaded
when you apply shading and grayscale.

• After the drawing view is placed, you can select the Set Primary and
Alternate Positions command on the drawing view shortcut menu, and
then add and remove members from the view, and change primary and
alternate position designations.
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Set Primary and Alternate Positions dialog box

Use the Set Primary and Alternate Positions dialog box to show or hide assembly
members in a selected alternate position assembly drawing view. If you change the
member selections, you must update the view.

Note

This dialog box is displayed when you select the Set Primary and Alternate
Positions command from the shortcut menu of an alternate position assembly
drawing view.

Member Name
Displays the names of alternate position members in an alternate position
assembly drawing view. You can click a member name to see what the member
position looks like in the preview pane.

Primary
Selects an alternate position member as the primary member in the drawing
view. One primary member is required.

The primary position parts are auto-ballooned when you create a parts list and
shaded when you apply shading and grayscale.

Alternate
Selects one or more additional alternate position members to display in the
drawing view.
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Documenting multiple parts in one Draft document

Solid Edge allows you to document multiple parts or assemblies in a single draft
document. This can be an advantage when working with an assembly. For example,
instead of creating a separate draft document for the assembly and each part, you
can use the Drawing View Wizard command to place drawing views of the assembly
document and the individual part documents into one draft document. This makes
document management and maintenance much simpler.

The Drawing View Wizard command tracks the parts and assemblies that you place
in a draft document. You can click the Drawing View Wizard command to place the
drawing views of the first part or assembly. The next time you click the command
the Select Part dialog box is displayed. The Select Part dialog box displays the
documents that are currently placed in the draft document in a folder tree structure.

If you have placed an assembly document, you can select a part in the assembly as
the basis for the next part view. If you want to create a part view for a part in a
different assembly, you can use the Browse button to find the part on your computer
or another computer on your network.
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Reference parts

Sometimes you may want parts or subassemblies to be included on a drawing, but
only for reference purposes. Reference parts typically provide a frame of reference
for the components in the drawing view to a higher level assembly or to a completed
product.

For example, when creating a drawing of the head subassembly (A) for a grinder,
you may want to display the case and switch (B) as reference parts to illustrate the
relationship between the head subassembly and the completed product.

You can specify that a part or subassembly is a reference part when you are placing
a part view of an assembly or you can edit the drawing view properties for the part
view later. The Display As Reference option on the Display tab of the Drawing
View Properties dialog box allows you to specify that a part or subassembly is
a reference part.

In an assembly, you can also use the Occurrence Properties command to specify that
an assembly occurrence is a reference part. You can then set the Derive "Display
As Reference" From Assembly option on the Drawing View Properties dialog box to
display the component as a reference part in the drawing.

Reference parts and parts lists

When creating a parts list of an assembly, you can use the Exclude Reference Parts
option on the List Control tab on the Parts List Properties dialog box to control
whether reference parts are included in the parts list.

Make a part a reference part

Step 1: In the Parts List on the Display tab of the Drawing View Properties
dialog box, select a part.

Step 2: Click the Display as Reference check box.

Tip

• You can exclude reference parts from parts lists on the List Control tab of
the Parts List Properties dialog box.

• You can control visible, tangent, and hidden edge line styles with the
Reference Parts controls on the Edge Display tab of the Options dialog box.
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Display reference geometry in a drawing view

1. On the Display tab of the Drawing View Properties dialog box, click the Parts
List Options button.

2. Select List Constructions, List Coordinate Systems, List Sketches, List
Reference Planes, or List Centerlines, depending on what you want to display
in the drawing view. You can also select List All to show all available reference
geometry in the view.

The selected reference geometry is added to the Parts List.

3. In the Parts List, highlight an object you want to display in the drawing view,
and select the Show check box.

4. Update the drawing view.

The reference geometry is displayed.

Tip

• Model files must be saved in Solid Edge version 15 or later for their
sketches and reference planes to display in the Parts List.

• If you list reference geometry without selecting the Show check box to
display it in the drawing view, the objects are not listed in the Parts List
the next time you use the Drawing View Properties dialog box. Use the
Parts List Options button again to add them back to the Parts List.

• Sketches are valid geometry with which to place 3D dimensions in
pictorial views.

• By default, reference planes and sketches use the Visible Edge and
Hidden Edge line styles on the Edge Display tab of the Options dialog box.
You can change the edge styles of reference planes and sketches with the
Display tab of the Drawing View Properties dialog box.

• If you list coordinate systems for a model on which mass properties
have been calculated, a center-of-mass coordinate system is available
for display in the Parts List.

Create a master draft in Insight XT

Saving a Solid Edge Draft to a separate Revision from the 3D model creates a master
draft or master drawing of the 3D model displayed in an open model document.

1. Save the current model (assembly, part, or sheet metal) file to SharePoint.

2. Choose Application menu®New®Create Drawing.

The Create Drawing dialog box is displayed.

3. Complete the Drawing View Wizard as required and click to place the drawing
on the sheet.
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The drawing contains a reference to the 3D model.

4. Save the drawing.

The New Document dialog box displays with properties associated with the
3D document.

5. Do one of the following:

• Click OK to save the draft to the same revision as the 3D model.

This is the traditional workflow. Draft documents are created in the same
URL, with the same Number, and Revision as the 3D model resulting in a
single Revision having a 3D dataset and the corresponding draft.

• Click Assign All or Assign to generate a new Number and Revision.

This choice creates a new document in the same folder as the 3D document.

• Chose a new URL, keeping the current content types and then Assign All or
Assign.

The new document resides in a different folder than the 3D model and has a
new Number and Revision.

• Chose a new URL, change the Part Content Type, and keep the existing
Number and Revision.

The new document resides in a different folder than the 3D model, but
retains the same Number and Revision as the 3D model.

Note

After making changes to the properties, you can click Restore in the New
Document dialog box to revert the properties to the initial contents.
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Drawing sheets

Drawing sheets

Drawing sheet overview
Drawing composition begins with choosing a drawing sheet. Drawing sheets are
similar to pages in a notebook. You can place drawing views on different drawing
sheets in the document. For example, you can place a front view and a right view
on one drawing sheet and a section view on another drawing sheet. Both sheets
are saved in the same document. To set up a drawing sheet, use the Sheet Setup
command on the Application menu.

All 3D model drawing views, dimensions, and annotations are placed on the active
working sheet, which has two components.

• The sheet outline (A) shows the orientation and print region of the sheet. You
can change the size and orientation of the sheet outline with the Sheet Setup
command.

• The area outside of the outline (B) is also part of the drawing sheet.

You also can draw, dimension, and annotate geometry on the 2D Model sheet, and
then create 2D model views of the 2D design and place them on the active working
sheet.

Use the following links to learn more about drawing sheets:

• Working sheets

• Background sheets

• Table sheets

• 2D Model sheet

• Manipulating sheets

• Sheet tab groups

• Sheet names and numbers

• Sheets and document templates

• Displaying drawing sheets in Draft Viewers

• Sheet scale and drawing view scale

Working sheets
The sheet where you place part views of the model and do all of your drawing view
construction is called a working sheet. You can create as many working sheets as
you need. Each working sheet has a background sheet attached to it.

Use the View tab®Sheet Views®Working command to show and hide all working
sheets.

You can modify the characteristics of a drawing sheet, such as sheet size and which
background sheet is attached, using the Sheet Setup command on the Application
menu. You can use the Save Defaults button in the Sheet Setup dialog box to save
your settings as the default for all new working sheets created in the document.

9-16 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Background sheets
A background sheet is used as a backdrop to the working sheet. You can attach the
same background sheet to any number of working sheets, making them useful for
any geometry that you want to place on more than one drawing.

• Use the View tab®Sheet Views group®Background command to show all
background sheets.

• Use the Background tab in the Sheet Setup dialog box to apply a background
sheet.

When you attach a background sheet to a working sheet with the Sheet Setup
command, geometry on the background sheet is displayed and printed along with
the working sheet. So that the paper sizes and graphics on both sheets line up, the
size of the working sheet is automatically set to the size of the background sheet you
attach. A typical customized scheme would be to have a different background sheet
for each standard-sized drawing (such as A, B, C, D, or A0, A1, A2, A3, A4).

Note

The graphics on the background sheet are not affected by drawing sheet scale.
They are always displayed 1:1 with respect to the working sheet.

For example, on the background sheet you can add a company-standard border
and title block, insert a raster image of your company logo with the Insert Object
command, or draw other geometry that you want to show in the background.

mt01413-s-1050 Solid Edge fundamentals 9-17



Lesson 9 Creating detailed drawings

Table sheets
Table sheets are working sheets that are inserted automatically in the sheet tab
tray to contain multi-page parts lists and tables. Table sheet tab names show the
table group number and the table sheet number within the group, for example,
Table1:1. When multiple sheets are inserted for the same table, the second sheet tab
name is Table1:2.

Table sheets can be used to organize long parts lists and tables into booklets for
easier printing. You can specify that table sheets are created for a new table or parts
list when you select the Create new sheets for table option on the Location tab in the
Properties dialog box.

You can use the Show sheet backgrounds option on the Location tab to control what
is displayed on the table sheets when they are generated. They can be blank sheets,
or you can display a table sheet template with a defined border and title block.

Example

To create a table sheet template, you can:

Step 1: Design a parts list title block that is sized for A Tall (8.5 x 11 inch)
paper.

Step 2: Place it on a working sheet, and then use the Background tab in
the Sheet Setup dialog box to associate a background sheet with
the template.

Step 3: Create a template that includes the background sheet and save it
to the C:\Program Files\Solid Edge ST5\Template\More folder.

To learn how to use table sheets when creating parts lists and tables, see Create
new sheets for tables.

You can use options on the View tab, Solid Edge Options dialog box (Draft) to specify
how the table sheets are named and arranged in the sheet tab tray. For example, you
can use the Number sheet groups separately option to keep table sheets together
in sheet tab tray.

To learn more, see Sheet names and numbers, below.

2D model sheet
The 2D Model sheet is a special sheet used exclusively for working in 2D model
space. It enables you to draw on the sheet and annotate at a scale appropriate for the
overall size of the part you are designing, yet it prints your drawing with annotations
appropriately scaled to the output sheet size you specify.

For example, you can drag a file containing 2D geometry—such as a Solid Edge
.dft document or an AutoCAD .dwg or .dxf file—onto the 2D Model sheet. You can
add annotations and dimensions using one drawing scale, then use the 2D Model
command in the Drawing Views group to create 2D views of your design that you
place on one or more working sheets at a different scale for printing.

Unlike working sheets, there is just one 2D Model sheet allowed per document. It is
always the first sheet in the document, and it cannot be renamed.

• Select the View tab®Sheet Views group®2D Model command to make this
sheet available.

• The scale of the 2D Model sheet is 1:1. To annotate and dimension at a different
scale than the scale of the printed drawing, without having to change the text
height before printing, use the Drawing Area Setup command on the Application
menu. This command automatically calculates the size and scale of your work
area on the 2D Model sheet based on the printout sheet size and the width and
height of your intended design.

• You can add a drawing border sheet to the 2D Model sheet. Use the Drawing
Area Setup command, and select one of the drawing border block files listed on
the Drawing Area dialog box in the Place Block list. Using the Drawing Area
Setup command ensures that the border is placed at the correct scale for the
paper it will be printed on.

If you are not concerned with scaling the border, you can drag a file containing a
drawing border onto the model sheet and click to place it.
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Manipulating sheets

You can use the sheet tabs located at the bottom of the drawing window in the
following ways:

• You can select and display a drawing sheet by clicking a tab. The name of the
displayed drawing sheet appears in bold.

• You can set up sheet options by double-clicking the sheet tab.

• You can right-click a drawing sheet tab to access the drawing sheet tab shortcut
menu. From this menu, you can insert, delete, reorder, and rename drawing
sheets.

You can use the following scroll buttons to scroll through the drawing sheet tabs.

Scrolls to the first drawing sheet tab in the document.
Scrolls to the last drawing sheet tab in the document.
Scrolls to the previous drawing sheet tab in the document. To scroll
through several tabs at a time, hold Shift, then click this button.
Scrolls to the next drawing sheet tab in the document. To scroll through
several tabs at a time, hold Shift, then click this button.

Sheet tab groups

Sheet groups collect similar types of sheets–such as working sheets, background
sheets, and table sheets—into groups in the sheet tab tray. Sheet tab groups are
displayed in alternating color groups in the sheet tab tray. This makes it easy to
find individual sheets and to print related sheets. For example, parts lists that span
multiple drawing sheets are grouped in the drawing sheet tab tray to facilitate
printing as a booklet.

You can change the default colors assigned to the sheet tabs using the following
options on the Colors tab (Solid Edge Options dialog box):

• Sheet tab 1—Specifies the sheet tab color of the 2D Model tab, the background
sheet tabs, and of alternating groups of working sheet tabs.

• Sheet tab 2—Specifies the sheet tab color of the primary working sheet tabs, and
for alternating groups of working sheet tabs.

Sheet names and numbers

Each sheet group has its own naming convention. Although you cannot specify how
names are assigned initially, you can rename individual sheets using the Rename
Sheet command on the sheet tab shortcut menu. Two sheets can have the same
name if they are located in different groups.

You can use the following options on the View tab, Solid Edge Options dialog box
(Draft) to specify how the sheets are named and arranged in the sheet tab tray.

• Number sheet groups separately—Keeps sheets of the same type grouped
together in the sheet tab tray. Working sheets, background sheets, and table
sheets are grouped and numbered independently of one another. Numbers are
assigned consecutively and automatically.
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Example

If there is one working sheet and four table sheets, then they are
numbered 1, followed by 1, 2, 3, 4.

This option also specifies that table sheets generated for one table are numbered
separately from the table sheets generated for a different table.

Example

When table sheets are produced for different tables, such as two different
parts lists, then the table sheets for each parts list are collected into
individual groups. The naming convention for the first table sheet group
is Table 1:1, Table 1:2, ...; the naming convention for the second table
sheet group is Table 2:1, Table 2:2, and so on.

• Display sheet number and name in tabs—Displays the working sheet number in
front of the sheet tab name.

Example

Working sheet numbers and names
1 - Sheet1

2 - Sheet2

Background sheet numbers and names
1 - A4-Sheet

2 - A3-Sheet

Table sheet numbers and names
1–Table1:1

2–Table1:2.

• Display sheet number in tabs—Displays only the sheet number. Use this option
to reduce the width of all tabs, making it easier to find a sheet.

Example

The following options are selected:

o Display sheet number in tabs

o Sheet tab 1 color (Light Aqua)

o Sheet tab 2 color (Light Orange)

You can create property text that references the sheet tab name or number and
display it in a callout. The help topic, Property Text source list (Source: From Active
Document), describes the property text that you can reference in the document.
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Sheets and document templates
You can reuse your customized background sheets by saving them in a document
template. When you use the template to create a new document, all of the
background sheets in the template are copied into the new document.

Displaying drawing sheets in Draft viewers
When you want to make your Draft documents available for review in Solid Edge
Viewer and View and Markup, you must specify the sheets to be included in the file.
Use the following check boxes on the General page (Solid Edge Options dialog box,
Draft environment), to select the sheet types:

• Include Draft Viewer data in file

o Include Working Sheets

o Include 2D Model Sheet

o Include Background Sheets

Select a drawing sheet

• Click the tab of the drawing sheet you want to activate.

Tip

• You can delete or rename a drawing sheet using the shortcut menu;
right-click while the cursor is over a sheet tab.

• You can double-click a drawing sheet tab to access the Sheet Setup dialog
box, or you can use the shortcut menu. To display the shortcut menu, click
the right mouse button while the cursor is over a sheet tab.

Scroll through drawing sheet tabs

• On the current drawing sheet, click a scroll button next to the drawing sheet
tabs. Clicking a scroll button displays the drawing sheet tabs so that you can
access them easily and select a drawing sheet. Click the scroll buttons of the
following picture to find out what each button does:

Note

Clicking a scroll button does not display a different drawing sheet. If the
document has only a few drawing sheets, the scroll buttons might not be
available.

Working Sheets command

Displays all working sheets in a document. If a background sheet is attached to the
working sheet, the graphics on the background sheet are displayed on the working
sheet. When you attach a background sheet to a working sheet, the software
automatically adjusts the size and the margin of the working sheet to match the
size and margin of the background sheet.
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Display background sheets

• Choose View tab®Sheet Views group®Background.

Change the background sheet

1. Choose Application menu®Sheet Setup.

2. On the Sheet Setup dialog box, click the Background tab.

3. Select a new background sheet from the list.

Tip

• When you change the background sheet, the size and margins of your
working sheet equal the settings of the selected background sheet.

• You can double-click a background sheet tab to access the Sheet Setup
dialog box, or you can use the shortcut menu. To display the shortcut
menu, right-click while the cursor is over a sheet tab.

Background Sheets command

Switches the view from a working sheet to the background sheet. When you set this
command, all of the background sheets in the document are displayed as tabs at
the bottom of window.

When you clear this command, all background sheet tabs are hidden, which prevents
other users from accidentally modifying them.

You can use a background sheet to draw graphics that you want to display on more
than one drawing sheet. For example, you can draw borders and title blocks that
contain your company logo, your name, and information about the drawings.
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You can display background sheet graphics on any or all working sheets, using the
Sheet Setup command.

Sheet scale

Sheet scale and drawing view scale

A sheet scale is a standard scale value for drawing views placed on the working
sheet. Typically, the sheet scale is indicated in the drawing border title block. When
you place a drawing view on the same sheet using a different scale, you can note
the exception scale value in a drawing view caption.

Only working sheets can have a sheet scale other than 1.0. Background sheets, the
2D Model sheet, and draw-in-view windows have their sheet scale fixed at 1:1.

Setting the sheet scale

You can set the sheet scale when:

• Placing the first view using the drawing View Wizard

When placing the first drawing view on the sheet using the View Wizard
command, you can specify the sheet scale from the View Wizard command bar
using the Set Sheet Scale option. When this button is selected, the sheet scale is
set automatically to the scale of the first drawing view—the principal or primary
view—placed on the drawing sheet. The same scale is applied automatically to
all subsequent views placed on the sheet. This ensures that the scale of all
drawing views on the sheet is consistent.

• Modifying views placed using other commands

When you place the first drawing view using a command other than the View
Wizard command, or when you have multiple views on a sheet with different
view scales, you can use the Set Sheet Scale command to set the sheet scale to
match any drawing view you select. This command is available from the shortcut
menu when a drawing sheet tab is selected.

• Removing sheet scale associativity
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You can see what sheet scale is currently assigned to the drawing sheet using
the Sheet Setup command. You can override a derived sheet scale by selecting
the Change the sheet scale manually check box and selecting or typing a new
scale value. This also removes the associativity between the first drawing view
and the sheet scale.

This command is available from the shortcut menu when a drawing sheet tab is
selected.

Showing the sheet name, number, and scale on the active sheet

You can use callouts and other types of annotations to extract and display property
text that identifies the sheet name, number, and scale of the active drawing sheet.

For example, you can place a callout on a shared background sheet, in the drawing
border title block, so that it displays the sheet scale on each working sheet. When
you place a drawing view on the same sheet using a different scale, you can note the
exception scale value in a drawing view caption. You can define the caption content
and control caption display using the Caption page (Drawing View Properties dialog
box).

To create a callout that extracts property text, such as the Sheet Name, Sheet
Number, and Sheet Scale properties, see the Help topic, Create property text. Many
other properties, such as file name, title, and author, can be extracted as well.

Drawing view scale

When you model a part or assembly, you can construct the model to the full scale of
the real-world object you are creating. The size of the working sheet determines the
scale you should use to display the 3D part or assembly. For example, the drawing
view scale for a front loader bucket part would be smaller if an A size sheet were
used, because the A size border is smaller than the D size.

By default, the View Wizard calculates the best fit for the drawing views based on
the model size and the sheet size. Part views, with the exception of detail views, have
the same scale as the model they are created from. Before you click to place the view,
you can use the View Wizard command bar to change drawing view scale:

• The default option—the Best Fit button—uses the size of the working sheet to
compute the best-fit scale value needed to display of the selected part. This scale
appears in the Scale box on the command bar.

• You can choose a different scale to apply to the drawing view using the Scale list
on the command bar.

• The Set View Scale button changes the scale of the drawing view you are placing
to match the current sheet scale.

Note

Aligned part views also share the same scale. To change the scale of an
individual part view, remove the alignment with the Unalign command on the
shortcut menu, and then use the Properties command on the shortcut menu to
set the scale you want.
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Dimensional values in drawing views

The dimensional values of the parts or assemblies in your part views measure the
actual size of the model. For example, if a hole feature in a part is 25 millimeters
and the drawing view scale is 2:1, when you dimension the hole feature, it will be 25
millimeters, not 50 millimeters. This means that you never have to worry about the
part view scale affecting the dimensional values when you are creating a drawing.

The dimension and annotation sizes in your working sheets are independent of the
drawing view scale. For example, if you define the height and size of dimension text
as 0.125 inch or 3.5 millimeters, these are the actual values of the dimension text
on the printed drawing.

Establishing a scaled work area on the 2D Model sheet

The scale of the 2D Model sheet is 1:1. However, you can set the size and scale of a
special work area where you can annotate and dimension at a different scale than
the scale of the printed drawing, without having to change the text height before
printing. The Drawing Area Setup command on the Application menu automatically
calculates the size and scale of your work area on the 2D Model sheet based on the
printed sheet size and the width and height of your intended design.

Set the drawing sheet scale

You can set the drawing sheet scale using either of the following workflows.

Set the sheet scale using the View Wizard

When using the drawing View Wizard command, the sheet scale is set automatically
to the scale of the first drawing view—the principal or primary view—placed on the
drawing sheet. The same scale is applied automatically to all subsequent views
placed on the sheet. This ensures that the scale of all drawing views on the sheet
is consistent.

1. Display a new working sheet.

2. Place a drawing view using the Drawing View Wizard by doing the following:

a. Choose the View Wizard command from the Drawing Views group.

b. Choose a model.

c. Select a view that you want to place.

d. Click Finish to close the View Wizard.

To learn how to do this, see Create drawing views of a part or assembly.

3. On the View Wizard command bar, do the following:

• Set the sheet scale to match the scale of the drawing view you are placing by

selecting the Set Sheet Scale button .
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• If the drawing view outline appears too large or too small, you can specify a
new sheet scale value using the Scale List on the command bar.

4. Click to place the view.

Tip

Instead of setting the sheet scale to match the drawing view, you can match
the drawing view to the sheet scale currently in use by selecting the Set View

Scale button .

Set the sheet scale using the Set Sheet Scale command

When you place the first drawing view using a command other than the View
Wizard, or when you want to base the sheet scale reported in the title block on a
different drawing view, use the Set Sheet Scale command.

1. Right-click the drawing sheet tab and choose the Set Sheet Scale command.

The Set Sheet Scale command bar is displayed. If a sheet scale was defined
previously, the value is shown on the command bar.

2. On the Set Sheet Scale command bar, do one of the following:

• To specify a sheet scale manually, click the User-Defined Sheet Scale button

, and then select a scale from the Scale list or type a scale in the Scale
value box.

• To derive the sheet scale from an existing drawing view, click the Drawing

View Scale button , and then click the drawing view that you want to use
to set the sheet scale.

If the sheet scale is already derived from a drawing view, that drawing
view is highlighted in the Select element color, and its scale is shown on
the command bar.

Example

You can use the sheet scale of the highlighted view, or you can click a
different drawing view.
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3. To apply the sheet scale, click Accept on the command bar.

Tip

• You can verify the current sheet scale by selecting the Sheet Setup
command from the shortcut menu when the sheet tab is selected.

The Sheet Setup dialog box also lets you change a user-defined sheet scale,
or remove the associativity between the sheet scale and a drawing view.

• You can use callouts and other types of annotations to extract and display
property text that identifies the sheet name, number, and scale of the
active drawing sheet. For example, you can place a callout on a shared
background sheet, in the drawing border title block, so that it displays the
sheet scale on each working sheet.

To create a callout that extracts the Sheet Name, Sheet Number, and
Sheet Scale properties, see the Help topic, Create property text.

• You can define the sheet scale and other content for a drawing view
caption using the Caption tab (Drawing View Properties dialog box).

Set Sheet Scale command

Using the Set Sheet Scale command

The Set Sheet Scale command serves several purposes:

• It sets the sheet scale for a new working sheet.

You also can do this by selecting the Sheet Setup command.

• It specifies the scale to be referenced in the Scale box of the title block. This is
useful when there are multiple drawing views with different view scales. For
example, you can use the Set Sheet Scale command to choose the drawing view
whose scale you want to reference via the %{SheetScale} property text string
placed in a callout in the title block.

• It lets you choose any drawing view—not just the first view placed on the sheet
using the View Wizard command—to be associative with the sheet scale. This is
useful when the first view placed on the sheet was created using copy and paste,
or through transfer from another sheet using the Drawing View Properties
dialog box. It is also useful when the view was created using the 2D Model
View command.

• It changes the drawing view that is associated with the sheet scale. For example,
you can choose a section view or a detail view to be associated with the sheet
scale.

• You can use the Set Sheet Scale command to see which drawing view is associated
with the sheet scale. That drawing view is highlighted in the Select element
color, which is defined on the Colors tab of the Solid Edge Options dialog box.
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You can undo or redo a sheet scale change.

Manual sheet scale mode

You can set the sheet scale manually by typing a scale value or selecting a scale

when you select the User-Defined Sheet Scale button on the Set Sheet Scale
command bar.

Changing a sheet scale manually does not change the drawing view scale of an
existing drawing view.

Associative sheet scale mode

You can use the associative sheet scale mode to derive the sheet scale from the scale
of an existing drawing view. This makes the sheet scale associative to the drawing

view scale. When you select the Drawing View Scale button on the Set Sheet
Scale command bar, you are prompted to select a drawing view with the scale you
want to use.

When a drawing view from which the sheet scale is derived is transferred to another
sheet, the sheet scale is reclassified as being user-defined. Similarly, when a drawing
view from which the sheet scale is derived is deleted, the sheet scale is reclassified as
user-defined.

Set Sheet Scale command bar

User-Defined Sheet Scale
When selected, sets the sheet scale when you select a value from the Scale list or
type a value in the Scale Value box.

Changing a sheet scale manually does not change the drawing view scale of an
existing drawing view.

Drawing View Scale
When selected, lets you choose an existing drawing view to apply its scale to the
sheet. Eligible view types are principal (pictorial and orthographic), auxiliary,
section, detail, broken-out section, broken, 2D model, 2D detail, and Quicksheet
template views.
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You can select a drawing view and then look at the values shown on the
command bar to see its scale. In this manner, you can match the sheet scale to a
specific drawing view.

Scale
Selects a scale value to apply to the working drawing sheet. This does not affect
other sheets in the document.

Scale Value
Defines the working drawing sheet scale based on a value you type.

If the Scale Value results in a scale that is not currently available, it is added
to the Scale list in the form of 1:X or X:1 where X is determined numerically by
the Scale Value.

Example

If you enter 5, then the sheet Scale list is set to 5:1. If you enter 1/3, then
the sheet Scale list is set to 1:3.

Reset
Resets the scale to a previous value or to another drawing view you select.

You can use Reset to remove associativity with a drawing view by selecting the
drawing view and then selecting this button.

Accept
Applies the current scale to the sheet. You also can right-click or press Enter.

Applying a sheet scale does not affect existing drawing views.

Add custom drawing view scales to Solid Edge

Predefined drawing view scales are displayed in the Scale list in many different
locations in the user interface, including the Drawing View Wizard, the Drawing
View Properties dialog box, and the Drawing View Selection command bar.

In addition to selecting a predefined drawing view scale from the Scale list, you can
type a custom drawing view scale in ratio format in the Scale box, and you can type a
decimal value in the Scale Value box.

If you want to include a standard set of custom drawing view scales in your draft
documents, you can add them to the custom.xml file, which is located in the Program
folder. All of the default English and metric drawing view scales that are provided
with Solid Edge are read from this file.

1. Open the custom.xml file in a text editor or XML editor.

The default location of this file is C:\Program Files\Solid Edge ST5\Program.

2. Scroll to the section of the file that begins with this tag:
<DrawingViewScales version="1">

Below this are two sets of predefined drawing view scales, English and metric.
They are formatted like this:

<DVScaleSet name=”English”>
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<DVScale value=”100:1”/>
<DVScale value=”80:1”/>

<DVScaleSet name=”Metric”>
<DVScale value=”50:1”/>
<DVScale value=”20:1”/>

3. Keeping the same format, add your custom drawing view scales to the
appropriate list. Any drawing view scale that employs positive numbers is valid.

Example

For example, both “3:2” and “2.5:0.5” are valid values. If an entry in is
invalid, it does not appear in the drawing view scale list in Solid Edge.

4. Save and close the file.

Creating sheets

Create a new drawing sheet

• Position the cursor over a sheet tab at the bottom of the drawing window, and
then right-click and choose Insert Sheet.

o If you position the cursor on a working sheet tab, the sheet created is a
working sheet.

o If you position the cursor on a background sheet tab, the sheet created is
a background sheet.

Tip

You can attach a background sheet to any drawing sheet using the Sheet
Setup command on the Application menu. Click the Background tab on the
Sheet Setup dialog box to find the background sheet settings.

Create a background sheet

This procedure explains how to create a background sheet and then attach it to a
working sheet in the document.

1. Choose View tab®Sheet Views®Background to display the default background
sheets.

At the bottom of the window, you should see a colored sheet tab for each
background sheet. They are labeled with the sheet size, such as A4-Sheet and
A3-Sheet.

The word BACKGROUND appears as a non-printing watermark stamped on
each background sheet.

2. Right-click a background sheet tab and choose Insert Sheet.

A new background sheet is created using the default drawing sheet settings.

3. Right-click the new background sheet tab and choose Sheet Setup.
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4. In the Sheet Setup dialog box, set the options you want.

5. Add content to the background sheet as you want it to appear.

6. Right-click a working sheet tab and choose Sheet Setup.

7. In the Sheet Setup dialog box, click the Background tab.

8. From the Background sheet list, select the name of the background sheet you
just created to attach the new background sheet to the working sheets.

Tip

• You can change the default color of background sheet tabs on the Colors
tab (Solid Edge Options dialog box).

• You can open the Sheet Setup dialog box by double-clicking a sheet
tab or using the sheet tab shortcut menu, or you can select it from the
Application menu.

• You can delete or rename a background sheet using the shortcut menu;
right-click while the cursor is over a sheet tab.

• You can save background sheets in a template for easy access. Create
the background sheets in a new document, then save the document to a
template folder. Use the Solid Edge Options command on the Application
menu to specify the location of the template folder so that the templates
are available when you create new documents.

• You can use the Block command to create a reusable block from the
background sheet graphics. To add this background to the 2D Model
sheet, use the Drawing Area Setup command and select it from the Place
Block list.

• You can use the Block command to create a block from the background
graphics. To add this background to the 2D Model sheet, use the Drawing
Area Setup command and select it from the Place Block list.

Set up a drawing sheet

1. From the Application menu , choose the Sheet Setup command.

2. In the Sheet Setup dialog box, set the options you want.

Note

If you want to set up a background sheet, click the Background tab and
set the options you want.
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Tip

• You can save the sheet setup as a default using the Save Defaults button in
the Sheet Setup dialog box. The current settings will then be used as the
default settings for any new drawing sheets you create in the document.

• You can set options for an existing drawing sheet by double-clicking a
background sheet tab to access the Sheet Setup dialog box, or by using
the shortcut menu. To display the shortcut menu, right-click while the
cursor is over a sheet tab.

• You can change the default color of sheet tabs using options on the Colors
tab (Solid Edge Options dialog box).

• Drawing sheet tabs can be labeled with the sheet number, sheet name,
or both. You can set these options on the View tab, Solid Edge Options
dialog box (Draft).

• You can use callouts and other types of annotations to extract and display
property text that identifies the sheet name, number, and scale of the
active drawing sheet. For example, you can place a callout on a shared
background sheet, in the drawing border title block, so that it displays the
sheet scale on each working sheet.

To create a callout that extracts the Sheet Name, Sheet Number, and
Sheet Scale properties, see the Help topic, Create property text.

Rename a drawing sheet

Step 1: On the drawing sheet, click the tab of the sheet you want to rename.

Step 2: On the Application menu, click Sheet Setup.

Step 3: On the Sheet Setup dialog box, click the Name tab and type a new name
for the sheet you selected.

Tip

You can also rename a drawing sheet with the Rename command on the
shortcut menu when the cursor is over a drawing sheet tab.

Reorder drawing sheets

Step 1: Right-click on a drawing sheet tab.

Step 2: On the shortcut menu, click Reorder.

Step 3: On the Reorder Sheets dialog box, use the Move Up and Move Down
buttons to reorder the drawing sheets.

Delete a drawing sheet

1. At the bottom of the graphics window, position the cursor over the sheet tab
name you want to delete, then right-click to display the shortcut menu.
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2. On the shortcut menu, choose Delete Sheet.

3. Confirm the selection.

Tip

The Delete Sheet command deletes the active drawing sheet and any drawing
sheets whose drawing sheet tabs are selected.

Insert Sheet command

Inserts a new drawing sheet in the document using the default drawing sheet
settings. You can change the default settings using the Sheet Setup command.

You can create either a working sheet or a background sheet, depending upon which
sheet tab your cursor is on when you select the Insert Sheet command.

• Create a new drawing sheet

• Create a background sheet

Sheet Setup command

Defines the properties of the working sheet. You can display and modify the following
properties: name, size, scale, and margin. You also can select the background
sheet you want to use.

You can save the current settings to use when you create new working sheets in the
document. You can save settings only for displayed working sheets.

To display a working sheet, use the View tab®Sheet Views group®Working
command.

Sheet Setup Dialog Box

Defines the properties of the active drawing sheet.

Tabs
Size

Background

Name

Options
Save Defaults—Saves the current settings as the default values.

Name page (Sheet Setup dialog box)

Defines the name of a drawing sheet. You also can change the name of a drawing
sheet.

Sheet name
Specifies a name for a new drawing sheet.

You can also use this box to rename a drawing sheet by selecting the sheet tab in
the document before selecting the Sheet Setup command.
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Background page (Sheet Setup dialog box)

Defines the color, margin settings and background sheet display information.

Background Sheet
Specifies which background sheet you want to use for the working sheet.

All graphics on the background sheet are displayed on the working sheet.
Changing the background sheet causes the size and margin settings of the
working sheet to update to the values defined by the selected background sheet.

Show Background
Displays the background sheet graphics on the selected working sheet.

Preview
Shows you the result of your settings before you apply them.

Size page (Sheet Setup dialog box)

Defines the drawing sheet size and print setup information. The units shown are
derived from the Units page (File Properties dialog box).

Sheet Size
Sets the size for the drawing sheet.

Same as Print setup
Sets the drawing sheet size using the current print setup definition. For
example, if the printer is set up as 8 1/2 X 11, the drawing sheet size is
set up as 8 1/2 X 11.

Standard
Defines the drawing sheet size from a list of standard ANSI and ISO paper
sizes.

Custom
Defines the drawing sheet size according to the entered width and height
values.

Sheet Scale
Displays the sheet scale for the active working sheet.

The Scale and Scale value boxes are not available when the sheet scale is derived
from a drawing view. You can determine which drawing view is driving the
sheet scale using the Set Sheet Scale command. This command is available from
the shortcut menu when a drawing sheet tab is selected. When you select the
command, the drawing view that is shown in the Selected element color is the
one that is currently being used to set sheet scale.

Change the sheet scale manually
When this check box is selected, you can select a scale from the Scale
list or type a scale in the Scale Value box. This lets you set sheet scale
independently of drawing view scale. It also removes any existing
associativity between the sheet scale and a drawing view scale. It does not,
however, change any drawing view scales.
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Caution

Selecting this check box permanently removes the associativity
between the sheet scale and the drawing views on the sheet.

Scale
Sets the sheet scale of the working drawing sheet.

Note

Scale values are defined in the Drawing View Scales section of the
Custom.xml file, in the Solid Edge Program folder. See the Help topic,
Add custom drawing view scales to Solid Edge.

Scale value
Defines the working drawing sheet scale based on a value you type.

If the Scale Value results in a scale that is not currently available, it is added
to the Scale list in the form of 1:X or X:1 where X is determined numerically
by the Scale Value.

Example

If you enter 5, then the sheet Scale list is set to 5:1. If you enter 1/3,
then the sheet Scale list is set to 1:3.

Sheet scale is also set when placing a view with the Drawing View Wizard.
When the first drawing view is placed on a sheet using the Drawing View
Wizard, the sheet scale is set automatically to the scale of this drawing view.
All subsequently placed views assume the same scale. This ensures that the
scale of all drawing views on the sheet is consistent.

Delete Sheet command

Deletes the active drawing sheet and any other sheets whose tabs are selected.

You can delete either a working sheet or a background sheet with this command. To
delete a background sheet, set the Background Sheets command on the View tab
before selecting the Delete Sheet command. To delete a working sheet, clear the
Background Sheets command before selecting Delete Sheet.

Rename Sheet command

Renames a sheet.

Note

Before you can select this command from the shortcut menu, you must move
the cursor over a drawing sheet tab.

Rename dialog box

The Rename dialog box provides a fast method to rename a drawing sheet.

New Name
Renames the active sheet when you type a new name.
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Note

Another way to rename a drawing sheet is to use the Sheet Setup command.
This method has the advantage of letting you also change other sheet
properties, such as sheet size, print size, and background sheet.

Reorder Sheets command

Changes the order of the drawing sheets by allowing you to move them up or down
a list.

Reorder Sheets dialog box

Reorder Sheets dialog box

Sheets
Lists all of the drawing sheets.

Move Up
Moves the selected drawing sheet one position up in the list.

Move Down
Moves the selected drawing sheet one position down in the list..
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QuickSheet templates

Create Quicksheet Template command

Creates a template of drawing views that are not linked to a model. You can then
drag a model from the Library tab or from Windows Explorer onto the template,
and the views populate with the model.

To create a Quicksheet template, configure drawing views of the type and with the
properties you want, and then choose the Create Quicksheet Template command. A
message box is displayed advising you to save your current work before the drawing
views are emptied. When you click Yes, you can save the file with the name and
location you want, and the Quicksheet template is ready for use.

When you create a Quicksheet template, all drawing views on all sheets are emptied,
including parts lists. Almost all view properties, including general properties, text
and color properties, and annotation properties, are maintained. However, some
display properties, such as selected parts display, Show Fill Style, and Hidden Edge
Style, are not maintained.

Create a Quicksheet template

1. Configure drawing views of the type and with the properties you want.

2. Click the Application button .

3. From the Application menu, choose the Create Quicksheet Template command

4. Because the Quicksheet creation process empties all views, a message box is
displayed advising you to save your current work before the views are emptied.
Do one of the following:

• If you want to save your current linked drawing views, click No and save
the file.

• Click Yes to proceed with Quicksheet template creation.

5. Save the file with the name and location you want. If you saved work in the
previous step, be sure to save the Quicksheet template to a different file name.
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The Quicksheet template is now ready for use.

Tip

• When you create a Quicksheet template, any 2D views in the document
remain unchanged because they are not linked to any model.

• Almost all view properties, including general properties, text and color
properties, and annotation properties, are maintained. However, some
display properties, such as selected parts display, Show Fill Style, and
Hidden Edge Style, are not maintained.

Populate a Quicksheet template

1. Create a new Draft document using a Quicksheet template.

This can be one of the templates delivered in the Quicksheet directory with Solid
Edge, or one that you have created.

2. On the Library tab or in Windows Explorer, navigate to the model file that you
want to use.

3. Drag the model file onto the Quicksheet template. The template populates with
the model you selected.

Tip

• Dragging a model onto a parts list in Quicksheet template will repopulate
the parts list, as well as all associated views.

• Automatic ballooning will occur if it is a property of the empty view.

• If you drop a family of assemblies into a Quicksheet template, the first
listed assembly will populate it.

Create automatic drawing views

1. Ensure that an empty drawing sheet is displayed.

2. On the Library tab, or in Windows Explorer, navigate to the model file that
you want to use.

3. Drag the model file onto the drawing sheet. The drawing sheet populates as
follows:

• For assembly models, an isometric view is created, centered on the drawing
sheet.

• For all other models, top, front, and right views are created, centered on
the drawing sheet.
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Tip

• To run the Drawing View Wizard instead of create automatic drawing
views, press the Shift key while you drag the model file onto the sheet.

• You can create automatic drawing views in which the views and
properties can be customized by creating a Quicksheet template and
dragging a model file onto it.

• Drawing views are created with the default options for their respective
types.

• Scale and spacing for automatic drawing views are the same as if
the Drawing View Wizard was run and the same views (isometric for
assemblies; top, front, and right for other models) selected.

Drawing area setup on the 2D Model sheet

Drawing area setup on the 2D Model sheet

In a draft document, you can draw, design, annotate, and dimension on the 2D
Model sheet. The 2D Model sheet is a special sheet used exclusively for working in
2D model space. It enables you to draw on the sheet and to annotate at a scale
appropriate for the overall size of the part you are designing, yet it prints your
drawing with annotations appropriately scaled to the output sheet size you specify.

• To display the 2D Model sheet, select the View tab®Sheet Views group®2D
Model command, and then click the document sheet tab labeled 2D Model.

• To set the size and scale of your work area on the 2D Model sheet, select
the Application menu®Drawing Area Setup command. Work area setup
calculations are made automatically based on sheet size and the dimensions of
your intended design.

Define a 2D Model drawing area

This procedure creates a working area in 2D model space where you can draw,
dimension, and annotate your design at 1:1 scale and still maintain the correct
text height—either 0.125 inches (English) or 3.50 mm (metric)—for the printed
drawing sheet size.

Tip

If you are importing a design file, you can drag the file onto a working
sheet, click the Fit command to fit the design to the sheet, and then use the
Inspect®Measure Distance command to determine the true width or height of
the finished design. You can enter this value into the Width or Height field in
the Drawing Area dialog box, and then click the Calculate Scale button.

1. (Display the 2D Model sheet) From the ribbon, choose View tab®Sheet Views
group®2D Model, and then click the document sheet tab labeled 2D Model.

2. From the Application menu, choose the Drawing Area Setup command.
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3. In the Drawing Area dialog box, select the sheet size for the final printed
drawing.

4. In the Drawing Area dialog box, define the size of the 2D working area and
the scale required to create geometry and place annotations using one of these
methods: width x height or scale factor.

• (Option 1) Type the Width and/or Height of the part or assembly to be
created, and then click the Calculate Scale button.

• (Option 2) Type the desired Scale, and then click the Calculate Width-Height
button.

5. In the Drawing Area dialog box, set the Place Block option, and then select a
drawing border from the Place Block list.

Note

• If there are no blocks in the current document, or if you want to use a
border located in a different draft document, use the Browse button to
locate a file that contains the drawing border block you want to use,
and then select the border as described above.

• To choose a drawing border created specifically for the AutoCAD
environment, select one of the drawing border blocks from the
TitleBlocks.dft file located in the \Program Files\Solid Edge
ST5\Sample Blocks folder.

6. Click OK to close the Drawing Area Setup dialog box and continue.

7. (Place the border block) On the 2D Model sheet, click where you want to place
the bottom-left corner of the border.

8. (Optional) You can modify the current drawing border scale by typing a new
value in the Block Scale box on the command bar.

9. (Optional) If the Block Properties dialog box is displayed, you can type a new
value for the sheet number and number of sheets, or edit any of the information
displayed in the white cells. Click OK to dismiss the dialog box.

The border is placed at the correct scale to encompass the intended geometry.

10. Choose View tab®Orient group®Fit .

11. Do one of the following:

• Left-click to place the border in another location on the same sheet.

• Right-click to end the place block function.
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Tip

• You can edit the information in the drawing border title block by clicking
the Blocks tab in the Layers pane, and then right-clicking the border
block name and choosing Open. See the Help topic, Displaying blocks
in the Library.

• You can add geometry to the 2D Model Sheet using any of the following
methods:

o Drag an existing .dft file, .dwg file, or .dxf file onto the sheet.

o Use the drawing tools to add geometry to an existing design or to
create a new design from scratch.

• You can add annotations and dimensions or modify existing ones.

Note

o When you add a new annotation, you can override the current
text scale using the Text Scale control on the displayed
command bar. Changing the setting on the command bar
changes the scale for all new text added to the current sheet.

o Text height for existing annotations must be adjusted
individually. Select the annotation, then click Properties on its
shortcut menu. Changing the value in the Text Scale field on
the Properties dialog box affects only the currently selected
annotation text.

• To create 2D model views from your finished design, change to the
working sheet, and choose the Sketching tab®Drawing Views group®2D

Model command .

Note

In 2D Drafting, the 2D Model command is located on the Tables tab.

• To print a drawing from the 2D Model sheet, use the Print Area option
on the Print dialog box. This allows you to specify two diagonal points
to specify the area that you want to print. See the Help topic, Print an
Area on the Sheet to learn more.

2D Model Sheet command

The 2D Model Sheet command inserts a drawing sheet with the label "2D Model"
into the active document. Place geometry on this sheet from which you want to
create a 2D model view with the 2D Model View command.

Drawing Area Setup command

The Drawing Area Setup command simplifies setting up a work area for creating
1:1 scaled drawings on the 2D Model sheet. Based on information you enter in the
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Drawing Area dialog box, it calculates the correct text height scale and drawing
border size to draw and annotate at a 1:1 scale. This makes the text legible on the
2D geometry and prints at the proper height for your paper size. It also gives you
the flexibility to annotate on the 2D Model sheet or in the scaled 2D model views
on the working sheet.

As part of the setup process, the command:

• Prompts you to browse for a drawing sheet border block in the current document
or in another file, and then it places the drawing border on the sheet at the
correct scale to encompass geometry of the specified width and height.

• Sets the text height scale for annotations and dimensions you add. At annotation
placement, the text scale can be overwritten at the sheet level using the Text
Scale control on the displayed command bar. Text height for existing annotations
must be adjusted individually using the Properties dialog box.

Drawing Area dialog box

Drawing Area dialog box

The Drawing Area dialog box collects the information necessary to create a scaled
work space on the 2D Model sheet. The instructions provided by the dialog box
are organized into three steps:

Step 1: Select sheet Size for final printed drawing.

Step 2: Enter Working area width x height OR scale factor.

Step 3: Select a block representing the drawing border.

Sheet Size list
Specifies a sheet size for the finished printed drawing.

Width, Height text boxes and Calculate Scale button
The Width and Height text boxes specify the overall physical size of the part or
assembly to be created. You can enter size information in both fields or in just
one field, clearing the other. Press Enter to have the system calculate the second
dimension from the first.

Click the Calculate Scale button to compute the scale of the drawing from the
width, height, and sheet size.

The default values in the Width and Height fields are the dimensions of the
selected sheet size.

Scale text box and Calculate Height x Width button
When setting up a new drawing area, the Scale value is used to stretch or shrink
the border so that it fits the intended design size of the part or assembly. Also, it
is applied to the annotation text size to maintain the correct text height when
new annotations are added. This enables you to annotate in 2D model space or
on the working sheet using model views.

If you clear the Width and Height fields and type a value in the Scale text box,
you can click the Calculate Width x Height button to compute the area of the
required work space.
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Note

The text scale value for new annotation is stored per sheet. To change the
text scale for all new annotations added to the sheet, change the setting
in the Text Scale field located on the annotation command bar before the
annotation is placed.

Note

If you edit the text scale on the Properties dialog box of a selected
annotation, you only change the scale for the individual annotation, not
for the sheet.

The default value in the Scale field is 1.00.

Document
Displays the file name and path name of a source draft document for a drawing
border. If the file contains blocks, they are listed at the bottom of the Drawing
Area dialog box.

Browse
Click to browse to a different draft file containing blocks for the drawing area
border.

To choose a drawing border created specifically for the AutoCAD environment,
select one of the drawing border blocks from the TitleBlocks.dft file located in the
\Program Files\Solid Edge ST5\Sample Blocks folder.

Place Block
Set this option then select a drawing border by its block name from the list
below. Clear this option if you do not want to use a border.

Note

The Drawing Area dialog box does not retain settings between sessions. When
you close the dialog box, the settings revert to the default.

Add a drawing sheet border to the 2D Model sheet

This procedure explains how to create and add a drawing sheet border to a 2D
Model sheet.

1. (Create the Graphics) On a working or background drawing sheet, draw the
graphics to represent the title block and border. You can use the Tables command
to create and place a user-defined table as a title block. You can extract property
text to display in the title block.
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Tip

As an alternative source of drawing border graphics, you can drag a .dft,
.dxf, or .dwg file onto a drawing sheet, which automatically creates a
block. To modify the graphics, select the Open command on the block
shortcut menu. You also can use the Unblock command to drop the block
to its base elements.

2. (Create a Block from the Graphics) Choose the Block command.

3. On the Block command bar, select all the border and title block graphics and
then click the green check mark (Accept).

4. On the drawing sheet, click to define an origin point for the drawing border.

5. (Optional) On the Block command bar, click the Block Options button to define
properties as needed.

6. (Finish the Block) On the Block command bar, in the Name text box, type a name
for the drawing border block and then click the green check mark (Accept). Click
the Select tool or press Esc to end block creation mode.

The drawing border is now listed in the Block Selection pane.

7. You can use the drawing border on the 2D Model sheet in the current drawing,
or you can add it to the Block Library for use in other documents.

Add the Drawing Border to the 2D Model Sheet in the Active Document

• To add the drawing border to the 2D Model sheet in the current document,
select the 2D Model command to display the 2D Model sheet. Next, you
can either select the Drawing Area Setup command, if you want to scale
the border, or just drag it from onto the 2D Model Sheet if you are not
concerned with scale. If you use the Drawing Area Setup command, then on
the Drawing Area dialog box, under Step 3: Select a Block to Represent a
Drawing Border, click the Place Block option, and then select the drawing
border block name from the list of blocks in the current document.

Create a Drawing Border Block File for Use in Other Documents

• You can drag the drawing border into the Block Library for use in other
documents. On the drawing sheet, click to select the drawing border
block you created. Drag it to the Block Library pane (the top pane) in
the Library. When you do this, it copies the block to a file and its name
changes to the default file name, Symbol1. It is still a block file. Select the
Rename command on the block file shortcut menu, and then retype the same
background block name you assigned to it when you created it.

To use this drawing border block file on the 2D Model sheet in another
document, open the draft document, display the 2D Model sheet, and then
select the Drawing Area Setup command. On the Drawing Area dialog
box, under Step 3: Select a Block to Represent a Drawing Border, click the
Browse button and select the drawing border file name from the Block
Library folder location.
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Tip

Using the Drawing Area Setup command to select and add a drawing
border ensures the border is scaled correctly for the sheet it is to be
printed on. However, you also can drag an individual block or a block
file onto the 2D Model sheet and use the Block Scale option on the
command bar to modify the scale.

Creating drawing views

Drawing view creation

You can make a drawing in Solid Edge using several types of drawing views: 2D
part views, 2D views, and predefined 3D model views. The drawing can contain
dimensions and other annotations that describe the size of a part or assembly, the
materials used to create it, and other information.

You can place any number of drawing views on a sheet. You can also modify the
characteristics of a selected drawing view with the Properties command on the
Edit menu or the shortcut menu.

To learn about creating a 2D view, see the Help topic, 2D views and 2D model views.

To learn about creating a 3D model view, see the Help topic, Creating 3D model
views with PMI.

Part views

You can create part views of any Solid Edge part, sheet metal, or assembly document
(.par, .psm, and .asm file types). Multiple part, sheet metal, and assembly documents
can be used as the basis for part views in a draft document. To document foreign
data, first convert the data into a Solid Edge document.
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Creating a primary part view

You begin creating part views by using the Drawing View Creation Wizard to create
a primary view of a 3D part or assembly. A primary view is simply the first view
placed on the drawing.

The Drawing View Creation Wizard displays a series of pages. The specific options
you see depend upon whether you start the command from a draft or 3D model
document:

• To start the Drawing View Creation Wizard from a draft document, select the
Drawing View Wizard command. You are then prompted to choose a 3D part,
sheet metal or assembly document as the source file for the drawing view.

• To start the Drawing View Wizard command from a part, sheet metal, or
assembly model document, on the Application menu, choose New®Create
Drawing.

• The Drawing View Options tab sets drawing view options for the model.

• The Drawing View Orientation tab is where you select a named view, such as
front, dimetric, or top.

• The Custom Orientation dialog box contains view manipulation commands that
you can use to create a custom view as the primary view. For example, you
can define a perspective view.

• The Drawing View Layout tab is where you select companion orthographic views
to place with the primary view.

Placing a primary part view

When you click Finish on the Drawing View Creation Wizard, the cursor is displayed
as a rectangle the size of the new part view. You can position the view anywhere
on the sheet, and then click to place it. If you selected companion views from the
wizard’s Drawing View Layout dialog box, when you click the drawing sheet, all
selected views will be placed at once.
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Creating additional part views

After you create one or more primary part views, you can use them to create:

• Principal views

• Perspective views

• Auxiliary views

• Detail views

• Section views

• Broken views

You can then use those part views to create still others. For example, if you create
a principal view (B) based on the primary view (A), you can create a section view
(C) based on the principal view.

Setting the projection angle

The projection angle defines the appearance of a new part view that is folded from
an existing part view. The projection angle is dependent on the mechanical drafting
standard you use and, typically, once you set the projection angle you will rarely,
if ever, need to reset it.

Mechanical drafting standards use either a first angle projection or a third angle
projection for creating multi-view projections of a part on a drawing sheet. The first
angle method is predominantly used by engineers and designers who follow ISO
and DIN standards. The third angle method is predominantly used by engineers
and designers who follow ANSI standards. You can create part views using either
method.

You can set the projection angle on the Drawing Standards tab on the Options dialog
box. You can also set the method you want to use in a template so that all documents
created using that template conform to the standard you need.
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Creating drawings of assemblies

When you create a part view of an assembly, you can control the display of the
individual parts and subassemblies in the assembly. For example, you may want
to hide certain parts or specify that a part is displayed as a reference part. You
can also control the display of weld beads and material addition features in a part
view of a weldment assembly.

• You can use the Model Display Settings button on the Drawing View Wizard
command bar to specify which parts you want to display in the part view before
you place it on the sheet.

• After placement, you can select the part view on the drawing and edit its
properties using the Properties command on the shortcut menu.

• You also can use the display configurations, PMI model views, and zones you
have saved in the Assembly environment to control the display of the parts in
the part view. When you select an assembly document in the Select Model dialog
box of the Drawing View Wizard, you can select the display name you want to
use from the .cfg, PM Model View, or Zone list on the Assembly Drawing View
Options page. For example, you can use an exploded display configuration name
to place a part view of an exploded assembly.

To enhance the performance of assembly drawing views, clear the Show Hidden
Edges and Show Edges of Hidden Parts options on the Assembly Drawing View
Options dialog box. To make these changes for all assembly drawing views, clear
these options on the Edge Display tab of the Solid Edge Options dialog box. You can
create a draft template file with these options cleared and use it to create all the
drawing views of your assemblies without hidden lines.

Note

In the Assembly environment, you can define several types of display
configurations: assembly configurations, zones, and exploded configurations.
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Creating draft quality views of assemblies

You can use the Create Draft Quality Drawing Views option on the Assembly
Drawing View Options page of the Drawing View Wizard to quickly create a
draft-quality drawing of a complex assembly. To allow draft quality views to be
quickly generated, only visible edges are created.

You can use draft quality views as input for principal views, auxiliary views, cutting
planes, and broken-out section views. You can add balloons to draft quality views
and create parts lists from them. You can place elements that connect to a drawing
view with a leader, such as balloons and callouts. Some of the view properties, such
as Hidden Edge Display, can be fixed. Others, such as Scale, can be modified.

You can use the Activate Parts for Dimensioning option on the Assembly Drawing
View Options dialog box of the Drawing View Wizard command to activate (load into
memory) the parts in the assembly so that you can use them for dimensioning and
other operations that require precision. This option is only available when Create
Draft Quality Drawing Views is also checked.

Creating 2D drawing views of 3D sections

To simulate the removal of material from a 3D model and to expose internal features,
you can create sectioned views of a part, sheet metal component, or assembly. To do
this, use the Section command , which is located on the Product Manufacturing
Information (PMI) tab in the part, sheet metal, or assembly document.

You can create a 2D drawing view directly from the 3D section view in the part,
sheet metal, or assembly document using the New®Create Drawing command on
the Application menu. You also can create a 2D view of the 3D section from within
the Draft environment. In this case, use the Drawing View Wizard command, and
then select the assembly, part, or sheet metal file that contains the 3D section view.

After you place the view on the sheet, select the Properties command from the
drawing view shortcut menu, then click the Sections tab on the Drawing View
Properties dialog box. Select the 3D section view from the list, and click OK. You
must then select the Update View command to update the drawing view with the 3D
section view.
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Creating drawings of a PMI model

You can produce drawings of model views containing product manufacturing
information using the Drawing View Creation Wizard. The display data contained
in the model view—view orientation, 3D sections, and PMI—is captured on the
drawing. PMI text copied to the drawing view retains its three-dimensional aspect.

Options on the Drawing View Wizard let you choose:

• A 3D PMI model view as the drawing view source.

• Whether to copy the model view PMI dimensions to the drawing view.

• Whether to copy the model view PMI annotations to the drawing view.

Once the drawing view is created, you can clear these options on the General page
of the Drawing View Properties dialog box to turn associativity on or off with the
model view:

• Include PMI Dimensions From Model Views check box.

• Include PMI Annotations From Model Views check box.

To learn how to create drawings of PMI model views, see Create a PMI drawing view.

Creating drawings of alternate assemblies

You can create drawing views of alternate assemblies. Alternate assemblies contain
multiple versions of the same part (family of parts) or they contain same part in
multiple positions (alternate position). When you create a drawing view of an
alternate assembly, you can use the following tabs in the Drawing View Creation
Wizard to define the view:

• Drawing View Creation Wizard (Select Family of Assembly Member) —Specifies
the family of parts assembly member to show in the drawing view. When you
select the member from the Family Member list, a preview of the member is
displayed. When you click the Next button, you can define any other assembly
drawing view options you want. For example, you can specify that the drawing
view is placed as a draft quality view.

• Drawing View Creation Wizard (Alternate Position Assembly)—Selects the
different positions you want to show in the drawing view. You must specify which
member to show in the primary position and which alternate positions to show.

To learn how, see Create an alternate position assembly drawing view.
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Creating drawings of weldment assemblies (.asm)

When creating a drawing of a part in a weldment assembly, you can create drawing
views that document the process-specific stages of the weldment process by first
saving the part to a new name using the Save Model As command.

This is useful when the part has assembly features that represent weld preparation
and post-weld machining operations. For example, you may need to apply chamfers
to parts in the assembly before constructing a groove weld.

Creating drawings of weldments (.pwd)

When creating a drawing of a weldment, you can create drawing views that
document the process-specific stages of the weldment process. When placing a
weldment drawing view, you can use the View option on the Weldment Drawing
View Options dialog box to specify whether the drawing view reflects the machined
view, welded view, or assembly view. For example, when you set the Machined View
option, you can place drawing views that document the post-weld machining that
was done to the weldment.

If you defined weld labels in the weldment document, you can use the Tie To
Geometry option on the Weld Symbol command bar to extract the weld labels into
the drawing.

Note

When you set the Tie To Geometry option, only edges that have had weld
labels assigned to them are selectable.

Creating drawing views automatically

You also can create drawing views quickly and automatically by dragging a Solid
Edge document onto a drawing sheet. You can even place an open Solid Edge
document onto a drawing sheet by dragging it from your Open Documents folder
in the Library.

• When you drag an assembly model onto an empty drawing sheet, an isometric
view is created.

• When you drag any other model file onto an empty drawing sheet, front, top,
and right views are created.

You also can drag a model onto a Quicksheet template. With a Quicksheet template,
you can customize the view types and properties, save the document as a template,
and reuse it with any model you want. The views remain unlinked to a model file,
but retain their properties. Or you can use one of the templates delivered with Solid
Edge in the Quicksheet folder. Included assembly templates (metric and English)
consist of one isometric view, parts list, and auto-balloon enabled. Included part
templates (metric and English) consist of front, top, and right orthogonal views,
and one isometric view.
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Component geometry in drawing views

You can display constructions, coordinate systems, sketches, reference planes, and
centerlines in drawing views created from a 3D part or assembly. For model files on
which mass properties have been calculated, a center-of-mass coordinate system is
available when you display coordinate systems. When the part file you are using to
create the drawing view contains construction geometry, Solid Edge Draft treats it
as an assembly. Like an assembly, you can expand it in the Parts List box on the
Display Tab of the Drawing View Properties dialog box. You can use the Parts List
Options button on the dialog box to control the display of component geometry.

You can create a query to find a specific type of model component, and then hide all
instances of it in the drawing view at once. Using a query in this manner, you can
quickly simplify a drawing of a complex assembly model, without having to select
and hide the individual components within each assembly part. To learn how, see
Help topic use a query to hide components in a drawing view.

Using the View Wizard

Create drawing views of a part or assembly

When you place the first view on a sheet using the View Wizard command, the sheet
scale is set by default to the scale of that view, and it is associative to the view.
Before placing the view, you can change the view scale using the Scale list on the
command bar. This, then, becomes the sheet scale.

Views placed after the first view use the same sheet scale. This ensures that the
scale of all drawing views on the sheet is consistent.

1. Choose Home tab®Drawing Views group®View Wizard .

2. If the Create Drawing dialog box is displayed, select a drawing template with a
*.dft file name extension.

3. If the Select Model dialog box is displayed, select a part, sheet metal, or assembly
document.

4. Click Open.

5. Set options on the Drawing View Wizard Options tab as needed, and then click
Next.

The options that are available depend on the type of model—part, sheet metal,
or assembly—for which you are generating a drawing. Refer to Tips, below.

6. In the Drawing View Wizard, on the Drawing View Orientation tab, do one
of the following:

• Select a named view as the principal view for the drawing, and then click
Finish.

• Click Custom to access the Custom Orientation dialog box. Use the options
at the top of the Custom Orientation window to orient the part or assembly,
and then click Close.
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7. In the Drawing View Wizard, on the Drawing View Layout tab, select any
additional views you want to generate, and then click Finish.

8. Use the command bar options to adjust how the view or views are placed on
the drawing sheet.

Example

By default, the View Wizard calculates the best fit for the drawing views
based on the model size and the sheet size. You can change the drawing
view scale by:

• Choosing a different scale from the Scale list.

• Setting the drawing view scale to match the current sheet scale. To do
this, click the Set View Scale button.

9. Click to specify the location of the view(s) on the sheet.

Tip

If you select multiple model views from the Drawing View Layout page,
then the View Wizard command ends when you click the drawing sheet.
If you select just one view, then you can continue placing orthographic
or isometric views by clicking above or below, to the right or left, or
diagonally with respect to the initial view.

Controlling drawing view caption display

• Drawing view captions may be turned off and on for a selected drawing
view using the Drawing View Selection command bar, or the Drawing
View Properties dialog box.

Displaying features added in the assembly model

• To display assembly material removal features in the drawing view—holes,
chamfers, and cutouts—you can select the Show assembly features check
box on the Drawing View Wizard Options page.

• To control the display of material addition features, such as fillet welds
and protrusions, you can use the options on the Display tab (Drawing
View Properties dialog box). You also can define a display configuration in
the assembly with material addition features hidden, then use the display
configuration when placing a drawing view of the assembly.

• Any time before you place the view, you can change the view layout and
scale using options on the command bar.

• You can attach more than one model file to a draft document.

• You can create more than one view layout at a time if the view orientation
you specified in the Custom Orientation dialog box is derived from a plane
or face. You also can use the Custom Orientation dialog box to create a
perspective drawing view.
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• To enhance the performance of assembly drawing views, you can clear
the Show Hidden Edges and Show Edges of Hidden Parts options on the
Drawing View Creation Wizard (Drawing View Options). Changing these
settings only affects the current drawing view you are creating.

To apply these changes to all assembly drawing views, clear the Show
Hidden Edges and Show Edges of Hidden Parts options on the Edge
Display tab (Solid Edge Options dialog box). You can create a draft
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template file with these options cleared and use it to create all the drawing
views of your assemblies without hidden lines.
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View Wizard command

Creates the primary part views in a draft document for a selected 3D assembly or
part model. The 3D assembly or part model is attached to the draft document, so if
the assembly or part changes, you can easily update part views. You can create a
single drawing that shows views of different part models and assemblies.

Using the Drawing View Wizard
When you select the View Wizard command, the Drawing View Creation Wizard
guides you through the process of selecting and placing one or more drawing views.

Drawing View Creation Wizard page Settings
Select Model dialog box You select the model from which the

drawing views are derived.
Drawing View Options Sets options for creating the view, based

on the Solid Edge model type. For
example:

• When creating a drawing of an
assembly, you can choose a display
configuration, a PMI model view, or
a zone to control the display of the
parts in the drawing view.

• When creating a drawing view of
a weldment, you can specify the
process-specific view of the weldment
you want to place.

Note

You can select the Advanced button
on the Drawing View Options
page to set limits on edge creation
using the Advanced Edge Display
Options dialog box.

Drawing View Orientation Specifies the primary view orientation,
such as front or right or iso.

Note

You also can select the Custom
button to define a perspective view
of the model using the Custom
Orientation dialog box.

Drawing View Layout Specifies additional views to place along
with the primary view.

Before you click to place the drawing view, you can use the View Wizard command
bar to choose:

• Drawing view style

• Drawing view caption

• Drawing view scale

• Edge display style

• Shading

Folding additional views from the primary view
On the Drawing View Wizard (Drawing View Orientation) page, if you selected
multiple model views to place at once, then the View Wizard command ends when
you click the drawing sheet. If you place just one view, then the command remains
active. You can:

• Create additional folded views by clicking to the right, left, top, or bottom of the
initial or selected view.

• Create pictorial views by clicking diagonally to the top-right, top-left,
bottom-right, or bottom-left of the initial or selected view.

• Right-click to end drawing view placement mode.

Changing the drawing view appearance after placement
You can change the appearance of a drawing view after you place it. Select the
border of the drawing view you want to modify, and then make display changes
using the options on the Drawing View Selection command bar. For more extensive
options, select the Properties button on the command bar to open the Drawing View
Properties dialog box.

Adding drawing views to the document
Multiple model or assembly documents can be attached to a draft document. After
you place the first part view in a document, you can select the View Wizard command
again to place additional part views. The next time you select the command, the
Select Attachment dialog box is displayed. This dialog box lists the documents that
are currently placed in the draft document, and it allows you to browse for another
part or assembly to use as the basis for the next part view.
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View Wizard command bar

When you select the View Wizard command to define a part view, you can use the
Drawing View Wizard command bar to make changes to how the view is sized. The
command bar is available only until you click to place the view on the working sheet.

You can select the border of an existing drawing view to modify it using the Drawing
View Selection command bar and the Drawing View Properties dialog box.

Back
Reopens the Drawing View Wizard so you can modify the drawing view creation
options.

Drawing View Style Mapping
Specifies that the drawing view will use a predefined style, which is set on the
Drawing View Style tab of the Solid Edge Options dialog box.

When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Best Fit
Assigns the calculated best fit scale to all of your new part views. The scale value
is shown in a box on the command bar.

Set View Scale
Set the scale of the new view to match the current sheet scale.

Scale List
Selects an alternative scale value to use to place the selected view.

Note

Scale values are defined in the Drawing View Scales section of the
Custom.xml file, in the Solid Edge Program folder. See the Help topic, Add
custom drawing view scales to Solid Edge.

Set Sheet Scale
When selected, sets the sheet scale to match that of the drawing view being
placed. If this is the first or primary drawing view placed on the sheet, then this
automatically sets the view scale for all drawing views subsequently added. This
ensures that the scale of all drawing views on the sheet is consistent.

This button is selected by default if the sheet scale is already linked to another
drawing view on the sheet. You can use the Set Sheet Scale shortcut command
on the sheet tab to determine which drawing view it is associated with.

When deselected, the new view is placed using the value shown in the Scale List.
The sheet scale and the drawing view scale are not associative.

Model Display Settings
Opens selected tabs in the Drawing View Properties dialog box for you to change
display settings before you place the drawing view(s):

mt01413-s-1050 Solid Edge fundamentals 9-57



Lesson 9 Creating detailed drawings

• Display tab (Drawing View Properties dialog box—In an assembly, you can
choose to display selected parts in the views. These settings are applied
to all the views you create.

• Sections tab (Drawing View Properties dialog box)—Selects a 2D section
to be applied to the drawing view.

• Shading and Color tab (Drawing View Properties dialog box) —Applies
model colors and shading to the drawing view.

Shading Options
Specifies color or grayscale, shading, and edge visibility for the drawing view.

Not Shaded
Displays color with visible and hidden edges, but no shading.

Shaded
Displays color and shading, but no edges.

Shaded with Edges
Displays color and shading with visible edges.

Grayscale Shaded
Displays grayscale and shading, but no edges.

Grayscale Shaded with Edges
Displays grayscale with visible edges.

Drawing View Selection command bar

Sets options for a drawing view. This command bar is displayed after a drawing view
border is selected. Not all options are available for all drawing views.

Drawing View Style
Displays the name of the currently used drawing view style, or applies a
different drawing view style.

Show Caption
Selects the captions to display for the currently selected drawing view or view
annotation, according to the currently selected Drawing View Style.

Show Primary Caption
Displays the content defined for the Primary caption in the Caption tab
(Drawing View Style dialog box).

Show Secondary Caption
Displays the content defined for the Secondary caption in the Caption tab
(Drawing View Style dialog box).

You also can choose whether to show the following information, if it is defined
in the caption text on the Caption tab (Drawing View Style dialog box) for the
currently selected drawing view style:
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Show Suffix
When a section view, detail view, or auxiliary view is selected, displays the
caption suffix.

The suffix can be displayed in the caption when %AS is added to the primary
or secondary caption text, and when the View Annotation Name property
text code (%VA) is added to the Suffix Property box.

Show Annotation Sheet Number
Displays the sheet number of the view annotation—the cutting plane,
viewing plane, or detail envelope—when %LN is added to the primary or
secondary caption text, and when the appropriate property text string is
added to the Annotation Sheet Number (%LN) Property box.

Show View Scale
Displays the view scale in the caption when %VS is added to the primary
or secondary caption text, and when the appropriate property text string is
added to the View Scale (%VS) Property box.

Show Angle of Rotation
Displays the view rotation angle in the caption when %VR is added to the
primary or secondary caption text, and when the appropriate property text
string is added to the Angle of Rotation (%VR) Property box.

Note

Primary captions, secondary captions, and view annotation captions are
defined in the Drawing View Style dialog box. To learn how to create
captions for selection on the drawing, see these Help topics.

• Define drawing view captions using property text

• Drawing view captions

• Drawing view styles

Scale
Specifies the drawing scale as a standard ratio. The specified ratio defines the
size of the drawing in relation to the size of the real-world object. For a 2:1
ratio, the 2 represents the size of the drawing and the 1 represents the size of
the real-world object.

Scale Value
Specifies a custom scale value.

Show Annotation
Specifies whether to display the view annotation graphics, such as the cutting
plane, detail envelope, or viewing plane. Also specifies whether to display the
profiles for a broken-out section view for the selected drawing view. Displaying
the profiles allows you to edit the profile for a broken-out section view.

This option is available only when the selected view is the source view where the
view annotation graphics are drawn.

Properties
Displays the Drawing View Properties dialog box.
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Modify Drawing View Boundary
While you can modify the size of a rectangular drawing view cropping boundary
simply by dragging its handles, the Modify Drawing View Boundary option
allows you to define a custom, non-rectangular drawing view cropping boundary.
This option is not available for dependent and independent detail views.

When you select this option, the drawing view is displayed in a special cropping
window. The rectangular boundary is converted to four endpoint connected line
segments. You can use the 2D drawing tools to redraw the view cropping border.
However, the new cropping boundary profile must be closed.

• To use a portion of the rectangular boundary window in the custom profile,
draw new line segments that connect to the existing line segments. When
you’re done drawing the boundary, use the Trim command to remove the
unneeded line segments.

• To draw a new boundary profile from scratch, delete all the existing line
segments and then draw the new boundary using the 2D drawing tools.

Use the Close Cropping Boundary button on the ribbon to exit the cropping
window, update the view, and return to the drawing.

Click here to see illustrations showing how the Modify Drawing View Boundary
option can be used to create a custom cropped drawing view.

You can return a cropped drawing view to its original display using the Uncrop
command on the selected drawing view’s shortcut menu.

Shading Options
Specifies color, grayscale, shading, and edge visibility for the drawing view.

Not Shaded
Displays color with visible and hidden edges, but no shading.

Shaded
Displays color and shading, but no edges.

Shaded with Edges
Displays color and shading with visible edges.

Grayscale Shaded
Displays grayscale and shading, but no edges.

Grayscale Shaded with Edges
Displays grayscale with visible edges.

Show Broken View
Shows or hides the broken view regions of the drawing view.

Lock drawing view position
Prevents the selected drawing views from being moved accidentally. When this
box is checked, and the drawing view is highlighted, a lock symbol is displayed
within the drawing view boundary to indicate its position is fixed.

A locked drawing view still can be moved using explicit commands. To learn
more, see Drawing view manipulation.
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Select Model dialog box

Use the Select Model dialog box to choose a 3D model to create drawing views. This
dialog box is displayed when you choose the View Wizard command in a new Draft
document. Not all options defined here are available in all environments.

Look In
Displays the drive and folder in which you want to search for the document or
image you want to open. The system stores the last location you browsed in
the Look In box.

Note

If you want to browse a network share, you must map the share to a
network drive. After you map the network drive, you can select it from
the Look In pulldown list.

Go to Last Folder Visited
Returns to the last folder that you visited.

Up One Level
Accesses the parent folder.

Create New Folder
Displays the Create New Folder dialog box that allows you to create a new folder.

View Menu
Controls the display method for the listed documents.

• Thumbnails–Displays thumbnails for the documents.

• Large Icons—Displays large icons for the documents.

• Small Icons—Displays small icons for the documents.

• List—Lists the names of the documents in columns.

• Details—Displays a detailed view of the folder contents. The columns
displayed include Name, Size, Type, and Modified.
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Detail
Determines the type of representation used in the Look-In control when you
work with Teamcenter or Insight XT managed documents. Changing the value
updates the view in the Look-In display.

• Full—Displays the Item, Item Revision, and Dataset on individual rows.

• Intermediate—Displays the Item and Item Revision combined in one row.
The Dataset displays on a separate row.

• Basic—Default display. The Item, Item Revision, and Dataset are displayed
on a single line.

Revision Filter
Controls the revisions of an item you see in the display list. The values available
are: All, Latest, Released, Latest Released, and Latest 3.

Search
Displays the Search dialog box so you can define advanced search criteria for the
document you want to open.

If you are working with managed documents, the Search dialog box for managed
documents is displayed.

Preview
Displays a bitmap image of the document if a preview image was saved for
the file.

Properties
Displays the document properties for the active document.

File Name
Specifies the name of the file you want to open.

Files Of Type
Specifies the type of files that you want to list.

Revision Rule
Specifies a revision rule for updating links when you open a managed document.

• As Saved - Opens the document and updates the links as it was last saved.

• Latest - Opens the document and updates the links to the latest revision in
the system.

• Latest Released - Opens the document and updates the links with the latest
released revision.

• External System - Opens the document and updates links with revisions
specified by an external system.

• Version from Cache - Opens the document from your cache. No document
transfers take place between the document library and your local cache
resulting in optimized performance. When Version from Cache is chosen in
conjunction with the Solid Edge Option Always Synchronize to Get Latest

9-62 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Version, the latest version of the direct document is copied from the server to
the cache and indirect documents are opened directly from the cache.

If you are opening a document that is managed by Teamcenter, you can select
from all of the revision rules available in Teamcenter in addition to those listed
here.

Note

This control is not available if you select a non-managed document, a
document that is checked out, or if you are working offline.

Variant Rule
Specifies the variant rule used when opening an assembly from Teamcenter. If
no variant was saved with the assembly, the option is grayed out. The variant
rule is assembly-specific and is cleared if you select a different assembly.

Options
Displays the translation options.

BOM
Displays the selected assembly structure in a BOM view. The option is only
available when working with Teamcenter.

Assembly open as
Determines with what options assemblies are opened. The default settings are
defined on the Assembly Open As tab of the Solid Edge Options dialog box.

Auto-Select
Uses the options defined on the Assembly Open As dialog box for opening
your assembly.

Note

The ranges shown here are the default settings on the Assembly Open
As dialog box. These numbers can vary based on your definitions.

Small Assembly
Defined as less than 50 number of unique components.

Medium Assembly
Defined as between 50 and 1000 unique components.

Large Assembly
Defined as greater than 1000 unique components.

Last Saved
Opens your assembly based on how it was last saved.

Hide All Components
Specifies that all the components in the assembly are hidden when you open it.
When working with Insight or Teamcenter managed documents, the next level of
reference documents is downloaded to the cache. When you open an assembly
with all components hidden, the assembly will open faster. This can be especially
useful when working with large assemblies.
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When you open an assembly with Hide All Components selected, the
subassembly listings in PathFinder are collapsed. You can expand the next
level of reference documents by clicking the + or by using the Expand command
on the PathFinder shortcut menu. Selecting Expand All from the PathFinder
shortcut menu will expand all branches and download them to cache. For more
information, see the Working with large assemblies efficiently Help topic.

Part activation
Specifies how you want to open an assembly (.asm). This option is available
when opening an assembly document. When this option is set, you can specify
whether the parts in the assembly are active or inactive. When this option is
blank, the active or inactive status of the parts is determined by the last save.
When you open an assembly with parts inactive, the assembly will open faster.

Activate All
Specifies that all parts in the assembly are active when you open the
assembly. This option is set when you enable Apprentice Mode on the Solid
Edge start up screen.

Inactivate All
Specifies that all parts in the assembly are inactive when you open the
assembly.

In some cases, parts that have associative links to other parts will still be
activated when you open the assembly. For example, parts with inter-part
links, adjustable parts, flexible pipes, fastener systems, and so forth may be
activated to ensure that the linked geometry is up to date. This typically
occurs when a part is modified outside the context of the assembly, and that
part is a parent in an associative operation. When the assembly containing
the child part is opened, the child part must be activated to update the link
information properly.

Part simplification
Allows you to specify how you want to open an assembly that contains simplified
parts. When this option is set, you can specify whether the parts in the assembly
are displayed using the simplified or designed version. When this option is
cleared, the simplified or designed status of the parts is determined by the last
save. When you open an assembly with parts simplified, the assembly will open
faster. This option is available when opening an assembly document.

Use All Design
Specifies that all parts in the assembly that have simplified versions defined
are displayed as designed when you open the assembly.

Use All Simplified
Specifies that all parts in the assembly that have simplified versions defined
are displayed simplified when you open the assembly.

Subassembly simplification
Allows you to specify how subassemblies are displayed when you open an
assembly. When this option is set, you can specify whether the subassemblies
in the assembly are displayed using the simplified or designed version. When
this option is cleared, the simplified or designed status of the subassemblies is
determined by the last save. When you open an assembly with subassemblies
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simplified, the assembly will open faster. This option is available when opening
an assembly document. For more information, see Simplifying assemblies.

Use All Design
Specifies that all subassemblies in the assembly will display using the
designed version when the assembly is opened.

Use All Simplified
Specifies that all subassemblies in the assembly that have simplified
versions defined are displayed simplified when you open the assembly.

Apply Simplified Assembly Override
Allows you to specify how you want to apply the display configuration. When
this option is set, you can specify whether the parts in the assembly are
simplified or designed when you apply the display configuration. When
this option is cleared, the simplified or designed status of the parts is
determined by their status when the configuration was saved. This option
is not available in the Teamcenter environment.

Top-Level Assembly
Specifies that all top-level assemblies that have simplified versions
defined are displayed simplified when you open the assembly.

All Subassemblies
Specifies that all subassemblies in the assembly that have simplified
versions defined are displayed simplified when you open the assembly.

Drawing View Creation Wizard (Drawing View Options)

The options available depend upon whether the model is assembly, part, or sheet
metal.

Designed part
Specifies that you want to create a drawing view of the part as designed. This
option is only available for Part and Sheet Metal files.

Simplified part
Specifies that you want to create a drawing view of the simplified version of a
part. This option is only available for Part and Sheet Metal files. It is disabled
if a simplified model does not exist.

Flat pattern
Specifies that you want to create a drawing view of the flattened sheet metal
part. This option is only available for sheet metal files that also contain the
flattened model in the file.

PMI model view
For a part or sheet metal model, lists the names of available PMI model views
that can be used to generate a drawing view.

.cfg, PMI model view, or Zone
For an assembly model, lists the names of available display configurations, 3D
PMI model views, and zones that can be used to generate a drawing view.

– Indicates a display configuration.
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– Indicates a 3D PMI model view.

– Indicates a zone.

Example

• You can hide parts or weld beads in the assembly document, save
the display configuration to a name you define, then use that display
configuration when creating the drawing view. For more information,
see the Using display configurations Help topic.

• If you select a PMI model view created with the View command, then
the model view controls the display states of parts in an assembly.

• If you used the Create Zone command to define a rectangular volume
of space based on one or more assembly components, then you can
create a drawing view of the components that are contained within
the boundary of the zone.

Include PMI dimensions from model views
Set this option to retrieve the PMI dimensions associated with a model view you
have selected in the PMI Model View list (for part/sheet metal models) or in the
Configuration and PMI Model View list (for assembly models). By default, the
copied PMI dimensions are associative to the drawing view.

Include PMI annotations from model views
Set this option to retrieve the PMI annotations associated with a model view you
have selected in the PMI Model View list (for part/sheet metal models) or the
Configuration and PMI Model View list (for assembly models). By default, the
copied PMI annotations are associative to the drawing view.

Use simplified assemblies
Specifies that you want to create a drawing view of an assembly using the
simplified assembly representation. This option is not available for assembly
zones.

For all subassemblies
Specifies that you want to create a drawing view that shows all the
subassemblies as simplified for which a simplified representation exists.
This option is only available for Assembly files.

Based on configuration
Specifies that you want to create a drawing view that displays the
subassemblies as simplified or as designed based on the configuration you
select. This option is only available for Assembly files.

For top assembly
Specifies that you want to create a drawing view that displays only the top
level assembly as simplified. This option is only available for Assembly files.

Use simplified parts
Specifies that you want to create a drawing view of an assembly with simplified
models. This option is only available for assembly files.
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For all parts
Specifies that you want to create a drawing view that shows all the parts as
simplified for which a simplified model exists. This option is only available
for assembly files.

Based on configuration
Specifies that you want to create a drawing view that displays the parts
as simplified based on the configuration. This option is only available for
assembly files.

Create draft quality drawing views
Quickly creates draft-quality drawing views of an assembly. You can use draft
quality views as input for principal views, auxiliary views, cutting planes, and
broken-out section views. You can also add balloons to draft quality views and
create parts lists from them. This option is only available for Assembly files.

To place a 3D cutaway/section view on a drawing sheet, the Create Draft Quality
Drawing Views option must be set. After placing a drawing view, use the
Sections page on the Drawing View Properties dialog box to select and display
the 3D cutaway/section view on the drawing sheet.

View quality
Specifies the quality or resolution when a draft quality drawing view is created
or updated. The resolution defines the pixel range box used to display the draft
quality view. Three is the highest value and provides the best setting. The
quality value is saved with the drawing view.

You can modify the Draft View Quality value on the General page of the Drawing
View Properties dialog box after placing the drawing view. If you modify the
value there, the drawing view will go out-of-date.

This option is only available when Create Draft Quality Drawing Views is also
checked.

Activate parts for dimensioning
Activates (loads into memory) the parts in the assembly so that you can use
them for dimensioning and other operations that require precision. You cannot
dimension pre-v17 pictorial views. This option is only available when Create
Draft Quality Drawing Views is also checked.

Show tube centerlines
Displays tube centerlines in the drawing view(s). This setting overrides the
Show Tube Centerlines check box on the Edge Display page of the Options dialog
box. This option is not available for Sheet Metal and Weldment files.

Show assembly features
Specifies whether assembly features created in the Assembly environment are
shown in the drawing view. This option applies only to material removal features
such as holes, chamfers, and cutouts. When this box is checked, these types of
assembly features are displayed in the drawing view even if the Use Simplified
Parts box is also checked. This option is only available for Assembly files.

To control the display of material addition features, such as fillet welds and
protrusions, you can use the options on the Display page of the Drawing View
Properties dialog box. You can also define a display configuration in the assembly
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with material addition features hidden, then use the display configuration when
placing a drawing view of the assembly.

Derive "Display as Reference" from assembly
Specifies that the occurrence properties defined in the assembly document
determine whether the occurrence is displayed as a reference part. Reference
parts are displayed using a different line style you can define. You can use the
Occurrence Properties command on the Assembly PathFinder shortcut menu
to specify that an assembly occurrence is displayed as a reference part in a
drawing. You can use the Edge Display page on the Solid Edge Options dialog
box to specify the reference part edge display style you want to use.

Machined view
Specifies that you want to create a drawing view of a machined view of a
weldment. This option is only available for weldment files (.pwd).

Welded view
Specifies that you want to create a drawing view of a welded view of a weldment.
This option is only available for Weldment files (.pwd).

Assembly view
Specifies that you want to create a drawing view of an assembly view of a
weldment. This option is only available for Weldment files (.pwd).

Show hidden edges in:
Orthographic views
Displays the hidden edges on parts in orthographic part views.

Pictorial views
Displays the hidden edges on parts in pictorial part views.

Show tangent edges in:
Orthographic views
Displays the tangent edges on parts in orthographic part views.

Pictorial views
Displays the tangent edges on parts in pictorial part views.

Show edges of hidden parts in:
Orthographic views
Displays the parts that are hidden by other parts in orthographic part views.
The edges are displayed using the hidden edge line style. This option is only
available for Assembly and Weldment files.

Pictorial views
Displays the parts that are hidden by other parts in pictorial part views. The
edges are displayed using the hidden edge line style. This option is only
available for Assembly and Weldment files.

Advanced
Displays the Advanced Edge Display Options dialog box.

Back
Moves to the previous step.
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Next
Moves to the next step.

Advanced Edge Display Options dialog box

Defines advanced edge display options for drawing views. The Advanced Edge
Display Options dialog box is available using the Advanced button on the first page
of the Drawing View Creation Wizard.

You can override these options for individual views on the Advanced page (Drawing
View Properties dialog box).

Limit Edge Creation
Only generate edges inside and overlapping cropped boundaries
Minimizes VHL drawing view processing time by limiting edge creation
for any cropped views or independent detail views. When this check box
is selected, only edges completely inside or overlapping the view cropping
boundary are generated. When this check box is cleared, all edges inside,
outside, and overlapping the view cropping boundary are generated.

Note

Geometry created with the Draw In View command is not affected
by this setting.

Show edges created by cutting plane line vertices
When you create a section view using a cutting plane that is defined by
multiple line segments, you can use this option to show or hide the resulting
edges in a drawing view.

When this option is cleared, edges created by cutting plane line vertices are
hidden when the drawing view is created. When this option is set, these
edges are visible. The default setting is cleared.

This option applies to 2D section and revolved section views. It does not
apply to 2D broken-out section views. The default setting is cleared.

Note

Not all edge cases are handled by this processing rule. For those edges
that are not, you can use the Hide Edges command to hide them.

Simplify B-spline Edges
Always
B-spline geometry from part edges is always converted to simple geometry.

Only edges outside of the plane of the drawing view
Only B-spline geometry from part edges non-parallel to the plane of the
drawing view are converted to simple geometry. This is the default for
newly placed views.

Never
B-spline geometry from part edges is never converted to simple geometry.
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Part Intersections
Processing part intersections can yield better drawing view results in cases such
as press fits, where parts slightly intersect.

Do not process intersections
Specifies that part intersections are not processed. This is the fastest option,
and the default for newly placed views.

Process intersections
Without creating face intersections (fast)
Creates part edges within the intersections of overlapping bodies. The
edges formed between intersecting faces of overlapping bodies are not
created.

Create face intersections of threaded parts (slow)
Creates face intersections of overlapping bodies for threaded parts on
which outer diameter and inner diameter threads overlap.

Create all face intersections (slowest)
Creates face intersections for all overlapping bodies. This is the slowest
option.

Drawing View Creation Wizard (Drawing View Layout)

You can use the Drawing View Layout options to choose additional orthographic
views based on the selected primary view.

• The dialog box displays nine buttons representing orthographic (principal) and
pictorial views of the part.

• The middle image represents the initial view you selected from the Named Views
list in the Drawing View Creation Wizard.
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• You can select additional views to place on the drawing sheet along with the
initial view by clicking one or more buttons representing the view orientations.

Note

The order in which the view orientation buttons are arranged in the
dialog box is based on whether you are using first-angle projection or
third-angle projection.

o For first-angle projection:

o For third-angle projection:

Back
Moves to the previous step.

Next
Moves to the next step.

Finish
Completes initial placement steps and closes the Drawing View Creation Wizard.
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At this point, you can either click to place the drawing view on the sheet, or you
can change placement options first, using the View Wizard command bar.

Drawing View Creation Wizard (Drawing View Orientation)

Named Views
Lists placement selections for the initial drawing view.

Note

You can use the View Orientation command to create user-defined
Named Views in the Part, Sheet Metal, and Assembly environments, and
those views will be listed here.

To learn how, see Save a new named view.

Custom
Displays the Custom Orientation dialog box. You can use the view manipulation
options in this window to reorient the 3D part before you create drawing views,
and to create a perspective view.

Back
Moves to the previous step.

Next
Moves to the next step.

Finish
Completes initial placement steps.

Custom Orientation dialog box

This window displays the 3D part or assembly you select in the Drawing View
Creation Wizard. You can use the view manipulation options in this window to
reorient the 3D part before you create drawing views. When you finish reorienting
the part, click Close to continue with the command.

Activate Part
Activates (loads into memory) the model data associated with a part. This
enables you to use a face or edge on the part for precise placement of the view
before the view is created. Activate Part is only available with assemblies.

Shaded with VHL Overlay
Specifies if the view will be simply shaded or shaded with VHL overlay. Using
the Shaded with VHL Overlay may decrease your performance when working
with large assemblies.

Rotate
Rotates a view freely about one of the following:

• The center of the view

• Any one of three principal axes

• Any edge of the model
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Note

You also can press the Home key to rotate the model to the default
isometric view.

Spin About
Rotates a view normal to a face. Spin About is not available for assemblies.

Common Views
Selects one of six principal views or eight isometric views. You can use the
arrows on the displayed dialog box to select the view.

Look At Face
Defines a view using any planar face. Look at Face is not available for
assemblies.

Align Edge
Aligns a view to a linear edge. In cases where Look At Face does not align the
view the way you want, you can use this option to select a linear edge of the
model and specify a new x or y axis.

Zoom Area
Zooms into an area in the window. The two points you place define the view.

Zoom
Reduces or enlarges the display of geometry around a specified point in the
window.

Fit
Fits all elements to the window.

Pan
Enables you to move in any direction from a specific point on the model to see
other areas of the model.

Perspective
Applies perspective to, or removes perspective from, the view in the Custom
Orientation window. A perspective view appears more realistic than an isometric
view. When perspective is applied, objects that are farther away appear smaller.

When you select the Perspective option, you can choose a predefined angle from
the Perspective Angle list, or you can define a custom perspective angle using
Shift+Ctrl while rotating the mouse wheel.

Perspective Angle
When the Perspective option is selected, you can choose from a list of perspective
angle values that equate to the focal lengths of a 35 mm camera. As the angle
increases, the distance to the object decreases, making the object appear closer.
For example, the angle in the first picture (A) is wider than the angle in the
second (B), so that the first picture appears closer.
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• Portrait (85 mm)

• Normal (50 mm)

• Wide (35 mm)

• Very wide (10 mm)

• Custom—This value is set and applied automatically when you press
Ctrl+Shift while you rotate the mouse wheel to change the perspective view
angle and distance.

Rotation Angle
Specifies the angle of rotation.

Close
Closes the Custom Orientation window and continues the drawing view creation
process.

Drawing View Creation Wizard (Select Family of Assembly Member)

Family Member
Lists members of the selected assembly. You can select one member at a time
for placement on the drawing sheet.

Preview
Displays a bitmap image of the document if a preview image was saved for
the file.

Back
Moves to the previous step.

Next
Moves to the next step.

Drawing View Creation Wizard (Alternate Position Assembly)

When an assembly contains mechanisms like linkages and actuators that change
position during the physical operation of the assembly, these may be defined as
alternate position members in the alternate position assembly model. When you use
the Drawing View Creation Wizard to create a drawing view of the assembly, the
Alternate Position Assembly tab is displayed for you to choose the different positions
you want to show in the drawing view.
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Member Name
Displays the names of alternate position members defined in an alternate
position assembly. You can click a member name to see what the member
position looks like in the preview pane.

Primary
Selects a member as the primary member in the drawing view. One primary
member is required.

The primary position parts are auto-ballooned when you create a parts list and
are shaded when you apply shading and grayscale.

Alternate
Selects one or more additional alternate position members to display in the
drawing view.

Note

After the drawing view is placed, you can select the Set Primary and Alternate
Positions command on the drawing view shortcut menu, and then add and
remove members from the view, and change primary and alternate position
designations.

Select Attachment dialog box

You can use the Select Attachment dialog box to create additional drawing views of
a model. This dialog box displays the model documents that are currently placed
in the draft document and allows you to select another part or assembly to use as
the basis for the next part view.

Parts
Displays the documents that are currently placed in the drawing view in a
folder tree structure.

Preview
Displays a bitmap image of the document if a preview image was saved for
the file.

Browse
Accesses a dialog box that allows you to search for a document.

Using the Create Drawing command

Create a drawing with the Create Drawing command

Automatically create a drawing of the 3D model displayed in an open model
document.

1. Save the current model (assembly, part, or sheet metal) file.

2. On the Application menu, click New®Create Drawing.

The Create Drawing dialog box is displayed.

3. Specify a template for the drawing.
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4. Do one of the following:

• (For automatic drawing view creation) Clear the Run Drawing View Creation
Wizard check box and click OK.

The resulting drawing view(s) depend upon the template you selected.

o If the specified template is not a Quicksheet template and the current
model file is a part or sheet metal part, then top, front, and right views
are created.

o If the specified template is not a Quicksheet template and the current
model file is an assembly, then an isometric view is created.

o If the specified template is a Quicksheet template, then the drawing
views and parts lists (if any) in the Quicksheet template are created
using the current model file.

• (For user-defined drawing views) Select the Run Drawing View Creation
Wizard check box and click OK.

The Drawing View Options tab of the wizard is displayed for you to configure
the views you want.

o To learn how to select and place user-defined drawing views, see Create
drawing views of a part or assembly.

o For general information about creating drawing views, see Drawing view
creation.

Note

In the Teamcenter-managed environment, draft documents are automatically
created in the same Item as the 3D model resulting in a single Item Revision
having a 3D dataset and the corresponding draft.
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Create Drawing command

Creates a drawing from the current model (assembly, part, or sheet metal) file, using
the template specified in the Create Drawing dialog box.

If Run Drawing View Creation Wizard is checked, the Drawing View Options page of
the wizard is displayed for you to configure the views you want.

If Run Drawing View Creation Wizard is not checked:

• If the specified template is a Quicksheet template, then the drawing views and
parts lists (if any) in the Quicksheet template are created using the current
model file.

• If the specified template is not a Quicksheet template and the current model file
is an assembly, then an isometric view is created.

• If the specified template is not a Quicksheet template and the current model file
is a part, or sheet metal part, then top, front, and right views are created.

If the current model file is a family of assemblies, the active family member is used
to create the new drawing.

Note

The Create Drawing command is available from the Application menu, when
you select New, then Create Drawing. It also is available on the shortcut
menu, when an assembly, part, or sheet metal file is selected in PathFinder
or the Library pane.

Create Drawing dialog box

Template
Specifies the template file to use for the new drawing.

The last template you selected is used as the default the next time you run
the command. Therefore, when you are working in a Teamcenter-managed
environment, the default template is the last SEEC template selected for the
command. When you are working in an unmanaged environment, the default
template is the last unmanaged template you selected for the command

Browse
Opens the New dialog box so you can browse for a different template file.

Run Drawing View Creation Wizard
Specifies that when you click OK, the Drawing View Creation Wizard runs so
you can configure the views you want.
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Drawing view types

Principal views

Principal views

Creating principal views

After you place the initial drawing views on the drawing sheet using the Drawing
View Wizard, you can use the Principal View command to create additional
orthogonal or pictorial drawing views using an existing drawing view.

You specify the orientation of the new drawing view using the cursor. For example,
to place a new principal view using an existing orthogonal view, first select the
source view (A), then position the cursor to the right, left, top, or bottom to place a
new orthogonal view (B), or position the cursor diagonally to place a new pictorial
view (C).

When you use the Principal View command to place new drawing views, they are
aligned with and are placed at the same scale as the source view.

Note

You cannot use the Principal View command to place a new drawing view
using a section view, auxiliary view, or detail view as the source view.

Principal view captions

The default principal view caption content and formatting is defined in the drawing
view style that is selected on the Principal View command bar when you create
the view.
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After you place a principal view, you can use the Show Caption options on the
Drawing View Selection command bar to show or hide the caption text. You also can
modify the caption using the Caption tab (Drawing View Properties dialog box).

You can reposition a caption by selecting the view and then dragging the label to a
new location.

To learn more, see the following Help topics:

• Drawing view styles

• Drawing view captions

Create a principal view

1. Choose Home tab®Drawing views group®Principal View .

2. Select an orthographic or pictorial view.

The cursor becomes a rectangle that represents the size of the view that you
are going to create.

3. Click to specify the view location on the sheet.

Where you click to place the view, and whether you are using first-angle
projection or third-angle projection, determine what view orientation is created.

• To create an orthographic view, click to the right, left, top, or bottom of the
selected view. This folds the selected view 90 degrees about the closest view
edge.

• To create a pictorial view relative to the orientation of the selected view,
click diagonally to the top-right, top-left, bottom-right, or bottom-left of the
selected view.

4. Continue placing views, or right-click to end the command.

Tip

• You can derive a principal view from a pictorial view.

• Section views, auxiliary views, and detail views are not valid input for
this command.

Principal View command

Creates an orthogonal or pictorial drawing view from an existing orthogonal or
pictorial drawing view.

You specify the orientation of the new drawing view using the cursor. For example,
to place a new principal view using an existing orthographic view, first select the
source view (A), then position the cursor to the right, left, top, or bottom to place a
new orthographic view (B), or position the cursor diagonally to place a new pictorial
view (C).
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After placing the first view, the Principal View command remains active. You can
continue placing views from the initial view by moving the cursor above or below,
diagonally, or right or left, and clicking to place each view.

You can right-click to end drawing view placement mode.

Note

Section views, auxiliary views, and detail views are not valid input for this
command.

Principal View command bar

The Principal View command bar is displayed when creating a principal view. The
Drawing View Selection command bar is displayed when you select a principal view
to edit it.

Drawing View Style Mapping
Specifies that the drawing view will use a predefined style, which is set on the
Drawing View Style tab of the Solid Edge Options dialog box.

When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the drawing view or records a style by example. This option is
not available when Drawing View Style Mapping is enabled.

Model Display Settings
Opens the Drawing View Properties dialog box so you can set display settings.
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Shading Options
Specifies color or grayscale, shading, and edge visibility for the drawing view.

Not Shaded
Displays color with visible and hidden edges, but no shading.

Shaded
Displays color and shading, but no edges.

Shaded with Edges
Displays color and shading with visible edges.

Grayscale Shaded
Displays grayscale and shading, but no edges.

Grayscale Shaded with Edges
Displays grayscale with visible edges.

Auxiliary views

Auxiliary views

The Auxiliary View command creates a new part view that shows the part rotated
90 degrees about a folding line. The drawing view is created from the axis of this
fold line. You can create auxiliary views from principal views and existing auxiliary
views.

Defining a folding line

The cursor is displayed as a line that is used to define the folding line. The auxiliary
view is created perpendicular to this folding line. To define the folding line, move
the cursor across the drawing view to highlight an edge that is perpendicular to the
desired auxiliary view.
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You also can define the folding line for a new auxiliary view by selecting two
keypoints using existing drawing view edges. Two points are required when a single,
linear element does not exist along the angle of the desired auxiliary view.
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Placing the auxiliary view
After defining the folding line, the cursor is displayed as a rectangle that is roughly
the size of the auxiliary view. To place the view, move the rectangle on the sheet to
position the view, and then click.

Modifying the auxiliary view
After you place the auxiliary view, you can:

• Move the viewing plane line in any direction using Shift+drag.

• Change the viewing plane line type, caption, and style in the Viewing Plane
Properties dialog box.

Auxiliary view and viewing plane captions
You can control caption display and formatting separately for the auxiliary view
and for the viewing plane line used to create it. In addition to showing and hiding
caption text using the Show Caption button on the command bar, you can change
the content and formatting of a caption.

• When you select a viewing plane line, you can use the Caption tab (Viewing
Plane, Detail Envelope, Cutting Plane Properties dialog box).

• When you select an auxiliary view, you can use the Caption tab (Drawing View
Properties dialog box).

You can reposition a caption by selecting the view and then dragging the label to a
new location.

The default viewing plane caption content and formatting is defined in the Drawing
View style that is applied to the auxiliary view. To learn more, see the following
Help topics:

• Drawing view styles

• Drawing view captions

Create an auxiliary view

1. Choose Home tab®Drawing Views group®Auxiliary View .

A representation of the viewing plane line is attached to the cursor. The auxiliary
view will be rotated 90 degrees about the viewing plane line.
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2. Move the cursor around on the drawing sheet. When the cursor locates a linear
element, the viewing plane line attached to the cursor becomes parallel to the
element.

3. Do one of the following:

• Click a located line to define it as the viewing plane line.

• Draw a viewing plane line by clicking two key points in the part view. The
new line is automatically defined as the viewing plane line.

The cursor becomes a rectangle that represents the size of the view that you
are going to create.

4. Position the auxiliary view where you want it, then click.

Where you place the view determines the direction of rotation of the auxiliary
view. The viewing plane is rotated toward the view location, as shown in the
figure.
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Tip

• You can create auxiliary views from both principal views and existing
auxiliary views.

• You can define the viewing plane line by selecting a linear edge or by
clicking two key points in a principal part view.

• The viewing plane line and auxiliary view are associative to the principal
view. If the geometry in the principal view changes, the viewing plane line
and auxiliary view update.

• You can move the viewing plane line in any direction using Shift+drag.

• You can use the Drawing View Style list on the Auxiliary View command
bar to choose a display style for the auxiliary view line. You also can
modify the appearance of an existing viewing plane line using the View
Plane Properties dialog box.

Auxiliary View command

Creates a new part view (A) that shows the part rotated 90 degrees about a viewing
plane line (B) on an existing part view. The viewing plane line can be parallel or
perpendicular to the geometry in the existing view.

You can use an auxiliary view to show geometry that cannot be dimensioned at any
of the orientations shown in principal views or existing auxiliary views.
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After you place the auxiliary view, you can:

• Move the viewing plane line in any direction using Shift+drag.

• Change the viewing plane line type, caption, and style in the Viewing Plane
Properties dialog box.

• Show or hide the viewing plane caption using the View Plane Selection command
bar.

Auxiliary View command bar

Drawing View Style Mapping
Specifies that the drawing view will use a predefined style, which is set on the
Drawing View Style tab of the Solid Edge Options dialog box.

When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Parallel
Specifies that you want the viewing plane line to be parallel to the selected
geometry element.

Perpendicular
Specifies that you want the viewing plane line to be perpendicular to the selected
geometry element.

Properties
Opens the Drawing View Properties dialog box so you can set display settings
for the auxiliary view.

Shading Options
Specifies color or grayscale, shading, and edge visibility for the drawing view.

Not Shaded
Displays color with visible and hidden edges, but no shading.
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Shaded
Displays color and shading, but no edges.

Shaded with Edges
Displays color and shading with visible edges.

Grayscale Shaded
Displays grayscale and shading, but no edges.

Grayscale Shaded with Edges
Displays grayscale with visible edges.

Viewing Plane Selection command bar

The Viewing Plane Selection command bar is displayed when you select the viewing
plane in a source view so that you can edit it.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Viewing plane name
Displays the viewing plane name. This label is system-generated using the
automatic naming sequence defined in the Specify Annotation Letters dialog
box. You can use the name the software supplies, or you can type one. All names
within one document must be unique.

You can modify the view annotation caption using the Caption tab of the Viewing
Plane Properties dialog box.

You can show and hide the auxiliary view plane name and related caption text
using the Show Caption option.

Show Caption
Displays a list of options for showing or hiding the viewing plane caption. If
the viewing plane caption is shown, you also can choose whether to show or
hide the view sheet number. You can adjust the position of the caption text
with the Select tool.

You can use these independent Show Caption controls to display the view sheet
number when the auxiliary view and the source view with the viewing plane
are on different sheets.

Note

You can use the following check box on the Annotation tab (Solid Edge
Options dialog box) to show the sheet number automatically when the
views are moved onto different sheets, and to hide the cross-reference
when the view are on the same sheet:

Show sheet number if parent annotation (e.g. cutting plane) and
derived view (e.g. section view) do not reside on the same sheet

Properties
Accesses the Viewing Plane Properties dialog box, where you can change the
viewing plane line properties and the viewing plane caption properties.
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Viewing Plane Properties dialog box

Sets properties for the viewing plane used to create an auxiliary view.

The Viewing Plane Properties dialog box is displayed when you click the viewing
plane line in a source view. You can change the direction of the viewing plane lines
and modify the viewing plane caption.

Tabs
General

Caption

General tab (Viewing Plane Properties dialog box)

Modifies the line and terminator properties of a selected view plane annotation.

Line Type
Specifies the line type, such as dashed or dotted.

Line Width
Sets the line width.

Terminator
Sets options for terminators.

Type
Sets the terminator type for all terminators.

Length
Specifies a value for the size of the terminator length used in the view plane.
This value is a ratio of the terminator size specified in the dimension style.

View Direction Lines
Sets the view direction options.

Single
Specifies that a single terminator line is displayed.

Double
Specifies that a double terminator line is displayed.
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Caption tab (Viewing Plane, Detail Envelope, Cutting Plane Properties dialog box)

The Caption tab in the Properties dialog box modifies the caption text and formatting
options for a view annotation. The specific options that are available vary with
the type of annotation that is selected.

Drawing View style
Specifies the drawing view style to associate with the view annotation caption.

Drawing view styles are mapped to drawing view types and view annotation
types on the Drawing View Style tab (Solid Edge Options dialog box).

Caption
The Caption options display and modify the caption content that has been defined
for the view annotation in the Caption tab (Drawing View Style dialog box).

Caption
Specifies the content for the currently selected view annotation caption. You
can create a caption that contains a single line of plain text, property text,
and symbols using the Properties buttons and by typing directly in the box.

Show
Specifies whether the view annotation caption is displayed by default on
the source view containing the cutting plane line, viewing plane line, or
detail envelope.

Properties buttons
• The View Annotation Name and View Sheet Number buttons insert
property text codes, which in turn reference the corresponding definitions
in the Properties section at the bottom of the dialog box.

• The Property Text button inserts property text strings that reference
other sources.

• The Symbols button inserts property text codes that convert to symbols.

Properties buttons

Use this To generate
this string

To extract
this content Example From this

source
%VA View

annotation
name

A The content
in the View
Annotation
Name (%VA)
Properties box.
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Properties buttons

Use this To generate
this string

To extract
this content Example From this

source
%VN View sheet

number
(2) The current

sheet number
where the
source view
is located.

%{Author} Selects and
inserts any
property
text strings
associated
with the Draft
document or
the model.

J. Simon Select Property
Text dialog box

These property
text codes:

%PM

%DI

%DG

You can select
symbols and
values for
insertion at the
current cursor
position in the
caption.

Generate these
symbols:

±

°

Æ

Select Symbols
and Values
dialog box

Format
The Format options display and modify the appearance of the view annotation
caption that has been defined in the Caption Format tab (Drawing View Style
dialog box).

Font
Lists the available fonts. Applies the font to the currently selected view
annotation caption text.

Font style
Applies Regular, Bold, Italic, or Bold Italic font style to the currently selected
view annotation caption text.

Color
Specifies the text color for the currently selected view annotation caption
text.

Size
Specifies the text size for the text in the currently selected view annotation
caption text.

Properties edit boxes
The Properties boxes define the content that is referenced by the %VA and %VN
property text codes when they are inserted in the Caption text box.

View Annotation Name (%VA)
Specifies the alphanumeric characters to use for labeling the view annotation.

The displayed label is system-generated using the automatic naming
sequence defined in the Specify Annotation Letters dialog box.
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Example

Primary labels:

A

Appended letters and numbers, which can be regular font or
subscript:

AA - AA

A1 - A1

You can edit the label after placement, but only if it is not in Follow defined
object sequence mode. Even then, you can override the label definition for a
specific view.

To learn more, see Drawing view captions.

Auto
When checked, automatically names the viewing plane line, cutting plane
line, or the detail envelope using the naming sequence defined in the Specify
Annotation Letters dialog box, and using the order specified in the Define
Object Sequence dialog box.

When unchecked, you can edit the label for the currently selected view
annotation.

Note

• This option is checked by default when Follow defined object
sequence is selected on the Annotation tab (Solid Edge Options
dialog box).

• This option is not available when Follow object creation sequence
is selected on the Annotation tab (Solid Edge Options dialog box).

View Sheet Number (%VN)
Specifies the content to display when the view sheet number is shown in
the view annotation caption.

Inserts the property text string for the View Sheet Number into the View
Sheet Number text box.

The view sheet number is useful when the source view with the view
annotation and the derived view—the section, detail, or auxiliary view—are
moved to different sheets.
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Show
The Show check box is available when a detail envelope, viewing plane line,
or cutting plane line is selected. It displays the sheet number where the
detail view, auxiliary view, or section view is located when the %VN property
text exists in the Caption text box.

Note

You can use the following check box on the Annotation tab (Solid Edge
Options dialog box) to show the sheet number automatically when the
views are moved onto different sheets, and to hide the cross-reference
when the views are on the same sheet:

• Show sheet number if parent annotation (e.g. cutting plane) and
derived view (e.g. section view) do not reside on the same sheet

At
The At list is available when a cutting plane line or a viewing plane line
is selected. It specifies where to display the view sheet number, when the
Show check box is selected. The options are at the Left Arrow, Right Arrow,
or at Both Arrows of the view annotation. The number of lines actually
displayed is controlled by the Single or Double setting on the General tab
of the Properties dialog box.

Note

You can specify display location only when the View Direction Lines
are set to Double on the General tab (Viewing Plane Properties dialog
box).

Perspective views

Perspective views

Creating perspective drawing views
There are two methods for defining a perspective view to place on a drawing.

• In the model document, you can first add perspective to a window, and then use

the View Orientation command to save a new named view with perspective.

Perspective views created in this manner can be selected from the Named Views
list in the Drawing View Creation Wizard (Drawing View Orientation). Look for
the view name with –Perspective appended to it.

• In a draft document, you can create a perspective drawing view using the
Custom Orientation dialog box of the Drawing View Creation Wizard.

This method creates an ad hoc perspective view to place on the drawing without
opening the model document.

What is perspective?
When perspective is applied to a model view, objects that are farther away appear
smaller. This is achieved through perspective angle, which makes perspective views
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more realistic than isometric views. In isometric views, objects in the model appear
uniformly sized no matter how far they are from the viewer.

Example

As the perspective angle increases, the distance to the object decreases,
making the object appear closer. The angle in the first picture (A) is wider
than the angle in the second (B), so that the first picture appears closer.

There are some limitations to perspective views. You cannot:

• Create a perspective view from a camera point that is inside the model.

• Add dimensions to a perspective view.

• Generate hidden edges.

• Create additional views from a source perspective view.

Defining perspective distance and angle

Perspective is defined by the combination of the perspective angle, zoom distance,
and pan. These values define the camera through which the model is viewed.

You can change all of these values in the Custom Orientation dialog box in Draft.

• To change the perspective angle, use the Perspective option. You can choose a
predefined angle from the Perspective Angle list, or you can define a custom
perspective angle using Shift+Ctrl while rotating the mouse wheel.

• To change the zoom distance, use the Zoom Area or Zoom options.

• To focus on one area of the model, use the Pan option to center that part of the
model within the window.

Note

The Perspective command in the model document quickly adds perspective to,
or removes perspective from, the model as it is currently displayed. However,
you cannot change the perspective angle with this command.

Create a perspective drawing view

1. Choose Home tab®Drawing Views group®View Wizard .
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2. In the Select Model dialog box, select a part, sheet metal, or assembly document,
and then click Open.

3. On the Drawing View Creation Wizard (Drawing View Options) page, click Next.

4. On the Drawing View Creation Wizard (Drawing View Orientation) page, click
Custom.

5. In the Custom Orientation dialog box, press the left mouse button as you move
the mouse to adjust the model orientation. When the model approximates the
desired orientation for the perspective view, release the button.

6. In the Custom Orientation dialog box, do one of the following:

(Select a predefined perspective angle)

• Click the Perspective button , and then select a value from the
Perspective Angle list.

Values are based on the focal length of a 35 mm camera.

o Portrait (85 mm)

o Normal (50 mm)

o Wide (35 mm)

o Very wide (10 mm)

(Define a custom perspective angle)
a. Press Ctrl+Shift while you rotate the mouse wheel to change the
perspective view angle and distance.

The model updates with each movement of the wheel.

b. Click the Perspective button to apply the perspective angle to the
view.

This value is stored as the new Custom angle for the view.

7. Click Close.

8. On the drawing sheet, click to place the view.

Tip

Before you click to place the view, you can automatically size the view to the
sheet by selecting the Best Fit option on the command bar.
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Detail views

Detail views

You can use the Detail View command to create an enlarged view of a specific area
of an existing drawing view. You can think of a detail view as a magnifying glass
focused on a special area within a drawing view.

You can create circular detail views or detail views using a closed profile you draw.
You can create dependent detail views that update when the source view changes,
and you can create independent detail views that do not reflect changes made in the
source drawing view. Similarly, independent detail views allow you to add geometry
with the Draw In View command and show or hide edges with Edge Painter without
affecting the source view.

Dependent and Independent Detail Views

• Dependent detail views are tied to the source view from which they are created.
To change shading, edge display, or other aspects of the dependent detail view,
you must make the change in the source view and then update both views.

• Independent detail views can have different display properties than the source
drawing view. For example, you can show or hide parts, display hidden lines,
add shading, or draw in the independent detail view without affecting the source
drawing view.

• Both dependent and independent views can be created from 3D geometry
contained in principal views, auxiliary views, other detail views, section views,
and broken out section views.

• You can create a dependent detail view–but not an independent one–from a 2D
Model view and from a drawing view that has been converted to 2D.

• You can not create detail views from drawing views that are out of date.

Converting dependent detail views

Once created, you can convert a dependent detail view to an independent detail
view by selecting the view then selecting the Convert to Independent Detail View
command on the shortcut menu. However, you can not convert an independent
detail view to a dependent view.
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Creating a circular detail view

You define a circular detail view using the Circular Detail View option on the
command bar. You can then specify the detail view envelope using three clicks of the
mouse. The first click (1) defines the center of the circular area to enlarge on the
source view, the second click (2) defines the diameter of the detail view circle, and
the third click (3) places the detail view.

Creating a user-defined shape for a detail view

You define a user-defined shape for a detail view using Define Profile option on the
command bar. You can then draw a profile the size and shape you want. Any closed
profile can be a valid detail envelope.
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Modifying detail views

Once created, both dependent and independent views can be modified with different
results. Dependent detail views are associative to the source view. When you make
changes to the geometry in the dependent detail view, the source view changes.
Independent detail views do not reference the source view, nor are changes made in
the independent view reflected in the source view. Independent detail views can be
used to show or hide parts, display hidden lines, add shading, or draw in the view
without affecting the source view geometry or view properties.

Drawing view properties

To modify a dependent or independent detail view, use the Select tool and the options
on the Drawing View Selection command bar to change drawing view scale, show and
hide caption text, or choose a shaded or hidden line display. You also can select the
Properties button to open the Drawing View Properties dialog box. The tabs that are
available contain properties that you can change, which vary with detail view type.

Detail view and detail envelope captions

You can control caption display and formatting separately for the detail view and for
the detail envelope. In addition to showing and hiding caption text using the Show
Caption button on the command bar, you can change the content and formatting
of a caption.

• When you select a detail envelope, you can use the Caption tab (Viewing Plane,
Detail Envelope, Cutting Plane Properties dialog box).

• When you select a detail view, you can use the Caption tab (Drawing View
Properties dialog box).

You can reposition a caption by selecting the view and then dragging the label to a
new location.

The default detail envelope caption content and formatting is defined in the Drawing
View style that is applied to the detail view. To learn more, see these Help topics:

• Drawing view styles

• Drawing view captions
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Detail view tool tip
If you pause the cursor over a detail view, a tooltip identifies the name of the source
geometry file, the file type, and the view type. For example, the full tooltip for an
independent detail view of a screw might display: High Quality View - Independent
Detail View - AllenScrewM8.par. The tooltip text for a dependent detail view is
simply High Quality View - Detail View - AllenScrewM8.par.

If you don’t see these tooltips displayed on the drawing view, set the Show tool tips
option on the Helpers tab of the Solid Edge Options dialog box.

Detail view border
You can hide the display of the border of the detail view after you place it. If you
select the detail view border, and then select the Properties button on the command
bar, you can clear the Show Detail View Border option in the Drawing View
Properties dialog box.
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Detail envelope

The detail envelope drawn on the source view in the shape of a circle or user-defined
profile defines the cropping boundary of the detail view. You can use the Drawing
Standards tab on the Solid Edge Options dialog box to set the display standards for
the detail envelope. For example, you can specify that the detail envelope display
conforms to (A) ANSI, (B) ISO/DIN/JIS, or (C) ESKD standards.

You can drag a detail envelope to change its location. However, if the detail envelope
is partially or fully constrained, the detail envelope will behave according to the
rules of its constraints.

You can modify the detail envelope by selecting it in the original view, and then
selecting Define Profile on the command bar. You can drag the detail envelope
profile handles to change the size of the detail envelope. Dependent detail views on
the drawing are updated when you change the size, shape, or location of the detail
envelope on the source view.

If you delete the detail envelope on the source view, the detail view is also deleted.

Displaying cropping edges

You can use the Display Cropping Edges option on the Annotation page of the Detail
View Properties dialog box to specify whether edges are displayed where the drawing
view boundary intersects the model. Edges are not generated where the boundary
passes over holes or voids in the model.

When you change this option on an existing drawing view, the drawing view becomes
out of date. You can update the drawing view using the Update Views command.
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Create a circular detail view

1. Choose the Detail command .

2. (Specify detail view type) On the Detail command bar, do one of the following:

• To create an independent detail view, select the Independent Detail View

button .

• To create a dependent detail view, clear the Independent Detail View button.

3. (Specify detail view envelope shape) On the Detail command bar, verify that the

Circular Detail View button is selected .

The default detail view shape is circular.

4. In the source drawing view, click the center of the area you want to see in the
detail view.

5. Move the cursor until the circular detail envelope is the size you want, and
then click.

6. Click to place the detail view on the drawing.

Tip

• Only graphics enclosed by the detail envelope are displayed in the detail
view.

• Modify the detail view

After the detail view is placed, click the detail view border to edit scale,
show or hide the detail view caption, and change display mode using the
options on the Drawing View Selection command bar.

You can modify the default content of the caption on the detail view by
clicking the Properties button on the command bar, and then making
changes using the Caption tab (Drawing View Properties dialog box).

• Modify the detail envelope

You can edit the detail envelope attributes by clicking the envelope in the
source view, and then setting options on the Detail Envelope Selection
command bar.

You can modify the default content and formatting of the detail envelope
caption by clicking the Properties button on the command bar, and then
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making changes using the Caption tab in the Detail Envelope Properties
dialog box.

Create a user-defined detail view

1. Choose the Detail command.

2. (Specify detail view type) On the Detail command bar, do one of the following:

• To create an independent detail view, set the Independent Detail View

button .

• To create a dependent detail view, clear the Independent Detail View button

.

3. (Specify detail view envelope shape) The default detail view shape is circular. To

draw a user-defined profile, click the Define Profile button .

4. Click the source drawing view that you want to detail.

The Line command bar is displayed.

5. (Draw the profile) Do the following:

a. On the command bar, select the Line option to draw a linear detail envelope,
or select the Arc option to draw a curved detail envelope.

b. In the source drawing view, draw a 2D shape around the area that you want
to detail.

6. On the ribbon, choose Home tab®Close group®Close Detail Envelope.

7. Click to place the detail view on the drawing.
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Tip

• Only graphics enclosed by the detail envelope are displayed in the detail
view.

• Modify the detail view

After the detail view is placed, click the detail view border to edit scale,
show or hide the detail view caption, and change display mode using the
options on the Drawing View Selection command bar.

You can modify the default content of the caption on the detail view by
clicking the Properties button on the command bar, and then making
changes using the Caption tab (Drawing View Properties dialog box).

• Modify the detail envelope

You can edit the detail envelope attributes by clicking the envelope in the
source view, and then setting options on the Detail Envelope Selection
command bar.

You can modify the default content and formatting of the detail envelope
caption by clicking the Properties button on the command bar, and then
making changes using the Caption tab in the Detail Envelope Properties
dialog box.

Detail command

Creates an enlarged detail view from an existing drawing view.

Detail envelope shape

You can create a circular detail view or draw a custom profile of any closed shape.
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Dependent and independent detail views

Before placing a detail view on the drawing, you can specify whether the detail
view is a dependent detail view or an independent detail view using the Detail
command bar.

Independent detail views are useful when you want the display properties in
the detail view to be different than the source drawing view. For example, on an
assembly drawing, you can specify that parts are hidden in an independent detail
view that are displayed in the source view.

Once created, you can convert a dependent detail view to an independent detail
view by selecting the view, then selecting the Convert to Independent Detail View
command on the shortcut menu.

Detail command bar

Drawing View Style Mapping
Specifies that the drawing view uses a predefined style, which is set on the
Drawing View Style tab (Solid Edge Options dialog box).

When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Scale
Defines the scale of the detail view. The scale is calculated with respect to
the drawing sheet, not the original drawing view. For example, if the original
drawing view is 2:1 scale, and you set the detail view scale to 2:1, the detail
view will be 2:1, not 4:1.

By default the scale is twice that of the scale specified for the original drawing
view.

Circular Detail View
Specifies that the detail view is defined using a circular detail envelope.

Define Profile
Specifies that the detail view is defined using a profile you draw. The profile
must be a closed shape.
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Independent Detail View
Specifies whether a dependent detail view or an independent detail view is
created.

Convert to Independent Detail View command

Converts a dependent detail view to an independent detail view. If the dependent
view contains annotations, dimensions, or other information, that information is
copied when the detail view is converted.

Detail envelopes

Set detail envelope properties

1. In the source view, click the detail envelope.

2. On the Detail Envelope Selection command bar, click the Properties button .

3. On the Detail Envelope Properties dialog box, set the options you want to use.

Tip

• You can also set the detail envelope properties using the Properties
command on the shortcut menu of the detail envelope.

Detail Envelope Selection command bar

The Detail Envelope Selection command bar is displayed when you select the detail
envelope in a source view so that you can edit it. After you have placed the detail
view, you can select its circular or custom border to edit view properties.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Detail envelope name
Displays the characters assigned to the detail envelope name. The label is
system-generated using the automatic naming sequence defined in the Specify
Annotation Letters dialog box. You can use the name the software supplies, or
you can type one. All names within one document must be unique.

You can modify the detail envelope caption using the Caption tab of the Detail
Envelope Properties dialog box.

You can show and hide the detail envelope name and related caption text using
the Show Caption option.

Show Caption
Displays a list of options for showing or hiding the detail envelope caption. If
the detail envelope caption is shown, you also can choose whether to show or
hide the view sheet number. You can adjust the position of the caption text
with the Select tool.

You can use these independent Show Caption controls to display the view sheet
number when the detail view and the source view with the detail envelope are
on different sheets.
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Note

You can use the following check box on the Annotation tab (Solid Edge
Options dialog box) to show the sheet number automatically when the
views are moved onto different sheets, and to hide the cross-reference
when the views are on the same sheet:

Show sheet number if parent annotation (e.g. cutting plane) and
derived view (e.g. section view) do not reside on the same sheet

Properties
Accesses the Detail Envelope Properties dialog box, where you can change the
envelope color and line properties and the detail envelope caption properties.

Define Profile
Displays the detail envelope editing tools on the ribbon, so you can draw a new
detail envelope profile or edit an existing detail envelope shape.

Detail Envelope Properties dialog box

The Detail Envelope Properties dialog box is displayed when you click the detail
envelope in a source view. Use the options on this dialog box to edit the envelope
color and line properties and the detail envelope caption properties.

Tabs

General

Caption

General tab (Detail Envelope Properties dialog box)

The General tab on the Detail Envelope Properties dialog box specifies properties for
the detail envelope in the source view.

Line type
Specifies the line type, such as dashed or dotted.

Line width
Sets the line width.

Detail envelope
Specifies how the detail envelope is displayed on the source drawing view. You
can choose from one of several standards-based formats.

ANSI
Specifies that the detail envelope is displayed consistent with ANSI
standards. The detail view caption is embedded within the detail view circle.

ISO/DIN/JIS
Specifies that the detail envelope is displayed consistent with ISO/DIN/JIS
standards. The detail view caption is displayed adjacent to the detail view
circle.
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ESKD
Specifies that the detail envelope is displayed consistent with ESKD
standards. The detail view caption and a leader line are displayed.

Display as circle
Specifies that the detail envelope is displayed as a circle when a user-defined
profile is drawn. This option may not be available for some detail envelope
options.

Section views

Section views

After you create a part view, you can use it to create a section view. A section view
displays a cross section of the 3D part or assembly model. Sectioned areas are
automatically filled.

You can create section views with the Section View command and the Broken-Out
command.

Before you can create a section view with the Section View command, you must
create a cutting plane on the part view you want to use as the basis for the section
view using the Cutting Plane command.

You can use the Broken-Out command to create a broken-out section view of internal
regions to a depth you define. This allows you to expose interior features of a part
so you can document them. With the Broken-Out command you draw the profile
within the command.
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Selecting a part view

When you click the Cutting Plane button you are prompted to select a part view.
This can be any orthographic, auxiliary, or detail view on the drawing. Click on
the view geometry to select it.

Auxiliary views often show the part at the optimal orientation for making the section
cut. A detail view can be useful for creating sections due to its scale.

Sections created from detail views inherit the same scale as the detail view.

Drawing a cutting plane

You draw a cutting plane using many of the drawing tools you find elsewhere in
Solid Edge. When you click the Cutting Plane button and then select a part view, the
command ribbon updates and displays commands for drawing a cutting plane.

A cutting plane can consist of a single line or multiple elements, such as lines and
arcs. If you draw a cutting plane that consists of more than one element, the cutting
plane must meet the following requirements:

• The elements must meet at their end points.

• The elements cannot form a closed region or have loops.

• The elements cannot cross each other.

• Any arcs in the cutting plane cannot be the first or last element.

• Any arcs must be connected to a line at both ends of the arc.

If you draw a cutting plane on a detail view so that it extends beyond the cropping
boundary, then the geometry outside the detail view, to the extent of the cutting
plane, will be included in the section view. If you draw the cutting plane so that
it is completely contained within the detail view, then only that geometry will be
included in the section view.

You can add dimensions and relationships between the cutting plane and the part
view to control the position, size, and orientation of the cutting plane.

When you have finished drawing the cutting plane, click the Close button on the
home tab. You can then dynamically define the cutting plane view direction by
clicking on one side of the view to be sectioned. If you need to change the view
direction, you can use the cursor to drag the cutting plane view direction lines to
the opposite side of the cutting plane.

You can edit the cutting plane by double-clicking it, or right-click the cutting plane
and select Properties on the shortcut menu.
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Placing the section view

When you select the Section View command, you are prompted to select a cutting
plane. After you select the cutting plane, a rectangle the size of the section view you
are going to place is displayed on the cursor. Also, options on the command bar
are activated that allow you to specify the type of section view you want to create.
When you position the view and click, the section view is created so that it is aligned
with the cutting plane.

Note

The view direction of the section view is defined by the cutting plane. The
side on which you place the view, relative to the cutting plane, has no effect
on view direction.

Displaying the cutting plane

After a cutting plane is created, you can control the display of cutting plane lines by
selecting the cutting plane annotation and then using the options on the Cutting
Plane Selection command bar and in the Cutting Plane Properties dialog box.

After a section view is placed, you can control the display of the cutting plane
graphics using the following check box on the General tab (Drawing View Properties
dialog box):

Show view annotation (Cutting Plane, Detail Envelope, Viewing Plane)

You also can hide the cutting plane by moving the cutting plane element to its own
layer, and then hiding the layer. To learn how to do this, see the Help topic, Hide a
cutting plane.

You can control the display of edges resulting from cutting plane lines created with
multiple line segments using the Advanced Edge Display Options dialog box or in
the Drawing View Properties dialog box. To learn how, see Show or hide cutting
plane lines in section views.

Section view and cutting plane captions

You can control caption display and formatting separately for the section view and
for the cutting plane. In addition to showing and hiding caption text using the Show
Caption button on the command bar, you can change the content and formatting
of a caption.

• When you select a cutting plane, you can use the Caption tab (Viewing Plane,
Detail Envelope, Cutting Plane Properties dialog box).

• When you select a section view, you can use the Caption tab (Drawing View
Properties dialog box).

You can reposition a caption by selecting the view and then dragging the label to a
new location.

The default content and appearance of section view captions, cutting plane captions,
and cutting plane lines are defined in the Drawing View style that is applied to the
view. You can set these options in your custom draft templates to make it easier to
create cutting plane and view plane annotations that automatically conform to your
standards. To learn more, see these Help topics:
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• Drawing view styles

• Drawing view captions
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Formatting fill and hatch patterns in section views

When you place a section view, you can use the Section command bar to select a fill
style to define the pattern displayed in the sectioned areas of the part. You also can
specify the spacing and angle of the fill area when you place the section view.

After the view is created, you can change the fill style, hatch spacing, and hatch angle
on cut faces using options on the Display tab (Drawing View Properties dialog box).
You can do this for one or more parts selected in the Parts list on the Display tab.

You also can control hatching on cut ribs in a section view, and you can use the
Draw In View command to edit the individual hatch lines. See Modifying section
views, below, to learn about these options.

If you want more control over the properties of the fill pattern, you can create a new
hatch style, and then use the hatch style to define a new fill style. Hatch styles enable
you to define color, line width, spacing, and angle properties to apply to a pattern.
You can use the following options on the Edge Display tab (Solid Edge Options dialog
box) to select the fill style to apply to newly created section views, and to specify
whether the hatching on individual parts can be different from the default style:

• Show Fill style in section view

• Derive from part

• Automatically alternate hatch spacing in section views

• Automatically alternate hatch angle in section views
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Revolved section views

On certain types of parts you can create a revolved section view to more accurately
view the features on the part. To create a revolved section view, select a cutting plane
consisting of two or more lines, then set the Revolved Section View option on the
command bar. The Revolved Section View option is only available when you create a
section view. You cannot change this option when you modify an existing section view.

Multiple segment cutting planes

If the cutting plane is defined by multiple lines that are not orthogonal, or the first
and last lines in the cutting plane are not parallel, you must specify whether the
first line (A) or last line (B) in the cutting plane will be used to define the fold angle
for the section view rotation. The line you select affects the placement angle of the
section view.
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Arcs in cutting planes

You can also include arcs in cutting planes. If an arc is included in the cutting plane,
it must be connected to a line at both ends. You cannot begin or end a cutting plane
with an arc. Also, when you create a section view from a cutting plane that includes
an arc, the Revolved Section View option on the command bar is automatically set
and cannot be cleared.

Arcs are ignored for sectioning and view creation. Rather, they serve to carry the
cutting plane line from one area of the model to another.

Note

You cannot create additional section views from a section view that was
generated from a cutting plane that includes an arc.

Section-only (thin-section or paper thin) views

To create a section view that does not include the geometry behind it, use the Section
Only button on the command bar. This option creates a section view where only the
thin slice of geometry that intersects the cutting plane is displayed. The geometry
that is beyond the cutting plane is not processed or displayed. For example, you can
create a section view of a part in which the keyway feature is not displayed.
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To further illustrate this, if you were to rotate a typical section view and a Section
Only section view, you would see half of the part with a typical section view (A), but
only a thin slice of the part with a Section Only section view (B).

This option is useful when creating sections of complex parts and assemblies where
displaying the geometry behind the cutting plane would be confusing or unnecessary.
Section views placed with the Section Only option also process faster than standard
section views.

You can also create a revolved section view using the Section Only option.

To learn how, see Create a thin section view.
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Thin section views of assemblies

When working with a large or complex assembly, the processing time improvement
with the Section Only option can be significant because fewer parts are processed.
For example, in Section A-A below, all the parts beyond the cutting plane must be
processed in a standard section view, but when you set the Section Only option
for Section B-B, only the parts that are intersected by the cutting plane line are
processed.

Note

You cannot create additional section views from a Section Only section view.

Creating a section view from an existing section view

You can also create a new section view from an existing section view.

9-114 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

When you create a new section view from an existing section view, you can use the
Section Only and Section Full Model options on the command bar to control the
appearance of the new section view. For example, when you create the new section
view B-B using Section A-A as the source view, there are four output options:

The Section Only and Section Full Model
options are cleared

The Section Only option is set

The Section Full Model option is set The Section Only and Section Full Model
options are set

The Section Only and Section Full Model options are only available when you
create a section view. You cannot change these options when you modify an existing
section view.

Section views in assembly drawings

For assemblies, you can specify which parts you want to section by using the Model
Display Settings button on the Section View command bar. After the section view is
created, you can change these settings by editing the properties of the section view.

The fill angle you specify for the section view is rotated 90 degrees for each sectioned
part. After the section view is created, you can edit the fill and apply different styles
and overrides.
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Modifying section views

Placement and alignment

You can modify the placement and alignment of the section view directly on the
drawing sheet. To modify the section view’s position, click and drag the view.

Hatching on cut ribs

You can use the Hatch ribs in section views option on the Advanced tab (Drawing
View Property dialog box) to specify whether the ribs and rib-like features
created with the Rib, Mounting Boss, Web Network, or Pattern commands are
cut and hatched or not hatched.

When you choose the no hatching option, then you also can use the Override Rib
Hatching dialog box to selectively identify individual ribs for display using the
hatch style. See the Help topic, Set rib hatching in section views.

Many drawing standards call for cut ribs not to display with hatching in section
views. You can set a file preference to honor this on the Drawing Standards
tab (Solid Edge Options dialog box).

Hatching on partially visible cut faces

Hatching on partially visible cut faces is controlled by the Process partially
hidden cut faces setting on the Advanced tab in the Drawing View Properties
dialog. When you set this option and update the section view, any hatching on
partially visible hidden cut faces is reprocessed. This can eliminate the need to
remove excess hatching using the Draw in View command.

Simplifying the section drawing view

You can simplify a section or broken-out section drawing view so that the area
exposed by the cutting plane is easier to see. Use the Set Drawing View Display
Depth command on the drawing view shortcut menu to set the visible display
depth beyond which all model geometry will be removed by a back clipping plane.

Showing cut and uncut hardware

You can use the Cut hardware check box on the Display tab (Drawing View
Properties dialog box) to specify whether hardware parts—such as nuts, bolts,
and washers—are cut when intersected by the cutting plane in section views.

Displaying thread graphics

When the cut is along the axis of a hole shown in a paper-thin section drawing
view, you can use the Show threads in Section Only section views option on the
Annotation tab (Drawing View Properties dialog box) to display hole threads.

Note

You can create internal threaded holes in the model when you use the Hole
command and set the Type to Threaded on the Hole Options dialog box.

To learn about creating threaded holes in the model, see Threaded
features.

Section View command (Draft environment)
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Creates a section view of a 3D part or assembly model from a selected cutting plane.

You can use the options on the command bar to define the type of section view you
want. For example, you can create:

Simple Section Views

Revolved Section Views

Section-Only (Thin-Section) Views

Section View command bar

The Section View command bar is displayed when creating a section view. The
Drawing View Selection command bar is available when editing a section view.

For more information on creating section views, see the Section views Help topic.

Drawing View Style Mapping
Specifies that the drawing view will use a predefined style, which is set on the
Drawing View Style tab of the Solid Edge Options dialog box.
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When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the drawing view. This option is not available when Drawing
View Style Mapping is enabled.

Fill Style
Selects the active fill style. The available fill styles conform to the commonly
used section line standards that represent the material type being sectioned,
such as steel, cast iron, and brass.

After the view is created, you can edit the fill pattern and hatching on cut faces
using the Fill style, Angle, and Spacing options on the Display tab (Drawing
View Properties dialog box).

Angle
Sets the angle for the fill pattern.

For newly created section views, you can specify that the hatch angle is
automatically rotated 90 degrees to prevent adjacent parts from having the
same fill pattern. You can do this on the Edge Display tab (Solid Edge Options
dialog box).

After the view is created, you can edit the fill pattern and hatching on cut faces
using the Fill style, Angle, and Spacing options on the Display tab (Drawing
View Properties dialog box).

Spacing
Adjusts the spacing of the pattern lines in a fill.

For newly created section views, you can specify that the hatch spacing is
automatically adjusted to prevent adjacent parts from having the same fill
pattern. You can do this on the Edge Display tab (Solid Edge Options dialog box)

After the view is created, you can edit the fill pattern and hatching on cut faces
using the Fill style, Angle, and Spacing options on the Display tab (Drawing
View Properties dialog box).

Section Only
Displays only the geometry that physically intersects the cutting plane. The
Section Only option is useful when creating section views of complex parts or
assemblies; it prevents geometry that lies beyond the cutting plane line from
being displayed. Section views placed with the Section Only option also process
faster than standard section views.

When you use the Section Only option to create a section view of a part, the
edges, faces, and features that lie beyond the cutting plane line are ignored.
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When you use the Section Only option to create a section view of an assembly,
the edges, faces, features, and parts that lie beyond the cutting plane line are
ignored.

This option is available only while you create a section view; it cannot be applied
to a previously created section view.

Revolved Section View
Creates a revolved section view. You must select a cutting plane that consists of
two or more lines to create this type of section view.

If the cutting plane is defined by multiple lines that are not orthogonal, or
the first and last lines in the cutting plane are not parallel, you must specify
whether the first line (A) or last line (B) in the cutting plane will be used to
define the fold angle for the section view rotation. The line you select affects the
placement angle of the section view.
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Section Full Model
Creates a section view of the entire model. This option is available only when
you create a section view from an existing section view. When this option is
set, the new section view (A) is based on the entire model. When this option is
cleared, the new section view is based on the results of the previous section view
(B). This option is available only while you create a section view. You cannot
apply this option to a previously created section view.

Model Display Settings
Accesses the Drawing View Properties dialog box so you can set the display
options for the section view. For example, when working with a section view of
an assembly, you can use the Display tab on the Drawing View Properties dialog
box to specify which parts are displayed or hidden in the drawing view.

Shading Options
Specifies color or grayscale, shading, and edge visibility for the drawing view.

Not Shaded
Displays color with visible and hidden edges, but no shading.

Shaded
Displays color and shading, but no edges.

Shaded with Edges
Displays color and shading with visible edges.

Grayscale Shaded
Displays grayscale and shading, but no edges.

Grayscale Shaded with Edges
Displays grayscale with visible edges.

Create a section view

1. Choose Home tab®Drawing Views group®Section View

.

2. Click a cutting plane.
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Tip

If you select a cutting plane with unparallel first and last lines, click the
first or last line to define a fold angle for the section view.

3. On the command bar, set the section view options you want to use.

4. On the drawing sheet, click to position the section view.

Tip

• A cutting plane can be used to create only one section view. Before you
can use a cutting plane to create another section view, you must delete
the first section view.

• To hide edges created by a cutting plane line with multiple segments, clear
the Show Edges Created By Cutting Plane Line Vertices option. You can
set this option in two places in the draft document.

o To set this as a preference for new section views, on the Solid Edge
Options dialog box, click the Edge Display tab, and then click
Advanced.

o To show or hide the cutting plane line edge in an existing drawing
view, from its shortcut menu, choose Properties, and then click the
Advanced tab.

• To change the section view direction, edit the view direction lines on the
selected cutting plane.

• You can use fill and hatch styles to define the patterned area of a section
view.

Section view options

• You can use the Section Only option to create a thin-section view that
displays only the graphics that are physically cut by the cutting plane.
This option is available only while creating a section view.

• For assembly models, you can use the Model Display Settings dialog box
to show and hide parts before you click to place the section view.

Section view alignment

• When you click to position the section view, the section view is created so
that it is aligned with the cutting plane.

• If you specified a fold line, then the new view is aligned to the fold line.

Section views from section views

• You can create a new section view using an existing section view.

• You can create a new section view from a rotated view. The new view
has no alignment.
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Create a revolved section view

1. Choose Home tab®Drawing Viewsgroup®Section View

.

2. Click a multi-line cutting plane.

3. On the command bar, set the Revolved Section option.

4. If you selected a cutting plane with unparallel first and last lines, click the first
or last line to define a fold angle for the section view.

5. On the drawing sheet, click to position the revolved section view .

Tip

• A cutting plane can be used to create only one section view. Before you
can use a cutting plane to create another section view, you must delete
the first section view.

• To hide edges created by a cutting plane line with multiple segments, clear
the Show Edges Created By Cutting Plane Line Vertices option. You can
set this option in two places in the draft document.

o To set this as a preference for new section views, on the Solid Edge
Options dialog box, click the Edge Display tab, and then click
Advanced.

o To show or hide the cutting plane line edges in an existing drawing
view, from its shortcut menu, choose Properties, and then click the
Advanced tab.

• To change the section view direction, edit the view direction lines on the
selected cutting plane.

• You can use fill and hatch styles to define the patterned area of a section
view.

Section view options

• You can use the Section Only option to create a thin-section view that
displays only the graphics that are physically cut by the cutting plane.
This option is available only while creating a section view.

• For assembly models, you can use the Model Display Settings dialog box
to show and hide parts before you click to place the section view.

Section view alignment

• When you click to position the section view, the section view is created so
that it is aligned with the cutting plane.

• If you specified a fold line, then the new view is aligned to the fold line.
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Section views from section views

• You can create a new section view using an existing section view.

• You can create a new section view from a rotated view. The new view
has no alignment.

Create a thin-section view

You can use the Section Only option to create a thin-section section view that
displays only the geometry that intersects the cutting plane. The resulting section
view does not include the geometry behind it.

1. Choose Home tab®Drawing views group®Section View.

2. Click a cutting plane.

3. On the command bar, click Section Only.

4. On the drawing sheet, click to position the thin-section view .

Show or hide cutting plane lines in section views

When you create a section view using a cutting plane that is defined by multiple line
segments, you can use the Show Edges Created By Cutting Plane Line Vertices
option to show or hide the resulting edges in a drawing view. You can set this option
in two places in the draft document.

Set the display of cutting plane lines for new drawing views

1. In the draft document, choose Application menu®Solid Edge Options.

2. In the Options dialog box, click the Edge Display tab.

3. Click Advanced.
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4. On the Advanced Edge Display page, do one of the following:

• To hide the edges, clear the Show Edges Created By Cutting Plane Line
Vertices check box.

• To show the edges, set the Show Edges Created By Cutting Plane Line
Vertices check box.

Show or hide cutting plane lines in an existing drawing view

1. Right-click the drawing view and choose Properties.

2. In the Drawing View Properties dialog box, click the Advanced tab.

3. On the Advanced page, do one of the following:

• To hide the edges, clear the Show Edges Created By Cutting Plane Line
Vertices check box.

• To show the edges, set the Show Edges Created By Cutting Plane Line
Vertices check box.

4. Right-click the drawing view and choose Update View.

Tip

See the related Help topic, Hide or Show a Cutting Plane Using Layers.

Set rib hatching in section views

Before you generate section views that contain ribs, web networks, patterns of ribs,
or mounting bosses, you can specify that ribs are cut but hatching is not displayed
on them.

After the section view is placed, you can use the Override Rib Hatching dialog box to
review the list of ribs that were cut, and to select individual ribs where you want
to show hatching.

1. Before you create a section view, do the following:

a. Right-click the source view where you want to define a section and choose
Properties.

b. On the Advanced tab (Drawing View Properties dialog box), under Section
View, clear the Hatch ribs in section view check box.

c. Apply the change and update the drawing view.

2. Generate the section view by doing the following:

a. Draw a cutting plane line.

b. Create a section view.

3. Right-click the section view and choose Properties.

4. On the Display tab (Drawing View Properties dialog box), in the Parts list,
right-click one of the part names and choose Override Rib Hatching.
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5. All ribs that were cut during section view processing are listed in the Override
Rib Hatching dialog box. For each rib in the list, do the following:

a. Click the rib name to highlight the corresponding rib in the section view.

b. Do one of the following:

• To display hatching on a selected rib, check the box that precedes its
name.

• To show the rib without hatching, clear the check box.

6. Click OK to save the changes and close the Override Rib Hatching dialog box.

7. To see the changes in the section view, click Apply in the Drawing View
Properties dialog box, and then update the drawing view.

Tip

• You can skip step 1 if you select the No hatch option on the Drawing
Standards page (Solid Edge Options dialog box). This sets a file preference
for the document.

• To use the Override Rib Hatching command, the Hatch ribs in section
view check box must be deselected before you generate the section view.
Otherwise, the cut rib list displayed in the Override Rib Hatching dialog
box is not produced.

Override Rib Hatching dialog box

For any section, broken-out section, or revolved section view, you can use the
Override Rib Hatching dialog box to selectively identify individual cut ribs for
display using the hatch style.

To learn how to generate the list in the dialog box, see the Help topic, Set rib
hatching in section views.

Hatched ribs
Lists the cut ribs in the selected section view, for example, Rib 1, Rib 2, Rib 3.

Selecting a rib name in the list highlights the corresponding rib in the drawing
view. (The rib names are for review only and are not related to the part file.)

Selecting the check box preceding a rib name displays hatching on the cut rib
when the dialog box is closed and the drawing view is updated.
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Note

Following are some rules that control the results of rib hatch processing.
These are based on view type and how the cutting plane line is drawn.

• Section views

At least one segment of the cutting plane line must intersect the rib, and
the normal cutting of the rib must produce a hatched face in the section
view.

• Broken-out section views

The broken-out section profile must be drawn on the same view where the
cut is applied, or the resulting view must have the same view direction as
the source view.

• Revolved section views

With a multi-segment cutting plane line, each cut in a revolved section
view can be controlled separately through the segments list on the Display
page of the Drawing View Properties dialog box. Similarly, you can
fine-tune the hatching of each revolved section segment in the Override
Rib Hatching dialog box.

Cutting plane

Draw a cutting plane line

Note

Cutting plane lines are used to define section views.

1. Choose Home tab®Drawing Views group®Cutting Plane .

2. Click a part view.

Any part view can be selected as the source of the section view, including
auxiliary and detail views.

3. Draw the cutting plane.

(See Tips, below.)

4. When you are finished drawing the cutting plane, on the ribbon, click Close

Cutting Plane .
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5. Click to define the section view direction.

Tip

• Source view selection

You can create a cutting plane line on a part view or a 2D view, but only a
part view can be used to create a section view.

• Drawing the cutting plane

o If you draw the cutting plane line so that it extends beyond the
cropping boundary of a detail view, then the geometry outside the
detail view, to the extent of the cutting plane, will be included in the
section view. If you draw the cutting plane line so that it is completely
contained within the detail view, then only that geometry, to the
extent of the cutting plane, will be included in the section view.

o A cutting plane can consist of one or more elements. You can include
both lines and arcs in a cutting plane. If you create a cutting plane
that consists of multiple elements, the elements must meet the
following requirements:

o The elements must meet at their endpoints.

o The elements cannot form a closed region or have loops.

o The elements cannot cross each other.

o Any arcs in the cutting plane must be connected to a line at each end
of the arc.

• Editing the cutting plane

o You can move the cutting plane’s caption text.

o You can double-click a cutting plane line to edit it, or right-click on
it and select Properties from the shortcut menu. The cutting plane
line style and position of the cutting plane direction arrows can be
adjusted.

Hide or show a cutting plane

You can hide the cutting plane used to define a section view by moving it to a new
layer and then hiding the layer.

Hide a cutting plane using layers

1. Create a new layer by doing one of the following:

• On the Layers tab, click the New Layer button .

• On the Layers tab, right-click the Layers node and select New Layer.
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A new layer with a default name, for example Layer1, is added to the Layers node
of the active drawing sheet. The layer name field is already selected for input.

2. Type a new name for the layer, for example, Cutting Plane.

3. Move the cutting plane to the new layer by doing all of the following:

a. On the drawing sheet, select the cutting plane you want to hide.

b. On the Layers tab, click the Move Elements button .

c. In the Move Elements dialog box, select the layer to move the cutting plane
to, and then click OK.

4. Double-click any other layer to make it active.

5. Hide the cutting plane layer by doing one of the following:

• On the Layers tab, select the cutting plane layer, and then click the Hide

Layer button .

• Right-click the cutting plane layer, and then choose Hide from its shortcut
menu.

6. Click in the active window to update the display.

Show a cutting plane on a hidden layer

On the Layers tab, select the hidden layer that contains the cutting plane, and

then click the Show Layer button .

Tip

• A hidden layer is marked by this symbol: .

• To learn how to control the display of cutting plane edges, see the
related Help topic, Show or hide cutting plane edges in section views.

Cutting Plane command

Accesses the cutting plane mode so you can draw a cutting plane line. Cutting plane
lines are used to create section views.
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Note

You can create a cutting plane line on a part view or a 2D view. However, you
can only create a section view using a cutting plane line on a part view.

Cutting Plane Selection command bar

Drawing View Style
Selects a style for the cutting plane line.

The cutting plane style is defined as a Line style and is associated with the
Drawing View style in use.

Cutting plane name
Displays the cutting plane name. This label is system-generated using the
automatic naming sequence defined in the Specify Annotation Letters dialog
box. You can use the name the software supplies, or you can type one. All names
within one document must be unique.

You can you can modify the caption using the Caption tab of the Cutting Plane
Properties dialog box.

Show Caption
Displays a list of options for showing or hiding the cutting plane caption. If
the cutting plane caption is shown, you also can choose whether to show or
hide the view sheet number. You can adjust the position of the caption text
with the Select tool.

You can use these independent Show Caption controls to display the view sheet
number when the section view and the source view with the cutting plane are on
different sheets.

Note

You can use the following check box on the Annotation tab (Solid Edge
Options dialog box) to show the sheet number automatically when the
views are moved onto different sheets, and to hide the cross-reference
automatically when the view are on the same sheet:

• Show sheet number if parent annotation (e.g. cutting plane) and
derived view (e.g. section view) do not reside on the same sheet

Properties
Displays the Cutting Plane Properties dialog box.

Edit Cutting Plane
Activates the cutting plane environment. This button is displayed only when
you select a cutting plane for editing.

Cutting Plane Properties dialog box

Sets properties for a cutting plane line used to create a section view.

The Cutting Plane Properties dialog box is displayed when you click the cutting
plane in a source view. You can change the direction of the cutting plane lines and
modify the cutting plane caption.
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Tabs

General

Caption

General tab (Cutting Plane Properties dialog box)

The General tab in the Cutting Plane Properties dialog box is displayed when you
click the Properties command on the Cutting Plane Selection command bar or on the
shortcut menu of a selected cutting plane.

Line type
Specifies the line type, such as dashed or dotted.

Line width
Sets the line width.

Terminator
Sets options for terminators.

Type
Specifies the terminator type.

Length
Specifies a value for the size of the terminator. This value is a ratio of the
font size in the drawing view style.

Display
Sets display options for the cutting plane line. The display options allow you to
display cutting plane lines according to the drawing standards you use.

Toward
Sets the view direction line to point toward the cutting plane. This option is
typically used when creating drawings that conform to the ISO standard.

Away
Sets the view direction line to point away from the cutting plane. This option
is typically used when creating drawings that conform to the ANSI standard.

Style
Sets the style for the cutting plane line. Options are Thick, Thick Corners
Only, and Thick/Thin.

Thick line length = __ x Font size
Specifies the length of the thick portions of the cutting plane line. The value
is multiplied by font size. This setting only applies to the Thick/Thin and
Thick Corners Only options for Style.

Offset arrow
Offsets the cutting plane direction arrow along the length of the thick portion
of the cutting plane line. Values are 0 through 1.

Value Cutting Plane Arrow Location
0 Arrows are located at the outside end of the thick portion.
0.5 Arrows are centered on the thick portion.
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1 Arrows are located at the inside end of the thick portion.

This option applies to Thick/Thin and Thick Corners Only cutting plane
line styles.

Note

The Toward option on this dialog box must be selected for the Offset
Arrow setting to work.

Broken views

Broken views

You can create broken views in the Draft environment using the Add Break Lines
command and the Broken-Out command.

You can use the Add Break Lines command on the drawing view shortcut menu to
define regions you want to completely remove in a part view. This allows you to
create a broken view of a long, slender part so you can display it at a larger scale.

You can use the Broken-Out command to create a broken-out section view. This
exposes interior features of a part so you can document them.

Create a broken-out section view

1. Choose the Home tab®Drawing Views group®Broken-Out command .

2. On the drawing sheet, click a principal view to be used as the source view
to define the section profile.

3. Draw a closed profile that defines the area you want to break out.

4. When you are finished drawing the closed profile, click the Close Broken-Out
Section button on the ribbon.
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5. Set the extent or depth of the section by doing either of the following:

• Option 1—Position the cursor over a drawing view that is folded 90 degrees
from the source view for the profile. As you move the cursor across the
geometry, you see two parallel lines connected by a perpendicular line that
sizes dynamically as the cursor is moved. One parallel line is fixed to a from
point on the face where you drew the profile. Move the cursor until the
parallel lines are the desired distance apart and click. This is the depth of
the cut.

Tip

o To see the precise distance, look at the Depth text box on the
command bar.

o To control the increments by which the distance increases as you
move the cursor, enter a value in the Step box on the command bar.

• Option 2—Type a value in the Depth text box on the command bar.

The section depth is measured from the face on which you drew the profile.

6. Select the drawing view you want to break out. You can select the drawing view
on which the profile is drawn, or another drawing view.

The broken-out section is applied perpendicular to the plane on which the profile
is drawn.

Tip

• After you select the drawing view to be broken out, the drawing view is
processed, and the profile is hidden.

• To modify the profile of a broken-out section view later, set the Show
Broken-Out Section View Profiles option on the General tab in the
Drawing View Properties dialog box, then select the broken-out section
view profile.

• When you edit a broken-out section view profile or change the extent
depth, you need to update the drawing view using the Update Views
command.

• You cannot use a broken view, detail view, or section view as a source
view for a broken-out section view.

Create a broken view

1. On the drawing sheet, right-click a principal view or a section view.

2. From the shortcut menu, choose the Add Break Lines command.

A line is displayed on the drawing view and moves with the cursor across the
drawing view envelope.

3. On the Add Break Lines command bar, do the following:

a. Specify break direction by selecting one of these buttons:
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• Vertical Break—to define a break region using vertical lines.

• Horizontal Break—to define a break region using horizontal lines.

b. Click the Break Line Type button, and then select the break line type you
want to use.

You can specify that the break line type is straight, cylindrical, a short
break, or a long break.

4. Click within the drawing view to define the start location of the portion of the
drawing view that you do not want to display.

This fixes the position of the first line in the break line pair. A second, parallel
line is displayed.

5. Move the cursor to the end location of the portion of the drawing view that you
do not want to display, and then click again.

The region to be removed is now defined.

6. (Optional) Repeat steps 4 and 5 to define additional regions.

7. When you are finished defining break regions, click the Finish button on the
command bar to update the drawing view.

Tip

• You can define both horizontal and vertical breaks on the same drawing
view.

• You can use the Break Gap, Height, and Pitch options on the Add Break
Lines command bar to change the appearance of the broken edges when
the drawing view is displayed in the broken state.

• To hide the break lines and show the cropped edges in the broken view:

1. Right-click the drawing view and choose Properties.

2. In the Drawing View Properties dialog box:

a. On the General page, select the Hide break lines in broken state
check box.
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b. On the Annotation page, select the Show boundary edges check
box.

• Add dimensions and apply annotations after the broken view is displayed.

• To display a broken view, select the drawing view border, and then choose

the Show Broken View button on the Drawing View Selection
command bar.

• To resize a broken view region, select a break line, position the cursor so
that a double arrow is displayed, and then drag to resize the region.

• To change the break line type, select one of the lines in the break line pair,
and then change the type on the edit command bar.

• To delete a broken view region, select the region and then press the Delete
key.

Broken-Out command

Defines regions of a part view which you want to break away to display interior
features on the part.

9-134 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Creating a broken-out section view
You create a broken-out section view by drawing a closed profile on a source drawing
view (A), defining the depth of the broken-out portion (B), then specifying the
drawing view you want to break away (C). The profile can consist of any 2D elements,
such as lines, arcs, and B-spline curves.

When you finish the command, the broken-out portion is displayed and the profile
is hidden (D).

You can define the extent depth using either of two methods. You can type a value in
the Depth box, or you can position the cursor over a drawing view that is folded 90
degrees from the source view, and then use the cursor to define the extent depth.

You also can specify that the drawing view to be broken out is different than the
drawing view on which the profile is drawn. For example, you can draw the profile
on a principal view (A), and then specify that a pictorial view is broken out (B). The
broken-out section is applied perpendicular to the plane of the source view.

Modifying the section view profile
You can modify the profile or extent depth for an existing broken-out section view.
You must first select the Show Broken-Out Section View Profiles option on the
General page (Drawing View Properties dialog box to make the profile accessible.
Then, you can do either of the following:

• Select the broken-out section view profile to edit the broken-out section view. You
can use the options on the Broken-Out Profile Selection command bar to modify
the profile or extent depth of the broken-out section view.

• Select the broken-out section view profile to delete it using the Delete key. This
also deletes the broken-out section view.

When you edit a broken-out section view profile or change the extent depth, you need
to update the drawing view using the Update Views command.

Line style control for boundary edges in broken-out section views
You can use the following options on the Annotation page (Drawing View Properties
dialog box) to control the line style used to display the hatch boundary edges in a
broken-out section view:

• Show boundary edges check box—When selected, the hatch boundary displays
using a thin line. When deselected, the Visible edge style setting on the Display
page (Drawing View Properties dialog box) controls edge display. Often, this
is a thicker line.

• Boundary edges style list—Selects the line style to apply.

This line style control is available for broken-out section views that are created
using the same drawing view to draw the profile and to apply the section. You can
touch up the hatch boundary edges using the Edge Painter, Show Edges, and Hide
Edges commands.
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Broken-Out section view command bar

Select Source View Step
Specifies the drawing view on which you want to draw the profile. You cannot
use a broken view, detail view, or section view as a source view for a broken-out
section view.

Profile Step
Defines the profile for the broken-out section. The profile must be closed and can
consist of any 2D elements, such as lines, arcs, and B-spline curves.

Depth Step
Specifies the extent depth for the broken-out section. You can define the extent
depth using two methods. You can type a value in the Depth box, or you can
position the cursor over a drawing view that is folded 90 degrees from the source
view and use the cursor to define the extent depth.

The depth you specify is measured from the face on which the profile is drawn in
the Profile Step.

Select Target View Step
Specifies the drawing view on which you want to apply the broken-out section.
You can apply the broken-out portion to the drawing view on which you drew
the profile, or you can select another drawing view. The broken-out section is
applied perpendicular to the plane of the source view.

Extent Step Options
Depth
Specifies the extent depth. You can type a value or define the depth using the
cursor.

Step
Sets the distance value to increase or decrease in set increments when you move
the cursor. For example, typing a step value of 0.25 and moving the cursor away
from the "from" point on the profile face would increment the distance from
0.25 to 0.5, then to 0.75, and so forth.

Broken-Out Profile Selection command bar

The Broken-Out Profile Selection command bar is displayed when you select the
closed profile on the broken-out section view.

Modify Profile
Modifies the profile for the broken-out section view.

Modify Depth
Modifies the extent depth for the broken-out section view.
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Add Break Lines command

The Add Break Lines command defines regions you want to remove in a part view.
This creates a broken view of a long, slender part so you can display it at a larger
scale.

You can break a part horizontally and vertically in the same view.

You can specify five different types of break lines:

Break line type Example

Straight

Cylindrical

Short Break - Linear

Short Break - Curved

Long Break
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Defining broken view regions

The Add Break Lines command, which is available from the drawing view shortcut
menu, defines a pair of break lines for each region of the part you do not want to
display. You can use the buttons on the Add Break Lines command bar to specify a
horizontal or vertical break line pair. You can define as many break line pairs as
you want. After you have defined all the break line pairs, use the Finish button to
generate the broken view.

For example, to remove the region as shown in the illustration on the right, you
would define a break line pair as shown at (A) and (B).

Displaying broken views

You can use the Show Broken View button on the Drawing View Selection
command bar to display a previously defined broken view. When this button is
deselected, the view is displayed in the unbroken state.
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Modifying broken views

When you want to modify a broken view, first display the entire drawing view using
the Show Broken View button on the Drawing View Selection command bar. Then,
you can:

• Delete a broken region by selecting a break line pair and then selecting the
Delete key.

• Resize a broken region by selecting the break line pair, positioning the cursor
so that a double arrow displays, and then dragging to reposition one or both
of the break lines.

You can control the visibility of the break lines using the Hide break lines in broken
state option on the General page, Drawing View Properties dialog box.

Dimensioning broken views

Add dimensions and annotations to the broken view after you define the broken view
regions. Dimensions on a broken view reflect the actual length of the part.

Add Break Lines command bar

Style
Sets the style for the broken view lines.

Vertical Break
Specifies that the drawing view is broken vertically.

Horizontal Break
Specifies that the drawing view is broken horizontally.

Break Line Type
Specifies the break line type. You can select from the following options.

Straight Break
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Cylindrical Break

Short Break - Linear

Short Break - Curved

Long Break

Break Gap
Sets the break gap distance between a pair of break lines when the view is
displayed in the broken state. You can type a value or select a value from the list.

Height (0-1)
Specifies the height of the zig-zags or waves when the short break or long break
options are selected. The value is a ratio of the break gap. You can type a value
between .01 and 1.0.

Example

If the break gap value is 10 millimeters and you set the zig-zag height to
0.5, the zig-zag height is 5 millimeters.

Pitch
Specifies the pitch value of a zig-zag or a wave in the short break options. You
can type a value between .01 and 1.0. The value you type is multiplied times the
total length of the break line and determines the number of zig-zags.

Example

If the total straight length of the break line is 10 millimeters, and you
specify a pitch value of 0.1, then the straight length of one zig-zag is 1
millimeter and there are a total of 10 zig-zags.

Symbols
Specifies the number of spikes that are displayed when you select the Long
Break option.

Finish
Breaks the drawing view in the specified locations and exits the command.
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Draft quality and high quality views

Draft quality and high quality views

Views fall into two general categories: draft quality and high quality.

For assembly models, which typically are larger and more complex than part or
sheet metal models, you can generate either a draft quality or a high quality view.
Draft quality views usually require less processing time than high quality views,
and only visible lines are created.

For part and sheet metal models, you can only generate high quality views. High
quality views are the default representations of the model.

You specify whether to create a draft quality view or a high quality view, as well as
other view options, in the Drawing View Wizard.

View generation options
The view generation options displayed by the Drawing View Wizard depend upon
the source model file type: .asm, .par, or .psm. Once the view is generated, you can
make additional modifications using the tabbed Drawing View Properties dialog box.

Some of the drawing view generation and display options include:

• Whether the view is a draft quality or high quality drawing view.

• Whether the assembly model and/or its parts will be generated as simplified
graphics.

• Whether part or sheet metal model graphics are displayed As Designed,
Simplified, or Flat Pattern.

• Whether hidden and tangent lines will be visible in orthographic and/or pictorial
views.

• Whether tube centerlines, if present, are generated.

• Whether to show material-removed or material-added assembly features, such
as cutouts, holes, and chamfers, or weldments and protrusions.

Identifying views on a drawing
If you are looking at a drawing and want information about a particular view on the
drawing sheet, there are two quick ways to get it:

• You can right-click the view and select the Properties command to display the
Drawing View Properties dialog box. Here, the dialog box title bar displays
information about the drawing view.

• You can use the tool tip feature. To see how this works, click the Select Tool,
and then place the cursor on the drawing view border and leave it there. A
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tool tip identifies the view quality, the view type, and the name of the source
model document. For example, the full tool tip for an independent detail view
of a screw might display: "High Quality View - Independent Detail View -
AllenScrewM8.par." The tool tip for a draft quality drawing view is shown in
this illustration.

If you do not see tool tips displayed on the drawing view, set both of these options on
the Tools®Options®Helpers tab: Show Tool Tips and With Enhanced Text.

Draft quality views

Available for assembly models only, a draft quality view is a quickly generated
line rendering for display and annotation in the Draft environment. Only visible
edges are created. Typically, draft quality views are used to produce interim design
drawings and to provide a pictorial illustration of a ballooned parts list.

Draft quality views are particularly useful when working with very large assemblies,
as the time it takes to generate the view is reduced. However, when you zoom in on a
draft quality view created from a large assembly, you may notice that it displays at a
lower resolution.

Creating draft quality views

To create a draft quality drawing view, set the Create Draft Quality Views option
on the Assembly Drawing View Options dialog box of the Drawing View Wizard.
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Using draft quality views

You can use draft quality views as input for principal views, auxiliary views,
cutting planes, section views, and broken-out section views.

Adding Annotations–You can add annotations such as balloons to draft quality
views and create parts lists from them. You can also place elements that connect
to a drawing view with a leader, such as callouts and weld symbols. For these
types of annotation operations, you can use inactive parts.

Adding Dimensions–Because dimension values are generated from the 3D
model, you first need to use the Activate Parts command to make the model
part data available for dimensioning.

Final Drawing Production–Although draft quality views can be shown in shaded
and wireframe formats, only visible lines are generated. To achieve the best
appearance for final drawing production, you may want to convert the draft
quality view to a high quality format. To do this, use the Convert to High Quality
View command on the selected drawing view’s shortcut menu.

High quality views

A high quality view is a drawing view that provides an accurate representation of
the model because it is generated from Parasolid objects. High quality views may be
used for precise operations, such as dimensioning, and for final drawing production.

Creating high quality views

The default settings on the Drawing View Wizard generate a high quality
drawing view for assembly, part, and sheet metal models. You can start the
Drawing View Wizard using the File®Create Drawing command or by selecting
the Drawing View Wizard command button.

Converting draft quality to high quality views

To convert a draft quality view to a high quality view, use the Convert to High
Quality View command on the selected drawing view’s shortcut menu.

Create a draft quality view

You can create a draft quality view for an assembly model, but not for part or sheet
metal models.

1. In the Draft document, choose the Home tab®Drawing Views group®View

Wizard command .

2. In the Select Model dialog box, select an assembly document.

3. In the Drawing View Creation Wizard (Drawing View Options) dialog box, select
the Create Draft Quality Drawing Views check box.

4. Click Next, and then do one of the following:

• In the Drawing View Creation Wizard (Drawing View Orientation) dialog
box, select a named view for display, and then click Finish.
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• To specify a custom orientation, in the Drawing View Creation Wizard
(Drawing View Orientation):

a. Click Custom.

b. Orient the assembly using the options in the Custom Orientation dialog
box, and then click Close to continue.

5. Use the options on the Drawing View Wizard command bar to adjust how the
view or views will be placed on the sheet.

6. On the drawing sheet, click where you want to place the view.

Tip

• At any time before you place the view, you can change the view layout and
scale using options on the command bar.

• You can add balloons to a draft quality view, and create parts lists from
them.

• You can place an assembly cutaway/section view. Use the Sections tab on
the Drawing View Properties dialog box to select an assembly cutaway or
section view that you created in the Assembly environment.

Convert a Draft Quality View to a High Quality View

Step 1: Right-click a draft quality view.

Step 2: On the shortcut menu, click Convert to High Quality.

Step 3: On the displayed dialog box, check Convert All the Draft Quality Views
in This Document if you want to convert all draft quality views in the
document. If you want to convert only the selected draft quality view,
clear this check box.

Step 4: Click OK. The views become out-of-date, and will be converted to high
quality views on the next drawing view update.

Convert to High Quality View command

Environment Location
Draft Shortcut menu, when a draft quality view is selected

Converts a draft quality view to a high quality view. You can convert all draft
quality views in the drawing into high quality views, or you can convert only the
selected draft quality view. Once a draft quality view is converted to a high quality
view, you cannot convert it back to a draft quality view.

After you run the command, the selected views become out-of-date, and are converted
on the next drawing view update. This command is not available for detail views.
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Drawing view manipulation

Drawing view manipulation

After you place a drawing view, you can manipulate it to ensure that information is
presented the way you want. You also can lock a drawing view to prevent it from
being manipulated accidentally.

Scaling drawing views

You can scale a drawing view with the Properties option when a drawing view is
selected.

A part view shares the same scale as the part view used to create it. If you scale an
aligned part view, all part views aligned with it are also scaled. If you want to scale
one aligned part view without affecting the others, you must first clear the Maintain
Alignment option on the shortcut menu when a drawing view is selected.

Repositioning views

You can manipulate the view positions on the drawing sheet to better organize it.

• You can move a drawing view anywhere on a drawing sheet using click+drag.

• In a multi-sheet drawing, you can move a drawing view to a different sheet by
changing the Sheet number that the drawing view is assigned to on the General
tab (Drawing View Properties dialog box).
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Rotating drawing views

You can rotate a drawing view with the Rotate command.

When you rotate a view, it becomes unaligned. You can use the Maintain Alignment
command to restore the view to its original orientation.

Dimensions on the drawing view rotate with the view. Dimensions that use the
horizontal and vertical dimension axis of the sheet are modified to use the horizontal
and vertical axis of the rotated drawing view coordinate system.

You cannot perform folding, cropping, or broken view operations on rotated views
and you cannot derive section or auxiliary views from a rotated view. The rotated
view cannot be used as input for the Principal Views, Cutting Plane, or Auxiliary
View commands.
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Shading drawing views
You can shade a drawing view using the Shading and Color tab of the Drawing View
Properties dialog box. You can control texture display, reflection display, and flat
shading, as well as specify whether assembly override and part face colors display in
the drawing view.

You can also control basic shading (color or grayscale, as well as edge display) with
these command buttons, which are located on the Drawing View Selection command
bar, the Auxiliary View command bar, the Section View command bar, and the
Principal View command bar.
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Adding graphics to the view
You can add 2D graphical elements to part views, draft views, and 2D views using
the Draw In View command on the selected view’s shortcut menu.

When the Draw In View window opens, choose any of the standard drawing tools to
add line graphics, such as rectangles, arcs, circles, or ellipses, or add external images
and pictures using the Image command on the Sketching tab.

Locking a drawing view
To prevent accidental movement of a drawing view, you can use the Lock drawing
view position option that is available:

• As a check box on the General tab (Drawing View Properties dialog box), when
you edit the drawing view properties.

• As a Lock button on the Drawing View Selection command bar, when you select
the drawing view border.

A locked drawing view is indicated by the lock symbol displayed within the drawing
view border when it is highlighted.

Locked drawing views still can be manipulated. For example, locking a drawing
view does not prevent:

• Indirect movement of the locked drawing view by the Create Alignment or
Maintain Alignment command.

• Explicit movement using the Move command or by changing the Sheet number.

• Copying and pasting, or deleting the drawing view. (You can use the Undo
command to reverse these operations.)

• Dragging a drawing view derived from the locked view.

• Rotating a locked drawing view.

Rotate a drawing view

1. Choose the Rotate command .
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2. Select the drawing view you want to rotate.

3. Click where you want the center of rotation to be (A).

The software dynamically displays a reference axis for the rotation.

4. Click to define the other end of the reference axis.

Tip

The location and position of the reference axis defines the rotation from
point (B).

5. As you move the mouse, the software dynamically displays the rotation axis and
drawing elements being rotated. When rotated into the position you want them,
click to define the rotation to point (C).

Tip

• Instead of clicking to define the orientation of the reference axis, you can
use the Position Angle box on the command bar.

• Instead of clicking to define the to point, you can use the Rotation Angle
box on the command bar. You can then click to define the side of the
reference axis you want to rotate toward, or type a value in the Position
Angle box.

• To rotate by increments, type a value in the Step Angle box on the
command bar.

• You can use IntelliSketch to define the rotation from and to points.

• You can rotate multiple selected views, including detail views, in a
single Rotate operation. When aligned views are rotated, they become
unaligned.

• You can use other view manipulation commands, such as Zoom and Pan,
while you are using the Rotate command.

When you finish manipulating the view, the software returns you to the
Rotate command at the point where you left off.
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Command

• Rotate command

Procedure

• Rotate an element

User Interface

• Rotate command bar

Change the display in a part view

1. Do one of the following:

• Right-click an element in the part view.

• Right-click the part view border.

2. On the shortcut menu, click Properties.

3. Click the Display tab.

4. From the Parts List, select the part or parts whose edge display you want to
change. You can set the style options for the visible, hidden and tangent edges.

Tip

• The Display tab is used to set the line display options for parts in the
selected part view only. The Edge Painter command can be used to set
the line display options for all the part edges in all part views in your
document.

• You can select all occurrences of a part in a drawing view. To do this, on
the Drawing View Properties dialog box, click the Display tab. From the
Parts List, right-click on the part, and then click Select All Occurrences.

• You must do an insert part copy into a sheet metal (.PSM) file if you want
to display the bend lines in a drawing view.

Shade a drawing view

1. On the Shading and Color page (Drawing View Properties dialog box), select the
Show shading in drawing views check box.

2. Set the other options you want on the Shading and Color page and click OK.

3. Update the drawing view.

The drawing view is displayed with the shading you specified.

You also can control basic shading (color or grayscale, as well as edge display) using
the shading buttons on the Drawing View Selection command bar, the Auxiliary View
command bar, the Section View command bar, and the Principal View command bar.
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Note

Changing shading settings for a drawing view, whether on the Shading and
Color page of the Drawing View Properties dialog box or on a command bar,
may cause the view to go out of date. If so, to see the drawing view with the
new shading settings, update the drawing view.

Tip

• You can select edges (for example, for dimension placement or ballooning)
regardless of whether the current shading setting displays the edges.

• When you update a shaded drawing view, the view is rendered using the
latest color assignments saved in the model file(s) (subject to the view
settings).

• Reference parts continue to display as reference parts in shaded drawing
views.

• By default, views derived from shaded drawing views are not shaded.

• You cannot shade a 2D view, revolved section view, or a paper-thin section
view.

• Detail views do not have their own shading settings. Rather, they use the
shading settings of their source views.

• Some large drawing views may not shade. If this occurs, a warning icon
is displayed in the Parts List in the Display page of the Drawing View
Properties dialog box. Try setting the display quality to a lower setting, or
reducing the size of the drawing view, or both.

• If parts in a subassembly do not shade, then there may be a conflict
between assembly color assignments and part face color assignments.
Verify that the Use Part Face Colors option on the Shading and Color page
of the Drawing View Properties dialog box is not selected.

Change the model display style

For part, sheet metal, and assembly documents, change the model display for a
part, sheet metal, or assembly model.

On View tab®Style group®View Styles palette, click a model display style button:

Wireframe

Visible Edges (available in model documents)

Visible and Hidden Edges

Shaded
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Shaded with Visible Edges

To add a shadow beneath a part or assembly in a shaded view, click the Drop Shadow

button in the View tab®Style group .

To add a floor reflection or mirror reflection beneath a part or assembly in a shaded

view, click the Floor Reflection button in the View tab®Style group .

The display updates automatically using the style you selected.

Tip

• To learn how to change model display style for draft documents, see
**Unsatisfied xref title**.

Fit Drawing View Command

Fits the selected drawing view to the active view.

Fit a Drawing View

Step 1: Click the drawing view.

Step 2: Click the right mouse button.

Step 3: On the shortcut menu, click Fit Drawing View.

Convert to 2D View command

Environment Location
Draft Shortcut menu, when a part view is selected.

Allows you to convert a part view to a 2D view.

Convert a Part View to a 2D View

Step 1: Click the part view.

Step 2: Press the right mouse button.

Step 3: On the shortcut menu, click Convert to 2D View.

Activate or inactivate drawing views

Once you open a document, you can switch between inactive mode and active mode
using commands on the ribbon.

Set default drawing open mode

1. From the Application menu, choose Open.

2. In the Open File dialog box, from the Files of Type list, select Draft Documents
(*.dft).
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3. In the Open File dialog box, click one of the following options:

• Activate Drawing Views For Edit

• Inactivate Drawing Views For Review

Tip

This greatly reduces the time required to open a managed or unmanaged
draft document.

4. Click Save As Default.

5. Click Open.

Inactivate or activate drawing views, lists, and model-derived tables in
the document

With the draft document open, select one of these commands from the ribbon:

• Tools tab®View Activation group®Inactivate Drawing Views
command—Immediately changes the document to inactive mode for fast
printing and viewing.

• Tools tab®View Activation group®Activate Drawing Views
command—Immediately changes the document to active mode for normal
editing.

Activate drawing views on-the-fly

If you try to drag a model file into a draft document that is in inactive mode—In
the dialog box, choose whether you want to activate the drawing on-the-fly:

• Click Yes to change the document to active mode and continue creating the
drawing view.

• Click No to end the drawing view creation command and leave the drawing
in review mode.

Inactivate Drawing Views command

Deactivates all parts lists and model-derived tables in the active draft document
so they cannot be selected and edited.

Inactive mode allows limited manipulation of drawing views, dimensions, and
annotations. This command sets the document to inactive mode, and displays an
Inactive watermark on the 2D Model sheet and all working sheets in the document.

Use this command to change the status of a draft document from active (for editing)
to review.
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Note

• You can set a preference to open a draft document in inactive mode by
setting the Inactivate Drawing Views For Review option in the Open File
dialog box and then clicking the Save As Default button.

• When the Inactivate Drawing Views For Review option is set for managed
documents, only the drawing file is downloaded to cache; the linked model
documents are not. This greatly reduces the time required to open the
drawing.

Activate Drawing Views command

Activates all drawing views, parts lists, and model-derived tables in the draft
document as though the document was opened in normal edit mode. In active mode,
objects are checked to determine whether they are out-of-date. Model geometry
in drawing views is live and accessible.

While the draft document is open, you can use this command to change the status
of a draft document from review (for fast-open viewing and printing) to active (for
editing).

Active mode is the default open mode for draft documents.

Note

• You also can set a preference to open a draft document in active mode
by setting the Activate Drawing Views For Edit option in the Open File
dialog box and then clicking the Save As Default button.

Bring a Dimension, Annotation, or Text Box to the Front

Step 1: Right-click a dimension, annotation, or text box.

Step 2: On the shortcut menu, click Bring to Front.

The selected dimension, annotation, or text box is now first in the display order.

Bring to Front command

Brings the selected dimension, annotation, or text to the front of the drawing, so that
it is first in the display order. This command can be useful when you are formatting
a drawing to meet drawing standards. You may need to give a text box a solid fill,
for example.

The Bring to Front command is available on the shortcut menu when a dimension,
annotation, or text box is selected is selected.

Send a Dimension, Annotation, or Text Box to the Back

Step 1: Right-click a dimension, annotation, or text box.

Step 2: On the shortcut menu, click Send to Back.

The selected dimension, annotation, or text box is now last in the display order.
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Send to Back command

Sends the selected dimension, annotation, or text to the back of the drawing, so that
it is last in the display order.

The Send to Back command is available on the shortcut menu when a dimension,
annotation, or text box is selected is selected.

Drawing view alignment

Drawing view alignment

Drawing view alignment ensures that when a source drawing view, or any of the
views created from it, is moved or scaled, that the position of all related views is
adjusted to maintain a horizontal/vertical or parallel/perpendicular relationship with
the manipulated view. The view alignment relationship is indicated by a dashed line.

New principal, auxiliary, and section drawing views are automatically aligned to the
source part view used to create them. However, when views are created from the 2D
model space, you need to create and define their alignment position.

Creating and Deleting View Alignment

You can use the Create Alignment command on the shortcut menu to create
alignment between drawing views based on the centers of the views or on selected
keypoints within them. You can use the Delete Alignment command to delete an
alignment you have created when it is no longer needed.

Unaligned Views

There may be times you want a view to be unaligned temporarily, for example:

• To scale a view independently of other views

• To move the view to another sheet.

Unaligned views are noted by a jog indicator.

If you need to move a drawing view to another sheet or scale the view, you can
toggle the alignment relationship off with the Maintain Alignment command on the
shortcut menu. After you move or scale the part view, you can again click Maintain
Alignment on the shortcut menu to re-establish the alignment constraint.

Create Alignment Between Drawing Views

Step 1: Right-click a drawing view.

Step 2: On the shortcut menu, click Create Alignment.

Step 3: Use the controls on the Create Alignment command bar to specify the
alignment type (horizontal, vertical, parallel, or perpendicular, and
whether the views are aligned with drawing view centers or keypoints).

Step 4: Do one of the following:
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• For a horizontal or vertical alignment using the centers of the
drawing views, click the alignment drawing view.

• For a horizontal or vertical alignment using keypoints, click a
keypoint in the current drawing view, and then click a keypoint in
the alignment drawing view.

• For a parallel or perpendicular alignment using the centers of the
drawing views, click an alignment line (or define one with two
keypoints) in the current drawing view, and then click the alignment
drawing view.

• For a parallel or perpendicular alignment using keypoints, click an
alignment line (or define one with two keypoints) in the current
drawing view. Then, click a keypoint in the current drawing view.
Finally, click a keypoint in the alignment drawing view.

Create Alignment command

Creates alignment between drawing views. You can specify horizontal, vertical,
parallel, or perpendicular alignment based on drawing view centers or selected
keypoints.

Create Alignment command bar

Specifies options for aligning drawing views.

Alignment Position
Specifies whether to align the drawing views by their centers or by specified
keypoints within them.

Horizontal
Specifies horizontal alignment between the drawing views.

Vertical
Specifies vertical alignment between the drawing views.

Parallel
Specifies parallel alignment between the drawing views, as determined by a line
that you specify in the current view. The alignment line can be a line in the view
or a line defined by keypoints in the current view.

Perpendicular
Specifies perpendicular alignment between the drawing views, as determined by
a line that you specify in the current view. The alignment line can be a line in
the view or a line defined by keypoints in the current view.

Maintain Alignment Between Drawing Views

Step 1: Right-click a drawing view.

Step 2: On the shortcut menu, click Maintain Alignment. If alignment
constraints on the drawing view were enabled, they are disabled. If
alignment constraints on the drawing view were disabled, they are
enabled.
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Maintain Alignment command

For the selected drawing view, turns the alignment relationships on or off.

• If the alignment relationships are enabled, then the Maintain Alignment
command disables them.

• If the alignment relationships are disabled, then the Maintain Alignment
command enables them.

Delete Alignment Between Drawing Views

Step 1: Right-click a drawing view.

Step 2: On the shortcut menu, click Delete Alignment.

Step 3: Click the alignment you want to delete.

Note

You cannot use the Delete Alignment command to delete derived view
alignments (as with section views and auxiliary views, for example).

Delete Alignment command

Deletes alignment between drawing views.

Drawing view cropping

Drawing view cropping

If you want to show only part of a drawing view, you can crop the drawing view.
Cropping does not change the drawing view scale. Rather, it limits the portion of the
view that is displayed on the drawing sheet.

You can crop any type of drawing view except a detail view. After you create a
cropped view, you can specify whether cropping edges are displayed and what edge
style is used.

There are two types of cropping boundaries you can define:

mt01413-s-1050 Solid Edge fundamentals 9-157



Lesson 9 Creating detailed drawings

• A rectangular cropping boundary.

• A custom cropping boundary.

Rectangular cropping boundary

To crop a drawing view by resizing the original cropping boundary, first select it to
display its border. Then drag one of the border’s handles (1) until only the geometry
you want to see is visible (2).

Custom cropping boundary

You can use the Modify Drawing View Boundary option on the Drawing View
Selection command bar to draw a non-rectangular cropping boundary.

When you click the Modify Drawing View Boundary button on the command bar, the
drawing view is displayed in a special cropping window. The rectangular boundary is
converted to four endpoint connected line segments.
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You can use the 2D drawing tools to redraw the view cropping border. You can use
any combination of lines, arcs, and curves to define the cropping boundary profile.
However, the new cropping boundary profile must be closed. To use a portion of the
existing rectangular boundary in the custom profile, draw 2D elements that connect
to the existing line segments. Use the Trim command to remove the unneeded line
segments.

To draw a new boundary profile, delete all the existing line segments and then draw
the new boundary using the 2D drawing tools.

When you have finished drawing the custom boundary, you can click the Close
Cropping Boundary button on the Home tab to exit the cropping window.

For more information, see Help topic: Example: Modify a drawing view cropping
boundary.

Displaying cropping edges

When you crop a drawing view, you can use the Show boundary edges check box on
the Annotation page (Drawing View Properties dialog box) to specify whether edges
are displayed where the drawing view boundary intersects the model.

• When the check box is selected, the cropping boundary is displayed using a
thin-line style. You can set the style using the Boundary edges style list.

• When the check box is deselected, no cropping boundary edges are displayed.

Edges are not generated where the boundary passes over holes or voids in the model.
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Uncropping a drawing view

You can return a cropped drawing view to its original display using the Uncrop
command on the shortcut menu.

Crop a drawing view

1. Select a drawing view to display its handles. As you move the cursor over the
drawing view, the cursor changes to show whether you are over a handle (A).

2. Click a handle and drag it to a new location. The drawing view display changes
(B).
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Tip

• If a drawing view has been cropped, you can uncrop the view using the
Uncrop command on the Drawing View shortcut menu.

• You can crop any drawing view, except drawing views that were placed
with the Detail View command. To edit the display of a detail view
you must edit the detail envelope.

• You can use the Show boundary edges check box on the Annotation
page of the Drawing View Properties dialog box to specify whether
edges are displayed where the drawing view boundary intersects the
model. When you change this option on an existing drawing view, the
drawing view becomes out of date. You can update the drawing view
using the Update Views command.

Example: Modify a drawing view cropping boundary

This example explains how to modify the drawing view cropping boundary by
reusing a portion of the existing drawing view boundary.

1. Click the drawing view to modify. You can not modify the boundary of a detail
view.

2. On the Drawing View Selection command bar, choose Modify Drawing View

Boundary . The drawing view is displayed in a special cropping window and
the rectangular boundary is converted to four endpoint connected line segments.
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3. Use the 2D sketching commands to draw the custom cropping boundary. For
example, you can use the Line command to draw new lines that define the
custom boundary.

4. Draw the new line segments you need to define the custom cropping boundary,
connecting the start and end line segments to the existing boundary.

5. Choose Sketching tab®Draw group®Trim.
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6. Click the line segments that you want to remove from the boundary. The finished
boundary must form a closed profile.

7. On the Home tab, choose Close Cropping Boundary to close the cropping view
window and return to the drawing sheet. The drawing view is cropped along the
custom boundary you drew.

Uncrop Command

Returns a drawing view that has been cropped to its original state.

The Uncrop command is available on the shortcut menu when a drawing view is
selected.
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Removing geometry from a drawing view

Removing Geometry from a View

By specifying a drawing view display depth for a back clipping plane, you can
simplify any type of drawing view so that geometry behind the plane is removed
from the view. This feature can be used, for example, to reduce the visible clutter
behind a section view or a broken-out section view.

In this illustration, the hashed line in (A) indicates where the back clipping plane
will be applied to the original drawing view display. The orthographic view (B) shows
the dynamic line tool used to define the display depth and the location of the back
clipping plane. The result (C) shows how the drawing view geometry in front of the
plane was trimmed and the geometry completely behind the plane was removed.

A drawing view display depth and clipping plane can be defined for any type of
view: orthographic, pictorial, section, auxiliary, and detail views. Dimensions and
annotations that are attached to edges removed by the drawing view clipping plane
are detached, also.

The Set Drawing View Depth command specifies a visible display depth for the
drawing view, and then it applies a back clipping plane. Geometry behind the plane
is removed from the drawing view when you update the view.

To adjust the location of the back clipping plane so that more or less geometry is
visible, select the Set Drawing View Depth command again and then specify a
different depth value.

To remove the drawing view clipping plane and restore the drawing view to its
original display depth, use the Remove Defined Depth command from the drawing
view’s shortcut menu and then update the view.

Simplify drawing view geometry with a clipping plane
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A back clipping plane removes clutter in an orthographic or pictorial drawing view
by trimming away all geometry behind the plane. The location of the back clipping
plane is defined initially by the drawing view display depth, which you can key in
or click to specify.

1. (Select the View to Clip) On the drawing sheet, right-click the drawing view
from which you want to remove geometry, then click Set Drawing View Display
Depth on its shortcut menu.

2. (Specify the Location of the Clipping Plane) When prompted, "Click to set the
distance or key in a value," use one of these options to set the depth of the back
clipping plane, depending upon whether the view you selected is an orthographic
or pictorial view:

Option 1—Specify Display Depth Dynamically
If you selected an orthographic drawing view in Step 1, you can click to define
the drawing view display depth. Position the mouse cursor over a different
drawing view that is orthogonal to the view you are modifying. As you move
the cursor across the geometry, you see two parallel lines connected by a
perpendicular line, whose length changes as the mouse is moved. The line
fixed at the edge of the view represents the “top” of the view being modified.
The parallel line that moves with the mouse cursor represents the dynamic
location of the back clipping plane. The perpendicular line between these
lines represents the display depth. This value is shown in the Depth text box
on the command bar, and it changes as you move the mouse.

Move the mouse until the back clipping plane is at the desired distance from
the line fixed at the “top” edge of the drawing view and click. To see the
precise distance, look at the Depth text box on the command bar. To control
the increments by which the distance increases or decreases as you move the
mouse cursor, enter a value in the Step box on the command bar.

If you selected a pictorial drawing view in Step 1, the dynamic line tool
described above is not available to you. Instead, type a value as described
in Option 2.

Option 2—Type a Display Depth Value
For both pictorial and orthographic drawing views, you can type a value in
the Depth text box on the command bar and press ENTER. The display
depth is measured from the “top” of the model in the selected drawing view
to the location where you want the back clipping plane to be placed.

3. (Update the Drawing View) To see the results, click Update View on the modified
drawing view’s shortcut menu, or click the Update Views command.
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Note

• The back clipping plane is parallel to the plane of the drawing view and
extends across the entire drawing view. Once created, its position is fixed
relative to the 3D model origin.

• To apply a back clipping plane to a dependent detail view, you must first
set the display depth on its source view, then update both views.

• For an independent detail view and its source view, you can apply back
clipping planes at different depths.

Set Drawing View Depth command

Defines a drawing view display depth and applies a back clipping plane at that
location to remove all geometry behind it. The Set Drawing View Depth command
is available on the shortcut menu of any type of high quality, but not draft quality,
drawing view. It is often used to clean up and simplify section views and broken-out
section views.

In this illustration, the hashed line in (A) indicates where the back clipping plane
will be applied to the original drawing view display. The orthographic view (B) shows
the dynamic line tool used to define the display depth and the location of the back
clipping plane. The result (C) shows how the drawing view geometry in front of the
plane was trimmed and the geometry completely behind the plane was removed.

Once applied, the plane itself is not visible.
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Tip

Only one clipping plane can be applied to the drawing view at a time. You can
adjust the location of the clipping plane so that more or less geometry is visible
by selecting the Set Drawing View Depth command again and specifying a
different view depth.

Drawing View Display Depth command bar

Drawing View Display Depth command bar

Define the drawing view visible display depth using one of these methods:

• Type a value in the Depth text box on the command bar.

• Position the mouse cursor over a drawing view that is folded 90 degrees from
the view to be modified, then click in the view to define the display depth. This
technique, which uses the dynamic line tool, is only for orthographic views of
the same model.

Depth
Sets the visible depth of the drawing view and applies a back clipping plane at
that location. You can type and enter a value or define the depth using the cursor
and the dynamic line tool visible in any orthographic view.

The display depth is measured from the “top” of the model in the selected
drawing view to the location where you want the back clipping plane to be placed.

Step
When using the dynamic line tool, sets the Depth value to increase or decrease
in set increments.

Delete drawing view display depth and clipping plane

You delete the back clipping plane from the drawing view by removing the current
display depth definition.

1. Right-click the drawing view.

2. On the drawing view shortcut menu, click Remove Display Depth.

3. Click OK at the prompt, "Are you sure you want to delete the depth definition
from the drawing view?"

4. On the drawing view shortcut menu, click Update View to refresh the view
display, or choose the Update Views command.

Remove Defined Depth command

Removes the current drawing view clipping plane definition from the selected
drawing view. To see the effect, you must update the view.
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The Remove Defined Depth command is available on the drawing view shortcut
menu whenever a back clipping plane has been applied to the selected drawing view.

Drawing View Display Depth command bar

Change drawing text size

There are several ways you can change the size of text that appears as alphanumeric
information in drawing annotations and dimensions. You can:

• Change text size in individual elements

• Use SmartSelect to automatically scale similar text elements

• Change the text size globally by editing the style

• Specify the appearance of table text

Change text size in individual elements
1. On the drawing, right-click the element you want to change, such as a bend
callout or a balloon.

2. From the shortcut menu, choose Properties.

3. In the Properties dialog box for the element you selected, click one of these tabs:

• Text and Leader page

• Text page

4. Do one of the following:

• Change font size—Type a different value in the Font size box.

• Change overall text size—Type a different value in the Text scale box to
increase or decrease the overall size of the annotation text.

• Change the width of callout text and symbols—Type a value in the Aspect
ratio box to change the text width but not text height.

5. Click OK to apply the change.

Use SmartSelect to automatically scale similar text elements
You can use SmartSelect to select all elements on the active sheet that have similar
attributes. This is very useful if you want to make changes to similar elements
throughout a drawing sheet.

1. Click the Select tool .

2. On the Select tool command bar, click the SmartSelect command .

3. Click one of the text elements you want to change, such as a balloon or callout
annotation or a dimension.
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The SmartSelect Options dialog box is displayed, with the Element Type check
box selected.

4. Click OK to continue.

The Edit Definition command bar is displayed.

5. To change the text size of all of the selected elements, in the Text scale box, type
a new value and press Tab.

The text size of all of the selected elements is changed.

Tip

You can use the other options on the Edit Definition command bar to make
changes to the elements in the select set. For example, you can select the
Properties button to change the color of the elements or text.

Change the text size globally by editing the style

This method updates all existing text elements that use the text style, and it is
applied to all new elements that you create.

1. Choose the Home tab®Dimension group®Styles command .

Tip

• You can find the same Styles command on the View tab and on various
annotation Properties dialog boxes.

2. In the Style dialog box, from the Style Type list, select Text.

3. From the Styles list, choose the Style you want to modify, such as ANSI or ISO.

4. Click Modify.

5. In the Modify Text Box Style dialog box, click the Paragraph tab.

6. Do one of the following:

• Change font size—Type a different value in the Font size box.

• Change the width of callout text and symbols—Type a value in the Aspect
ratio box to change the text width but not text height.

7. Click OK to dismiss the Modify Text Box Style dialog box, and then click Apply
to update the text style wherever it is used.

Tip

If you modify the style of Dimensions rather than Text, you can specify a value
for the Callout text aspect ratio on the Text page of the Modify Dimension
Style dialog box.
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Updating drawing views

Drawing view updates

When you change parts and assemblies depicted in part views, you can easily update
the views so they match the new model geometry. This works because part views are
associative to the 3D part or assembly they were created from. For example, if you
add a hole to a 3D part in the Part environment and then update the part view in the
Draft environment, the hole geometry is added to the 2D drawing.

When a drawing view is out-of-date with respect to the 3D model, the software
displays a solid border or box around it on the drawing sheet. To update the drawing
view display as well as the retrieved dimensions, use the Update Views command.

Tools for checking drawing view out-of-date status

There are several tools that work together to identify drawing view out-of-date
status conditions.

• Drawing View Tracker

The Drawing View Tracker checks for both out-of-date geometry in part views
and out-of-date model status in the document and provides specific instructions
for what to do to update them. When you open a document with out-of-date
part views, Drawing View Tracker displays a warning that the views need to be
updated before dimensioning.

• Assembly Configuration Changes Make Drawing Views Out-of-Date
In This Draft File option

This option (on the General page of the Solid Edge Options dialog box) is an
automatic check for display configuration changes for all assembly views in the
draft document that have the Configuration Match option enabled. Display
configurations store both the show/hide and the simplified/designed status
of the parts in the assembly. When this option is set, changes to an assembly
configuration associated with a drawing view will make the view out-of-date. All
drawing views in the document are checked automatically.

• Configuration Check
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This option (on the Display page of the Properties dialog box for a selected
drawing view) is a manual check for display configuration changes for the
assembly shown in the currently selected drawing view.

• Configuration Match

This option (on the Display page of the Properties dialog box for a selected
drawing view) controls whether show/hide part settings in the drawing view
match the show/hide settings within the assembly configuration. Views without
this option set will not be out-of-date after changes are made to an assembly
display configuration.

Using the Drawing View Tracker

The Drawing View Tracker provides specific information on updating both
out-of-date part views and out-of-date models. While a view becomes out-of-date
when the 3D model to which it is associative changes, a model becomes out-of-date
when links external to the Draft environment change. Out-of-date model causes may
include, but are not limited to:

• A part file modified outside the context of its parent assembly file

• Broken internal links in a part file

Out-of-date model conditions cannot be resolved inside the Draft environment.
Because different circumstances can cause an out-of-date model condition, the
Drawing View Tracker provides step-by-step instructions for updating out-of-date
models in the current document. Solid Edge displays a solid border around an
out-of-date view (A), a corner border around an out-of-date model (B), and both a
solid border and a corner border when both out-of-date view and out-of-date model
conditions apply (C).

Correcting an out-of-date model condition usually causes an out-of-date view
condition.

Failed dimensions after updating part views

When you update a part view, a dimension may fail to update because the edge it
referred to is no longer displayed in the part view. For example, if you deleted a hole
feature in the part model, the edge representing the hole will be removed from the
part view when you update it.

When a dimension fails to update, it changes to the "failed" or detached color. The
color change helps you detect failed dimensions easily, so you can edit the drawing.
All failed dimensions for a part view form a single selection set, in case you want to
delete them all at once.
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Reattaching dimensions

Sometimes you may want to reattach failed dimensions in a drawing. For example,
if you delete one of several holes that comprise a single hole feature on a part, and
the edge representing the hole was dimensioned on the drawing, the dimension will
fail. Instead of deleting the dimension and placing a new dimension, you can drag
and drop the dimension line handle point to one of the remaining hole edges on the
part view. This saves time because any prefixes, tolerances, and other formatting
on the failed dimension are applied to the new dimension. You can also drag and
drop the dimension line handle point(s) to different parent object(s), even if they
have not failed.

Tracking changed dimensions and annotations

Wherever possible, Solid Edge attempts to rebind dimensions and annotations that
were detached after a drawing view update.

All changed dimensions and annotations, whether they have been repaired or not,
are reported in the Dimension Tracker dialog box. To activate this dialog box, select
the Tools®Dimensions®Track Dimension Changes command.

To learn more, see Tracking dimensions and annotations.

Track drawing views

1. Choose Tools tab®Assistants group®Drawing View Tracker .

2. In the Drawing View Tracker dialog box, in the Drawing view status box, select
a view or model.

3. Review the step-by-step instructions for updating the selected view or model in
the Update Instructions box.

Tip

• Click Details to display information about the model status, such as
whether the model has been modified or is missing.

• Click Update Views to update drawing views without exiting the Drawing
View Tracker. The Update Views button updates out-of-date views (for
example, a view that no longer matches because the part file has been
modified), but does not update out-of-date models (for example, a view
that no longer matches because a part file has been modified outside the
context of its parent assembly file).

• In the Drawing View Status box, you can update views individually by
right-clicking on them and selecting Update View.

• In the Details box, you can toggle assembly display by right-clicking on
assemblies or associated parts and selecting Show Entire Assembly.

• You can highlight assemblies, subassemblies, and parts by clicking them in
the Details box. The highlight is displayed in all views on the active sheet.
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• You can open files directly from the Drawing View Tracker to view or
modify them. Right-click the document shown in the Details box and
select Open.

Note

The document is displayed using the Document Name Formula.

Drawing View Tracker command

Accesses the Drawing View Tracker to view and update the status of your drawing
views with respect to your models. The Drawing View Status, Update instructions,
and Details portions of the dialog box use the Document Name Formula to display
the current document.

Drawing View Tracker dialog box

Drawing view status
Displays the status of all drawing views in the current document. Status is
displayed in a tree, with views listed under the files to which they are associative.
The following symbols can appear in the Drawing View Status box and the
Details box:

Drawing view

Drawing view out-of-date

Model out-of-date

Subassembly part has been modified

File not found

Model up-to-date
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Update instructions
Displays step-by-step instructions for updating the view selected in the Drawing
View Status box.

Update Views
Updates the views to match the current state of the part or assembly depicted on
the drawing. All views within a document update when you select this command.

Details
Displays details for the model or drawing view selected in the Drawing View
Status box. When a model is selected, the current state of the model is displayed.
When a view is selected, the current representation of the drawing view with
respect to the current model is displayed.

View out-of-date

One or more views is out-of-date because the 3D model to which the view is
associative has changed. You can use the Drawing View Tracker dialog box to get
step-by-step instructions on how to update the view.

Model out-of-date

One or more models is out-of-date because links external to the Draft file have
changed. You can use the Drawing View Tracker dialog box to get step-by-step
instructions on how to update the model.

Update part views in a document

• Choose the Update Views command

Tip

• To update a single view, select a drawing view and choose the Update
View command from the shortcut menu.

• When a part view is out of date with the part or assembly it describes, the
border of the part view is displayed in the disabled color.

• The Update Views command updates all part views in a document.

• (Force Drawing Views to Update) If you hold Ctrl+Shift when you click
Update Views, Solid Edge performs a full update, just as it would on
initial view creation. That is, it rereads all of the model data to regenerate
the views, rather than only the model data thought to have changed.

• You can increase update performance for views of assemblies for which
you do not need hidden edge information. On the Options dialog box, on
the Edge Display tab, clear the Show Hidden Edges and Show Edges of
Hidden Parts check boxes.
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Update a drawing view after editing a part or assembly

1. Position the cursor over a drawing view that is a part view and double-click
the left mouse button.

The part, sheet metal, or assembly document associated with the drawing view
is opened.

2. Edit the part, sheet metal, or assembly document.

3. Right-click the drawing view.

4. On the shortcut menu, click Update View.

Note

The Update View command is only available after you open a part, sheet
metal or assembly document in the Draft environment. You can also use
the Save command.

5. Choose Application menu®Close. The document closes and the Draft
environment displays the drawing document associated with the part. The
affected drawing views are displayed with a border indicating that they are out
of date.

6. To update all the drawing views, choose Home tab®Drawing Views
group®Update Views command. The drawing views update.

Tip

• To update a single drawing view, select the drawing view and click the
Update View command on the shortcut menu.

• Force Drawing Views to Update—If you hold Ctrl+Shift when you click
Update View, Solid Edge performs a full update, just as it would on initial
view creation. That is, it rereads all of the model data to regenerate the
view, rather than only the model data thought to have changed.

Open the 3D document that a drawing view references

• Position the cursor over a drawing view that is a part view and double-click
the left mouse button.

The part, sheet metal, or assembly document associated with the drawing view
is opened.

Tip

• After you finish editing the 3D document, if you want to see the changes
in the drawing document, you must update the drawing view using the
Update Views command.

mt01413-s-1050 Solid Edge fundamentals 9-175



Lesson 9 Creating detailed drawings

Update Views command

Updates the part views to match the current state of the part or assembly depicted
on the drawing. All part views within a document update when you select this
command.

Update Command

Saves the document. When you close the part, sheet metal, or assembly document
and return to the Draft environment, a box may be displayed around the affected
drawing views to indicate that the drawing view is out of date with respect to the
3D document.

Drawing view formatting

Drawing view styles

Drawing view styles

Drawing view styles control the appearance of:

• Different types of drawing views. These include principal views, 2D Model views,
section views, auxiliary views, and detail views.

• Different types of view annotations. These include cutting planes, viewing
planes, and detail envelopes.

• Drawing view caption content and formatting.

To understand the overall process for defining drawing view captions, view
annotation captions, and view annotation labels, refer to the Drawing view style
workflow.

Using drawing view styles to customize drawing views
You can use Drawing View styles to customize the appearance of drawing views
and view annotations.

Example

• Within a single overall style, such as ISO, ESKD, or GB, you can define
unique content and formatting for each drawing view type and for each
view annotation.

• You can create a new drawing view style for a specific customer or supplier,
such as Customer ABC or Supplier XYZ, and use the style to customize
the appearance of different drawing view types and view annotations
to meet their requirements.

While the recommended way to use drawing view styles is to create a single style
for a specific business or industry, it is possible to define a different drawing view
style for different drawing view types. For example, you can create a style to apply
to section views and to the cutting planes used to define them, and name the new
style Section.
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Formatting drawing views

You can apply formatting to drawing views, view annotations, and caption text
by doing any of the following:

• Use the Styles command to create and name a new drawing view style, or to
modify an existing drawing view style. Independent primary and secondary
caption text and formatting can be defined for each drawing view type in the
Drawing View Styles dialog box.

• Ensure the drawing view style is used consistently. You can map a drawing
view style to each type of drawing view using the Drawing View Style tab (Solid
Edge Options dialog box).

To learn how, see Map drawing view styles.

• Modify the properties of a single, selected drawing view or view annotation. For
example, you can use the Caption tab (Drawing View Properties dialog box to
modify the default drawing view caption or view annotation caption defined in
the drawing view style.

Using the Styles command to create and modify drawing view styles

Whether you are creating or modifying a drawing view style, you begin with the
Styles command and the Style dialog box, where you set the Style Type to Drawing
View. You can select the New button to create a new style or the Modify button to
change an existing style.

• The Drawing View style identifies the name of the style and defines:

o The display properties of different types of drawing views.

o The default content and formatting of drawing view captions.

o The appearance of the lines used by cutting planes, view planes, and detail
view envelopes.

• The Drawing View Style dialog box contains four tabs:

o Use the Name tab to name a new drawing view style that you are creating.
If you are modifying a style, you can select a different style or no style as
the basis for your changes.

o Use the Lines tab to specify the appearance of lines and terminators used
in cutting planes, view planes, and detail envelopes, and in the section,
auxiliary, and detail drawing views that are derived from them.

o Use the Caption tab to specify the property text-derived content of the
primary caption and the secondary caption for each type of drawing view and
view annotation. This is also where you control whether a caption is shown
or not shown by default when a drawing view or view annotation is placed
on the drawing.

o Use the Caption Format tab to specify the formatting of the caption and its
location with respect to the drawing view or view annotation.
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To learn the basic procedure for creating drawing view styles, see the Help topic,
Create or modify a drawing view style.

Drawing view style workflow

Use the following workflow to create drawing view styles for different drawing view
types. This process incorporates all of the elements of the drawing view style:

• Drawing view captions

• View annotation captions

• View annotation labels

Step 1: On the Name tab, create a new Style name based on the existing style
that is the best match for the content and formatting that you want.

Step 2: Use the top portion of the Caption tab, under Drawing View, to select a
drawing view Type, and then define the content that you want to appear
in the caption when the drawing view is placed. You should do this for
each type of drawing view for which you want to define unique caption
content within a single drawing view style. Another way to use this is
to define unique caption content for a single drawing view type and to
assign it to its own style.

Use the Show check box to control whether the caption is displayed by
default for the currently selected drawing view type.

Step 3: For section, auxiliary, and detail views, use the View Annotation portion
of the Caption tab to select the view annotation Type—Cutting Plane,
Viewing Plane, or Detail Envelope—and then define the content that
you want to appear in the caption when that view annotation is defined
on a source view.

Use the Show check box to control whether the view annotation caption
is displayed by default for the currently selected view annotation type.

Step 4: In the Properties portion of the Caption tab, verify that the boxes contain
the property text strings, plain text, and punctuation that you want
to show when the corresponding property text code, such as %AS, is
resolved in the caption.

For each of the Properties boxes that you reference in the drawing view
caption or the view annotation caption, you can use the Show check box
to control whether it is displayed in the primary or secondary caption if
that caption is shown.

Step 5: Use the Caption Format tab to specify caption font, font size, color, and a
horizontal divider between primary and secondary captions.

Note

To learn how to do steps 1 through 5, and to see examples, see
Define drawing view captions using property text.
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Step 6: Use the Caption options on the Annotation tab (Solid Edge Options
dialog box) to automate the display of sheet number, view scale, and
rotation angle in drawing views.

Step 7: (Optional) Use the Specify Annotation Letters dialog box to define
annotation labels, for example, A, B, C and A1, B1, C1, and to choose the
order in which you want the labels to be assigned.

Step 8: Use the Drawing View Style tab of the Solid Edge Options dialog box to
map drawing view styles to drawing views.

Create or modify a drawing view style

Use the options in the Drawing View Style dialog box to create or modify a drawing
view style. A drawing view style defines the default content and appearance of the
source drawing view caption and the view annotation caption.

1. Choose View tab®Style group®Styles .

2. In the Style dialog box, set the Style Type to Drawing View.

3. Do one of the following:

• (To define a new drawing view style) Click New.

• (To modify an existing drawing view style) From the Styles list, select the
style to modify and then click Modify.

4. (For a new drawing view style) In the New Drawing View Style dialog box, on
the Name page, do the following:

• In the Name box, type a name for the new drawing view style.

Example

To create a style for detail views and detail envelopes, type Detail.

• From the Based On list, select a style to use as a template for the new
drawing view style.

5. On the Caption tab (Drawing View Style dialog box), define the default drawing
view caption text and caption location for the selected drawing view type.

To learn how, see the Help topic, Define drawing view captions using property
text.

6. On the Caption Format tab (Drawing View Style dialog box), specify the
appearance of the caption and its placement location with respect to the drawing
view.

7. On the Lines tab (Drawing View Style dialog box), choose the line styles that will
be used to display the cutting plane lines in view annotations.

8. In the Drawing View Style dialog box, click OK.

9. In the Style dialog box, click Close.
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Tip

You can create and name a unique drawing view style for each type of drawing
view you place. To apply a style you have created, select the style name from
the Drawing View style list on the command bar, or from the Drawing View
style list on the Caption tab (Drawing View Properties dialog box).

Map drawing view styles

You can either assign all drawing views to use the same style, or you can selectively
assign different drawing view types to use different styles.

Assign the same style to all drawing view types

1. On the Drawing View Style tab (Solid Edge Options dialog box), from the Set all
styles list, select the drawing view style that you want to assign to all drawing
views.

2. Click the Apply button alongside the Set all styles list.

3. To apply the drawing view style automatically when placing new drawing views,
select the Use drawing view style mapping check box.

Assign different styles to different drawing view types

1. On the Drawing View Style tab (Solid Edge Options dialog box), in the
Element-to-Style mapping table, click the first drawing view type, such as
Principal and Pictorial Views.

2. From the Style list on the same row of the table, select the drawing view style
that you want to assign to the drawing view type.

3. Repeat the first two steps for all other drawing view types.

4. To apply the drawing view style mapping automatically when placing new
drawing views, select the Use drawing view style mapping check box.

Tip

• The styles that are available for mapping are defined using the Styles
command and then choosing Drawing View from the Style Type list.

• When the Use Drawing View Style Mapping box is checked on the
Drawing View Style tab of the Solid Edge Options dialog box, then the
Drawing View Style Mapping button also is set on the command bar when
placing or modifying a drawing view.

When the Use Drawing View Style Mapping box is not checked, Solid
Edge uses the active style to define the appearance of drawing views as
you place them.

Example: formatting a new drawing

You can use styles to make new drawings conform to your company standards. For
example, Solid Edge provides line styles with names such as Visible and Hidden.
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The Hidden style has a line type that looks like a dashed line (A). Your company
standard may require that a hidden line look like a dotted line (B).

To change the Hidden line style to conform to your company’s standards, follow
these steps:

1. Choose the View tab®Style group®Styles command.

2. In the Style dialog box, click the Line style type in the Style Type box.

3. In the Styles list box, click Hidden line style in the line Styles list.

4. Click Modify to access the Modify Line Style dialog box.

5. On the General tab, in the Type box, select the line type that looks like a dotted
line.

All the lines that you draw while the Hidden style is selected on the command bar
will conform to your company’s standards: hidden lines will appear as dotted lines.
You can save the style to a template with the Styles command. This allows you to
use the style again in other drawings.

Example: formatting an existing drawing

You can use styles to make existing drawings conform to your company’s standards.
Suppose you receive a drawing from another company, and all the hidden lines are
continuous (A). Your company standard indicates that hidden lines should be a line
type that is dashed (B). You have been using a line style, called Hidden, to conform
to the standards used by your company.

To change the hidden lines in the drawing quickly and efficiently, follow these steps:

1. Open the drawing that you received from the other company.

2. Select all the lines that you want to change.

3. On the command bar, select Hidden in the Style list box to change all the lines
that you have selected.

All the lines now appear as dashed lines instead of continuous lines.

Drawing view captions

Drawing view captions

Drawing view captions and view annotation captions are defined as part of the
Drawing View style in the Drawing View Style dialog box.
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Defining drawing view captions

You can define default caption content using plain text, property text, and symbols.
When a drawing view is placed, the information referenced by the property text
codes is displayed in the drawing view caption and in the view annotation caption.

Use the Caption tab (Drawing View Style dialog box) to specify the property
text-derived content of the primary caption and the secondary caption.

• For the currently selected type of drawing view—Principal and Pictorial Views,
Section Views, Detail Views, Auxiliary Views, or 2D Model Views—and for the
currently selected caption type—Primary caption or Secondary caption—use the
top portion of the Caption tab, under Drawing View, to define the basic caption
content that you always want to display when the drawing view type is placed.

o You can use the first four buttons to insert commonly used property text
codes.

Use these buttons To insert these property text
codes

Suffix (%AS)

View Scale (%VS)

View Angle of Rotation (%VR)

Annotation Sheet Number (%LN)

Note

The %LN property text code
provides a cross-reference
between the section, auxiliary,
or detail view caption and the
sheet where the corresponding
cutting plane, viewing plane,
or detail envelope is located.

o You can use the next two buttons to insert symbols and other types of
property text at the cursor position, either in the drawing view caption text
or the view annotation caption text.

Use this button To do this Using this
Retrieve any property
text strings associated
with the Draft document
or with the model.

Select Property Text
dialog box

Insert symbol codes that
specify tolerance zone,
dimensions, material
condition, geometric
characteristics, and
welds.

Select Symbols and
Values dialog box
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Use the Caption Format tab (Drawing View Style dialog box) to specify the
formatting of the caption and its location with respect to the drawing view or view
annotation. You can:

• Specify the placement location—above or below the drawing view—for the
primary and secondary captions that you define.

• Choose a font type, font size, and color of the caption text.

• Add a horizontal divider between the primary and secondary captions.

Use the Lines tab to specify the appearance of lines and terminators used in cutting
planes, viewing planes, and detail envelopes, and in the section, auxiliary, and detail
drawing views that are derived from them.

In addition, each drawing view style references formatting instructions from the
following tabs in the drawing Dimension style:

• Units tab

• Secondary Units tab

• Spacing tab

To learn how to create captions within drawing view styles, see the Help topic, Define
drawing view captions using property text.

Defining view annotation captions

The captions for Section Views, Auxiliary Views, and Detail Views are independent
of the captions for the view annotations used to create them. Use the middle portion
of the Caption tab—under View Annotation—to specify a single line of property text,
plain text, and symbols that you always want to display in the source view caption
where the currently selected View Annotation Type—Cutting Plane, Viewing Plane,
or Detail Envelope—is drawn.

Whatever you define as the default caption content may be modified after a drawing
view is placed by selecting the cutting plane line, the viewing plane line, or the detail
envelope and then opening the Properties dialog box.

You are not limited to the property text inserted by the following buttons:

View Annotation Name (%VA)

The %VA property text code automatically displays the view annotation label
(for example, A, B, C) within the caption text of the cutting plane, viewing plane,
or detail envelope view.

• The label is defined in the Specify Annotation Letters dialog box, which you
can open from the Annotation tab (Solid Edge Options dialog box).
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• You can select an existing cutting plane, viewing plane, or detail envelope
on the sheet and modify its default content and formatting by editing its
properties.

View Sheet Number (%VN)

The %VN property text code automatically displays the sheet number where the
section, auxiliary, or detail view is located.

Note

The %VN property text code provides a sheet cross-reference between the
source view where the cutting plane, viewing plane, or detail envelope
is drawn, and the resultant view.

See the Help topic, Define a view annotation caption.

Automating drawing view caption content

Using property text to extract information into a caption ensures caption content
is current. For example, inserting the %VS and %VR property text codes into the
caption text displays the current view scale and view rotation angle. Inserting the
%LN property text code into the section view caption displays the sheet location of
the cutting plane used to create it. Similarly, inserting the %VN property text code
into the detail envelope caption displays the sheet number of the detail view.

You can use the check boxes in the Caption section on the Annotation page (Solid
Edge Options dialog box) to automate the following:

• Display the view scale in the caption only when the view scale is different from
the sheet scale. Otherwise, do not show the view scale.

• Display the view rotation angle only when the drawing view is rotated. Do not
display rotation angle when it is 0 degrees.

• Display sheet location information in a caption. When a derived view is moved
to a different sheet than its parent, update the caption with the sheet number
cross-reference. When the views are reunited, do not show the sheet number.

Assigning view annotation labels

The alphanumeric labels that appear in view annotation captions are defined in the
Specify Annotation Letters dialog box. You can define four different sequences of any
combination of uppercase and lowercase letters and numbers, and you can assign a
different labeling sequence to different view annotations. The labels can be assigned
automatically according to a user-defined order or in the order they are created.

You can specify the order in which labels are generated using the following options
on the Annotation tab (Solid Edge Options dialog box).
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Follow object creation sequence
Assigns names based on the order in which view annotation objects are
generated.

Follow defined object sequence
Assigns names to view annotation objects based on a user-defined order. You can
use the Define Object Sequence dialog box to specify the order.

To learn how, see Define annotation labels.

The following table compares the effect on view annotation names when using object
creation sequence to determine view annotation names and when using the order in
the Define Object Sequence dialog box.

Label results for:

Creation order Annotation object
created

Follow object
creation sequence

Follow defined
object sequence

1 Cutting plane 1 A - Cutting plane 1 A - Viewing plane 1
2 Viewing plane 1 B - Viewing plane 1 B - Viewing plane 2
3 Detail envelope 1 C - Detail envelope 1 C - Viewing plane 3
4 Cutting plane 2 D - Cutting plane 2 D - Detail envelope 1
5 Detail envelope 2 E - Detail envelope 2 E - Detail envelope 2
6 Viewing plane 2 F - Viewing plane 2 F - Cutting plane 1
7 Viewing plane 3 G - Viewing plane 3 G - Cutting plane 2

Showing and hiding caption content

There are multiple levels of display control for captions:

• For the drawing view.

• For the source view where the cutting plane, viewing plane, or detail envelope is
located.

• For individual elements of the caption, such as the view name, suffix, sheet
number, rotation angle, and the view scale.

For each primary or secondary caption you define, for each drawing view type
and view annotation type, you can use the Show check boxes on the Caption tab
under Drawing View and under View Annotation to control whether the caption
is displayed by default when the view or view annotation is placed. You also can
use the Show check boxes at the bottom of the Caption tab—under Properties—to
selectively control whether individual property text strings are extracted and
displayed in the caption.

You can select existing drawing views and view annotations and use the Show
Caption button on the command bar to control whether a Primary or Secondary
caption is shown or not, and if shown, whether individual, subordinate parts of the
caption (such as view annotation name, suffix, view scale, and angle of rotation)
are displayed.
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Modifying caption properties

You can control caption display and formatting separately for a drawing view, such
as an auxiliary or section view, and for the viewing plane or cutting plane used to
create it.

• When you select any drawing view, you can use the Caption tab (Drawing View
Properties dialog box) to modify its properties.

• When you select a view annotation, you can use the Caption tab (Viewing Plane,
Detail Envelope, Cutting Plane Properties dialog box) to modify its properties.

Define drawing view captions using property text

You define drawing view captions and view annotation captions within a drawing
view style. As part of this process, you:

• Define drawing view caption content

• Define view annotation caption content

• Specify caption formatting

Define drawing view caption content

1. On the Caption tab (Drawing View Style dialog box), from the Drawing View
Type list, choose one of the following drawing view types to define a caption:

• Principal and Pictorial Views

• Section Views

• Detail Views

• Auxiliary Views

• 2D Model Views

2. From the second list, select the caption type—Primary caption or Secondary
caption—and then select the Show check box.

3. In the top portion of the Caption tab—under Drawing View—some standard
property text codes and other content is displayed based on the drawing view
type you selected. Do the following to define content that you always want to
display when a drawing view of the current type is placed:

a. Delete the content you do not want to keep.

b. Click the Properties buttons to insert any of the four most frequently used
property text codes—Suffix (%AS), Annotation Sheet Number (%LN), View
Scale (%VS), and Angle of Rotation (%VR)—into the text box.

These property text codes reference the Properties boxes at the bottom of
the Caption tab.

c. To add descriptive text, punctuation, or symbols, click where you want to
insert it in the caption text, and then:
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• Type plain text.

• Click the Symbols button to select and insert symbols such as
degree or diameter directly into the text using the Select Symbols and
Values dialog box.

• Click the Property Text button to choose property text from sources
other than the drawing view using the Select Property Text dialog box.

Example

Selecting From graphic connection as the property text source
extracts property values from the model the drawing view depicts.

d. Click the Show check box.

Example

For Principal and Pictorial Views, you may want to show the view scale
and the rotation angle whenever a view is rotated. Do the following:

a. In the text box, type SCALE=, click the View Scale %VS button ,
and then press Enter to insert a new line.

b. Type VIEW ANGLE=, and then click the Angle of Rotation %VR

button .

4. At the bottom of the Caption tab—under Properties, do the following:

a. For each of the property text codes you inserted into the Caption text box,
such as %VS and %VR, ensure the appropriate property text strings exist
in the Properties boxes, and that the content is what you want to show in
the caption.

• The Properties boxes contain property text strings that derive their
values from the drawing view or the view annotation. You can add
content to the default property text strings by typing, copying and
pasting, and inserting symbols.

Example

Parentheses ( ) are shown around the Annotation Sheet Number
and View Sheet Number property text strings. You can delete the
parentheses, if you do not want them to appear in the caption. You
can add other kinds of text and punctuation by typing it.

• If you delete the default property text strings in a Properties box, you
can use the buttons located at the right side of the box to recreate it.

b. For each property that you want to include in the caption, select the
corresponding Show check box.
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Tip

• You can define a primary caption and secondary caption for each drawing
view type.

Define view annotation caption content

For section views, auxiliary views, or detail views, use the middle portion of the
Caption tab—under View Annotation—to specify a single line of content that you
always want to display in the caption of a source view with a cutting plane line, a
viewing plane line, or a detail envelope:

1. On the Caption tab (Drawing View Style dialog box), from the View Annotation
Type list, select one of the following:

• Cutting Plane

• Viewing Plane

• Detail Envelope

2. In the Caption box, click the Properties buttons to insert property text codes, or
type plain text as you want it to appear.

You also can use the Property Text button at the top of the dialog box to insert
other property text strings, and you can use the Symbols button to insert symbol
codes.

3. Click the Show check box.

4. At the bottom of the Caption tab—under Properties, do the following:

a. For each of the property text codes you inserted into the view annotation
Caption text box, such as %VA and %VN, ensure the appropriate property
text strings exist in the Properties boxes, and that the content is what you
want to show in the caption.

b. For each property that you want to include in the caption, select the
corresponding Show check box.

Tip

• You can create a cross-reference between the sheet the view annotation
is on and the sheet the drawing view is on. When either is moved to a
different sheet, the sheet number is in each of the drawing view captions.

To do this, the %LN and %VN property text codes must be added to
the caption text boxes, and the property text strings must exist in the
Annotation Sheet Number (%LN) and View Sheet Number Properties
(%VN) edit boxes.

For an example, see Define a view annotation caption.
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Specify caption formatting
Within the drawing view style, you can use the Caption Format tab (Drawing View
Style dialog box) to specify the formatting of primary captions differently from
secondary captions.

Add a horizontal line between captions

1. Click the Caption Format tab.

2. From the Caption type list, select Primary caption of drawing views and
view annotations.

3. Select the Separator check box.

Change font properties

You can define different font properties for different drawing view styles by
doing the following:

1. Click the Caption Format tab.

2. From the Caption type list, select one of these Caption types:

• Primary caption of drawing views and view annotations

• Secondary caption of drawing views

3. Do any of the following:

• Choose a different font from the Font list.

• Type a different font size in the Font size box.

• Choose a different color from the Color list.

• Change the text alignment from Center (the default) to Left or Right.

The text is aligned with respect to the view width.

Tip

You can use the Microsoft Character Map dialog box to insert Chinese,
Japanese, and Korean language characters into the caption text, as well
as symbols not supported by the Solid Edge symbol fonts. In this case
you should choose a font that will support those characters, for example,
Arial Unicode MS.

Change caption location

You can change the default location of drawing view captions and view
annotation captions.

1. Click the Caption Format tab.

2. From the Caption type list, select one of these Caption types:

• Primary caption of drawing views and view annotations

• Secondary caption of drawing views
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3. Do any of the following:

• Change the Drawing view caption location from Bottom to Top.

• Change the Cutting plane caption location with respect to the direction
arrows.

For illustrations of the available options, see the Caption Format tab
(Drawing View Style dialog box).

• Change the location of the viewing plane caption with respect to the
terminator.

• Change the Drawing view sheet number location in view annotation
captions with respect to the cutting plane or viewing plane direction
arrows.

Left Arrow Both Arrows

Define annotation labels

You can define the alphanumeric labels assigned to datum frames and to view
annotations—cutting planes, viewing plane lines, and detail envelopes—using the
Specify Annotation Letters dialog box. The labels are displayed automatically:

• In view annotation captions, which are defined as part of the process of creating
or modifying a drawing view style.

• When a datum frame is placed.

1. On the Annotation tab (Solid Edge Options dialog box), under Auto-Naming of
View Annotations, do the following:

a. Select Follow defined object sequence.

b. Click the Specify Annotation Letters button.

2. In the Specify Annotation Letters dialog box, define the labeling scheme for
assigning view annotation names automatically:

a. List 1

In the List 1 box, verify that the letters that are displayed there by default
are the ones you want to use to label view annotations. You can type other
letters and numbers, but special characters, spaces, punctuation, and
duplicate letters are not allowed.
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Example

In the default Solid Edge ANSI and ISO templates,
the letters in the List 1 box are the English alphabet,
ABCDEFGHIJKLMNOPQRSTUVWXYZ.

b. When list ends continue list appended with

Select one of the following labeling options to append to the view annotation
label when all of the letters in the List 1 box have been used:

• Sequenced Letter (AA, AB, AC, ...)

• Number (1, 2, 3, ...)

• Duplicate Letter (AA, BB, CC, ...)

c. (Optional) To display the appended letters using the subscript format shown
below, click the Append as subscript check box.

Tip

The dash and the spacing on either side of it are defined on the
Caption tab in the drawing view style or modified in the properties
dialog box. You can add space around the dash in the Suffix (%AS)
box, under Properties, so that it looks like this: %VA - %VA.

d. List 2, List 3, List 4

Repeat the above steps to define letters or numbers in the List 2, List 3,
and List 4 boxes, as needed, but change the sequence of letters or numbers
appended to the annotation letters to distinguish between them.

You cannot duplicate the characters within a list box, but you can use the
same character sets in List 2, List 3, and List 4.

Note

You do not have to use the List 2, List 3, List 4 boxes unless you want
to create different labels to apply to different types of annotation
objects.

e. Assign Lists

Under Annotation sequence, select the labeling scheme you want to apply to
each type of annotation object.

You can use the user-defined lists specified in the List 1, List 2, List 3, and
List 4 boxes, or you can select one of the system-defined alternatives:

• Plain numbers (1, 2, 3, ...)

• Lowercase Roman numerals (i, ii, iii, ...)

• Uppercase Roman numerals (I, II, III, ...)
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• None

Example

You can:

• Assign List 1 to viewing plane names and cutting plane names,
and then select 1, 2, 3, ... as the Annotation sequence for detail
envelopes.

• Assign List 1 to viewing planes, List 2 to detail envelopes, List 3
to cutting planes, and List 4 to datum frames.

• Select None if you want to leave an annotation object unnamed
when it is created. The object still may be edited and named using
the Caption tab (Viewing Plane, Detail Envelope, Cutting Plane
Properties dialog box), or the Datum Frame command bar.

3. Click OK to continue.

4. On the Annotation tab (Solid Edge Options dialog box), under Auto-Naming of
View Annotations, click the Define Sequence button.

5. In the Define Object Sequence dialog box, specify the order that you want to
assign name to view annotation objects by selecting a name and then using the
Move Up and Move Down buttons to change its location in the list.

Tip

View annotation labels for cutting planes, viewing planes, and detail envelopes
appear in view annotation captions. You can define the caption content and
formatting as part of a drawing view style using the Drawing View Style
dialog box. To learn how, see the following Help topics:

• Drawing view style workflow

• Create or modify a drawing view style

• Define drawing view captions using property text

Define a view annotation caption

You define drawing view captions and view annotation captions within a drawing
view style. Using a detail envelope as an example, this procedure shows how you
can create a view annotation caption that displays the sheet number of the derived
view automatically whenever the drawing view and the view annotation reside
on different sheets.

Create a detail envelope caption

To create this caption—DETAIL ENVELOPE “E” REF. DETAIL ON (2)—do all of
the following:

1. On the Caption tab (Drawing View Style dialog box), in the View Annotation
section:
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a. From the Type list, select Detail Envelope.

b. Delete any existing content in the Caption box.

c. Type DETAIL ENVELOPE, and then click to insert the %VA property
text code into the caption text box.

The %VA property text code automatically displays the view annotation
name (its label) when the detail envelope is created on the source view.

Note

The alphanumeric label is defined in the Specify Annotation Letters
dialog box, which you can open from the Annotation tab (Solid Edge
Options dialog box). See the Help topic, Define annotation labels.

d. Type REF. DETAIL ON, and then click to insert the %VN property
text code into the caption text box.

e. Select the Show check box to the right of the Caption text box.

f. In the Properties section, select the Show check box to the right of this
Properties box:

View Sheet Number (%VN)

2. Click OK to close the Drawing View Style dialog box.

3. Click Apply to close the Style dialog box.

4. On the Annotation tab (Solid Edge Options dialog box):

a. In the Caption section, select the following check box:

Show sheet number if parent annotation (e.g. cutting plane) and derived
view (e.g. section view) do not reside on the same sheet.

Specify Annotation Letters dialog box

The Specify Annotation Letters dialog box defines the alphanumeric labels that
are assigned automatically to view annotation names and to datum frames when
they are created. These labels must be unique, per annotation object type, within
the current document.

Letters Used for Annotation
Specifies up to four different user-defined combinations of alphanumeric
characters that can be used to label viewing plane, cutting plane, detail envelope,
and datum frame annotations.

List 1
Specifies the primary character set for creating view annotation names
automatically. They are used in the order they appear in the box.

The default character set includes all letters of the English alphabet. You can
type other letters and numbers, but special characters, spaces, punctuation,
and duplicate letters are not allowed.
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Note

• You can use the Character Map command to open the
Microsoft Character Map dialog box, which you can use to insert
characters that originate in other languages, such as Chinese,
Japanese, and Korean. However, the drawing view style you are
using must specify a font that supports the characters you insert.

• All characters in the List 1, List 2, List 3, and List 4 boxes must
be specified as Unicode characters.

When list ends continue list appended with
Selects one of three different lettering or numbering schemes to add to
the end of the annotation letter string to create a unique label name.
These are applied when the primary label letters (in the List 1 box) have
been used once.

The append options are as follows:

Sequenced Letter (AA, AB, AC, ...)
When the last annotation letter in List 1 has been used, then the
next annotation object that is created is labeled AA, and the next
one is labeled AB, and then AC.

Number (1, 2, 3, ...)
When the last annotation letter in List 1 has been used, then the
next annotation object that is created is labeled A1, and the next
one is labeled A2, and then A3.

Duplicate Letter (AA, BB, CC, ...)
When the last annotation letter in List 1 has been used, then the
next annotation object that is created is labeled AA, and the next
one is labeled BB, and then CC.

Append as subscript
Displays the appended letters or numbers as subscript.

Note

The dash and the spacing on either side of it are defined
in the drawing view style. You can do this on the Caption
tab (Drawing View Style dialog box), in the Properties box,
Suffix (%AS).

List 2, List 3, List 4
The List 2, List 3, and List 4 boxes define three additional character sets for
creating label names. For example, you can create a character set that uses
only numbers, or a combination of letters and numbers.

When list ends continue list appended with
Specifies the additional letter or number sequence to append to the
annotation letter string, which is defined in the List 2, List 3, or List 4
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box, to create a unique label name. This is applied when the primary
label letters have been used once.

Append as subscript
Displays the appended letters or numbers as subscript.

Assign Lists
Assigns annotation letters to different types of annotation objects. The
annotation letters appear in the annotation caption when the object is created.

You can assign the user-defined names in the List 1, List 2, List 3, and List
4 boxes, or you can assign system-defined sequential numbers, uppercase or
lowercase Roman numerals, or no label at all.

Viewing plane
Assigns the annotation naming convention for viewing planes.

Detail envelope
Assigns the annotation naming convention for detail envelopes.

Cutting plane
Assigns the annotation naming convention for cutting planes.

Datum frame
Assigns the annotation naming convention for datum frames.

Reset
Restores all of the options on this dialog box to the default values for labeling
and sequencing.

Caution

If viewing planes, cutting planes, detail envelopes, or datum frames exist
in the document, and if Follow defined object sequence is currently selected
on the Annotation tab (Solid Edge Options dialog box), then pressing the
Reset button renames all of the existing view annotation objects.

Define Object Sequence dialog box

The Define Object Sequence dialog box prioritizes the order for assigning the view
annotation and datum frame labels defined in the Specify Annotation Letters dialog
box.

Note

The Define Object Sequence dialog box is available only when Follow defined
object sequence is selected on the Annotation tab (Solid Edge Options dialog
box).

Object sequence
Specifies the order in which the view annotation label letters, which are assigned
to different types of annotations in the Assign Lists section of the Specify
Annotation Letters dialog box, are applied to these view annotation objects:

• Viewing planes
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• Detail envelopes

• Cutting planes

• Datum frames

You can use the Move Up and Move Down buttons to move the currently
highlighted view annotation object up or down within the list.

Note

Only the view annotation objects that share the same labeling scheme are
affected by the sequence order in this dialog box. For example, if viewing
planes, detail envelopes, and datum frames all use the List 1 labeling scheme,
but cutting planes use List 2, then the sequence order for Cutting planes
has no effect.

The following table compares the effect on view annotation names when using object
creation sequence to determine view annotation names and when using the order in
the Define Object Sequence dialog box.

Label results for:

Creation order Annotation object
created

Follow object
creation sequence

Follow defined
object sequence

1 Cutting plane 1 A - Cutting plane 1 A - Viewing plane 1
2 Viewing plane 1 B - Viewing plane 1 B - Viewing plane 2
3 Detail envelope 1 C - Detail envelope 1 C - Viewing plane 3
4 Cutting plane 2 D - Cutting plane 2 D - Detail envelope 1
5 Detail envelope 2 E - Detail envelope 2 E - Detail envelope 2
6 Viewing plane 2 F - Viewing plane 2 F - Cutting plane 1
7 Viewing plane 3 G - Viewing plane 3 G - Cutting plane 2

Drawing View Style dialog box

Creates or modifies a drawing view style, including the caption and view annotation.

Tabs

Name

Caption

Caption Format

Lines

Lines tab (Drawing View Style dialog box)

The Lines tab in the Drawing View Style dialog box defines the appearance of view
annotations that use the drawing view style.

Drawing View
Sets options for drawing view border display.
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Line Type
Specifies the line type for the drawing view border.

Line Width
Specifies the line width for the drawing view border.

Note

To see the effect of changes to these settings, the Show drawing view
border check box on the General tab (Drawing View Properties dialog
box) must be selected.

View Annotation
Terminator
Specifies the appearance of the terminator lines and arrows.

Display
Controls the display of terminators on the cutting plane line or the
viewing plane line. Options are None or Both.

Thin terminator lines
Controls the thickness of the terminator lines.

Type
Specifies the symbol to display on the terminator lines. Options include
Arrows (filled, hollow, open), Slash, Back Slash, Blank, Circle, and Dot.

Length= __ x Font size
Specifies the length of the terminator symbol as a ratio of font size.

Cutting Plane
Point toward
Specifies that the terminator lines point toward the cutting plane line.

Point away
Specifies that the terminator lines point away from the cutting plane line.

Style
Sets the style for the cutting plane line. Options are Thick, Thick Corners
Only, and Thick/Thin.

Thick line length = __ x Font size
Specifies the length of the thick portions of the cutting plane line. The value
is multiplied by font size. This setting only applies to the Thick/Thin and
Thick Corners Only options for Style.

Offset arrow
Offsets the cutting plane direction arrow along the length of the thick portion
of the cutting plane line. Values are 0 through 1. This option applies to
Thick/Thin and Thick Corners Only cutting plane line styles.

Value Cutting Plane Arrow Location
0 Arrows are located at the outside end of the thick portion.
0.5 Arrows are centered on the thick portion.
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1 Arrows are located at the inside end of the thick portion.

Line
Line type
Specifies the line type for terminator lines used in captions. These include
dashed and solid line types.

Line width
Specifies the line width for terminator lines used in captions.

Viewing Plane
Single
Specifies that a single terminator line is displayed.

Double
Specifies that a double terminator line is displayed.

Caption Format tab (Drawing View Style dialog box)

The Caption Format tab is displayed in the Drawing View Style dialog box when
creating a drawing view style using the Styles command. It specifies the appearance
of a drawing view caption and of a view annotation caption.

The options that are available vary with the caption type.

Format
Specifies the appearance of the drawing view and view annotation primary
caption and secondary caption independently of one another.

Caption type
Primary caption of drawing views and view annotations
Specifies that all of the Caption Format tab options below are applied to
the primary caption.

Secondary caption of drawing views
Specifies that all of the Caption Format tab options below are applied
to the secondary caption.
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Note

View annotations only use the primary caption type.

Font
Lists the available fonts. Applies the font to the currently selected Caption
type.

Note

You should choose a font that supports all of the characters that
you intend to use in captions. For example, the Arial Unicode font
supports all characters that can be selected using the Microsoft
Character Map dialog box, including Chinese, Japanese, and Russian
language characters.

Font style
Applies Regular, Bold, Italic, or Bold Italic font style to the currently selected
Caption type.

Font Size
Specifies the text size for the text in the currently selected Caption type.

Color
Specifies the text color for the currently selected Caption type.

Alignment
Specifies caption text alignment with respect to the number of lines of text.

Fill text with background color
Fills the text with the current background color. The background color of the
drawing sheet is set on the Colors page (Solid Edge Options dialog box).

You can use this to add blank space around caption or label text that
interferes with other elements on the drawing.

Separator
Displays a horizontal separator line between the primary caption text and
the secondary caption text.

Use units, secondary units, and spacing from this dimension style
The dimension style controls the units, secondary units, and spacing values used
in the drawing view style and view annotation style.

You can verify the values and other settings for the dimension style using the
following tabs in the Dimension Style dialog box:

• Units tab

• Secondary Units tab

• Spacing tab

Location
Drawing view caption location
Caption location options are:
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• Top—Above the drawing view.

• Bottom—Below the drawing view.

Cutting plane caption location
Specifies where the cutting plane caption text is placed with respect to the
cutting plane lines.

Direction Line Open End
Positions the cutting plane caption text at the open end of the cutting
plane. For example, if your cutting plane terminator option is set to
Point Away, the text is positioned as shown at (A). If your cutting plane
terminator option is set to Point Toward, the text is positioned as shown
in (B).

Direction Line Connected End
Positions the cutting plane caption text at the end of the direction line
that is connected to the cutting plane. For example, if your cutting plane
terminator option is set to Point Away, the text is positioned as shown at
(A). If your cutting plane terminator option is set to Point Toward, the
text is positioned as shown in (B).

Cutting Plane End
Positions the cutting plane caption text beyond the ends of the cutting
plane. When this option is set, the caption text is positioned the same for
both cutting plane terminator options.
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Locate viewing plane caption option at terminator end
Sets the position of the caption text. When this box is checked, the caption is
placed at the terminator end of the viewing plane line. When unchecked, the
caption is placed at the non-terminator end of the viewing plane line.

Drawing view sheet number location in view annotation caption
Specifies where the drawing view sheet number appears within the view
annotation caption when a cutting plane or viewing plane is placed on the
drawing. You can show the sheet number at the left arrow, at the right
arrow, or at both arrows.

Caption tab (Drawing View Style dialog box)

The Caption tab in the Drawing View Style dialog box defines default caption content
in a style. You can create different caption content for each type of drawing view
and for each type of view annotation.

Drawing View
The options in the Drawing View section define caption content in the style for
the currently selected drawing view type.

You can map drawing view styles to drawing view types on the Drawing View
Style tab (Solid Edge Options dialog box).

Type
The first list specifies the type of drawing view for which you are creating
a caption style. The options are Principal and Pictorial Views, 2D Model
Views, Section Views, Auxiliary Views, Detail Views, or Nailboard Views.

The second list specifies that you are creating caption text for a Primary
caption or a Secondary caption.

Show
Specifies that the default content and formatting for the currently selected
caption type—the Primary caption or the Secondary caption—is applied
when the currently selected Drawing View Type is placed on a drawing.

Example

It is common to show a caption on auxiliary, detail, and section views,
but not to show a caption on principal or pictorial views.

Caption text
Defines the default content for the currently selected drawing view type
and caption type.
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You can create a caption that contains multiple lines of plain text, property
text, and symbols using the Properties buttons and by typing directly in
the box.

Properties buttons
Insert property text codes and symbol codes into the caption text box. When
a drawing view is placed, the corresponding information is displayed in the
drawing view caption, if the caption and the property are set to Show.

• The Suffix, Annotation Sheet Number, View Scale, and Angle of Rotation
buttons insert property text codes that reference the corresponding
definitions in the Properties section at the bottom of the dialog box.

• The Property Text button inserts property text that references other
sources. You can insert the property text at the current cursor position,
or you can copy it to the clipboard.

• The Symbols button inserts codes that convert to symbols.

Properties buttons

Use this To do this
Which
extracts this
content

Example From this
source

Insert this
property text
code:

%AS

Suffix

The cursor
position
within the
caption text
determines
whether the
content is
inserted as
a suffix or as a
prefix.

In the caption
for a section
or auxiliary
drawing
view, you can
display the
name of the
viewing plane
line or cutting
plane line:

B

B-1

Displays the
resolved string
defined in the
Suffix (%AS)
box at the
bottom of the
Caption tab.
This string is
different for
each drawing
view type.

View
annotation
names (%VA)
are defined
in the Specify
Annotation
Letters dialog
box.

Insert this
property text
code:

%LN

Annotation
sheet number

In a drawing
view or view
annotation
caption, this
displays:

(2)

The resolved
string defined
in the
Annotation
Sheet Number
(%LN) box,
below.

Insert this
property text
code:

%VS

View scale In a drawing
view caption,
this displays:

(1:45)

The resolved
string defined
in the View
Scale (%VS)
box, below.
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Properties buttons

Use this To do this
Which
extracts this
content

Example From this
source

Insert this
property text
code:

%VR

Angle of
rotation

In a drawing
view caption,
this displays:

45°

The resolved
string defined
in the Angle
of Rotation
(%VR) box,
below.

Select and
insert a
property text
string at the
current cursor
position in the
dialog box,
such as:

%{Number of
Sheets}

Any property
text strings
associated
with the Draft
document
or from the
model.

In a drawing
view or view
annotation
caption, this
displays:

6

Select
Property Text
dialog box

Select
and insert
property text
codes at the
current cursor
position in the
dialog box,
such as:

%PM

%DI

%DG

Any available
symbols or
values, such as
dimension or
weld symbols.

In the drawing
view or view
annotation
caption,
displays the
symbol:

±

°

Æ

Select
Symbols and
Values dialog
box

View Annotation
The options in the View Annotation section define caption content for the
currently selected view annotation type. This enables you to define a caption
that differs for each type of view annotation.

Type
Specifies the type of view annotation for which you are creating a caption.
You can select Cutting Plane, Viewing Plane, or Detail Envelope.

Caption
Defines the default content for the currently selected view annotation
caption. Captions for view annotations contain a single line of plain text,
property text, and symbols.

You can use the Properties buttons to insert text, you can copy and paste
content, and you can type directly in the Caption box.
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Show
When checked, specifies that the view annotation caption is displayed when
a drawing view that contains a corresponding view annotation—a cutting
plane, viewing plane, or detail envelope—is placed on a drawing.

Properties buttons
The Properties buttons insert property text codes into the view annotation
caption.

Properties buttons
Use this To do this Which

extracts this
content

Example From this
source

Inserts this
property text
code:

%VA

View
annotation
name

In the view
annotation
caption, this
displays the
composite
content
defined by the
following:

• View
annotation
properties

• View
annotation
name
labels

The content
in the View
Annotation
Name (%VA)
box on the
Caption tab
(Viewing
Plane, Detail
Envelope,
Cutting Plane
Properties
dialog box)

View
annotation
labels are
defined in
the Specify
Annotation
Letters dialog
box.

Insert this
property text
code:

%VN

Drawing view
sheet number

In the drawing
view caption,
this displays:

(1)

The resolved
string defined
in the View
Sheet Number
(%VN) box,
below.

Properties boxes
Specifies the property text, plain text, and symbols to display in the drawing
view caption and the view annotation caption when all of the following are true:

• Three-character property text codes, which reference the property text boxes
in the Properties section, exist in the drawing view Caption box and in the
view annotation Caption box.

• The Show check box for the property text in the Properties section is selected.

• The Show check box for the caption Type is checked.
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Suffix (%AS) box
Specifies the content to be inserted as a suffix (or a prefix) in the drawing
view caption when %AS is entered in the Caption box.

The Suffix option is intended to be used for section, detail, and auxiliary
views, and it is unique for each view type. This enables you to specify
different formatting for each view annotation label.

Inserts the %VA property text code into the Suffix (%AS) box. This
extracts the view annotation name into the suffix content defined in
the Caption box.

You can create a hyphenated suffix by typing in the box and copying
and pasting other property text.

Show
When checked, and when %AS exists within the Caption box, shows the
suffix with the drawing view caption.

Example

If you want to display section views with captions using the format
“SECTION (A)”, you can enter “(%VA)” in the Suffix %AS box, and
enter “SECTION %VA” in the Caption box. When the first section view
is placed, the %VA resolves to display “A”, and %AS resolves to display
“(A)”, and the full caption is shown as “SECTION (A)”.

Annotation Sheet Number (%LN) box
Displays the property text string for the annotation sheet number. There is a
single definition of %LN for all view types.

Use this option when a resulting drawing view is separated from the view
annotation used to create it.

Inserts %{Annotation Sheet Number|DV} into the Annotation Sheet
Number box. When resolved, this identifies the sheet number where the
corresponding view annotation exists.

Show
When checked, and when %LN is shown in the caption box, displays the
content derived by %LN in the drawing view caption.

View Scale (%VS) box
Displays the property text string for the primary and secondary view scale,
for example, 2:1.

There is a single definition of %VS for all view types.
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Inserts %{Primary Scale|DV} into the View Scale box. When resolved,
the %{Primary Scale|DV} property text displays the first number in the
drawing view scale.

Inserts %{Secondary Scale|DV} into the View Scale box. When resolved,
the %{Secondary Scale|DV} property text displays the second number
in the drawing view scale.

Show
When checked, and when %VS is shown in the primary or secondary
caption box, displays the view scale in the drawing view caption.

Angle of Rotation (%VR) box
Displays the property text string for the view angle of rotation. There is a
single definition of %VR for all view types.

Inserts %RA into the Angle of Rotation box. When resolved, this property
text displays the rotation angle symbol for the ESKD drawing standard
in the caption.

Inserts %CA into the Angle of Rotation box. When resolved, this property
text displays the counterclockwise rotation angle symbol for the GB
drawing standard in the caption.

Note

You can insert the property text code for the clockwise rotation
angle symbol (%C2) using the Select Symbols and Values dialog
box.

Inserts %{View Angle|DV} into the Angle of Rotation box. When
resolved, this property text displays the drawing view rotation angle
in the caption.

Show
When checked, and when %VR is shown in the primary or secondary
Caption box, displays the content derived by %VR in the caption.

View Sheet Number (%VN) box
Displays the property text string for the drawing view sheet number. There
is a single definition of %VN for all view types.
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Inserts (%{View Sheet Number|DV}) into the View Sheet Number box.
When resolved, this identifies the sheet number where the corresponding
drawing view exists.

Show
When checked, and when %VN is shown in the primary or secondary
Caption box, displays the content derived by %VN in the drawing view
caption.

Defining Drawing Standards

The first time you load Solid Edge at your company, you should consider setting
standards to apply to the drawings you create in the Draft environment.

Although you can change the settings in the Draft environment to meet company
requirements each time you create a Draft document, you will be more productive if
you set up one or more Draft documents with the standard settings you need. You
can then use these documents as templates for all of your drawings, making it easier
for all users to conform to company standards.

When setting your drawing standards, consider the following:

• Background sheet graphics for your drawing borders

• The projection angle you want

• The thread depiction standard you want

• The edge display symbology you want for the drawing views

• The standard you want for the dimension style

• The fonts you want for text on your drawings

Creating New Documents

When you use the Document option, the working units for the new document are
based on the option you selected when you loaded the software. For example, if you
selected the Metric option, the working units will be metric; if you selected the
English option the working units will be English.

The advantage to this approach is that graphics for the background sheets already
exist in the new document. You can customize these graphics by adding your
company logo and any other graphics you want.
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Creating Background Sheet Graphics

Most companies use custom graphics for their drawing borders. These graphics can
include title block information, zone markings, company logos, and so forth. You
can create the graphics you need from scratch or you can translate graphics from
AutoCAD or MicroStation using the Open command on the File menu.

If you are creating the graphics from scratch, you should consider modifying the
generic background sheet graphics in the templates you use to create new documents.

These graphics have been sized correctly for the standard English and metric sheet
sizes. You can easily delete and add graphics to meet your requirements. You can
use the Grid command to precisely position the new graphics you place.

If you translate graphics from another CAD system, they will be placed on the
working sheet. You can then cut and paste them to the background sheet.

After you have created your custom graphics for the sheet sizes you use, you can
delete the background sheet graphics for any sizes you do not use. Doing this will
reduce the size of your standard Draft document.

Setting the Projection Angle

When you create drawing views that are folded from an existing drawing view,
they are created using either first angle or third angle projection. You can set the
projection angle you want on the Options dialog box.

Setting the Thread Depiction Standard

When you create drawing views that contain threaded features, they are displayed
using the ANSI or ISO standard for thread depiction. You can set the thread
depiction standard you want on the Options dialog box.

Note

When constructing parts with industry standard threads, you should typically
use the Hole or Thread commands, not the Helical Protrusion or Helical
Cutout commands.

Helical features require significantly more memory to construct and display in
part documents, and take significantly longer to process in a drawing view.
You should only use helical features where the actual shape of the helical
feature is important to the design or manufacturing process, such as with
springs and custom or unique threads.

Setting the Edge Display Symbology

You can set the edge display symbology for visible, hidden, and tangent edges for
drawing views so they are displayed according to the standards for your company or
industry. For example, your company may not show hidden edges on the drawings
you create. Also you may use a different line thickness for visible and hidden edges.
You can set the Edge Display options you want on the Options dialog box.
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Selecting the Standard for the Dimension Style

Solid Edge is delivered with dimension styles for commonly used drawing standards
including ANSI, ISO, DIN, and so forth. The Style Type option on the Style dialog
box is used to choose the dimension style you want.

After you select the dimension style you want, you can modify the settings within
the style to conform to the standards for your company. For example, you can choose
the font, font size, working units, and so forth for the dimensions you place. You can
also create new styles that are based on one of the existing styles.

Setting the Text Font

For text you place on drawings, you will want to modify the text style settings to
meet your standards. You can also create new text styles for the different types of
text you place. For example you may use a different font for text in the title block
than the text for notes.

By creating additional styles, you can quickly change all the text settings to match
your needs. Defining the text styles in your standard Draft document will also
ensure that all users place text that meet the standards for your company.

Maintaining your Standard Draft Documents

After you have finished creating your standard Draft documents you should test
them to ensure that they meet your standards and make any modifications that are
needed. You should archive a copy in case the originals are accidentally deleted or
modified. If you have multiple users at your company, you should place your standard
Draft documents in the folder where the other Solid Edge templates are stored.

When you load a new version of Solid Edge in the future, you should create new
standard Draft documents again. This will ensure that any enhancements made to
the document structure in the software are incorporated properly.
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Edge display

Edge display in part views

When you create a part view of a part or assembly, the software automatically
determines which edges are visible and which are hidden, and uses line styles to
depict these edges.

When Solid Edge processes part views, it does not create edges where edges do not
already exist in the solid model. The only exception to this rule is for silhouettes, such
as on a cylindrical shaft (1). Tangent edges (2) are visible edges that have adjacent
faces whose normals are parallel at that edge (within the specified tolerance).

You can control the edge display to ensure that your part views show parts the way
you want them on a drawing sheet. You can specify the line styles you want to use
for visible, hidden, and tangent edges, change the line style for individual part edges,
and hide and display individual part edges.

When the parts and assemblies depicted in your part views change, you can update
the part views and the edge display without recreating the part views.
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Setting up the edge display

The Edge Display tab on the Options dialog box allows you to set the line styles you
want to use for the visible, hidden, and tangent edges of part views on the drawing
sheet. These line styles are automatically applied when you create part views.

The templates delivered with Solid Edge contain line styles named, visible, hidden,
and tangent. You can use the Style command on the Format menu to change these
line styles or create new line styles.

If your organization has a standard line style for hidden, visible, and tangent edges,
you can ensure that your drawings conform to standards by saving the edge display
options in a template. You can then use the template to apply the same edge display
options each time you create a new part view.

Changing the edge display

There are several ways you can change the edge display in the drawing view:

• You can use the Properties command on the Edit or shortcut menu to change
the edge display options for individual part views. When working with views of
parts in an assembly, you can use the Properties command to change the edge
display for each part in the assembly.

• You can use the Show Hidden-Tangent Edges option on the Display page
(Drawing View Properties dialog box) to show hidden lines and hidden-tangent
lines in the drawing. This exposes the internal components and details of the
parts.

After you create a part view, you can also use the Edge Painter command to change
the edge display for individual edges. You can use the options on the command bar to
specify the new line style and whether the entire edge or only a portion of the edge
is changed. With the Edge Painter command, you can change the edge display one
element at a time or multiple elements at one time. To change the edge display on
more than one element at a time, you can click the mouse button and drag the cursor
over the elements for which you want to change the edge display. When you release
the mouse button, the edge display will be changed for the selected elements.

Displaying and hiding edges

In complex part views, you can use the Properties command to hide or display hidden
edges and tangent edges. For example, many companies prefer not to display hidden
edges on assembly drawings. Options on the Display page (Drawing View Properties
dialog box) allow you to control the display of hidden lines and hidden-tangent
lines in the drawing. You can use these options to show the internal components
and details of the part.

• Show Edges Hidden By Other Parts

• Show Hidden-Tangent Edges

If you do not need hidden edge information, you can often increase drawing view
performance by keeping hidden edges undisplayed. In addition, you can use the
Hide Edges command to hide individual edges, and the Show Edges command to
display individual edges.
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Setting edge display defaults

You can use the Drawing View Display Defaults dialog box, accessible from the
Display tab of the Drawing View Properties dialog box, to set default display settings
for part edges. When you save the file, these settings are saved with the view. The
drawing view level default settings control the display of parts added after the view
is created that appear when the view is updated.

When you fold a drawing view, the folded view inherits its edge display settings
from the source view.

Displaying and hiding parts

In an assembly drawing, you can use the Properties command to hide or display
parts in the part view. When you hide or display parts in a part view, the part view
becomes out-of-date. You can use the Update Views command to update the part
view on the drawing sheet.

Interference between parts in an assembly

When there is physical interference between parts in an assembly, such as with
a press fit or threaded parts, the default drawing view display settings may not
process the edges properly where the parts interfere. For example, if a shaft is
designed to be a press fit into a hole on its mating part, the edge of the hole is
obstructed by the shaft, and it will not display as a visible edge. Also, because
the shaft is physically larger than the hole, the shaft edges may not display (1) or
they may not be trimmed properly (2).

This display is normal when using the default settings, which are designed to ignore
interference to improve processing speed. Commands and options are available to
adjust the display to process the interfering edges. Settings on the Display tab of
the Drawing View Properties dialog box allow you to modify the edge display of
the entire drawing view.

The Part Intersections options on the Advanced tab enable you to specify additional
processing to determine where edges on mating parts intersect. Since interference
only occurs when more than one solid body exists in a part view, you should leave the
Do Not Process Intersections option set when working with part views of a single
part.
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When the option is set to Process Intersections Without Creating Face Intersections,
the edges on the shaft will display properly.

You can use the Create Face Intersections of Threaded Parts option on the Advanced
tab when working with mating parts that are threaded, such as a threaded stud that
protrudes from a threaded hole, to obtain correct display.

If threads for holes slightly off parallel or perpendicular to the view plane do not
display, try increasing the thread axis tolerance on the Advanced tab. If edges that
should display as tangent in a drawing view instead display as visible or hidden,
try increasing the tangent tolerance on the Advanced tab. Generally you should
only adjust these tolerances if you are experiencing the specified view quality
problems. Letting Solid Edge determine thread axis tolerance and tangent tolerance
is recommended in most cases.

Change the edge display in a drawing view

1. Choose Home tab®Edges group®Edge Painter .

2. On the Edge Painter command bar, set the edge option you want to use. You can
select Change Segment to apply the edge option to an element segment, or select
Change Entire to apply it to an element.

3. Do one of the following:

• To change the edge display one element at a time, click each element for
which you want to change the edge display.
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• To change the edge display on more than one element at the same time, drag
the cursor over the elements. When you release the mouse button, the edge
display for all the elements is changed.

Note

• When a drawing view is updated, options set with the Edge Painter
command are cleared.

• You can use the Hide Edge command to turn off the display of a
selected segment in a drawing view.

Show part edges

1. Choose Home tab®Edges group®Show Edges .

The software highlights the hidden part edges.

2. Click the part edges you want to display.

Hide part edges

1. Choose Home tab®Edges group®Hide Edges .

2. Click the part edges you want to hide in a part view.

Set default display for part edges

1. On the Display tab of the Drawing View Properties dialog box, click Drawing

View Display Defaults .

2. In the Drawing View Display Defaults dialog box, set default display settings as
needed.

3. Click OK.

The part edge display defaults are set. When you save the file, these settings are
saved with the view. The drawing view level default settings control the display of
parts added after the view is created, and they are applied when the view is updated.
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Tip

• You can use the Restore Display Default Settings button on the Display tab
to reapply all of the default settings to the selected drawing view at once.

• You can also set display defaults by selecting every node in a view in the
Parts List, then changing the display settings directly on the Display tab.

• When you fold a drawing view, or create a new section from a section view,
the new view inherits its display defaults from the source view.

Drawing View Display Defaults dialog box

Defines edge display defaults for part views. These defaults are initially derived
from the settings on the Edge Display tab (Solid Edge Options dialog box), as well
as Drawing View Options in the Drawing View Creation Wizard (which override
settings on the Display tab).

Changes you make in the Drawing View Display Defaults dialog box are not applied
until you make and apply a change on the Display tab, or until you select the Restore
Default Display Settings button. However, when you save the file, the default
values are saved with the view, and they override any other settings the next time
you open the file.

Show fill style
Specifies a fill style to be used for the selected parts.

Derive from part
Applies the fill style used in the part.

Automatically alternate hatch spacing in section views
Specifies that different parts are displayed automatically with different hatch
pattern spacing. This aids in distinguishing one cut face from another.

You can adjust the hatch pattern spacing in the selected section or broken-out
section view using the Spacing box on the Display tab (Drawing View Properties
dialog box).

Automatically alternate hatch angle in section views
Specifies that different parts are displayed automatically with different hatch
pattern angles. This aids in distinguishing one cut face from another.

You can adjust the hatch pattern angle in the selected section or broken-out
section view using the Angle box on the Display tab (Drawing View Properties
dialog box).

Visible edge style
Sets the default style for visible edges. On an assembly drawing this option
can be applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Hidden edge style
Sets the default style for hidden edges. On an assembly drawing this option
can be applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.
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Show edges hidden by other parts
Specifies whether to display edges hidden by other parts in the drawing view
by default. The edges are displayed using the hidden edge line style. This
option applies to the entire drawing view on an assembly drawing.

Show hidden-tangent edges
Displays hidden-tangent edges, if they were created in the drawing view.
These edges are in addition to other hidden edges. The edges are displayed
using the hidden edge line style.

Use this option to:

• Show the lines between rounds and tapered faces, which do not have a
sharp edge.

• Show the external edges on the back side of a cast part.

Note

If this results in too many hidden-tangent edges being visible, you
can use these commands to adjust them: Edge Painter, Hide Edges,
Show Edges.

Tangent edge style
Sets the default style for tangent edges. On an assembly drawing this option
can be applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Show tube centerlines
Specifies whether tube centerlines are displayed.

Tube centerline style
Sets the default style for tube centerlines. On an assembly drawing this option
can be applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Derive "Display as Reference" from Assembly
Specifies that the occurrence properties defined in the assembly document
determine whether the occurrence is displayed as a reference part. You can use
the Occurrence Properties command on the PathFinder shortcut menu to specify
that an assembly occurrence is displayed as a reference part in a drawing.

Add graphics to a part view

1. On the drawing sheet, select a part view or a 2D view.

2. Right-click to display the shortcut menu.

3. On the shortcut menu, click Draw In View.

4. Add the graphics you want. For example, you can add images or pictures using
the Insert-Image command, or create lines or shapes using tools on the Draw
group of the Sketching tab of the ribbon.

5. Do one of the following:
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• For a 3D model view, choose Home tab®Close group®Close Draw in View
to close the Draw In View window.

• For a 2D view, you can click the sheet tab to change to the working sheet
from the 2D Model sheet.

Tip

• If you change the scale of the part view later, the graphics you added
will also change scale.

• If you move the part view later, the graphics you added will also move.

Show Edges command

Highlights edges that have been hidden with the Hide Edges command. You can
select an edge and turn its display on.

Hide Edges command

Hides individual edges that you do not want displayed in a part view.

Edge Painter command

Changes an element or element segment in a drawing view to visible, hidden, or
tangent edge option. Occasionally when a drawing view is processed with the Edge
Display command, edges that transition from visible to hidden for example, may not
give you the results you want. You can use Edge Painter to apply the edge display
options you want when this occurs. You can apply the edge display options one
element at a time or to multiple elements at the same time.

When you create a drawing of an assembly model, an additional edge option is
available to allow you to classify an edge as assembly hidden. Assembly hidden
edges are visible edges that are concealed behind another part in the assembly model
but would otherwise normally be visible.

Edge Painter command bar

Change to Visible
Sets the edge option to visible.

Change to Self-Hidden
Sets the edge option to hidden.

Change to Assembly-Hidden
Sets the edge option to assembly hidden. This option is available only if the
attached model is an assembly.

Change to Tangent
Sets the edge option to tangent.

User-Defined Edges
When set, lets you customize edge line style, color, type, and width using the
options on the command bar.
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Style
Selects a line style. The line styles listed are defined in the Dimension Style
dialog box.

Line Color
Sets the edge line color.

Line Type
Sets the edge line type.

Line Width
Sets the edge line width.

Change Segment
Specifies that the active edge option will be applied to an element segment. The
segment is defined by the graphics that intersect the selected element.

Change Entire
Specifies that the active edge option will be applied to an entire element.

Draw In View command

Opens the drawing view you select so you can add graphics to it. You can use the
Draw In View command to add graphics to part views, draft views, and 2D views.

When the Draw In View window opens, you can add line graphics, or you can add
external images or pictures using the Insert-Image command on the main menu.

When you add graphics to a part view with this command, if the drawing view scale
is changed later, the graphics you added will be scaled also. If you move the drawing
view, the graphics you added will also move.

Note

You can also add graphics on top of a part view with the Draw commands,
but these graphics will not scale or move if the drawing view is scaled or
moved later.
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Drawing properties

Drawing properties

Drawing property text
Drawing property text is text that is associative to properties in the current draft,
part, or assembly file, as well as properties in models attached to the current file.
Property text is variable text that is referenced and maintained without manual
editing. For example, you can use property text to display a file’s name and last
modification date, and this information will change when you save the file or select
the Update Property Text command.

You can create or edit property text while creating or editing callouts, balloons, and
parts lists. To add property text, use the Property Text button on the respective

dialog boxes or command bars:

In some cases, you may want to change property text to plain text that is not
associative to the drawing. To convert a specific drawing property text, first select
the text in the drawing, then use the Convert Property Text command on the
shortcut menu.

To convert all drawing property text to plain text at once, use the Convert All
Property Text command.
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Drawing View Properties

Drawing view properties define every display aspect of a drawing view or a 2D Model
view. They are set and modified in the Drawing View Properties dialog box. This
multi-tabbed dialog box displays options that vary with the type of view you are
creating or modifying and whether it is a high quality view or a draft view.

• General tab—Defines the drawing view name, scale, and display characteristics.
Not all options are available for all view types.

• Display tab—Defines the part display, edge display overrides, and section view
options of part views. This tab is not available when you select a 2D view.

• Caption tab—Modifies the caption text and formatting options for the selected
drawing view or view annotation.

• Sections tab—Displays a list of the 3D sectioned cutaway views available for
the drawing view. This tab is available if the drawing view is a high quality
drawing view.

• Drawing View Display Defaults dialog box—Defines edge display defaults for
part views. These defaults are initially derived from the settings on the Edge
Display tab (Solid Edge Options dialog box), as well as Drawing View Options in
the Drawing View Creation Wizard (which override settings on the Display tab).

• Annotation tab—Defines the annotation display defaults for centerlines, detail
borders, and drawing view captions.

• Model Options tab—Defines the drawing view options for simplified parts and
assembly features.

• Shading and Color tab—Defines the shading and color options for the drawing
view.

• Advanced tab—Defines advanced display and processing options for the drawing
view. The settings on this Advanced tab of the Drawing View Properties dialog
box take precedence over their counterparts in the Advanced Edge Display
Options dialog box (Solid Edge Options®Edge Display tab®Advanced button).

Reference Parts

Sometimes you may want parts or subassemblies to be included on a drawing, but
only for reference purposes. Reference parts typically provide a frame of reference
for the components in the drawing view to a higher level assembly or to a completed
product.

You can specify that a part or subassembly is a reference part when you are placing
a part view of an assembly or you can edit the drawing view properties for the part
view later. The Display As Reference option on the Display tab of the Drawing View
Properties dialog box specifies that a part or subassembly is a reference part.

Set drawing view properties

1. Do one of the following:

• Right-click an element in the drawing view.
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• Right-click the drawing view border to select the drawing view.

2. From the shortcut menu, choose Properties.

3. In the Properties dialog box that appears, set the options you want to use.

Tip

• You also can display the shortcut menu by clicking the Select tool,
positioning the cursor over a drawing view, then clicking the right mouse
button.

Display or hide parts in a part view

1. Do one of the following:

• Right-click an element in the part view.

• Right-click the part view border.

2. On the shortcut menu, click Properties.

3. On the Drawing View Properties dialog box, click the Display tab.

4. From the Parts List, select the part or parts that you want to display or hide.

5. Do one of the following:

• Click the Show Selected Parts(s) option to display a part.

• Click the Hide Selected Parts(s) option to hide a part.

6. Set the other options you want to use for the selected parts in the assembly.

Tip

• When you use the Show Selected Parts(s) or Hide Selected Parts(s) options
to display or hide parts in an assembly drawing after you have processed
the edges in a part view, the part view will be out-of-date. To update the
part view, use the Edge Display command.

• You can use the Properties command to set the style options for visible,
hidden and tangent lines.

• You can select all occurrences of a part in a drawing view. To do this, on
the Drawing View Properties dialog box, click the Display tab. From the
Parts List, right-click on the part, and then click Select All Occurrences.

Drawing View Properties dialog box

Defines the properties for a drawing view or a 2D Model view.

Not all properties are available for all types of views. For example, dependent
detail views and 2D Model views have access only to the properties on the General
tab and the Text and Color tab, whereas independent detail views have access to
the properties on all of the tabs.
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Tabs

General

General (Nailboard Drawing View)

Display

Caption

Sections

Annotation

Model Options

Shading and Color

Advanced

General tab (Drawing View Properties dialog box)

The General tab of the Drawing View Properties dialog box defines or modifies the
drawing view name, scale, and display characteristics. Not all options are available
for all drawing view types.

Description
Describes a drawing view. You can type any additional notes or documentation
you need.

Sheet
Displays the drawing sheet name the drawing view exists on in the document.
You can edit this value to move the drawing view to another working sheet
in your document.

Using this option is similar to cutting and pasting drawing views to a new
working sheet. All dimensions and annotations connected to geometry inside the
view also move to the selected sheet.

View Scale
Sets the view scale options for the drawing view.

Select scale
Sets the drawing scale to a standard ratio. The specified ratio defines the
size of the drawing in relation to the size of the real-world object. For a 2:1
ratio, the 2 represents the size of the drawing, and the 1 represents the
size of the real-world object.

Scale value
Sets the drawing scale to the value you type.

View Coordinate System
Sets the coordinate system for the drawing view.

Axis
Displays the axis of the coordinate system to use as the dimension axis.
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Show view annotation (Cutting Plane, Detail Envelope, Viewing Plane)
Displays the view annotation graphics—the cutting plane line, the detail
envelope, or the viewing plane line—on the source drawing view. This option is
available only when the selected view is a section, detail, or auxiliary view.

Show Broken-Out Section view profiles
Displays the profiles for a broken-out section view for the selected drawing view.
Displaying the profiles allows you to edit the profile for a broken-out section view.

Create 3D Dimensions in Pictorial views
Allows creation of 3D dimensions, that is, dimensions that use the associative
model to determine true distance, rather than the space on the 2D drawing
in pictorial views.

Scale dimensions and annotations
Scales the annotations and dimensions inside a view. When this option is set, the
annotations and dimensions display at the active Scale Value for the drawing
view. When this option is cleared, the annotations and dimensions display and
print according to the size specified in the dimension style. This option is useful
when working with 2D foreign data that has been translated into Solid Edge
Draft, such as 2D AutoCAD data.

Hide break lines in broken state
Hides or shows the break lines in a broken region.

This check box works with the Show Broken View option on the Drawing View
Selection command bar.

Show drawing view border
Specifies whether the border is displayed for the drawing view.

Auto-Balloon on next update
Specifies whether automatic ballooning is enabled for the drawing view. You can
use the drop-down list to choose saved settings (from the General tab of the
Parts List Properties dialog box) for newly added balloons. This can be helpful
if previously created balloons used saved settings, because you can choose the
same settings for the new balloons.

Retrieve dimensions on next update
Specifies whether dimensions are retrieved from the associated model on the
next drawing view update.

Include PMI dimensions from model views
Includes PMI dimensions on drawing views which were created using a model
view. When you generate a drawing view from a 3D model view and this option
is set, any product manufacturing information (PMI) dimensions that exist in
the 3D model view are displayed on the drawing view.

When this option is cleared, the drawing view goes out of date. When you update
the drawing view, the PMI dimensions are removed from the drawing view.

This option is not valid for drawing views of assembly zones.

Include PMI annotations from model views
Includes PMI annotations, such as balloons, feature control frames, and so forth,
on drawing views which were created using a model view.
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When this option is cleared, the drawing view goes out of date. When you update
the drawing view, the PMI annotations are removed from the drawing view.

This option is not valid for drawing views of assembly zones.

Lock drawing view position
Prevents the selected drawing views from being moved accidentally when
dragging the cursor. When this box is checked, and the drawing view is
highlighted, a lock symbol is displayed within the drawing view boundary to
indicate its position is fixed.

A locked drawing view still can be moved using explicit commands. To learn
more, see Drawing view manipulation.

Note

A convenient way to lock and unlock a drawing view is to use the Lock
Drawing View Position button on the Drawing View Selection command
bar.

Rotation angle
Specifies the rotation angle of the drawing view. The selected drawing view
rotates about its center according to the angle you specify. You cannot change
the rotation angle for broken views or views that have broken regions.

When a view is selected, one of these drawing view status messages is displayed at
the bottom of the General tab:

• This drawing view is Out-of-Date with respect to the model geometry.

• This drawing view is Up-to-Date with respect to the model geometry.

• This view is a two-dimensional user view which is not connected to any geometry.

You can update an out-of-date view using the Update View command from the view
shortcut menu. You can update all out-of-date views in the drawing using the Home
tab®Drawing Views group®Update Views command on the ribbon.
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Display tab (Drawing View Properties dialog box)

Defines the part display, edge display overrides, and section view options of part,
sheet metal, and assembly drawing views. Option availability varies with view type.

Cut segments
Lists the segments in the cutting plane line used to create a section or revolved
section view, for example, Cut Segment 1, Cut Segment 2, Cut Segment 3.

Note

For multi-segment lines, you can use the Highlight Selection button to
identify which line segment corresponds to which cut in the part geometry.

Alternate positions
Lists the member names shown in an alternate position assembly drawing view.
One member is labeled the (Primary) member; all other members represent
alternate positions of the primary member.

You can select a member from the Alternate positions list, and then select a part
in the Parts list, to adjust the show, hide, fill, edge, and style for individual parts
as they are displayed in different positions in the drawing view.

Note

You can add and remove members in the list, and change their position
designations, using the Set Primary and Alternate Positions command on
the drawing view shortcut menu.

Parts list
Lists the drawing view objects in a tree structure. You can select objects in the
list and then change their display options using the shortcut menu or using
other options on the Display tab.

The following icons may appear in the Parts List:

Icon Description
Part
Weld bead
Construction

Sketch

Coordinate system/center-of-mass coordinate system

Reference plane

Flow line

Tube centerline

Bend centerline
Pipe segment
Pipe fitting
Pipe run
Assembly
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Harness
Bundle
Cable

Wire
Indicates section view. For example:

Indicates no fill. For example:

Indicates reference. For example:

Indicates an error. Check to be sure the associative model is present
and contains no invalid geometry.

Note

If the appears next to a wire harness conductor, the font color
for the conductor properties turns red and an error message
appears at the bottom of the conductor properties.

Indicates a hidden component.
Indicates indeterminate status (multiple selections, for example).

Some icons can appear simultaneously. For example, indicates a reference
part in a section view.

If a section view contains cut ribs, you can fine-tune the hatching display by
selecting the Override Rib Hatching command on its shortcut menu. To learn
how to do this, see the Help topic, Set rib hatching in section views.

Clear Edge Overrides
When set, specifies that edge (Edge Painter and Hide Edge) overrides are cleared
for the drawing view when you click OK.

Drawing View Display Defaults
Displays the Drawing View Display Defaults dialog box.

Parts List Options
Specifies whether to list one or more categories of reference
geometry—constructions, coordinate systems, sketches, reference planes, or
centerlines—in the Parts List. When reference geometry is in the Parts List, it is
available for display in the drawing view.

Highlight Selection
Highlights the graphics for the selected model(s) in the drawing view.

Query Selected Items
Contains controls for creating and manipulating queries. You can use a query to
hide components in a drawing view.
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New Query
Displays the Query dialog box to allow you to create a new query.

Query list
Lists all available queries.

Edit Query
Displays the Query dialog box to allow you to edit the query shown in the
query list.

Execute Query
Executes the query shown in the query list.

Selected Part(s) Display
Restore default display settings
Restores default display settings, as specified in the Drawing View Display
Defaults dialog box.

Show
Displays the parts you select in the Parts List in the drawing view. On
an assembly drawing this option can be applied to individual parts in the
drawing view.

Derive "Display as Reference" from Assembly
Specifies that the occurrence properties defined in the assembly
document determine whether the occurrence is displayed as a reference
part. You can use the Occurrence Properties command on the Assembly
PathFinder shortcut menu to specify that an assembly occurrence is
displayed as a reference part in a drawing.

Display as Reference
Displays the selected parts as reference parts. You can use the Edge
Display tab (Solid Edge Options dialog box) to specify the reference
part edge display style you want to use.

Section
Sections the selected parts. On an assembly drawing this option can
be applied to individual parts in the drawing view if the drawing
view is a section view.

Cut hardware
Specifies whether the selected hardware parts—such as nuts, bolts,
and washers—are cut when intersected by the cutting plane in
section views. This option is only available for section views of
assemblies.

See the help topic, Specify hardware parts.

Show fill style
Specifies a fill style for the selected parts.

Derive from part
Show the fill style used in the part.
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Spacing
For a section or broken out section view:

• Displays the spacing value of the currently applied hatch pattern.

If any spacing values of selected items are different, then the value
is indeterminate. The Spacing box displays a blank.

• Overrides the spacing in the hatch pattern for one or more parts
selected from the Parts list tree on the Display tab.

Angle
For a section or broken out section view:

• Displays the angle value of the currently applied hatch pattern.

If any angle values of selected items are different, then the value is
indeterminate. The Angle box displays a blank.

• Overrides the angle in the hatch pattern for one or more parts
selected from the Parts list tree on the Display tab.

Visible edge style
Sets the style for visible edges. On an assembly drawing this option can be
applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Hidden edge style
Sets the style for hidden edges. On an assembly drawing this option can be
applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Show edges hidden by other parts
Displays edges hidden by other parts in the drawing view. The edges are
displayed using the hidden edge line style. This option applies to the entire
drawing view.

Show hidden-tangent edges
Displays hidden-tangent edges, if they were created in the drawing
view. These edges are in addition to other hidden edges. The edges are
displayed using the hidden edge line style.

Use this option to:

• Show the lines between rounds and tapered faces, which do not
have a sharp edge.

• Show the external edges on the back side of a cast part.
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Note

If this results in too many hidden-tangent edges being visible, you
can use these commands to adjust them:

• Edge Painter

• Hide Edges

• Show Edges

Tangent edge style
Sets the style for tangent edges. On an assembly drawing this option can
be applied to individual parts in the drawing view. You can apply different
styles to different parts in the assembly.

Tube centerline style
Sets the style for tube centerlines. On an assembly drawing this option
can be applied to individual parts in the drawing view. You can apply
different styles to different parts in the assembly.

.cfg, PMI model view, or Zone
Lists the names of available assembly display configurations, 3D PMI model
views, and zones that can be used to generate a drawing view.

– Indicates an assembly display configuration.

– Indicates a 3D PMI model view.

– Indicates a zone.

Check
For legacy files that contain display configurations, checks the current
display configuration version against the version when the drawing view was
last updated and sets the view out-of-date if the version is different.

Note

• Alternatively, you can set an automatic checking option for
assembly display configuration changes across all drawing views.
Set the Assembly Configuration Changes Make Drawing Views
Out-of-Date In This Draft File option on the General page of the
Solid Edge Options dialog box.

• The Match option, below, also must be set to enable the automatic
display configuration check.

Match
Controls whether show and hide part settings in the drawing view tree
structure match the show and hide settings within the selected configuration,
zone, or PMI model view.

When checked, all elements are shown.
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Include reference, sketch, and construction items
Specifies how an assembly display configuration or PMI model view selected
from the .cfg, PMI model view, or Zone list is used in the selected drawing view.

• When checked, specifies that drawing views show all of the model objects
and design elements that are in the selected assembly display configuration
or PMI model view. In addition to the solid design bodies, you can show
surfaces, curves, centerlines, sketches, coordinate systems, and reference
planes.

• When unchecked, specifies that drawing views only show the design bodies
in the assembly display configuration.

Example

To reduce complexity in a drawing, you can use this option to display tube,
pipe, or frame centerlines without displaying the solid tubes, pipes, or
frames.

User Interface

• Drawing View Properties dialog box

• Drawing View Selection command bar

• Item Numbers page (Solid Edge Options dialog box)

• Solid Edge Options dialog box

Command

• View Wizard command

Procedure

• Set drawing view properties

• Set default display for part edges

• Display component geometry in a drawing view

• Display or hide parts in a part view

• Set rib hatching in section views

• Create a new draft query

• Use a query to hide components in a drawing view

Caption tab (Drawing View Properties dialog box)

The Caption tab in the Drawing View Properties dialog box modifies the caption
text and formatting options for the selected drawing view or view annotation. To
see the effect of your changes on the drawing view without closing the dialog box,
you can use the Apply button.
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The Caption tab and the Caption Format tab in the Drawing View Style dialog box
are where caption content and formatting for the drawing view style is defined
initially.

Drawing View style
Specifies the drawing view style to use for the caption text.

Location
Specifies the location for both primary and secondary caption text. The secondary
caption text is always displayed below the primary caption text.

Caption location options are:

• Top—Displays the primary and secondary captions above the drawing view.

• Bottom—Displays the primary and secondary captions below the drawing
view.

Caption
Specifies the content, format, and width of the primary caption and secondary
caption independently of one another.

Caption type
Primary caption—Specifies that all of the Caption tab options below are
applied to the primary caption.

Secondary caption—Specifies that all of the Caption tab options below are
applied to the secondary caption.

Show
When checked, specifies that the currently selected Caption type—the
Primary caption or the Secondary caption—is displayed.

Caption text
Defines the content for the currently selected caption type. You can create a
caption that contains multiple lines of plain text, property text, and symbols.

Example

You can enter this string using the Properties buttons and by typing
in the Caption box:

%{Author} VIEW %AS %LN

VIEW SCALE=%VS VIEW ANGLE=%VR

Properties buttons
Insert property text codes and symbol codes into the caption text box. These
property text codes reference the corresponding definitions in the Properties
section at the bottom of the dialog box.

When a drawing view is placed, the corresponding information is displayed
in the drawing view caption, if the caption and the property are set to Show.
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Properties buttons

Use this To do this
Which
extracts this
content

Example From this
source

Insert this
property text
code:

%AS

Suffix

The cursor
position
within the
caption text
determines
whether the
content is
inserted as
a suffix or as a
prefix.

In the caption
for a section
or auxiliary
drawing
view, you can
display the
name of the
viewing plane
line or cutting
plane line:

A

A - A

Displays the
resolved string
defined in the
Suffix (%AS)
box at the
bottom of the
Caption tab.
This string is
different for
each drawing
view type.

View
annotation
names (%VA)
are defined
in the Specify
Annotation
Letters dialog
box.

Insert this
property text
code:

%LN

Annotation
sheet number

In a drawing
view caption,
this displays:

(2)

The resolved
string defined
in the
Annotation
Sheet Number
(%LN) box,
below.

Insert this
property text
code:

%VS

View scale In a drawing
view caption,
this displays:

(1:45)

The resolved
string defined
in the View
Scale (%VS)
box, below.

Insert this
property text
code:

%VR

Angle of
rotation

In a drawing
view caption,
this displays:

45°

The resolved
string defined
in the Angle
of Rotation
(%VR) box,
below.

Select and
insert a
property text
string at the
current cursor
position in the
dialog box,
such as:

%{Number of
Sheets}

Any property
text strings
associated
with the Draft
document or
the model.

In a drawing
view caption,
this displays:

6

Select
Property Text
dialog box
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Properties buttons

Use this To do this
Which
extracts this
content

Example From this
source

Select
and insert
property text
codes at the
current cursor
position in the
dialog box,
such as:

%PM

%DI

%DG

Any available
symbols or
values, such as
dimension or
weld symbols.

In the drawing
view caption,
displays the
symbol:

±

°

Æ

Select
Symbols and
Values dialog
box

Format
Font
Lists the available fonts. Applies the font to the caption text.

Font style
Applies Regular, Bold, Italic, or Bold Italic font style to the caption text.

Font size
Specifies the text size for the caption text.

Color
Specifies the text color for the caption text.

Alignment
Specifies caption text alignment with respect to the drawing view width.

Separator
Displays a horizontal separator line between the primary caption text and
the secondary caption text.

Properties
The boxes in this section define the property text and symbols to be displayed in
the caption when the corresponding Show check box in the Properties section
also is selected. You can add content to some of the boxes by typing text and by
inserting symbols, characters, and other property text strings.

Note

Even when the Show check box is selected, you still must use the
Properties buttons at the top of the Caption tab to insert the content into
the desired location within the Caption box.

View Annotation Name (%VA) box
The read-only box displays the letters, characters, and symbols that appear
in the caption of a source view that contains a cutting plane, a detail
envelope, or a view plane. In other types of views, this box is blank.
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The property text in each caption name is defined in the drawing view style
associated with the respective view annotation.

Suffix (%AS) box
Displays the text to be inserted as a suffix (or prefix) in the caption.

The Suffix option is intended to be used for section, detail, and auxiliary
views, and it is unique for each view type. This enables you to specify
different formatting for each view annotation label.

Inserts the %VA property text code (for view annotation name) in the
Suffix (%AS) box. This extracts the view annotation name into the suffix
content defined in the caption box. You can type additional text and
property text codes in the box to create a hyphenated suffix.

Show
When checked, and when %AS is shown in the caption text, displays the
derived suffix content with the drawing view caption.

Example

If you want to display section views with captions using the format
“SECTION (A)”, you can enter “(%VA)” in the Suffix %AS box, and
enter “SECTION %VA” in the Caption box. When the first section view
is placed, the %VA resolves to display “A”, and %AS resolves to display
“(A)”, and the full caption is shown as “SECTION (A)”.

Annotation Sheet Number (%LN) box
Displays the property text string for the annotation sheet number. This is
defined in the drawing view style.

Use this option when a resulting drawing view is separated from the view
annotation used to create it.

Inserts %{Annotation Sheet Number|DV} into the Annotation Sheet
Number box. When resolved, this identifies the sheet number where the
corresponding view annotation exists.

Show
When checked, and when %LN is shown in the caption box, displays the
content derived by %LN in the drawing view caption.

View Scale (%VS) box
Displays the property text string for the primary and secondary view scale,
for example, 2:1. This is defined in the drawing view style.

Inserts %{Primary Scale|DV} into the View Scale box. When resolved,
the %{Primary Scale|DV} property text displays the first number in the
drawing view scale.
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Inserts %{Secondary Scale|DV} into the View Scale box. When resolved,
the %{Secondary Scale|DV} property text displays the second number
in the drawing view scale.

Show
When checked, and when %VS is shown in the caption box, displays the
view scale in the drawing view caption.

Angle of Rotation (%VR) box
Displays the property text string for the angle of rotation. This is defined
in the drawing view style.

Inserts %RA into the Angle of Rotation box. When resolved, this property
text displays the rotation angle symbol for the ESKD drawing standard
in the caption.

Inserts %CA into the Angle of Rotation box. When resolved, this property
text displays the rotation angle symbol for the GB drawing standard
in the caption.

Inserts %{View Angle|DV} into the Angle of Rotation box. When
resolved, this property text displays the rotation angle in the caption.

Show
When checked, and when %VR is shown in the caption box, displays the
content derived by %VR in the drawing view caption.

Annotation tab (Drawing View Properties dialog box)

You can apply different annotation line styles to the drawing view you are editing
using the Annotation tab in the Drawing View Properties dialog box.

Show bend centerlines
Displays the bend centerlines on drawing views of sheet metal part flat patterns.

Bend up centerline style
Sets the style for centerlines on bends in the up direction.

Bend down centerline style
Sets the style for centerlines on bends in the down direction.
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Note

In the part or sheet metal model, when the Derive bend direction from
drawing view check box is selected on the Annotation tab (Solid Edge
Options dialog box), then the bend direction centerline styles displayed
on the flat pattern drawing are based on the up and down drawing view
directions.

To learn more, see Creating flat pattern drawings.

Derive bend direction from drawing view
Allows the flattened drawing view to determine bend direction rather than the
model. (By default, bend direction is derived from the face that is designated
the top face when a sheet metal part is flattened.)

Tip

Use the Derive bend direction from drawing view option to keep the bend
direction properly aligned with the drawing view that you place.

• When this box is checked, the bend direction shown in a top drawing
view will be the opposite of that shown in a bottom drawing view.

• When this box is checked, the bend up and bend down centerline
styles also are applied based on the drawing view bend direction.

• When this box is unchecked, the bend direction will be the same for
both top and bottom views.

Show deformation feature origins
Displays the feature origin used to model deformed features, such as dimples,
drawn cutouts, and louvers.

Origin edge style
Sets the style for the feature origin.

Refer to these help topics:

• Adding sheet metal deformation features.

• Working with feature origins

Show deformation feature profiles
Displays the feature profile used to model deformed manufactured features, such
as beads, dimples, and drawn cutouts.

Profile edge style
Sets the style for the feature profile.

Refer to the help topic, Adding sheet metal deformation features.

Show flowlines
Displays the flow lines in a drawing view of an exploded assembly.

Exploded flowline style
Sets the style for exploded assembly flow lines.
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Show boundary edges
Provides line style control for boundary edges in cropped drawing views and
in broken-out section views.

• In cropped drawing views—When the check box is selected, applies a
thin-line style to the cropping boundary edges where the drawing view
boundary intersects the model.

When the check box is deselected, no cropping boundary edges are displayed.

• In broken-out section views—When the check box is selected, applies a
thin-line style to the hatch boundary edges in broken-out views that are
created using the same drawing view to draw the profile and to apply the
section.

When the check box is deselected, hatch boundary edges are displayed, but
they use the Visible edge style setting on the Display tab (Drawing View
Properties dialog box).

Boundary edges style
Specifies the line style for displaying cropping boundary edges and hatch
boundary edges.

Show threads in Section Only section views
Displays hole threads when the cut is along the axis of the hole shown when you
create a thin-section view using the Section Only option.

Note

You can create internal threaded holes in the model when you use the Hole
command and set the Type to Threaded on the Hole Options dialog box.

To learn about creating threaded holes in the model, see Threaded
features.

For more information, see Drawing view cropping.

Solid fill sectioned weld beads
When selected, specifies that all cut weld bead faces in the section drawing view
are displayed using the solid fill style color.
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When deselected, the faces are displayed using the underlying hatch pattern in
the fill style.

This option overrides the default setting on the Edge Display tab, in the Solid
Edge Options dialog box.

Model Options tab (Drawing View Properties dialog box)

Defines the drawing view options for simplified parts and assembly features.

Simplify
Use simplified parts
Specifies whether simplified parts are shown in a drawing view. You can use
this option for drawing views created using a display configuration or a zone.

When the Show Assembly Features box also is checked, both simplified parts
and assembly features are displayed in the drawing view.

For all parts
Specifies that simplified parts are used in the drawing view for all parts
for which a simplified representation is available.

Note

Only this option is valid for placement of a drawing view with
an assembly zone.

Based on configuration
Specifies that simplified parts are used in the drawing view based on
model configuration.

Use simplified assemblies
Specifies whether the simplified assembly representation is used in the
drawing view. You can use this option for drawing views created using a
display configuration.

For all subassemblies
Specifies that you want the drawing view to display all the subassemblies
as simplified for which a simplified representation exists.
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Based on configuration
Specifies that you want the drawing view to display the subassemblies
as simplified or as designed based on how the configuration you select.

For top assembly
Specifies that you want the drawing view to display only the top level
assembly as simplified.

Assembly Features
Show assembly features
Specifies whether assembly features created in the Assembly environment
are shown in the drawing view. This option applies only to material removal
features such as holes, chamfers, and cutouts. When this box is checked,
these types of assembly features are displayed in the drawing view even if
the Use Simplified Parts box is also checked.

Note

You cannot use this option to control the display of assembly material
removal or addition features that were applied to pipes, frames, and
weld beads.

In these cases, you can only control the display of the entire body
using the options on the Display tab on the Drawing View Properties
dialog box. For example, if you apply an assembly cutout feature to a
pipe, frame, or weld bead, you can only show or hide the entire pipe,
frame, or weld bead.

User Interface

• Drawing View Properties dialog box

• Drawing View Selection command bar

Command

• View Wizard command

Procedure

• Set drawing view properties

• Display component geometry in a drawing view

• Display or hide parts in a part view

• Use a query to hide components in a drawing view

Sections tab (Drawing View Properties dialog box)

Displays a list of the 3D sections available for the assembly, part, or sheet metal
model shown in the drawing view. This page is available for both high quality views
and draft quality views. However, only assembly models can be displayed in draft
quality views.
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Sections
Select one or more 3D sections to be displayed in the drawing view, then click
OK. You must use the Update View command on the shortcut menu to see the
effect on the view.

Note

If the drawing view is derived from a PMI model view and is associative to it,
then Sections are disabled. This is because the 3D model view controls the
display settings of any 3D sections that may be included in it.

Shading and Color tab (Drawing View Properties dialog box)

Defines the shading and colors for the drawing view. For example, you can apply
model colors to drawing views to:

• Show purchased parts in one color and manufactured parts in another color.

• Assign a unique color to all newly designed parts on a drawing.

• Apply assembly weld colors to weld bead graphics.

Show shading in drawing views
Adds or removes shading in the drawing view.

Use assembly override colors
Specifies that assembly override colors are used in the drawing view.

Use part face colors
Specifies that part face colors are used in the drawing view.

Note

If parts in a subassembly do not shade, then there may be a conflict
between assembly color assignments and part face color assignments.
Clear this option and then update the drawing view.

Shaded view quality
Specifies the quality of the view shading. Higher values look better, but
require more disk space, and may increase processing time. Lower values
require less disk space and make view generation faster, but may increase
the coarseness of the shading.

Show visible edges
Shows or hides visible edges in the drawing view. Whether visible edges
are displayed or not, you can still select edges in the view (for example, for
dimension placement or ballooning).

Display as gray scale
Adds or removes gray scale shading in the drawing view.
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Flat shading
Adds or removes color display without surface shading or styles in the
drawing view.

Textures
Shows or hides texture display in the drawing view. If the style used to draw
the part uses textures, enable this option to see them.

Reflections
Adds or removes reflection display in the drawing view. Reflection display
can make a big difference in the view’s appearance, particularly if the view
uses metallic colors.

Use model colors
Specifies that you want to allow model colors to be applied to drawing view edges
using either or both of the options below. Model colors applied to drawing views
are flat, not gradient. A drawing view that uses model color goes out of date
when the color is changed in the model.

Note

The Color Manager command, as well as the Part Painter command and
the Colors page of the Solid Edge Options dialog box, control base color
styles in the part model and assembly style override colors in the assembly
model. See Using Color Manager and Part Painter.

Apply part base colors to edge styles
If a base color has been defined in the model, specifies that it is applied to
the edge color in the drawing view. If no base color has been assigned, then
the default drawing view edge color is used.

Apply assembly override colors to edge styles
If assembly override colors have been defined in the model, specifies that
they are applied to the edge colors in the drawing view.

Apply edge style colors to section hatch styles
Applies the selected edge style color—base or assembly override—to the
hatching on previously created section drawing views.

Note

The resulting edge color of adjacent parts in an assembly is determined by
the relationship of one part to another. You can change an edge color in
the drawing view using the Edge Painter command.

Advanced tab (Drawing View Properties dialog box)

Specifies advanced display and processing options for the drawing view. The settings
on the Advanced tab of the Drawing View Properties dialog box take precedence over
their counterparts in the Advanced Edge Display Options dialog box.
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Drawing View
Let Solid Edge determine VHL tolerance (recommended)
Specifies whether Solid Edge determines the VHL tolerance for the drawing
view. Generally, letting Solid Edge determine the VHL tolerance provides
the best results. You should only clear this check box and set VHL tolerance
manually if you are having problems with drawing view quality. This option
is not available for detail views.

VHL Tolerance
Specifies the VHL tolerance when Let Solid Edge Determine VHL
Tolerance is unchecked. Five (5) is the highest value and provides the
most accurate display. If you have drawing view problems and want to
see if changing the VHL tolerance resolves them, increase the setting
one value at a time and use the lowest number that provides satisfactory
results. A higher VHL tolerance setting than necessary may degrade
drawing view update performance. This option is not available for detail
views.

Let Solid Edge determine thread axis tolerance (recommended)
Specifies whether Solid Edge determines the thread axis tolerance for
the drawing view. Generally, letting Solid Edge determine the thread
axis tolerance provides the best results. You should only clear this check
box and set thread axis tolerance manually if threads for holes that are
slightly off parallel or perpendicular to the view plane do not display in
the view. This option is not available for detail views.

Thread axis tolerance
Specifies the thread axis tolerance when Let Solid Edge Determine
Thread Axis Tolerance is unchecked. You can set thread axis
tolerance from 0 to 5 degrees, inclusive.

Let Solid Edge determine tangent tolerance (recommended)
Specifies whether Solid Edge determines the tangent tolerance for the
drawing view. Generally, letting Solid Edge determine the tangent tolerance
provides the best results. You should only clear this check box and set
tangent tolerance manually if edges that should display as tangent in the
drawing view instead display as visible or hidden. In such cases, a larger
tolerance often corrects the display. This option is not available for detail
views.

Tangent tolerance
Specifies the tangent tolerance when Let Solid Edge determine tangent
tolerance is unchecked. You can set tangent tolerance from 0 to 5
degrees, inclusive.

Limit edge creation
Only generate edges inside or overlapping cropped boundaries
Reduces VHL drawing view processing time by limiting edge creation for any
cropped views or independent detail views. When this check box is selected,
only edges completely inside or overlapping the view cropping boundary are
generated. When this check box is cleared, all edges inside, outside, and
overlapping the view cropping boundary are generated.
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Note

Geometry created with the Draw In View command is not affected
by this setting.

Show edges created by cutting plane line vertices
When you create a section view using a cutting plane that is defined by
multiple line segments, you can use this option to show or hide the resulting
edges in a drawing view.

When this option is cleared, edges created by cutting plane line vertices are
hidden when you update the drawing view. When this option is set, these
edges are visible. The default setting is cleared.

This option applies to 2D section and revolved section views. It does not
apply to 2D broken-out section views.

Note

Not all edge cases are handled by this processing rule. For those edges
that are not, you can use the Hide Edges command to hide them.

Simplify B-spline edges
Always
B-spline geometry from part edges is always converted to simple geometry.

Only edges outside of the plane of the drawing view
Only B-spline geometry from part edges non-parallel to the plane of the
drawing view are converted to simple geometry.

Never
B-spline geometry from part edges is never converted to simple geometry.

Part intersections
Processing part intersections can yield better drawing view results in cases such
as press fits, where parts slightly intersect. Changing this setting causes the
drawing view to become out-of-date.

Do not process intersections (fastest)
Specifies that part intersections are not processed. This is the fastest option.

Process intersections
Without creating face intersections (fast)
Creates part edges within the intersections of overlapping bodies. The
edges formed between intersecting faces of overlapping bodies are not
created.

Create face intersections of threaded parts (slow)
Creates face intersections of overlapping bodies for threaded parts on
which outer diameter and inner diameter threads overlap.

Create all face intersections (slowest)
Creates face intersections for all overlapping bodies. This is the slowest
option.
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Section View
Process partially hidden cut faces
Ensures hatching on partially hidden interior cut faces is visible only in
the area that should be visible given the section view direction. This can
eliminate the need to remove excess hatching using the Draw in View
function. This option is available for all types of section views, including
broken out sections. For complex section views, where this option may
slow drawing processing, you may want to clear this check box.

Hatch ribs in section view
Provides control over the hatching displayed on cut ribs in a section
view. You may want to uncheck this option when the cut line is along the
rib, and not across the rib.

• When checked, cut ribs are always hatched.

Note

When this option is checked, a list of ribs is not generated for
selective rib display using the Override Rib Hatching dialog
box, and the Override Rib Hatching command is not available.

• When unchecked, the body is hatched, but the ribs are not. This
results in a visible edge between the hatched primary body and the
unhatched rib.

You can use the Override Rib Hatching dialog box to selectively
choose which ribs you want to hatch and which ribs you do not.

To learn how to do this, see the Help topic, Set rib hatching in section
views.

The default for hatching on ribs in section views, revolved section views,
and broken out section views is set on the Drawing Standards tab (Solid
Edge Options dialog box).

Draft Quality View
View quality
Specifies the relative accuracy of the line strings that represent the part
edges in the draft quality view. The higher the view quality, the smaller
the facets on the line strings that represent the part edges are. View
quality ranges from 1, the fastest and least accurate setting, to 3, the
slowest and most accurate setting. To maximize performance, you should
use the lowest value that produces the results you want. The default of
2 is suitable for most applications. If you need higher quality, convert
the draft quality view to a high quality view.

Drawing View Properties dialog box

What can go wrong-drawing view properties

This topic gives you solutions to problems you may encounter with drawing view
properties.

The file cannot be found
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Could not read component geometry

Section could not cut the part

VHL calculation failed

Could Not Read Component Geometry

Check the associated model file for failed features.

Section Could Not Cut The Part

This message generally results from a non-manifold condition, in which three or
more surfaces of the input set share a common edge. Redefine the input set to
eliminate the non-manifold condition.

VHL Calculation Failed

The model contains invalid geometry.

The File Cannot Be Found

Check the location and name of the file and try again.

Tangent Tolerance and Thread Axis Tolerance

Generally, letting Solid Edge determine the tangent tolerance and thread axis
tolerance provides the best results. You should only clear these check boxes and set
these values manually if you are having display problems with tangency between
edges or threaded parts in your drawing view. To preserve overall view quality, you
should set these tolerances to the lowest values that resolve your display problems.

Queries

Find a part in a drawing view

1. Do one of the following:

• Right-click an element in the drawing view.

• Right-click the drawing view border.

2. On the shortcut menu, click Properties.

3. In the Drawing View Properties dialog box, click the Display tab.

4. In the Parts List, highlight the parts you want to query.

5. In the query list, select the query you want to use.

6. Click the Execute Query button.

The parts that match your query are highlighted in the Parts List.
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Create a new draft query

1. On the Library tab, click the Queries tab .

2. On the Queries tab, click the New Query button ..

3. In the Query dialog box, set the options you want to define the search criteria.

4. Click OK.

The new query is added to the Queries tab and to the query list in drawing
view properties.

Tip

• You can use the commands on the shortcut menu to edit, delete, and
rename a query entry on the Query tab.

• You can create, manipulate, and execute queries from the Display page of
the Drawing View Properties dialog box.

Use a query to hide objects in a drawing view

You can create a query to find a specific type of model object, and then hide all
instances of it in the drawing view. Using a query in this manner, you can quickly
simplify a drawing of a complex assembly model, without having to select and hide
the individual parts within each assembly.

1. On the Display tab of the Drawing View Properties dialog box, click the New

Query button .

2. In the Query name box, type a descriptive name for the query.

3. In the Query dialog box, under Query criteria, do all of the following:

a. From the Properties list, select the Component Type property.

b. From the Condition list, select Is (Exactly).

c. From the Value list, select the type of geometry you want to find.

For example, you can find solid body parts, generic assembly components,
and components created in structural frame, wiring harness, piping, and
tube models.

Example

In a complex tubing model, you can hide the tube component solid
bodies so that only the tube centerlines are displayed. Choose Tube
from the Value list, and choose Is (Exactly) from the Condition list.

d. Click Add to List.

4. Click OK to save the query.
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5. On the Display page of the Drawing View Properties dialog box, do all of the
following:

a. In the Parts list box, select the top level assembly.

b. Under Selected Part(s) Display, clear the Show check box.

c. Under Query Selected Items, click Execute Query.

6. Update the drawing view.

The selected component types are hidden in the drawing view.

Queries tab

The Queries tab is a member of the docking window tab set in Draft. It displays a
list of available queries, and allows you to create new queries.

New Query
Opens the Query dialog box.

Queries
Lists queries that have already been defined.

Query dialog box (Draft environment)

Finds parts and components in a drawing view using the search criteria you define.
After you find them, you can hide them (or only show those parts or components) in
the drawing view.

Query Name
Defines a name for the query.

Query Criteria
Specifies the query search criteria.

Property
Lists the properties you can search for.

Condition
Defines the conditional argument for the property being searched. For
example, you can define a query where the Condition option is set to
Contains, and the Property option is set to Material, and the Value is set to
Steel. All parts whose material property contains the word "Steel" would
be selected.

Value
Defines the value to search for in the specified property. You can type any text
you want to search for. You can search for multiple values in one operation
by separating the values with a semicolon (;). For example, you could search
for a material property of either steel or copper by typing: Steel; Copper.

Add To List
Adds the specified search criteria to the Find Items That Match These
Criteria list.
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Find items that match these criteria
Displays the criteria to be used in the search.

Match All
Matches all of the criteria listed.

Match Any
Matches any criterion listed.

Remove
Removes selected entries from the Find Items That Match These Criteria list.

Search subnodes Only
Restricts the query to leaf nodes. This can enable better results with some
queries (is not queries, for example).

2D drawing views and 2D model views

2D drawing views and 2D model views

2D drawing views

A 2D drawing view consists of two-dimensional elements. It is not associative to a
3D model. A 2D drawing view allows you to quickly create or modify a drawing view
without making changes to a part or assembly document.

To create a 2D drawing view of a part or assembly, you can convert a 3D part view or
you can draw the 2D graphics yourself. You also can import a 2D design file and then
create 2D views from it. You can layer 2D graphics on top of a 2D view.

Whenever you add or edit 2D graphical elements, a full range of drawing tools is
provided. These include drawing and relationship commands that make it easy for
you to draw an accurate 2D representation of a part or assembly.

Note

For more information about 2D drawing in Solid Edge, see the Drawing 2D
elements Help topic.
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2D model views

2D model views are scaled 2D drawing views placed on working sheets of geometry
that reside at full scale on the 2D Model sheet. You can create multiple 2D model
views that reference the 2D model geometry, and you can customize the cropping
boundary for each view created from the geometry on the 2D Model sheet.

Creating a 2D drawing view

There are several commands related to creating a 2D view from existing graphics:

• 2D Model View command—Creates a 2D view that references geometry on the
2D Model sheet. Use the Drawing Area Setup command, which is available only
for the 2D Model sheet, to set up a scaled work area in 2D model space.

• Convert to 2D View command—Converts a 3D part view to 2D geometry. Once
you convert a part view to a 2D view, associativity to the part or assembly
document cannot be retrieved.

• Draw In View command—Available for a 3D part, assembly, or sheet metal view
placed on a working drawing sheet, this command opens a 2D View Edit window
for you to draw in the view and to add annotations at a 1:1 scale.

• 2D View command—Superseded by the 2D Model View command, but still
available through customization.

2D drawing scales

When drawing inside a 2D view placed on a working sheet, you typically work at 1:1
scale. You also can draw directly on the working sheet. If you decide later that you
want to scale graphics you have drawn directly on the sheet, just move or copy them
into a drawing view with the Cut, Copy, and Paste commands.

The dimension and annotation sizes on the working sheet are independent of the
drawing view scale. For example, if you define the height and size of dimension text
as 0.125 inches or 3.5 millimeters, these are the actual values of the dimension text
on the printed drawing.
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Using the 2D Model sheet
You also can work on the 2D Model sheet in 2D Model space. The Drawing Area
Setup command defines a scaled work area where you can create, edit, and annotate
a 2D design at a scale appropriate to the size of the part or assembly, yet print at a
scale appropriate to the dimensions of your drawing sheet.

The Auto-Hide layer is available at all times when working on the 2D Model sheet.

2D Model view workflow
This workflow is used to create a 2D model view in a draft document.

First, use the 2D Model Sheet command to display the full-scale 2D Model sheet.
There is one 2D Model sheet per document.

Next, use the Drawing Area Setup command to define a work space on the 2D
Model sheet.

Next, place or create the design geometry on the 2D Model sheet, using any
combination of design file import, dragging an existing .dft file onto the sheet, and
2D line drawing tools.

On the working drawing sheet, use the 2D Model View command to create one or
more 2D model views that reference the 2D model geometry. You can customize the
clipping boundary for each view created from the geometry on the 2D Model sheet,
and assign a unique caption to each view.

Creating detail views from a 2D model view
You can use the Detail View command to create a dependent detail view from a
2D model view or a drawing view that has been converted to 2D geometry. You
can create a detail view that displays a circular envelope or a detail view with a
custom boundary.

Click here to learn more about Solid Edge detail views and the procedures for
creating them.

2D views and associativity
If you set the Maintain Relationships option in the Relate group on the ribbon, the
graphics you draw in a 2D view can be updated associatively, similar to the profiles
you draw in the Part environment. You can place driving dimensions and apply
relationships to control the size and location of the elements.
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Hiding construction graphics, dimensions, and annotations

When you want to hide elements in a drawing view but you do not want to assign
the hidden elements to individual layers, you can use the Auto-Hide layer. You can
hide construction geometry, dimensions, and certain annotations. For example, you
can place dimensions on the 2D Model sheet Auto-Hide layer to drive the size of the
geometry but not display when a drawing view is placed on the working sheet.

• The Auto-Hide layer is available while you are drawing and dimensioning on

the 2D Model sheet. You can use the 2D Model View command to create a
drawing view of the 2D Model sheet geometry, and all elements on the Auto-Hide
layer are hidden automatically.

• The Auto-Hide layer also is created automatically when you right-click a drawing
view and choose the Draw In View command. When you close a Draw In View
window, elements on the Auto-Hide layer are hidden automatically.

Completing the 2D view

When you finish drawing in a 2D view on the working sheet, click the Return button
on the command bar to close the 2D View Edit window. After you close the 2D view
window, you can add driven dimensions and annotations, such as weld symbols,
feature control frames, and so forth to the drawing sheet.

If you are working in 2D model space on the 2D Model sheet, you can add and edit
annotations and dimensions directly on the sheet. The graphics you add on the
2D Model sheet are visible in the 2D view on the working sheet when you click
the sheet tab.
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Editing 2D views

When you need to edit 3D model graphics in a 2D view, double-click the view. You
can also use the Draw in View command on the shortcut menu.

If the 2D view graphics were created from the 2D Model sheet as a block, or dragged
onto the sheet as a file, then you can use the Open command on the shortcut menu
to open the graphics for editing. Or you can use the Unblock command to drop the
block to its base elements for individual manipulation.

If you created the 2D view associatively, you can edit the driving dimensions to
modify the graphics. When you close the 2D view, the driven dimensions you placed
on the sheet will update.

2D View command

Creates a 2D view. When you click or click and drag to position the 2D view, this
command opens the 2D View Edit window so that you can draw 2D elements in
the view.

The functionality of the 2D View command has been replaced by the 2D Model
View command, which allows you to create and edit multiple 2D model views on a
single 2D Model sheet.

Create a 2D View

Step 1: Click the 2D View button.

Step 2: Click to place the 2D view at default size, or click and drag to place the
2D view.

Step 3: On the 2D View Edit window, use the commands provided to draw your
2D view.

Step 4: On the command bar, click Return.

Tip

• Any elements you place on the Auto-Hide layer are automatically hidden
when you close the 2D view window.
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Edit a 2D View

Step 1: Double-click the 2D view.

Step 2: On the 2D View Edit window, use the commands provided to edit the
2D view.

Step 3: On the command bar, click Return.

Tip

Any elements you place on the Auto-Hide layer are automatically hidden
when you close the 2D view window.

Create a 2D model view

To create a 2D Model view, geometry must be present on the 2D Model sheet in
the draft document.

1. (Display the 2D Model sheet) From the ribbon, choose View tab®Sheet Views
group®2D Model, and then click the document sheet tab labeled 2D Model.

2. (Define your 2D Model work space) From the Application menu, choose the
Drawing Area Setup command, and then specify your final printed drawing size,
overall design dimension, and scale in the Drawing Area dialog box.

3. On the 2D Model sheet, place the 2D geometry from which you want to create
the 2D Model view.

Example

You can drag a draft file or import a .dwg or .dxf design file. You can add
annotations and dimensions to the geometry, and you can use the line
drawing tools to add geometry to the design before you create the 2D
model view.

4. (To create 2D views of your design) Click the working sheet tab in your draft

document, then choose Sketching tab®Drawing Views group®2D Model .

Note

In 2D Drafting, the 2D Model command is located on the Tables tab.

5. On the 2D Model sheet, click to define the first point of a cropping boundary
for the 2D view. Move the mouse and click again to define a second point on a
diagonal from the first.

The 2D Model sheet is closed automatically, and the working drawing sheet
you started from is re-displayed. You can set options on the 2D Model View
command bar before placing the view.

6. On the 2D Model View command bar, set the style and caption options as desired
for the new view.

7. Click the Properties button on the command bar to define additional view
properties in the 2D Model View Properties dialog box.
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Refer to the General tab (Drawing View Properties dialog box) for more
information about these options.

8. On the working sheet, click to place the 2D Model view.

Tip

• You also can edit 2D Model View properties after you place the view.
Select the view border, and then click Properties on its shortcut menu.

2D Model View command

Creates a 2D model view of the 2D model geometry on the 2D Model sheet. You can
create multiple 2D model views at a 1:1 scale, and you can customize the clipping
boundary for each view. After you place the views on the working sheet, you can add
annotations and complete the drawing.

2D Model sheet scale

You also can use the Drawing Area Setup command to define a work space on the
2D Model sheet where you can draw and annotate at a 1:1 scale. This makes the
text legible on the 2D geometry and prints at the proper height for your paper size.
It also gives you the flexibility to annotate on the 2D Model sheet or in the scaled
2D model views on the working sheet.

2D Model View command bar

After you select the 2D Model View command and specify the geometry cropping
boundary, this command bar is displayed for you to set view options before you
click to place it on the drawing sheet.

Cancel
Returns you to the drawing sheet and cancels the 2D Model View function.

Drawing View Style Mapping
Specifies that the drawing view uses a predefined style. The style is set by
mapping the 2D Model Views element to a style on the Drawing View Style tab
of the Solid Edge Options dialog box. The style format is defined in the Drawing
View Style dialog box.

When the Drawing View Style Mapping button is cleared, you can select and
apply individual styles. Choose the style from the Drawing View Style list.

Drawing View Style
Selects a style for the 2D Model view. This option is not available when Drawing
View Style Mapping is enabled.

Properties
Opens the Drawing View Properties dialog box for you to set options for the 2D
model view.
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Scale
Specifies the drawing scale as a standard ratio. The specified ratio defines
the size of the drawing in relation to the size of the real-world object. For a
2:1 ratio, the "2" represents the size of the drawing and the "1" represents the
size of the real-world object.

Using hyperlinks

Using hyperlinks

Working with hyperlinks

You can use a hyperlink to link an object or element on a drawing sheet to a file or
URL. You can add a hyperlink to any Draft object or element that supports user
properties. Drawing views, 2D line geometry, blocks, drawing views, dimensions, and
some annotations are examples of some of the items that support hyperlinks.

You can use hyperlinks to:

• Link to a company Website to obtain material information or vendor
specifications.

• Link to a local file that contains detailed information about some aspect of
the drawing, such as weld specifications, assembly procedures, finite element
analysis calculations or design criteria.

• Link to an image file, such as a logo, an installation illustration, or a photograph
of a reference part.

• Link to a database for Material Requirements Planning (MRP) or Engineering
Change Notices (ECNs) to get information for the drawing title block.

• Link to another Solid Edge document.

When you click an object hyperlinked to a file, the target file opens in the default
viewer assigned to that file-type. When you click an object hyperlinked to a URL, the
web page associated with the URL is opened in a default browser.

Enabling hyperlink mode

To get started, you must enable hyperlinks. Selecting the Insert®HyperLink
command lets you:

• Add, edit, and remove hyperlinks between objects on the drawing sheet and
external files or URLs.

• Select, open, and display the targets of previously created hyperlinks on the
drawing.

Hyperlink pointers

In hyperlink mode, you see two different kinds of pointers when the mouse moves
across objects and elements on the drawing sheet.
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When this pointer is displayed, it means a link has not been assigned to the object or
element. You can click to select it and add a hyperlink:

When this pointer is displayed, it means there is an existing hyperlink defined for
the object or element:

In this case, you can click to follow the link, or you can right-click to edit, remove, or
view the hyperlink target name associated with the object or element.

Adding and editing hyperlinks

In hyperlink mode, you can add, edit, and remove hyperlinks from 2D objects and
elements. Items that are not highlighted are not hyperlinked.

• To add a link, click an object, or right-click the item and select the Add/Edit Link
command from its shortcut menu. The Hyperlink dialog box is displayed for you
to type a source URL or a target file path name. You also can use the Browse
button to locate the file through your computer file system.

• To edit a link, right-click the object and select the Add/Edit Link command from
its shortcut menu.

• To remove a link, right-click the object and select the Remove Link command.

Opening hyperlinks on a drawing sheet

When you select the HyperLink command, all objects with previously defined
hyperlinks are highlighted at once on the drawing sheet. This identifies the
items that have attached files, such as specification documents and installation
instructions, or referenced web pages.

• When you click an object hyperlinked to a file, the target file opens in the default
viewer assigned to that file-type.

• When you lclick an object hyperlinked to a URL, the web page associated with
the URL is opened in a default browser.

• To display the target name without opening it, right-click the hyperlinked object
or element and look at the text displayed to the right of the Open command.

Add, edit, and view hyperlinks

You can add, edit, and remove hyperlinks on 2D objects and elements, and you can
open and follow existing hyperlinks on a drawing while you are in hyperlink mode.
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Add a hyperlink

1. Choose the Sketching tab®Insert group® HyperLink command .

2. On the drawing sheet, click the object or element on which you want to place
a hyperlink.

3. In the HyperLink dialog box, type the URL or file path name in the Enter Link
Source field, or click Browse to locate the file.

• URL example: www.solidedge.com

• File example: C:\Temp\flat.psm

• Document example: C:\Temp\spec.txt or C:\Temp\spec.doc

• Email example: mailto:John.Doe@ugs.com

4. Click OK to set the hyperlink.

Edit a hyperlink
1. Choose Sketching tab®Insert group® HyperLink.

2. Right-click the hyperlinked object.

3. On the shortcut menu, click Add/Edit Link.

4. In the HyperLink dialog box, retype the source URL or file name in the Enter
Link Source field, or click Browse to locate the file.

5. Click OK to update the hyperlink.

Remove a hyperlink
1. Choose Sketching tab®Insert group® HyperLink.

2. Right-click the hyperlinked object.

3. On the shortcut menu, click Remove Link.

Open and follow a hyperlink
1. Choose Sketching tab®Insert group® HyperLink.

2. Right-click the hyperlinked object. The hyperlink target displays on the Open:
<filename/URL> context menu.

3. To open the file or go to the Web site, click Open.

Tip

You also can click an existing hyperlink to open it directly.

HyperLink command
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Enables hyperlink functions.

Selecting this command initiates hyperlink mode, so you can:

• Add, edit, and remove hyperlinks between objects on the drawing sheet and
external files or URLs.

• Select, open, and display the targets of previously created hyperlinks on the
drawing.

HyperLink Dialog Box

HyperLink Dialog Box

The HyperLink dialog box is displayed when you add and edit hyperlinks on drawing
objects and elements.

Enter Link Source
Specifies the file or URL to which you are hyperlinking the selected object.

You can link to any type of file for which you have a default viewer or editor
installed on your computer and for which the file type is defined. For example,
to open a text file (.txt), you need an application such as Notepad or Wordpad.
Examples of other file types you can specify include .doc, .xls, .jpeg, and .bmp.

You can link to an Internet or intranet site if you have a browser installed on
your computer.

Browse
Displays the Open File dialog box for you to locate a source file by browsing.

Open (Link) Command

Opens a hyperlink to a file or URL on the selected object. The name of the file or the
URL that the link will open is displayed on the shortcut menu.

Add/Edit Link Command

Creates or edits a hyperlink to a file or URL on the selected object.

HyperLink Dialog Box

Remove Link Command

Removes a hyperlink to a file or URL from the selected object.

Inserting images

Insert an image on a drawing
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Inserts an image or picture in the center of the document.

1. Choose the Insert Image command .

The Insert Image dialog box is displayed.

2. On the General tab of the Insert Image dialog box, specify an image file and
insertion method.

3. (Optional) On the Border tab (Insert Image dialog box), set image border options.

4. Click OK to close the Insert Image dialog box and insert the image.

5. (Optional) The image is still selected. You can use the options on the Insert Image
command bar to change the image’s height, width, angle, horizontal/vertical
display, and aspect ratio as needed.

6. Click in free space to exit the command.

Tip

• To move the image from its default location, use the Move command.

• Click the Image Properties button on the command bar to change the
image border line properties after it is inserted.

• You also can use the shortcut menu of an image to control its horizontal or
vertical display, its aspect ratio, and display/hide the image border.

Insert an image on a model

You can insert an image, such as a logo or picture, on a model face or anywhere else
in the document.

1. Choose the Insert Image command on the Sketching tab, in the Insert group.

2. In 3D environments, highlight and lock a sketch plane.

To learn how, see the Help topic, Lock or unlock a sketch plane.

3. On the General page of the Insert Image dialog box, specify an image file and
insertion method.

4. (Optional) On the Border page of the Insert Image dialog box, set image border
options.
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5. Click OK to close the Insert Image dialog box.

6. Click where you want to place the image.

Tip

After you place the image, you can:

• Change the image height, width, angle, horizontal/vertical display, and
aspect ratio using the options on the Insert Image command bar.

• Select the image, and then move or rotate it. Choose Move (or Rotate)
from the Move split-button on the Sketching tab, Draw group.

Insert Image command

Inserts an image into a document. You can insert these types of files:

• Windows bitmap image file (.bmp)

• JPEG image file (.jpg)

• TIFF image file (.tif)

Note

JPEG image files must be in RGB format. CMYK format is not supported.

You can either link or embed the image, and you can control its display, including
height, width, and aspect ratio.

In draft documents, another way to insert an image into documents is to drag it from
your desktop or copy and paste it from an external application, such as Microsoft
Paint. Pictures inserted in this manner are created as image objects rather than as
symbols.

Inserted images can contribute to your modeling workflow in several ways. For
example, you can sketch geometry over an image to create features based on it. Or
you can use an image as a label or decal on a plane or planar face in the model.

Insert Image command bar

Width
Sets the width of the image.

Height
Sets the height of the image.

Angle
Sets the orientation angle of the image. Zero degrees is horizontal to the x axis.
The angle increases in the counterclockwise direction.

Image Properties
Displays the Image Properties dialog box for you to change image border and
other properties.
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Flip Horizontal
Flips the image horizontally, such that the left side of the image is displayed
on the right and vice versa.

Flip Vertical
Flips the image vertically, such that the top of the image is displayed on the
bottom and vice versa.

Lock Aspect Ratio
Locks the aspect ratio of the image so that when you manipulate its dimensions,
it scales proportionally.

Reset Aspect Ratio
Resets the aspect ratio to the image’s original proportions.

Toggle Border Display
Displays/hides the image border.

Insert Image dialog box

The Insert Image dialog box is displayed when you insert an image into a document.
This dialog box changes name to Image Properties when you click an existing image
or picture in the document.

Tabs

Border page (Insert Image dialog box)

Image border properties can be set when inserting an image or picture into the
document using the Insert Image command, and they can be edited after the image
is placed.

Show Border
Displays/hides the image border. Even if the border is hidden, it can be located
by moving the cursor over the edge of the image.

Style
Sets the border line style when inserting images in draft documents. This list is
not available when inserting images into parts created in the 3D environment.

Color
Specifies the line color of the image border.

Width
Specifies the line thickness of the image border.

Type
Specifies the line type of the image border.

General page (Insert Image dialog box)

When inserting an image or picture into the document, the General page on the
Insert Image dialog box specifies the image to be inserted and whether it will be
linked to or embedded in the document.
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When editing the properties of an inserted image or picture, the only options on the
General page that can be changed are Transparent Color and Image Opacity.

File Name
Specifies the name of the image file.

Browse
Accesses a Browse dialog box that allows you to search for image files.

Link to File
Creates an associative link to the file the image is created from. If you want to
embed the image file, clear this check box.

Transparent Color Specifies a single transparent color for the image.

To apply transparency, set the Use Transparent Color check
box, click the Pick Color button, and then click a color in the
image thumbnail to specify a transparent color.

To remove transparency, clear the Use Transparent Color
check box.

Image Opacity Specifies the opacity for the image. At 0%, the image is
entirely transparent; at 100%, entirely opaque. The Image
Opacity option is not available in the Draft environment.

Drawing Creation activities

Activity: Drawing view placement

Drawing view placement

This activity covers the typical workflow for placing drawing views of a Solid Edge
part. All drawings are different, but the basic approach to view creation, layout,
manipulation, and editing is the same in all Solid Edge environments. In fact, the
steps for placing assembly views are the same steps used for creating part views
on a drawing sheet. This activity provides you with a basic understanding of the
workflow used to create drawing sheets quickly and effectively.
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After completing this activity, you will be able to:

• Place multiple views of a part on a drawing sheet.

• Manipulate the views.

• Shade a drawing view.

• Modify drawing view properties.

• Create principal drawing views.

• Create Auxiliary views.

• Create Section views.

• Create Detail views.

Create a draft document

Create a new ISO draft document.

▸ Choose the Application button®New®ISO Draft.

Setup the background and sheet size for the drawing sheet

▸ Position the cursor over the Sheet1 tab (lower left corner) and right-click. On
the shortcut menu, click Sheet Setup.

▸ On the Sheet Setup dialog box, click the Background page. Set the background
sheet to A1-Sheet. This sets the background and sheet size for the drafting
sheet. Check the Show background button.
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▸ Click Save Defaults to save A1-Sheet as the default border/background for this
document. By saving defaults now, any new sheets created in this file will
automatically default to A1-Sheet.

▸ Click OK.

▸ Choose the Fit command to display the entire drawing sheet in the active window.

Select the drawing standards for the drawing sheet

▸ Click the Application button.

▸ Click the Solid Edge Options button.

▸ Click Drawing Standards. On the Drawing Standards page, set the Projection
Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.

Select views in the Drawing View Creation Wizard

▸ On the Home tab®Drawing Views group, choose the View Wizard command

.
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▸ On the Select Model dialog box, select bearblk.par and click Open.

▸ In the Drawing View Creation Wizard, set the options as shown, and then click
Next.

▸ Select front as the named view for the drawing view orientation. Click Next.
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▸ In the Drawing View Layout dialog box, click the Right and Top view buttons as
shown, and click Finish.

Place the views selected on to the drawing sheet

▸ The drawing scale displays in the command bar. Make sure it is set to 1:1. Solid
Edge automatically assigns the scale, which makes the views as large as possible
and still fit on the drawing sheet.
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▸ A rectangle is attached to the cursor. Move the rectangle to the approximate
center of the sheet, and click.
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Place an additional part view on the drawing sheet

▸ Choose the View Wizard command .

▸ On the Select Attachment dialog box, select bearblk.par, and click OK. This
enables the placement of another part view.
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▸ Proceed through the Drawing View Creation Wizard as before, and when
prompted for Named Views, click iso, then click Finish.
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▸ In the command bar, set the view scale to 1:1. Then move the cursor, and click to
place the view in the upper right corner of the sheet, as shown.

Save the drawing file

▸ On the Quick Access toolbar, click Save, and in the Save As dialog box, save
the file as bearblk.dft.
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Place an auxiliary view on the drawing sheet

▸ On the Home tab®Drawing Views group, choose the Auxiliary command .
Notice that a fold line attaches to the cursor. If IntelliSketch locates a point, the
line disappears. Move the cursor until IntelliSketch ceases to locate a point
and the line displays.

▸ Move the cursor across the front drawing view until the fold line attaches to the
model edge as shown, then click to select this edge as the folding line.

▸ Position the view as shown and click. This view may overlap other views because
of limited space on the drawing sheet. Move the view in the next step.

Create a new drawing sheet and move the auxiliary view to the new sheet

▸ Position the cursor over the Sheet1 tab in the lower left corner of the screen, and
right-click to display the shortcut menu.

▸ On the shortcut menu, click Insert to create a new drawing sheet. This adds
a new sheet (Sheet2) to the draft document, and Sheet2 displays. To switch
between sheets, click on the tab of the sheet you want to switch to. The sheet
tabs are found at the lower left corner of the window.

▸ Click the Sheet1 tab. This returns the view to the first drawing sheet in the
draft document.
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▸ Click the Select tool command, and position the cursor over the auxiliary view
so that the view highlights and then right-click. On the shortcut menu, click
Properties.

▸ In the High Quality View Properties dialog box, on the General page, change
the sheet from Sheet1 to Sheet2, and click OK. This moves the auxiliary view to
Sheet2.

▸ Click the Sheet2 tab to make Sheet2 the active sheet.

▸ Drag the auxiliary view towards the upper left corner, as shown.

Create a cutting plane for a section view

Place a cutting plane in the top view. This cutting plane will be used to create a
section view.

▸ Click the Sheet1 tab to make it the active sheet.

▸ Choose the Cutting Plane command .

▸ Select the Top view as the drawing view where the cutting plane will be drawn.
The window changes to the Cutting Plane Line mode.

▸ Click the Zoom Area button, and define a zoom area around the Top view.

▸ Choose the Line command to draw a profile line for the cutting plane .
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▸ Draw the sequence of lines shown in the following figure. Lock into the midpoint
of the left vertical edge and the center point for the upper right hole. Use
IntelliSketch relationships to locate the keypoints. If the keypoints do not
highlight, make sure theMid and Center options are checked in the IntelliSketch
group. Move the cursor over the elements (without selecting them) to activate
them for keypoint location. A dashed line appears when you are in line,
horizontally or vertically, with the midpoint or center point of the circle.

▸ On the Home tab®Close group, choose the Close Cutting Plane command

.

▸ To complete the direction step, position the cursor below the drawing view, and
click to position the cutting plane arrows as shown.

Create a section view

Create a section view using the cutting plane defined in the previous step.

▸ Fit the view.

▸ In the Drawing Views group, choose the Section command .

▸ Select the cutting plane line created on the top view as cutting plane from which
the section view will be created.

▸ On the Section view command bar, click the Model Display Settings option .

▸ In the dialog box, clear the Hidden edge style option box. Click OK on the
message box and then click OK on the Drawing Properties dialog box. This turns
off hidden edges in the cross section view.
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▸ Place the cross section below the top view as shown.

▸ Use the Properties dialog box to move the section view to Sheet2.

▸ Click the Sheet2 tab to view the second sheet. Reposition the section view, below
the auxiliary view.

Change the cross-hatch properties of the section view

▸ To change the cross-hatch properties, select the view, then right-click to display
the shortcut menu. Click Properties from the shortcut menu.

▸ In the High Quality View Properties dialog box, click the Display page.

▸ Under the Show fill style box, uncheck the Derive from part box. On the Show
fill style list, select ANSI32(Steel) and then click OK on the message box and
then click OK on the dialog box.

▸ Save the document.

Place a detail view off of the front view

▸ Return to Sheet1.

▸ Choose the Detail command .
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▸ Click to place the center of the detail view circle on the front view, and then
click again to define the radius of the detail view circle. The view circle should
resemble the one shown in the following illustration.

▸ Move the large circle attached to the cursor away from the front view. Click to
place the detail view as shown below.

▸ Move the detail view to Sheet2 by changing the view properties.

▸ Switch to Sheet2.

▸ On Sheet2, position the detail view to the right of the auxiliary and section
views as shown.
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Change the display of a drawing view to shaded

▸ Return to Sheet1.

▸ Click on the iso drawing view.

▸ On the Select command bar, notice the shading options list for the display of the

selected drawing view. Choose the Grayscale with Visible Edges command .

▸ Click in an open area of the drawing sheet to deselect the iso drawing view.
Notice the out-of-date border around the iso drawing view.

▸ In the drawing Views group, choose the Update Views command .
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▸ The iso drawing view now displays as shaded.

▸ This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to place drawing views, auxiliary views, section
views and detail views. You also learned how to use drawing sheets to organize
the drawing views.

Activity: Assembly drawing creation

Assembly drawing creation

This activity demonstrates the method for creating a drawing of an exploded
assembly view.
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After completing this activity, you will be able to:

• Place drawing views of an assembly.

• Create a drawing view that uses an exploded view assembly display
configuration.

Create a new draft document

Create a new ISO draft document.

▸ Choose the Application button®New®ISO Draft.

Define views to place on the drawing sheet

Use the drawing view wizard to define the type of view to place on the drawing sheet.

▸ Choose the View Wizard command.

▸ Set the Files of type: field to Assembly Document (*.asm).

▸ On the Select Model dialog box, select carrier.asm located in the training folder
and click Open.

▸ On the Drawing View Creation Wizard, select exploded view from the list of .cfg,
PMI model view, or Zone and then click Finish.

▸ Use background sheet A1-sheet and a view scale of 1:1.

Place an exploded assembly view

▸ Place the drawing view in the center of the drawing sheet.
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▸ Click Save and save the file as mycarrier.dft in the training folder.

Place a front view on a new sheet

▸ On the Sheet tab, right-click and then click Insert to insert Sheet2.

▸ Choose the View Wizard command. The dialog box is different than the first
time you executed the command because at this point you have placed a view
of the assembly.

▸ On the Select Attachment dialog box, click OK. On the Drawing View Creation
Wizard, make sure that no configuration is selected and click Next.

▸ On the Drawing View Orientation dialog box, click the Custom option.

▸ While in the Custom Orientation window, press the Home key to display the
Isometric view.

▸ Click the Shaded with VHL Overlay button.

▸ Click the Common Views button.
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▸ Click Show face view as shown.

▸ Click Rotate 90° clockwise as shown.

▸ Close the Common Views dialog box by clicking the X in the upper right corner.

▸ The image below shows the resulting view.

▸ Click Close in the Custom Orientation window, and then on the Drawing View
Layout page, click Finish.

▸ Change the scale to 1:1.
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▸ Place the view in the upper left region of the drawing sheet.

Draw a cutting plane for a section view

Draw a cutting plane on the front view that will be used to create a section view.

▸ Choose the Cutting Plane command .

▸ Click the drawing view just placed and construct a cutting line through the
center of the view. The cutting plane will look similar to the illustration below.

▸ Choose the Close Cutting Plane command .
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▸ Move the cursor and click on the upper side of the cutting plane to define the
cutting direction.

Create a section view

Create a section view using the cutting plane defined in the previous step.

▸ Choose the Section command.

▸ Click the cutting line just constructed.

▸ Click the Model Display Settings option .

▸ On the Drawing View Properties dialog box, expand the parts list for the
assembly by clicking the + symbol next to carrier.asm. This shows all of the
parts in the assembly. If the assembly contained subassemblies, these would
also display.

▸ Click the Part named mtgpin.par:1, and then uncheck the Show box. This
excludes the part from the sectioning process.
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▸ Click OK and finish placing the section view below the top view. Your drawing
sheet should look similar to the following illustration. Notice that the mounting
pin (mtgpin.par) is hidden in the section view.

Hide a part in the drawing view

Hide another part in the drawing view. Once this is done, an out-of-date border
will appear.

▸ Click the Select Tool and select the new section view. Right-click on it, and click
Properties on the shortcut menu. On the High Quality View Properties dialog
box, on the Display page, repeat the previous steps to hide splate.par:1 and click
OK. The section view should now display an out-of-date border.
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▸ Click the Update Views command . The part file named splate.par:1 is now
hidden in the section view of the assembly and the out-of-date border is no
longer displays.

Adjust the parts display

Adjust the displayed parts again. This demonstrates how to turn on and off the
display of parts in the drawing view.

▸ Click the Select Tool and select the section view again. Right-click on the section
view, and click Properties on the shortcut menu. Click the Display page, expand
the parts list for carrier.asm, show all parts except mtgpin.par, and click OK.

▸ Choose Update Views to update the section view. Splate.par:1 now displays in
the section view.

▸ This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to creating a drawing of an exploded assembly view.
You also learned how to control the display of assembly parts on the drawing.

Activity: Quicksheet

Quicksheet

A quicksheet is a draft document that contains drawing views that are not linked to
a model. When you drag and drop a model file from the Library tab of PathFinder or
Windows Explorer onto a quicksheet template, the views populate with the model.
Quicksheet templates can only be created using the Create Quicksheet Template
command.
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This activity shows the process for using a quicksheet.

After the activity, you will be able to:

• Create a quicksheet template.

• Populate a quicksheet template.

• Place a user-defined quicksheet in the Quicksheet template folder.

Create a new draft document

Create a new ISO draft document.

▸ Choose the Application button®New®ISO Draft.

Set the drawing standards

▸ Click the Application button.

▸ Click the Solid Edge Options button.

▸ Click Drawing Standards. On the Drawing Standards page, set the Projection
Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.
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Define the drawing views

Use the Drawing View Wizard to place a drawing view on the new sheet.

▸ Click the View Wizard command.

▸ On the Select Model dialog box, make sure the Look in: field is set to the class
working folder, and set the Files of Type option to Part Document (*.par).

▸ Select dr_plate.par and click Open.

▸ Place the five views shown on the drawing sheet at a scale of 2:1. Use front
drawing view option. Move the views so they fit on the sheet.

Arrange the views on the sheet

▸ Arrange the views as shown and edit the view properties.
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View (A) – Hidden edge style turned off.

View (B) – Scale = 5:1, Shaded with Visible Edges.

Note

This drawing view configuration will be used as a quicksheet template.

Create a quicksheet template

▸ Click the Application button and then choose the Create Quicksheet Template
command.

Note

Command empties all drawing views and parts lists, then converts the file
into a Quicksheet Template.

▸ Click Yes in the Create Quicksheet Template warning box

▸ In the Save As dialog box, save the template as quicksheet_a.dft in the training
folder.
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Populate a quicksheet template

The template quicksheet_a.dft is still open. You will populate this template.

▸ In PathFinder (Library tab), drag dr_plate2.par into the template.

▸ The results are shown.

Note

Notice in the results that a view overlaps the title block. The views will
need to be adjusted to fix this.

▸ Save the file as dr_plate2.dft and then make the necessary adjustments.

▸ Close the file.
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Place the new quicksheet template in the Solid Edge templates folder

Note

If you decide to use the template in a common workflow for similar type
parts, it is recommended that it be added to the Solid Edge template folder
for easy access.

▸ Copy quicksheet_a.dft to the Solid Edge ST5/Template/Quicksheet folder.

Create a new draft file using the quicksheet template

Create a new ISO draft file using the quicksheet template just added to the Solid
Edge ST5 templates folder.

▸ Click the Application button.

▸ Click New.

▸ In the New dialog box, click the Quicksheet page. Select quicksheet_a.dft and
then click OK.

▸ Close all files. This concludes the quicksheet activity.

Activity summary

In this activity you learned how to create and populate a quicksheet template. This
tool is provided to help streamline the drawing production workflow. When you know
the views needed and view property settings for similar type parts, quicksheets can
reduce repetitive steps required for each drawing created.
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Activity: Broken view creation

Broken view creation

This activity covers the use of the Broken View command.

After completing this activity, you will be able to: create a broken drawing view of
a part on a draft sheet in Solid Edge.

Create a new draft document

Create a new ISO draft document.

▸ Choose the Application button®New®ISO Draft.

Define the drawing view

▸ Click the View Wizard command.

▸ On the Select Model dialog box, make sure the Look in: field is set to the training
folder, and set the Files of type: field to Part Document (*.par).

▸ Select dualbar.par and click Open.
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▸ In the Drawing View Creation Wizard, ensure the Part and Sheet Metal Drawing
View default options are set as shown, then click Next.

▸ In the named Views: field, click top. Click Finish.

▸ Change the scale to 2:1 and place the drawing view on the draft sheet as shown.
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Add a vertical broken region to the drawing view

▸ Click the Select tool, and then right-click on the drawing view. Choose the Add
Break Lines command on the short-cut menu.

▸ On the command bar, set the options as shown.

▸ Place two vertical lines representing the region to be broken as shown.

▸ On the command bar, click Finish to create the broken view.
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▸ The result is shown.

▸ On the command bar, click the Show Broken View button to switch the
view display back to unbroken.

Place a horizontal break in the drawing view

▸ Use the Horizontal Break Line option to add another set of break lines to
the view.
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▸ Close the file and save as breakline.dft.

Place a broken view with different break line types

▸ Create a new ISO draft file and using the View Wizard command, open and
place the front view of bar.par.

▸ Place four sets of break lines on the bar. Each set will be a different type.

Straight

Cylindrical

Short Break — Linear

Long Break

▸ This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to create broken views using horizontal and vertical
breaks. You also learned how to use different break line types.
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Activity: Broken-out section creation

Broken-out section creation

This activity demonstrates the use of the Broken-Out Section command.

After completing this activity, you will be able to create a broken section of a part
on a draft sheet in Solid Edge.

Create a new draft document

Create a new ISO draft document.

▸ Choose the Application button®New®ISO Draft.

Set the drawing standards

▸ Click the Application button.

▸ Click the Solid Edge Options button.

▸ Click Drawing Standards. On the Drawing Standards page, set the Projection
Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.

Define the drawing view

Use the View Wizard command to place a drawing view on the new sheet.

▸ Choose the View Wizard command.

▸ On the Select Model dialog box, make sure the Look in: field is set to the training
folder, and set the Files of Type option to Part Document (*.par).

▸ Select crankcase.par and click Open.

▸ Place a top, front, right and iso view on the drawing sheet at a scale of 2:1, and
then move the views so they fit on the sheet.
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Define the broken-out section view

The section view will be displayed in the isometric view. Draw the profile defining
the broken-out section in the front view.

▸ Choose the Broken-Out Section View Command .

▸ Select the front view. Beginning from the center of the circle, draw the profile
shown.
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▸ Choose the Close Broken Out Section command .

▸ In the top view, define the extent of the section as shown.

▸ Select the iso drawing view to apply the broken-out section to.
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Edit the broken-out section

▸ Right-click the iso view and click Properties.

▸ In the High Quality View Properties dialog box, click the General page and check
Show Broken-Out Section view profiles and then click OK.

▸ The profile for the broken-out section for the iso drawing view is shown in the
front drawing view.

▸ To edit the profile, click the rectangular profile in the front view.

▸ Click Modify Depth on the command bar.

▸ Type 80 mm for the Depth and press the Enter key. Click Accept.

▸ The iso view is now out of date, signified by the box around the view.

▸ Click the Update View command to refresh the iso drawing view.
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▸ The broken-out section will appear as shown.

Note

To remove a broken out section, delete the profile used to define the
broken out region.

▸ This completes the activity. Save the file as broken section.dft.

Activity summary

In this activity you learned how to create a broken-out section view. You also
learned how to modify the broken-out section profile to create a different broken
view representation.
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Lesson review

Answer the following questions:

1. Name the ways to create a draft document.

2. Describe the main steps required for creating a drawing.

3. After you create one or more primary part views, name the additional views you
can create from them.

4. What does it mean when a grey border is around a drawing view?

5. What is a quicksheet?
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Summary

You can create drawings of parts and assemblies. Use the Drawing View Wizard to
place the primary views on the sheet. You can rearrange views, shade views, change
view scale, crop views, place dimensions and annotations on a view, and much more.
Refer to Solid Edge Help if you feel you need additional information.

Dimensions, Annotations, and PMI

Dimensions, Annotations, and PMI

An essential part of the design process is adding dimensions and annotations as
Product Manufacturing Information (PMI) to your drawings and model documents.

• You can add dimensions and annotations to a drawing in the Draft environment,
and to a sketch in a model document.

• You can add PMI to 3D models in the Part, Sheet Metal, and Assembly
environments.

Dimensioning overview

You can add dimensions to the 3D PMI model or 2D design geometry by measuring
characteristics such as size, location, and orientation of elements. You can measure
the length of a line, the distance between points, or the angle of a line relative to
a horizontal or vertical orientation. Dimensions are associative to the 3D model
or 2D elements to which they refer, so you can make design changes easily. Solid
Edge provides a full complement of dimensioning tools so you can document your
parts, assemblies, and drawings.

To learn about placing dimensions on the 3D model, see PMI dimensions and
annotations.

In the Draft environment, you can add dimensions using the commands in the
Dimension group on the Home tab or the Sketching tab. You also can create
dimensions by retrieving them from part, sheet metal, and assembly models with
the Retrieve Dimensions command.
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You can use the dimensioning commands to place the following types of dimensions:

(A) Linear dimensions

(B) Angular dimensions

(C) Diameter dimensions

(D) Radial dimensions

(E) Dimension groups

These dimension commands are available:

• Smart Dimension command

• Distance Between command

• Angle Between command

• Coordinate Dimension command

• Angular Coordinate Dimension command

• Symmetric Diameter command

• Chamfer Dimension command

Each dimension command has a command bar that sets options for placing the
dimension. When you select an existing dimension, the same command bar is
displayed so you can edit the dimension characteristics.
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Using dimensions to control elements

You can place a dimension that controls the size or location of the element that it
refers to. This type of dimension is known as a locked dimension. If you change
the dimensional value of a locked dimension, the element updates to match the
new value.

The value of an unlocked dimension is controlled by the element it refers to, or
by a formula or variable you define. If the element, formula, or variable changes,
the dimensional value updates.

Because both locked and unlocked dimensions are associative to the element they
refer to, you can change the design more easily without having to delete and reapply
elements or dimensions when you update the design.

Locking and unlocking dimensions

In general, you can set or clear the lock option on the Dimension command bar or
on the Dimension Value Edit dialog box to specify whether a dimension is a locked
dimension or an unlocked dimension.

Note

If the Lock button is not available, set the Maintain Relationships option in
the Relate group on the Home tab or the Sketching tab.

In the Draft environment, dimensions can be placed as either locked or unlocked,
depending upon the setting of the Maintain Relationships command. If Maintain
Relationships is set, the dimensions are locked by default. These exceptions apply:

• Dimensions placed on part views are always unlocked.

• Dimensions placed between a 2D view and an element on the drawing sheet
can only be unlocked.
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Dimension color

Locked and unlocked dimensions are distinguished by color. The default colors are
different in the synchronous modeling environments than they are in the Draft
environment.

Changing dimension color in Draft

In the Draft environment, the color defined for each dimension type is part of
the dimension style, which you can edit using the Style command on the View
tab in the Style group. You can change the default color for locked and unlocked
dimensions on the General page of the Modify Dimension Style dialog box.

• The default color for locked dimensions—Black/White—is set by the Driving
Dimension option.

• The default color for unlocked dimensions—Dk Cyan—is set by the Driven
Dimension option.

Not-to-scale dimensions

You can override the value of a driven dimension by setting its dimensional value
to not-to-scale. For example, if you override the dimensional value that is 15
millimeters (A) to be 30 millimeters, the actual size of the line that you see would still
be 15 millimeters (B). Solid Edge underlines the values of not-to-scale dimensions.

The Not To Scale command is available on the context menu when a dimension is
selected.
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Placing dimensions

To add dimensions to elements, you can use a dimension command, such as Smart
Dimension, and then select the elements you want to dimension.

As you place dimensions, the software shows a temporary, dynamic display of the
dimension you are placing. This temporary display shows what the new dimension
will look like if you click at the current cursor position. The dimension orientation
changes depending on where you move the cursor.

For example, when you click the Distance Between command and select an origin
element (A) and an element to measure to (B), the dimension dynamically adjusts its
orientation depending on where you position your cursor (C) and (D).

Because you can dynamically control the orientation of a dimension during
placement, you can place dimensions quickly and efficiently without having to use
several commands. Each of the dimension commands uses placement dynamics that
allow you to control how the dimension will look before you place it.

Note

When the IntelliSketch Intersection option is set and you select Distance
Between, you can place a driven dimension that measures to the intersection
of two elements.
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Snapping to keypoints and intersection points

When placing a dimension, you can use shortcut keys to select and snap to keypoints
or intersections. After you locate the line, circle, or other element that you want to
snap to, you can press one of these shortcut keys to apply the point coordinates to
the command in progress: M (midpoint), I (intersection point), C (center point),
and E (endpoint).

To learn more, see Help topic Selecting and snapping to points.

Making dimension lines collinear and concentric

You can drag an existing dimension so that it snaps into alignment with another
dimension.

• As you drag a linear dimension (A), you can locate another dimension to display
a dotted alignment indicator (B). When you release the mouse button, the first
dimension snaps into collinear alignment with the second.

• You can use the same technique to move a radial dimension so that it snaps into
concentric alignment with another radial dimension.

Aligning dimension text and leader break points

You can use the Line Up Text command to align dimensions by their dimension text,
using alignment and justification options you select on the Line Up Text command
bar. Two other options on the command bar align linear dimensions using the leader
break points instead of the dimension text.
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Placing driving dimensions to an intersection

Sometimes you need to place a driving dimension to the intersection of two elements.
You can do this by dimensioning to a profile point you create using the Point
command.

For example, you can create a point at the theoretical intersection of two profile
lines, and then use the Distance Between command with the By 2 Points placement
option to dimension to the point you created. This results in a locked dimension,
which you can use to control distance, size, or shape.

To learn how, see Place a driving 2D dimension to an intersection.
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Placing dimensions with the dimension axis

The Dimension Axis command sets the orientation of the dimension axis on the
drawing sheet or profile plane. You can use the new dimension axis, rather than
the default axis of the drawing sheet or profile plane, while you use the Distance
Between or Coordinate Dimension commands. After you define the dimension axis,
you can place dimensions that run parallel to or perpendicular to the dimension axis.

Placing dimensions between drawing views

You can add dimensions that measure the true distance between edges in different
views of the same model, such as between a principal view and a detail, cropped, or
broken view.

In addition to being of the same model, the drawing views must share the same view
plane. For example, you can add a dimension between an edge in a front view and
an edge in a detail view with the same front orientation, but not between a front
view and a side view.

You can:

• Place dimensions between drawing views using any of the commands that
measure distance or angle between two elements.

• Select edges, center marks, bolt hole circles, centerlines, sheet metal bend lines,
tube centerlines, keypoints, and hidden lines within the drawing views for
dimension placement.

Dimensioning with a grid

You can easily create and align dimensions using a grid and the Snap To Grid options
on the Grid options dialog box. You can snap to a grid point or to a grid line.

While modifying an existing dimension, you can select any part of the
dimension—line, text, or handle—and drag it, and it will snap into position. When
you turn off the grid, you turn off the snap-to-grid feature.

Dimensioning automatically

There are two ways you can add dimensions automatically and generate geometric
relationships to constrain the geometry:

• You can use the Relationship Assistant command when editing existing
profiles. This is a quick method of dimensioning and setting simple geometric
relationships for any 2D information brought into Solid Edge, including
information from other systems.

• You can use the Auto-Dimension command when drawing new elements. The
options on the Auto-Dimension page of the IntelliSketch dialog box control when
the dimensions are drawn as well as whether to use dimension style mapping or
not.
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Using the Relationship Assistant

The Relationship Assistant command helps you finish a profile or sketch, or make
it fully parametric. After applying all critical dimensions and relationships to the
shape, you can use the Relationship Assistant command to apply any missing
geometric or dimensional relationships to help fully constrain the model. It is a good
idea to check the profile with the Show Variability option to check for degrees of
freedom.

You can also use the Relationship Assistant command bar to show you how many
additional relationships are required and how the shape can change based on the
current relationships and dimensions.

To determine how many additional relationships are needed and how the profile or
sketch can change, drag a fence around the profile, then click the Accept button on
the command bar. You can then click the Show Variability button on the command
bar to display the number of relationships needed. A temporary display of the profile
using the highlight color is also displayed to illustrate one possibility of how the
profile can change. You can click the Show Variability button repeatedly to see
other variations.

Formatting dimensions

If you want two or more dimensions to look the same, you can select the dimensions
and apply a style with the command bar. If you want to format dimensions so that
they look unique, you can select a dimension and edit formats with the command
bar or the Properties command on the shortcut menu.

To learn how to format dimension terminators, see Set Terminator Size and Shape.

You can add prefix, suffix, superfix, and subfix text and supplementary information
to a dimension value using the options in the Dimension Prefix dialog box. You
can use this dialog box while you place or edit a dimension. To learn how, see Add
and edit dimension text.
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Adding breaks to dimension projection lines

Dimensioned drawings can become cluttered and difficult to read when dimensions
intersect one another. Using the Add Projection Line Break command, you can
add breaks to projection lines on a selected dimension (A). The result is that break
gaps (D) are inserted into the projection line (B) wherever it intersects another
dimension (C). Visually, the break is represented by not drawing the projection
line at the point of intersection.

(A) = selected dimension

(B) = projection line (broken)

(C) = intersecting dimensions (unbroken)

(D) = break gaps

The purpose of the projection line gap is to add visible white space and improve
legibility. The size of the gap is set by the Break option on the Lines and Coordinate
tab (Dimension Properties dialog box).

To add a break around dimension text that intersects other dimensions, set the Fill
Text With Background Color option on the Text page (Dimension properties dialog
box).

You can cut, copy, and paste a dimension with projection line break gaps as long as
you select both the breaking and the broken dimensions along with the geometry.

Dimension projection lines that you have broken retain their setting during view
updates, and also when you reposition the dimension text or lines for aesthetic
reasons.

You can remove dimension line breaks using the Remove Projection Line Break
command.
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Adding jogs to dimension projection lines

You can improve the clarity of a dimensioned drawing and avoid overlapping
dimension lines by adding jogs to the dimension projection lines. This capability
is supported in coordinate dimensions, linear dimensions, diameter dimensions,
symmetrical diameter dimensions, and circular diameter dimensions.

• You can use Alt+click to add one or more jogs:

To the dimension lines of a coordinate dimension.

To the horizontal or vertical dimension projection lines of linear, symmetrical
diameter, circular diameter, and distance between dimensions.

• You can remove a single jog on an existing dimension by holding the Alt key
while you click a jog key point.

• You can remove all jogs on a selected dimension line or projection line using
the Jog button on the command bar.

• You can drag the segment or the handle points created by the jog to change the
length and orientation of the jog lines.

There are some limitations when adding jogs to stacked or chained dimensions.
See the Help topic, dimension groups.
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Copying dimension data

In the Solid Edge Draft environment, you can copy data such as prefix strings,
dimension display types, and tolerance strings from one dimension to another. You
also can copy the style properties associated with a dimension or annotation to
another dimension or annotation using the Copy Attributes command.

Using the mouse scroll wheel to change dimensions

You can use the mouse scroll wheel to change a driving or system dimension. As you
scroll the wheel, the dimension increases or decreases in 5 percent increments.
For example, if the dimension is 100 mm, the dimension will increase or decrease
by 5 mm.

You can use the mouse scroll wheel to change a dimension by selecting the dimension
you want to change, and then scrolling the wheel forward to increase the dimension
or backward to decrease it.

An option on the General page of the Solid Edge Options dialog box controls the
mouse scroll wheel function.

• If the option Enable Value Changes Using the Mouse Wheel is unchecked, you
can use Ctrl+mouse wheel to change a dimension value.

• If the option is checked, you can use the mouse wheel to change a dimension
value.

Using expressions in dimensions

There are many instances when the dimensions of individual features in a design
are related. For example, the bend radius used to manufacture a sheet metal part is
usually a function of the stock thickness. You can define and automate these types of
design relationships with expressions. You can select a dimension and then use the
Variables command on the Tools tab to enter a formula. When the formula is solved,
the dimensional value changes to the value that the formula calculates.

You might want to use dimensions with expressions for the following purposes:

• Drive a dimension by another dimension; Dimension A = Dimension B

• Drive a dimension by a formula; Dimension A = pi * 3.5

• Drive a dimension by a formula and another dimension; Dimension A = pi *
Dimension B

Setting or modifying units of measure

You can set the units of measure for a dimension by selecting the dimension and
using the Properties command on the shortcut menu. You can set the units of
measure for a document using the Properties®File Properties command on the
Application menu.
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Showing variability
The Show Variability option on the Relationship Assistant command bar shows
how 2D elements can change based on their dimensions and relationships. Use the
Relationship Assistant command to see the types of changes in a shape allowed
by existing degrees of freedom.

To learn how, see the help topic, Show how a profile or sketch can change.
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Tracking changed dimensions and annotations

When a drawing view is updated in the Solid Edge Draft environment, you can track
dimensions and annotations that have been changed or deleted from the model. To
open the Dimension Tracker dialog box so you can identify these changes, use the
Tools tab®Assistants group®Track Dimension Changes command.

• On the drawing, every changed dimension and annotation is flagged by a balloon.

• In the Dimension Tracker dialog box, changed items are displayed in columnar
format. You can sort the changes by clicking a column heading.

• You can select one or more items in the list and assign a revision name to the
balloon labels on the drawing.

To learn more, see Help topic Tracking dimension and annotation changes.

Dimensioning to sheet metal bends

When placing dimensions on sheet metal bends Solid Edge takes into account the
dimension’s position relative to a bend and automatically provides the best solutions
in QuickPick. The solution can dimension to one of the following:

• Layer face intersection

• Bend silhouette

Note

When placing the dimension, you can press I to switch between the different
dimension binding options available in QuickPick.

Editing the bend angle updates the bind style between a layer face intersection
and a bend silhouette.

The bind point changes dynamically as you change the angle.
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Types of dimensions

A linear dimension measures the length of a line or the distance between two
points or elements. You can place linear dimensions with the Coordinate, Distance
Between, Smart Dimension, and Symmetric Diameter commands.

An angular dimension measures the angle of a line, the sweep angle of an arc, or the
angle between two or more lines or points. You can place angular dimensions with
the Angle Between and Smart Dimension commands.

A radial dimension measures the radius of elements, such as arcs, circles, ellipses, or
curves. You can place a radial dimension with the Smart Dimension command.

A diameter dimension measures the diameter of a circle. You can place a diameter
dimension with the Smart Dimension command.

A coordinate dimension measures the distance from a common origin to one or more
keypoints or elements.

You can use the following commands in Solid Edge to place dimensions:

• Smart Dimension command

• Distance Between command

• Angle Between command

• Coordinate Dimension command

• Angular Coordinate Dimension command

• Symmetric Diameter command

• Chamfer command
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The components of a dimension are as follows:

(A) Projection line (E) Break line
(B) Dimension line (F) Symbol
(C) Dimensional value (G) Connect line
(D) Terminator

Coordinate dimensions

You can use the Coordinate Dimension command and Angular Coordinate Dimension
command to place dimensions that measure the distance from a common origin
to one or more keypoints or elements.

You can place coordinate dimensions in any order and on either side of the origin.
You can also add, remove, and modify jogs on the dimension line to make it easy
to position all the dimensions.
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Coordinate dimensions that refer to a common origin are members of a coordinate
dimension group.

Placing coordinate dimensions

To place coordinate dimensions, you first select an origin element to establish a
measure-from point (A), and then position the origin symbol (B).

You then select an element away from the origin as a measure-to point (C), and
position the dimension (D). The dimension measures the distance from the origin
element to the measure-to element.
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To make it easier to accurately align the dimension text for a group of coordinate
dimensions, several built-in snap alignment positions allow you to align the text
when placing or modifying coordinate dimensions.

You can add additional coordinate dimensions to an existing coordinate dimension
group by selecting any dimension in the group as the origin, and then select an
additional element to dimension.

Moving coordinate dimension groups

In the Draft environment, you can move a group of coordinate dimensions by
dragging the track point on the origin symbol. Select the origin, position the cursor
over the track point, then drag the group to a new location.

9-318 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Placing coordinate dimensions with jogs

To add one or more jogs while placing a coordinate dimension, first select the element
you want to dimension, then hold the Alt key and click to add the jogs. For example,
to place the following 12 millimeter dimension as shown, you would first select the
circle as the element to dimension (A), you then hold the Alt key and click points
(B), (C), and (D) to add the jogs. You then release the Alt key and click points (E)
and (F) to finish placing the dimension.

Adding jogs to coordinate dimensions

To add a jog to an existing coordinate dimension, use the Select Tool to select a
coordinate dimension (A). Position the cursor over the dimension line where you
want to insert the jog (B). Hold the Alt key and click.
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Two vertices and a jog segment are added (C). You can modify the jog by dragging a
vertex handle (D). You can also modify the jog by dragging the jog segment.

To make it easier to place coordinate dimensions with multiple jogs, the cursor
snaps into alignment when the last dimension line segment (A) is aligned with the
first dimension line segment (B).

Modifying jogged coordinate dimensions

You can modify the jog on a coordinate dimension by dragging a jog vertex (A) and
(B), or by dragging a jog segment (C).
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The modification behavior for each jog vertex is different when you drag it. For
example, when you drag the vertex farthest from the dimension text (A), you change
the jog segment position. When you drag the jog vertex closest to the dimension text
(B), you change the jog segment angle.

When you drag the jog segment (C), you also change the jog segment position.

Snapping coordinate dimensions to a grid

After you place coordinate dimensions using the built-in snap positions, and if you
have exceeded the number of built-in snap positions, then you can adjust their
alignment using a grid. To activate the grid, select the Tools®Grid command, and
then set the Snap To Grid options to use grid lines or points.

If you added jogs, then you can use snap to grid to modify the location of jog handles.

Removing jogs from coordinate dimensions

In the Draft environment, you can remove all the jogs from a coordinate dimension
using the Jog button on the Dimension command bar. Use the Select Tool to select a
coordinate dimension, then click the Jog button on the command bar.

You can also remove a single jog from a coordinate dimension using the Select Tool
and the Alt key. Select a coordinate dimension, then position the cursor over a vertex
on the jog you want to remove. Hold the Alt key and click.
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Class fit dimensions

Because the tolerance specification for the proper fit between holes and shafts is such
a common and critical aspect in the design and manufacture of parts, international
standards bodies have established rule-based systems of tolerances for the Limits
and Fits of holes and shafts.

The terms hole and shaft can also be taken as referring to the space between two
parallel faces of any part, such as the width of a slot, the thickness of a key, etc. Only
distance dimensions are covered by the standards. The standards do not apply
to angular dimensions.

Solid Edge provides ASCII text files that you can use to automatically define the limit
or fit for a dimension whose type is set to Class using the dimension command bar.

Class dimension display options

When you set the dimension display type to Class, you can choose one of several
methods to display the limits or fits for the dimension.

Fit

Fit, tolerance only

Fit with tolerance

Fit with limits

Fit Hole/Shaft only
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Fit Hole/Shaft, tolerance only

Fit Hole/Shaft with tolerance

User-defined

(Any user-defined text is valid)

Formatting options for class fit dimensions

You can specify formatting options for tolerance dimensions and for class fit
dimensions by editing the dimension properties or by defining it in the dimension
style. Refer to the following options on the Text tab, in the Tolerance Text group:

Hole/Shaft
Three separator types are available to specify the layout of class fit hole/shaft
dimensions with tolerance.

Use these options To get this layout
Separator Vertical

Space Vertical

Slash Horizontal

Position
Use these
options

To get this layout

Bottom Tolerance aligned to the bottom of the dimension text.
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Use these
options

To get this layout

Center Tolerance center-aligned with the dimension text.

Top Tolerance aligned to the top of the dimension text.

Align to
The following options are available to specify alignment of the upper tolerance
value with the lower tolerance value:

• Decimal Point

• Sign

Use tolerance text size for combined tolerance text values
When upper and lower tolerance values are the same, specifies that the combined
values are displayed using the tolerance text size entered in the Size box.

Example

Class fit ASCII text files

Three ASCII text files are available that provide support for ANSI and ISO class
fit dimension standards:

• SE-LimitsAndFitsTableANSIinch.txt

• SE-LimitsAndFitsTableANSIMetric.txt

• SE-LimitsAndFitsTableISO.txt

By default, the files are located in the Solid Edge Program folder. You can instruct
Solid Edge to look for these files in a different folder, including a folder on another
machine on the network using the File Locations tab on the Options dialog box.

Note

If you edit these files, save a copy of these files before you uninstall Solid Edge.

Controlling the display of zero value tolerances

When placing a class fit dimension that displays a tolerance, you can set an option to
inhibit the display of a tolerance that has a value of zero.
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The Inhibit Display of 0.0 Values for Automatic Fit Tolerances option on the Text
page controls whether zero value tolerances are displayed or hidden.

You can set this option for an individual dimension using the Properties command,
or you can set it for all dimensions using the Style command.

3D pictorial drawing view dimensions

You can add 3D dimensions to a pictorial drawing view. On a drawing, 3D
dimensions use the associative model to determine true distance, rather than the
space on a 2D drawing. You can place a linear, radial, or angular Smart Dimension
as a 3D dimension.

Note

To add dimensions and annotations to 3D models, use the commands on
the PMI tab on the ribbon. See the Help book, Product Manufacturing
Information (PMI).

Linear 3D dimensions
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Radial 3D dimensions

For radial 3D dimensions, if the dimension is on the inside of the 3D circle or arc,
then the tail of the dimension is tied to the center of the 3D circle or arc. If the
dimension is on the outside of the 3D circle or arc, then the dimension line is aligned
with the center of the 3D circle or arc.

Angular 3D dimensions

For angular 3D dimensions, the model planes and adjacent face planes of the lines
are valid dimension planes.

Workflow

You place a 3D dimension on a pictorial drawing view using the same workflow as
when you place a 2D dimension. However, if the drawing view is out of date, you
must use the Update View command to make it up to date with the model before you
can dimension it.

Dimensions in 3D are created relative to a dimension plane. In a drawing, this
is determined by the element you select. You can change the plane at any time
during dimension placement. In a drawing, change the dimension plane with the
N and B keys.
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Drawing View Properties dialog box

The Create 3D Dimensions In Pictorial Views check box on the General page of the
Drawing View Properties dialog box controls whether 3D dimensions are placed. By
default, 3D dimensions are enabled for pictorial views.

Placement guidelines on drawings

Because 3D dimensions measure actual model space, it is important to consider the
perspective of the view when evaluating apparent conflicts between dimensions.
For example, a cutout that appears circular in a pictorial view may actually be
elliptical, and have proximate radial dimensions with different values. Moreover,
when you look at a drawing, there is no way to distinguish at a glance between a 2D
dimension and a 3D dimension (unless the 3D dimension has a placement that is
impossible for 2D dimensions).

Therefore, it is possible to create a drawing with both 2D and 3D dimensions on
which dimension values seem to conflict, because the 2D dimension is measuring
drawing sheet space and the 3D dimension is measuring actual model space. Keep
this in mind and use your knowledge about your situation and workflow to avoid
creating potentially confusing drawings.

Dimension groups

You can place dimensions in dimension groups with the following commands:

• Distance Between

• Angle Between

• Symmetric Diameter

• Coordinate Dimension

This makes the dimensions easier to manipulate on the drawing sheet. All members
of a stacked or chained dimension group share the same dimension axis.

(A) Stacked dimension group
(B) Chained dimension group
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A coordinate dimension group is another type of dimension group. Coordinate
dimensions measure the position of key points or elements from a common origin.
All the dimensions within the group measure from a common origin. You should
use coordinate dimensions when you want to dimension elements in relation to a
common origin or zero point.

When you place dimension groups with the Distance Between or Angle Between
commands, the cursor position determines what type of dimension group will be
placed. After you place the first dimension in a group and click the second element
you want to measure, if the cursor is below the first dimension, then the dimension
group will be a chained group (A). If the cursor is above the first dimension, then the
dimension group will be a stacked group (B).

Adding jogs to dimension groups

You can use Alt+click to add jogs to the horizontal or vertical dimension projection
lines, but there are some limitations when adding jogs to stacked or chained
dimension groups:

• You cannot place a jog on a shared extension line.

• In chained dimension groups, you can add a jog only to the first and last
extension line.

• In stacked dimension groups, you cannot add a jog to the first—the
shared—extension line.

Zero and negative dimensions

You can use zero and negative values to manipulate geometry in the following
dimension types:

• Smart Dimension between two elements (or keypoints from two elements)

• Distance between two elements (or keypoints from two elements)

• Smart Dimension angle between two elements (or keypoints from two elements)

• Angle between two elements (or keypoints from two elements)
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After you place one of the above dimensions, you can change it to zero or a negative
value to control element placement. When you select a dimension, its parents
highlight.

Zero and negative dimensions work best on fully constrained geometry. When a
profile or sketch is not fully constrained, negative dimensions can be unpredictable
(unexpected change of side, for example).

Unsupported dimensions
Zero and negative values are not supported for any group dimension, including linear
coordinate, angular coordinate, linear stacked, linear chained, angular stacked, and
angular chained. Zero and negative dimensions are also not supported for radial
dimensions, diameter dimensions, and chamfer dimensions. Point constraints do not
allow negative offsets.

Controlling zero and negative dimensions
Because positive and negative values need not follow the X axis or Y axis, there is
no set positive or negative direction when you use zero and negative dimension
values. Rather, the direction is determined by how the dimension is placed with
respect to the other relationships affecting the geometry. When you change the sign
of a dimension (from positive to negative, for example), the direction the distance is
measured changes relative to the geometry only. A positive value is measured in the
direction in which the dimension was originally placed.

If you toggle a dimension from driving to driven when its value is negative, the
dimension is displayed as positive. A driven dimension can never be negative.
Dimensions retrieved from part models are positive because they are always driven,
and zero dimensions are not retrieved.

Displaying zero and negative dimensions
The following conditions apply to the display of zero and negative dimensions:

• Text positions are processed as if the dimension were positive or non-zero
(above, embedded, and so forth). Text position for zero values behaves as if the
dimension were a very small positive value.

• Zero dimensions do not move or change the dimension break position.
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• Dual unit display shows both united values with a negative sign.

• Zero angular dimensions between two non-intersecting elements display as
linear dimensions (but with a degrees symbol). You can drag the ends of the
extension lines with handles or move the text position as shown below.

Retrieving dimensions and annotations from a model

You can copy dimensions and annotations from a part, sheet metal, or assembly
model to a drawing view using either of the following methods:

• Use the Retrieve Dimensions command to copy dimensions and annotations
from the model to an existing orthogonal or section drawing view. The Retrieve
Dimensions command copies PMI dimensions and annotations as well as sketch
dimensions and annotations.

To learn how, see the Help topic, Retrieve dimensions and annotations from
the model.

• Use the Drawing View Wizard to generate a drawing view from any previously
defined PMI model view created with the PMI tab®Model Views group®View
command. This method copies only PMI elements to the drawing.

To learn how, see the Help topic, Create a PMI drawing.

With either method, when you change the design later you can use the Update
View command on the shortcut menu to update the part view and the retrieved
dimensions also update. For example, if you change the size of a hole in your part,
the retrieved dimension for the hole in the part view will update to the new value.
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Dimension and Annotation Standards and Formats

Style mapping applies standard or custom style formats to lines, hatches, fonts, fills,
dimensions, annotations, and views as you place objects that use these styles in the
document. The element-to-style mapping table on the Dimension Style tab of the
Options dialog box allows you to choose which style to map to which element, or it
allows you to assign one style to all elements.

When the Use Dimension Style Mapping option is set on the Dimension Style

tab, then the Dimension Style Mapping option is also set by default on the
relevant command bars and dialog boxes used to place individual elements. You
can override the mapped style for an individual element by clearing this option on
the command bar.

For global impact across all design documents and drawings, you can specify drawing
standards and styles in the template files used to create part, assembly, sheet metal,
and draft documents. This ensures that designers apply standards that conform
with company style guidelines.

Standards

The default, standard styles available are:

• ANSI

• ANSImm

• BSI

• DIN

• ISO

• JIS

• UNI

In addition, you can create and name custom styles. The style format is defined in the
Style dialog box (Format-Style-Dimension style type-New button or Modify button).

Style Format Options

New and modified style formatting options vary widely between the type of element.
Some of the style formatting options include the following:

• Lines (e.g., style, color, width)

• Units (e.g., inch, mm)

• Spacing (e.g., in a pattern)

• Delimiters (e.g., period or comma)

• Terminators (e.g., arrow, circle, dot)

• Round-off
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User-defined tables

The Table command allows you to create a table that contains user-defined data.

The table consists of a title (A), column header (B), and column data (C).

Saved settings cannot be applied to user-defined tables. However, you can create
a style template to specify reusable table properties—including lines and text—by
creating a custom table style.

Creating a table

To create a user-defined table, use the Table command.

The command displays the Table Properties dialog box, which contains four tabs that
assist you in creating the table: the General tab, Title tab, Data tab, and Sorting tab.
These tabs are shared among all Solid Edge table types.

To learn more about how you can use the options on these tabs, see the following
Help topics:

• Using the General tab

• Using the Title tab

• Using the Data tab

• Using the Sorting tab

Saved settings cannot be applied to user-defined tables. However, you can create a
style template to specify table appearance—including lines and text—by creating a
custom table style.

Creating a custom table style

You can use the Styles command to create your own, fully customized Table styles
in the Draft environment and make them available for many different table
applications. For example, custom table styles can be applied to parts lists, pipe lists,
hole tables, bend tables, drawing notes, revision tables, and the dimension table
used by families of assemblies.

You can select and apply a custom table style to a user-defined table using the Table
command bar or the General page of the Table Properties dialog box.
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See the Help topic, Table styles.

To learn how you can change the appearance of individual elements of a table—titles,
columns, headers, and data cells—without changing the table style, see the Help
topic, Formatting columns and data cells.

Using the General tab

The General page on the Properties dialog box is where you define basic information
about the table or parts list. This includes where to place the table, how the table
grows or shrinks, and how multi-page tables are displayed. You also can move a
table to a different sheet.

Table placement and sizing

You can use either of these methods to place a table: dynamically, or by specifying a
table origin point.

• You can place a table dynamically by moving the mouse until the table is located
where you want it, and then clicking to fix its position.

• You can place the table at a specific origin point when you select the Enable
Predefined Origin for Placement check box, and then enter sheet coordinates
in the X Origin and Y Origin boxes.

With either placement method, you can apply a Page Anchor Point to control table
placement and sizing. These options are illustrated here:

(A) Top-Left

(B) Bottom-Left

(C) Top-Right

(D) Bottom-Right

• Choosing a top-left anchor point means that the top-left table corner is easily
matched to the top-left corner of the working sheet.

• When the anchor point is on the left, the page gets wider on the right as columns
are added. When the anchor point is on the right, the page gets wider on the left
as columns are added.

• When the anchor point is on the top, the page height adjusts on the bottom.
When the anchor point is on the bottom, the page height adjusts on the top.

Specifying maximum table height

You can specify the maximum table height using either of these methods:
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• Selecting the Maximum Number of Rows option and typing a positive integer.
Once that number is reached, a new page is created.

• Selecting the Maximum Height option for the table and typing a size value. Once
that size is reached, a new page is created.

Moving table pages to working sheets

You can use the Sheet control to specify the sheet that you want the table to appear
on. Use the control to place the parts list with the drawing it references.

Working with multi-page tables

In tables that have multiple pages:

• Left and right anchor points control which side of the table that pages are added.

• When new columns are added, they are added to each page.

• The Page Gap specifies the minimum distance between each page.

• You can change the Page value to place each page onto different sheets.

Using the Title tab

Use the Title tab in the Properties dialog box to add, remove, and manage the
location of titles and subtitles in a table or parts list.

Creating titles

A table can have any number of titles and each title can have multiple lines of text.

You can create a table title using the Add Title button and then typing in the
Title Text box. The Position option determines whether the title is displayed as a
header at the top of the table, as a footer at the bottom of the table, in both locations,
or not at all.

The order in which the titles are created, combined with the Position setting,
determines their display order and location in the table.
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Example

• If you create two titles in the Header position, then they are displayed as
a title and subtitle spanning the first two rows of the table.

• If you create two titles with the first (T1) in the Header position and the
second (T2) in the Footer position, then (T1) is displayed at the top of the
table and (T2) is displayed at the bottom of the table.

The total number of titles is indicated by the value in the Number Of Titles box.

To learn how: Add a table title.

Modifying titles

You can modify a title by selecting its number from the Title list. Then, you can:

• Change the title by typing in the Title Text box.

• Change the location of the title in the table by selecting an option from the
Position list.

• Delete the title using the Delete Title button .

Using the Data tab

You can use the Data tab in the Properties dialog box to enter data into a table or
parts list, and to manipulate the format of the table.

Formatting a data column

On the Data tab, you can use the Format Column button to display the Format
Column dialog box, where you can customize the format for the selected column. You
can do such things as set the column width; create, position, and align a column
header; align data; and show and hide columns and headers.

In the Format Column dialog box, you can use the Format Cells button to display the
Format Table Cells dialog box.
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• To learn how you can use the Format Column dialog box and the Format Table
Cells dialog box to customize the appearance of the header rows and data cells,
see the Help topic, Formatting columns and data cells.

• To learn how you can insert or delete columns and rows, move rows, drag
columns from one location to another, see the Help topic, Make changes to a
table or parts list.

Editing data cells

White data cells may be edited. You can double-click a cell to edit it, and press
the Tab key to save the value you type.

Gray shaded data cells are disabled for direct editing, because they contain content
derived from the model by property text. You can override the derived values in
these cells using the following shortcut commands:

• Allow Cell Overrides—When you use this command to enter a new value, the cell
is no longer associative to the model.

• Clear Cell Overrides—This command resets the value of an edited cell to its
original value derived by property text.

Copying data from a spreadsheet

You can copy and paste cells from a spreadsheet into a user-defined table or into
user-defined cells in system-generated tables, such as parts lists and family of
parts tables.

When importing a spreadsheet, you need to ensure that the number of columns
and rows are exactly the same in the table and spreadsheet or you may lose data
during the copy and paste. For example, if your table contains three columns and
five rows, but the spreadsheet contains four columns and six rows, the table is not
large enough and data will be lost.

Using the Sorting page

You can use the Sorting page on the Properties dialog box to sort the table or parts
list based on the contents of the column. To learn how, see Sort table contents.

General sorting techniques

• You can do multi-column sorting with up to three columns. For example, you can
sort by column 1, then by column 5, and then by column 2.

• You can sort by ascending or descending order.

• You can use the Reverse Order of Entries option to reverse the order of the
search results.

• You can add a column name to the Sort Criteria lists by first adding the column
property on the Columns tab.

• Blank rows in a table may be affected by sorting.
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Sort by component type

For assembly models containing piping or tubing, you may want to sort the parts list
by selecting the Component Type Order option from the Sort by lists.

Sort by custom property

You can sort the parts list by custom properties that are assigned in the part and
sheet metal documents, and which are then inserted as custom columns in the
parts list.

To learn how, see Example: Show custom properties in a parts list.

Sort by assembly structure or item number

There are two ways you can sort the columns to show item numbers in parts lists
on assembly drawings:

• You can select the Assembly Order criteria in the first Sort by list to match the
order that is shown in Assembly PathFinder.

• You can select the Item Number criteria to sort using the item numbers
generated by the Parts List command.

Hole tables

Hole tables are a useful means of defining the size and location of a hole. A hole
table works much like a software spreadsheet. Holes are represented as rows in the
table and dimensions of the holes as columns. Both circles and arcs are supported
in hole tables.

You can create hole tables based on the following hole dimensions:

• hole size only

• hole location only

• hole size and location

Creating hole tables

To create a hole table, use the Hole Table command. On the Hole Table command
bar, you can use the Hole Table Properties button to open the Hole Table Properties
dialog box, where you can define the information you want to appear in the table.
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Formatting a hole table

Before you place the hole table on the drawing sheet, you can use the Hole Table
Properties dialog box to format it the way you want. For example, you can set
properties on the Columns tab to control the column width, column title and column
arrangement in your hole table. You can also set options for the size and location of
the hole table, the font you want to use, whether you want to list the holes by origin
or by size, and so forth. You can add callout columns to the hole table. You can
change the hole table formatting later.

Using smart depth with hole table entries

You can use Smart Depth controls to intelligently describe holes in a hole table.
When you use Smart Hole Depth or Smart Thread Depth for a hole table entry, the
entry populates based on the data variables, template text, or other information you
specify on the Smart Depth tab of the Hole Table Properties dialog box. This is
useful for easily determining whether the depth or thread of a hole is finite.

Renumbering hole table entries

With the renumbering options on the List tab of the Hole Table Properties dialog
box, you can determine how Solid Edge renumbers the rows in your hole table when
you update it. You can choose to renumber holes, to keep previous numbers for
deleted holes, or to leave blank lines for deleted holes.

Saving the hole table format

You can save a hole table format with a name you define, so you can easily use it
again. To apply a saved format in another drawing, select its name from the Hole
Table Properties list on the command bar.

Setting up hole properties for the hole table

You can include hole properties such as Radial Location and Angular Location in
your hole table. Use the Columns tab of the Hole Table Properties dialog box to set
up a column for each property you want in the hole table.

Family of parts dimension tables on drawings

Family of parts dimension tables placed on drawings are useful for defining the size
and location of features derived from similar family members. The Family Of Parts
Table command automatically generates a table that contains all of the variables
derived from a family of parts, and it imports the dimensional and positional data
for all members of the selected family. You also can link the family member variables
to dimensions on the drawing.
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The family of parts table lists family member location and size data by row. Family
variable labels are shown as column headings. You can easily customize the table by
making formatting changes. You can insert user-defined columns into the table and
extract other model information into them. For example, you can use property text to
extract graphical model information to supplement the dimensional and positional
values derived from the family of parts.

Creating a family of parts table on a drawing

To create a family of parts table on a drawing, you begin by placing one or more
drawing views containing a family member, and then you add dimensions to them.

Next, choose the Family Of Parts Table command , and then select a drawing
view of a family member.

The command displays the Variables tab on the Family Of Parts Table Properties
dialog box, where you can specify which family variables you want to include and
exclude from the table.

You then can place the table on the drawing sheet, or you can first use the other
options on the multi-tabbed Family Of Parts Table Properties dialog box.

mt01413-s-1050 Solid Edge fundamentals 9-339



Lesson 9 Creating detailed drawings

• You can add and edit data using the Data tab. You also can create and edit
column headings by double-clicking the blank cell at the top of the column, or by

selecting a column and then selecting the Column Format button .

Note

Column headings are required if you want to sort and group the table
data. See the Help topic, Using the Data tab.

• You can specify the table style and the maximum table height or number of data
rows using the General tab. The Location tab specifies the placement location
on the sheet, and whether to place it on the current sheet or on one or more
new table sheets.

See the Help topic, Defining table size and location.

• The Title tab is where you specify the text, formatting, and positioning of table
titles and subtitles. See the Help topic, Using the Title tab.

• Optionally, you can use the Sorting tab to specify that the table is sorted based on
any column headers you defined. You can use the Groups tab to group table data
into categories, which keep like items together. See the following Help topics:

o Using the Sorting tab

o Grouping data in tables

The last step is to link the drawing dimensions to the variables in the family of
parts table.

Note

Do not create a drawing from the family of parts master document. Instead,
create the drawing from one of the family members. For more information,
see the Using family members in assemblies and drawings section in the
Help topic, Families of Parts.

Including and excluding family variables

The Variables tab in the Family Of Parts Properties dialog box is where you choose
the variables that you want to display in the family of parts drawing table. These
are also the variables that you can link to dimensions on the drawing.

The Variables tab contains two lists of variables:

• The left-hand pane, Variables, displays all of the variables found in the Variable
Table for the selected family of parts, less those variables that are listed in the
right-hand pane.

• The right-hand pane, Variables Shown In Table, shows the variables that are
currently selected for the drawing table.

You can remove variables from the table using the Remove button. You can add
variables to the table using the Add button.

When you click OK, the data for all family members is imported, and the drawing
table is ready to place on the drawing sheet.
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Linking family variables to drawing dimensions

After you place the table on the drawing, you can link each of the family variables to
its corresponding driven dimension on the drawing. The links are associative, so
that when the member changes in the model, the dimension on the drawing goes
out of date.

Each dimension can be linked to just one variable, but you can link the same
variable to multiple dimensions. This enables you to illustrate the same dimension
in different views.

• To create a link, use the Link Variable button on the Family Of Parts Table

command bar: .

• To remove a link, use the Unlink Variable button on the command bar: .

Formatting a family of parts table

You can make formatting changes to a table before you click to place it, or you can
place it first and then select the Properties button on the command bar or on the
table shortcut menu to modify the table and data format.

Some of the formatting changes you can make include:

• Add one or more table titles of multiple lines of text.

• Hide a table row. Each row displays the values for a member of the family. You
may not want to show the data for members other than the one in the drawing
view.

• Hide a table column. Each column displays the family-derived values for a
family variable. You may not want to show the values for a variable that does
not have a corresponding dimension shown on the drawing view.

• Reorder members (rows) and variables (columns). You can move rows up and
down, and you can move columns left and right.

• Change the data display order. You can do multi-column sorting with up to
three columns.

• Insert one or more user-defined data columns, and specify that information
such as mass, volume, and material be extracted from the model using property
text strings.

Note

You can use property text to extract information from the Variable Table
by selecting Variables From Active Document as the source in the Select
Property Text dialog box. To learn how to use property text in a family of
parts table, see the Extract model information using property text section
in Make changes to a parts list or table.

Use the options on the Format Column dialog box to do such things as add, align,
and position headers, hide columns, change column width, and align data within
the table.
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Use the options on the Format Table Cells dialog box to apply formatting to the
currently selected cell in a header row, or to all data cells in a column.

To learn how you can change the appearance of individual elements of a table—titles,
columns, headers, and data cells—without changing the table style, see the Help
topic, Formatting columns and data cells.

To learn how to change the table format, see Make changes to a parts list or table.

Updating a family of parts table

When a change to a family of parts causes a drawing table to go out of date, a thin
gray border surrounds the table.

To update the table based on the model change, use the Update Family Of Parts
Table command on the table shortcut menu. You also can use this command to apply
formatting changes you make to an existing table.

Defining and modifying table styles

You can use the Styles command to create your own, fully customized Table styles
in the Draft environment and make them available for many different table
applications.

The Table style provides line style properties that control the display of table borders
and grids. For example, you can change the color, type, and width of the border and
grid lines. Set the Type to None if you do not want to display a table component.

For each component of a table, you also can define a text style. You can define
different text styles for the table title, column headings, and cell data.

To learn more, see help topic Table styles.

To learn how to customize table styles, see Help topic Create or modify a table style.

Tracking dimension and annotation changes

Activating the Dimension Tracker

In the Solid Edge Draft environment, you can track dimensions and annotations
that have changed when a drawing view is updated. The Dimension Tracker dialog
box reports the changes for you to review and to label.

• You can open the Dimension Tracker dialog box at any time by choosing Tools
tab®Assistants group®Track Dimension Changes from the menu. However, the
contents of the dialog box are updated only when dimensions, annotations, or
hole table entries have actually changed.

• The Dimension Tracker dialog box is opened automatically when you update a
drawing view in which dimensions, annotations, or model-derived table entries
have changed.

Using the Dimension Tracker

On the drawing, every changed dimension, annotation, and model-derived table is
flagged by a balloon. On the Dimension Tracker dialog box, changed items are listed
in columnar format. You can:
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• Sort the changes by clicking on the column headings: ID, Element, Reason,
Previous (Value), Current (Value), and Sheet. Each number in the ID column
corresponds to a change balloon number on the drawing. The Element column
identifies whether the item is a dimension or an annotation, and what type it is,
for example, linear, coordinate, circular diameter, or balloon/callout.

• Select one or multiple items and assign a label to the corresponding balloons on
the drawing using the New Revision button on the dialog box.

• Find a changed item on the drawing by clicking an item listed on the Dimension
Tracker. This highlights the dimension or annotation on the drawing view. For
complicated drawings, you can locate and zoom in on a changed item using the
Find button.

• Remove validated items from the change list—and corresponding balloons from
the drawing—using the Clear Selected or Clear All buttons.

Change reasons

The Reason column in the Dimension Tracker dialog box explains how a dimension
or annotation changed when you updated a drawing view.

• Detached – rebind failure.

Solid Edge was unable to find an eligible geometric element to rebind the item.
The item may have been deleted.

• Detached – no edge information.

The edge of the geometry was not rendered and could not be found.

• Value changed.

The model feature changed size.

• Terminator moved.

The terminator connect point was moved. The Annotation Moved Tolerance
option on the Options tab of the Dimension Tracker dialog box specifies the
distance tolerance beyond which this change is reported.

• Geometric rebind – Reattached to available geometry.

The item was rebound to the nearest eligible geometric element within a preset
distance tolerance.

• Content changed.

A change to dimension text or other content not related to value was made to a
PMI dimension. Examples of changes that cause the Content Changed reason to
be displayed include edits to dimension prefix text, a changed dimension type
and tolerance, and the addition of inspection requirements.

Revision balloons

To modify the appearance of revision balloons before they are added to the drawing,
you can change these settings on the Options tab of the Dimension Tracker dialog
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box: Balloon Shape, Balloon Color, and Number of Sides (for n-sided balloons). Then,
update the drawing view.

To alter the appearance of revision balloons already on the drawing, select the
balloon and then select the Properties command on its shortcut menu. You can then
edit the balloon annotation properties.

Using Copy/Paste/Undo

You can use the Copy button on the Dimension Tracker dialog box to copy all the
information from the Dimension Tracker list, and then use the Paste command on
the shortcut menu to paste the information to another document.

If you assign a label to a changed item and then want to revise it, you can
immediately select the Edit®Undo command to restore the item to the Dimension
Tracker list and the corresponding balloon to the drawing.

Annotations overview

An essential part of the design process is adding text, notes, and annotations.
Annotations are text and graphics that give information about the design. You
can add annotations to a drawing, a part, or an assembly by using the text and
annotation commands in the software.

Types of annotations

To place annotations, you can use the following commands:

• Text

• Balloon

• Callout

• Connector
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• Feature Control Frame

• Datum Frame

• Datum Target

• Surface Texture

• Weld Symbol

• Center Mark
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• Center Line

Annotations with leaders

Annotations with leaders have the following components:

(A) Terminator
(B) Leader line
(C) Break line
(D) Annotation

You can manipulate the annotation by selecting the leader and moving parts of
it. You can control the display of a leader break line and terminator and insert
or delete vertices on a leader.

Annotations with borders

The Callout command and the Text command create annotations that can be
displayed with or without a border outline. Text formatting and behavior control
options are available to ensure that the content always fits within the border.

Example

To create an annotation with the appearance shown in the following
illustration, you can do either of the following:

• Use the Callout command with the Show border outline option selected.

• Place a text box using the Text command, and then add a leader to it
with the Leader command.
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Annotations and associativity

Annotations can be associative or non-associative. An associative annotation moves
when the element it is connected to moves. Text boxes differ from other annotations
in that they are always non-associative.

If you attach the terminator of a leader to an element (A), the annotation moves
with the element (B). If you create the leader connection point in free space, the
annotation is not associative to any element in the drawing.

You can make a connected annotation non-associative by pressing the Alt key while
you drag the terminator handle off the element.

You can make a free space annotation associative by selecting the terminator of the
leader and dragging it to an element. The element edge highlights to show that it
is connected.

You can move a leader line connection point to free space or to another element yet
retain associativity with the first element, by pressing the Alt+Ctrl keys while
dragging the terminator handle.

Adding leaders

When placing an annotation, you can use the Leader and Break Line options on the
command bar to add a leader. You also can add a leader to an existing annotation
using the Leader command.

An annotation can have more than one leader. The terminator end of the annotation
can point to an element or be placed in free space. The annotation end of a new
leader must connect to an annotation or to the leader on an annotation.
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Inserting and deleting vertices on leaders

You can insert or delete a vertex on any annotation with a leader using the Alt key.
Vertices are edit points that you can use to manipulate the leader line.

When you insert a vertex, you split the leader into two segments. You can drag the
vertex to change the orientation and angle of the leader.

You can add a vertex by selecting a leader, holding the Alt key, and clicking where
you want to insert the edit point. To learn how, see the help topic, Insert a vertex in
a leader.

You can delete a vertex by pressing the Alt key while you click the vertex you want
to remove. To learn how, see the help topic, Delete a vertex from a leader.

Snapping to keypoints and intersection points

When placing many types of annotation and when measuring distance, you can
use shortcut keys to select and snap to keypoints or intersections. After you locate
the line, circle, or other element that you want to snap to, you can press one of
these shortcut keys to apply the point coordinates to the command in progress: M
(midpoint), I (intersection point), C (center point), and E (endpoint).

To learn more, see the help topic Selecting and snapping to points.
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Formatting annotations

If you want annotations to look the same, you can apply a style by selecting it on
the command bar. Text styles can be applied to text boxes. You can apply dimension
styles to the following annotations:

• balloon

• callout

• feature control frame

• datum frame

• datum target

• weld symbol

• surface texture symbol

• center marks, centerlines, and bolt hole circles

• connector

If you want to customize the look of one or more annotations, you can select an
annotation and edit its properties with the command bar or the Properties command
on the shortcut menu.

Aligning annotations

You can use the Line Up Text command to align annotations by their text, using
alignment options you select on the Line Up Text command bar. Two other options
on the command bar align annotations using their leader break points.

Saving annotations

When an annotation, such as a feature control frame, appears several times, you can
save the settings so that you can use them again. You can save any of the settings
for a feature control frame, weld symbol, or surface texture symbol in a template
with a name that you specify, much like a style.
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Tracking changed dimensions and annotations
When you update a drawing view in the Solid Edge Draft environment, you can
identify dimensions and annotations that have been changed or deleted in the model.
To open the Dimension Tracker dialog box so you can identify these changes, use the
Tools®Dimensions®Track Dimension Changes command.

• On the drawing, every changed dimension and annotation is flagged by a
revision balloon.

• On the Dimension Tracker dialog box, changed items are displayed in a columnar
format. You can sort the changes by clicking a column heading.

• You can select one or more items in the list and assign a revision name to the
balloon labels on the drawing.

To learn more, see Help topic Tracking dimensions and annotations.

Parts lists

Many companies include parts lists in their assembly drawings to give additional
information about individual assembly components. For example, part number,
material, and the quantity of parts required are typically documented in a parts list.

A Solid Edge parts list on a drawing is associative to the part view you select to
create it. You can add balloons automatically to the drawing, and the balloons can be
numbered to correspond to the part entries in the parts list.

9-350 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Creating parts lists
You can create a parts list by choosing the Home tab®Tables group®Parts List

command , and then selecting a part view. You can place balloons on the part view
automatically by selecting the Auto-Balloon button on the Parts List command bar.

To learn more about using balloons in parts lists, see the Help topic, Balloons.

Specifying content and format of a parts list
Before you place the parts list on the drawing sheet, you can use the pages on the
Parts List Properties dialog box to format it the way you want. You also can change
the parts list formatting after you have placed it.

The parts list consists of a title (A), column header (B), and column data (C).

• The General tab is where you specify the table style and the maximum table
height or number of data rows. The Location tab specifies the placement location
on the sheet, and whether to place it on the current sheet or a new sheet. See the
Help topic, Defining table size and location.

• The Title tab is where you specify the text, formatting, and positioning of table
titles and subtitles. See the Help topic, Using the Title tab.

• The Columns tab is where you define the column content and initial formatting.
You define content by selecting the property text that you want to extract to
display in it. You can combine multiple properties in each column, and you can
add simple text strings to any column. See the Help topic, Using the Columns
tab.

• The Data tab is where you add and remove columns and rows, and where you
edit extracted information displayed in individual cells. See the Help topic,
Using the Data tab.

To learn how you can change the appearance of individual elements of a
table—titles, columns, headers, and data cells—without changing the table style,
see the Help topic, Formatting columns and data cells.

• Use the Balloon tab to specify all aspects of balloons on the parts list:

o Balloon shape and number of sides.

o User-defined text and extracted property text.
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o Whether to show item number and count in the balloons.

o Control level for duplicate auto-balloons.

o Automatic balloon stacks for fastener system components.

• You assign the parts list item number format on the Options tab. This also is
where you choose whether to produce a cut length or total lengths part list for
pipe and frames. See the Help topic, Using the Options tab.

• After the parts list is created, you can edit the item numbers displayed in the
parts list and in the balloons using the Item Number tab.

• For each part and subassembly, you can use the List Control tab to specify the
granularity of the parts list.

• On the Sorting tab you can specify that the parts list is sorted based on the
document number of the part in the assembly, by component type, material,
quantity, and title. See the Help topic, Using the Sorting tab.

• For a parts list that spans multiple table sheets, you can use the Groups tab to
define table subheadings to categorize table data and keep like items together.
See the help topic, Grouping data in tables.

Item numbers in parts lists

You can include an Item Number column in the parts list, and show the part and
subassembly item numbers that are used by the assembly. Item numbers are
assigned in the assembly document using the Item Numbers tab (Solid Edge Options
dialog box).

• To use these item numbers in parts lists, you must select the Use assembly
generated item numbers check box on the Options tab (Parts List Properties
dialog box.

• Alternatively, you can leave this option unchecked and have the Parts List
command generate item numbers on the fly. You also can choose to use flat list
item numbers or level based item numbers when you create an exploded parts
list.

To learn more about item numbers, see the following Help topics:

• Exploded parts lists

• Item numbers in assemblies

Items without balloons (*)

An item number in the parts list that is marked by an asterisk indicates that no
balloon was created automatically for it on the drawing. Items without balloons are
controlled by options on the Parts List Properties dialog box:

• On the Options tab, you can select the Mark Un-ballooned Items check box and
specify one or more characters to display after the item number in the parts list.
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Example

You can change the default single asterisk marker (*) to a double asterisk
(**).

• On the Balloon tab, you can use the Auto-Balloon options to control how many
(or how few) duplicate balloons are created.

An item number balloon that displays NA represents a part that has been excluded
using List Control.

Setting up part properties for the parts list

You can include part properties such as Title, Document Number, Mass, and Material
in your parts lists. Use the Columns tab of the Parts List Properties dialog box to set
up a column for each property you want in the parts list. The properties themselves
are defined in the part and sheet metal documents, using these commands on the
Application menu:

• Properties®File Properties command

• Properties®Material Table command

You also can use the Property Manager command to view and edit the document
properties for a parts list. Working in a drawing of an assembly, the Property
Manager command displays the document properties for all the parts in the
assembly. This makes it easy to ensure that the parts list displays accurate and
complete information about the assembly.

Note

You can define part properties without opening the part or sheet metal
document in Solid Edge. Select the document in Windows Explorer, and then
right-click and choose the Properties command.

For an example of how you can define a custom property and display it in a parts list,
see Help topic Example: Show Custom Properties in a Parts List.
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Accounting for non-graphic parts

Assemblies often contain components for which there is no model required, such
as paint, grease, oil, labels, and so forth. These non-graphic parts still need to be
documented in the parts list and bill of materials that are created for the assembly.
In Solid Edge, you can use the File Properties command on the Application menu in
the Part and Sheet Metal environments to add custom properties to an empty part
document. Use the custom properties to define the required information for these
types of parts. You can create two types of non-graphic parts: parts that require a
unit type and quantity, and parts without a unit type and quantity.

For more information, see Non-graphic parts in assemblies.

Using multiple parts lists

You can create multiple parts lists for the same drawing. With multiple parts lists,
you can have different item numbers for the same parts. You also can create parts
lists that contain only specific component types (pipes, for example).

To create parts lists that share the same item numbers, you can designate an active
parts list. Then, when you create other parts lists, use the Link To Active button on
the Parts List command bar to link them.

You can make a different parts list the active parts list by selecting the Make Active
command on the shortcut menu with the parts list selected. When you create a new
parts list, it becomes the active parts list.

Renumbering parts lists

When you delete parts in an assembly and then update the parts list, the parts list
is not automatically renumbered. For example, if you delete part number 10, the
parts list will skip that number.

9-354 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

You can renumber a parts list using the Sorting tab on the Parts List Properties
dialog box. If you used automatic ballooning when you created the parts list,
renumbering the list also renumbers the balloons.

Note

The balloons for the deleted parts are not automatically deleted, but you can
delete them manually.

Saving the parts list format

You can save a parts list format with a name you define, so you can easily use
it again. Use the Saved Settings option on the General page of the Parts List
Properties dialog box to name, save, and reapply your parts list format.

A quick way to reapply the parts list formatting is to use the Saved Settings list

on the Parts List command bar.

Updating parts lists

Parts lists are similar to part views; when the parts list is not up-to-date, a gray
outline is displayed around the parts list to indicate that it needs updating. For
example, if you edit the part properties, you will have to update the parts list to
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display the changes. The Update command on the shortcut menu updates the
parts list.

Solid Edge does not check the file time stamp to determine whether a parts list is
out-of-date. Rather, the software computes the parts list in memory from cached
properties and compares it to existing parts list data. If there are differences, the
parts list becomes out-of-date.

Also, if mass is included in the parts list, the software uses the geometric time stamp
of the model references to determine whether the parts list is out-of-date. This
out-of-date check occurs during document transition (for example, when you open
or save a file), during parts list updates, and when a drawing view using the same
assembly the parts list references is created, updated, or deleted.

Creating a custom table style

You can use the Style command to create your own, fully customized Table styles
for parts lists. For example, you can define line color for the table border, grid, and
heading dividers.

When you place a parts list on the drawing, you can select a custom table style using
the Table Style list on the Parts List command bar.

For more information, see these Help topics:

• Table styles

• Create or modify a table style

Exploded parts lists

You can use the Parts List command and options in the Parts List Properties dialog
box to define and place an exploded parts list on an assembly drawing.

Use the General page (or the Parts List command bar) to:

• Select the default Solid Edge Exploded parts list style from the Saved Settings
list.

• Define a custom exploded parts list style.

Use the Options page to:

• Show the item numbers that were created in the assembly.

Using item numbers from the model ensures the parts list item numbers do not
change unless the model does. Otherwise, item numbers are generated on-the-fly
by the Parts List command.

Note

You can use the assembly model item numbers when the Maintain item
numbers check box is selected in the assembly document on the Item
Numbers page, Solid Edge Options dialog box. To learn more, see Help
topic Item numbers in assemblies.

Use the List Control page to:

• Display subassemblies and subassembly parts in an exploded parts list.

9-356 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

• Choose the item numbering format:

o Level based item numbers, which indicate the hierarchy of an exploded parts
list.

o Flat list item numbers.

• Show the top level assembly in a row by itself.

Use the Columns page to:

• Select and format the Item Number data column.

• Select additional data columns—Mass (Item), Mass (Quantity), Miter Cut 1,
and Miter Cut 2—when generating parts lists for assembly models containing
frames, pipes, or tubes.

• Indent the item numbers or the content of any column.

Use the Sorting page to:

• Sort the item numbers in the same order that they are shown in Assembly
PathFinder.

Note

Unless the assembly has been saved in V17 or later, the parts list order
may not match the Assembly PathFinder order.

Using the Columns tab

You can use the Columns tab on the Properties dialog box to add columns to a parts
list or bend table, and to define and format column headings.

Defining column content

You define the column content by selecting the type of property you want to extract
to display in it. You can combine multiple properties in each column, and you can
add simple text strings to any column.

• Parts lists—You can choose a predefined parts list-specific property, such as Item
Number, Quantity, Cut Length, Total Length, Mass (Item), Mass (Quantity) and
miter angle (Miter Cut 1, Miter Cut 2).

Column totals are computed automatically when you use the Mass (Item) and
Mass (Quantity) columns.

• Bend tables—You can choose any predefined property in the sheet metal bend
table to add to, or remove from, the drawing bend table. These include properties
for Sequence, Radius, Included Angle, (outside) Angle, Direction, and Feature.

• You can choose from any of the other file properties, such as Material, Volume,
Density, Status, Document Number, and Company.

• You can add columns for special properties that are defined on the Custom tab in
the File Properties dialog box in the part and sheet metal documents.
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On the Columns tab in the Parts List Properties dialog box, you can find these
properties in the Properties list, and you can insert a column for each special
property.

• You can create user defined columns by selecting the User Defined property.

Note

You also can add user-defined rows and columns on the Data tab.

• You can add simple text to the property strings in the column definition. The
text is displayed in the parts list along with the property text derived values.

Creating a custom column definition

A custom column is one for which you specify the content you want to see. You
can add a custom column for:

• User-defined information created in the draft document.

• Custom properties defined on the Custom tab in the File Properties dialog box in
model documents.

There are two things you need to do to create a custom column definition.

1. Add the column to the table—Use the Add Column button and select the User
Defined property or any custom property to add it to the table.

2. Define the column content—When the new column is highlighted in the Columns
list, its property text code is displayed in the Property text box. You can select a
property from the Properties list, and then select the Add Property button to add
its corresponding property text code to define the column content.

• If you added a custom property column, for example, Part Type, its property
text code is displayed as %{Part Type/CP|G}. The values defined for the Part
Type property in the model documents are extracted and displayed in the
Part Type column in the draft document.

• If you added a User Defined column, however, the Property text box is blank.
The content definition is based solely on the properties that you add from the
Properties list, or the text that you type in the Property text box.

You can select one or more types of data that you want to appear in this column.
If you select multiple properties, they are added in the order that they are
selected. When the information is extracted into the table cell, it appears in the
order that the property text codes are added.

You also can:

• Add formatting to the property text string using the space bar and the Enter
key.

• Control the display order of extracted information by the order that you
choose the property text.
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• Type directly in the box to add special characters or any other fixed
information that you want to appear in each cell in the custom column. For
more information about property text, see the following help topics:

o Basic property text rules

o Format codes to modify property text output

Formatting columns

You can specify all column formatting on the Columns tab and using the Format
Table Cells dialog box. This includes column width and alignment, column heading
position and alignment, and column heading text. For example, you can specify that
column headings are centered but column data is left- or right-justified.

You can save all content and formatting specification settings on the Parts List
Properties dialog box to be reused with another model. To save your parts list
format, use the Save Settings options on the General tab of the dialog box.

Defining column order

The Move Up and Move Down buttons control the order in which the columns are
displayed in the table or parts list. The column at the top of the list appears first; the
column at the end of the list appears last.

You can control whether new columns are added to the right or left side of the table
using the Page Anchor Point setting on the General tab of the Properties dialog box.
For example, if the anchor point is bottom-right, then columns are added to the
left side of the table. If the anchor point is top-left, then columns are added to the
right side of the table.

Modifying individual columns

Once the table is placed on the drawing, you can select a column to change its format.
Use the buttons on the Data tab to add user defined columns and rows, delete
columns and rows, and edit the content and formatting of individual data cells.

• To learn how you can use the Format Column dialog box and the Format Table
Cells dialog box to customize the appearance of the header rows and data cells,
see the Help topic, Formatting columns and data cells.

• To learn how you can insert or delete columns and rows, move rows, drag
columns from one location to another, see the Help topic, Make changes to a
table or parts list.

Using the Options page

The Options page in the Parts List Properties dialog box consolidates parts
list-specific content selection properties in one location. It is where you specify item
numbers, component types, and whether to generate a total length parts list.

Formatting item numbers

All properties that pertain to item number formatting are specified on the Options
tab. You can:
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• Specify whether item numbers are derived from the assembly and maintained by
the assembly, or whether item numbers are generated on-the-fly by the Parts
List command. If items numbers are not derived from the assembly, you can use
the Item Number tab to edit the item numbers from within the parts list.

Tip

You can use the Assembly Order sorting criteria on the Sorting page to
display the column data in the same order as the Assembly PathFinder.

• Specify the starting item number.

• Specify the number to increment by.

• Specify whether to mark items that do not have balloons, and what identifying
string to use. The default mark is an asterisk (*).

• Specify if the parts list is renumbered by changing the sort order.

Note

The Maintain item numbers check box on the Item Numbers page (Solid Edge
Options dialog box) in the assembly document controls whether item numbers
are created in the assembly.

Selecting component types

You can include and exclude component types on the parts list—parts, pipes, pipe
fittings, and frame members—and you can use the Move Up and Move Down buttons
to change the component type display order.

You can sort the parts list by component type when you select the Component
Type Order option on the Sorting page. You also can change the display order
of information derived from the model document properties. Examples of these
properties include file name, item number, quantity, material type, and material
properties.
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Specifying a total length or cut length parts list
A total length parts list shows all pipes and frame members derived from the same
component displayed as a total length on the same row.

A cut length parts list (A) shows each frame member or pipe that is a different
length displayed on a different row.

Note

Cut length can be synchronized with Teamcenter. The value appears as a Note
in Product Structure Editor.

It is easy to generate either type of parts list for pipes and frames. See the Help
topic, Create a total length parts list.
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Balloons

Many companies include parts lists in their assembly drawings to give additional
information about individual assembly components. For example, part number,
material, and the quantity of parts required are typically documented in a parts list.

You can add balloons to the drawing, and the balloons can be numbered to correspond
to the part entries in a parts list.

Balloons also can display property text extracted from a source file.

Automatic balloons on a part view

You can automatically add balloons to a part view of an assembly based on its parts
list when you choose the Parts List command and set the Auto-Balloon option on the
Parts List command bar.

When you select the part view that you want to balloon, the parts list and the
balloons that reference it are created automatically.

You also can create balloons automatically without placing a parts list. To learn how
to do this, see the Help topic, Automatically add balloons to a part view.
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Controlling duplicate balloons

You can specify varying levels of control for duplicate balloons using the Auto-Balloon
options on the Balloon page (Parts List Properties dialog box). For example, when
working with multiple drawing views, you can specify that no part item has more
than one balloon shown in the entire document, no matter how many drawing views
show the part.

Adjusting text size for automatic balloons

The appearance of automatically generated balloons is specified by options on the
Balloon page (Parts List Properties dialog box). Here, for example, you can adjust
the text size of the balloons before you add them to the drawing by typing a new
value in the Text Size box.

Balloon item numbers

You can specify that balloons in a part view of an assembly display item numbers
that reference the item numbers in a parts list.

• If you place the balloons before you create the parts list, the item numbers are
assigned sequentially in the order you select the parts.

• If you place the balloons after you create the parts list, the item numbers in the
balloons match the active parts list.

Note

There can be multiple parts lists on a drawing. The most recently created
parts list is the active parts list.

You can make a different parts list the active parts list by clicking Make
Active on the shortcut menu with the parts list selected.

To assign item numbers, use the Balloon command and set these options on the
Balloon command bar:

• Link To Parts List, which automatically generates balloons according to the
active parts list.

• Item Number, which automatically generates the balloon item numbers. If you
clear the Item Number option, then you can add the item numbers individually
to each balloon.

• Item Count, which adds the part quantity value to the bottom half of the balloon.

You can modify the balloon item numbers and the parts list at the same time.

• To edit the item number values in the parts list and in the balloons, use the Item
Number tab (Parts List Properties dialog box.

• To change the item number formatting, use the Options tab (Parts List
Properties dialog box.
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Balloons that reference property text

You can create balloons that reference property text information in a source
document. Some examples include project, part document number, material
specification, and revision.

To select the specific property text to be displayed in a new balloon, use the Property
Text button on the Balloon command bar to open the Select Property Text dialog box.

You can assign property text to different text locations in the balloon—(A), (B),
(C), and (D)—by adding the property text string into the Upper, Lower, Prefix, and
Suffix boxes on the Balloon command bar.

Note

To display property text at text location (A), you must clear the Item Number
option on the Balloon command bar.

To learn how to create or modify balloons so that they show a document number or
other document property, see Show document properties in balloons.

Stacking balloons

When multiple balloons reference items in the same parts list group, they often
overlap one another and it is difficult to see what the leaders are pointing to. The
parts that comprise a fastener group, for example—bolt, washer, lock washer and
nut—are small and close together. You can use the Automatically stack balloons in
the selected drawing view check box on the Balloon page (Parts List Properties
dialog box) to rearrange the fastener balloons into a stack, yet have each fastener
part retain its associativity. If a part item number changes, its balloon also updates.
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When balloons are stacked, they align vertically or horizontally, with a single leader
attached to the first balloon in the stack. This example shows a horizontal stack and
accompanying parts list. The first balloon is the one at right with the attached leader.

To learn how to arrange balloons in a stack automatically and manually, see the
Help topic Stack balloons.
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Balloon stack edit handles

You can use the following edit handles to manipulate a balloon stack. Balloon stacks
with break lines have four edit handles. Balloon stacks without break lines have
three edit handles.

A vertical balloon stack with an underline balloon shape and a break line has one
additional edit handle (E).

Handle location Purpose
(A)

Balloon stack edit
point

Changes the stack arrangement from horizontal to vertical,
or from vertical to horizontal.

(B)

Break line edit point

Lengthens or shortens the break line.

Flips the balloon stack and break line to the opposite side
of the leader.

For a stack without a leader, you can turn the break line on,
drag the stack, and then turn the break line off again.
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Handle location Purpose
(C)

Leader edit point

Moves the balloon stack freely by moving the break line and
changing the leader line length and orientation.

Inserting vertices adds edit points.

To learn how, see Move an annotation.
(D)

Annotation
connection point

Moves the start point of the leader along the annotated
element.

Pressing <Alt> disconnects the leader and removes
associativity.

Pressing <Alt+Ctrl> disconnects the leader, yet preserves
associativity.

To learn how, see Move an annotation.
(E) Only for a vertical balloon stack with an underline balloon

shape—Drags the vertical line on the stack to the opposite
side of the annotation.
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Center lines, center marks, and bolt hole circles

Center lines, center marks, and bolt hole circles are used in the Draft environment
to facilitate the dimensioning and annotation process. They are associative to the
elements they are added to in the 2D Model sheet, working sheet, or drawing view. If
the drawing view is modified, the center lines, center marks, and bolt hole circles
will update their position and size accordingly.

You can use the Angle Between command to add dimensions that reference these
annotations.

Adding center lines, center marks, and bolt hole circles

You can add a center line, center mark, or bolt hole circle annotation one annotation
at a time, or automatically add them to all part views on the drawing sheet. For
center lines and center marks, you can fence-select a group of elements to add
them to.

The commands to add these annotations are located on the Home tab®Annotation
group.

Automatic Center Lines command, for part views only, provides access to
command bar functions that automatically add and remove both center lines
and center marks.

Center Line command adds individual center lines.

Center Mark command adds center marks to one or more curved elements,
such as circles, arcs, ellipses, or partial ellipses.

Bolt Hole Circle command
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Modifying center lines, center marks, and bolt hole circles

You can change the appearance of an existing center mark, line, or bolt hole circle by
changing its properties. Select the annotation and then use the Properties command
on the shortcut menu.

Any of these annotations can be removed individually using the Delete command on
the annotation shortcut menu.

Center lines and marks that were added automatically with the Automatic Center
Lines command can be removed as a group by setting the Remove Lines and Marks

button on the Automatic Center Lines command bar.

Reattaching detached annotations

When center lines, center marks, and bolt hole circles become detached due to
changes in the model or drawing view update, they are displayed using the Error
Dimension color set on the General page (Dimension Style dialog box). They also are
identified in the Dimension Tracker dialog box.

You can reattach the annotations using the attachment handles that are visible when
you select them. When reattached, they display using the Driven Dimension color.

Geometric tolerancing

Geometric tolerancing is a form of annotation that you can use to provide additional
information about the features of a part. While dimensions and their associated
tolerances give information about the acceptable variation in the size or location of
a feature on a part, geometric tolerancing establishes the relationships between
features on a part. For example, you can define the tolerance for the position of a
hole in a part in relation to other features, or datums, on the part.

In the Draft environment, you can define the geometric tolerances with the following
commands:

• The Feature Control Frame command specifies the necessary tolerance on a
feature in relation to reference letters for other features of a part, called datums.

• You can identify the datums on your part using the Datum Frame command.

• You can specify datum points, lines, planes, or areas for special function or
manufacturing and inspection using the Datum Frame command.

Note

Solid Edge supports the ASME Y14.5-2009 ANSI and ISO drafting standards
for geometric dimensioning and tolerance callouts. The between and statistical
tolerance symbols are supported in the TrueType symbol fonts.
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Feature control frames

A feature control frame is composed of two or more rectangular compartments that
contain information about tolerances. The first block always contains a geometric
characteristic symbol. Subsequent compartments contain tolerance values and
symbols representing part variations, such as maximum material condition. You
can create the feature control frame by typing text and selecting symbols from
a dialog box.

You can refer to up to four datums in a feature control frame.

A feature control frame has the following parts:

(A) Geometric characteristic symbol
(B) Tolerance
(C) Datum reference
(D) Tolerance zone symbol
(E) Tolerance value
(F Material condition symbol

A valid feature control frame must contain these two components:

• Geometric characteristic symbol

• Tolerance

Some geometric characteristics also require a reference to a datum in the feature
control frame. You can apply material conditions to the tolerance and datum
references. You can also apply a diametrical tolerance zone to the tolerance.

Manipulating feature control frames

Feature control frame edit handles

After you place a feature control frame, you can use the annotation edit handles
to adjust its position and orientation.

9-370 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

Feature control frame edit handles
Location Purpose
(A)

Annotation
connection point

Moves the start point of the leader along the annotated element.

Pressing the Alt key disconnects the leader and removes associativity.

Pressing the Alt+Ctrl keys disconnects the leader, yet preserves associativity.

To learn how, see Move an annotation.
(B)

Leader edit point

Moves the feature control frame freely by editing the leader line.

Changes the leader line length and orientation.

Note

Break line length and orientation are not affected.

Inserting vertices into the leader line adds edit points. To learn how, see Move
an annotation.

(C)

Leader attachment
point

Dragging point (C):

• Lengthens or shortens the break line.

• Flips the feature control frame and break line to the opposite side of the
leader.

• If no break line is used, flips the feature control frame in 90, 180, and 270
degree increments with respect to the entity it references.

Feature control frame snap points

You can change the leader line attachment point using snap points displayed on the
feature control frame. Pressing Alt while dragging the point (C) displays the snap
points so you can connect to them.
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Feature control frame snap points
Location Purpose
Alt+drag (C)

Leader attachment
point

Pressing Alt while dragging point (C):

• Displays the available leader snap points (see D, below).

• Changes the connection point of the leader to the feature control frame.
(D)

Snap points

Pressing Alt while dragging the point (C) displays the following snap points:

• With a break line, eight points are visible along the frame perimeter.

• Without a break line, one additional point is visible at the center of
the frame.

Engineering fonts

The engineering fonts delivered with the software contain industry-specific fonts,
special characters, and symbols that you can use to annotate engineering drawings.
These fonts include degree symbols, diameter symbols, and other special characters
and symbols that are not usually included in a typical word processing package.

Your choice of font should be based on the industry for which you are creating
engineering drawings.

The software provides TrueType fonts; with TrueType fonts, what you see on the
screen is what appears on the printed page. The screen display of the document
closely matches the printed document.
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Product Manufacturing Information (PMI)

PMI overview

Product Manufacturing Information, or PMI, consists of dimensions and annotations
that are added to the 3D model and can be used in the review, manufacturing, and
inspection processes.

In synchronous and ordered modeling, PMI dimensions also provide an important
design modification tool. By editing dimension values you can make changes to
the model. You can lock and unlock dimensions to control how connected model
faces respond to dimension value edits. And you can control the direction in which
dimension edits are applied. This greatly simplifies the process of design, testing,
and update.

The Solid Edge PMI application combines the functionality of adding dimensions
and annotations, generating fully rendered 3D model views with 3D section views,
drawing formatting, and publishing the information.

You can add these types of PMI:

• Dimensions—Smart Dimension, Distance Between, Angle Between, Coordinate
Dimension, Angular Coordinate Dimension, Symmetric Dimension.

• Annotations—Leader, Balloon, Callout, Surface Texture Symbol, Weld Symbol,
Edge Condition, Feature Control Frame, Datum Frame, Datum Target.

For more information about adding these PMI elements, see the Help topic, PMI
dimensions and annotations.
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You can create these types of views:

• 3D section views, which can be added to or removed from,

• 3D model views

Note

• The dimensions you add using the ordered PMI dimensioning commands
are always driven dimensions.

• You can choose whether a synchronous PMI dimension added to the model
should be locked or unlocked.

• The section views and model views are associative to the 3D model. When
the 3D model changes, the section views and model views also update.

PMI commands

The PMI tab conveniently groups the commands you need to:

• Add PMI dimensions and annotations directly in the 3D model.

• In the ordered environment, copy 2D dimensions and annotations from a sketch
to the PMI 3D model.

• Create model and section views of the 3D model.

In the synchronous environment, you also can use dimension and annotation
commands located on any other tabs on the ribbon to add PMI to the model, as
well as to dimension sketches. It is the type of element you select (model edge or
sketch geometry), not the command, that determines whether a dimension is a
three-dimensional PMI dimension or a two-dimensional sketch dimension.

For information about using PMI commands, see the Help topic, Working with 3D
PMI.

PathFinder, PMI, and model views

PathFinder accesses and controls all PMI elements and 3D model views for the
model. If a sheet metal model has two different states, designed and flattened, for
example, then the PMI and model views are owned by the model state in which
they are created.

• The PMI collection located on PathFinder contains expandable sub-collections of
all Dimensions, Annotations, and Model Views in the active document.
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• If the PMI collection is empty, then it is not displayed in PathFinder.

• When you define a PMI model view, its name is added to the Model Views
collection.

• A separate Section Views collection, located in PathFinder above the PMI
collection, contains all 3D section views that have been defined in the document.

• PMI elements and section views can appear multiple times in PathFinder. When
one of these items is selected, all occurrences of the item are selected.

This table explains the PMI-related icons used in PathFinder.

A node is the top-level entry in a PMI collection or in a sub-collection under a
defined model view.
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Legend
PMI collection symbol
Dimension node, shown (in PMI or Model Views collection)

Dimension node, hidden (in PMI or Model Views collection)
PMI dimension element, shown
PMI dimension locked (synchronous)
PMI dimension element, hidden
Annotation node, shown (in PMI or Model Views collection)

Annotation node, hidden (in PMI or Model Views collection)
PMI annotation element (callout symbol example), shown
PMI annotation element (callout symbol example), hidden
Model Views collection
Defined model view
Section Views collection

Section view, applied
Section view, not applied

Note

• The check box in front of each PMI element listed in PathFinder turns
the element on and off. There are also Show, Hide, Show All, and Hide
All commands on the shortcut menu for each group of Dimensions and
Annotations.

• Model views are not shown or hidden, but instead they are applied to the
graphic window using the Apply View command.

• Defined 3D sections are applied and removed using the Apply Cut
command.
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The following image and corresponding table explain the color codes assigned to
dimensions.

PMI dimension color codes
Color Solve condition Dynamic Edit? Attached to

Blue Free Yes Synchronous
elements

Red Locked, dimension
constrained. Yes Synchronous

elements

Purple Driven by other dimension or
variable No.

Ordered elements or
otherwise uneditable
PMI

Brown Not available No
Not adequately
attached to any
element
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Within the PMI collection, different types of dimensions—for example, linear, radial,
angular—display unique symbols and element names on PathFinder. Also, their
respective color code is displayed.

Annotations work the same way, with their own set of symbols and specific naming
conventions.

To learn more about showing and hiding PMI elements, see the Help topic, Working
with 3D PMI.

Reviewing a PMI model

A special PMI model review mode allows you to review all of the model views defined
in the document along with their associated PMI data. You may want to use this
feature before exporting PMI models and data to View and Markup, for example.

When you select the Review Command (PMI Model Views), a PMI Model Review
command bar is displayed to guide you through the review of each model view.

For more information, see the Help topic, Creating 3D model views with PMI.

Sharing a PMI model

There are many ways you can share 3D models and their attached data.

• Use the Create Drawing command to generate a drawing of the dimensioned
model currently displayed in the graphics window. You also can use the Create
Drawing command to generate a drawing of any model view “snapshots” you
have created in the document.

• Use the Apply View command to display a model view with a special orientation
in the graphics window, and then use the Print command to print it.

• Use the Save As Image command on the Application menu to save the contents
of the graphic window in an image file format.
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• Publish them to a format compatible with View and Markup using the Send PMI
to View and Markup command. This will save the file in .pcf format, making it
available to View and Markup.

• Publish them to Solid Edge Viewer using the Save As command to save the
information to .jt format.

Creating drawings of a PMI model

You can use the Drawing View Wizard to produce drawings from a 3D model
with PMI. The data in the model views—view orientation, 3D sections, and PMI
dimensions and annotations—are copied to the drawing view. The PMI text copied
to the drawing retains its three-dimensional aspect.

There are two basic ways to do this:

• You can generate the drawing from the current model representation in the
graphics window.

• You can generate drawings from alternate model views that you have created
using the View command. Model views allow you to apply special formatting,
backgrounds, and view orientations to your model.

Once you have copied one or more PMI model views to the drawing, you can:

• Turn associativity with the model view on and off.

• Change the PMI model view currently displayed in the drawing view.

• Choose a different render mode—including color shading—for each of the model
views on the drawing.

For more information, see the Help topic, Create a PMI drawing.

Working with 3D PMI

Model view creation workflow

PMI model view creation is WYSIWYG. The model orientation, render mode,
annotations, and dimensions that are visible in the graphics window when you select
the Model View command are what you get when the PMI model view is created.

Note

Models in an assembly must be activated before PMI can be added to them.

1. Set a PMI dimension and annotation plane. In the ordered environment, use
the Lock Dimension Plane command on the PMI toolbar to set an active 3D
dimension and annotation plane. Annotations and dimensions are placed
parallel to this plane. You can change this dimension plane at any time while
adding annotations and dimensions.

2. Add PMI dimensions and annotations. In the synchronous environment,
sketch dimensions migrate automatically to the 3D model when you extrude a
sketch region or use another command that converts the 2D region to a 3D solid.
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You also can add new PMI annotations and dimensions directly to the model
using the commands on the PMI tab.

See these Help topics for more information:

• Part Modeling workflow overview

• PMI dimensions and annotations

3. Add PMI dimensions and annotations. In the ordered environment, you can
use the Copy To PMI command to copy 2D dimensions and annotations from
a feature or sketch to the 3D model. You can edit the copied elements using
the commands on their shortcut menu. You can add new PMI annotations and
dimensions using the commands on the PMI tab.

To learn more about PMI dimensions and annotations, see the Help topic, PMI
dimensions and annotations.

4. Choose a view orientation for the model view using standard rotation, view
selection, and zoom commands.

5. Create a PMI model view. Use the PMI tab®Model Views group®View
command to capture all of this display information, assign a view name and
render mode, and save the view. It adds the view name to the “Model Views”
collection on PathFinder. All of the dimensions and annotations associated with
the model view are listed under the model view name.

To learn more about PMI model views, see the Help topic, Creating 3D model
views with PMI.

6. Modify the model view. If necessary, change the model orientation and
display settings.

You can hide PMI elements that interfere with the view.

Use the Edit Definition command on the model view shortcut menu to:

• Change the model view name and definition using the Options button on the
Edit Definition command bar.

• Make changes to the display of parts and subassemblies in the view using
the Model View Display group button on command bar.

• Add and edit dimensions and annotations in the model view using the Model
View Display group button on command bar.

To learn how, see the Help topic, Edit a PMI model view definition.

7. Create additional model views. Use the Model View command to capture
a new orientation and display mode for corresponding PMI. Assign a different
name to this view, and choose a render mode as desired. If you change the render
mode, use the Apply View command on the PathFinder shortcut menu to apply
the view settings to the graphic display.

8. Review. Use the Review command for a graphical tour of all PMI model views.

9. Export and publish the model view. Use the Send PMI To View and Markup
command to publish your PMI model views and open them in View and Markup.
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To learn more about publishing PMI models, see the Help topic, Publishing
Product Manufacturing Information (PMI) and Model Views to View and
Markup.

Adding a 3D section view to a model view

Within the context of the PMI workflow, any 3D sections applied at the time of model
view creation are automatically included in the model view, but you can also add or
remove sections after the model view is created.

1. Set the section view display properties.

2. Display or hide the cutting plane.

3. Add the section to the model view.

For more information about using section views in PMI model views, see the Help
topic, Use a 3D section view in a PMI model view.

Model view editing commands

The commands you use to edit the definition and properties of a 3D model view are
located on the shortcut menu of the selected model view on PathFinder. For example,
the shortcut menu to manipulate model views contains these commands:

To learn how to use these commands to manipulate PMI model views, see the Help
topic, Manipulate a PMI Model View.
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PMI element editing commands
The commands you use to add PMI elements to 3D model views, remove PMI
elements from 3D model views, and show and hide PMI elements are also located on
the shortcut menu of a selected dimension or annotation in PathFinder:

To learn how to use the commands to manipulate PMI elements, see the Help topic,
Display and edit PMI elements.
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Whether PMI elements are visible or not is controlled by the check box preceding
an element or node name, and by the Show and Hide commands on the shortcut
menu.

Showing and hiding nodes and elements
When you point to the top level of a Dimensions or Annotations collection, the
Show command acts as a gatekeeper for the individual PMI elements in that
collection.

• If you select Hide while pointing to the Dimensions or Annotations node,
then all the dimensions and annotations in the collection are immediately
turned off in the display.

Note

Individual elements can only be made visible if the node is also set
to be shown.

• If you select Show while pointing to the Dimensions or Annotations node,
then the dimensions and annotations in the collection can be shown,
depending upon their individual show/hide settings.

Tip

You can edit a model part or feature without the clutter of PMI annotations
and dimensions. Use the Hide command to temporarily remove the
annotations and dimensions; use the Show command to restore them.

If you set or clear the check box in front of an individual PMI element in any
collection, then all instances of this PMI element are shown or hidden in the
document.

See the Display and edit PMI elements section in the Product Manufacturing
Information (PMI) overview Help topic for a table that illustrates the show and
hide states of PMI-related icons.

Show or hide in a model view
If you select Hide while editing a model view, then elements that are hidden when
you exit edit mode are removed from that model view’s list of collected elements.

Show All and Hide All
The Show All and Hide All commands for a node are a fast way to turn on or off
all of the individual dimensions or annotations in the document.

PMI dimensions and annotations

Creating PMI elements

Annotations and dimensions placed on model geometry are PMI elements. They
are created in two ways.

• When you use a sketch to construct a feature, the dimensions placed on the
sketch migrate to the appropriate edges on the solid body. These migrated
dimensions become three-dimensional, PMI dimensions. See the Help topic,
Create a dimensioned part from a sketch.
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Annotations placed on a sketch also are copied to the model.

• You can place dimensions and annotations directly on model edges at any time
using any of the commands on the ribbon. In addition, the tool set on the PMI
tab conveniently groups all PMI-related functions together in one place.

Note

The commands you use to place dimensions and annotations on sketches and
on the model are the same. However, dimensions and annotations placed on
2D sketch elements and those placed on 3D model elements behave differently.
The differences are most apparent during editing.

Locked and unlocked PMI dimensions

In synchronous models, you can use PMI dimensions to modify the model. You
control the effect of model changes by choosing whether a dimension on a model edge
is locked or unlocked, and by specifying the direction of change.

• An unlocked dimension means that when faces connected to the dimensioned
edge are modified, the dimension value is allowed to change. The default color of
an unlocked dimension is blue.

• A locked dimension keeps the dimension value from being changed when a
connected face is moved or resized.

A dimension must be locked before a formula or variable rule can be applied
to the dimension.

The default display color of a locked dimension is red.

In PathFinder, a locked dimension is easily identified by the lock icon .

Note

All 2D dimensions that migrate from sketches are locked.

9-384 Solid Edge fundamentals mt01413-s-1050



Creating detailed drawings

You can edit individual dimensions to lock and unlock them, as needed to modify
the model. Use the lock button on the Dimension Value Edit dialog box to change
a dimension from unlocked to locked.

If the Lock button is not available, select the Maintain Relationships command.

Note

Dimension locking rules

• It is better to leave dimensions unlocked, only locking values as necessary
for a particular edit. When you edit the model, the edit is automatically
localized, leaving uninvolved dimensions unchanged.

• in synchronous modeling, a PMI dimension must be locked before it can be
driven by a formula or be used in a formula. Similarly, you cannot unlock
a dimension that is controlled by a formula or is used within the formula
of another dimension or variable.

To learn how you can modify a model by editing dimension values, see the Help
topic, Editing model dimensions.

PMI dimension colors

The following table explains the color codes assigned to dimensions.
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PMI dimension color codes
Color Solve condition Dynamic Edit? Attached to

Blue Free Yes Synchronous
elements

Red Locked, dimension
constrained. Yes Synchronous

elements

Purple Driven by other dimension or
variable No.

Ordered elements or
otherwise uneditable
PMI

Brown Not available No
Not adequately
attached to any
element

PMI dimension edit cursors

As you move the Select cursor over a dimension, it indicates the type of operation
that is available if you click at that location:

PMI dimension edit cursors
Cursor
imageOperation

When is it
displayed? Example

Edit the
dimension
value.

Cursor is
over the
dimension
text.

Drag a
terminator
inside or
outside the
extension
lines.

Cursor
is over a
dimension
terminator.

Modify the
dimension
properties.

Cursor
is over a
dimension
line or
extension
line.
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PMI dimension modification handles

There are two types of dimension modification handles: a value edit handle and
formatting handles.

Dimension value edit handle

• A PMI dimension value edit handle is displayed when you click the dimension
text. The dimension value edit handle consists of a Dimension Value Edit dialog
box (1) and 3D arrow and sphere terminators (2).

o The dialog box is where you enter or edit the value.

o You control the direction in which the edit is applied by clicking the arrow
buttons on the dialog box or by clicking either of the 3D terminators.

The 3D sphere terminator indicates the stationary side.

The default direction is indicated by the highlighted arrow button on the
dialog box and by the 3D arrow terminator. A dimensional edit equal in
both directions is indicated by the highlighted symmetric button and
both 3D arrow terminators.

Sometimes the 3D terminators are more explicit, as shown in the
following example.
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To learn how to use the dimension value edit handle, see the Help topic,
Resize the model by editing PMI dimension values.

• If the Dimension Value Edit dialog box is completely disabled, it means the
dimension cannot be edited in its current state.

Dimension formatting handles

• You can change the dimension format using these handles:

o The Edit Definition command bar and dimension formatting handles are
displayed when you click a dimension line or extension line.

You can use the options on the Edit Definition command bar to modify
the dimension properties, including tolerance, prefix, and orientation.

The filled circles are format handles you can drag to change the length of
the dimension line and extension lines.

o When you click a dimension terminator, such as an arrow, you can drag it
outside or inside the extension lines.

To learn how you can show and hide, edit, and manipulate PMI elements, see the
Help topic, Display and edit PMI elements.

Not-to-scale dimensions

You can override the value of a driven dimension by right-clicking on the dimension
and selecting Not to Scale from the context menu. Solid Edge underlines the values
of not-to-scale dimensions.

The not-to-scale designation appears in the dimension value edit dialog box.
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Preselection preview

When you place your cursor on a dimension value, you see two preselection preview
features that show you how a dimension value edit will be applied: direction of
edit and model face selection.

Direction preview

• Where you place your cursor prior to selecting the dimension text influences the
direction in which the edit will be applied.

o If you place the cursor on the left side of the dimension value, in this
example the number 4, then the direction arrow points left. If you select the
dimension value by clicking here, the edit will be applied in this direction.

o If you place the cursor on the right side of the dimension value, in this
example the number 5, then the direction arrow will point right. If you select
the dimension value by clicking here, the edit will be applied in this direction.

Face selection preview

You can preview what model faces will be affected when you edit a dimension
value, by pointing to the dimension text without selecting it. The related model
faces are highlighted for you to review them.

To change the selection set, you can set and clear relationships on the Live Rules
options window.
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You also can affect the outcome by changing the solve option on the Dimension
Edit QuickBar.

To learn more, see these Help topics:

• Working with Live Rules

• Select faces to be modified by PMI dimension edits

Using keypoints

When placing PMI model dimensions that you want to use to change the model, you

can use the 3D keypoint filter, Center And Endpoints and Midpoint . This
ensures that dimensions are placed on keypoints that are valid for modifying the
model. These keypoints are at the centers of circles and arcs and at the midpoints
and endpoints of edges.

Note

The Center and Endpoints, and Midpoint filters use virtual vertices to derive
the appropriate keypoint.

To use either of these keypoint filters during dimension placement, select the
Keypoints button on the Dimension command bar, under the Other group button.
Then select the desired filter.

Using a dimension plane

When you add PMI dimensions and annotations to a model, they are aligned parallel
to a dimension plane. The default plane is the base plane most parallel to the
screen. However, you can choose a different plane using the Lock Dimension Plane
option on the command bar. This option is available when you have selected
a dimension or annotation command.

Only planes you set explicitly appear in the graphics window. These are displayed in
red-brown half-highlight.
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To turn off a dimension plane you have set, press F3.

Using intersection points

You can use a model intersection point to place a PMI dimension. Using an
intersection point:

• Makes it easy to add a dimension to a model edge that has been rounded, split,
or trimmed.

• Helps the dimension rebind to the original endpoints when the model edge is
rounded, split, or trimmed.

Solid Edge automatically detects the presence of intersection points. You can use the
intersection point method when placing any dimension.

Note

To turn off Intersection Point mode, select a dimension command and press
the I key.

Example

Following are some examples of when you might want to place dimensions
using intersection points.

Edge modified by rounding
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Edge modified by trimming

Edge modified by splitting

You also can use QuickPick to locate all intersection points—not just the
least-distance default—as shown in the following example:

You also can place a dimension using the intersection point of a virtual centerline
and the surface of a cylindrical or conical object, including canted, toroid, spherical,
and splined shapes. These intersection points are available on demand, without
having to invoke Intersection Point mode.

To learn how to use this feature, see the Help topic, Place a PMI dimension using an
intersection point.

Using a dimension axis

Sometimes you need to add a PMI element that measures along an axis that is
not orthogonal to the object you are dimensioning. This may be the case when you
use the Distance Between, Angle Between, Coordinate Dimension, or Symmetric
Diameter command.

When one of these dimension commands is in progress, you can use the Dimension
Axis option under the Properties group button on the Dimension command bar to
set the dimension axis.
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Adding PMI dimensions

You can use the Smart Dimension command to dimension circles, arcs, and ellipses
as well as linear elements.

When adding a dimension that requires two points:
• The first click determines the point to measure from.

• The second click specifies the point or element to measure to.

Dimension stacking and chaining
• Linear dimensions can be stacked or chained using the Distance Between
command.

• Angular dimensions can be stacked or chained using the Angle Between
command.

• Symmetric diameter dimensions can form a stack, not a chain.

• All dimensions in a stack or chain must be placed with respect to the same
active dimension plane.

• Each stacked or chained dimension has its own entry on PathFinder.

Adding PMI annotations

• You can place annotations in free space.

• You can attach annotations to model faces, surfaces, curves, edges, and sketch
elements.

• You can attach annotations to existing dimensions and annotations.
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Here, the datum annotation is attached to an existing feature control frame.

They also can connect to faces.

Modifying PMI format and properties

You can select and modify individual PMI elements by doing any of the following:

• When the dimension format handles are displayed, you can:
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o Modify PMI dimension round-off, dimension type, tolerance, and prefix for
the selected element, using the options on the command bar.

o Change the length of the dimension lines and dimension extension lines by
selecting and dragging a red dot. You also can select and drag a dimension
arrow outside the extension lines.

• Use the Properties button on the command bar or the Properties command on
the shortcut menu to change formatting properties for font size, terminator type,
extension line type, coordinate display, and more.

o If you select a dimension, then the Dimension Properties dialog box is
displayed.

o If you select an annotation, then the annotation-specific dialog box is
displayed.

You can make changes that affect all PMI elements at once:

• You can make interactive adjustments to PMI text size so it is easier to read
when you zoom in and out of the model.

• You can change PMI element color globally by modifying the style.

To learn more, see the Help topic, PMI text size and color.

Moving a PMI element

There are several ways you can move PMI elements.

• You can move a PMI dimension or annotation using the Move Dimension
command. This moves PMI elements in a direction that is normal to the plane
where they reside, adding extension lines as needed.

• Placing your cursor on a PMI element and then dragging it moves the element
within the plane where it resides. The element moves in different ways
depending upon what part of the element you drag and whether you use the
formatting handles.
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• You also can use Alt+drag to detach a PMI dimension or annotation from one
model element and attach it to a different model element. To learn how, see
Reattach or move a dimension or annotation.

If you move an annotation that is attached to another PMI element—including
stacked and chained dimensions—they move together.

Moving an annotation connected directly to a face results in translation along the
face only, not off it.

To learn how to move and manipulate PMI dimensions and annotations, see the
Help topic,Move PMI elements.

Using property text in PMI elements

You can extract and use property text in PMI dimensions and in callout and balloon
annotations.

• To use property text in callouts and balloons, select the Property Text button

on the annotation dialog box.

• To use property text in a dimension prefix, suffix, subfix, or superfix, copy and
paste the property text string into the corresponding text box in the Dimension
Prefix dialog box. You can open the Dimension Prefix dialog box by clicking the

Prefix button on the Dimension command bar.
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• To extract hole information from hole features in a part or assembly, use the Hole
Reference, Smart Depth, or Hole callout property text strings.

• You can extract bend information—Angle, Radius, and Direction—from a formed
part, but not from a flat pattern.

• To update property text in PMI elements, use the PMI tab®Property Text
group®Update All command.

• To convert property text strings to plain text for individual annotations and
dimensions, use the Convert Property Text command on the selected element
shortcut menu.

• To convert all strings in the document, you can use the PMI tab®Property Text
group®Convert All command.

To learn more about property text, see the Help topic, Using property text.

PMI text size and color

Setting PMI text size
There are several ways to change the text size of PMI elements.

• Change all PMI elements and associated graphics (lines, leaders, and arrows) at
once, using either of the following methods:

o Automatically scale elements. When you use the active model style to
determine text size, PMI elements scale automatically as the view is zoomed
in and out. This sometimes results in PMI being too large or too small
relative to the feature or component.

o Change element size interactively. You can use the Increase PMI Font and
Decrease PMI Font buttons to change the size of PMI elements based on pixel
size. This has the advantage of letting you fine-tune the size interactively.

• Change the size of new elements by editing the style. You can set a default text
size for all new PMI elements on the Text page of the Modify Dimension Style

dialog box. You can access this dialog box using the Styles command .

• Change the size of individual PMI elements. You can override the default text
size for individually selected elements using the Properties command.

You can specify the break line length and the gap between the break line and the
PMI text on the Lines and Coordinates tab in the dimension style and in the
dimension properties.

To learn how to set and change PMI text size, see the Help topic, Change PMI text
size.

Setting global PMI color
PMI dimension color is an at-a-glance indicator as to whether a dimension is locked
or unlocked. You can change the global color setting for PMI dimensions. This also
changes the color of PMI annotations.
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You can change global PMI color settings on the Colors page of the Solid Edge
Options dialog box.

• The default color of unlocked PMI dimensions is blue. It is the same as that set
for all sketch elements. You can choose another color for them from the Sketch
list.

• The default color of locked PMI dimensions is red. It is the same as that set for
handle elements. You can choose another color for them from the Handle list.

You cannot change the color of individual PMI elements.

Creating 3D model views with PMI

Model views help you manage the display of a part, sheet metal, or assembly model
within the Product Manufacturing Information (PMI) workflow. You can define
different 3D views of the model to completely communicate design, manufacturing,
and functional information.

Model views can contain the following:

• Model state, for example, designed or flattened (synchronous).

• Ordered dimensions, including driving dimensions that have been copied to 3D.

• Synchronous dimensions

• Annotations

• Section views
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Once defined, you can select individual model views from the Model Views collection,
which is located under the PMI node on Pathfinder.

For review purposes, you can share the model view and data electronically using
View and Markup or Solid Edge Viewer.

Creating model views

The View command creates a 3D view of the assembly, part, or sheet metal model as
currently displayed in the graphics window.

• All dimensions, annotations, view settings, and section views that are displayed
when you create the model view are copied to the model view.

• Each model view definition includes a view name, orientation, scale, and view
extent (zoom).

• The Model View Options dialog box is where you assign initial values for view
name, render mode, and section view and cutting plane display. You can change
these settings by editing the model view definition.

• You access and control PMI model views using PathFinder.

• Each model view definition contains a specific list of PMI elements—types of
dimensions, annotations, and included section views—that are displayed when
the view is applied.
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Note

Showing or hiding these elements in one model view applies the show or
hide setting to the same elements in all model views.

For more information, see the Help topic, Working with 3D PMI.

Reviewing model views

You can review all of the model views defined in the document along with their
associated PMI data using a special PMI model review mode. You can use this
feature before exporting PMI models and data to View and Markup.

When you select a model view and choose the Review command on the shortcut
menu, a PMI Model View Review command bar is displayed to guide you through
the review of each model view.

• You can navigate through the PMI model views using these tools:

o Step through each view using the Next and Previous arrows.

o Jump to a specific model view by selecting its name from the Model View List.

• As you select each 3D model view, the active window temporarily changes to
display the view as it was defined. This includes its show and hide states and
section views that have been applied.

• When you close the review session, the graphics screen returns to its previous
display.

Another way to review the contents of a model view is to select the model view name
on PathFinder, and then select the Apply View command on its shortcut menu.

Adding 3D section views to model views

• The Section Views collection on PathFinder contains a list of all existing 3D
section views that have been defined for the model.

• You can add an existing 3D section view to a model view using the Add To Model
View command on its shortcut menu.

• Similarly, you can remove a section view from the model view you are editing
using the Remove From Model View command.
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Modifying a PMI model view
When you select the Edit Definition command on the model view’s shortcut menu,
the model view is displayed in a special edit environment. The Model View command
bar provides access to two levels of editing functions for the PMI model view.

• Using the Model View Options dialog box, you can change the view name, choose
a different rendering mode, and change the section view and cutting plane
display settings.

• Selecting the Model View Display group button places you in model view creation
and edit mode, where you can:

o Change the show or hide visibility and display properties of individual PMI
elements.

o Add new PMI annotations and dimensions to the model view.

Note

o While you are in this edit mode, you cannot use the modeling
commands.

o Except for view orientation and render mode, changes made in this
edit mode are WYSIWYG.

PMI elements and section views that are hidden are automatically
removed from the model view.

PMI elements and section views that are added and shown are
automatically added to the model view.

When you exit model view edit mode, your changes are applied to the model view
and the normal modeling commands are made available again.

Sending a PMI model view to View and Markup
You can share 3D model views containing PMI data by electronically publishing
them to a format compatible with View and Markup or Solid Edge Viewer.

• Use the Send PMI to View and Markup command to save the file in .pcf format,
which is opened in View and Markup.

• Alternatively, you can use the Save As command on the Application menu to save
the information to .jt format.

Note

The Send PMI to View and Markup command sends all the model views in
the file to View and Markup.

Publishing PMI and model views to View and Markup

To make Product Manufacturing Information, or PMI, and model views available
for display in View and Markup or Solid Edge Viewer, the information must be
published. You can publish the information with the Send PMI to View and Markup
command, or you can use the Save As command to save the information to .jt format.
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Using Send PMI To View and Markup
You can quickly publish information with the Send PMI To View and Markup
command, which is available on the shortcut menu when a model view is selected in
PathFinder. This sends all PMI data and model views defined in the active document
to a .pcf file. The file is opened automatically in View and Markup. Any PMI data
that is not associated with a model view is not displayed in the viewer.

Using Save As
To publish information with the Save As command, you must first set the Save PMI
Data option on the Solid Edge to JT Translation Options dialog box, and then save
the document to .jt format. All model views and PMI information associated with a
model view are saved to the .jt document.

Once saved, you can open the .jt document in the viewer. A list of the model views
and associated PMI information is displayed in the Model Views page on PathFinder.

Note

When the Save PMI Data option is selected, other jt save options are disabled
and the appropriate options are set to support PMI data. Precise geometry is
always sent when the Save PMI Data option is selected even if the Include
Precise Geometry option is not set.

Only graphic topology supported by the viewer is written to the.jt file. The following
items are controlled by model views, but are not written to the .jt file.

• Coordinate systems

• Reference planes

• Sketches and profiles

• References axis

• PMI section views

Property text codes

You can add symbols and reference data to annotation text and dimension text.
When a dialog box such as the Callout dialog box or the Dimension Prefix dialog box
provides buttons to do so, you can click the buttons to insert the symbols. In some
cases, when the dialog box does not provide a button interface to insert the symbol
directly, you can type a three-character symbol code instead.

For many types of annotations, such as text boxes, feature control frames, weld
symbols, and hole tables, as well as dimension text and drawing view captions, you
can avoid typing symbol codes using the Select Symbols and Values dialog box.

The following tables are organized by category:

• Symbols

• Values

The three-character code in the left-most column displays the corresponding symbol
shown in the right-most column, or it fetches the matching value from the model.
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The codes must be typed exactly as listed. They are valid for the Solid Edge ANSI
Symbol and Solid Edge ISO Symbol fonts.

Symbols

Geometric characteristic symbols
Code Represents Displays this symbol

%FL Flatness

%SR Straightness

%CI Circularity

%CY Cylindricity

%PP Perpendicularity

%AN Angularity

%PR Parallelism

%PS Profile of a Surface

%PL Profile of a Line

%CR Circular Runout

%TR Total Runout

%PO Position

%CO Concentricity

%SY Symmetry

Material condition symbols
Code Represents Displays this symbol

%MC Maximum

%LC Least

%SC Regardless of Feature Size

%RC Reciprocity Condition
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Tolerance zone symbols
Code Represents Displays this

%PZ Projected

%TZ Tangent Plane

%FZ Free State

%ER Envelope Requirement

%UD Profile Unequally Disposed

%IN Independency

%TL Translation
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Dimensioning symbols
Code Represents Displays this

%DI Diameter

%DG Degree

%BT Between

%ST Statistical Tolerance

%CF Continuous Feature

%SQ Square

%CB Counterbore

%SF Spotface

%CS Countersink

%DP Depth

%IL Initial Length

%AL Arc Length

%PM Plus Minus

%AN Taper Angle

%A2 Taper Angle 2

%A3 Taper Angle 3

%A4 Taper Angle 4

%SG Symmetric Taper Angle

%S2 Symmetric Taper Angle 2

%Gd

Note

The second letter is
lowercase.

Material Thickness
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GOST weld symbols
Code Represents Displays this

%FW Fillet Weld

%HW Heat

%HB Heat Back

%SW Smooth

%SB Smooth Back

%SN Stagger Chain

%SK Stagger Check

%UL Not All Around

%NU Number

%DA Diameter

%PN Plus Minus

%DR Degree

Other symbols
Code Represents Displays this

%CL Centerline

%PT Parting Line

%OV Oval

%RL Rectangle

%RA Rotated View (ESKD
standard)

%CA
Rotated View
Counterclockwise (GB
standard)

%C2 Rotated View Clockwise
(GB standard)
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Values

Hole references
Code Represents Fetches this hole data

%HC Hole Callout

For example, displays
hole diameter and
depth symbols plus
extracted values:

%HS Hole Size <Hole Size Value>
%HD Hole Depth <Hole Depth Value>
%BS Counterbore Size <Counterbore Size Value>

%BD Counterbore Depth <Counterbore Depth
Value>

%SS Countersink Size <Countersink Size Value>
%SA Countersink Angle <Countersink Angle Value>
%TS Thread Size <Thread Size Value>
%TD Thread Depth <Thread Depth Value>
%ZH Smart Hole Depth <Smart Hole Value>

%ZT Smart Thread Depth <Smart Thread Depth
Value>
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Bend References
Code Represents Fetches this bend data

%BA Bend Angle <Bend Outside Angle
Value>

%BN Bend Angle Unsigned <Bend Angle Unsigned
Value>

%IA Included Angle <Bend Inside Angle Value>
%BR Bend Radius <Bend Radius Value>
%BO Bend Direction <Bend Direction Value>
%BI Bend Sequence <Bend Sequence Number>
%BQ Bend Quantity <Number of Bends>

Drawing View References

Code Represents Fetches this drawing
view information

%VA View Annotation Name <View Annotation Name>

%LN Annotation Sheet Number <View Annotation SheetNumber>

%VS View Scale <Drawing View Scale
Value>

%VR Angle of Rotation <Drawing View Rotation
Angle>

%VN Drawing View Sheet
Number

<Drawing View Sheet
Number>

Weld Bead References

Code Represents Fetches this weld bead
data

%TT Target Thickness <Weld Bead Target
Thickness Value>

%GL Gap Length <Weld Bead Gap Length
Value>

%BL Bead Length <Weld Bead Length Value>
%NB Number of Beads <Number of Weld Beads>
%PI Pitch <Weld Bead Pitch Value>

Other

Miscellaneous
Code Represents Fetches this hole data
%RT Carriage Return Inserts a new line.
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Dimensions and Annotations activities

Activity: Retrieving and placing dimensions

Retrieving and placing dimensions

Overview

This activity covers the workflow of placing dimensions and annotations on a
drawing. An existing drawing file is used to dimension and annotate.

Objectives

In this activity you will:

• Retrieve dimensions from the Model.

• Update out-of-date drawing views.

• Use the Drawing View Tracker.

• Place dimensions on a drawing.

• Modify dimensions on a drawing.

• Place annotations on a drawing.

Open a draft file

▸ Open fan_body.dft.
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Retrieve dimensions

Begin the activity by working on the front view. Retrieve dimensions from the part
model.

▸ Choose the Zoom Area command. Zoom in on the drawing view as shown.

▸ On the Home tab®Dimension group, choose the Retrieve Dimensions command

.
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▸ Click the drawing view to retrieve dimensions contained in the part model.

Modify the retrieved dimensions

Delete and replace a dimension. Reposition a dimension.

▸ Click the Select tool and then delete the 100 mm diameter dimension. Replace
this dimension on the cross section view later in the activity.

▸ Reposition the 75 mm dimension. Click the dimension value and drag it inside
the dimension projection lines. Click the dimension line and drag it to the
position shown.
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Place center marks

Place a center mark in the center of the part and on each of the counterbored holes.

▸ On the Home tab®Annotation group, choose the Center Mark command .

▸ On the command bar, select the Projection Lines button .

▸ Select the By 2 Points option.
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▸ For the first point, click circle (A).

▸ For the second point, click the center of the upper right counterbored hole to
place the center mark.

▸ Repeat these two steps for the three remaining counterbored holes. Right-click
after placing each center mark.

▸ To place the first center mark on the interior circle, change the dimension type to
Horizontal/Vertical and select circle (A).

▸ To place the center marks between the diagonal ribs, change the orientation to
Use Dimension Axis.

▸ On the command bar, click the Dimension Axis option .
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▸ Click the 45° line (B). This will enable you to place center marks parallel and
perpendicular to this line.

▸ Place the 45° center marks by selecting circle (A).

Place angular dimensions

Place angular dimensions on the holes measured from the right horizontal center
line.

▸ On the Home tab®Dimension group, choose the Angle Between command .
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▸ Place an angular dimension from the right horizontal center line to the 45°
center mark line on the upper right counter bore hole.

▸ Do not end this command. Continue using the same origin. Select the angled
center mark line on the upper left side counter bore hole, and place the string
90° dimension.

Place a linear dimension and add a prefix

Dimension the fin thickness. Add a prefix to the dimension.

▸ On the Home tab®Dimension group, choose the Distance Between command .
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▸ On the command bar, click the Prefix option. Type 8 X in the Prefix field and
click OK.

▸ Set the dimension orientation to Horizontal/Vertical and select the two vertical
lines illustrated below to place the new dimension. Click to position the
dimension. This is the thickness dimension for each of the eight fins.
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Place a Smart dimension and add prefix, suffix and special characters

Add a SmartDimension to the bottom right hole. Set a prefix and suffix for the
dimension and also add special characters to include in the dimension display.

▸ Choose the Smart Dimension command .

▸ Click the Dimension Prefix option.

▸ Set the Prefix to 4 X.

▸ Click the Suffix field, and do the following:

• Click the counter bore symbol from the special characters, and press the
spacebar on the keyboard.

• Click the Diameter symbol , press the space bar on the keyboard, and
type 14.

• Press the spacebar.

• Click the Depth symbol , press the spacebar, and type 5. This sets the
suffix to the diameter and depth of the counter bored hole.

• Click OK to accept these inputs. The Special characters are displayed with a
% sign as part of the character in the Suffix field. But the symbol is actually
placed on the drawing.
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▸ Select the through hole in the lower right counterbore hole. Any dimensions
placed after this one will exhibit the same prefix and suffix until you clear the
Prefix field in the Dimension Prefix dialog box.

Dimension a section view

Place a distance between dimension with a prefix option on the section view.

▸ Choose the Distance Between command, and click the Dimension Prefix option.
Click the Clear button, and then set the Prefix to a diameter symbol. Click OK.

▸ Fit the view and then zoom in on the section view. Right-click to exit the zoom
area command.
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▸ Select the two horizontal lines (flanked by white area and crosshatching), and
place the dimension to the right of the view as shown. Even though this is a
linear dimension, the diameter symbol can be used as a prefix.

▸ Save the document.
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Edit a dimension and add a tolerance

Edit the dimension placed in the previous step and place a tolerance on the
dimension.

▸ Using the Select tool, click the 90 mm diameter dimension in the section view.
The command bar changes to edit definition mode to make a change to the
selected dimension.

▸ Click Dimension Type, and click the Unit Tolerance option.
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▸ Type 0.03 in the Upper and Lower tolerance boxes. The dimension changes to
show a plus/minus on the tolerance because the upper and lower values are the
same. If the upper and lower tolerance values differ, the two tolerances display
as separate items.

Use the dual unit dimension display

Edit the dimension and apply a dual unit dimension style.

▸ Click the Select tool and then, right-click on the 90 mm diameter dimension in
the section view. Click Properties on the shortcut menu to display the Dimension
Properties dialog box. Changes here only change the property of the dimension
selected. To modify all dimensions, click the Styles command in Style group
and make the changes.
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▸ Click the Secondary Units tab, and then set the Dual unit display and the Add
parenthesis ( ) boxes. Click OK. The 90 mm dimension updates to show the
dual units.

Fit the drawing sheet

▸ Choose Fit to fit the drawing sheet.
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Change sheet size

Notice that the drawing is too crowded. Change the drawing border to a larger size.

▸ Right-click on the Sheet1 tab, and from the shortcut menu, click Sheet Setup.

▸ Click the Background tab and change the background sheet to A2-Sheet. Click
OK.

▸ Fit the window again.
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▸ Reposition the views on the drawing sheet.

Close the draft file

▸ Save and close the file.

Open part file used to create drawing views

Open fan_body.par that was used to generate the drawing views. Make a change
to fan_body.par. When reopening the draft file, the changes are made obvious with
the out-of-date drawing views.

▸ Open fan_body.par.
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Edit a circular pattern feature

▸ Notice the 8 fins on the fan. Select the circular pattern of fins. Use QuickPick
or PathFinder to select the pattern.

▸ Click the on the Pattern X8 text.
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▸ Type 6 in the pattern count edit handle and then press the Enter key.

▸ Save and close the file.

Open draft file

Open fan_body.dft created earlier in this activity to observe how the file behaves
after fan_body.par was edited.

▸ Open fan_body.dft. Notice the Drawing Views dialog box. This box informs you
that one or more of the current drawing views are out-of-date. It also tells you to
go to the Drawing View Tracker command to get more information about the
status of the drawing views.
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▸ Click OK. Notice the box that surrounds the drawing views. This box indicates
that the views are out-of-date.

Use Drawing View Tracker

▸ On the Tools tab®Assistants group, choose the Drawing View Tracker command.
The Drawing View Tracker shows which drawings are out-of-date. When you
click on an entry, more information displays in the Update Instructions box
about that view.

▸ In the Drawing View Tracker dialog box, click the Update Views button . You
could also select a single drawing view from the Drawing View Tracker dialog
box and update that view by selecting Update View from the shortcut menu.

▸ Click Close to dismiss the Dimension Tracker dialog box.
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▸ Now notice that the drawing views update to reflect the change to the number
of fins on the fan. Also notice that the boxes indicating out-of-date drawing
views no longer display.

▸ Fit the drawing sheet.

▸ Save the file. This completes the activity. However, you may continue to place
additional views or dimensions for extra practice.

Activity summary

In the activity you learned how to place dimensions and annotations on a drawing.
You also learned how to edit a part and then update the drawing views to reflect
the changes.

Activity: Placing annotations

Placing annotations

Overview

This activity covers the workflow of placing annotations on a drawing. An existing
drawing file is used to annotate.

Objectives

In this activity you will place geometric tolerances and finish symbols.

Open draft file

▸ Open annotation_fan.dft.
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Place a datum frame

Place a datum frame on the right drawing view.

▸ On the Home tab®Annotation group, choose the Datum Frame command .

▸ On the command bar, cancel the selection of the Leader and Break Line options.
Type A in the Text box and set the Dimension Style box to ISO.

▸ Select the right vertical edge on the cross-section view and place the datum
frame as shown. If you want the minus sign to display before and behind the
letter A in the datum frame (-A-), on the View tab, choose Styles®Modify to
invoke the Modify Dimension Style dialog box. Then click the Annotation tab
and set the Dashes on Datum Text option.

▸ On the command bar in the Text box, change A to B and then click the diameter
dimension on the cross section view and place the datum frame as illustrated.
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Reposition a dimension

▸ Click the Select tool, and reposition the dimension on the counterbored hole as
shown below. Reposition the dimension horizontal.

Place a feature control frame

▸ On the Home tab®Annotation group, choose the Feature Control Frame

command .

▸ Click the Position symbol, and click the Divider symbol.

▸ Click the Diameter symbol, press the space bar, type in 0.05, and then press the
space bar again.

▸ Click the Material conditions: S and click the Divider Symbol. Press spacebar
and then type B in the content field. The dialog box should match the following
illustration.

▸ In the Save settings: field, type Position B 0.05.

▸ Click Save to save these settings as Position B 0.05. If prompted, click yes to
overwrite the file that already exists.

▸ Click OK.

▸ On command bar, clear the selection of the Leader and Break Line options.

▸ Select the diameter dimension on the lower right counterbore, and place the
geometric tolerance as shown.
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Place another feature control frame

▸ Click the Feature Control Frame Properties .

▸ Click the Parallelism symbol and create a callout of 0.10 mm to datum A.
Be sure to add the dividers as shown.

▸ Click OK and set the Leader and Break Line options. Place the feature control
frame on the left side of the cross section view as shown.

▸ Save the file.

Place a surface texture symbol

▸ On the Home tab®Annotation group, choose the Surface Texture Symbol

command .
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▸ Select the Symbol type: for a machined finish.

▸ Type 1.6 in the value field shown and click OK.

▸ On the command bar, clear the selection of the Leader.

▸ Place the surface finish symbol on the left vertical object line of the cross
sectioned part. Click the edge (A).

Hide an edge in the drawing view

The section cut produced extra edges in the section view. Hide those edges.
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▸ On the Home tab®Edges group, choose the Hide Edges command.

▸ Click the two edges shown.

Place a centerline on the section view

▸ On the Home tab®Annotation group, choose the Center Line command .

▸ On the command bar, make sure the Dimension Style is set to ISO and the
Placement options field is set to By 2 Points.

▸ On the command bar, click the Center Line properties button .
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▸ On the Center Line & Mark Properties dialog box, click the Line Type shown
and click OK.

▸ Place the Center line through the center of the counter bored hole by selecting
a keypoint on each end of the hole. Use IntelliSketch to locate the keypoint of
the vertical line.

Place an edge condition on the section view

▸ Choose the Edge Condition command .

▸ In the Edge Conditions properties dialog box, type 12 in the Upper tolerance
field and 6 in the Lower tolerance field. Click OK.
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▸ Select the lower horizontal edge on the cross section view edge and place
the symbol as shown below. You may have to select the edge condition after
placement and select the handles to reposition the text as shown.

▸ Fit the drawing sheet.

▸ Save the file.

Add notes to the drawing sheet

Notes can be added to a drawing sheet using text boxes. However, you can also use
a word processor to create the notes, and then copy and paste the notes directly
into Solid Edge.

▸ Choose the Text command .

▸ Click and drag to place a text box above the title block as shown.

▸ Right-click to end the text box placement and then click the Select tool.
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▸ Select the text box and right-click. Choose the Properties command.

▸ In the Text Box Properties dialog box, type 50 for the Fixed Width field and
25 for the Height. Click OK.

▸ Now that a text box is on the drawing sheet, enter the text. Type the text shown
in the illustration in the Text box. After typing “NOTE:” press the Enter key to
start a new line for the first note. Also notice that the last character wraps to a
new line. This is because the text box is not wide enough for the sentence.

▸ To modify the text box width, click the Select Tool command and identify the text
box border of the text box. Select and hold one of the graphic handles, and drag
it out to widen the text box.

▸ To add the second note, identify the end of the first note with the Select tool,
press the Enter key, and then type the next note.

▸ Save and close the file. This completes the activity.
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Activity summary

In the activity you learned how to place geometric tolerances and assign surface
texture symbols to the drawing.

Activity: Placing a parts list

Placing a parts list

Overview

This activity demonstrates the process for placing an assembly parts list on a
drawing sheet.

Open draft file

▸ Open carrier.dft located in the training course folder.

▸ If the Drawing Views dialog box informs you of an out-of-date drawing view,
click OK. On the Home tab®Drawing Views group, choose the Update Views

command .

Set the parts list option for auto ballooning

Turn on the auto-balloon option.

▸ In the On the Home tab®Tables group, choose the Parts List command .
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▸ Select the Drawing view.

▸ On the Parts List command bar, make sure the Auto-Balloon button is selected.

Set the balloon properties

▸ On the Parts List command bar, click the Properties button .

▸ Click the Balloon page. Type 5 for the Text Size. Use the default balloon shape.
The settings shown will place balloons which contain the item number and count.

Define location of the parts list

▸ Click the Location page.

▸ Click the Create table on active sheet button. Click the check box for Enable
predefined origin for placement.

Type 10 in the X origin: and Y origin: fields.

Define the parts list columns

▸ Click the Columns page.
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▸ Select Author from the Properties list, and click the Add Column button (1) to
add this to the columns list.

▸ Continue defining the columns for the parts list. Use the Delete Column button
to remove columns. Use the Move Up and Down buttons to arrange the columns.
Set up the columns as shown.
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▸ Click on Quantity in the Columns list.

▸ Type QTY in the Text: field (1) under Column Header.

▸ Click OK.
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Place the parts list on drawing

Now that the options are set, place the parts list on the drawing sheet.

▸ Click Place List on the command bar to include parts list with balloons.

▸ Click in the drawing sheet window to place the parts list and balloons.

▸ Zoom in on the Parts List in the lower left corner of the drawing.

▸ Notice the Author field is added on the right end of the parts list, and the column
header for Quantity is labeled as QTY. You can control the order of the columns
by right-clicking the parts list and then click Properties. Click the columns page.
Select the column from the list and then click the move up or move down buttons.

▸ Click Fit. Then zoom in on the drawing view. Notice that balloons are placed
on the parts, and the balloon numbers correspond to those in the parts list. To
reposition the balloons, click the Select Tool command, and drag the balloons
to a new location.

▸ Save and close the file. This completes the activity.

Activity summary

In this activity you learned how to create a parts list with ballooning. You learned
how to format the parts list.
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Summary

The Drafting application provides for the creation of drawings. Views and
dimensions that are placed on a drawing are associative to the 3D model and update
when changes are made to the model.

In this course you:

• Created drawings

• Added views to a drawings

• Dimensioned drawing views

• Placed annotations on drawings

• Placed a parts list on a drawing.
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10 Practicing your skills with
projects

Additional modeling projects

Introduction

This section contains additional parts for modeling practice. You can create each
part in this section in several different methods using a variety of commands in Solid
Edge. There is no correct or incorrect method to create these parts. Experiment with
different commands and options in an effort to learn as much about each command
as possible. There is an isometric view of each part to give you a better idea as to
what the finished part looks like. There are also principal views that contain the
dimensions you need to create the part. There may be more dimensions than you
need on the drawings.
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Base plate
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Bearing block A
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Bearing block B
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Column base
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Dovetail bracket
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Dovetail stop
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Gland blank
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Gland
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Guide plate
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Head attachment
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Head yoke
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Rod support
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Saw blade
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S-bracket
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Side beam bracket
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Slide stop
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Slotted link
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Swivel plate
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Trunnion plate
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Activity: Construct a bicycle hand tool

Construct a bicycle hand tool

Model a specialized wrench for removing the pedal cranks from a bicycle.
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Major dimensions

▸ Use the following dimensions when constructing the overall shape of the tool.
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Socket and wrench dimensions

▸ Use the following dimensions when constructing the socket and Allen wrench.
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Activity: Construct an intercom speaker cover

Construct an intercom speaker cover

Create a cover plate for a ceiling-mounted intercom speaker.
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Major Dimensions
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Activity: Construct a bicycle saddle shell

Construct a bicycle saddle shell

Transform a basic model into an anatomically correct shell for a bicycle saddle.
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Open part file

▸ Open saddle_ex.par from the downloaded zip file spse01550.zip.
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Hints

▸ Some hints:
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Finish the model

▸ Finished saddle:

Note

Applying a texture is optional. See the Help topic on “Style Command” to
learn more.
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